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Workforce Management 8.5 Web for
Supervisors (Classic) Help
Welcome to Workforce Management (WFM) Web for Supervisors (Classic) Help. Use this page to go
directly to the information you need, or use the Table of Contents to take a step-by-step tour of all the
features and functions in WFM Web for Supervisors.

Tip
WFM has a new interface for the Forecast module. If you have landed on this page by
accident and are using the new Supervisors interface, see Workforce Management
Supervisor Help, which describes the new Forecast module.

Getting Started
Learn about WFM controls, setting the
date, and finding agents in large tables.

Date Selectors
Finding Agents in Tables
Controls in the Supervisor's Window

Policies and Configuration
Create your policies, organizational
objects, and security roles.

Exceptions
Time-Off Rules
Contracts
Rotating Patterns
Organization
Security RolesCalendar and Trading

Create calendar items, set time-off limits,
and manage schedule trade requests.

Calendar Items
Time-Off Limits
How Trading Works

Forecast and Schedules
Create Forecasts and scenarios,
Schedules and scenarios (Master and
Intra-Day).

New Forecast Wizard
Forecast Scenarios
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Schedule Trade DetailsSchedule Scenarios
Master Schedule
Master Schedule Intra-Day

Performance, Adherence, and Reports
Monitor performance and set alerts,
calculate adherence per-channel, and
create reports.

Performance Monitor
Performance Alerts
Adherence Calculations
Adherence Per-Channel
Create and Generate Reports
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Overview
This Help provides a comprehensive guide to the features and functions of the Workforce
Management (WFM) Web for Supervisors (Classic) interface. In addition, it offers some general
guidance on using web browsers. If you require more assistance on using your web browser, refer to
the browser's help system.

Tip
WFM has a new interface for the Forecast module. If you have landed on this page by
accident and are using the new Supervisors interface, see Workforce Management
Supervisor Help, which describes the new Forecast module.

Supervisors Help Options

The red underlined links below will take you directly to a topic. Links are available throughout
Supervisors Help to give you easy access to information.

Getting Started
Explains how to perform WFM Web basics such as
logging in and out, choosing dates, and navigating
through WFM Web.

Policies Module

Explains how to configure the following Policy
objects (rules that WFM considers when making
forecasts and setting up schedules): Exception
Types, Time-Off Types, Time-Off Rules,
Meetings, Marked Time, Shifts, Contracts, and
Rotating Patterns.

Configuration Module

Explains how to:

• Configure WFM to send email notifications when
the following types of events occur: Schedule
modifications (agent notifications), changes in
the status of schedule trade requests (user and
agent notifications), and changes in the status
of time-off requests (user and agent
notifications).

• Use the Colors module to configure the colors
that WFM uses in the Supervisor schedule
views. You can configure default values for
these schedule items: Work, Days Off, Meals,
Breaks, Activity Sets, Exceptions, Time Off,
and Marked Time. You can also configure
specific colors, by site, for different types of:
Activity Sets, Exceptions, Time Off, and

Overview
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Marked Time.
• View, create, update, delete, and manage

Shared Transport Groups.
• Configure Agent properties Activities, Time

Off, Time-Off Bonuses, and assign Time-Off
Rules, Time-Off Types, Contracts or
Rotating Patterns to them.

• Configure Business Units and Sites.
• Configure Time-Off Bidding Periods.
• Configure Schedule State Groups and

Adherence Rules
• Configure Activities
• Configure Users (supervisors and other persons

who are not agents)
• Configure Roles (security roles and privileges)

Calendar Module
Explains how to view, add, edit, and delete
preplanned items, such as exceptions and
preferences; how to grant or decline these items;
and how to set time-off limits.

Forecast Module Explains how to make workload and staffing
predictions for one or more sites.

Schedule Module

Explains the schedule views and how to make real-
time adjustments to the schedule. Includes these
bidding views:

• Overtime Bidding View—Explains the overtime
bidding process, including: creating an overtime
offer, bidding by agents, bid resolution and
publishing to the Master Schedule.

• Schedule Bidding View—Explains the schedule
bidding process, including: creating a scenario,
bidding by agents, bid resolution and publishing
to the Master Schedule.

Trading Module Explains how to review, and approve or decline,
agents' proposed schedule trades.

Performance Module
Explains how to view actual site performance
compared with planned performance, using such
key indicators as Service Level and Average Speed
of Answer (ASA).

Adherence Module Explains the real-time agent adherence views,
which include both table and graph options.

Reports Module
Lists all of the reports available in WFM Web for
Supervisors, and details the information included in
each report.

About Window Displays the release number and copyright

Overview
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information for this release of WFM Web.

Printing This Online Help

If you prefer to print the Help rather than use it online, complete the following steps:

1. In the Navigation pane on this page, at the bottom of the Table of Contents, click PDF Version.
2. When the dialog opens, select:

• Open with to select the application, with which you want to view and print the Help.
Adobe Acrobat v9 is recommended.

• Save File to save the Help to a folder on your computer.
When the download is complete, navigate to the folder that contains the saved .pdf file,
open and view the file on your computer offline.

3. Use the Print function in your application to print the document.

Overview

Workforce Management Web for Supervisors Help 18



About WFM Web
The About window displays when you select the About button, which is found in the top right corner
of WFM Web window, near the Log out button. The About window displays the copyright information,
Settings... button, and the Workforce Management (WFM) Web Server version.

Java Plug-In Support in Browsers

Since Oracle deprecated Java Web Start in Java SE 9 and discontinued support in Java SE 11, WFM
introduces its UI Launcher, enabling users to run Web for Supervisors Java-based views in the same
browser session, as they always have. To use the UI Launcher, you must install Java on the computer
that is running WFM Web. The Java folder must be set to either the PATH or JAVA_HOME environment
variable. If it is set to both, the value is taken from JAVA_HOME.

Tip
The UI Launcher is also compatible with OpenJDK. If OpenJDK is set up simply by
unzipping the Java files, neither of these variables are set automatically and you must
set the Java folder to PATH or JAVA_HOME manually.

Deploying the WFM UI Launcher
To use the WFM UI Launcher:

Overview About WFM Web
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1. Log in to the Web for Supervisors application.
2. At the Home view, click About.
3. Below Settings..., click Download UI Launcher.
4. When the download dialog opens, click Save File.
5. Save the file in a folder on the local computer.
6. After unzipping the files, run assoc-add.bat.

This associates the *.wfm files with the launcher.
The WFM UI Launcher is now ready to use.

7. At the Home view, click About > Settings...
8. Click the Type column header to sort the column until the ENUM type setting appears at the top.

This enables you to find RUN_JAVA_STANDALONE quickly.
9. In the Value column, click to open the drop-down list and select UI Launcher.

WFM uses the UI Launcher as the default application to open .wfm files in the same session.

You can select one of three values for RUN_JAVA_STANDALONE:

• Off (Plug-in used)—If selected, WFM uses the Java plug-in inside the browser to open the Web for
Supervisor Java-based views.

• Java Web Start—If selected, WFM Web does not attempt to start the Java applet, but generates and
downloads the wfm.jnlp file, which launches automatically. However, you might have to save it to your
hard drive and start it as you would any other application. It then starts as a standalone Java Web Start
application, containing Java-based supervisor views.

• UI Launcher—If selected, WFM Web does not attempt to start the Java applet, but generates and
downloads the start.wfm file, which launches automatically. However, you might have to save it to
your hard drive and start it as you would any other application. It then starts as a standalone
application, containing Java-based supervisor views.

If you select either Java Web Start or UI Launcher, see the limitations below.

Limitations: Browsers That Do Not Support Java Plug-Ins
If you enable the RUN_JAVA_STANDALONE setting to use a standalone Java Web Start or the UI
Launcher, take note of the following limitations:

• You cannot use the wfm.jnlp or start.wfm file to start the Web for Supervisors views at any time. The
file is valid and launches the application only if the user's session, from which the file was downloaded,
is active. After the user logs off or the session expires, the (separate) Java and Launcher applications
stop working too. Therefore, you must keep the browser window (from which the wfm.jnlp or
start.wfm file was downloaded) open for the duration of work and remain logged in.

• If the local settings in About > Settings... are changed, you must download the wfm.jnlp or
start.wfm file again and restart before the changes take effect.
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Changing GUI colors and font size

WFM Web for Supervisors uses other indicators besides color to highlight a change or status, but you
can customize many elements in the GUI by changing the color.

1. Click About > Settings... to display the Settings page.
The Settings page has one setting displayed on each row and can be scrolled up or down.

2. Optional: Click Sort to open a drop-down list and choose one of four sort options: Setting,
Description, Type, or Value; or click any column heading to sort by the list in ascending or
descending order.

3. Click any row in Settings... that is of type COLOR to display the Color Palette pane.
4. The Color Palette pane has five fields: RED, GREEN, BLUE, HUE, and COLOR (#), which show the

numerical values for the chosen color in the palette.
The palette corresponds to the standard Windows-style color picker.

5. Click Apply after you have made your changes, and then Close to close the color picker.
6. Optional: To change the Text Size Settings, select one of four radio buttons; None, +1, +2, or +3.
7. Optional: Select the Use High Contrast Theme check box to display all color choices in high contrast,

the next time that you log in to WFM Web.

8. Click Save Changes and exit the Settings... page.

9. Optional: Click Restore default value to abandon your changes.

More WFM Web Application Settings
In addition to GUI color settings, there are other settings in About > Settings.... that affect allow
you to customize WFM Web application functionality:

• ACCESSIBILITY_COMPATIBLE—If checked, WFM Web runs in accessibility mode. If the check box is
cleared (default), WFM Web does not run in accessibility mode.

• CFG_SHOW_TERMINATED_AGENTS—If checked, WFM Web shows terminated agents and agents with
hire dates set in the future in lists or tables. If the check box is cleared (default), WFM Web hides
terminated agents and agents with hire dates set in the future, and they cannot be viewed in lists or
tables.

• FRC_STAFFING_USE_MANHOURS—If checked, WFM Web shows staffing totals in person-hours instead
of full-time equivalents. If the check box is cleared (default), WFM Web shows staffing totals in full-time
equivalents.
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WFM Agent Mobile Client Support

In addition to the WFM Web for Agents desktop interface, WFM Web includes the Agent Mobile Client
web interface, which is optimized for mobile devices. To access WFM Web for Agents on their mobile
devices, agents can use the same URL that they use to gain access to the Agent UI on their desktop.

Agents can use the latest supported version of Safari on their iOS devices and the latest supported
version of Google Chrome on their Android devices.

Advise agents that their browser screen's actual resolution must be at least 320 by 550. WFM does
not support anything less than either dimension.

Screen Reader Support

WFM Web for Supervisors supports screen readers for vision-impaired users, with keyboard, focus and
screen reader ToolTip support throughout the WFM Web for Supervisors interface. Every menu item
and on-screen command can be reached by using the keyboard (and so, can also be reached using a
screen reader).

In addition, the Accessible Schedule Details dialog box simplifies and organizes commands for vision-
impaired users and the screen readers that they use, in these views:

Schedule > Schedule Scenarios > Scenario Agent-Extended view

Schedule > Schedule Scenarios > Scenario Intra-Day view

Schedule > Master Schedule > Master Schedule Intra-Day view

Schedule > Master Schedule > Master Schedule Agent-Extended view

Tip
WFM Web was improved to allow supervisors to use Java-based views on browsers
that do not support Java plug-in, like Chrome. See the RUN_JAVA_STANDALONE Web
Application setting below.

Glossary of Abbreviations

The acronyms and abbreviations that appear on Workforce Management screens and throughout the
document appear as links that reference a glossary containing definitions for these terms. You can
view definitions by clicking the link (in bold red) and it will open in a pop-up window on the page you
are viewing. For example, average handle time.

Also, see the entire Genesys Glossary.
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Getting Started

Tip
WFM has a new interface for the Forecast module. If you are using the new
Supervisors interface and have landed on this page by accident, see the "Getting
started" page in the Workforce Management Supervisor Help, which describes the
new Forecast module.

Site supervisors can use a web browser to log in to Workforce Management Web for Supervisors
(WFM Web) and perform the following tasks:

• View, add, edit, and delete agent preferences and exceptions.
• Set time-off limits.
• Forecast staffing requirements, based on service objectives and historical data.
• Schedule agents and teams for multiple activities, and make real-time schedule changes.
• Create a bidding scenario with profile agents, which real agents can use to bid on their favorite

schedules.
• View, and approve or decline, agents' proposed schedule trades.
• Configure Schedule State Groups and Organization objects, such as Business Units and Sites,
• Configure Activities properties.
• Configure policies for Exception Types, Time-Off Types, Time-Off Rules, Meetings, Marked Time,

Shifts, Contracts, and Rotating Patterns.
• Monitor real-time site performance.
• Review agents' real-time adherence to their scheduled status.
• Generate reports that show schedule and performance information.
• Configure email notifications.

Screen Resolution and Multiple Browser Windows

• WFM Web is optimized for a screen resolution of at least 1024 x 768. At lower resolutions, some
elements (such as table headers) might not display correctly.

• If you are using Mozilla Firefox, Genesys recommends that you not run WFM Web in more than one
browser window on the same workstation, because doing so can cause the application to behave in
unexpected ways.

• If you are using Internet Explorer, Genesys recommends (for the same reason) that you not open a
second browser window on the same WFM Web session by selecting File > New or pressing Ctrl+N.
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However, starting a separate WFM Web session by launching a separate Internet Explorer browser
thread does not appear to cause this problem.

Security Features

WFM Web includes security features that prevent unauthorized access to information:

• You can view and make changes only to those modules (such as Calendar or Schedule) and objects
(such as sites) for which you have security access. You cannot access other modules or objects.

• Configuration and security options enable you to restrict access to agents' personal information, such as
wages.

• Agents use a separate application (WFM Web for Agents), which enables them to view and change their
own information. They have limited access to other agents' schedule information, but only if schedule
trading is enabled at your site. Agents can also access this application on their Android, smartphone, or
other mobile device if the supervisor provides the URL.

Accessibility

To run Web for Supervisors with accessibility tools like JAWS, set the ACCESSIBILITY_COMPATIBLE Web
Application setting to true in the About > Settings.. dialog. Otherwise, WFM Web for Supervisors
could freeze, or display adverse or unexpected behavior while screen readers like JAWS are being
used.

Setting the Clock

WFM Web for Supervisors picks up the regional settings from the local computer. You may wish to
change this if, for example, WFM Web appears in a 12-hour format and you want to view a 24-hour
format.

Tip
WFM Web for Agents picks up the regional setting from the server where the WFM
Web application is running—not from the agent's computer.

Links to Further Information
Log In Explains how to start your WFM Web session.

The Supervisors Window Explains the layout and functions of the WFM Web
controls.
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Policies
Explains how to configure the following policies:
Exception Types, Meetings, Time-Off Types, Time-
Off Rules, Marked Time, Shifts, Contracts, and
Rotating Patterns.

Configuration

Explains how to configure Shared Transport,
Agents, Organization objects, such as Business
Units, Sites, and Time Zones, Schedule State
Groups and Activities.
Notifications explains how to configure email
notifications.
Colors explains how to configure the colors that
WFM uses in the Supervisor schedule views.

Calendar
Explains how to view, add, edit, and delete
preplanned items, such as exceptions and
preferences; how to grant or decline these items;
and how to set time-off limits.

Forecast
Explains how to forecast staffing requirements
based on projected interaction volumes and service
objectives.

Schedule Explains how to build, view, share, edit, and delete
published and unpublished schedule scenarios.

Schedule Bidding
Explains the schedule bidding process, including:
creating a scenario, bidding, bid resolution and
publishing to the Master Schedule.

Trading Explains how to view, and approve or decline,
agents' desired schedule trades.

Performance

Explains how to view actual contact center
performance compared with planned performance
based on key indicators such as Service Level,
Average Speed of Answer (ASA), and
Abandonment.

Adherence
Explains how to view agents' real-time adherence
to their schedules in both tabular and graph
formats.

Reports Explains how to generate, view, print, and export
predefined WFM reports.

Log Off Explains how to end your WFM Web session.
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Logging In
Before you can log in to Workforce Management (WFM), you must have the WFM Web URL (address).
In some contact centers, the Log in page might already be set up for you and you can simply enter
your username and password. If this is not the case, ask your administrator for the WFM Web URL.
After typing it into your browser, WFM displays the splash screen for the Log in interface.

Tip
WFM has a new interface for the Forecast module that you can access after logging in
to Web for Supervisors (if you have the appropriate access rights). To use the new
interface, see Opening the new Forecast UI Also, see Workforce Management
Supervisor Help, which describes the new Forecast module.

Logging in to Web for Supervisors

To start using WFM Web:

1. Obtain the WFM Web URL (address) from your administrator.
2. Open a web browser.
3. Type the WFM Web URL into your browser's address bar and press Enter.

The Log in window appears.
4. Enter your user name and password.
5. Click OK.

If WFM Web validates your user name and password, he Web for Supervisors (Classic) Home view
opens. If WFM Web cannot log you in, it displays an error message indicating the problem. Either click
Login to try again (for example, if you think that you misspelled your user name or password), or
click Show error details.

Important
Multiple Supervisors using the Firefox web browser cannot be logged in to the same
host at the same time.
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Opening the new Forecast UI

Depending on how WFM Web is set up in your contact center, you might or might not see the option
to open the new Forecast module. If you require access and do not see this option, contact your
administrator.

To open the new Forecast user interface:

1. First, log in to the Supervisor (Classic) interface. See the procedure above.
2. In the top-right corner of the classic Home view (or any other view), click New UI.

The new Forecast UI opens.
3. Click Forecast to open the drop-down menu containing a list of views in the Forecast module.
4. Select a view from the list to open it.
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The new Forecast UI is described in the Workforce Management Supervisor Help.

System Login Timestamp

The timestamp information from the previous login is displayed in the WFM Web GUI the next time
you log in through the Supervisor interface, alerting you to any unauthorized use of your login
credentials.

Figure: Web for Supervisors Login Timestamp

If you do not set the timestamp to the browser time zone, the time zone for the location at which you
log in is used in the timestamp. The timestamp is displayed in the top-right corner of the Home
page, below the list of modules and breadcrumbs bar.
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Date Selectors
Many WFM Web modules and views have common date-selection controls to modify the date(s)
displayed in them. The following sections cover:

• Selecting a start date.
• Jumping to other dates by opening the monthly calendar.
• How WFM Web automatically selects the first workday in weekly views.

Selecting the Start Date

Where available, the date-selection controls appear at the right edge of the toolbar. These controls
function as follows:

<
Click this button to move the start date back one
interval (day, week, or schedule planning
period—depending on the context).

Date:

Type a date into this date box to directly edit the
start date. (The sequence of month, day, and year
digits depends on your operating system's regional
settings.) You can also use the up or down arrow to
modify the displayed date.

... Click this button to open the monthly calendar.

- [End Date]
For views that display more than one day's
information, the end date appears (but cannot be
edited) here.

>
Click this button to move the start date forward
one interval (day, week, or schedule planning
period—depending on the context).

Selecting the Month

The calendar shows one calendar month. You can use the calendar's controls to:

Select a new start date: Click a date. (The calendar closes, adjusting the
current module or view to your selected start date.)

Jump forward or backward one year: Click the small up or down arrow to the right of the
year text box.

Jump to a specific year: In the year text box, select and retype the digits
that you want to replace. (Green digits remain
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editable; press Enter to lock the new year, which
turns the digits black.)

Jump forward or backward one month: Click the small up or down arrow to the right of the
month name.

Jump to a specific month: Click the month name, and then click a different
month in the drop-down list that appears.

Colors in the calendar have the following meanings:

Dark gray square: Currently-selected start date.

Weekly Views: Automatic Start Day Selection

In weekly views, if you enter a date other than the first weekday, the view automatically adjusts to
start with the first weekday.

If the WeekStartDay setting has been specified (in the Business Units > Properties tab), the first
weekday is the one specified in WeekStartDay. Otherwise, the first weekday is the one specified in
your operating system's regional settings.

Getting Started Date Selectors

Workforce Management Web for Supervisors Help 30



Finding Agents in Tables
In a number of Workforce Management (WFM) Web windows, you can search for particular agents by
using the Find Agent dialog box. To open it, select the table you want to search and then either:

• Select Find from the Edit menu.
• Press [Ctrl] + F.

You can search for agents in these windows:

• The Calendar main window.
• The table in the Schedule Scenario Weekly View and Master Schedule Weekly View. Select a cell

in the Agent Name column to activate the Find command.
• The table in these views:

• Schedule Scenario Agent Extended
• Schedule Scenario Intra-Day
• Master Schedule Agent Extended
• Master Schedule Intra-Day

To search for one or more agents:

1. In the Find Agents dialog box, type either the full name for which you are searching or its first few
letters.

2. Select the Last Name or First Name radio button.
3. Click Find.

The table that you are searching now shows the first agent listed whose name matches the
search string that you entered. A message box informs you if there are no agent names
that match your search criteria.

4. Click Find again to find the next agent whose names matches the string you entered. You can search as
many times as you want.

5. When you have finished searching, click Close.

Displaying Terminated Agents in Tables

You can enable WFM to display terminated agents wherever agents are displayed in lists or tables in
the Schedule, Calendar, Trading, Adherence, Policies, Configuration, Reports views. By
default, WFM does not display terminated agents.

To change the default, see the CFG_SHOW_TERMINATED_AGENTS setting in About > Settings...
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The Supervisor's Window
The panes in WFM Web for Supervisors display some combination of the controls described below,
depending upon selections that you make in the Object pane. For more information, see the
description of the Get Data button in the table below.

Generic buttons The following buttons appear at the top right of
every WFM Web window:
Home displays the Home view, which is a list of all
View menu options that is organized by tab.
Refresh applies to the current view.

About button About displays information about copyright and
the current version information.

Logout button Logout closes WFM Web, without confirming your
choice if there are no changes to save.
New Page displays a new web page of WFM Web.
Default view is Home.

Help button General Help displays WFM Web help at the
Overview topic.
Contextual Help displays WFM help at the current
topic.
Search enables you to enter search criteria to
quickly find the object you are looking for. The
criteria you enter will depend on which pane you
have open.
Sort enables you to sort lists to easily find the
items you are looking for. The sorting criteria will
vary, depending on which pane you have open.
Paging controls enable you to browse the
previous and next pages or navigate to the first
and last items in the data set (start and end of the
list), by clicking the appropriate arrow button in the
view. To navigate between pages, you can use the
Up, Down, Page Up, and Page Down keys on the
keyboard.

Modules
Click to open each WFM module: Configuration,
Policies, Calendar, Forecast, Schedule,
Trading, Performance, Adherence, and
Reports.

Breadcrumb navigation

WFM for Supervisors uses the same type of
"breadcrumb navigation" as you see in Windows 7
directories and across the top of some web browser
windows. Click any link in this display to choose
from a drop-down menu and make a selection
within that branch of the currently selected
module. For example, the following breadcrumb
navigation path will display a specific schedule
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scenario for the currently selected date:

Home > Schedule > Scenarios > Q4-2010 >
Q4-2010 Intra-day

Edit Menu (Copy, Cut, Paste, Find) Each of these commands becomes enabled when it
can be performed on the currently selected object.

Actions Menu
Select from a list of view-specific commands. This
menu's contents change as you move among
modules and views, and they match the command
icons that appear on the toolbar.)

Actions Toolbar
These buttons correspond to the commands on the
Actions menu. Hover your mouse pointer over a
toolbar button to see a tool tip that displays the
button's name.

Objects Pane

This pane offers several different display schemes,
depending on the current selection of tab and
menu item:
Tabs: module-specific item trees under separate tabs
One tree: Business Units (BUs) > Sites
One tree: BUs > Sites> Activities
Upper tree: BUs > Sites> Teams > Agents
Lower tree: BUs > Multi-site Activities > Activity Groups >
Sites > Activities

When there are two selecting items in either of these two trees,
it triggers an automatic selection of corresponding items in the
other tree.

At the site level, you may see a team in the tree labeled
<None>. This node lists any agents that are assigned to the site,
but not assigned to a team. If all agents in that site are assigned
to a team, then the <None> team is empty. The only exceptions
to this hierarchy are when Scenarios is selected or when you
use the Configuration or Reports modules.

Clicking an object in a tree (or clicking its expand/collapse
control) displays the object's contents below it, indented slightly.
When you have displayed the desired object, double-click it (or
click it once, and then click Get data) to open the selected view
for that object.

Where the Objects tree displays check boxes, you can usually
select / deselect multiple objects by selecting ( ) / clearing (

) their check boxes, respectively. Certain views do not display
check boxes; in this case, you can select multiple objects by
clicking the group of objects while pressing the SHIFT or CTRL
key. Some views and windows allow you to select only a single
object.

Expand/Collapse Controls

Wherever you see the icon in a tree or other
control, you can click it to see an expanded view of
the adjacent item's contents or details. The icon
indicates an expanded item. Click it once to
collapse the item's contents and see more parallel
items.

Working Pane (or Data Pane)
The right pane of the window displays data and
controls that correspond to your selected module
and view. Some views display graphs with an
explanatory legend below them.
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Action Buttons

View-level action buttons within the working pane
provide controls that are specific to particular views
(for example, apply or cancel).

The Get data button , when present
at the lower left below the Objects tree, refreshes
the display with current data from the database.

Tip
Not all modules use the Get data button. If there is no
Get data button, the view is automatically updated
with the new data every time that you change your
date or object selection.

Status Bar
The status bar, at the very bottom of the window,
displays messages about WFM Web's current state.
(In some views, it displays the most recently
generated warning or error message.)

Retrieving Lists of Items in Segments

The list of items or objects (such as Agents, Shifts, Profiles, Activities, Schedule States,
Contracts, and Rotating Patterns) in a pane is displayed in segments or sequential pages. When
large amounts of data are being retrieved, the list of items in the pane is displayed in smaller
segments sequentially, with 50 items per page. This limits the number of items that are retrieved
from WFM at any given time, maintaining optimal performance during retrieval. See Paging controls.

Changing the Font Size in the Browser

There are two ways to change the font size in the browser:

1. On the keyboard, hold the down the Ctrl button and scroll up to make the font larger or down to make it
smaller.
Use this method to change the font size of the breadcrumbs and modules in WFM Web for Supervisors,
such as Rotating Patterns, Contracts, Organization, Schedule State Groups, Shifts, and
Activities.

2. Select About > Settings and use the Text Size slide bar to adjust the text.
Use this method to change the font size of the all modules, except the new modules (see the list
above).

Customizing Table Views

Many WFM Web views include on-screen tables. You can typically customize the display of these
tables in one or both of the following ways:
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Resize Columns
In the table's header row, place your mouse pointer
over the separator between two column headers.
When you see a two-headed arrow, click and drag
the column separator to adjust the column widths.

Sort by Column

In some tables, you can sort the data according to
one of the displayed columns. Specify the column
by clicking its header.

You can change the sort order by clicking the
header again. An upward-pointing arrowhead in the
header indicates ascending order. A downward-
pointing arrowhead indicates descending order.

If the Agent column is specified as the sort key, in ascending order, it will read: Agent ^
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Logging Off
You should always log off when you have finished using WFM Web.

Important
If you do not log off, other users of your workstation might be able to view your
account information.

To log off from any WFM Web view:

1. Pull down the File menu.
2. Select Logoff/Login.

WFM Web logs you off and the login screen appears. Another user can log in or you can now close the
browser.
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Policies
Policy objects are the rules that govern the work schedules of contact center agents. These rules are
defined as policy objects for each site; WFM considers them when making forecasts and setting up
schedules.

Important
To configure objects and change settings in the Policies module, you must have the
appropriate role privileges. See Policies Role Privileges.

WFM Web for Supervisors includes the following policy objects:

• Exception Types—Defined periods of time when agents are engaged in noncontact work or are absent,
such as during meetings or on days off.

• Time Off Types—Various types of time off, such as vacation, sick leave, and holiday. This module enables
you to configure various time-off types and associate them with time-off rules.

• Time-Off Rules—The rules that govern accrued time off, and how awarded time off is granted. This
module enables you to configure time-off rules for multiple time-off types or a single time-off type.

• Meetings—A period set aside for a specific activity, such as a meeting or training, attended by multiple
agents.

• Marked Times—Periods that you can designate as requiring special tracking. For example, you might
have an agent who works extra hours on a particular day, but the extra hours do not count as overtime.
You can mark those hours to track and report on them.

• Shifts—Defined periods of time when agents are assigned to work activites. Shifts define workday
parameters by time of day, duration, and days of the week.

• Contracts—Settings for agent availability times and days off that might be union or contractual
requirements. WFM automatically takes these settings into consideration during scheduling to produce
legal schedules for every agent.

• Rotating Patterns—Rotating work weeks of shifts, working days, working hours, and/or work activities. A
rotating pattern can be assigned to an agent.

Watch the Video

• Creating Exception Types
• Creating Time-Off Types
• Creating Time-Off Rules
• Creating Meetings
• Filtering Agents by Activities
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Exception Types
Exception types define periods of time when agents are engaged in non-work activities, such as
training or meetings. Each site configures its own set of exception types, based on its business
requirements.

Creating Partial-Day Exceptions

Scheduler evaluates partial-day exceptions to see whether they are Valid or Invalid. Valid partial-
day exceptions comply with the criteria that are listed in Exception Type Properties (below).

Partial-day exceptions must:

• Not conflict with a full-day exception or granted preference.
• Fall entirely within the agent's availability pattern as specified in the Contract module and (if

applicable) within granted availability preference hours.
• Fall entirely within activity hours of operation for activities the agent can perform.
• Fall entirely within at least one compatible shift's start and end times and be compatible with the meal

settings for that shift.
• Not overlap the start or end time for another partial-day exception.

Exceptions with Payback
WFM supports exceptions with payback to enable agents to make up for work time lost due to
lateness events or personal appointments. If agents in your contact center are given appropriate
permission to use this feature, they (and you) can insert payback exceptions into an existing
schedule.

You can insert these exception types when modifying individual agent schedules. See the Insert
Exception with Payback Wizard in the Schedule > Intra-Day view. Agents can insert payback
exceptions in the My Schedule or My Schedule Details view. See Adding Exceptions To Your
Schedule in the Workforce Management Agent Help.

Using Time-Off Types Instead of Exception Types

The standard exception types that WFM creates when you choose the Generate Default Schedule
State Groups and exception types while importing a site include several that represent various
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types of time off. These exception types, and the Exception is Used as Time Off setting, are
included for backward compatibility only.

For example, the standard exception types include Time Off, Holiday, Sick Day, and Personal
Day. These time-off exception types are comparatively inflexible and cannot be associated with time-
off accrual rules. For this reason, time-off types are the preferred way to configure the various kinds
of time-off periods you use.

Genesys recommends that you configure all types of time off using the Time-Off Types module
instead of configuring them as exception types.

Tip
Supervisors can also enter time off as preferences in WFM Web's Calendar module.

Trade Rules Associated with Exception Types

You can change which trade rule is associated with a specific Exception Type, but you cannot edit or
delete a Trade Rule.

Creating Exception Types
Link to video
To create exception types, watch the video and/or follow this procedure:

1. In the Policies module, select Exception Types.
2. In the Objects pane, select the site(s) or business unit with which the new object will be associated.

Tip
You can select multiple sites (just keep clicking on them) but only one business unit.

3. Click New .
4. Configure the new object on each of the Properties and Associated Sites tabs.

5. When you are finished, click Save .

Policies Exception Types

Workforce Management Web for Supervisors Help 40

https://player.vimeo.com/video/160795567?title=0&byline=0&portrait=0


Editing Exception Types

To edit exception types:

1. Select the exception type in the Exception Types pane.
2. Make the necessary changes. See Exception Types Properties tab to find out how to configure these

settings.

3. Click Save .

Deleting Exception Types

To delete exception types:

1. Select the exception type in the Exception Types pane.

2. Click Delete .

Copying Exception Types

To copy existing exception types:

1. In the Exception Types pane, select the exception type you want to copy.

2. Click Copy .
3. When the Copy Exception Type pane opens, enter a name for the exception type.
4. In the bottom half of the pane, click the Enterprise list and select the business unit, to which you want

to associate this exception type.

5. Click Save .
Alternatively, click Close to close this pane and cancel the action. If you do this, the
exception type is not copied.
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Exception Types Settings

You can configure settings in two tabs in the Exception Types view (after clicking New or
selecting an existing exception type):

• Properties Tab
• Associated Sites Tab

Properties Tab

• Exception Type Name—Each exception type should have a descriptive name. The name must be
unique within all sites associated with the exception.

• Short Name of Exception Type—To be used in graphical representations of the exception in
Calendar and Scheduler, and can be up to three characters.

• Exception Usage—Select one of the following radio buttons:
• Regular—An ordinary exception.
• in Meeting Planner/Scheduler—This exception will be used to configure a meeting and will be

inserted into the schedule when the meeting is scheduled.
• as Time Off—The exception duration is counted against the Time-Off balance.

Important
The Exception Used as Time Off property does not use any other time-off rules or settings (including
time-off limits). The ability to use an exception as time off is intended for legacy purposes only, for
customers who have previously created exceptions to use as partial-day time off. Genesys recommends
that users set up time-off types that they can use for both full-day and partial-day time off, and that they
no longer use exceptions to represent partial-day time off.

• Convertible to Day Off—Select this check box to instruct Scheduler to convert a full-day
exception to a day off, if that is necessary for consistent scheduling. The day off is counted
towards Preference Fulfillment.

Important
Selecting this check box disables and checks the property Exception Is Exclusive for the Whole Day.

• Exception Type Is Paid—If the check box is selected, the exception is paid. If cleared, it is unpaid.
• Allow Breaks and Meals during Exception—Select this check box to allow breaks and meals
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during the currently selected exception. Default setting: cleared. Disabled if the current
combination of selected exception properties does not allow breaks. (Enabled only if Exception
Type is Paid is selected.)

• Exception Is Exclusive for the Whole Day—This exception occupies the entire day.
• Trade Rule—Indicates how this exception should be treated if an agent who is assigned this exception

is involved in a schedule trade. From this drop-down list, select possible values are Delete, Do Not
Trade, Keep with Agent, and Keep with Schedule (default).

• Agent Initiated—Select this check box to allow an Agent to initiate this Exception type. Default:
cleared.

• Specify Dates—Select this check box to set the start and end date for the exception. This check
box is enabled only when the Agent Initiated check box is selected.

• Start Date—Select to specify the start date of an allowed range for this exception type. Then
enter the month, day, and year manually, or click the down arrow to select the date from a drop-
down calendar. The default is the current date.

• End Date—Select to specify the end date of an allowed range for this exception type. Then enter
the month, day, and year manually, or click the down arrow to select a date from the drop-down
calendar. The default is the current date.

Associated Sites Tab

1. Select the check box of each site to associate with the current exception type.
2. Clear the check box of each site to disassociate with the current exception type.

3. Click Save .

On this tab you can associate an exception type with a Schedule State Group. The site's Schedule
State Groups drop-down list is enabled when you check the site. It contains all of the Schedule
State Groups under that site.

If a Schedule State Group with an associated Fixed State Exception exists for the selected site, this
Schedule State Group is selected by default in the Schedule State Group drop-down list when you
check this site. See the figure below.
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Figure: Schedule State Group drop-down list—Associated Sites tab
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Time-Off Types
WFM enables you to configure multiple types of time off. Examples of time-off types include vacation,
sick leave, paid time off, holiday, and maternity leave.

By default, WFM creates the Vacation time-off type. This time-off type cannot be deleted and does
not belong exclusively to any site.

You can configure a time-off rule for a one or multiple time-off types. When you configure multiple
time-off types for the same rule, the time-off balance is calculated and accrued for all time-off types
associated with that rule.

Use the procedures in this topic to create, copy, edit, and delete time-off types, and associate/
disassociate time-off types with sites.

You assign time-off type/time-off rule combinations to agents by using the Configuration > Agents
> Time Off pane.

Creating Time-Off Types
Link to video
To create a time-off type, watch the video and/or follow the steps in this procedure:

1. In the Policies module, select Time-Off Types.
2. In the Objects pane, select the site(s) or business unit with which the new object will be associated.

Tip
You can select multiple sites (just keep clicking on them) but only one business unit.

3. Select New ( ) from the toolbar.
4. Configure the new object on the Properties tab and the Associated Sites tab.
5. Click Save when you are finished.
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Editing Time-Off Types

To edit a time-off type:

1. In the Time-Off Type pane, select a time-off type.
2. Select the Properties tab and/or the Associated Sites tab and make the changes.
3. Click Save.

Tip
You cannot edit a time-off type that is used in the Calendar or Meeting Planner.

Deleting Time-Off Types

To delete a time-off type:

1. In the Time-Off Type pane, select a time-off type.

2. Select Delete from the toolbar.

Tip
You cannot delete a time-off type that is used in the Calendar or Meeting Planner.

Copying Time-Off Types

To copy a time-off type:

1. Select an existing time-off type from the list.

2. Click Copy from the toolbar.
3. Rename and associate the time-off type with a Business Unit.
4. Click Save when you are finished.
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Properties Tab

• Name—This name should be descriptive and must be unique within the site.
• Short Name—The short name of the time-off type can be up to three characters.
• Time-Off Type is Paid—Select this check box if the time-off type is paid.
• Counts Toward Time-Off Limits—Select this check box if WFM should apply time-off hours of this

type to the time-off limits that you set in the WFM Web for Supervisors Calendar module. If you clear
this check box, no time-off limits are applied to this time-off type.

• Trade Rule—This controls whether agents can trade schedule periods that include time off of this type.
For example, a paid-time-off day normally stays with the agent, whereas training may stay with the
schedule (any agent who is working that shift would attend that training). The selections are:
• Delete (deletes the trade proposal)
• Do not trade (denies the trade proposal)
• Keep with agent
• Keep with schedule (default).

Associating and Disassociating Sites

1. Select a site's check box to associate it with the current time-off type.
• In the Schedule State Group drop-down list, select the group that will be associated with this

time-off type.

2. Clear a site's check box to disassociate with the current time-off type.
3. Click Save.

When associating sites, on the Associated Sites tab you can associate a time-off type with a
Schedule State Group. The site's Schedule State Groups drop-down list is enabled when you check
a site. It contains all Schedule State Groups under the selected site.

If a Schedule State Group with an associated Fixed State Exception exists for the selected site, this
Schedule State Group is selected by default in the Schedule State Group drop-down list when you
check this site.
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Time-Off Rules
Time-off rules control how the agent's time-off hours are accrued/awarded and define the options for
time-off requests. For example, you might set different accrual rates for paid time off depending on
how long an agent has been employed.

Use the Time-Off Rules panes to:

• Create and edit time-off rules includes setting Properties and Rules for Requests
• Delete time-off rules
• Copy time-off rules
• Associate agents and time-off types with a time-off rule

You can configure:

• Multiple time-off rules for each time-off type
• A single time-off rule for multiple time-off types
• A single time-off rule for one time-off type

How Time-Off Rules Work

The following points explain how time-off rules work:

• Time off can be either accrued or awarded.
• If you change a time-off rule, the agent's carry-over time-off hours for that time-off type are calculated

immediately, and the new rule applies from the time of the change. Time-off rules can change during
configuration of the site, the agent, or the time-off rule.

• If agents with time-off rules for one or more time-off types are transferred to a different site during
synchronization, the time-off rules associated with the agents remain, but they are no longer active. To
enable agents to continue to accumulate time off, you must manually assign agents time-off rules for
the new site. When WFM calculates carry-over for these agent, it calculates the time off at the old rate
until the End Date and at the new rate from the End Date until the Carry-Over date.

Tip
Time-Off carry-over occurs automatically by default. You can turned it off in the WFM Server Application
Options.

• If an agent becomes unassigned (is no longer associated with a site) he or she keeps the assigned time-
off rules. However, WFM sets the date, on which the agent was removed from the site as the End Date,
and time off is accrued, based on the rules from the former site only up to that date. The agent can
continue to accrue time off, only if you assign the him/her to a site and assign another time-off rule.
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• If an agent is unassigned from a time-off rule for any time-off type (by setting the End Date for this
time-off rule) and is not assigned this time-off type by any other time-off rule (no other record exists
with a Start Date for this time-off type) then the agent can request time off for this time-off type but
the balance is no longer accrued.

Tip
To understand how time-off rules or constraints affect agent preferences, see
Preference Statuses.
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Configuring Time-Off Rules
The Time-Off Rules panes, which include Properties, Rules for Requests, and Assignments, enable you
to create, edit, delete, and copy time-off rules, configure rules for requests, and assign time-off rules.

Creating Time-Off Rules
Link to video
To create a time-off rule, watch the video and/or follow this procedure:

1. In the Time-Off Rules pane, click New .
The Properties pane opens.

2. Configure the Time-Off Rules Properties, as required.

3. Click Save Now .

Next Steps:

• Configure rules for time-off requests. See Rules for Requests and part 2 of this video series.
• Assign agents and time-off types to this rule. See Assigning Time-Off Rules and part 3 of this video

series.

Time-Off Rules Properties

You can configure the following properties for Time-Off Rules:
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• Name—Accept the default name or enter a different name. The name must be unique within the site.
• Type—Select one of two types:

• Accrued—A certain number of time-off hours accumulate for each period worked.
• Awarded—A set amount of time off given for the year.

For example, paid time off is usually accrued, whereas holidays are awarded.

Tip
The Type field is enable only when the time-off rule is created. Thereafter, it is read-
only.

• Ignore accrual settings (resulting in unlimited balances, if this rule is used)—Select this check
box to disable:
• All other controls in the Properties pane.
• The Estimated daily paid hours and Estimated weekly paid hours in the Rules for Requests pane.

Default setting: cleared (disabled).
Use the default setting for special circumstances, such as sick days, that are subject to
time-off limits but do not count against an agent's time-off balance.

Tip
The Limit the total number of requested time-off hours, if setting is related to
time-off balances. It works for both awarded and accrued rules when WFM calculates
the balance. When the Ignore accrual settings (resulting in unlimited balances,
if this rule is used) setting is checked, WFM does not calculate the balance.
Therefore, there's no limitation for the affected period. When both of these settings
are checked, you might see the error message: Agent has accrual rule but ignore
balance check is selected. To avoid this error, uncheck the Ignore accrual settings
(resulting in unlimited balances, if this rule is used) setting and set a higher
number of hours for the rule, instead of an unlimited balance.

• Number of hours earned—Enter the number of hours that can be accrued every period in the hh:mm
format.

• For every—Enter a number for how often the specified hours are accrued and then select the unit for
the number (hours, days, weeks, months, or years) from the drop-down list.

Tip
Awarded time off must be entered as x hours per 1 Year. You cannot select any other
period. Synchronization can affect an agent's time-off accrual. If agents with time-off
rules for one or more types of time off are transferred to a different site during
synchronization, the time-off rules remain associated with the agents, but they are no
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longer active. You must manually assign time-off rules that are configured for the new
site to the agents.

• Limit the time-off balance to the following value—Select this check box to set a limit to the total
number of time-off hours an agent can accumulate.

• Hours that can be carried over to the next year—Enter the number of time-off hours that can be
carried over into the next yearly period. At carry-over, bonus and accrued time-off hours are combined
and the allowed number of hours is carried over to the next year. Hours above the allowed carry-over
number are deleted. The default number of carried-over hours is 0.

Tip
The current time-off period is determined either by the most recent carry-over date or,
if no prior carry-over date exists, by the agent's date of hire. In cases where an agent
has worked for several years with no carry-over calculation, time-off balances are
calculated by taking into consideration each year the agent has worked. To apply
bonus time-off hours to the current year, the agent must have had time-off carry-over
calculated at the most recent carry-over date. If you have already applied bonus hours
and the carry-over date is not current, you can perform a carry-over calculation, at
which time the bonus hours will be converted to carry-over hours. When performing
this update, make sure that the number of carried-over hours allowed is large enough
to accommodate all bonus hours to be carried over.

• Hours that can be taken in advance per year—Enter the number of time-off hours the agent can
take in advance each year. These hours are offset by the hours accrued. This setting is disabled for
awarded time-off rules.

• Apply rule on hire date (if not checked, rule becomes applicable after the period below, starting on
the hire date)—Select this check box to specify that the agent accrues time off from the date of hire. If
disabled, time off is accrued beginning on the date when time off can be requested as set in the Time
off can be requested after this period expires (after the hire date) field.

• Time off can be requested after this period expires (after the hire date)—Enter the number of
weeks or months the agent has to work after the hiring date before he or she can enter a time-off
request.

• Carry-over day—Enter a date that signifies the end of a period when carry-over days become
applicable and a new time-off accrual period starts. It can be any day and month.

Tip
• The Carry-Over Day is applied to all agents who are assigned this time-off rule. The

last carry-over date for all agents is updated to the date you select in the Carry-Over
Day field.

• Time-off days can be requested or granted only if they are after the last carry-over date.
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• Calculations of carry-over cannot be reversed.
• Carry-over calculations apply from the last carry-over date or the agent’s date of hire,

whichever is more recent.

Editing Time-Off Rules

To edit a time-off rule:

1. In the Time-Off Rules pane, select the rule you want to edit.
2. Make the appropriate changes to the Properties and Rules for Requests pane settings.

3. Click Save Now .

Tip
Editing time-off rules changes the way accrued hours are calculated by WFM. Changes
affect time-off balances of all agents associated with the rule, but not the historical
records of agents’ time-off balance calculated by the carry-over process.

Deleting Time-Off Rules

To delete a time-off rule:

1. In the Time-Off Rules pane, select the rule you want to delete.

2. Click Delete .
3. When the Confirmation dialog appears, click Yes to proceed or No to cancel the action.

Copying Time-Off Rules to Sites

To copy a time-off rule:
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1. In the Time-Off Rules pane, select the rule you want to copy.

2. Click Copy .
3. In the Copy Time-Off Rule pane, enter a new name for the rule.
4. Remove the check mark from the Copy to the same Site check box if you want to copy the rule to

site, other than the selected one. Otherwise, leave it checked.
5. If you removed the check mark, select the site to which you want to copy this rule.

6. Click Save Now .
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Rules For Requests
The Rules for Requests pane, enables you to configure rules for time-off requests.

Configuring Rules for Requests
Link to video
To configure rules for time-off requests, watch the video and/or follow this procedure:

1. In the Time-Off Rules Properties pane, click Rules for Requests.
2. Configure the rule settings below.

3. Click Save Now .

Next Step:

• Assign agents and time-off types to this rule. See Assigning Time-Off Rules and part 3 of this video
series.

Rules for Requests Settings

• Paid hours in full-day time off—Enter the number of paid hours in a full day time-off period. (If you
enter 0, paid hours for full-day time off items are not defined.)

• Estimated daily paid hours—This value is enabled only if you left the Ignore accrual settings check
box in the Properties pane unchecked. It is used only if you selected Hours or Days in the For every
drop-down list for Number of hours earned. WFM Server uses this value when estimating an agent's
time-off balance for dates when no schedule is available. Therefore, under normal circumstances, it
should match the contract Standard Daily Paid Hours for agents who are assigned this time-off rule and
have contracts associated with them. If an agent has no contract, you can enter any number of hours.

• Estimated weekly paid hours—This value is enabled only if you left the Ignore accrual settings check
box in the Properties pane unchecked. It is used only if you selected Hours or Days in the For every
drop-down list for Number of hours earned. WFM Server uses this value when estimating an agent's
time-off balance for dates when no schedule is available. Therefore, under normal circumstances, it
should match the contract Standard Weekly Paid Hours for agents who are assigned this time-off rule
and have contracts associated with them. If an agent has no contract, you can enter any number of
hours. You can configure this text box down to a one-minute time unit.

• Automatically approve time-off requests if:
• Request is made by the following number of weeks in advance—Select and complete to

enable WFM to automatically grant time off that an Agent requests through WFM Web, provided the
request meets the Week(s) and Hours specifications in Minimum requested time off.
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• Minimum requested time off is—Enter minimum hours and minutes for time-off requests.
(Automatic Approval is also known as auto-granting.)

• Prevent agent time-off request if:
• Request is made by the following number of days in advance—Enter the number of days that

an Agent can request time off in advance.

• Issue warnings for time-off requests if: (Checking this box effective prevents agents from making
these requests.)
• Request is made by the following number of days in advance—Enter the number of days an

agent can request time off in advance before a warning is issued.
• Requested number of continuous time-off days in this request is less than the following

value—Enter a number for the minimum continuous time-off days an agent is allowed before a
warning is issued.

• Limit the total number of requested time-off hours, if:
• Maximum number of hours that can be requested are—Specify the number of days in

advance that can be requested.
• Applicable time period for this limitation is—Enter a time period for this limitation. Use this

rule to ensure fairness, for example in vacation usage by restricting requests until every agent has
reserved at least some vacation time. Also:
• You can modify these rules at any time. Your change does not affect existing items, but it does

affect all subsequent agent or supervisor actions.
• You are restricting time-off usage, not time-off accrual.
• Agents cannot request more time off than is allowed during the restricted period. But a

supervisor requesting more time off than is allowed will receive a warning and will be able to
override the restriction.
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Assigning Time-Off Rules
Use the Time-Off Rules Assignment pane to assign agents and time-off types to a time-off rule.

Associating Agents and Time-Off Types to Rules

To associate agents and time-off types to time-off rules, watch the video and/or complete this
procedure:

Link to video
1. In the time-off rules Assignments pane, click Associate Agents and Time-Off Types with this rule

.
2. Enter a Start Date and End Date for this rule assignment.

3. Click Add Agent(s) to a Time-Off Rule .
A pane containing a list of available agents opens.

4. Select one or more agents to associate with this rule and then, click Apply .
The selected available agents are moved to a list of assigned agents.

5. In the Time-Off Types section, click Add Time-Off Types to a Time-Off Rule .
Another pane opens, enabling you to select from a list of time-off types.

6. Select one or more time-off types and click Apply .
The selected time-off types are moved to a list of assigned time-off types.

7. In the Associate following agents and time-off types with rule pane, click Apply again.

Disassociating Agents and Time-Off Types

To disassociate agents and time-off types to time-off rules:

1. In the assigned agents and time-off types lists, select the items you want to disassociate from this rule.

2. Click Remove Agents and Time-Off Types association from this rule .
3. When the confirmation dialog appears, click Yes to proceed or No to cancel the action.
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Associating Agents Based on Hire Dates

Use the following procedure to perform bulk assignments of time-off rules, based on the agents' hire
date.

1. In the time-off rules Assignments pane, click Associate Agents and Time-Off Types with this rule

.
2. Enter a Start Date and End Date for this rule assignment.

3. Click Add Agent(s) to a Time-Off Rule .
A pane containing a list of available agents opens.

4. Click Sort and choose Hire Date.

5. Select one or more agents to associate with this rule, based on the hire date and then, click Apply .
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The selected available agents are moved to a list of assigned agents.
6. To assign time-off types, complete steps 5-7 in the procedure above.

When selecting Hire Date in the Sort menu, you can toggle it to display in ascending or descending
order, or toggle it in the column header.

To select multiple rows in lists, use the Shift+Space keys on the keyboard, or hold down the Shift key
and use your mouse. Simply hold down the Shift key and either click the first and last row you want
to select or click each row, one after the other.
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Meetings
Use the Meetings view to create, edit, copy, or delete meetings, or to assign attendees to meetings.

Important
To configure objects and change settings in the Meetings view, you must have the
appropriate role privileges. See Policies Role Privileges.

Planner vs. Scheduler

Use the Meeting Planner (described here) to create and configure meetings that you know about in
advance. It is especially useful for recurring team meetings or coaching sessions. Meetings that are
created in the Meeting Planner are taken as inputs during schedule building.

Use the Meeting Scheduler to create ad hoc meetings and insert them into a schedule that has
already been built. Access the Meeting Scheduler feature in WFM Web Supervisor from within the
Intra-Day Schedule view or Agent-Extended Schedule view.

Meetings Pane

The toolbar above the Meetings pane contains the following controls:

New
Creates a new meeting, which begins by opening
the Properties tab.

Delete

Removes the selected meeting. This command
cannot be undone. A Confirmation dialog enables
you to cancel or continue. This command is not
enabled if the meeting contains one or more
agents who are not visible to the current user
(because of a lack of permissions).

Copy
Enables you to copy the selected meeting to create
a new one.

Filter
Filters the Meetings list by agent or team. See
Filtering Agents and Teams.

Sort
Sorts the Meetings list in ascending or descending
order. (You can also click the Meetings column
header to sort the list.)

This pane also includes a Search field and Help icon.
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Meetings View Settings

You can configure settings in three tabs in the Meetings view (after clicking New or selecting an
existing Meeting):

• Properties Tab
• Participants Tab
• Associated Sites Tab

At the top of all three tabs you will find the Save icon, which enables you to save the meetings

settings in a particular tab, and the Help icon.

Properties Tab

• Name—The name of this meeting, for example, Sales Meeting or Monthly Review. The name must be
unique within all sites associated with the meeting. You can also add a memo in this field, Memos in
Meeting Exceptions in the Workforce Management Administrator's Guide.

• Exception Type—You can base a meeting on any exception type that is configured for the current site
if you selected the Exception Usage: in Meeting Planner option when creating exception types.

• Earliest Date and Time—A proposed time at which Scheduler can assign the meeting to start.
• Latest Date and Time—A proposed time at which Scheduler can assign the meeting to end.
• Meeting Duration—The length of time that Scheduler should allot for the meeting.
• Days of the week—The days of the week on which Scheduler can assign this meeting.
• Time Zone—The time zone to use when displaying any time-related information. Set by default to

local (current user's time zone.)

Meeting Type section: Select one of the following three radio buttons to enable the properties that
are associated with them:

• Single Agent—A common activity, such as a webinar, that can occur at the most convenient time for
each agent.

• Single Group—The default meeting type. Represents a single meeting for all agents who are specified
on the Participants tab.
• Enter or select the meeting's minimum number of attendees requirement in the Required

Percentage of attendees box. Set this value to 1% to schedule a meeting for as many attendees
as possible. Using 1% does not require a minimum number of attendees. The default value is 100
percent.

• Multiple Groups—A common time, but for multiple groups. Enter or select a number in each of the
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following fields to specify the group sizes:
• Min. Number of Groups
• Minimum Group Size
• Max. Number of Groups
• Maximum Group Size

Recurrence: section: Select one of the following five radio buttons to enable the properties that are
associated with them:

• Use Total Hours—The total meeting hours. When you specify this optional parameter, Scheduler
creates as many meetings with the defined duration as necessary, to satisfy the Total Hours
requirement. For example, if the meeting duration is set to two hours, and Use Total Hours is set to
six hours, Scheduler generates three two-hour meetings. Scheduler can assign these meetings
consecutively.

Tip
The value of Use Total Hours is not used for Multiple Groups meetings.

• Daily—Occurs once a day.
• Weekly—Occurs once a week (unless a value other than 1 is entered in the Recurs Every setting).

• Recurs Every—Defines how often the meeting should recur. Examples: 1 (every week), 2 (every
other week), 3 (every third week).

• Monthly—Occurs once a month.
• Set Number of Times instead of Latest Date—If you select Daily or Weekly for the Recurrence

type, set a value for the number of consecutive days or weeks during which this meeting should be
scheduled. If you check this box and enter a value, a red asterisk and comment appears below the
Latest Date and Time option, indicating that latest date is being overwritten by the Number of
Times setting.

Tip
WFM requires that either Number of Times or Latest Date be set, not both.
The current date will be displayed in the Latest Date field but this value will not be used to schedule
meetings. The Latest Time value will be used for scheduling meetings when either Latest Date or
Number of Times is set.

Even though values can be set in all fields, only values for the appropriate meeting
type are used for scheduling. For example, Required Percentage of attendees will
be used only for Single Group meetings.
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Participants Tab

Use these controls when you are adding participants to the meetings:

Search field
Enables you to enter criteria, used to search for
available agents.

Search by:
radio buttons

Enables you to search for available agents by First
Name or Last Name.

Add Agents
Enables you to add agents to the Participants list,
by opening a list of Available Agents.

Remove Agents
Removes selected agents from the Participants
list. This action cannot be undone.

Sort
Sorts the participants list by First Name, Last
Name, Site, or Team.

The Participants tab also displays four columns: First Name, Last Name, Site, and Team name of
the participants in the selected shared transport.

List of Available Agents
The Available Agents pane contains the following fields and controls:

Search field
Enables you to enter criteria, used to search for
available agents.

Search by:
radio buttons

Enables you to search for available agents by First
Name or Last Name.

Apply
Applies the agents you select from the Available
Agents list to the Participants list.

Filter
Enables you to filter the Available Agents list by
Activities, Multi-Site Activities, or Contracts.

Close
Closes the Available Agents pane without
applying any selections.

Sort
Sort the available agents by First Name, Last
Name, or Team.

Associated Sites Tab

1. Select the check box of each site to associate with the current meeting.
2. Clear the check box of each site to disassociate from the current meeting.
3. Click Save.
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Managing Meetings
Use the procedures in this topic to create, edits, delete, copy, and add participants to meetings.

Creating Meetings
Link to video
To create a meeting:

1. In the Policies module, select Meetings.
2. Select a site or business unit (this action selects all indented sites beneath it) on the Objects pane.

3. Click New .
The Properties tab opens, by default.

4. Configure the settings, as described in the Properties, Participants, and Associated Sites tabs, as
required.

5. Click Save .
The new meeting appears in the Meetings pane.

Adding Participants to Meetings

To add participants to a meeting:

1. In the Meetings pane, select a meeting and then, click the Participants tab.

2. Click Add .
3. In the Available Agents pane, select one or more agents.

Tip
You can also filter, sort, or search agents in the list of available agents.

4. Click Apply .
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The selected agents move to the Agents list in the Participants pane.
Alternatively, you can click Close to close the pane without saving your selections.

Important
• Agents can appear in only one pane at a time.
• Only agents from the meeting site are available for selection.
• When a schedule that includes the meeting time is generated, Scheduler verifies that

enough agents are available to satisfy the Minimum Percentage requirement and
then assigns the meeting exception to the available agents. If too few agents are
available, Scheduler generates an error message and does not schedule the meeting.

Editing Meetings

To edit a meeting:

1. In the Meetings pane, select the meeting you want to edit.
2. Click any one of the three tabs (Properties, Participants, or Associated Sites) to change its

settings.

3. When you are finished making changes, click Save .

Deleting Meetings

To delete a meeting:

1. In the Meetings pane, select the meeting you want to delete.

2. Click Delete .
3. When the Confirmation dialog opens, select Yes to proceed or No to cancel the action.

If you select Yes, the meeting is deleted and the action cannot be undone.
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Copying Meetings

To copy a meeting:

1. In the Meetings pane, select the meeting you want to copy.

2. Click Copy .
3. When the Copy Meeting pane opens, enter a name for the meeting.
4. In the bottom half of the pane, click the Enterprise list and select the business unit and site, to which

you want to associate this meeting.

5. Click Apply .
Alternatively, you can click Close to close this pane and cancel the action. If you do this,
the meeting is not copied.
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Filtering the Available Agents List
When you are adding participants to a meeting and there is a large number of agents to select from,

you might want to use the Filter (found at the top of the Available Agents pane) to easily
group them by Activities, Multi-Site Activities, or Contracts.

After you create one or more filters, they appear as bullets above the Available Agents list. If only
one item is selected for the filter, the bullet shows the selected item's name. If more than one item is
selected, the bullet shows the number of items in the filter.

When you click Filter in the Available Agents pane, you will see three tabs, all of which have
the following controls:

Common Controls

Apply
Applies the selected items in a list (activities, multi-
site activities, or contracts).

Close
Closes the Filter pane without applying the
selected filter conditions.

Add
Opens a pane containing a list of items for
selection (depending on the tab you selected:
Activities, Multi-Site Activities, or Contracts).

Remove
Removes any previously selected items from the
Filter by.. list.

Search field
Uses search criteria to quickly find items in long
lists.

Sort

Enables various sort options, depending on the list
of items you are sorting:

• For activities, sort by Activities or Type
• For multi-site activities, sort by Multi-Site

Activities or Type
• For contracts, sort by ascending or descending

order

Filtering Agents by Activities
Link to video
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1. In the Available Agents pane, click Filter .
The Filter by.. pane opens with the Activities tab selected by default.

2. In the Filter by Activities pane, click Add .

3. When the list of activities opens, select one or more activities, and click Apply .
4. In the Activities tab, if the filter contains all selected activities, click Apply again.

5. To remove an activity from the filter, click Remove before applying the filter.

6. To close this pane without applying any of the selected items, click Close .
The filter now appears at the top of the Available Agents pane.

Filtering Agents by Multi-Site Activities

1. In the Available Agents pane, click Filter .
The Filter by.. pane opens with the Activities tab selected by default.

2. Click Multi-Site Activities.

3. In the Filter by Multi-Site Activities pane, click Add .

4. When the list of multi-site activities opens, select one or more activities, and click Apply .
5. In the Multi-Site Activities tab, if the filter contains all selected activities, click Apply again.

6. To remove an activity from the filter, click Remove before applying the filter.

7. To close this pane without applying any of the selected items, click Close .
The filter now appears at the top of the Available Agents pane.

Filtering Agents by Contracts

1. In the Available Agents pane, click Filter .
The Filter by.. pane opens with the Activities tab selected by default.

2. Click Contracts.

3. In the Filter by Contracts pane, click Add .4.
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When the list of contracts opens, select one or more contracts, and click Apply .
5. In the Contracts tab, if the filter contains all selected contracts, click Apply again.

6. To remove a contract from the filter, click Remove before applying the filter.

7. To close this pane without applying any of the selected items, click Close .
The filter now appears at the top of the Available Agents pane.

Viewing and Removing Filters

Filters appear at the top of the Available Agents list, which now contain only the filtered items. You
can see the contents of a filter in two ways:

• Click the filter to open a list of them.
• Hover your cursor over the filter to see a pop-up that displays them.

For example, in the figure below the user clicked the Activities (2) filter, which opened the Filter by
Activities pane listing the items in that filter.

To remove a filter without opening it, click the X in the bullet itself.

Figure: Filter Bullets in Meetings View
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Marked Time
Use Marked Time to identify periods that WFM should track and display that are not already
accounted for. For example, some agents might each work a number of hours on an issue involving
one account. By using marked times, you can designate that those hours spent working on that issue
be displayed in the Schedules module and reported on, using the Schedule Marked Time Report and
Schedule Marked Time Totals Report that are generated in WFM Web's Reports module.

Use the procedures in this topic to create, edit, delete, and copy Marked Time.

Creating Marked Time
Link to video
To create new Marked Time:

1. In the Policies module, select Marked Times.
2. In the Objects pane, select the site(s) or business unit with which the new object will be associated.

You can select multiple sites (just keep clicking on them) but only one business unit.

3. Select New .
The Properties tab opens by default.

4. Configure the Properties tab.
5. Click the Associated Sites tab and select the sites you want to associate with this Marked Time.

6. Click Save .

Editing Marked Time

To edit Marked Time:

1. In the Marked Times pane, select a marked time.
2. Select the Properties tab and/or the Associated Sites tab, and make the changes.

3. Click Save .
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Deleting Marked Times

To delete Marked Time:

1. In the Marked Times pane, select a marked time.

2. Click Delete .

Copying Marked Times

To copy an existing Marked Time:

1. In the Marked Times pane, select an existing Marked Time.

2. Click Copy .
3. When the Copy Marked Time pane opens, type a name for the Marked Time.
4. Expand the Enterprise list and select the site, to which you want to associate this Marked Time.

5. Click Apply .

Properties Tab

• Name—Each Marked Time should have a descriptive name that is unique within the site.
• Short Name—The name to be used in graphical representations of the Marked Time and Scheduler. It

can be up to three characters.
• Special Uses—Select one of three radio buttons:

• None—This marked time has no special uses (default).
• Use for overtime—This marked time is to be used to mark overtime schedule states.
• Use for payback—This marked time is to be used to pay back work time that was missed, due to

(agent's) lateness or a personal appointment.

Associated Sites Tab

1. Select the check box of each site to associate with the current Marked Time.
2. Clear the check box of each site to disassociate with the current Marked Time.
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3. Click Save.
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Shifts
A shift defines basic workday parameters. Shifts are defined by time of day, duration, and days of the
week. Create, copy, edit, and delete shifts by clicking Policies > Shifts and selecting the
appropriate business unit and site on the Objects pane.

Creating New Shifts
Link to video
You can create a new shift or copy an existing shift to create a new one. To create a new shift:

1. Go to Policies > Shifts.
2. In the Objects pane, select the Business Unit and then, the Site, in which you want to create the

shift.

3. Click New .
The new shift appears on the Shifts pane. with the default name.
The default name includes a number to ensure that each shift has a unique name in the
Configuration database. You can change this name, but it must remain unique to prevent
duplicate name errors from occurring.

4. Configure the shift properties.

Copying Shifts

To copy an existing shift:

1. Select a shift.

2. Click Copy .
The Copy Shift <shift_name> pane opens.

3. In the Name field, enter a name for the shift.
The Copy to the same Site check box is checked, by default.

4. If you choose to uncheck the Copy to the same Site check box, select the BU and then, the Site, in
which you want to create the shift ( see the figure below).
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Figure: Copy Shift

5. Click Save Now .
The new shift appears on the Shifts pane under the selected Site.

6. Change the shift properties, if necessary.

Use the following panes to configure the new shift:

• Shift Properties
• Shift Contracts
• Task Sequences
• Shift Sequences

Editing Shifts

To edit a shift:

1. On the Shifts pane, select the shift you want to edit.
2. Make the necessary changes in each pane.

3. Click Save Now .

Deleting Shifts

To delete a shift:

1. On the Shifts pane, select the shift you want to delete.
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2. Click Delete .

Shift Number Limitation During Building

The maximum number of shifts that can be configured when building schedules is 100 shifts.

Count all the agents configured for your schedule scenario, all their different contracts, and all the
different shifts associated with those contracts. The total number of shifts cannot exceed 100. If it
does, your build will fail, and WFM will display Error 43: Too many shifts: the maximum number
is 100, but more than 100 were requested.

Tip
You can configure more than 100 shifts in your WFM database; the limitation is that
you cannot associate more than 100 shifts with a single schedule.

Use Rotating Patterns to Solve a "Too Many Shifts" Problem
A contact center might configure a very large number of shifts, because the managers believe that
multiple shifts are the only way to create fixed schedules. However, rotating patterns can
accommodate many different types of schedules, including both fixed and flexible schedules, using
very few shifts. For example, you could create weekly rotating patterns to configure a fixed schedule
that uses just one shift. For more information see Rotating Patterns.
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Shift Properties
Use the Shifts Properties pane to define the general shift parameters. By default, this pane opens
when you select a shift in the Shifts pane.

Name Field

The name for this shift. Use names, such as First Shift, Swing Shift, or Second Shift, that identify the
shift type. The name must be unique within the site.

Time and Duration

• Min. Paid Hours—The minimum number of hours defined for this shift, entered in hh:mm format. All
contracts assigned to the shift must be available to work at least this number of hours. Valid values are
00:01 to 23:45. This value must be less than or equal to the Maximum Daily Paid Hours setting in
the associated contract. Must include all paid breaks and meals.

• Max. Paid Hours—The maximum number of hours defined for this shift, entered in hh:mm format. Valid
values are 00:01 to 23:45. This value must be greater than or equal to the Minimum Daily Paid
Hours setting in the associated contract. Must include all paid breaks and meals.

• Earliest Start Time—The earliest time that this shift can start. Some sites stagger shifts so that, for
example, all third-shift agents arrive between 7:15 and 8:15. The earliest start time for this shift would
then be 7:15.

• Latest End Time—The latest time that this shift can end. Shift agents can end their shift at staggered
intervals that correspond to the stagger at the beginning of the shift. For example, a shift that starts
between 7:15 and 8:15 can end between 3:15 and 4:15. The latest end time for this shift would then be
4:15.

• Next Day—When this check box is checked, indicates that this shift can end during the next day.
• Start Step—If using staggered start times for various agents working a shift, the Start Step is the

increment of time between possible shift start times. Scheduler uses this Start Step to configure
agent schedules. The start step can be any number of minutes between 1-120.

Important
The Earliest Start Time's last two digits must be either :00 or an even multiple of the
Start Step entry; otherwise, Scheduler disregards the Start Step entry and defaults
to a Start Step of 15 min. For example: If you set an Earliest Start Time of 9:15
and a Start Step option of 30 minutes, the Scheduler disregards the Start Step
entry (because 15 is neither equal to nor a multiple of 30), and starts shifts at 9:15,
9:30, 9:45, 10:00, and so on.
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Use the following optional time settings to narrow the range of time during which the start or end of
the shift can be scheduled. You can create a fixed start or end time for the shift. For example, to set a
fixed start time, set the Latest Start Time field to the same time as the Earliest Start Time field.
The total shift duration then remains flexible.

Important
If you set fixed start and end times for your shift, the shift will be too inflexible to
create optimal schedules.

• Latest Start Time—The latest time that this shift can start. Some sites stagger shifts so that, for
example, all third-shift agents arrive between 7:15 and 8:15. The latest start time for this shift would
then be 8:15.

• Earliest End Time—The earliest time that this shift can end. Shift agents can end their shift at
staggered intervals that correspond to the stagger at the beginning of the shift. For example, a shift
that starts between 7:15 and 8:15 might end between 3:15 and 4:15. The earliest end time for this shift
would then be 3:15.

Available Days of Week

The days of the week for which this shift can be assigned by the scheduling algorithm. By default, all
days are selected.

Distribution:

• Min.—The minimum number of occurrences of the shift for each agent whose contract is associated
with the shift.

• Max.—The maximum number of occurrences of the shift for each agent whose contract is associated
with the shift.

• Applies To—The period of time for which Scheduler should apply the distribution minimum and
maximum.
• Disregard—Distribution properties are not applied.
• Every Week—The Min./Max. are considered on a weekly basis. Amounts entered should equal the

numbers required for one week.
• Schedule Planning Period—Distribution properties are applied to the schedule planning period.

Distribution amounts entered should equal the numbers required for the entire schedule planning
period.

Days-Off Rule

The rules that can be defined for the days off that are associated with the shift:
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• No Rule means there are no rules about days off.
• There are three possible day-off rules:

• Next day—If agents work this shift, they get the next day off.
• Previous day—If agents work this shift, they get the previous day off.
• Next day is not off—If agents work this shift, they cannot get the next day off.
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Shift Contracts
Use the Shifts > Contracts pane to assign contracts to a shift. You opened this pane, by clicking
Contracts at the top of the Shift Properties pane.

Important
Assigning contracts to a shift is optional. You can save a shift without associating it
with a contract.

Assigning a Contract to a Shift

To assign a contract to a shift:

1. In the Shifts pane, select a shift.
2. In the right-side pane, select Contracts.

3. Click Assign a Contract to a Shift .
4. In the Use This State for Assignments drop-down list, select the appropriate state.
5. Select one or more contracts from the list on the Contract Associations pane. You can assign multiple

contracts to a single shift.

6. Click Apply to move the selected contracts into the Contracts pane.

7. Click Save Now .

Removing a Contract from a Shift

To unassign or remove a contract from a shift:

1. In the right-side pane, select Contracts.
2. In the Contracts list, select the contract you want to remove.

3. Click Remove Contract from Shift .
4. When the Confirmation dialog appears, click Yes.
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Changing the State of an Assigned Contract

To change the state of an assigned contract:

1. In the Contracts pane, use the State drop-down menu for the Contract you want to change and
select Primary (default) or Secondary.

2. Click Save Now .

Tip
• Assigned contracts appear only in the Contracts pane.
• To select multiple contracts, hold down SHIFT or CTRL and click each additional

contract.
• Each assigned contract has a state: Primary or Secondary. The default state after

being moved is Primary.
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Task Sequences
Task sequences define periods of time during which agents can work only on a specified set of tasks
that are then configured as one or more Activity Sets. Time that is not included in a task sequence
can include any work that the agent has the skills to perform and which is not part of any configured
Activity Set. For examples and more detailed information about task sequences, see the Workforce
Management Administrator's Guide.

Use the Shift > Task Sequences pane to create, edit, or delete task sequences or to assign task
sequences to the shift, but note the following:

• Although you create task sequences during configuration of a particular shift, after they have been
created you can assign task sequences to any compatible shift within the same site.

• To be compatible, task sequence settings must not conflict with meal settings.
• Task sequences are optional. However, if any task sequences are defined for a shift, the shift must

include at least one task sequence. Make one of three selections in the Task Sequences Usage drop-
down list, as shown in the figure below.

Figure: Task Sequences Usage Settings

Creating a Task Sequence

To create a task sequence:

1. At the top of the Shift Properties pane, select Task Sequences.
The Task Sequences pane opens.

2. Select a setting from the Task Sequences Usage drop-down list (see figure above).
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3. Click Add to open the Task Sequence Items window. See Adding and Editing Task Sequences for
information about configuring the new task sequence.

Assigning Task Sequences to a Shift

After you have created and saved your task sequences, you can assign them to a shift. To assign a
task sequence to the shift:

1. In the Shifts pane, select the shift for which you want to apply a task sequence.
2. In the Task Sequences Usage drop-down list, choose either Task Sequences must be used or Task

Sequences can optionally be used.
If you choose to retain the default setting Do not use Task Sequences, none are assigned.

3. In the Task Sequences pane, select a task sequence.

4. Click Save Now .

Removing a Task Sequence from a Shift

To remove a task sequence from a shift:

1. In the Shifts pane, select the shift for which you want to delete a task sequence.
2. In the Task Sequences list, select the task sequence.

3. Click Delete .
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Adding and Editing Task Sequences
Use the Task Sequences pane controls to create and edit task sequences.

Search field
Enter the search criteria. For example, the name of
the task sequence.

Apply Click to apply an this task sequence to a shift.

New Click to create a new task sequence

Delete Click to delete an existing task sequence.

Close Click to close the Task Sequences pane.

Help
Click to view a Help topic about the Task
Sequences pane.

Use the following controls in the Task Sequence Items pane:

Save Changes Click to save changes you have made in this pane.

Add Activity Set Click to add an Activity Set to the task sequence.

Add Work Item Click to add a Work item to the task sequence

Delete Row Click to delete an existing row.

Move Up Click to move a selected row up one row.

Move Down Click to move a selected row down one row.

Close Click to close the Task Sequence Items pane.

Help
Click to view a Help topic about the Task
Sequence Items pane.

What is a Work Item?

A Work item is work that can be done in between tasks in Task Sequence or in between the task and
the start/end of the shift. Add work items to task sequences only if tasks are not anchored to one
another. Use the following guidelines:
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• If a Work item is added before the task, it means the task is not anchored to the start of the shift or the
previous task.

• If a Work item is added after the task, it means the task is not anchored to the end of the shift or the
following task.

• If a Work item is not added before the task, it means the task is anchored to the start of the shift or the
previous task.

• If a Work item is not added after the task, it means the task is anchored to the end of the shift or the
following task.

Adding a Task Sequence

1. In the Task Sequence Usage pane, click Add Task Sequence Association With Shift.
2. In the Task Sequence pane, do one of the following:

• Select an existing task sequence and then proceed to step 7.
• Click New Task Sequence.

The Create New Task Sequence pane opens.

3. In the Task Sequence Name field, enter a name to replace the default name.
The name must be unique within the site.

4. Click Add Activity Set or Add Work Item to create a new row in the task sequence list.
5. Configure the settings as described in Task Sequence Settings. You can add as many rows as you need.

6. When task sequence configuration is complete, click Save Changes and select it in the list.

7. To assign the selected task sequence to the shift, click Apply .

8. Click Save Now .

Editing a Task Sequence

1. In the Task Sequence Usage pane, click the task sequence that is displayed in the Task Sequence
table.
The Edit Task Sequence pane opens.

2. Make your changes. If you need to add more rows to your task sequence list, click Add Activity Set

or Add Work Item .
3. When you have finished, click Apply.
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Important
The duration of the task sequence must be greater than, or equal to, the duration of
the selected activity set.

Deleting Task Sequences

1. In the Task Sequences pane, select a task sequence in the list.

2. Click Delete .

Task Sequences Settings

• Activity Set—You can use any activity set that is configured for the current site. You can use the same
activity set in any number of task sequences. For more information about activity sets, see Creating
and Deleting Activity Sets.

• Min Duration—The minimum duration, in hh:mm format, for this task sequence.
• Max Duration—The maximum duration, in hh:mm format, for this task sequence.

Important
The minimum duration of an activity set that is configured as part of a task sequence
must be less than or equal to the maximum possible duration of the shift for which
that task sequence has been configured.
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Shift Sequences
Shift items are breaks and meals. Use the Shift Items controls to create, edit, and delete breaks and
meals and to arrange them into patterns called shift items sequences.

To open the Shift Sequences pane, select a shift in the Shifts pane and in the right-side pane,
select Shift Sequences. The Shift Sequences pane has three sections: Distance Between Shift
Items, Meals and Breaks Associated with Shifts, and Shift Sequences, which are described in
the following topics:

• Configuring Shift Items
• Using Shift Sequences
• Adding and Editing Shift Sequences
• Configuring Shift Sequences

Configuring Shift Items

1. To configure Minimum Distance Between Shift Items, uncheck the Unlimited check box and enter
the time, in minutes, that must elapse between one shift item and the next.
This parameter sets the minimum required distance between meals and breaks.

2. To configure Maximum Distance Between Shift Items, uncheck the Unlimited check box and enter
the time, in minutes, that represents the maximum that can elapse between one shift item and the
next. This parameter sets the maximum allowed distance between meals and breaks, between shift
start and first shift item, and between last shift item and shift end. The initial display is 0:00; but the
control is actually disabled until you clear the Unlimited check box. Range: 00:00—36:00

Important
In the settings above, using a value of 0:00 means: Do not use this constraint.

3. To create a new meal, click Add Meal association with shift ( ).
4. To change settings for a meal, select it and then click Edit.

See Adding and Editing Meals for information about configuring meals.

5. To create a new break, click Add Break associate with shift ( ). To change settings for a break,
select it and then click Edit. See Adding and Editing Breaks for information about configuring breaks.
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Important
When you edit, delete, or change the order of meals or breaks in a shift item sequence, that sequence is
deleted.

6. Click Move Up ( ) or Move Down ( ) to arrange the breaks in the order in which you want
them to occur if more than one is included in a shift sequence.
The order of meals is fixed. You can only modify the order by changing the position of breaks around
them, using Move Up and Move Down. To change the order in which meals occur, you must return to
the Meals pane and make changes there.

Warning
Changing the order of meals on the Meals pane automatically deletes all shift sequences that include those
meals.

7. Create a Shift Sequence if you want to create a pattern of breaks and meals to apply to a shift. See
Using Shift Sequences for information on configuring new sequences or editing existing ones.

8. When you have finished configuring the shift items, click Save to save the settings or Cancel to discard
them.

Using Shift Sequences

A shift sequence enables you to arrange meals and breaks so that they occur in a specific order
during the shift.

When you create multiple shift sequences for the same shift, Scheduler first sets the shift and then
checks for compatible shift item sequences for that shift. Scheduler checks shift work duration and
meal constraints to select the optimal shift item sequence.

Important
When you edit, delete, or change the order of meals or breaks in a shift sequence,
that sequence is deleted.

Shift sequences appear in the list pane at the bottom of the Shift Sequences pane. This list shows
these shift sequence properties:

• Allowed check box:
• If checked, this shift item sequence is enabled and can be used in schedules.
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• If cleared, this shift item sequence is disabled and cannot be used in schedules.

• Min Paid Hours—The shortest period of time that can be scheduled for this shift item sequence.
• Shift Items Names—The names of the shift items that are included in the sequence and listed in the

correct order.

Adding and Editing Shift Sequences

• To create a new shift sequence, click New in the Shift Sequences section.
• To edit a shift sequence, select it in list of shift sequences.

The Shift Sequences Properties pane opens, enabling you to make changes to the meals and breaks
Shift Items list.

Configuring Shift Sequences

To configure the shift sequence:

1. After you have associated meals and breaks with a shift and saved the settings, click New in the Shift
Sequences section.
The Shift Properties pane opens.

2. Select the Allowed check box to activate this shift item sequence.
If you do not want to use the shift item sequence in schedules for a certain period of time, you can
clear this check box rather than deleting the shift item sequence. This keeps the sequence available for
when you want to use it again.

3. Enter a value in the Minimum Paid Hours field.
4. Click Add Break.

The Breaks To Be Added To The Shift Sequence pane opens.
5. In this pane, do one of the following:

• Select a break in the list and click Apply.
• Select a break in the list and click Copy. You can copy the break to the same site, by checking the

Copy to the Same Site check box, or copy it to another business unit and site within the
enterprise.

• Enter search criteria in the Search field (for example, the name of the break) to quickly find the
break you want to apply or copy.

6. Click Move Up and Move Down to change the placement of a selected item.

Important
You cannot use Move Up and Move Down to change the order of the meals. If
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moving the selected item up or down would change the meal order, then clicking
the button has no effect. To change the meal order, return to the Shift Sequence
Properties pane and make the change there. If you do so, your all shift item
sequences are deleted and you must recreate them.

7. When you have finished, click OK. To discard all changes, click Cancel.
The new or edited shift sequence appears on the Shift Sequence pane. This list is always sorted by
the value in the Minimum Paid Hours column.
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Adding and Editing Breaks
Use the Break Properties pane to define the rules for assigning breaks during a shift.

A shift can contain up to eight breaks.

Configuring Breaks

To configure a break:

1. In the Shifts pane, select the shift with which you want to associate this break.
2. In the right-side pane, select Shift Sequences.
3. In the upper-right corner of the Shift Sequences pane, click Add Break association with shift (

).
The Breaks To Be Associated With Shifts pane opens.

4. In this pane, do one of the following:

• Add a new break by selecting New . The new break is added to the list and can be assigned to
a shift.

• Create a copy of break by selecting it in the list and clicking Copy .
You can copy the break to the same site, by checking the Copy to the Same Site check box, or
copy it to another business unit and site within the enterprise.

• Delete a break by selecting it in the list and clicking Delete . The break is no longer associated
with any shift.

• Enter search criteria in the Search field (for example, the name of the break) to quickly find the
break you want to apply or copy.

5. To assign a break to a shift, select it and click Apply .
The break appears in the Meals and Breaks Associated with this Shift list.

Break Rules Properties

• Break Name—The name of the break. Use names that clearly identify the break type. The break name
must be unique within the site.

• Break Short Name—Enter a short name of up to 3 characters to identify this break. The short name
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appears in the Intra-Day and Agent Extended Schedule views.
• Schedule State Group—Select a Schedule State Group in the drop-down list.
• Duration of the Break—The duration of this break in one-minute increments, entered in hh:mm format.
• Minimum Length from Shift Start—The minimum amount of time that must pass before an agent

can start this break. Enter the duration in the format hours:minutes.
• Maximum Length from Shift Start—The maximum amount of time that can pass before an agent

starts this break. Enter the duration in the format hours:minutes.
• Minimum Length from Shift End—The minimum amount of time that must pass after an agent

returns to work from this break until the end of the shift. Enter the duration in the format
hours:minutes.

• Fixed Position—Determines whether the break has to occur at a specific point in the shift. Possible
values are None, Start of Shift, and End of Shift.

• Start Step—The increments between break start times. For example, with a start step of 15 minutes,
agents leave for the break 15 minutes apart.

• Start Offset—Sets how many minutes past the hour in the interval in which a break may occur that the
start step calculation should begin. Use Start Offset to adjust the break start to a finer granularity
than using only the start step alone. For example, if your Start Step is set to 15 and the Start Offset
to 1, then breaks could start at 12:01AM, 12:16AM, 12:31AM, and so on. Enter values in hh:mm format.

• Paid Time—When selected, the break is paid.
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Adding and Editing Meals
Create a new meal for each shift that is included in the schedule. For example, if your site operates
24 hours a day, you might need to create meals called Breakfast, Lunch, Dinner, and Swing.

Meals are always linked to a shift. These meals apply to all contracts associated with the shift. If a
conflict arises that prevents a meal from being scheduled for an agent, the shift containing the meal
cannot be assigned to the agent.

Tip
If no restrictions are involved (for example, a cafeteria with limited hours of
operation), then configure regular breaks instead of meals for each shift.

Configuring Meals

To configure a meal:

1. In the Shifts pane, select the shift with which you want to associate this meal.
2. In the right-side pane, select Shift Sequences.

3. In the upper-right corner of the Shift Sequences pane, click Add Meal association with shift .
4. When the Meals To Be Associated With Shifts pane opens, do one of the following:

• Add a new meal by selecting New . The new meal is added to the list and can be assigned to a
shift.

• Create a copy of meal by selecting it in the list and clicking Copy .
You can copy the meal to the same site, by checking the Copy to the Same Site check box, or
copy it to another business unit and site within the enterprise.

• Delete a meal by selecting it in the list and clicking Delete . The meal is no longer associated
with any shift.

• Enter search criteria in the Search field (for example, the name of the meal) to quickly find the
meal you want to apply or copy.

5. To assign a meal to a shift, select it and click Apply.
The meal appears in the Meals and Breaks Associated with this Shift list.
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Meals Properties

• Meal Name—The name of the meal. Use names, such as Lunch, Dinner, or Mid-afternoon break, that
identify the meal type. The meal name must be unique within the site.

• Meal Short Name—Enter a short name of up to 3 characters to identify this meal. The short name
appears in the Intra-Day and Agent Extended Schedule views.

• Schedule State Group—Select a Schedule State Group in the drop-down list.
• Duration of the Meal—The duration of this meal in one-minute increments, entered in hh:mm format.
• Minimum allowed duration of the Meal—The minimum allowed duration of this meal in one-minute

increments, entered in minutes. Unchecking Allow to change meal duration indicates that this
setting is not being used. The value must be less than the meal duration. Checking Allow to change
meal duration and leaving the field value at 0:00 causes an error to display.

• Earliest Start Time—The earliest time that agents can begin to take this meal. This value plus the
Duration cannot extend past the Latest End Time value.

• Latest End Time—The latest time that agents can complete this meal.
• Start Step—The increments between meal start times. For example, with a start step of 15 minutes,

agents leave for lunch 15 minutes apart.
• Paid Time—If selected, this meal is paid. If cleared, this meal is unpaid.

Qualification

• Min Time Before This Meal—The minimum amount of time after the shift start time before agents are
allowed to take this meal. For example, agents might be required to work for at least two hours before
the meal. Enter the duration in the hh:mm format. The time before a meal can include breaks or other
meals.

• Min Time After This Meal—The minimum amount of time between the meal and the shift end time.
For example, agents might be required to work for at least four hours after the meal. Enter the duration
in the hh:mm format hours:minutes. The time after a meal can include breaks or other meals.
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Contracts
Contracts settings are similar to employment contracts, in that they are used to configure settings
for agent availability times and days off that might be union or contractual requirements. In the same
way, WFM automatically takes the Contract settings into consideration to produce legal schedules
for every agent.

At the top of the Contracts List pane, use the Site Settings pane to configure settings for the
selected site, such as the minimum duration for start and end of working days, start times between
consecutive working days, schedule planning period type, and planning period start date.

At the top of the Constraints pane, click each one of the following panes to configure additional
properties and define scheduling parameters:

• Constraints—Defines the basic scheduling parameters for each contract, including constraints on
working hours, working days, and the duration between working days.

• Availability Patterns—Defines the default settings for the days and hours that each contract can be
scheduled.

• Day-Off and Weekend Rules—Defines the default settings for the days off per planning period, weekend
rules, specified days off, and consecutive days off rules.

• Synchronization—Ensures that an agent starts each workday within a user-defined time threshold.
• Shifts—Displays a list of shifts that are assigned to the selected Contract.
• Agents—Displays a list of agents that are associated with the selected Contract.
• Profiles—Displays a list of profiles that are associated with the selected Contract.
• Advanced Hours—Displays the Contract minimum and maximum hours.

In the Shifts, Agents, and Profile views, use the following panes to further configure Contracts:

Shifts:

• Available Shifts pane—Used to set the state of the shift assignment (Primary or Secondary) and,
from a list of available shifts, select one or more to assign to (or remove from) the selected Contract.

Agents:

• Associate Agents pane—Used to assign an effective date for the selected Contract and, from a list of
available agents, select one or more to associate with the selected Contract.

Profiles:

• Profile Properties pane—Used to create a new Profile, add and delete skills to/from a Profile, and
save any changes.

• Associate Skills pane—Used to assign a skills level and, from a list of available skills, select one or
more to associate with a Profile.
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Contracts List Pane
Use the Contracts List pane to create new contracts or view, edit, delete, or copy existing contracts.
Use the controls in the top-right corner of this pane to complete the following tasks:

Search field
Enter the search criteria. For example, enter the
name of the contract.

New Click this icon to create a new contract.

Delete Click this icon to delete and existing contract.

Copy
Click this icon to copy and rename an existing
contract.

Help
Click this icon to view a Help topic about the
Contracts pane.

Sort
Click this icon to sort the Contracts list in ascending
or descending order.

Viewing an Existing Contract

To view a list of existing contracts that are configured for the site you selected on the Objects pane:

1. Select Policies > Contracts.
2. In the Objects pane, select an existing site.

All available contracts for this site are displayed in a list in the Contracts pane.

Creating a Contract
Link to video
To create a new contract:

1. Select Policies > Contracts.
2. In the Objects pane, select the site for which you want to create a contract.

3. In the upper-right corner of the Contracts pane, click New .
The Constraints pane is displayed.

4. By default, the Name field is already populated with a unique name when you select New. The name
includes a number to ensure that each newly created Contract has a unique name in the Configuration
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database. You can change this name, but it must remain unique to prevent duplicate name errors from
occurring.

5. In the Constraints pane, set the parameters in the Properties section, as required.
6. Continue to configure the additional contract properties, by selecting each tab at the top of the

Constraints pane, as required.
For detailed information about each pane, see Constraints, Availability Patterns, Days Off and Weekend
Rules, Synchronization, Shifts, Agents, and Profiles.

7. To save the changes in each pane, click Save .

Deleting a Contract

To delete a contract:

1. Select Policies > Contracts.
2. In the Objects pane, select the site from which you want to delete a contract.
3. In the Contracts pane, select the contract that you want to delete.

4. In the upper right corner of the pane, click Delete .

Copying a Contract

To copy and paste an existing contract (to create a new one):

1. Select Policies > Contracts.
2. In the Objects pane, select the site from which you want to copy a contract.
3. From the Contracts list, select an existing contract.

4. In the upper right corner of the Contracts pane, select Copy .
The Copy Selected Contract pane is displayed.

5. In the Name field, enter the name of the contract.
6. In the Associate Copied Contract with the Following Site section, select the site, to which you

want to associate this contract.

Important
If a Contract is copied to a site with different planning period than the original site, all of the contract's
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planning-period-related values are reset to the default values.

7. In the upper right corner of the Copy Contract pane, click Save Now.
The contract is displayed in Contracts pane with the new name.

8. To configure the contract properties, select each tab at the top of the Constraints pane, as required.
For detailed information about each pane, see Constraints, Availability Patterns, Days Off and Weekend
Rules, Synchronization, Shifts, Agents, and Profiles.

9. To save the changes in each pane, click Save .

Editing a Contract

To edit an existing contract:

1. Select Policies > Contracts.
2. In the Objects pane, select the site in which you want to edit a contract.
3. In the Contracts pane, select the contract that you want to edit.

The Constraints pane is displayed,
4. In the drop-down list, select each properties pane that you want to edit.

5. After editing the selected pane, click Save .
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Site Settings
At the top of the Contracts pane, click Site Settings to open the pane and configure the following
settings for a selected site:

Minimum Duration Section

• Minimum Duration Between the End of the Day and Start of Next Working Day—Enter a time
period in hours and minutes for the duration between the end of the current day and start of the next
working day, or specify an unlimited duration by checking the Unlimited check box.

• Minimum Duration Between the Start Times of Two Consecutive Working Days—Enter a time
period in hours and minutes for the duration between the start times of two consecutive working days,
or specify an unlimited duration by checking the Unlimited check box.

Schedule Planning Period Section

• Schedule Planning Period Type—Enables you to define a period of longer than a week that can be
used to set up Contract constraints, such as number of paid hours and number of days off. The
Schedule Planning Period options are: None, Monthly, Two Weeks, Three Weeks, Four Weeks,
Five Weeks, and Six Weeks.

• Start Date—Enter the date, on which the selected planning period begins.

Important
The start date must correspond to the Week Start Day value that is configured for
the business unit, to which the site is assigned. Future iterations of the Schedule
Planning Period will start on the same day of the week. If you selected the Monthly
option, this field will be unavailable, and future iterations of the Schedule Planning
Period will start on the first day of each calendar month.

After you have configured these settings, click Save .

To reconfigure these settings, you can click the Reset button. Doing so, will reinstate the default
settings and the Review Validation Messages pane opens, displaying the following warning message:

If you click Reset, all settings for Schedule Planning Period work hours and time off
for all Contracts at this location will be deleted. New Schedule Planning Period
settings will have to be entered manually. Do you want to continue?
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Warning
If you click Reset, all previously entered Schedule Planning Period settings in the
Contract Constraints and Day off and Weekend Rules panes are deleted, and
you must reenter them for all Contracts in the affected site.

Click Close if you want to ignore the message or Apply in the Review Validation
Messages pane, if you want to reset the settings.
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Contract Constraints
The Contract Constraints pane defines the basic scheduling parameters for each contract. Use the
Constraints pane when you create a new contract or when you edit an existing contract.

To view the Constraints pane for an existing contract:

1. Select Policies > Contracts.
2. Select an existing site in the Objects pane.
3. Highlight an existing contract in the existing Contracts list.
4. In the right-side pane, select Constraints.
5. After you have set the parameters in the Working Hours, Working Days, and Scheduling sections as

required, in the upper right-hand corner, click Save.

Among other properties, you can set synchronization, which ensures that an agent starts each
workday within a user-defined time threshold.

Important
You cannot create optimal schedules if you have not configured the constraints
properly. Workforce Manager runs a consistency check to ensure that the minimum
and maximum days off per week are compatible with the minimum and maximum
days off per schedule planning period.

If you receive an error message when you are configuring Contract constraints, review the rules for
each constraint (described in the Working Hours and Working Days tables below).

List of Contracts Retrieved in Segments

The list of Contracts is displayed in segments or sequential pages. When large amounts of data are
being retrieved, the list of items in Contracts pane is displayed in smaller segments sequentially,
with 50 items per page. This limits the number of items that are retrieved from WFM at any given
time, maintaining optimal performance during retrieval. You can browse the previous and next pages
or navigate to the first and last items in the data set (start and end of the list), by clicking the
appropriate button in the view. To navigate between pages, you can use the Up, Down, Page Up,
and Page Down keys on the keyboard.

Contract Constraints Properties

Contract Name—The name of the Contract, which must be unique within the site.
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Icon—The icon you want displayed for this Contract. Choose a background color that will
make identification easy. Clicking the down arrow displays all available icons.

Tip
If you make changes that do not pass validation, the Review Validation Messages
pane is displayed, which shows a list of error and warning messages. For more
information about these messages, see Review Validation Messages.

Working Hours section

Setting Name Definition Daily Valid
Values

Weekly Valid
Values

Schedule
Planning Period

Valid Values

Standard Paid
Hours

The paid time, in
hours and
minutes, that
agents assigned to
this contract work
in a standard day,
week, and (if
applicable)
schedule planning
period.

less than 24 hours

less than 168
hours

can configure with
a 1-minute time
unit

less than 1008
hours (or fewer,
depends on the
planning period
length)
can configure with
a 1-minute time
unit

Rules:

• Should exclude overtime.
• Values must be greater than or equal to the Minimum Paid Hours for the same

period.
• Values must be less than or equal to the Maximum Paid Hours for the same

period.

Minimum Paid
Hours

The minimum paid
time, in hours and
minutes, that
agents assigned to
this contract are
required to work
per day, week, and
(if applicable)
schedule planning
period according
to contractual
requirements.

less than 24 hours

less than 168
hours

can configure with
a 1-minute time
unit

less than 1008
hours (or fewer,
depends on the
planning period
length)
can configure with
a 1-minute time
unit

Rules:

• The daily value must be more than 0.
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Setting Name Definition Daily Valid
Values

Weekly Valid
Values

Schedule
Planning Period

Valid Values

• This value must be less than or equal to the Standard Paid Hours value for the
same period.

• The daily value x Minimum Working Days per Week must be less than or
equal to the weekly value.

• The daily value x Minimum Working Days per Week must be less than or
equal to the Maximum Paid Hours (weekly).

• If you are using a schedule planning period, the weekly value x the number of
weeks in the schedule period must be equal to or less than the schedule
planning period value.

• If the period is a month, then the number of weeks is assumed to be equal to 4.
• The weekly value divided by the Maximum Daily Paid Hours value must be

less than or equal to the Minimum Working Days per Week.
• The weekly value can be equal to 0 if Minimum Working Days per Week is

equal to 0.

Maximum Paid
Hours

The maximum
paid time, in hours
and minutes, that
agents assigned to
this contract are
required to work
per day, week, and
(if applicable)
schedule planning
period according
to contractual
requirements.

less than 24 hours

less than 168
hours

can configure with
a 1-minute time
unit

less than 1008
hours (depends on
the planning
period length)
can configure with
a 1-minute time
unit

Rules

• Includes all overtime and paid exceptions.
• Must be greater than or equal to the Standard Paid Hours value for the same

period.
• The daily value x Minimum Working Days per Week must be equal to or

greater than the Weekly Minimum Paid Hours value.
• If you are using a schedule planning period, the weekly value x the number of

weeks in the schedule planning period must be greater than or equal to the
schedule planning period value.

• If the period is a month, then the number of weeks is assumed to be equal to 5.
• The weekly value must be equal to or greater than the Daily Minimum Paid

Hours x Minimum Working Days per Week
• The weekly value divided by Daily Minimum Paid Hours must be greater than

or equal to the Maximum Working Days per Week.
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Setting Name Definition Daily Valid
Values

Weekly Valid
Values

Schedule
Planning Period

Valid Values

• The weekly period must be greater than 0.
• If the period is a month, it must be less than 31 x 24 hours.

Working Days section

Setting Name Definition Daily Valid
Values

Weekly Valid
Values

Schedule
Planning Period

Valid Values

Maximum
Consecutive
Working Days

The maximum
number of
consecutive days
that agents
assigned to this
contract type are
allowed to work.

1–365 days Not Applicable Not Applicable

Rules:

• Must be equal to or greater than the Minimum Working Days per Week.
• If Maximum Working Days per Week is less than 7, must be less than or

equal to the Maximum Working Days per Week x 2.
• This value can exceed the Maximum Working days per Week x 2 only when

the Maximum Working days per Week is 7 and must be less than or equal to
365.

• If agents have multiple assigned contracts, WFM uses the Maximum
Consecutive Workdays setting from the contract on the first day of the
schedule for the entire schedule. If the contract is assigned to the agent after
the first day of the schedule and that contract's Maximum Consecutive
Working Days setting has a different value, WFM ignores the that value.

Minimum
Consecutive
Working Days

The minimum
number of
consecutive days
that agents
assigned to this
contract type must
work before a
scheduled day off.

2–365 days Not Applicable Not Applicable

Rules:

• Effective only when value is set to 2 or more days. Any value below 2 is
considered not specified.

• Must be equal to or greater than the Minimum Working Days per Week.
• If Maximum Working Days per Week is less than 7, must be less than or
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Setting Name Definition Daily Valid
Values

Weekly Valid
Values

Schedule
Planning Period

Valid Values

equal to the Maximum Working Days per Week x 2.
• This value can exceed the Maximum Working days per Week x 2 only when

the Maximum Working days per Week is 7 and must be less than or equal to
365.

• If agents have multiple assigned contracts, WFM uses the Minimum
Consecutive Workdays setting from the contract on the first day of the
schedule for the entire schedule. If the contract is assigned to the agent after
the first day of the schedule and that contract's Minimum Consecutive
Working Days setting has a different value, WFM ignores the that value.

• WFM considers only days that have shifts or Granted work time ("overwrite"
shift) as work days. Paid full-day exceptions and time-off are considered days off
and are not counted as part of the Minimum Consecutive Working Days.

Minimum Working
Days per Week

The minimum
number of days
that agents
assigned to this
contract must
work per week.

Not Applicable 0–7 days Not Applicable

Rules:

• Must be less than or equal to the Maximum Working Days per Week.
• This value x Daily Minimum Paid Hours must less than or equal to the

Weekly Maximum Paid Hours.
• This value must be less than or equal to the number of available days per week

set on the Availability Pattern pane.

Maximum Working
Days per Week

The maximum
number of days
that agents
assigned to this
contract are
allowed to work
per week.

Not Applicable 0–7 days Not Applicable

Rules:

• Must be greater than or equal to the Minimum Working Days per Week.
• Must be less than or equal to the Weekly Maximum Paid Hours divided by

Daily Minimum Paid Hours.

Scheduling section
The Scheduling section in the Constraints pane has only one parameter. The Schedule activity
sets instead of task sequences check box, sets the scheduling mode, based on site and contract
configuration before scheduling. By default, this check box is not checked.
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WFM uses the following algorithm to determine the scheduling mode:

• If task sequences do not exist at the site, contracts are scheduled in Activity Set mode.
• If task sequences exist at the site, contracts are scheduled in Task Sequence mode.
• If task sequences exist at the site and the Schedule activity sets instead of task sequences check

box is checked in a particular contract, this contract is scheduled in Activity Set mode. In this case, any
shifts that have mandatory task sequences are ignored (as if they were not assigned to this contract)
and shifts that have optional task sequences are scheduled without task sequences.

Web for Supervisors Views in Previous Versions

If the WFM 8.5.2 back end deployed in your environment is a version earlier than 8.5.204, the
Constraints pane will not include the Scheduling section with the Schedule activity sets
instead of task sequences check box.

Tip
Some constraints are common for all contracts under a site. They are set in the
Contracts > Site Settings pane in WFM Web.
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Availability Patterns
You use the Contract Availability pane when you create a new contract or when you edit an
existing contract.

To view the Availability Pattern pane for an existing contract:

1. Select Policies > Contracts.
2. Select an existing site in the Objects pane.
3. Select an existing contract in the Contracts pane.
4. In the right-side pane, select Availability Pattern.

Use the Availability Pattern pane to define the days and hours that each contract can be
scheduled.

You can schedule a contract only within the parameters that are set here, but you can change these
hours at any time.

Important
Availability Pattern settings are not the same as Availability Preferences settings that
you configured in the Calendar. Availability preferences that are requested in the
Calendar apply to single agents, as do the daily availabilities that the preferences are
based upon. The Contract > Availability Pattern tab sets the default daily
availability for the entire contract type.

Overnight Availability on Last Day of Contract
The availability of the contract on the last day is not cut off at 24:00 hours, but allows overnight
shifts.

Defining Availability-Pattern Hours

To define Availability Pattern hours:

1. Enter the start time and end time, in hours and minutes, that this contract must be available for work
for each day of the week.

2. If the availability extends past midnight, select the Next Day check box.

The maximum availability duration is 36 hours, which can occur only when the shift start time is
midnight. If you use a different shift start time, you must adjust the end time to ensure that it does not
violate the 36-hour maximum.
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For example, if the shift start time is 1:00 AM, the maximum duration is 36 hours minus the number of
hours between midnight and the start time. In this case, you must set the end time to 12:00 PM, so that
the maximum duration is 35 hours.

This rule—that the duration that is set by the start time and end time must be less than or equal to 36
hours—applies to each 15–minute timestep. So, if your shift start time is 8:30 AM, the maximum
duration is 36 – 8.5 = 27.5 hours. Therefore, the latest end time that you can enter by using this
example is 12:00 PM.

The duration must be greater than or equal to the Minimum Daily Working Hours.
3. Click Apply.

Editing Availability Patterns

To modify the Availability Pattern:

• Select the contract, and redefine the hours on the Availability Pattern pane.

Important
If you make changes that do not pass validation, the Review Validation Messages
pane is displayed, which includes a list of error and warning messages. For more
information about these messages, see Review Validation Messages.

Copying and Pasting Availability Patterns

To copy and paste an Availability Pattern:

1. In the Availability Patterns pane, click Copy for the week day you want to copy.

2. Navigate to the weekday to which you want paste the weekday, and click Paste .
The Start and End time are copied to the selected week day.
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Review Validation Messages
If you make changes that do not pass validation, the Review Validation Messages pane is
displayed, which includes a list of error and warning messages. These messages provide information
about each constraint that is not compatible with this change or assignment. See the figures below.

The Review Messages dialog provides three options (buttons):

1. Proceed—Click to proceed with the change or assignment. (This button is disabled if the validation
message is of type Error.)

2. Cancel—Click to cancel the change or assignment.
3. Help—Click to open a Help dialog for this topic.

Figure: Rotating Patterns Error Message

Figure: Assigning Contracts or Rotating Patterns Warning Messages
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Day Off and Weekend Rules
You use the Day Off and Weekend Rules pane when you create a new contract or when you edit an
existing contract.

To view the Day Off and Weekend Rules pane for an existing contract:

1. Click Policies > Contracts.
2. In the Objects pane, select the a site.
3. In the Contracts pane, select an existing contract.

The Constraints pane is displayed by default.
4. In the right-side pane, select Day Off and Weekend Rules.

The Day Off and Weekend Rules pane is displayed.
5. Check the Days off per schedule planning period check box and enter the Minimum days off per

schedule planning period and Maximum days off per schedule planning period, if required.

Use the Day Off and Weekend Rules pane to ensure that each contract receives a set number of
days off per scheduling period. You can also use this pane to configure specific rules for weekend
days off and consecutive days off.

Contract Day Off and Weekend Rules Properties

Weekend Rules section
Defines the minimum and maximum number of times per user-defined schedule planning period
(none, two to six weeks, or one month) that agents who are assigned to this contract must have a
specified day or days off. The schedule planning period is set in Policies > Contracts > Site
Settings.

Important
If you are making changes in Contract properties, Day Off and Weekend Rules tab
or assigning agents to a Contract, be sure to read the topic Review Validation
Messages.

A Note About Terminology

Many of the world's workers take their weekends on Saturday and Sunday, but not all. To assign a
different weekend, select the first day of the weekend from the Weekend First Day drop-down list.
Thus, you can alter a contract's settings for weekends quickly and easily with a single adjustment.

If your schedule planning period is one month, you can enter up to five First Weekend Days,
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Second Weekend Days, and weekends off.

• Weekend First Day—If Saturday is the first day of this contract's weekend, keep the default setting
(Saturday). If this contract's weekend starts on a different day, select that day from the drop-down list.

Tip
The value that you select here is displayed instead of First Weekend Day in the Days Off section.

• Maximum Consecutive Working Weekends—The maximum number of consecutive weekends that
agents who are assigned to this contract type are allowed to work.

Tip
A working weekend is when at least one of the weekend's days is scheduled for work.

Turn the constraint OFF in one of two ways:

• Set the value of value Maximum Consecutive Working Weekends to 0. This is the default
setting.

• Select the Unlimited check box, which is located on the right side of the same line. This is the
default setting.

• Maximum Consecutive Working "Saturday" (2nd day of the weekend)—The maximum number of
consecutive 2nd day of the weekend that agents who are assigned to this contract type are allowed to
work. The actual day of the week is determined by your selection in the Weekend First Day field.

Days Off section

• Friday (or first weekend days) Are Off—When enabled, this feature guarantees that an agent has a
specified number of First Weekend Days off per schedule planning period. Select the minimum and
maximum number of times per schedule planning period that the contract must be excluded from the
First Weekend Days schedule.

Tip
The actual day of the week is listed in the label (for example, Mondays Are Off), and is determined by your
selection in the Weekend First Day field.

• Saturday (or second weekend days) Are Off—When enabled, this feature guarantees that an agent
has a specified number of Second Weekend Days off per schedule planning period. Select the
minimum and maximum number of times per schedule planning period that the contract must be
excluded from the Second Weekend Days schedule.
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Tip
The actual day of the week is listed in the label (for example, Tuesdays Are Off), and is determined by your
selection in the field Weekend First Day field.

• Both Weekend Days Are Off—When enabled, this feature guarantees that agents of the contract are
scheduled with the entire weekend off. Select the minimum and maximum number of times per
schedule planning period that the contract must be excluded from the weekend schedule.

Tip
If you select Both Weekend Days Are Off, you should still set the properties for the individual weekend
days off. Both Weekend Days Are Off does not replace First Weekend Days Are Off and Second
Weekend Days Are Off.

Consecutive Days Off Rules section

• Minimum consecutive days off hours per week—This setting enables you to ensure adherence with
legal or company-set requirements for minimum consecutive hours off per week.

Tip
If the value is more than 24:00, then the Minimum Working Days per Week constraint should not exceed
6 days, which leaves room for at least one day off to satisfy this constraint, and this constraint is satisfied if it
is obeyed at least once a week.

• Minimum number of consecutive days off per planning period—Enter or select the minimum
number of consecutive days off that agents must receive at some point during the schedule planning
period.

Notes About Days Off and Weekend

The information in this section about days off and weekends is important to note when planning
agent schedules.

Number of Days Off Per Period
The minimum number of days off per period is based on the lowest number of minimum days off for
all contracts in that period. The maximum number of days off per period is the highest number of
maximum days off for all contracts in that period.
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Consecutive Days Off Per Period
The following conditions apply for consecutive days of per period when the effective start date is
specified for contract assignment:

1. If the period is covered by more than one contract and all contracts have the same consecutive time off
value, the constraint is retained for the entire period as if covered by only one contract.

2. If the period is covered by more than one contract and the number of days contract that is available is
less than the required consecutive time off, that contract is ignored while the maximum consecutive
time off constraint for the period is evaluated.

3. If the consecutive time off constraint is present in all contracts (satisfying only condition 2. above, the
average consecutive time off value is calculated, based on the average total requested time off for
each contract or number of contracts per period.

4. If at least one contract during the period has a consecutive time off value or 0, that value is used for
entire period.

Consecutive Working Sundays and Weekends Per Period
The consecutive working Sundays and Weekends per period function uses the maximum
consecutive setting that is specified in the contract that is assigned on the first day of the schedule.
Constraints are not violated during the contract date intervals and are handled properly on date
boundaries so that the maximum value of both contracts is not exceeded.

Minimum and Maximum Saturdays, Sundays, and Weekends Per Scheduling
Period
The min/max Saturdays, Sundays, and weekends per scheduling period function uses the setting that
is specified in the contract that is assigned on the first day of the schedule.

If certain rules must be applied to the transitional period, a special transitional contract must be
created. Therefore, if the agent needs to change his/her contract from A to B on a certain date (d0)
and it is in the middle of the week or in the middle of long period, the user must create the
transitional contract to start at day d1, which is the start of the week or the period. Contract B must
start at the date d2, which is the start of the full week or period after d0. The application does not
provide additional automation to create transitional contracts or rotating patterns.
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Synchronization
You opened this pane by selecting Synchronization in the right-side pane in the Contracts view.
Enable the settings on the Synchronization pane by selecting the Use Synchronization of Daily
Schedules check box.

Using synchronization ensures that an agent starts each workday within a user-defined time
threshold.

Synchronization includes the Shift Start Time Flexibility option. This option allows the schedule
start/end times to vary within a specified range. Allowing some flexibility enables you to create a
more optimal schedule.

Synchronization and the Schedule Planning Period

The synchronization setting and the schedule planning period affect how Workforce Management
aligns agent start times:

• If the synchronization period is shorter, but fits exactly into the schedule planning period,
synchronization will be complete. For example, if the synchronization period is two weeks and the
schedule is six weeks, three synchronization periods exactly fit the schedule.

• If the synchronization period is shorter than the schedule planning period, only the time covered by the
synchronization period will be synchronized. The rest of the schedule will not be synchronized. For
example, if the synchronization period is four weeks and the schedule is six weeks, the first four weeks
will be synchronized, but the final two weeks will not be.

• If the synchronization setting is longer than the schedule planning period, no synchronization will occur.
For example, if synchronization is set to four weeks, but a schedule is built for three weeks,
synchronization is disabled for the entire schedule.

Using Synchronization

To use synchronization:

1. Select the Use Synchronization of Daily Schedules check box, and then select either Synchronize
Shifts between Days Off, [X] Week(s) Period, or the Schedule Planning Period radio button.

Tip
If a Contract is copied to a site with different planning period than the original site, the Use
Synchronization of Daily Schedules check box will be unchecked.

2. If you selected [X] Week(s) Period, enter the required number of weeks in the text box, or use the
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arrows to navigate to the correct number.
3. If necessary, change the Shift Start Time Flexibility settings:

• For strict start time synchronization, leave Shift Start Time Flexibility set to the default 00:00.
• To change Shift Start Time Flexibility settings, enter the number of minutes or hours by which

the Scheduler can adjust the synchronized schedule, or highlight the hour or minute in the text box
and use the arrows to adjust the selected time.

4. If necessary, change the Synchronization Type setting. Select one of these choices from the drop-
down menu:
• Shift Start (default)
• Shift Start and Duration
• Shift Start, Duration, and Meals Status
• Shift Start, Start of Meal, and Breaks

Tip
Scheduler will attempt to synchronize by all parameters in your selection.

5. If necessary, change the Applicable Days setting. By default, all check boxes (Sun, Mon, Tue, Wed,
Thu, Fri, Sat) are selected. To specify a day of the week to which synchronization does not apply, clear
that day's check box. For example, to exclude the standard weekend, clear the check boxes for
Saturday and Sunday.

6. To disable synchronization, clear the Use Synchronization of Daily Schedules check box.

7. To save the setting, click Save .

Shift Synchronization For Weeks or Scheduling Periods

If synchronization is different between two contracts, the synchronization is considered separately for
each contract. Synchronization between contracts with identical configuration can continue to be
used, even when contracts change. For example, shift start times can be synchronized for the entire
week, even if the contract changes mid-week.

Contracts are considered to have identical synchronization constraint under the following conditions:

• Contracts have the same synchronization period, week days, and start window.
• Contracts have the same synchronization type (start, start + duration) and the same list of available

shifts
• Contracts have a simple configuration check that indicates that synchronization is possible.

A configuration check verifies that for the start time synchronization type, there are shifts that can
start within the synchronization start time window.
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In addition, the paid duration of shifts check box must be checked, for the start time and duration to
synchronize, and the set of common shifts must be present in all contracts, for start, duration, and
meal to synchronize.

Shift Synchronization Between Days Off

If synchronization is identical between contracts as in synchronization for weeks or scheduling
periods, the contract change has no effect on synchronization. The Scheduler works as if only one
contract is configured.

For non-identical synchronization configuration, synchronization does not extend outside of the
contract date interval.

Team Synchronization by Contract

Before contract assignment changes, teams could easily be split into groups by contract. The groups
were then synchronized as teams. When contract assignments include effective start dates, these
contract groups might change during schedule scenarios. Therefore, team synchronization
constraints are not longer applied to the entire scenario, but are split into smaller intervals so that
agent contract assignments do not change.

Policies Contracts

Workforce Management Web for Supervisors Help 115



Contract Shifts
The Shifts pane displays all available shifts that can be associated with this contract. All shifts
configured for the contract site are listed. The shifts you select must have settings compatible with
the contract settings. An error message appears if the settings are not compatible. If the settings for
at least one day are compatible, the association is accepted. Use the Contracts > Shifts pane
when you create a new contract or when you edit an existing contract.

To view the Shifts pane for an existing contract:

1. Select Policies > Contracts.
2. In the Objects pane, select a site
3. In the Contracts pane, select an existing contract.

The Constraints pane is displayed by default.
4. In the right-side pane,select Shifts.

The Shifts pane is displayed containing a list of shifts that are associated with this contract.

The Shifts pane displays the details for assigned shifts in the following columns:

Name The name of the assigned shift.
Earliest Start The earliest start time for this shift.
Latest End The latest end time for this shift.
State The state of the shift, either Primary or Secondary.

Use the Shifts pane to assign shifts to the Contract or change the state of an assignment.

Important
If you make changes that do not pass validation, the Review Validation Messages
pane is displayed, which includes a list of error and warning messages. For more
information about these messages, see Review Validation Messages.

Assigning a Shift To a Contract

1. In the Contracts pane, select a contract from the list of existing contracts.
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2. Click Assign Shifts .
The Available Shifts pane opens with details in the Name, Earliest Start, and Latest End

columns. Alternatively, if you want to unassign a shift, click Unassign Shifts .
3. In the Use This State for Assignments drop-down list, select Primary or Secondary.
4. In the Available Shifts to be Associated with Contract section, select one or more shifts.

Search for a specific shift by typing the shift name in the Search field, if desired.

5. To associate the shift(s) with this contract, click Apply .
The selected shifts are displayed in the Shifts pane.

6. Close the Available Shifts pane, and on the Shifts pane, click Save Changes .
You can configure shifts for a selected site in the Policies > Shifts view.

Removing an Assigned Shift From a Contract

1. In the Contracts pane, select a contract from the list of existing contracts.
2. In the Associating Shifts for <shift name> list, select the shift you want to remove and click

Unassign Shifts .
The shift if removed from the list.

3. In the Shifts pane, click Save Changes .

Changing the State of an Assigned Shift

1. In the Contracts pane, select the contract to which the shift you want to change is assigned.
2. In the Associated Shifts for <contract name> section, from the drop-down list in the State column,

change the state to either Primary (default) or Secondary.

3. To save the changes, click Save Changes .
To select multiple shifts, hold down SHIFT or CTRL and click each additional shift.
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Contract Agents
You use the Agents pane in the Contracts view when you create a contract or when you edit an
existing contract.

To view the agents associated with an existing contract:

1. Select Policies > Contracts.
2. In the Objects pane, select a site
3. In the Contracts pane, select an existing contract

The Constraints pane displays by default.

4. In the right-side pane, select the Agents.
The Agents pane displays containing a list of agents that are associated with this contract
on the selected date.

To change the date field in the Agents or Available Agents pane, click inside the field and a
calendar is displayed. Select the date, as required. If you make changes that do not pass validation,
the Review Validation Messages pane is displayed, which contains a list of error and warning
messages. For more information about these messages, see Review Validation Messages.

Use the Contracts > Agents pane to specify an effective start date for the selected contract and
assign agents to the contract. You can also assign effective dates for contracts in the Configuration
> Agents > Contracts and Rotating Patterns pane.

Contract Effective Dates

Contracts that are assigned to an agent have a start date that specifies when the assigned contract
becomes effective. Agents can have multiple contracts with different start dates assigned to them,
but all assigned contracts must have different start dates. In this way, an agent can have only one
effective contract on any given day.

Important
You can specify an effective start date for an assigned contract that has daily
granularity, but you cannot specify an effective start time.

Contract assignments might not always have an effective start date. If an effective start date is not
specified, the contract is considered to be assigned to the agent from the beginning of time. The
agent will have only one contract assigned from the beginning of time. All other assignments to that
agent, must have specific effective start dates that are unique for each contract assigned.

If the agent does not have a contract assigned with no start date, it is assumed that the agent had no
contract between the beginning of time and the earliest contract assignment.
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There is no explicit end date for contract assignments. The agent has only one effective contract at
the time, because an assigned contract ceases to be effective on the start date of another. The
assigned contract with the latest effective start date is assumed to be effective until the end of time.
This approach simplifies contract assignment and guarantees that contracts that are assigned to
agents have no gaps in the effective intervals.

You can specify an effective start date for an assigned contract in Contracts on the Agent
assignment tab, see the procedure below.

Associating an Agent With a Contract

1. In the Contracts pane, select a contract from the list of existing contracts.

2. Click Show Available Agents .
3. In the Effective Date field, enter the effective start date for this contact assignment.
4. Select one or more agents from the Agents to be Associate with <contract name> section.

Tip
Enter search criteria into the Search field and use the radio buttons to filter on First or Last Name, if the list
of agents is long.

5. To associate the agent(s) with this contract, click Apply .

6. Close the Available Agents pane, and on the Agents pane, click Save Changes .

Agents—The agents that can be associated with this contract. All agents from the current site are
listed.

Effective Date—The effective start date that is specified for this contract assignment.
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Configuring Profiles
Profiles are descriptions of virtual agents.

You can configure multiple profiles for each contract by selecting typical sets of skills. The WFM
Scheduler uses contract parameters, combined with the profiles' skill sets, to produce blank schedule
scenarios that are based on profile characteristics rather than on the actual agent pool. This is
especially useful if you have not yet hired agents.

These blank schedule scenarios provide you with an unlimited number of "what-if" assessments of
the number of agents of each contract and skill set that might be required. You can manually assign
agents into the schedule after it is built.

You can create a new profile or copy an existing profile and rename it to create a new one, or you can
delete a profile.

Creating a Profile

To create a new profile:

1. Click Policies > Contracts and then, in the Objects pane, select a site.
2. In the Contracts pane, select a specific contract.

The Constraints pane displays, by default.
3. At the top of the pane, select Profiles.

A list of profiles that have been created for this contract displays.

4. In the Profiles pane, to create a new profile, click Add Profile .
5. When the Profile Properties opens, enter a name for the profile.

The name should be descriptive and different from any other profile name within the contract.

6. To add skills to the profile, click Add Skill .
A list of available skills is displayed in the Selected Skills to be Associated With Profiles section.

Tip
Alternatively, if you want to remove a skill, click Delete Skill .

7. Select the skills you want to associate with this profile, and then, click Add Skill .
8. In the Use this Level for Assignments field of the Available Skills pane, enter the correct skill level.
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Important
The value that you enter will affect the profile's availability on the Select Profiles page of the Schedule
Scenario Wizard. That page displays only profiles with a skill level that falls within the required range of the
Activities that you are scheduling. For example, if you define a profile here with a Stocks & Bonds skill level
of 5, and then use the wizard to create a scenario that requires a Stocks & Bonds skill level of 8–30, your
profile will not appear as a choice, because 5 is not between 8 and 30.

9. Continue to add skills and set skill levels until you have fully configured the profile.

10. To save the profile setting, click Save Changes .

Deleting a Profile

To delete an existing profile:

1. Click Policies > Contracts and then, in the Objects pane, select a site.
2. In the Contracts pane, select a specific contract.

The Constraints pane displays, by default.
3. In this pane, select Profiles.

A list of profiles that have been created for this contract displays.

4. In the Associated Profiles section, select the profile you want to delete and click Delete Profile
.
The profile is removed from the list.

5. To save the changes, click Save Changes .

Copying an Existing Profile

To create a new profile by copying an existing profile:

1. In the Policies > Contracts > Profiles pane, select an existing profile in the Associated Profiles
section.

2. Click Copy Selected Profile .
The Copy Selected Profile To Another Contract pane displays.

3. In the Name field, rename the profile.
4. In the Copy Selected Profile to Another Contract section, select a contract from the list.
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Tip
Alternatively, if you know the Contract name, you can type it in the Search field to find it quickly.

5. Click Save Profile .
The profile is added to the list of Associated Profiles.

Tip
If the contract you selected in step 4 is different from the contract selected in step 1, the copied profile is
visible only after you navigate to the list of profiles under the appropriate site for this contract. If the contract
selected in step 4 is the same, the copied profile is visible in the profile list immediately after it is copied.

6. Configure the profile. The settings are described in steps 7–10 above.
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Advanced Hours
The Advanced Hours option, which opens the Advanced Hours pane, is used only if you are using
Monthly schedule planning periods. For information about monthly schedule planning periods, see
the Contracts > Site Settings tab.

The Advanced Hours pane defines the Contract's minimum and maximum hours.

The values in this pane override the standard Contract hours. You can use these values if you have to
customize monthly workloads to handle seasonal variations in staffing requirements.

Tip
If you set the value for a month to 0, the Contract constraints for monthly minimum
and maximum working hours are used.
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Rotating Patterns
Rotating Patterns are rotating work weeks, work days, work hours, and/or work activities. A Rotating
Pattern can be assigned to an agent. See the following examples:

• Example 1: A regular Weekly Pattern might be Monday through Friday from 9:00 AM to 5:00 PM
followed by a short Weekly Pattern of Tuesday through Thursday from 12:00 PM to 4:00 PM.

• Example 2: Agents that work four 10-hour days per week could work Monday through Thursday one
week and Tuesday through Friday the next week. The combination of these alternate days off (Fridays
or Mondays) comprises a Rotating Pattern.

Rotating Patterns Pane

In this pane you can view, create, delete, and copy Weekly Patterns. After creating Weekly Patterns,
you can then combine them to create Rotating Patterns. You configure Rotating Patterns by the week.
Therefore, you can have as many weekly rotations as you need.

The Rotating Patterns pane displays a list of Rotating Patterns that exist under the selected site
within the enterprise.

Figure: Rotating Patterns Pane Controls

Use the controls in the top-right corner of this pane to complete the following tasks:

Search field
Enter your search criteria. For example, the name
of a Rotating Pattern.

New Click this icon to create a new Rotating Pattern.

Delete
Click this icon to delete an existing Rotating
Pattern.

Copy Click this icon to copy an existing Rotating Pattern.

Help
Click this icon to view a Help topic about the
Rotating Patterns pane.

You can also use the Rotating Patterns module to view and configure Rotating Patterns properties,
and associate agents with these patterns. The Rotating Patterns module consists of two additional
panes:

• Properties
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• Associated Agents

Displaying and Retrieving Rotating Patterns

The list of Rotating Patterns is displayed in segments or sequential pages. When large amounts of
data are being retrieved, the list of items in Rotating Patterns pane is displayed in smaller
segments sequentially, with 50 items per page. This limits the number of items that are retrieved
from Workforce Management at any given time, maintaining optimal performance during retrieval.
You can browse the previous and next pages or navigate to the first and last items in the data set
(start and end of the list), by clicking the appropriate button in the view. To navigate between pages,
you can use the Up, Down, Page Up, and Page Down keys on the keyboard.

Creating Rotating Patterns
Link to video

1. At the top of the Rotating Patterns pane, click New .

2. In the Properties pane, click Add Week .

3. Expand the properties pane to view all fields, click Expand .
4. In the Name field, enter a name for the Rotating Pattern.

By default, the Name field is already populated with a unique name when you select New.
The name includes a number to ensure that each newly created Rotating Pattern has a
unique name in the Configuration database. You can change this name, but it must remain
unique to prevent duplicate name errors from occurring.

5. In the Weekly Patterns section, populate the fields, as required.
6. In the Weekly Rules for .. section, populate the fields as required.

For a description of the fields in the Weekly Patterns and Weekly Rules for .. sections, see
Rotating Patterns Properties.

7. Click Save Now .

Deleting Rotating Patterns

1. In the Rotating Patterns pane, select the Rotating Pattern that you want to delete.

2. At the top of the Rotating Patterns pane, click Delete .
A Confirmation dialog displays, asking if you want to proceed.

3. Click Yes to proceed or click No to cancel the deletion.
If you select Yes to proceed, you cannot undo the deletion of the Rotating Pattern.
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Copying Rotating Patterns

1. In the Rotating Patterns pane, click to select the Rotating Pattern in the list that you want to copy.

2. At the top of the Rotating Patterns pane, click Copy .
The Copy Rotating Pattern pane displays.

3. In the Name field, enter a name for the Rotating Pattern.
4. In the Associate Copied Rotating Pattern With Following Site section, click to expand each site

and select the site, to which you want to copy the Rotating Pattern.

5. Click Save Now .
A copy of the Rotating Pattern displays with the new name in the list for the selected site.

Using Copy and Paste Within Rotating Patterns

While editing or creating Rotating Patterns, you can select, mark, or copy the settings of a single day
and then copy, transfer, or distribute these settings to a single or multiple, selected days (in other
words, copy once, paste multiple times). When you select a day,and click Copy, the Paste icon is
enabled.

Copying a Week in Rotating Patterns

1. Select a row that displays a Weekly Pattern name (for example, week1)
2. Click Copy.

The Paste icon is enabled.
3. Select the row, into which you want to paste the week1 (for example, week2) and click Paste.

Information from week1 is copied to week2.

See also, Weeks in Rotating Patterns.

Copying a Day in Rotating Patterns

1. Select a day row (for example, day1).
2. Click Copy.

The Paste icon is enabled.
3. Select the row, into which you want to paste day1 (for example, day2) and click Paste.

Information from day1 is copied to day2.

See also, Days in Rotating Patterns.
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Rotating Patterns Properties
In the Rotating Patterns Properties pane, you can add, copy and paste, or delete Weekly Patterns
to/from a Rotating Pattern, move Weekly Patterns up or down within the list, and set various property
parameters for each day within the Weekly Pattern.

See control and setting descriptions for the following panes, in addition to the Rotating Pattern
Properties pane:

• Weekly Patterns Pane
• Rotating Pattern Activities Pane
• Available Activities Pane
• Shifts Pane
• Weekly Rules Pane

Weeks in Rotating Patterns

Weeks in Rotating Patterns are displayed in separate rows for each week name, with the total number
of weeks displayed in the bottom-right corner of the Properties pane. Rotating Patterns containing a
large number of weeks (for example, more than 30) display quickly on one page. You can review or
edit a week, by selecting the row to open the properties for that week, or select the row to copy the
entire week and paste it to other weeks. The Search function generates quick and accurate results
(even when using partial search criteria).

Days in Rotating Patterns

While editing or creating Rotating Patterns, you can select, mark, or copy the settings of a single day
and then copy, transfer, or distribute these settings to a single or multiple, selected days (in other
words, copy once, paste multiple times). When you select a day ,and click Copy, the Paste icon is
enabled.

Properties Pane
Use the control in this pane to perform the following tasks:

Expand pane
Expands the Properties pane to display all column
in one view.

Add Week Adds a Weekly Pattern to the Rotating Pattern.
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Delete Week

Deletes the selected Weekly Pattern from the
Rotating Pattern. When you click Delete, a
Confirmation dialog is displayed, asking you to
confirm the deletion. Click Yes to proceed or No to
cancel the deletion.

Move Week Down
Moves the selected Weekly Pattern down from its
original position in the Weekly Patterns list.

Move Week Up
Moves the selected Weekly Pattern up from its
original position in the Weekly Patterns list.

Copy
Copies the selected Weekly Pattern. After the
pattern is selected, the Paste icon is enabled.

Paste
Pastes the Weekly Pattern (that was selected and
copied).

Help
Displays a Help topic that describes the
Properties pane.

Save Now
Saves any changes made within the Properties
pane.

The Properties pane is divided into three sections. The top section contains two fields:

• Name—The name of the Rotating Pattern.
• Week Days—The week day on which the Rotating Pattern starts.

The bottom section Weekly Patterns, is described below. Within the Weekly Patterns pane you can
open the following panes by clicking the related field:

• Click the Activities field in any day row to open the Rotating Pattern Activities pane.
• Click the Shifts field in any day row to open the Shifts pane.
• Click the Week <number> (for example, Week1) to open the Weekly Rules pane.

Review Validation Messages
If you make changes that do not pass validation, the Review Validation Messages pane is
displayed, which includes a list of error and warning messages. For more information about these
messages, see Review Validation Messages.

Weekly Patterns Pane
This pane has the following rows and columns, which can be configured for each day of the week:

Name The name of the Weekly Pattern for the selected
day.

Weekday The day on which the weekly pattern begins. (
Monday to Sunday)

Column Descriptions:
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Day A day within a weekly pattern.

Day Off Rule

The rules that determine whether a day off can be
assigned for that day. The possible rules are:

• Day In—A granted shift, granted any shift, or
granted availability.

• Day Off Possible—The day can be a working
day or a day off depending on which provides
the most optimal schedule.

• Day Off—The day must be a day off.

Shift

The shift that is assigned for the selected day of
the week. Click in this field for any day and the
Shifts pane opens, enabling you to choose from a
list of existing shifts. For a description of the
controls in this pane, see Shifts pane.

Availability Time

The time that the agent is available during the shift
for the selected day. In the drop-down menu,
choose Use Shift Time or Start/End Time.
Choosing Start/End Time means that the times
that are set in the Start Time and Estimated End
Time fields are used on that day.

Start Time
The start time for the shift on the selected day
(used only if the Start/End Time option is set in
the Availability Time field for the selected day).

Paid Hours/Duration The number of hours (or duration) for which the
agent is paid.

Estimated End Time
The estimated time of the shift on the selected day
(used only if the Start/End Time option is set in
the Availability Time field for the selected day).

Activities

The Activities that are assigned to the agent for
this shift or day. Click in the field for any day and
the Rotating Patterns Activities pane opens,
from which you can select Activities. For a
description of the controls in this pane, see
Rotating Pattern Activities pane.

Week <number> (<weekly pattern name>)
The row displaying the week number (for example,
Week1) and the name of the weekly pattern.
Clicking on this row opens the Weekly Rules pane.

Rotating Pattern Activities Pane
Open this pane by clicking in the Activities column and see the following controls, columns, and
fields:

¨ No Activity Limitations check box
When checked, all of the activities listed are
assigned. If unchecked, only the selected activities
are assigned to the agent for the selected day's
shift.
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Apply
Moves the selected activities to the Weekly
Patterns pane.

Add Activity

Opens the Available Activities pane. When an
activity is added, it is assigned to the agent for the
selected day's shift. If the No Activity
Limitations check box is checked, all of the
activities listed are assigned.

Remove Activity
Removes the selected activities in the Rotating
Pattern Activities pane.

X Close Closes the Rotating Pattern Activities pane.

Help
Displays a Help topic that describes the Rotating
Pattern Activities pane.

Search field
Enter the search criteria. For example, the name of
the activity.

Activity Name The name of the activity.

Available Activities Pane
Open this pane by clicking Add Activity in the Activities pane and see the following controls,
columns, and fields:

Apply
Moves the selected activities to the Rotating
Patterns Activities pane.

Close Closes the Available Activities pane

Help
Displays a Help topic that describes the Available
Activities pane.

Search field
Enter the search criteria. For example, the name of
the activity.

Activity Name Name of the activity.

Shifts Pane

Open this pane by clicking Edit in the Shifts column and see the following controls, columns,
and fields:

¨ Any Available Shift check box
When checked enables the agent to work any
available shift on the selected day. If unchecked,
the agents must work the assigned shift on the
selected day.

Apply
Moves the selected shift to the selected day in the
weekly pattern.

Close Closes the Shifts pane.
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Help Opens a Help topic for the Shifts pane.

Search field
Enables you to enter search criteria. For example,
the name of a specific shift.

Name The name of the shift.

Weekly Rules Pane
Open this pane by clicking the row containing the weekly pattern name in the Weekly Patterns
section of the Properties pane, and see the following controls and fields:

Weekly Pattern Name The name of the Weekly Pattern.

¨ Use Weekly Paid Hours check box

When checked, the Minimum Paid Hours and
Maximum Paid Hours fields are enabled and can
be defined by entering a minimum and maximum
number of hours. When unchecked, these fields are
disabled.

Minimum Paid Hours

The minimum number of hours defined for this
pattern, entered in hh:mm format. If this constraint
is set, WFM schedules the agent to work at least
this many hours for this particular week of the
Schedule Planning Period. Valid values are
00:00 to 168:00. This value must be less than or
equal to the Maximum Weekly Paid Hours
setting in any associated contract. Must include all
paid breaks and meals.

Maximum Paid Hours

The maximum number of hours defined for this
pattern, entered in hh:mm format. If this constraint
is set, WFM will schedule the agent to work no
more than this many hours for this particular week
of the Schedule Planning Period. Valid values
are 00:01 to 168:00. This value must be greater
than or equal to the Minimum Weekly Paid
Hours setting in any associated contract. Must
include all paid breaks and meals.

Rotation Types

By combining the possible settings in the Weekly Pattern pane, you can create nine different types of
rotation days:

1. Day Off—The agent must be assigned a day off on this day.
2. Any Shift—The agent can receive any compatible shift or a day off. In effect, the rotating pattern does

not impose limitations on Scheduler for this day.
3. Availability—The agent can receive any shift that falls within the specified earliest start time and has

the correct number of paid hours. Scheduler also has the option to assign a day off.
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4. Flexible Shift—The agent must be assigned the specified shift, but the start time and paid hours are
flexible within the limits of the shift configuration. Scheduler also has the option to assign a day off for
this day.

5. Fixed Shift—The agent must be assigned the specified shift with the exact start time and number of
paid hours that are specified. Scheduler also has the option to assign a day off for this day.

6. Granted Fixed Shift—The agent must be assigned the specified shift with the exact start time and
number of paid hours that are specified. Scheduler cannot assign a day off for this day.

7. Granted Flexible Shift—The agent must be assigned the specified shift. The start time and number of
paid hours can be adjusted by Scheduler. Scheduler cannot assign a day off for this day.

8. Granted Availability—The agent must be assigned a shift that falls within the specified earliest start
time and has the correct number of paid hours. Scheduler cannot assign a day off for this day.

9. Granted Any Shift—The agent must be assigned a shift on this day. Scheduler cannot assign a day off
for this day.

You can create a Weekly Pattern using any combination of these rotation types, as long as the
combination does not conflict with paid hours and working days constraints.

Important
For Fixed Shift types, Scheduler can assign a shorter shift than specified in the
Rotating Pattern configuration if the agent has requested a number of preferences for
the scheduling period. This happens because Scheduler treats this rotation type as a
preference.
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Rotating Patterns Associating Agents
The Associated Agents pane contains a list of agents who are associated with this Rotating pattern
on the selected date starting from the Rotation Week. Use this pane (within the Rotating Patterns
pane) to associate one or more agents with a selected pattern.

Save Now
Saves any changes made within the Associated
Agents pane.

Show Available Agents
Displays a list of available agents that you can
associate with the Rotating Pattern.

Help
Displays a Help topic that describes the
Associated Agents pane.

Show Agents assigned to this rotating
pattern on following date field

The date that all agents in the list are actually
assigned to the Rotating Pattern. Click in this field
to display a calendar, from which you can select a
date.

Important
Rotating Pattern assignment to the agent has an
effective date, which is the start day when the
Rotating Patterns becomes applicable to the agent. It
is possible to assign multiple Rotating Patterns for the
agent with the different start days.

To assign Rotating Patterns to an agent, see Contracts &
Rotating Patterns.

Search field

Enter search criteria. For example, agent's name or
you can use the Search by radio buttons to filters
the search criteria, by selecting either First name or
Last name.

The Associated Agents section has the following columns:

First Name The agent's first name.
Last Name The agent's last name.

Current Week
The current week of the rotation on the date
specified by the date picker Show Agents
assigned to this Rotating Pattern on
following date.

Contract The name of the Contract.
Team The name of the agent's team.

From the Associated Agents pane, you can open two other panes; the Available Agents pane and
the Distribution pane, which are described below.
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Available Agents Pane

This pane displays the following controls and fields:

Assign Agents
When clicked, associates agents with the Rotating
Pattern. The agents are then displayed in the
Associated Agents pane.

Distribution
When clicked, displays the Distribution pane, in
which more weeks can be added to the distribution
of weeks for which the Rotating Patterns apply.

X Close Closes the Available Agents pane.

Help
Displays a Help topic that describes the Available
Agents pane.

Effective Date field
The starting date on which the Rotating Pattern is
assigned to the agent. Click the date field to
display a calendar, from which you can choose a
date or retain the default (current date).

Starting Week field
The starting week in which the Rotating Pattern
starts for the agent. Select one of the existing
weeks from the drop-down list.

Available Agents list

Lists the available agents that can be associated
with Rotating Patterns. The columns in the list
display the agents First name, Last name, the
Rotating Pattern Name, Rotation Week,
Contract, and Team name. Rotating Patterns and
Contracts are displayed, based on the effective
date that is selected.
To view all of the columns in this list, scroll left-to-right or right-
to-left, by placing your cursor in any one of the rows and use the
right and left arrow keys to scroll to a column that is out of view.

Distribution Pane

This pane displays the following fields and controls:

More
When clicked, adds an additional week to the
Rotating Patterns distribution.

X Close Closes the Distribution pane.

Help
Displays a Help topic that describes the
Distribution pane.

Distribution list Displays the list of weeks, across which the
Rotating Pattern is distributed.
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Associating Agents with a Rotating Pattern

1. Select Policies > Rotating Patterns.
2. In the Objects tree, select a site, for which you want to create a Rotating Pattern.
3. In the Rotating Patterns pane, select a Rotating Pattern in the list.
4. In the right-side pane, select Associated Agents.

The Associated Agents pane opens.

5. Click the Show Available Agents .
The Available Agents pane opens.

6. In the Effective Date field, enter the date on which the Rotating Pattern becomes effective for the
agent.

7. From the Starting Week drop-down list, select a starting week.
8. In the Available Agents list, select one or more agents.

You can also select the appropriate Search by radio button and enter an Agents first or last
name in the search field.

9. To see the distribution of the Rotating Pattern across more weeks, select Distribution .
The Distribution pane is displayed.

10. To add more weeks to the displayed list, click More .
11. To close the Distribution pane, click Close X.

12. In the Available Agents pane, click the Assign Agents .
The selected agents are displayed in the Associated Agents pane and are now associated
with the selected Rotating Pattern and the starting week.

13. In the Associated Agents pane, click Save Now .

Review Validation Messages
If you make changes that do not pass validation, the Review Validation Messages pane is
displayed, which includes a list of error and warning messages. For more information about these
messages, see Review Validation Messages.
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Configuration
Within the Configuration module you can access the following views, in which you can configure
various WFM objects and functionality:

• Notifications
• Colors
• Shared Transport
• Agents
• Organization
• Time-Off Bidding Periods
• Schedule State Groups
• Activities
• Users
• Roles
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Notifications
In the Configuration module, select Notifications to create, edit, delete, and copy emails by site
for the four types of notifications listed below. The notification types that you create are listed in the
Notifications pane, along with its corresponding subject. You can create the same notification types
for many different sites and business units, depending on your requirements.

• Schedule Modifications
• Schedule Trade Status Changes
• Time-Off Bidding
• Time-Off Requests Status Changes

Security Permissions

You must have certain security permissions assigned in WFM Web to configure notifications. See User
Security in the Workforce Management Administrator's Guide for a description of WFM security roles
and associated privileges, and Creating Roles in this Help.

Default Setting

By default, WFM does not generate notifications. To generate notifications you must first create them,
then select at least one site in the Associated Sites tab, to which the notifications will be sent and
save. Once you have done so, notifications of the selected types are sent.

WFM Daemon

A Genesys server component, WFM Daemon, sends out notifications to agents and supervisors. For
more information on this server component, see Workforce Management Administrator's Guide.

Managing Notifications

After creating notifications, you might need to edit, delete, or copy them from time to time, or you
might want to add or remove certain associated sites. The following procedures describe how to
perform these tasks.
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Creating Notifications
To create notifications of schedule modifications:

1. In the Configuration module, select Notifications.
2. In the Objects tree, select a business unit.
3. In the Notifications pane, click New.

The Properties tab opens by default.
4. From the Type drop-down list, select one of four notification types:

• Schedule Modifications
• Schedule Trade Status Changes
• Time-Off Bidding
• Time-Off Request Status Changes

5. At this step, choose one of two options:
• Use the prepopulated text in the Subject and Message fields, adding any additional token

variables, as required.
• Enter new text in the Subject and Messages fields, adding token variables, as required.

6. Click Save.

You can now associate sites with this notification.

Editing Notifications

Tip
You cannot change the notification type when modifying notifications.

To modify the message subject or body text:

1. Delete/type over text.
2. Place the cursor where you wish to insert a token.
3. Click the appropriate token button. The token gets inserted.
4. Click Save on the toolbar.

If you switch to another notification type without saving, a message asks if you wish to save
or cancel.
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Deleting Notifications
To delete a notification:

1. In the Notifications pane, choose the notification you want to delete.
2. Click Delete.
3. In the Confirmation dialog, click Yes to delete the notification or No to cancel the action.

Copying Notifications
To copy an existing notification to a different business unit:

1. In the Notifications pane, choose the notification you want to copy.
2. Click Copy.
3. When the Copy Notification pane opens, select a business unit and then, click Apply.

The notification is now copied and associated with the business unit you selected.

Web for Supervisors Views in Previous Versions of WFM

If the WFM 8.5.2 backend deployed in your environment is prior to 8.5.203, the Notifications view
displayed in the interface more closely matches the content below.

Under Configuration, use the Notifications view to create and edit emails by site for the types of
notifications listed below:

• Schedule trade status changes
• Time-off request status changes
• Schedule modifications

Default Setting
By default, WFM does not generate notifications. To generate notifications, you must select at least
one site to send notifications of given type in the Targets tab and save. Once you have done so,
notifications of the selected types are sent.

Security Permissions
You must have certain security permissions assigned in the WFM Web. See each individual topic
above for the type of permission required.

WFM Daemon
A Genesys server component, WFM Daemon, sends out notifications to agents and supervisors. For
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more information on this server component, see Workforce Management Administrator's Guide.

Configuration Notifications

Workforce Management Web for Supervisors Help 140

https://docs.genesys.com/Documentation/WM/8.5.2/Admin/Welcome


Properties and Site Associations
When you create email notifications, the Properties and Associated Sites panes become available for
you to select the type of notification you want to send, compose the subject and body of the
message, and select the sites you want to associate with them. In the Properties tab, there is some
prepopulated text in the subject and message body, if you wish to use it.

Notification Properties

After selecting a notification type from the drop-down list, you will find that each of the four
notifications types has the same sections in the Properties tab. However, the information withing
these sections vary slightly, depending on which notification type you selected.

Tokens
This section contains buttons for inserting tokens into the message body.

Notification of Schedule Modifications—Available tokens related to agent time-off requests are:
Agent, Requested Dates.

Notification of Schedule Trade Status Changes— Available tokens related to agent schedule
trades are: Proposing Agent, Responding Agent, Requested Dates, Requested Status, Submission
Date, Expiration Date.

Notification of Time-Off Bidding Changes—Available tokens related to time-off bidding requests
are: Agent, Bidding Status, Status Expiration, Bidding Period, Bidding Period Start, Bidding Period
End, Team, Site.

Notification of Time-Off Request Status Changes—Available tokens related to agent time-off
requests are: Agent, Requested Dates, Requested Status, Employee ID, Team, Site, Submit Date,
Actual Status.

Subject
This section contains Genesys-supplied subject text, which you can modify by changing text or
inserting tokens.

Notification of Schedule Modifications—The supplied text is "Message from Genesys Workforce
Management: Schedule modification occurred."

Notification of Schedule Trade Status Changes—The supplied text is "Message from Genesys
Workforce Management: Schedule trading status changed."

Notification of Time-Off Bidding Changes—The supplied text is "Message from Genesys
Workforce Management: Time-Off Bidding status changed to <Bidding Status> for <Agent>."
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Notification of Time-Off Request Status Changes—The supplied text is "Message from Genesys
Workforce Management: Time-Off Request status changed to <Requested Status> <Actual Status>."

Message Body
This area also contains Genesys-supplied body text, which you can modify by deleting/typing over
text and inserting tokens.

Notification of Schedule Modifications—The supplied text is "The schedule for <Agent> has
been modified for the date(s) <Requested Dates>."

Notification of Schedule Trade Status Changes—The supplied text is "The schedule trade
proposal for <Proposing Agent> and <Responding Agent> for the date(s) <Requested Dates> has
been updated with the status of <Requested Status>. Trade proposal's submission date is
<Submission Date>. It will expire on <Expiration Date>."

Notification of Time-Off Bidding Changes—The supplied text is "Status for agent <Agent>
changed to <Bidding Status>. It is applicable to time-off bidding period <Bidding Period> with start
<Bidding Period Start> and end <Bidding Period End>."

Notification of Time-Off Request Status Changes— The supplied text is "<Agent> has
requested time off for the date(s) <Requested Dates>. The requested time off is currently in
<Requested Status> status."

Associating Notifications with Sites

Use this tab to select one or more sites to associate with a notification.

To associate a notification with a site:

• Expand a business unit to display its sites and make your initial selection(s) or change them at any
time.

Web for Supervisors Views in Previous Versions of WFM

If the WFM 8.5.2 back end in your environment was deployed prior to release 8.5.203, the Notification
properties and site associations are displayed and configured in different views. The version of your
interface more closely matches the content below.

To configure notifications of schedule trade status changes, you must have the permission assigned
in WFM Web. See User Security in the Workforce Management Administrator's Guide for a description
of WFM security roles and associated privileges, and Creating Roles in this Help.

To bring up the module for notification of schedule trade status changes:

1. Select the Configuration tab.
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2. Select Notifications from the Views menu. The Objects tree highlights Schedule Trades Status
Changes. The Working pane shows the Messages tab where you configure the message Subject,
Body, and variables (Tokens).

Messages Tab
The Messages tab has three areas: Tokens, Subject, and Message Body. They are described above
for each Notification type. Note that some tokens and supplied text might have been added or
changed in the latest release.

Modifying the Message
To modify the message subject or body text:

1. Delete/type over text.
2. Place the cursor where you wish to insert a token.
3. Click the appropriate token button. The token gets inserted.
4. Click Save on the toolbar. If you switch to another notification type without saving, a message asks if

you wish to save or cancel.

Targets Tab
Use the Targets tab to select business units and/or sites within business units. You can expand
business units to display their sites. You can select multiple sites.

Rules for Sending
After a successful save, WFM uses the specified Subject and Body and the rules listed below when
sending notifications to agents and supervisors. The rules for each Notification type are described in
Rules for Sending Notifications. Note that the Time-Off Bidding notification is new in 8.5.203.
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Rules for Sending Notifications
This topic describes the rules that govern when and to whom WFM sends emails for each notification
type. After saving notifications, WFM uses the specified Subject, Body, and rules listed below when
sending them to agents and supervisors.

Schedule Modifications

When a supervisor changes one or more scheduled days, WFM sends a schedule modification
notification to the affected agent in the configured site and to supervisors who have the appropriate
security rights.

Schedule Trade Status Changes

WFM applies the following rules when sending notifications of trade status changes. The proposing
agent is one creating the trade request; the responding agent is the one receiving the proposal:

• Both the proposing and responding agents associated with the selected sites get notified when a trade
status is User-declined, User-approved, Auto-declined, Auto-approved, or Cancelled.

• Supervisors who have appropriate security rights are notified when a trade status is Pending, or
changes from Pending to any other status.

• The responding agent is notified when the status of a trade proposal is In Review or Open.
• The proposing agent is notified when the response status of a trade proposal is Accepted, In Review,

or Cancelled.

Double-Handshake Trade Proposals
A double-handshake trade proposal works as follows: When Agent A creates a trade proposal for
Agent B (or for the community), there is a check box that asks whether or not the agent wants to
manually approve the response: Check if you want to manually approve response to this trade
proposal.

If this box is not checked, the order of events is:

1. Agent A creates proposal.
2. Agent B accepts proposal.
3. Trade is either automatically approved or goes into In Review state for a supervisor to review and

approve, depending on the details of the trade.

If the box is checked, a double-handshake proposal is created. The order of events is then:
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1. Agent A creates proposal.
2. Agent B accepts proposal.
3. Agent A needs to approve the response from Agent B.
4. Trade is either automatically approved or goes into In Review state for a supervisor to review and

approve, depending on the details of the trade.

The extra approval step (3) allows Agent A to re-confirm that he wants the trade to go through.

Time-Off Bidding

WFM applies the following rules when sending notifications of time-off bidding changes:

• When an agent's status in bidding period is changed to Waiting or Timed Out, WFM sends a time-off
bidding notification to the affected agent.

Time-Off Request Status Changes

WFM applies the following rules when sending notifications of time-off request status changes:

• When supervisors manually change agents' time off in the Calendar module, affected agents and other
supervisors who have the appropriate security rights receive a notification.

• When agents request time off that are not Auto-declined, supervisors who have the appropriate
security rights are notified.

• When automatic Time-Off request status changes occur, the affected agents and supervisors who have
the appropriate security rights and are notified.

• When time-off balances change, supervisors who have the appropriate security rights are notified.

For a complete description of the WFM security roles and privileges, see Roles in this Help.
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Colors
Within the Configuration module, Supervisors can use the Colors view to configure the colors that
WFM uses in the Supervisor Schedule views.

• You can configure default values for these schedule items: Activity Sets, Breaks, Days Off,
Exceptions, Marked Times, Meals, Time Offs, and Work.

• You can configure specific colors for: Activity Sets, Exception Types, Marked Times, or Time-Off
Types.

To find items in long lists, use Search. To sort the list in ascending or descending order, click Sort

or the Item column header.

Using the drop-down list, you can filter the list by Default, Activity Sets, Exception Types,
Marked Times, or Time-Off Types to view specific items for the selected business unit and sites. If
you choose Default, the default colors for the business unit are displayed and the Site column is
empty.

For details about how to configure default and specific colors, see Configuring Colors.

Security Permissions

To configure colors, you must have the Configuration > Colors in Schedule security permission,
which is assigned in WFM Web. See Configuration Role Privileges.
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Configuring Colors
Use the Colors view to modify the default colors that appear in any Supervisors view which displays
these schedule items: Activity Sets, Breaks, Days Off, Exceptions, Marked Times, Meals, Time
Offs, and Work.

You can also use the Colors view to define specific colors for: Activity Sets, Exception Types,
Marked Times, or Time-Off Types.

Defining Default Colors

To define the default colors:

1. In the Configuration module's drop-down menu, select Colors.
2. In the Colors pane drop-down menu, select Default.
3. In the Item column, click any one of the items to redefine the default background and text color for that

item.

Tip
Use the Search or Sort controls to easily find items in long lists. Sort the Item column in ascending or
descending order, by using the icon shown here or by clicking the column header.

4. The palette displays in the Properties pane. Use the top half of this pane to select a text color, and the
bottom half to select a background color. View your current choices in the Sample text strip at the top
of the Properties pane.

5. Choose text and background colors, by using the gradient color panel, the swatches vertical scale, or
the HEX number field to define a specific color.

Tip
The text color is only applicable in the Intra-Day Schedule and Agent-
Extended Schedule views, when you uncheck the Full view check box and can
see the schedule items' short codes.

6. Save your choices, by clicking Save at the top of the window.
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Tip
If you select a different item in the Colors pane without saving, the Confirmation dialog box appears,
indicating that there are unsaved changes. Click Yes to save changes, No to discard them, or Cancel to
cancel action.

Defining Specific Colors

To define specific colors:

1. In the Configuration module drop-down menu, select Colors.
2. In the Objects pane, select a site.
3. In the Colors pane drop-down menu, select Activity Sets, Exception Types, Marked Times, or

Time-Off Types.
4. Make your text and background color selections in the same way that is described in steps 4-6 in the

procedure above.
Your choices will apply only to the selected items.

Resetting the Color Scheme

Click the Reset button in the Properties pane at any time to reset the color scheme.

Web for Supervisors Views in Previous Versions

If the WFM 8.5.2 back end deployed in your environment is a version earlier than 8.5.204, the Colors
Tool views displayed in the interface more closely matches the controls described in the procedures
below.

Defining Default Colors
To define the default colors:

1. Select the Configuration tab.
2. Select Colors from the Views menu.
3. Select the Default tab in the Objects tree.
4. Under the Default tab, select an item: Activity Sets, Breaks, Days Off, Exceptions, Marked Time,

Meals, Time Off, and Work'.
Your choices will redefine the background and text colors of the selected item.
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5. The Colors Tool appears in the Working pane. Use the top half of the tool to select a background
color, and the bottom half to select a text color. View your current choices in the sample text SAMPLE
TEXT strip across the bottom of the Work pane.

6. Select one of the tabs in the top half of the Colors Tool to specify the method you will use to choose a
background color.
Each of these color picking methods should be familiar to anyone who has chosen colors on a personal
computer:
• Swatches offers a series of squares with specific colors. Click a square to select its color.
• HSB (Hue Saturation Brightness) offers a vertical sliding scale were you define the RGB components

and a color square where you select the HSB components. You can also enter numbers in fields on
the right side of the tool to define the HSB components.

• RGB (Red Green Blue) offers horizontal sliding scales or number box where you define the RGB
components.
Experiment with any or all of the color picking methods until you find a satisfactory background
color.

7. Select one of the tabs in the bottom half of the Colors Tool to specify the method you will use to
choose a text color.
Experiment with any or all of the color picking methods until you find a satisfactory text color.

Tip
The text color is only applicable in the Intra-Day Schedule and Agent-Extended Schedule views, when
you uncheck the Full view check box and can see the schedule items' short codes.

8. Save your choices, by clicking Save at the top of the window.

Important
If you select a different item in the Objects pane without saving, the Confirmation dialog box appears:
There are unsaved changes. Please press Yes to save changes, No to discard changes or Cancel
to cancel action. Click Yes, No, or Cancel.

Defining Specific Colors, by Site
To define specific colors by site:

1. Select the Configuration tab.
2. Select Colors from the Views menu.
3. Select the Specific tab in the Objects pane.
4. Under the Specific tab, expand ( ) one of the Types nodes.
5. In the Object tree beneath the Type node, select one or more objects. An object can be a business unit,

a site, or a specific color.
All your Colors Tool choices will apply only to the selected object(s).
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6. Make your background color and text color selections in the same way that is described in steps 4-8 for
default colors, in the default colors procedure above.
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Shared Transport
Use the Shared Transport view to create, update, copy, delete, and manage shared transport.

Important
Shared Transport is known by many different names worldwide—bus, carpool, ride
share, lift share, and paratransit, for example. See Wikipedia for details.

Accessing the Shared Transport View

Access this view in one of two ways:

• At the opening display of all WFM Web views, beneath Configuration, select Shared Transport
• Select the Configuration tab, click Configuration, and then select Shared Transport from the drop-

down menu.

Shared Transport Pane

The toolbar above the Shared Transport pane contains the following controls:

New
Creates a new shared transport, which begins by
opening the Properties tab.

Delete

Removes the selected shared transport. This
command cannot be undone. A confirmation dialog
box allows you to cancel or continue. This
command is not enabled if the shared transport
contains one or more agents who are not visible to
the current user (because of a lack of permissions).

Copy Opens the Copy Shared Transport pane.

Filter Filters the shared transport list by agent or team.

Sort
Sorts the shared transport list in ascending or
descending order. (You can also click the Shared
Transport column header to sort the list.)

This pane also includes a Search field and Help icon.
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Using the Shared Transport View

Use the Shared Transport view in one of two ways:

1. In the Object pane, select a site.

The Shared Transport pane lists all shared transport groups that are associated with your selection.
The list displays one shared transport group per row, with these columns:
Shared Transport Name of the shared transport group.
Status Open or Closed.

Comments Descriptive comments (if any) for the shared
transport group.

Size

Number of agents who are participating in the
shared transport group. This number could be
higher than the number of visible participants if
you do not have security permissions to view all
participants.

Bus

A selected check box indicates that this shared
transport group is the company bus. (To
designate a shared transport group as the bus,
select the Shared Transport Properties tab
and then select the This is the Bus check box.)

2. Select a single existing Shared Transport in the list, to highlight its row and open it's Properties tab.

Important
• If you change the shift start time or shift end time for an agent who belongs to a shared

transport group, a warning message appears, at these views:
• Master Schedule Intra-Day view
• Scenario Intra-Day view
• As well as when you are modifying individual agents' schedules

• You can use the Options dialog box to add the Shared Transport Groups column to
the grid columns table in the Master Schedule Intra-Day view. This column displays
the shared transport group participation for each agent on the selected day.

• For the Scenario Intra-Day view and Agent Extended view, you can use the Options
dialog box to add the following columns: Site Name, Shared Transport, Overtime,
Paid Hours, Total Hours, Start Time, and Comments.
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Shared Transport Settings

You configure settings on three tabs in the Shared Transport view (after clicking New or selecting
an existing shared transport):

• Properties Tab
• Participants Tab
• Join Requests Tab

At the top of all three tabs you will find the Save icon, which enables you to save the shared

transport settings in a particular tab, and the Help icon.

Properties Tab

Use these controls when you are creating or updating shared transport:

Shared Transport Name field Edit the name of the shared transport.
Shared Transport Status radio buttons Select Open or Closed.

This is the bus check box Designate this shared transport as the company
bus or clear to remove that designation.

Maximum Size field
Enter or select the maximum number of bus riders
for this shared transport. Enabled only if the This
is the bus check box is selected (use only if this
shared transport is a bus).

Comments field Enter or edit the comment text.

Participants Tab

Use these controls when you are adding participants to the shared transport:

Add Agents
Enables you to add agents to the Participants list,
by opening a list of Available Agents.

Remove Agents
Removes selected agents from the Participants
list. This action cannot be undone.

Sort
Sorts the participants list by First Name, Last
Name, or Team.
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The Participants tab also displays three columns: First Name, Last Name, and Team name of the
participants in the selected shared transport.

List of Available Agents
The Available Agents pane contains the following fields and controls:

Search field
Enables you to enter criteria, used to search for
available agents.

Search by:
radio buttons

Enables you to search for available agents by First
Name or Last Name.

Apply
Applies the agents you select from the Available
Agents list to the Participants list.

Close
Closes the Available Agents pane without
applying any selections.

Sort
Sort the available agents by First Name, Last
Name, or Team.

Join Requests Tab

Use these controls and columns when you are managing join requests:

Approve When clicked, approves the selected requests.

Decline When clicked, declines the selected requests.

Description of columns:

(pending)
Shows the question mark icon (pending) until the
request is approved or declined (see above) and
then the icon changes accordingly.

Agent Name of the agent who made this request to join
the shared transport.

Site Site of the agent who made this request to join the
shared transport.

Team Team of the agent who made this request to join
the shared transport.

Comments Shows any comments that relate to the Join
Request.
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Managing Shared Transport
Use the procedures in this topic to create, delete, copy, and add participants to shared transport, and
approve/decline join requests.

Creating Shared Transport
Link to video
To create shared transport:

1. In the Objects pane, select the site for the shared transport.

2. In the Shared Transport pane, click New .
3. When the Properties tab opens, enter the shared transport Name, Status, Maximum Size, and

Comments.
4. If the mode of transport is a bus, check This is the bus.

5. Click Save .
6. You can now add participants to the shared transport.

Deleting Shared Transport

To delete shared transport:

1. In the Shared Transport pane, select the shared transport you want to delete.

2. Click Delete .
When the Confirmation dialog opens click Yes to proceed or No to cancel the action. (Note
that this action cannot be undone.)

Adding Participants
Link to video
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To add participants to shared transport:

1. In the Shared Transport pane, select a shared transport and click the Participants tab.

2. Click Add Agents .
3. From the Available Agents list, select one or more agents.

You cannot exceed the maximum size that you set in the Properties pane.

4. Click Apply .

Copying Shared Transport
Link to video
To copy shared transport:

1. In the Shared Transport pane, select the shared transport you want to copy.

2. Click Copy .
3. When the Copy Shared Transport pane opens, change the name for the new shared transport.
4. If desired, check the Copy to the same Site check box.

Otherwise, associate a different site by expanding the Enterprise list to select a different
Site.

5. Click Apply , and then Save .
You can also choose to Close the Copy Shared Transport pane without applying your
selections.

Managing Join Requests
Link to video
To approve or decline shared transport Join requests:

1. Click a shared transport that you know has pending Join requests.
2. Click the Join Requests tab.

3. From the Join Requests list, select a request with a pending status .
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4. Click either Approve or Decline .
The pending column shows a check mark (✔) or an X, depending on your choice.

5. Click Save .
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Filtering Agents and Teams

When you have large numbers of agents and teams, you might want to use the Filter (found at
the top of the Shared Transport and Meetings panes) to easily and conveniently group them. For
example, you might want to filter agents associated with a certain team or site, or to filter teams
associated with a certain site.

After you have created one or more filters they appear as bullets above the Shared Transport or
Meetings list. If only one item is selected for the filter, the bullet shows the name of that item. If
more than one item is selected, the bullet shows the number of items in the filter.

Filtering Agents

To create a filter for selected agents:

1. Select a site.

2. Click Filter .
When the Agents and Teams tabs appear, the Agents tab is selected by default.

3. Click Add .
The Agents pane opens, containing a list of available agents and the following controls:

Search field
Enables you to enter criteria to quickly find
agents in long lists.

Search by:
radio buttons

Enable you to search for available agents by
First Name, Last Name or Employee ID.

Apply
Applies the agents you select from the Available
Agents list to the Filtered by Agents list.

Close
Closes the Available Agents pane without
applying any selections.

Sort
Sort the available agents by First Name, Last
Name, Employee ID, Site, or Team.

4. Select one of more agents, and click Apply .
5. In the Agents tab, if the filter contains all selected agents, click Apply again.

To remove an agent from the filter, click Remove before applying the filter. To close this pane
without applying any of the selected items, click Close .
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Filtering Teams

Filtering meetings by Team relies on a notion that all team members are also participants of the
meeting, otherwise the meeting is filtered out. Most likely, you will filter meetings by Team when you
are trying to find a meeting time that is suitable for the entire team (not just a single member of the
team).

To create a filter for selected teams:

1. Select a site.

2. Click Filter .
When the Agents and Teams tabs appear, select Teams.

3. Click Add .
The Teams pane opens, containing a list of teams and the following controls:

Apply
Applies the selected teams to the filter and adds
them to the Filter by Teams list.

Close
Closes the Teams pane and does not apply any
selections.

Search field
Enables you to enter criteria to quickly find teams
in long lists.

Sort Sorts the Teams list by Team or Site

4. Select one of more teams, and click Apply .
5. In the Teams tab, if the filter contains all selected teams, click Apply again.

To remove a team from the filter, click Remove before applying the filter. To close the Teams tab
without applying any of the selected items, click Close .

Viewing and Removing Filters

The Filters appear at the top of the Shared Transport list, which now contain only the filtered
items. Click any one of the bullets to see the items contained in that filter. For example, in the figure
below the Teams (2) filter was clicked, which opened the Teams tab displaying the items in that
filter.

To remove a filter without opening it, click the X in the bullet itself.
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Figure: Filter Bullets in Shared Transport View
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Agents
Use the Agents module to view and configure agent properties, and assign Activities, Contracts,
or Rotating Patterns to agents. The Agents module consists of the two panes described below.

Agents Pane

This pane displays a list of agents in the selected site within the enterprise, with the agent's first
name, last name, ID number, and hire date. Use the Search function to generate quick and accurate
results (even when using partial search criteria).

Properties Pane

This pane enables you to configure various settings in five categories. Click to open the following
panes:

1. Properties
2. Activities
3. Contracts and Rotating Patterns
4. Time Off
5. Time-Off Bonuses
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Agent Properties
To view the selected agent's properties, select Properties at the top of the pane.

This view contains the following agent information:

First name: The agent's first name.
Last name: The agent's last name.
Employee ID: The agent's employee identification number.
Site The agent's site.
Team The agent's team.

Email:
The email address that is used to notify agents of
schedule change events, schedule trade request
status changes, and time-off request status
changes.

Hire Date:

The hire date that is set as the date of import when
new agents are imported from Genesys
Administrator. You can change the date to the
agent's actual hire date. The Scheduler does not
include agents whose hire date is set as a date in
the future.

Termination Date:

The date on which the agent was terminated. To
set a termination date for an agent, select the
check box and enter a date for termination.

Agent properties are maintained in the Workforce Management
database, even after agents are deleted from Genesys
Administrator. However, you can choose to have deleted agents
hidden from view in Workforce Manager by changing the
CFG_SHOW_TERMINATED_AGENTS setting. Click About >
Setting... (near the Log out button) to open the dialog.

Hourly Wage:

Optional: A parameter that specifies the agent's
hourly wage and that is used in budgeting. You can
configure this option so that it appears only to
users with appropriate security rights in the Roles
module in Workforce Management Web.

Rank:

Optional: A setting that can be used as the criteria
for allocating the agents preferences during
scheduling. The value for any agent's ranking can
contain up to 5 digits. If you do not use ranking,
leave this parameter value at 0 (which is the lower
rank value). The rank setting affects Workforce
Management only; It is not related to the agent's
ranking that is configured in Configuration
Manager.

Comments: Any comments that are related to the agent.
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Save Now

To save any changes, click this icon at the top of
the pane.

Tip
If you do not have at least one of the Edit privileges in
the Agents view, this icon is disabled and you cannot
save changes.

Help
To view a Help topic about the Properties pane,
click this icon at the top of the pane.

Moving Agents to Other Teams or Sites

To move an agent to another team or site:

1. In the Agent Properties pane, select Move Agent .
2. In the Move Agent <agent_name> To Following Team pane, do one of the following:

• In the list of teams/sites, select the team or site.
• Enter the team or site name in the Search field to quickly find it, and then select it.

3. Click Apply .
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Agent Activities
To view the selected agent's activities, select Activities at the top of the pane. Then, use the
controls in the top-right corner of this pane to complete the following tasks:

Add Activity Click to add an activity for the selected agent.

Delete Activity Click to delete an activity for the selected agent.

Save Now Click to save any changes.

Help
Click to view a Help topic about the Properties
pane.

Tip
If you do not have the Edit Activities privilege in the Agents view, the Add Activity
and Delete Activity icons are disabled.

Activities Pane

This pane displays a list of activities that are assigned to an agent and contains detailed information
in two sections (Activities and Agent's Skills) about the activities in the following columns:

Activities Section

Name The name of the activity that is assigned to the
agent (sortable column).

Site
The name of the site at which the agent is
configured; It might be a site, other than the one in
which the agent currently appears, if the agent was
moved to another site.

Status

The agent's status, which determines the activities
on which the agent is eligible to work. For example:

• Primary—Works as if the agent became eligible
for an activity, based on his/her primary skills.

• Secondary—Works as if the agent became
eligible for an activity, based on his/her
secondary skills.
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• Disabled—Specifies explicitly that the agent
cannot work on this particular activity, even if
his/her skills allows it.

• Auto—Cancels any previous explicit assignment
and returns to determining the activity
eligibility, based on the agent's skills.

Effective Date

The start date on which the agent becomes eligible
to work on the activity with the specified status.
The explicit agent activity assignment does not
have an end date. One assignment must be
replaced by another one. This assignment has daily
granularity and uses shift days, rather than
calendar days.

Important
You cannot specify a time of day that the effective
date for activities will begin.

Skilled

Displays the agents eligibility to work on the
assigned activity, based on the skill set. This value
can be Primary, Secondary, or N/A (if the skill is
disabled for agent or is absent altogether). This
value is overridden by the value in the Status
column.

In the Activities pane, click Add Activity to open another pane, in which you can add an
effective date for the Activity, set the status, and select the Activity to assign from a list of available
Activities.

Agent's Skills Section
This section displays a list of the selected agent's current skills in three columns, as shown in the
table below. To change the skill Status in this pane, click the drop-down list to select Disabled,
Primary, or Secondary.

Skill The name of the selected agent's skill.
Level The selected agent's skill level.

Status

The selected agent's current status.

Tip
If you do not have the Edit Activities privilege in the
Agents view, this column is disabled.
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Adding an Activity

To add and activity to the selected agent:

1. Double-click the Effective Date field to change the date or keep the current date (default).
2. In the Status drop-down list, select Primary, Secondary, Auto, or Disabled.
3. In the Activities to be Assigned to Agents list, click an activity to assign to highlight it.

4. Click Assign Activity . The activity displays in the Activities pane.
5. Click X to close the assignment pane.

Deleting an Activity

To delete an activity:

1. Select an activity.

2. Click Delete Activity .
3. When the Confirmation dialog opens, click Yes to proceed or No to cancel the deletion.

If you select Yes, you cannot undo the deletion of the activity.

Configuration Agents

Workforce Management Web for Supervisors Help 166



Agent Contracts and Rotating Patterns
To view, add or delete the selected agent's assigned contracts or rotating patterns, select Contracts
& Rotating Patterns at the top of the pane.

Use the controls in the top-right corner of this pane to complete the following tasks:

Add Contract or Rotating Pattern
Click to add a contract or rotating pattern for the
selected agent.

Delete Contract or Rotating Pattern
Click to delete a contract or rotating pattern for the
selected agent.

Save Now Click to save any changes.

Help
Click to view a Help topic about the Properties
pane.

Tip
If you do not have the Edit Contracts & Rotating Patterns privilege in the Agents view,
the Add/Delete Contracts and Add/Delete Rotating Patterns icons are disabled.

This view is divided into two sections: Contracts and Rotating Patterns.

To configure contracts, see the Contracts topic in this Help file. To configure rotating patterns, see
the Rotating Patterns topic.

Review Validation Messages
If you make changes that do not pass validation, the Review Validation Messages pane is
displayed, which includes a list of error and warning messages. For more information about these
messages, see Review Validation Messages.

Contracts Section

The Contracts and Rotating Patterns pane displays a list of contracts and rotating patterns that
are assigned to an agent, containing detailed information in two sections. The details for the assigned
contracts are displayed in the following columns:

Name The name of contract that is assigned to the
selected agent (a sortable column).

Effective Date A start date on which the assigned contract
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becomes effective for the agent. Agents can have
multiple contracts assigned to them with different
effective dates. All contracts that are assigned to
an agent must have different effective dates.
Therefore, on any specified day, the agent has only
one effective contract. The effective date of
assignment for the contract has daily granularity.

• You can also assign contracts with an effective
date to agents in the Agents pane.

• You cannot specify a time of day that the
effective date for contracts will begin.

In the Contracts pane, click Add to open another pane, in which you can add an effective date
for the contract. Then, select the contract to assign from a list of available contracts, configured
under the site in the Contracts pane.

Adding Contracts
To add a contract to the selected agent:

1. Double-click the Effective Date field to change the date or keep the current date (default).
2. In the Contracts to be Assigned to Agents list, click a Contract to assign or highlight it.

3. Click the arrow to assign the contract. The contract displays in the Contracts pane.
4. Click X to close the assignment pane.

Deleting Contracts
To delete a contract:

1. Select a contract.

2. Click Delete .
3. When the Confirmation dialog opens, click Yes to proceed or click No to cancel the deletion.

If you select Yes, you cannot undo the deletion of the contract.

Rotating Patterns Section

The detailed for the assigned rotating patterns are displayed in the following columns:
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Name The name of rotating pattern that is assigned to
the selected agent (a sortable column).

Effective Date

A start date on which the assigned rotating pattern
becomes effective for the agent. The agent can
have multiple rotating patterns assigned to him/her
with different effective dates. All rotating patterns
that are assigned to an agent must have different
effective dates. Therefore, on any specified day,
the agent has only one effective rotating pattern.
The effective date of assignment for the rotating
patterns has daily granularity.

• You cannot specify a time of day that the
effective date for rotating patterns will begin.

Starting Week
Specifies the weekly pattern that is configured in
the rotating pattern that on the effective date the
agent starts to work. (For example, Week 1, Week
2, Week 3.)

In the Rotating Patterns section, click Add to open another pane, in which you can add an
effective date for the rotating pattern. Then, select a starting week, the rotating pattern to assign
from a list of available rotating patterns, which are configured under the site in the Rotating Patterns
pane.

Adding Rotating Patterns
To add and rotating pattern to the selected agent:

1. Double-click the Effective Date field to change the date or keep the current date (default).
2. In the Starting Week drop-down list, select the week that you want the rotating pattern assignment to

begin.
For example, Week 1, Week 2, Week 3, etc.

3. To distribute the rotating pattern across an increased number of weeks, at the top of the pane, click the

Calendar .
The Distribution pane displays, containing a list of rotation weeks.

4. To increase the number of rotation weeks, click More .
The number of rotation weeks in the list increases exponentially.

5. Click X to close the Distribution pane.
6. In the Rotating Patterns to be Assigned to Agents list, click a rotating pattern to assign by

highlighting) it.

7. Click the arrow to assign the rotating pattern.
The rotating pattern displays in the Rotating Patterns pane.

8. Click X to close the assignment pane.
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Deleting Rotating Patterns
To delete a rotating pattern:

1. Select a rotating pattern.

2. Click Delete .
3. When the Confirmation dialog opens, click Yes to proceed or No to cancel the deletion.

If you select Yes, you cannot undo the deletion of the rotating pattern.
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Agents Time Off
In the Time Off pane, you can add, edit, and delete Time-Off Rules and Time-Off types that are
associated with selected agents. Use the controls in the top-right corner of the following panes to
complete the described tasks:

Time Off Pane Controls
[[File: WM_851_icon-
object_tree_checkbox_cleared.png]|alt=Show
historical button] Show Historical check box

Enter a check mark to display time-off rules that
contain historical data (the selected agent's time-
off balance).

Associate Time-Off Rule and Time-Off
Type with Agent

Click to associate the selected agent with time-off
rules and time-off types.

Remove Time-Off Rule and Time-Off Type
association from Agent

Click to disassociate the selected agent from time-
off rules and time-off types.

Save Now Click to save any changes.

Help Click to view a Help topic about the Time Off pane.

Tip
If you do not have at least one of the Edit Time Off privilege in the Agents view, the
Associate and Remove Time-Off Rules icons are disabled and you cannot make
these changes.

Time Off Historical Data

Historical data refers to the calculated balance in time-off rules. When the Show Historical check
box is checked or enabled, the list of time-off rules (available for selection) will include rules that
have calculated balances. If you select a rule, the Time-Off Rule Assignment Properties pane opens,
displaying the details of the rule's assignment, calculated carry-over balances, and time-off types.
The Show Historical check box is cleared by default.

Time-off rules that contain historical data can be deleted, but it is not recommended, because it can
affect the agent’s time-off balance.
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Assigning Time-Off Rules and Types
Use the Time-Off Rule Assignment Properties pane to assign time-off rules and time-off types to
agents, using the controls and procedures described in this topic.

Associating Time-Off Rules and Time-Off Types with Agents

To associate a time-off rule and time-off types with the selected agent:

1. In the Agents Properties pane, click Time Off.

2. Click Associate Time-Off Rule and Time-Off Types with Agent .
The Time-Off Rule Assignment Properties pane opens.

3. Select a Time-Off Rule from the drop-down list .
4. Enter a Start Date and End Date, or click within either field to open a calendar, from which you can

select a date.
The Start Date is pre-populated with the current date, but you can change it, if necessary.
If you check the box at end of the End Date field, WFM Web enters the current date
automatically.

5. Click Add Time-Off Types to a Time-Off Rule .
The Time-Off Types pane opens.

6. Select one or more time-off types from the list and then, click Apply .
To find a specific types, enter criteria in the Search field. For example, enter the name of the
each time-off type you want to find.

7. After the selected time-off types appear in the Properties pane, in the Transfer Balance column you
can:
• Leave the check box enabled (checked by default) to carry over the balance from the previous rule.
• Clear the check box to accrue a new balance for this rule.

8. Click Apply .

9. In the Time Off pane, click Save Now .

Editing Time-Off Rules and Time-Off Types Associated with Agents
To edit an existing time-off rule and time-off types associated with an agent:

1. In the Time Off pane, select the rule you want to edit.
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2. The Time-Off Rule Assignment Properties pane opens.
3. Make the necessary changes, following steps 3-9 in Associating Time-Off Rules and Time-Off Types with

Agents.

Deleting Time Off
To delete a time-off rule and time-off types currently associated with an agent:

1. In the Time Off pane, select the rule you want to delete.

2. Click Remove Time-Off Rule and Time-Off Types association from Agent .
3. When the Confirmation dialog opens, click Yes to proceed or No to cancel the action.

4. In the Time Off pane, click Save Now .

Time-Off Rule Assignment Properties controls

Use the following controls in the Time-Off Rule Assignment Properties pane:

• Apply—Click to associate the configured time-off rule and time-off types with the agent.

• Close—Click to close the pane.

• Help—Click to view a Help topic about the Agent Time-Off Rules Properties pane.
• Time-Off Rules drop-down list—Click to select a time-off rule that controls how the agent's time-off

hours are accrued/awarded.
• Start Date—Click to open a calendar, from which to choose a start date for the selected time-off rule.

The default date is the current day.
• End Date—Click to open a calendar, from which to choose an end date for the selected time-off rule.
• Current Day check box—Click to automatically populate this field with the current date.

Carry-Over Details controls

In the Time Off tab, time-off rules that have calculated carry-over balances are colored gray, and
when selected, open the Time-Off Rule Assignment Properties pane, displaying the Carry-Over
Details controls.

Time-off rules that have no calculated carry-over balance are colored black and when selected, opens
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the Time-Off Rule Assignment Properties pane without displaying the Carry-Over Details
controls.

The carry-over details controls are:

• Carried Hours—The number of hours that have been carried over for this agent.
• Accrued Hours—The number of hours that have accrued for this agent.
• End Date Balance—The number of hours that are left at the end date for this rule.
• Awarded Bonus Hours—The number of awarded bonus hours accrued for this agent.
• Used Bonus Hours—The number of bonus hours that this agent has used.
• Expired Bonus Hours—The number of bonus hours that have expired.
• Scheduled Hours—The total number of scheduled hours for this agent.
• Granted Hours—The total number of hours that have been granted for this agent.
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• Preferred Hours—The total number of preferred hours for this agent.
• Declined Hours—The total number of hours that have been declined for this agent.

Time-Off Types controls

Use the following controls in the Time-Off Types pane:

Add Time-Off Types to a Time-Off Rule Click to add time-off types to a time-off rule.

Remove Time-Off Types from a Time-Off
Rule

Click to delete time-off types from a time-off rule.

Apply
Click to apply the selected time-off types to the
time-off rule assignment.

Close Click to close the pane.

Search
Enter search criteria to find time-off types quickly.
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Time-Off Bonuses
When you create time-off rules, you configure time off to be either accrued or awarded. On the other
hand, time-off bonuses are awarded. You configure them (add, edit, and delete) as described in the
procedures below.

Tip
If you do not have the Edit Time-Off Bonuses privilege in the Agents view, the Add
and Delete Time-Off Bonuses icons are disabled.

Time-Off Bonus End Dates

Time-off bonuses may or may not have a set End Date property, but it's important to understand how
the End Date property affects the way in which WFM counts unused hours when processing carry-
over hours.

If the time-off bonus has a specified end date, WFM processes carry-over as follows:

• If the end date of the bonus time is before the carry-over date, the bonus expires and WFM does not
carry over any hours.

• If the end date of the bonus is after the carry-over date, the bonus remains assigned after the carry-
over date (it doesn't expire on carry-over date) and WFM fixes the used hours in the carry-over record,
meaning the unused hours pass to the new carry-over period and they are not subject to the maximum
carry-over hours constraint.

If the time-off bonus does not have a specified end date, WFM carries over the bonus hours to the
next configured carry-over date. The total number of hours carried over is subject to the maximum
carry-over hours constraint. The bonus expires after the carry-over date. Any used hours are updated
as they were before.

Adding Time-Off Bonuses

To add a time-off bonus for a selected agent:
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1. Select an agent and then, in the Agent Properties pane, click Time-Off Bonuses.
The Agent Time-Off Bonuses pane opens.

2. Click Add Agent Time-Off Bonus .
The Time-Off Bonuses Properties pane opens.

3. Select a Time-Off Type from the drop-down list.
4. Enter a Start Date and End Date, or click within either field to open a calendar, from which you can

select a date.
The Start Date is pre-populated with the current date, but you can change it, if necessary.
If you check the box at end of the End Date field, WFM Web enters the current date
automatically.

5. In the Bonus Hours field, enter the number of hours you want to award the selected agent.
6. In the Comments field, enter any additional relevant information.

7. Click Apply .

8. In the Agent Time-Off Bonuses pane, click Save Now .

Editing Time-Off Bonuses

To edit an existing time-off bonus:

1. In the Agent Time-Off Bonuses pane, select the bonus that you want to edit.
2. When the Time-Off Bonus Properties pane opens, make the necessary changes following the steps

3-8 in Adding Time-Off Bonuses.

Deleting Time-Off Bonuses

To delete an existing time-off bonus:

1. In the Agent Time-Off Bonuses pane, select the bonus you want to delete and click Delete Agent

Time-Off Bonus .
2. When the Confirmation dialog opens, click Yes to proceed or No to cancel the action.

3. Click Save Now .
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Organization
You must have security rights to the Configuration > Organization module to view it.

In this module, you can configure the following objects:

• Business Units
• Sites
• Time Zones

In the Organization > Business Units view, you can associate the following objects with a
business unit:

• Sites
• Skills

In the Organization > Sites view, you can associate the following objects with a site:

• Teams
• Agents
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Business Units
A business unit (BU) consists of a set of sites that may be grouped together because the agents at
the sites perform the same activity, or for ease of management. Go to Configuration >
Organization > Business Units to view this pane.

For monitoring purposes, you can group activity results from the various locations as a single
business unit, allowing contact center managers to evaluate activity performance across locations.
For display and staffing purposes, Workforce Manager splits the activity load among the sites that
compose the business unit.

Use these panes to:

• Create a new business unit or edit an existing one.
• Delete a business unit.
• Copy a business unit.
• Use the Sites pane to link sites to a business unit.

Business Unit Pane Controls

Search field
Enter the search criteria. For example, the name of
the business unit.

New Click to create a new business unit.

Delete Click to delete the selected business unit.

Copy
Click to copy the selected business unit to create a
new one.

Help
Click to view a Help topic for the Business Unit
pane.

When you create a business unit, the Properties pane is open for any selected business unit. It is
the default selection in this pane. (The other selection is Sites.)

Properties Pane Controls

Save Now
Click to save the properties after you have entered
them or made changes.

Help Click to view a Help topic for the Properties pane.
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Name field Enter a name for the business unit.
Time Zone drop-down list Click to select a time zone for this business unit.
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Creating Business Units
To create a new business unit:

1. In the Configuration > Organization module, select Business Unit.

2. In the Business Unit pane, select New .
By default the Properties pane for this business unit is open.

3. In the Name field, enter a name for the business unit.

Important
New Business Units are created with the default name, New Business Unit (<number>). The BU name
must be unique. Therefore, Genesys recommends that you change it to a unique name, otherwise an error
message appears prompting you to edit the name.

4. In the Time Zone drop-down list, select a time zone for the new business unit.

5. Click Save Now .
A new business unit appears.

For help with configuration of your new business unit, see Business Unit Properties.

Creating New Business Units Using Copy

To create a new business unit by copying an existing one:

1. In the Business Unit pane, select a business unit.

2. Click Copy .
The new business unit appears in the Business Units list with the same time zone as the business unit
you copied.

3. Do the rest of the configuration as described in Business Unit Properties and Business Unit Sites.

4. Click Save Now .
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Business Unit Properties
When you click an existing business unit (BU) name in the Business Units pane, the Business Unit
Properties pane opens by default.

Use this pane to edit the business unit:

• Business Unit Name—Enter a name that is unique in the WFM environment.
• Time zone—This shows the default time zone. To change it, select a different time zone from the drop-

down box.
• Week Start Day—Use this drop-down menu to set the first day of the week for all Sites under the

Business Unit, including the week start day when creating schedules. You can choose from any day of
the week.

The week start day is important for proper scheduling and schedule-related weekly totals. WFM Web
differentiates between how it displays and uses the week start day. Within the interface, where the
week start day is not vital for proper data presentation, WFM uses the browser locale settings. Where
the week start day is used for presentation or validation purposes, WFM uses the setting specified in
the BU.

Additional Options

In the right-side pane, select Sites for additional business unit configuration options.
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Business Unit Sites
The Business Units Sites pane enables you to select the sites you want to be included in the
business unit. To open it, select a BU and in the right-side pane, click Sites.

Sites Pane Controls

Save Now
Click to save the properties after you have entered
them or made changes.

Add Site to Business Unit
Click to add a site to a business unit. When
clicked, opens a list of available sites from which to
choose.

Help Click to open a Help topic for the Sites pane.

Available Sites Pane Controls

Apply
Click to apply this site to the selected business
unit.

Close Click to close the Available Sites pane.

Help
Click to open a Help topic for the Available Sites
pane.

Adding Sites to Business Units
To add a site to your business unit:

1. Select a business unit.

2. In the Sites pane, select Add Sites to Business Unit .
The Available Sites pane opens.

3. Select a site and click Apply .
The site appears in the Sites pane and is assigned to the selected business unit.

Tip
If you select a site that cannot be applied for any reason, the Review Validation Messages pane opens with
an error description.
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Sorting Sites in Lists

To sort the sites in a list, click the header of the column by which you want to sort the sites.
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Business Unit Skills
Using the Business Units > Skills pane, you can select the skills you want to include in a business
unit (BU). To open this pane, select a BU and in the right-side pane, click Skills.

Skills are imported into WFM automatically during synchronization, but they are first defined and
assigned to agents in Genesys Administrator. In WFM, skills are assigned to business units (not sites).
A skill is assigned to one business unit only and can be assigned only to activities and profiles under
this business unit.

Read more about skills in the Workforce Management Administrator's Guide.

Skills Pane Controls

Save Now
Click to save the properties after you have entered
them or made changes.

Add Skills to Business Unit
Click to add a skill to a business unit. When clicked,
opens a list of available skills from which to choose.

Remove Skills from Business Unit Click to remove a skill from a business unit.

Help Click to open a Help topic for the Skills pane.

Available Skills Pane Controls

Apply
Click to apply this skill to the selected business
unit.

Close Click to close the Available Skills pane.

Help
Click to open a Help topic for the Available Skills
pane.

Adding Skills to Business Units
To add a skill to your business unit:

1. Select a business unit.

2. In the Skills pane, select Add Skills to Business Unit .
The Available Skills pane opens.
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Important
The Available Skills pane contains unassigned skills only. To assign this same skill to another BU, you must
first unassign it from this BU.

3. Select a skill and click Apply .
The skill appears in the Skills pane and is assigned to the selected business unit.

Tip
If you select a skill that cannot be applied, the Review Validation Messages pane opens with an error
description.

4. Click Save Now .

Removing Skills from Business Units
To remove a skill from a business unit:

1. In the Skills pane, select the skill you want to remove.

2. Click Remove Skills from Business Unit .
3. When the Confirmation dialog opens, select Yes to proceed or No to cancel the action.

4. Click Save Now .

Sorting and Searching Skills Lists

To sort the skills in a list:

• Click the header of the column by which you want to sort the skills.

To search for skills in a list:

• Type the skill name in the Search field and press Enter.
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Business Unit Configuration
You must have the Access backend configuration security right to view the Business Units >
Configuration pane.

Use the Configuration pane and the parameters described below to configure the Data Aggregator
(DA) setup for the Business Unit.

• Data Aggregator—Select the Data Aggregator instance for this business unit. If the application
selected is not validated by Genesys Configuration Server or if no application is selected, WFM uses the
default value <none>.

• Restart Data Aggregator icon—Click to restart DA. (WFM Web prompts you to save any
outstanding changes before restarting.)

• Stat Server—A read only field, containing the name of Stat Server Application that is specified in the
selected Data Aggregator Application's connection properties. If there is no selected DA, or if DA
Application or the Stat Server ID is invalid, this field is empty.

• Tenant—Enter the name of the tenant. The default value is Environment.
• Tenant Password—Enter the tenant password that was set in Genesys Administrator. If not set in

Genesys Administrator, the password is blank. This value does not display in plain text.
• Time Profile—From the drop-down list, select a time profile. This list is populated with data from Stat

Server Application's Options\TimeProfiles section. The default value is <none>.
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Sites
Sites can be equivalent to switches, which are defined in Genesys Configuration Manager and
imported into WFM.

You can create sites in WFM that are unrelated to a switch. This is appropriate when switches do not
correlate with your company's organization. For example, a single location could be divided into
multiple entities to reflect divisions along business unit lines.

Go to Configuration > Organization and select Sites. Now you can:

• Create new sites
• Edit sites
• Delete sites
• Associate agents with sites
• Distribute agents between teams.
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Site Properties
When you create a site or select an existing one, the properties for that site are displayed in the Site
Properties pane. At the top of this pane, you can view additional configuration settings for the site,
by selecting Teams or Agents.

The fields in the Properties pane are:

• Name—Enter a name for a new site or edit the existing one. The name must be unique in the WFM
environment.

• Associated Switch—A read-only field that shows the switch associated with the site as configured in
Genesys Administrator.

• Maximum Number of Seats—The maximum number of seats in the center. This places a limit on the
number of agents that Workforce Manager can schedule at any given time. Some combinations of
activity sets and task sequences might conflict with this constraint. In cases of conflict, Scheduler gives
priority to the activity set.

• Time Zone—The default time zone. To change it, select the desired time zone from the drop-down list.
• Business Unit—The business unit, with which the site is associated.
• Alarm Threshold—The number of minutes before or after a Schedule State Group is scheduled to

occur before an agent is considered severely non-adherent. Can be set to any integer between 0-1440
(24 hours). The default value is 5 minutes.

• Allow auto-approval of schedule trades—Check this box to enable auto-approval of this trade type.
Clear it to require manual approval of all agent schedule trades.

• Allow Agents to create Shared Transport—Check this box to enable agents on this site to create
and modify shared transport groups.

• Paid Breaks are mandatory—Check this box to make paid breaks mandatory during scheduling. By
default, the check box is cleared. (See Tip below.)

• Suppress Break-related warnings while scheduling—Check this box to suppress break-related
warnings during scheduling. By default, the check box is cleared. (See Tip below.)

Tip
There's more information about mandatory paid breaks, suppressing break-related
warnings, and scheduling breaks and meals in conjunction with exceptions in the
Workforce Management Administrator's Guide.

The following check boxes exist while you are creating a new site. After the site is saved these check
boxes are no longer visible:

• Generate default Schedule State Groups and Exception Types—Check this box to enable WFM to
create default schedule state groups and exception types.
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• Associate existing exceptions with site—Check this box to enable WFM to verify that none of the
newly created exception types for the site's BU have the same name as an existing exception type. If
there is duplication, WFM adds a new site to its associated sites. If no duplication exists, a new
exception type is created.
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Creating, Editing, and Deleting Sites
Use the following Site pane controls to create, edit, and delete sites:

Search field
Enter the search criteria. For example, the name of
a site.

New Click to add a new site.

Delete Click to delete an existing site.

Copy Click to copy the selected site.

Help Click to open a Help topic for the Sites pane.

Creating New Sites

1. In the Configuration module, select Organization > Sites.

2. In the Sites pane, click New .
3. On the Properties pane, in the Name field, enter a name for the site.

The name must be unique in the WFM environment.
4. In the Maximum Number of Seats field, enter the maximum number of seats in this site.
5. From the Time Zone drop-down list, select a time zone for the site.
6. From the Business Units drop-down list, select the business unit, with which you want to associate this

site.
7. In the Alarm Threshold field, enter a value for the alarm.

See Alarm Threshold, for information about this parameter.
8. Check the Allow auto-approval of schedule trades if you want the agents in this site to have

automatic approval for any schedule trade requests. If not, leave the check box empty.
9. Check the Allow Agents to Create Shared Transport if you want the agents in this site to be able to

make shared transport requests. If not, leave the check box empty.
10. Check the Generate default Schedule State Groups and Exception Types if you want WFM to

create default schedule state groups and exception types. If not, leave the check box empty.
11. Check the Associate existing exceptions with site if you want WFM to verify that none of the newly

created exception types for the site's BU have the same name as an existing exception type. If not,
leave the check box empty.

12. Click Save Now .
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For help with configuration of your new site, see Site Properties.

Creating Sites Using Copy

To create a new site by copying an existing one:

1. In the Sites pane, select a site and click Copy .
2. In the Properties pane, rename the new site and configure the properties, if required.

Although some of the configuration settings transfer from the original to the copy, you must do the
rest of the configuration as described in Site Properties and Associating Agents with a Site.

Editing Sites

To configure a site or edit its configuration:

1. In the Sites pane, select it.
2. Enter the appropriate settings as described in Site Properties.

Settings on the Agents pane are described in Associating Agents with a Site.

Deleting Sites

To delete an existing site:

1. In the Sites pane, select the site you want to delete.

2. Select Delete .
3. When the Confirmation dialog opens, click Yes to continue or No to retain the selected site and it's

properties.
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Associating Teams with a Site
You can associate teams with an existing site or with a newly created site, by selecting Teams at the
top of the Properties pane.

The Teams pane controls are described below.

Teams Pane Controls

Save Now Click to save the configuration in the Teams pane.

Create Team Click to create a new team within the site.

Delete Team Click to delete the selected team from the site.

Help Click to open a Help topic for the Teams pane.

You can sort the Team list, by clicking the Team Name column header.

When you create a new team, the Team Properties pane opens. Agents who are associated with the
selected team appear in the Team Properties pane.

When you click Add Agent to Team ( ), agents appear in the Available Agents pane and can be
filtered by Last Name, First Name, or Employee ID. By default, all agents to which you have
access appear in this pane. You can edit the team name, add or remove agents from the team, and
remove agents from the site

Team Properties Pane Controls

Save Now
Click to save the configuration in the Team
Properties pane.

Close Click to close the Team Properties pane.

Help
Click to open a Help topic for the Team Properties
pane.

Name field Enter a name for the team.

Add Agent to Team Click to add agents to the team.
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Remove Agent from Team Click to remove agents from the team.

Remove Agent from Site
Click to remove agents from the site.

When you add agents to a team, the Available Agents pane opens. See the Available Agents Pane
Controls. You can filter this list to display only agents from certain business unit(s) or the entire
enterprise, and to include unassigned agents in the enterprise or business unit. See Agent Filter.

To sort agents in the Available Agents pane, click any one of the column headers.

Adding and Removing Agents from a Team
To add an agent to a team:

1. In the Teams pane, click Add Agents to Team .
The Available Agents pane opens.

2. Select an agent from the list and click Apply . (Use CRTL or SHIFT to select several agents at a
time.)

3. After you have finished assigning agents, click Close in the Available Agents pane.

To remove an agent from a team:

1. In the Teams pane, select the agent you want to remove. (Use CNTRL or SHIFT to select several agents
at a time.)

2. Click Remove Agent from Team .

To remove an agent from a site:

1. In the Teams pane, select the agent you want to remove.

2. Click Remove Agent from Site .

3. Click Save Now .

Warning
When you move an agent from one site to another site, the agent's historical
schedules are still available to be viewed and reported. However, any Calendar items
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related to that agent will not be available when building future schedules for the new
site. This is because items, such as Time-Off Types, Exception Types, Contracts, and
Shifts, are configured separately for each site.
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Associating Agents with a Site
You can associate agents with an existing site or with a newly created site, by selecting Agents at
the top of the Properties pane.

The Agents pane has the following controls:

Agents Pane Controls

Save Now Click to save the configuration in the Agents pane.

Search By radio buttons Select one of three radio button to find an agent in
the list: Last Name, First Name, Employee ID.

Search field Enter the search criteria. For example, the agents
first name.

Add Agent to Site Click to add agents to the site.

Remove Agent from Site
Click to remove agents from the site.

Help Click to open a Help topic for the Agents pane.

Agents who are associated with that site appear in the Available Agents pane and can be filtered.
By default, all agents to which you have access appear in this pane.

Available Agents Pane Controls

Apply Click to assign an agent to a site.

Close Click to close the Available Agents pane.

Help
Click to open a Help topic for the Available
Agents pane.

Search By radio buttons
Select one of three radio buttons to find an agent
in the list: Last Name, First Name, Employee
ID.

Search field
Enter the search criteria. For example, the agents
first name.

Click to filter the list of available agents, by
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Filter

opening the Agent Filter pane.
You can filter this list to display only agents from certain
business unit(s) or the entire enterprise, and to include
unassigned agents in the enterprise or business unit. See the
figure below.

Figure: Agents Pane—Filtering

Sorting Agents in Lists

To sort agents in either the Agents or Available Agents pane, click the header of the column in
which you want to sort the agents.

Adding and Removing Agents from a Site
To add an agent to a site:

1. In the Agents pane, click Add Agent to Site .
The Available Agents pane opens.

2. Select an agent from the list and click Apply . (Use the CTRL or SHIFT keys to select several agents
at a time.)

3. After you have finished assigning agents, click Close in the Available Agents pane.

To remove an agent from a site:
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1. In the Agents pane, select the agent you want to remove. (Use the CTRL or SHIFT keys to select several
agents at a time.)

2. Click Remove Agent from Site .

Warning
When you move an agent from one site to another site, the agent's historical
schedules are still available to be viewed and reported. However, any Calendar items
related to that agent will not be available when building future schedules for the new
site. This is because items, such as Time-Off Types, Exception Types, Contracts, and
Shifts, are configured separately for each site.
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Site Configuration
You must have the Access backend configuration security right to view the Sites > Configuration
pane.

Use the Configuration pane and the parameters described below to configure the Data Aggregator
(DA) setup for the site.

• Data Aggregator—Select the Data Aggregator instance for this site. If the application selected is not
validated by Genesys Configuration Server or if no application is selected, WFM uses the default value
<none>.

• Restart Data Aggregator button—Click to restart DA. (WFM Web prompts you to save any
outstanding changes before restarting.)

• Stat Server—A read only field, containing the name of Stat Server Application that is specified in the
selected Data Aggregator Application's connection properties. If there is no selected DA, or if the DA
Application or Stat Server ID is invalid, this field is empty.

• Tenant—Enter the name of the tenant. The default value is Environment.
• Tenant Password—Enter the tenant password that was set in Genesys Administrator. If not set in

Genesys Administrator, the password is blank. This value does not display in plain text.
• Time Profile—From the drop-down list, select a time profile. This list is populated with data from Stat

Server Application's Options\TimeProfiles section. The default value is <none>.
• Switch Used for Statistics—Select the switch that will be used for handling statistics. The default

value is <none>.
• Associated Switch—Select the switch that is associated with the site that will be used to synchronize

Genesys configuration objects.
• Unassign Agents in case Genesys login is deleted check box—Enter a check mark in this box if

you want WFM to automatically unassign from this site, any agent whose login is deleted from this
site.

• Assign agents if logins are for this Site only check box—Enter a check mark in this box if you
want WFM to automatically assign to this site, any agent whose login is only valid for this site.

• Dedicated WFM Server—Select the WFM Server instance that will be used for forecasting,
scheduling, trading, and performance and adherence measurements. If the WFM Server Application
option SynchronizationLevel is set to 1, it synchronizes agents under the Associated Switch
selected in this pane. The default value is <none>.
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Time Zones
Time zones are initially set up in Genesys Administrator and then imported into Workforce
Management automatically during synchronization.

Time Zones List

The Time Zones list displays all time zones that were imported during synchronization. You can only
apply time zones that are in this list to WFM objects, such as sites or business units.

Use the scroll bar or enter criteria into the Search field to find the a time zone.

Daylight Saving Information

Each seasonal daylight saving time change must be configured in advance to record historical data
using the correct local time.

Synchronizing Time Zones

WFM Server transfers all time zones configured in Genesys Administrator into Workforce Management
through automatic synchronization.

Synchronization overrides the daylight saving settings you have configured for time zones unless you
select Do Not Synchronize when you configure your daylight saving offset. See Time Zone Settings
for this procedure.
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Time Zone Settings
You configure Time Zones by specifying new seasonal time change settings or editing the existing
settings for a time zone.

Specifying Daylight Savings Information

To specify new Daylight Savings information:

1. Use the scroll bar or enter criteria into the Search field to find the time zone you want to edit.

2. In the Settings pane, Add Daylight Saving information to the time zone, by clicking .
The Daylight Saving Information pane opens.

3. Enter the Start Date and Time and the End Date and Time for which the offset is to be effective.

Important
You cannot enter two different time offsets for the same period. If a site and a business unit share the same
time zone, the settings for both are changed when you edit information for one.

4. In the Offset field, enter the number of minutes that the daylight saving time differs from the standard
time or click the up or down arrow button until the correct number of minutes appears.
The offset can be negative (the clock resets to an earlier time) or positive (the clock resets to a later
time). The time offset cannot be zero (0).

For example, to make the change from U.S. daylight savings time to standard time (fall back), enter 60
as the time offset value. At the end of the time period you select, the offset is automatically reversed.
In the example of U.S. daylight savings time, your system time will reset (spring forward) 60 minutes at
the beginning of the next daylight savings time period.

Important
This offset must be a number divisible by 30.

5. Click Apply to save your changes.
6. Select the Do Not Synchronize check box in the Settings pane, if you do not want the Genesys

Administrator settings to override the settings that you configure in the Workforce Management Web
when automatic synchronization occurs.
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Important
If you leave Do Not Synchronize unselected, automatic synchronization will affect the current year settings.
For example, 2 a.m. GMT will be changed to the equivalent of that time in the PST time zone (which is GMT-8).

Editing Daylight Savings Information

To edit the Daylight Savings information:

1. In the Time Zones list, select the time zone that has the Daylight Saving information you want to
change .

2. In the Settings pane, click Daylight Savings Information to open that pane.
3. To configure the settings, see steps in Specifying Daylight Savings Information.

4. When you are done editing, click Apply to save your changes.

Deleting Daylight Savings Information

To delete Daylight Saving settings for a time zone:

1. In the Daylight Savings Information pane, select the click Remove Daylight Saving Information

from time zone .
2. When the Confirmation dialog opens, click Yes to proceed or No to cancel the action.

Proceed with caution. If you select Yes, the action cannot be undone.
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Time-Off Bidding
You enable WFM's time-off bidding feature by creating and configuring bidding periods and
associating them with a site and multi-site activity (MSA). Once configured, agents who are within the
site and assigned the MSA can submit multiple, concurrent time-off requests within the bidding
period, which WFM processes between the specified Processing Start date/time and Closing date/
time.

WFM grants these time-off requests, based on seniority and/or rank. Time-off requests that WFM
cannot grant are processed after the bidding period Closing date/time if there are available slots in
the time-off limits. After the Closing date/time, WFM continues to process requests, but does not wait
for the agent to make changes to preferred, wait-listed requests that cannot be granted, nor does it
update the agent's bidding status.

Important
To configure objects and change settings in the Time-Off Bidding Periods view, you
must have the appropriate role privileges. See Configuration Role Privileges.

To enable the time-off (vacation) bidding feature:

1. Create the bidding period.
2. Configure its properties by entering the dates and times that you want the period to cover and the

bidding period constraints.
3. Associate sites and a multi-site activity with the bidding period.

Important
Time-off requests can be granted during the bidding process only if the time-off types
are associated with time-off rules that have auto-granting enabled. If auto-granting for
a time-off rule is disabled or the time-off rule is not assigned to a time-off type, the
request will not be processed within the bidding process. Also, if the Allowed Agent
Timeout setting is configured for the bidding period, the time period that it
represents will be wasted on these types of requests, because they can never be
auto-granted. However, WFM still waits for agent to change their request to make
auto-granting possible.
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Entering and Changing Time-Off Requests

In the Calendar view, you can change the agents' time-off requests, enter new requests, or manually
grant existing requests at any time, even after the bidding process has started.

In the Time-Off Bidding views, when the bid assignment process is in the Timed Out state, you can
manually skip the agent. Adjust the order of processing at any time by setting agent's status to
Skipped or Ready, indicating that the automatic bid process should not consider the agent's requests.
When you set the agent's status to Skipped, the bid assignment process moves on to the next
agent's request.

When Can Agents Submit or Change Requests?
Agents can enter new time-off requests at any time, even if bid assignment process has been started
and their existing requests have already been processed. The new requests will be given Preferred
Wait-Listed status, like all other requests being pooled for bidding. After entering the new requests,
agents must change the request status to Ready.

Agents must enter time-off requests that cross the bidding period boundaries as two or more
separate requests, with all of the items in each request being either fully within or fully outside of the
boundaries. WFM rejects requests that straddle the boundaries. If there are existing requests of this
type (due to data migration), the bid assignment process considers only that part of the request that
is inside the boundaries, even if it means that only the part of request is granted.

Agent cannot delete or recall a single item in a batch request that contains multiple items; the same
action is performed on all items in the request. The same rule applies if the status of time-off items in
the batch changes (to Granted, Preferred, or Declined), but a supervisor can override it.

Resolution of Requests

When WFM process the bids, it uses the resolution rule that was configured for the bidding period
(see Bidding Period Properties rows 10-13) and automatically resolves time-off preferences by either
granting them or performing some other action, such as wait-listing. After the Closing date/time, WFM
continues processing any time-off requests that were not previously processed, using resolution
rules. Time-off requests submitted after the Closing date/time are processed on a FIFO basis.

How Automatic Bid Assignment Works

The automatic bid assignment process runs multiple times between the Processing Start date/time
and the Closing date/time with a preset frequency using the following algorithm:

1. For each agent in status Waiting:
• Check if agent's timeout has expired:

• If expired, set agent to Timed Out
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2. If there are still agents in status Waiting, which were skipped (above):
• DONE. Wait until the next run.

3. Process the agent list in the predefined order and look for agents in status Entering and Ready.
• If Ready or Entering, but the bidding period Allowed Agent Timeout = 0 (which means no waiting

for the agent to change requests):
• Attempt to grant all pending (Preferred/Wait-Listed) time-off requests within this bidding period.
• If all pending requests have been successfully granted:

• Set agent's status to Processed then, moves on to the next agent.

• Some pending requests could not be granted or agent's status is Entering, (meaning the bidding
period Allowed Agent Timeout value is > 0:
• Set agent status to Waiting.
• Calculate waiting time, by adding the time-out duration to the next agent's availability interval.
• DONE. Wait until the next run.

• Continue with the next agent.

Waiting:
The time interval that the system will wait for the agent or <wait for the agent until> is calculated as
followings:

1. Convert the current time to the agent’s time zone and calculate the agent’s current time.
2. If the agent is currently within the scheduled shift from the Master Schedule.

• Calculate <remaining shift time> = <shift end time> - <current time>.
• If <bidding period configured timeout> is less than <remaining shift time>, then:

• <wait for the agent until> is <current time> + <bidding period configured timeout>.
• DONE.

• Otherwise:
• <remaining timeout> = <bidding period configured timeout> - <remaining shift time>.
• Agent's current time moves to midnight next day.
• Calculate Next Day.

3. Or else check to see if the agent has the schedule (other than the shift including, but not limited to Day
Off and/or Full-Day Exception) for the calendar day of the agent’s current time.
• <remaining timeout> = <bidding period configured timeout>

• Agent's current time moves to midnight next day.
• Calculate Next Day.

4. Or else use agent’s Contract and check to see if the agent is currently within Contract availability.
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• Proceed as with the shift above, but with <availability end time> instead of <shift end time>.

Next Day:

1. Check if there is a schedule for the day of the agent’s current time.
• Check if it is a shift that starts at the current time or later than the current time.

• If <remaining timeout> is less than <shift duration>:
• <wait for the agent until> is <shift start time> + <remaining timeout>

• DONE

• Otherwise:
• <remaining timeout> = <remaining timeout> - <shift duration>.

2. Or else, check if there is a Contract availability window for the day of the agent’s current time.
• Proceed as with the shift above, but use <availability duration> instead of <shift duration>.

3. Agent's current time moves to midnight next day.
4. If Agent's current time is beyond the bidding period processing interval:

• <wait for the agent until> = bidding period Closing Date and Time.
• DONE

5. Calculate Next Day.

Web for Supervisors Views in Previous Versions

If the WFM 8.5.2 backend deployed in your environment is a version earlier than 8.5.203, the Time-
Off Bidding views displayed in the interface closely matches the content in this topic with the
exception of the topics Entering and Changing Time-Off Requests and Automatic Bid Assignment
Algorithm, which are not applicable in versions prior to 8.5.203.

Also, agents can submit time-off requests in the same way that they always did, but WFM does not
auto-grant or take any other action if they are within a configured time-off request window (even
partially). WFM processes these requests on the bidding process date and time (resolution date/time).
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Creating and Configuring Bidding Periods
Use the procedures and information in this topic to create, copy, delete, and suspend bidding periods.

Creating Bidding Periods

To create and configure a bidding period:

1. Select Configuration > Time-Off Bidding Periods.

2. Select a site within a business unit and click New .
The Properties pane opens.

3. Set the bidding period Properties.
4. Associate sites with this bidding period.

5. Click Save Now .

Tip
You can create bidding periods for the same site that overlap within the Start date/
time and End date/time, but the time period between the Opening date/time and
Closing date/time must not overlap or intersect.

Copying Bidding Periods

If you want to create another bidding period, using the properties similar to an existing one, create a
new bidding period by copying an existing one and then, make the necessary changes.

To copy a bidding period:

1. Select a bidding period in the list and click Copy .
The hierarchy of business units and sites within the enterprise is displayed.

2. In the Name field, enter a name for this bidding period.
3. Change the opening, processing, start, and end date/time settings, as necessary.
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4. Select the site(s) that you want to associate with this bidding period and click Save Now .

Deleting Bidding Periods

To delete a bidding period:

1. In the Time-Off Bidding Periods pane, select the bidding period that you want to delete.

2. Click Delete .
3. When the Confirmation dialog opens, select Yes to delete the selected bidding period or No to cancel

the action.

Suspending a Bidding Period

You can temporarily suspend the bid assignment process for the bidding period by checking Do not
process this bidding period check box in the Properties pane. When checked, time-off requests for
the bidding period are not processed. When the check box is cleared, the bid processing resumes
processing where it stopped.

If the current date and time is before the Processing Start date/time or past the End date/time,
processing is not resumed.

Bidding Period Properties

When you create new bidding periods you must then configure the properties. It is important that you
understand the impact of these settings on the bid assignment process, especially when setting the
various date and time properties for multiple bidding periods.

Properties Pane Controls
Control Description

Name The name of the bidding period.

Multi-Site Activity

Opens a list of multi-site activities (MSA), enabling
you to associate one with a time-off bidding period.
After the MSA is associated with a bidding period,
agents who can perform the MSA are able to bid for
time-off within that bidding period.

Opening Date and Time The date and time that the bidding period rules
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Control Description
begin to apply to the agent's time-off requests, and
the process begins pooling the requests.

Agents cannot submit requests for the bidding
period before the Opening date/time. However,
they can submit requests for any other bidding
period configured for the same interval, if it is
submitted after the Opening date/time and before
the Closing date/time.

Processing Start Date and Time The date and time that this bidding period will start
process time-off requests.

Closing Date and Time

The date and time that this bidding period will
finish processing time-off requests.

The bid assignment process runs multiple times
between the Processing Start date/time and the
Closing date/time, processing the time-off requests
begin pooling on the Opening date/time.

Start date and time The date and time that this bidding period interval
for time-off requests starts.

End date and time

The date and time that this bidding period interval
for time-off requests ends.

The Start date/time and End date/time properties
dictate the interval for time-off requests that are
affected by the rules of this bidding period. When
setting these dates/time, there are a couple of
scenarios, of which you should be aware:

• Multiple bidding periods configured for the
same interval—If you are configuring multiple
bidding periods with the same Start dates/times
and End dates/times, ensure that the interval
between the Opening date/time and the Closing
date/time do not intersect or overlap.

• Crossing boundaries of the interval—The
dates of all concurrent time-off requests must
be either inside or outside of the Start date/
time and End date/time interval. If agents
request time off for dates that cross the bidding
period boundary, they must submit separate
requests, with each request inside or outside of
the Start date/time and End date/time interval.
When agents submit cross-interval requests,
WFM rejects them.

Time zone drop-down list
The time zone that will be used for the dates and
times set for this bidding period. You can choose
the business unit time zone, if desired.

Allowed Agent Timeout
When the agent is in Waiting status, the time
interval (in hours and minutes) in which the agent
will be allowed to change their time-off requests to
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Control Description
comply with time-off limits.

If the bid assignment process finds an agent whose
time-off preferences it cannot grant, it waits for the
time interval specified in this property before
moving on to the next agent. However, if an agent
is unavailable for the entire waiting period, the bid
assignment process does not count the unavailable
time. The available time is determined by the
agent's schedule or if the schedule is not available,
his/her Contract.

Maximum number of weeks that can be
requested

The maximum number of weeks that the agent can
request for the entire bidding period within multiple
requests.

Maximum number of days that can be
requested

The maximum number of days that the agent can
request for the entire bidding period within multiple
requests.

Maximum number of hours that can be
requested

The maximum number of hours that the agent can
request for the entire bidding period within multiple
requests.

The default value is 0 for the Maximum number
of <weeks, days, hours> that can be
requested, indicating that this constraint is not
observed for this bidding period.

Only time-off requests made after the bidding
period opening date/time are counted against the
Maximum number of <weeks, days, hours>
settings.

Minimum consecutive days

The minimum number of consecutive days that the
agent can include in a single request.

This property defines the required number of combined day-off
and time-off requests for a single request. If agents have days
off defined by their Contract, granted Calendar days off, or
Rotating Pattern days off, then they are counted in the Minimum
consecutive days parameter. In other words, agents do not have
to request time off for known days off.

Allow full-day time-off requests only check box When checked, agents can request only full-day
time off (cannot request part-day time off).

Criteria radio buttons

The 4 available priorities for this bidding period;
Rank, Seniority, Seniority and Rank, or First
come, first serve.

Requests will be granted, declined, or wait-listed,
based on the selected priority.

If the sorting criteria is set to First come, first
serve, the timestamp is taken from the last date/
time that the agent changed his/her bidding status
to Ready, (not the date/time that the request was
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Control Description
submitted).

Do not process this time-off bidding period.
(It will be automatically checked by system
after it was processed) check box

Enables you to suspend the bid assignment process
if, for any reason, you need to temporarily suspend
it, or if you do not want the bidding period to be
processed for any reason.
Be sure to save the Properties settings if you
check this box for an existing bidding period.

Message to agents Enables you to add any message that you feel is
relevant to the agent about this bidding period.

Web for Supervisors Views in Previous Versions

If the WFM 8.5.2 backend deployed in your environment is a version earlier than 8.5.203, the Time-
Off Bidding views displayed in the interface more closely matches the procedures below. The only
other topic on this page applicable to versions prior to 8.5.203, is Deleting Bidding Periods.

Configuring Time-Off Bidding Periods
To configure a bidding period:

1. In the Configuration module, select Configuration > Time-Off Bidding Periods.

2. Select a site within a business unit and click New .
The Time-Off Bidding Period Properties pane opens.

3. Enter the bidding period parameters in the following fields:
• Name—Enter a name for the bidding period.
• Processing date and time—Enter the date and time that the requests within this bidding period

will be processed.
• Start date and time—Enter the date and time that this bidding period starts.
• End date and time—Enter the date and time that this bidding period ends.

4. From the drop-down list, select a Time zone. (You can choose the business unit time zone, if desired.)
5. Enter a value for the Minimum days per request.
6. Select one of four priorities for this bidding period; Rank, Seniority, Seniority and Rank, or First

come, first serve.
Requests will be granted, declined, or wait-listed, based on the priority.

7. Check the Do not process this time-off bidding period. (It will be automatically checked by
system after it was processed) check box if you do not want the bidding period to be processed for
any reason.

8. In the Message to agents field, add any message that you feel is relevant to this bidding period.
9. Associate sites with this bidding period.
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10. Click Save Now .

Tip
When saving bidding periods, if the dates for any two periods for the same site
overlap, WFM displays an error message.

Copying a Bidding Period
To copy a bidding period and change the sites associated with it:

1. Select a bidding period in the list and click Copy .
The hierarchy of business units and sites within the enterprise is displayed.

2. In the Name field, enter a name for this bidding period.

3. Select the site that you want to associate with this bidding period and click Save Now .
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Agent Statuses in the Bidding Process
The Status pane in the Time-Off Bidding view lists agents that have submitted requests within the
bidding period and sorts them in the order that they will be processed for bid assignment. You can
use the Status pane to manually change an agent's status when managing agent time-off requests
within bidding periods.

Information about agent statuses is displayed in the following columns:

• Actions —Clicking this icon opens the agent's time-off details in a separate window.
• Order—Indicates the agent's place in the bid assignment processing queue.
• Agents—The agent's first and last name.
• Status—The agent's status; Entering, Skipped, Ready, Waiting, Processed, or Timed Out.
• Modified—The date and time that the agent's current status was changed.
• Waiting End Date—The date that waiting period ends for this agent's request changes, and when the

bid assignment moves on to the next agent in the queue.
• Site—The agent's site name.
• Team—The agent's team name.

How Statuses Affect Request Processing

The agent's status determines when and how their time-off requests are processed for bid
assignment. For example, these statuses can be selected in the Status drop-down list:

• Entering—The initial (default) status assigned to the agent, indicating that the agent can enter time-
off requests to be added to the bidding period queue. Agents and supervisors can set this status any
time agents want to change their requests. During bid processing, WFM sets the bid assignment status
to Waiting and sends the agent an email notification.

• Ready—Usually set by agent, indicating that time-off requests were submitted and are ready for
processing. Agents and supervisors can set this status at any time. WFM processes the requests and
sets the request status either Processed or Waiting, depending on the bid assignment rules or
constraints.

• Skipped—Supervisors can manually set this status at any time, indicating that bid assignment process
should not consider the agent's requests. WFM ignores the agent's requests during the bid assignment
process.

The following statuses are set by the bid assignment process; neither supervisors nor agents can set
them:

• Waiting—Set when the bid assignment process cannot grant all requests. It indicates that the process
is waiting for the agent to enter or change his/her time-off requests. Once the waiting period is over
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(the date is displayed in the Waiting End Date column) or the process finds that all changed requests
can be granted, it resumes processing.

• Processed—Set when all of the agent's requests have been successfully granted, or the agent has not
submitted any requests. The process also checks for items that might have already been granted.

• Timed Out—Set when the time allotted to the agent to edit or enter time-off requests has expired. At
this point, the process moves on to the next agent.

Tip
Bidding periods created before migration to the latest 8.5.2 release, will have no
saved agent status records, Therefore, agents statuses will default to Entering, but
you can change them after migration to conform to the new rules. If you make no
changes to the bidding period properties after migration, the old bidding period
functions.

Changing an Agent's Status

To change an agent's status:

1. Click the Status tab.
2. In the Status column (of the agent whose status you want to change), click the drop-down list to select

Entering, Ready,Processed, or Skipped.

3. Click Save .

The Modified column displays the date and time of the change.

Viewing Time-Off Details for an Agent

1. Click the Status tab

2. Find the agent whose details you want to view and in the first column, click Actions .
The agent's time-off details open in a separate window.

3. Optionally, click Sort and select Date, Item, Start Time, End Time, Paid Hours, Status
Requested, Status Actual.
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What's in the Details?
The Time-Off Details window includes:

• The agent's name
• The period or date range within which time-off requests were made (matches the Start and End dates

that you entered in Bidding Period Properties)
• A table containing detailed information in the following columns: Date, Item, Start Time, End Time,

Paid Hours, Status Requested, Status Actual

• A Sort icon, enabling you to sort by date, item, start time, end time, paid hours, status requested,
or status actual.

Configuration Time-Off Bidding

Workforce Management Web for Supervisors Help 215



Associating Sites and Multi-Site Activities
Workforce Management enables you to choose the way in which you associate agents with bidding
periods. In most cases, associating agents by using sites is acceptable. However, you might want to
achieve a more granular approach to time-off bidding by associating agents using multi-site activities
(MSA).

Associating Sites with Bidding Periods

To associate one or more sites with a bidding period:

1. In the Time-Off Bidding Periods pane, select the bidding period that you want to associate with a
site.

2. Click Sites and then, enter a check mark beside one or more sites.

3. Click Save Now .

Removing a Site from a Bidding Period
To remove a site from a bidding period:

1. Remove the check mark beside the site that you want to remove.

2. Click Save Now .

Associating a Multi-Site Activity with a Bidding Period

When associating a multi-site activity with a bidding period, it's best to use an MSA with configured
time-off limits on which agents can bid. However, you can use multi-site activities only for agent
association, if you wish.

Tip
To ensure all agents associated with the MSA are assigned to the bidding period,
select all sites (in the procedure above).
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To associate a multi-site activity with a bidding period:

1. In the Time-Off Bidding Periods pane, select the bidding period that you want to associate with a
multi-site activity.

2. In the Properties pane, beside the Multi-Site Activity field, click Edit .
A list of Multi-Site Activities opens in a separate pane.

3. Select an MSA and then, click Apply .
The MSA appears in the MSA field in the Properties pane.

Removing a Multi-Site Activity from a Bidding Period
To remove a a multi-site activity from a bidding period:

1. In the Properties pane, click the x in the Multi-Site Activity field.
The MSA is removed and the field is empty.

2. If you want to choose another MSA without removing the existing one, simply select another MSA from
the list and click Apply .
Your latest selection replaces the existing one in the MSA field.

If there is a long list of MSAs, use Sort to switch between ascending descending order, or enter

the name of the MSA you want to use into the Search field.
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Schedule State Groups
A Schedule State Group is a collection of schedule states that is linked to a site.

If you selected Generate Default Schedule State Groups and Exception Types when you imported the
site, these Schedule State Groups appear automatically:

• Asynchronous Work
• Days Off
• Exception Types
• Fixed-Staff Work
• Immediate Work
• No Activity
• Shift Items/Meals
• Time Off

The Schedule State Group view enables you to create a new group, copy and paste an existing group,
edit, and delete groups. See Configuring Schedule State Groups.

Important
To configure objects and change settings in the Schedule State Groups view, you
must have the appropriate role privileges. See Configuration Role Privileges.

For information about setting adherence rules for Schedule State Groups, see Configuring Adherence
Rules.

Schedule State Groups and Genesys States

Each schedule state group is associated with one or more Genesys states, such as CallRinging or
WaitForNextCall. Each group can include an additional reason (aux) code, sent with the related
Genesys state, that further identifies what the agent is doing.

Important
Aux codes are not supported for all Genesys states. The T-Server you are using
dictates which Genesys states support aux codes. Check the documentation for your
T-Server to determine which of the Genesys states can support aux codes.
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You can apply the Start Before Threshold and Start After Threshold values to each schedule
state group; these values help you track agent adherence. Configure these functions in the
Adherence Rules pane.

About Schedule States

The schedule states that you can include in schedule state groups are:

• All breaks configured for the site
• All meals configured for the site
• All activities configured for the site
• All exception types configured for the site
• All time-off types configured for the site
• Fixed states, which are:

• Generic break, meal, exception, and activity states that you can use in place of specific meals,
breaks, exceptions, and activities.

• Day Off, Vacation, No Activity

Tip
Use these Fixed States to report the state, for which an agent is scheduled when a
particular schedule state type (such as an Exception Type) has been deleted from
WFM.
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Configuring Schedule State Groups
To create a schedule state group, you must first select a site within a business unit. When you select
a schedule state group or create a new one, the Schedule State Group Properties pane opens.

The following topics provide information to help you create and manage your Schedule State Groups:

• Schedule State Groups Pane Controls
• State Group Properties Pane Controls
• State Type Pane Controls
• Assigning a State to Multiple Groups
• Creating Schedule State Groups
• Creating Groups Using Copy and Paste
• Editing Schedule State Groups
• Deleting Schedule State Groups

Schedule State Groups Pane Controls

Search field
Enter the search criteria. For example, the name of
the schedule state group.

New Click to create a new schedule state group.

Delete Click to delete an existing schedule state group.

Copy
Click to copy and paste an existing schedule state
group.

Help
Click to view a Help topic about the Schedule
State Group pane.

State Groups Properties Pane Controls

Save Now Click to save changes you have made in this pane.

Help
Click to view a Help topic about the Schedule
State Group Properties pane.

Name field Enter a name for the Schedule State Group.

Type drop-down list
Select a type for the Schedule State Group, such as
None (default), Planned Overhead, Unplanned
Overhead, Actual Work.
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Assign Schedule States

Click to assign a schedule state to the group and
open the State Type pane, from which you can
select states from various state types (see controls
below).

Unassign Schedule States Click to remove or unassign a schedule state.

State Type Pane Controls

Apply
Click to apply the state to the schedule state
group.

Close Click to close the State Type pane.

Help
Click to view a Help topic about the State Type
pane.

State Type drop-down list
Select a state type for the Schedule State Group,
such as Fixed State, Activity, Exception Type,
Break, Meal, or Time-Off Type.

Show Assigned States check box

Check this box to display the states that are
already assigned. When checked, the name of the
schedule state group, to which this state is
assigned displays in the Schedule State Group
column.

Search field

Enter the search criteria. For example, if you
selected Exception Type in the State Type drop-
down list, enter an exception type name, such as
Exc1 or Exc2.

Assigning a State to Multiple Groups

You can assign the same schedule state(s) to different Schedule State Groups under the same
Business Unit. For example, you can assign the state ExceptionType1 to SSG1 (under Site1 & under
BU1) and to SSG2 (under Site2 & under BU1) at the same time—but only because both Schedule
State Groups are under the same Business Unit (BU1).

Previously (in streams earlier than 8.1), a Schedule State could be assigned to a Schedule State
Group only once at any given time.

Preset Schedule State Groups

Schedule state groups from a previous release of Workforce Management are brought into the WFM
Web as pre-configured groups. The default groups, which can be edited or deleted are:
Asynchronous Work, Days Off, Exception Types, Fixed-Staff Work, Immediate Work, No
Activity, Shift Items/Meals, and Time Off.
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Important
The formerly-used Vacation Schedule State Group no longer exists. Instead, Vacation
is now a default time-off type within the Time Off Schedule State Group. All previously
configured Vacation Schedule State Groups are migrated into the automatically-
created Vacation time-off type.

Creating Schedule State Groups

1. In the Configuration > Schedule State Groups pane, select a the site for which you want to create
the schedule state group.

2. On the Schedule State Groups pane, select New .
The new schedule state group displays with a default name and the Schedule State Group
Properties pane opens.

3. In the Name field, enter a name for your schedule state group. It must be unique within the site.
4. From the Type drop-down list, select a type (None (default), Planned Overhead, Unplanned

Overhead, or Actual Work).

5. Assign schedule states to the group by clicking Assign Schedule States .
The State Type pane opens.

Tip
To remove any schedule state, select it and click Unassign Schedule States .

6. Select a State Type from the drop-down menu.
A list of states that are associated with this state type are displayed in the lower half of the pane.

7. (Optional) to display any states already assigned to the schedule state group, click the Show Assigned
States check box.

8. When you have finished adding schedule states, click Apply .
9. In the Schedule State Group Properties pane, from the drop-down list, select Adherence Rules to

continue configuration of this schedule state group. See Configuring Adherence Rules.

Creating Groups Using Copy and Paste
To create a new schedule state group by copying and pasting an existing one:
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1. In the Schedule State Groups pane, select a schedule state group.

2. Select Copy .
The Copy Schedule State Group <schedule state group name> pane opens.

3. Enter a name for the new schedule state group. It must be unique within the site.

Tip
If the name is not unique, the Review Validation Messages pane opens, with a description of the error
message. In this case, A duplicate name specified.

4. In the lower half of the pane, select the business unit and site, with which you want to associate this
schedule state group.

5. Click Save Now .
The new schedule state group appears in the objects list according to the sort order selected
(ascending or descending).

Editing Schedule State Groups

You can edit any schedule state group, whether it is pre-set or user-created.

To edit a schedule state group:

1. Select it Schedule State Group pane and make the changes in the Schedule State Group
Properties and Adherence Rules panes.

2. Change the schedule state group name, if necessary. It must be unique within the site.
3. Change the state type, by selecting one of the four state types from the drop-down list.

4. Use the Assign Schedule States or Unassign Schedule States to change state
assignment for this group.

5. When you have finished adjusting which schedule states are included, click Apply .

6. Click Save Now .
7. At the top of the Schedule State Group Properties pane, click Adherence Rules to continue

configuration of this schedule state group. See Configuring Adherence Rules.

Important
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If you make any change to a Schedule State Group (assign or unassign a state, or
change the adherence rule), the Schedule State Group effective date automatically
updates to the current date.

Deleting Schedule State Groups

To delete a selected schedule state group from the Schedule State Groups pane:

1. Select the schedule state group you want to delete.

2. Click Delete .
3. When the Confirmation dialog appears, click Yes.

The schedule state group is deleted and any schedule states included in it now appear on the State
Type pane.
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Configuring Adherence Rules
You can configure Adherence Rules for each Schedule State Group and for multiple media channels
within a site. These rules determine what standards WFM uses when monitoring agent performance.
To view the Adherence Rules pane, select Adherence Rules at the top of the Schedule State
Group Properties pane.

Adherence Rules Pane Controls

Save Now Click to save changes you have made in this pane.

Associate Genesys current states with
schedule states group

Click to associate Genesys current states with
schedule state groups.

Delete State Click to delete an associated Genesys state.

Help
Click to view a Help topic about the Adherence
Rules pane.

Adherence Threshold Levels

Channel

Click to configure the media channel for the
schedule state group. Select one of three radio
buttons:

• None—Schedule state groups containing non-
work activities that do not have a specified
channel (and therefore, belong to all channels).

• Voice/Unspecified—Schedule state groups
using this channel contain voice-related
activities and other work that is not related to
any other configured channel, such as other
non-media-channel activities.

• Specify Name—Schedule state groups with
this name will contain activities and other work
being done on this channel.

Important
The channel name must match the name that is used
in Stat Server statistics (and sent to WFM).

Channel Name Enter a name for the selected channel.
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Genesys Current States Mappings

Start Before Threshold field

Enter a start time. This is the duration of time
considered to be adherent time before the start of
a schedule state.
Valid values are 0–20. The default value is 20.

End After Threshold field

Enter an end time. This is the duration of time
considered to be adherent time after the end of a
schedule state.
Valid values are 0-20. The default value is 20.

Current State drop-down list Select a state from this list to set the current state
to be mapped to the aux (reason) code.

Aux Code (Reason) field

Enter an appropriate aux (reason) code. A reason is
user-specified information that supplements
schedule state information. A reason helps to
define the precise nature of the schedule state
group to which it is attached.

Tip
Reasons do not apply to all Genesys current states.
Refer to your Genesys Stat Server documentation for
additional information.

Start Before and End After Thresholds
Set the Start Before Threshold and End After Threshold for an acceptable amount of flexibility in
scheduled state start and end times. Threshold settings indicate how many minutes early or late an
agent can transfer to a scheduled state without being considered nonadherent.

Example 1: An agent is scheduled to start a shift at 12:00 PM and the Start Before threshold is set
for 5 minutes. If the agent starts the shift at 11:54 AM, which is beyond the 5-minute threshold, it is
written to the database and appears on the adherence reports as a nonadherent current state.

Example 2: If the schedule requires agents to work from 12:00–1:00 and both thresholds are set to 5
minutes, an agent who starts at 11:55 and ends at 1:04 is adherent. Agents who start and/or end
outside the configured thresholds are either nonadherent or severely nonadherent.

You can configure the setting that marks the cut-off between nonadherence and severe
nonadherence in the Alarm Threshold combo box on the Site Properties pane of the
Organization module. See Site Properties for details.

Setting Adherence Rules
Link to video
To set adherence rules for a schedule state group:
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1. In the Schedule State Groups pane, select a schedule state group.
2. At the top of the Schedule State Group Properties pane, select Adherence Rules.

The Adherence Rules pane opens.
3. In the Start Before Threshold and End After Threshold fields, set the adherence threshold levels

for the schedule state group.
These rules define agent adherence parameter. Agents are adherent if their start time and
end time are within threshold intervals for that scheduled state.

4. Select the media channel for the Schedule State Group: None, Voice/Unspecified, or Specify Name.
If you choose Specify Name, enter the channel name—for example, email.
The channel name must match the name that is used in Stat Server statistics (and sent to
WFM).

5. Click Associate Genesys current states with schedule states group to populate the
mappings list in the lower half of the pane.
• Select the current states that should be associated with this schedule state group.
• Continue adding rows as necessary.
• To remove a Genesys current state from the Current State column, select it and then click Delete

State .

You can associate a Genesys current state with any number of schedule state groups.
6. Enter reasons (aux codes), if necessary, by typing the appropriate code into the Reason Code column

for the appropriate Genesys current state.

7. Click Save Now .

Configuring Media Channels for Schedule State Groups

Configuring a media channel for schedule state groups enables you to track an agent adherence to
the schedule when agents are scheduled to work on multiple media channels or when agents are
working on a media channel that is currently not scheduled. Agents are considered non adherent, if
they are non adherent on any one of those channels.

After implementation, WFM tracks multiple channel-related agent real-time states per time interval.
See the following example of a contact center use case that might require multi-channel adherence
tracking.

Use Case: Tracking Multi-Channel Adherence
A site in the contact center has voice and email related activities, and agents can make outbound
calls, which are scheduled as exceptions. The schedule state groups can be configured as follows:
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Schedule State Group Channel Schedule State Real-time States

Inbound calls Voice/Unspecified All (immediate) voice-
related activities

WaitForNextCall,
CallRinging,
AfterCallWork,
CallInbound

Outbound calls Voice/Unspecified
Exception types that
represent outbound call
work

WaitForNextCall,
CallRinging,
AfterCallWork,
CallOutbound

E-mails <channel_name> (for
example, email)

Deferred, email related
activities

WaitForNextCall,
CallRinging,
AfterCallWork,
CallInbound

Overheads None (no channel) Breaks, meals, time off,
exceptions, etc.

NotReadyForTheNextCall,
LoggedOut

Important
Tracking multi-channel adherence is a new feature in WFM 8.5. if there is no schedule
state group with a channel name under the site, WFM calculates adherence as it
would for a single agent real-time state, and Stat Server aggregates the statistics as it
did in previous WFM releases. However, if there is at least one schedule state group
with a configured channel name, WFM tracks multiple channels. For each site, WFM
tracks as many different channels as there are distinct channel names for all schedule
state groups under the site.

For more information about how WFM calculates agent adherence for single channel and multi-
channel sites, see Adherence Calculations.
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Schedule State Groups History
Use the History pane to enable accurate reporting of historical adherence, by adding and modifying
the Schedule State Group Effective Date.

Effective Dates in Schedule State Group History

The History pane displays historical data; in other words, how the Schedule State Group has
changed over time. It enables you to restore previous changes to the current state.

By setting an effective date, you specify that the historical change (the latest one in list) is actually
effective from that specific date (and not immediately). Historical changes made before that are valid
up to the effective date.

The effective date can be set on any latest historical change and many historical changes can have
effective dates. This enables you to specify dates, from which changes are effective. This is
important, because Adherence Reports are populated with information from the Schedule State
Groups to determine adherence. Changing a Schedule State Group configuration without setting
adherence, applies the latest changes to all data and adherence might be incorrectly calculated for
dates, on which the previous Schedule State Group configuration should have been applicable.

After changing a Schedule State Group, it is best to apply the effective date, by indicating from which
date it is applicable to ensure the History pane displays past changes and the effective date
assignments.

Modifying the Effective Date
If you modify the effective date in the Schedule State Group History pane, the new date is
applicable, starting at midnight on the effective date (not from the midnight of the current day in the
site time zone, as is the default), and historical adherence is updated in the Adherence Reports.

To change the effective date:

1. Click Modify to open the Set Effective Date pane.
The current date in your site time zone is displayed, by default.

2. Click the date field to display a calendar, from which you can select an alternative date.

3. Click to Apply the changes or Close without modifying.

Loading Historical Data
To populate the Historical Changes Records section in this view, click Load Historical Data.

All historical change records, from the start date to the current day, will be displayed in the following
columns:
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• Date and Time—The date and time that the change was made.
• Action—Details of the changes.
• Effective Starting—The effective start date of the changes.
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Activities
Activities are work items that are tracked and managed using Workforce Management. For example,
answering inbound calls, responding to email, completing after-call work, performing scheduled
callbacks, and participating in chat sessions.

You must configure activities separately for each site or business unit. Business units require multi-
site activities, which combine activities at some or all of the sites in a business unit. If you select a
site in the Objects pane, the activities configured for that location appear in the Activities pane. If
you select a business unit, the multi-site activities configured for that location appear in the
Activities pane.

Important
To configure objects and change settings in the Activities and Multi-Site Activities
view, you must have the appropriate role privileges. See Configuration Role Privileges.

In the Activities pane, click an activity to view its properties and edit them.

• For instructions about how to view or create new activities or multi-site activities and configure staffing
properties and open hours, see Creating and Deleting Activities.

• To define regular activities, see Configuring Skills for Activities and Associating Agents With Activities.
• To configure multi-site activities, see Assigning Activities to Multi-Site Activities, and Configuring Skills

for Multi-Site Activities.
• To view, add, edit, or delete activity sets, or configure new or existing activity sets, see Creating Activity

Sets and Adding Activities to Activity Sets.
• To view, add, edit, or delete activity groups, or configure new or existing activity groups, see Grouping

Multiple Activities.
• To configure activity policies to establish rules and guidelines that determine how, when, and in which

activities the agent can engage, see Activity Properties.
• To associate Stat Server statistics with activities and multi-site activities for use in monitoring

interaction and service levels, see Statistics Configuration for Activities and Configuring Statistics for a
Multi-Site Activity.

• To set default target service levels or staffing requirements for different types of activities, see Default
forecasting objectives.
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Activity Properties
When you select a site and add an activity, the Activity Properties pane opens and you can
configure activity policies to establish rules and guidelines that determine how, when, and in which
activities the agent can engage.

The Activity properties are described in the following section; Multi-Site Activity properties are
described below.

In the Activity Properties section:

• Name—Enter a name for this activity. The name must be unique within the site.
• Short Name—Enter a short name for this activity. The short name can be up to three characters and

identifies the activity in Schedule displays. The short name does not need to be unique.
• Type—Select one of the following three options:

• Immediate Work—CTI activities that use Workforce Management service objectives for Forecasting
and Adherence.

• Deferred Work—Backlog activities, such as email, that use special forecasting calculations.
• Fixed-Staff Work—Non-CTI activities that do not use Workforce Management service objectives.

• Activity Set—If this activity becomes part of an Activity Set, this field is automatically populated with
the name of the activity set.

• Maximum Simultaneous Users—Enter a value that represents the maximum number of agents or
staff that can work on this activity simultaneously.

• Minimum Staffing Level—Enter a value for the minimum percentage of agents or the minimum
number of agents required for this activity and select the appropriate radio button: Percent or
Agents.

In the Hours of Operation section:

• Monday to Sunday fields—Enter start and end times.
• Next Day check box—Check or uncheck for each day, as required. Check the check box for those days

on which the hours of operation extend into the next day.
• Closed check box—Check or uncheck for each day, as required. Check the check box for those days

when the contact center is closed. When checked, the start and end times for that day are disabled and
cannot be modified. Lease the check box is unchecked, if the contact center is open on that day.

• Copy/Paste icons—Click to copy and paste start and end times, and next day settings from one day to
another day.

Multi-Site Activity Properties

The Properties pane opens when you select a business unit and add a multi-site activity. The
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properties in the following sections have the same descriptions as the ones above.

In the Multi-Site Activity Properties section:

• Name (must be unique within the business unit).
• Type

In the Hours of Operation section:

• Monday to Sunday fields

• Next Day check box

• Closed check box

• Copy/Paste icons
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Creating and Deleting Activities
You can add an activity or a multi-site activity by creating a new one or by copying an existing one.
You can also delete existing activities.

Creating Activities

To create an activity:

1. In the Objects pane, select the site to which you want to add the new activity.

2. When the Activities pane opens, select New Activity .
The Activity Properties pane opens with the default name New Activity (<number>).

3. In the Activity Properties and Hours of Operation sections, populate the fields as described in
Activity Properties.

4. Click Save Now .
5. Configure the activity, as explained in these topics:

• Adding Activities to Activity Sets
• Configuring Skills for Activities
• Associating Agents with Activities.

See also Statistics Configuration for Activities.

Creating Multi-Site Activities

To create a multi-site activity:

1. On the Objects pane, select the business unit, to which you want to add the new multi-site activity.

2. Select New Multi-Site Activity .
The Multi-Site Activities Properties pane opens.

3. In the Multi-Site Activity Properties and Hours of Operation sections, populate the fields as
described in Multi-site Activity Properties.

4. Click Save Now .
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Creating Activities and Multi-Site Activities Using Copy

To create a new activity or multi-site activity by copying an existing one:

1. In the Activities pane, select an activity or multi-site activity.

2. Select Copy .
The Activity Assignment pane opens.

3. In the Name field, rename the activity, if necessary. (The name must be unique with the site or
business unit [BU].)

4. In the Associate Copied Activity With The Following Site (for multi-site, BU) section, select the
site (or BU) with which you want this activity to be associated.

5. Click Save Now .

Deleting Activities and Multi-Site Activities

To delete an activity or multi-site activity:

1. Select the activity in the Activities pane.

2. Click Delete .
3. When the Confirmation dialog opens, click Yes to delete or No to cancel the action.
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Creating and Deleting Activity Sets
Use Activity Sets to combine activities into groups for multi-skilled scheduling. At the top of the
Activities pane, click Activity Sets and configure activity sets for a selected site.

Tip
You must create activities before you can configure activity sets.

When using activity sets, be aware of the following:

• Activity sets are separately configured for each site. You cannot configure activity sets for business
units.

• An activity in an activity set can be incorporated in a multi-skilled schedule only with other activities
from the same set.

• An activity cannot belong to more than one activity set.
• An activity belonging to an activity set can only be scheduled using the activity set.
• To configure an activity so that it will never be incorporated in a multi-skilled schedule, create an

activity set containing only that one activity.
• The activity set constraint is incompatible with the maximum seats constraint. If there is a conflict,

Scheduler gives priority to the activity set constraint.

Agents assigned to an activity set perform the selected activities on a multi-skilled basis. These
agents cannot be assigned to any other activities during the minimum time period specified for the
activity set.

Important
To accommodate those times when some agents cannot be assigned to work on an
activity set, Genesys recommends that you always keep an activity that is not a part
of an activity set available for agents to perform during the activity set open hours. If
the activity set becomes overstaffed before all agents are scheduled, Scheduler tries
to create activity set work for them. However, if an agent's unassigned period is
shorter than the minimum activity set period, Scheduler has to assign the agent an
extended period with no activities at all (forced break) because no activity is available
for him or her to work on.
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Creating Activity Sets

To create an Activity Set:

1. In the Objects pane, select the site, for which you want to create the activity set.
2. At the bottom of the Activities pane, click Activity Sets.

3. In this pane, click New Activity Set .
The Activity Set Properties pane opens.

4. Configure the following settings, as described:
• Name—Enter a name for the activity set. The name must be unique within the site.
• Short Name—Enter a three-letter short name for the activity set.
• Minimum Duration—Enter a value for the minimum length of time that an agent can work on the

activities within this activity set.
• Strict—Check this box if you do not want meals, part-day exceptions, or part-day time offs to be

scheduled during the activity set period. (Breaks can be scheduled during the activity set.) Leave
this box unchecked, if breaks, meals, part-day exceptions, and part-day time offs can interrupt this
activity set. (The only constraint is the minimum duration.)

5. Click Save Now .
6. Continue with the configuration of the activity set by adding activities to it. See Adding Activities to

Activity Sets.

Deleting Activity Sets

To delete an activity set:

1. In the Activity Sets pane, select the set that you want to delete.

2. Click Delete .
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Grouping Multiple Activities
Grouping multiple activities from within the same business unit enables data aggregation for contact
center performance monitoring and reporting.

You can create activity groups, assign activities to them using a filter, copy, and delete activity
groups.

Creating New Activity Groups

1. In the Objects pane, select the business unit, for which you want to create the Activity Group.

2. In the Activities pane, select New Activity Group .
The Activity Group Properties pane opens.

3. In the Name field, enter a unique name for the group.

4. Click Save Now .
The new activity group appears in the Activities pane.

Assigning Activities to Activity Groups

1. In the Activities pane, select the group, to which you want to assign activities.
2. At the top of the Activity Group Properties pane, click Activities.

3. When the Associated Activities pane opens, click Assign regular activities .
The Activities pane opens.

4. Select the activities you want to associate with this Activity Group.
To quickly find an activity, type the activity name into the Search field. Only activities for
the selected business unit are available. Activities for other business units do not appear.

5. When you have selected all activities, click Apply .

6. In the Associated Activities pane, click Save Now .

When you assign activities to an activity group, you can use a filter to select only those sites and
multi-site activities to which you want these groups and activities to apply.
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Using Filters When Assigning Activities to Groups

1. In the Activities pane, click Filter .
The Filter pane opens.

2. In the Sites list, do one of the following:
• Remove the check mark in the All check box and select the sites, to which you want to assign these

groups and activities.
• Remove the check mark in the All check box and check No Filtering by Sites. (If this box is

checked, the activities and groups apply to all sites in the list.)

3. In the Multi-Site Activities section, do one of the following:
• Remove the check mark in the All check box and select the multi-site activities, to which you want

to assign these groups and activities.
• Remove the check mark in the All check box and check No Filtering by Activities. (If this box is

checked, the activities and groups apply to all multi-site activities in the list.)

4. Click Apply .

Copying Activity Groups

1. In the Activities pane, select the Activity Group you want to copy.

2. Click Copy .
The Copy Activity Group pane opens.

3. In the Name field, rename the Activity Group, if necessary. (The name must be unique within the
business unit.)

4. In the Associate Copied Activity Group With The Following Business Unit section, select the
business unit with which you want this Activity Group to be associated.

5. Click Save Now .

Tip
When you copy an activity group and add it to the same business unit, all activities
that were associated with the copied activity group are associated with the duplicated
activity group.
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Deleting Activity Groups

1. In the Activities pane, select the Activity Group you want to delete.

2. Click Delete .
3. When the Confirmation dialog opens, click Yes to delete or No to cancel the action.
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Adding Activities to Activity Sets
After creating an activity set, add the activities, by opening the Activities pane.

To add activities to an activity set:

1. In the Activities pane, click Assign regular activities .
The Available Activities pane opens.

2. From the Activities list, select the activities that you want to add to this set.
To quickly find an activity in the list, enter the name of the activity in the Search field.

Tip
You will notice that the activities that are already assigned to an activity set, display the activity set name in a
separate column. These same activities are still available to select for the new activities set.

3. Click Apply .

4. In the Associated Activities pane, click Save Now .
The selected activities are added to the list of activities in the Activity Sets pane.
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Configuring Skills for Activities
Use the Skills pane to add, or delete skills that are associated with an activity.

Note the following information about skills:

• If you add a skill to an activity, only agents with that skill are scheduled for that activity.
• If you associate multiple skills with an activity, agents must have all of the skills to work on the activity.
• An activity may include more than one skill, or it may represent a particular skill level.

Important
Agents are associated with skills in Genesys Administrator, not in the Workforce
Management. Workforce Manager Skills are identical to Genesys Administrator Skills
objects and become available in Workforce Management after synchronization with
Genesys Administrator.

Skills Security Features

Only the skills that the current user is authorized to access in Genesys Administrator are visible.

If a user's security access has changed so that he or she can no longer access certain skills, those
skills are still visible; but the user whose access was changed cannot add, delete, or modify them.

Adding Skills to an Activity

To add a skill to an activity:

1. In the Activities pane, select the activity, to which you want to add skills.
2. At the top of the Activities Properties pane, click Skills.

3. When the Skills pane opens, click Add Skills to an Activity .
4. In the Skills pane, assign the minimum and maximum skill levels.

• Skill Minimum Level—A minimum skill level value required for an agent with this skill to perform
this activity. Define whatever range is appropriate for each skill, such as 1 to 10 or 1 to 100. The
range should be consistent with the range used in Genesys Administrator.

• Skill Maximum Level—A maximum skill-level value required for an agent with this skill to perform
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this activity.

5. In the list of skills, select those that you want to associate with this activity.
To quickly find a skill, you can enter search criteria into the Search field (for example, the skill name).

Important
You must define skills in Genesys Administrator before they appear in this list.

6. When you have finished selecting skills, click Apply .

Deleting Skills Associated With an Activity

To delete a skill:

1. In the Skills pane, select the skill you want to delete.
To quickly find a skill, you can enter search criteria into the Search field (for example, the skill name).

2. Click Delete .

3. When you have finished deleting skills, click Save Now .
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Associating Agents With Activities
Use the Agents pane within the Activities view to associate agents with activities. To open this
pane, select Agents at the top of the Activity Properties pane.

Agents can work on activities under two conditions:

1. They have the proper skill set. Their skills must match the skills required for the activity.
2. They are eligible for activity assignments. If the effective date is before the current date, these

assignments override the agent’s eligibility to work on the activity accordingly to the skill set.

To adjust which agents are associated with an activity, change the skill settings for either:

• The agent, by using the Agent Information section. See the Agent Activities View.
• The activity, by using the Skills pane in Configuration > Activities module. See Configuring Skills for

Activities.

Associating Agents with an Activity

To associate an agent with an activity:

1. In the Activities pane, select the activity, with which you want to associate agents.
2. At the top of the Activity Properties pane, click Agents.
3. The Agents Associated with The Activity pane opens.

4. Click Associate agents with the activity .
A list of Available Agents opens.

5. In the Effective Date field, enter (or click within the field to select from a calendar) the date that you
want the association to begin.

6. In the Status field, use the drop-down list to select one of four options: Primary, Secondary, Auto, or
Disabled.

7. In the Available Agents list, select the agents you want to associate with this activity.

8. When you have selected all agents, click Apply .

Tip
To disassociate (or remove) an agent from an activity, go to Configuration > Agents
> Activities view.

Configuration Activities

Workforce Management Web for Supervisors Help 244



Finding Agents in the List

There are three ways to quickly and easily find agents when there is a long list of available agents:

1. Enter the agents name into the Search field and select one of the two Search by: filters (First Name
or Last Name radio button).

2. Sort agents by First Name, Last Name, or Team.

3. Filter agents by Activities, Multi-Site Activities, or Contracts.

In each of the three Filter panes, you can Sort the list in ascending or descending order.

To remove an item from the list, click Remove .
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Statistics
Use the Statistics pane to associate statistics with each activity or multi-site activities.

Important
You must have the proper permission or security right to view and configure statistics
for Activities and Multi-Site Activities. If you do not have this right, the Activities >
Statistics and Multi-Site > Activities panes are not visible. Also, you cannot
associate statistics with an activity or multi-site activity if it is of type Fixed-Staff
Work.

Use the statistics to monitor interaction and service levels.

To associate statistics with activities, you must have configured the necessary statistics in Stat Server
and configured a connection between Data Aggregator and Stat Server on the Data Aggregator
Application Connections tab. The Data Aggregator–Stat Server connection must be active.

Tip
You will find that some statistics are already configured in WFM with the variant
names (and 'WFM' prefixed) listed in parentheses in the Statistics Options column of
the Recommended Statistics Settings table.

Statistics properties are described in Statistics Properties. Additional configuration information
appears in Configuring Activities Statistics and Multi-Site Activities Statistics.
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Statistics Properties
Statistics—The Stat Server statistics that you will associate with an activity or multi-site activity.

Type—The kind of object being monitored.

• Interaction Volume—Defines how to retrieve the number of interactions coming into the contact
center for each activity. Used for Immediate and Deferred activities.

• Abandonment Volume—Describes the number of interactions abandoned from the contact center for
each activity. Used for Immediate activities.

• Quality of Service—Used to compare the actual values with the service objectives projected in the
schedule for each activity. This includes statistics that track service level and average time of answer
(ASA). Used for Immediate activities.

• Handle Time—Tracked for each activity and compared to the handle-time objectives defined in the
forecast. Used for Immediate and Deferred activities.

• Backlog—Tracks the number of incoming interactions in the queue that are waiting for processing and
have not yet been distributed to the agents. Used for Deferred activities only.

Object—The Queue, Interaction Queue, Routing Point, Group of Queues, Group of Routing Points,
Group of Agents, or Group of Places being monitored.

• Queue—All DNs of the ACD Queue and Virtual Queue types in the site.
• Interaction Queue—Script objects of the Interaction Queue type.
• Routing Point—All DNs of the Routing Queue and Virtual Routing Point types in the site.
• Group of Queues—All DN Groups of the ACD Queue type in the site.
• Group of Routing Points—All DN Groups of the Routing Points type in the site.
• Group of Agents—All DN Groups of the Agent type in the site.
• Group of Places—All DN Groups of the Place type in the site.

Filters—Optional values that define the interactions handled by the object more precisely. Used in
contact centers with multi skilled agents. In most cases, filters require installation of Genesys
Universal Routing Server (URS).

Flexible Configuration Mode

The Statistics section of Statistics Properties includes a Flexible configuration mode setting
for certain Types (such as, Quality of Service, Handle Time, Interaction Volume, and Backlog). When
enabled, it supports configuration settings from a previous release of WFM or to specify more
complex statistical requests

In Flexible configuration mode, if you select Interaction Volume, Handle Time, or Backlog all Object
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types are available rather than only those shown in Recommended Statistics Settings. That is, you
can select objects of the types Queue, Interaction Queue, Routing Point, Group of Queues, Group of
Routing Points, Group of Agents, or Group of Places.

If you select Quality of Service while in Flexible configuration mode, you can select statistics for
average speed of answer alone.

If you are not in Flexible configuration mode, you must select one of these combinations:

• Service Factor, Distributed Interactions, and Time Range
• Distributed Interactions and Average Speed of Answer
• Service Factor, Distributed Interactions, Average Speed of Answer, and Time Range.

Statistics configured using Flexible configuration mode setting appear in the Statistics list with
an exclamation mark icon next to them.

Important
If you select the Flexible configuration mode check box but do not configure any of
the additional settings which then become available, the statistic is treated as if the
Flexible configuration mode check box was cleared. No exclamation point icon
appears next to the statistic in the Statistics list; and when you edit the statistic, the
Flexible configuration mode check box is not selected.

Use As Average

Also in the Statistics section of Statistics properties, the Use as average setting tells WFM to
record average values. Use it only for the Quality of Service and Handle Time statistics types.

For example, regular Handle Time statistics provide the total handle time, a number which is then
divided by the number of interactions handled to produce the value that WFM uses. If you select Use
as average, WFM simply records the total handle time and does not divide that value by the number
of interactions.

Important
You can apply Use as average only once per activity for each statistic type.
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Configuring Statistics for Activities
Use the Activities Statistics pane to associate Stat Server statistics with selected activities. When
you define a statistic, you tell WFM which statistics and which objects to monitor for each activity. You
define multi-site activity statistics in the same way you define regular activity statistics.

Some activities may require multiple statistics definitions, for example, you may have to define
statistics for each queue or group that performs this activity.

Add and delete statistics for activities using the procedures in this topic.

Adding Statistics to Activities

To add statistics to an activity:

1. Select the Site that contains the activities you want to associate with statistics.
2. In the Activities Properties pane, select Statistics.

3. In the Activity Statistics pane, click Add Statistics Information to activity .
4. In the Statistic Type pane, configure the statistics. See Recommended Statistics Settings.
5. Select a Filter, if necessary.

Filters are used in multi skilled contact centers to further clarify the object to be monitored.
6. Select the Time Range(s) for Quality of Service statistics.

You can select one or two time ranges.
7. Check the Flexible configuration mode check box, if applicable.

This option is not available for Abandonment Volume statistics.
8. Check the Use as average check box, if applicable.

9. Click Apply .

10. After the statistic appears in the Activity Statistics pane, click Save Now .
The selected statistic is now associated with the activity.

11. To add additional statistics to this same activity, click Add Statistics Information to activity and
continue with steps 3-7 in this procedure.

Tip
The Statistics section displays different statistic, depending on the Type/Object
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combination you choose. Statistic types are predefined and not all statistics types
apply to all activity types.

Fixed staff activities do not use statistics. Therefore, if you select an activity of type Fixed-Staff Work, the
Statistics pane is not displayed.

After the Type and Object are selected, the drop-down lists are enabled and you can
choose statistics from the list. For a description of all of the Types, Objects,
Statistics, and Filter, see Statistics Properties.

Recommended Statistics Settings

The Statistics Option names in this table are suggested. Use Genesys Administrator to open the
Stat Server application, where you can set the names for these options and the values for their
objects.

Statistics Types Statistics Options Available Objects

Interaction Volume
TotalNumberCallsEntered
(or WFMTotalNumberCallsEntered)

Queue, Interaction Queue,
Routing Point, Group of Queues,
and Group of Routing Points

Abandonment Volume
TotalNumberCallsAband
(or WFMTotalNumberCallsAband),
TotalNumberShortAbandons, TimeRange

Queue, Interaction Queue,
Routing Point, Group of Queues,
and Group of Routing Points

Quality of Service

ServiceFactor1 (or
WFMServiceFactor1),
AverTimeBeforeAnswering
(or WFMAverTimeBeforeAnswering),
TotalNumberCallsDistrib (or
WFMTotalNumberCallsDistrib)

Queue, Interaction Queue,
Routing Point, Group of Queues,
and Group of Routing Points

Handle Time

TotalNumberCallsHandled
(or WFMTotalNumberCallsHandled),
TotalHandleTime (or
WFMTotalHandleTime)

Group of Agents, Group of Places

Backlog
EmailsWaitingInQueue
(or WFMEmailsWaitingInQueue)

Queue, Interaction Queue,
Routing Point, Group of Queues,
and Group of Routing Points

Tip
Statistics for the multimedia interaction queue depend on the interaction type (for
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example, the email, chat, backlog and open media types will have different statistics).
For a complete list of statistics and statistic categories, see the Workforce
Management Administrator's Guide.

Deleting Statistics from Activities

To edit statistics associated with an activity:

1. In the Activities Statistics pane, select statistic you want to delete.

2. Click Remove Statistics Information from activity .
3. When the Confirmation dialog appears, select Yes to proceed or No to cancel the action.

4. Click Save Now .
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Configuring Skills for Multi-Site Activities
Use the Skills pane to add, or delete skills that are associated with a multi-site activity.

Adding Skills to a Multi-Site Activity

To add a skill to a multi-site activity:

1. In the Objects pane, select a business unit.
2. In the Activities pane, select the multi-site activity, to which you want to add skills.
3. At the top of the Multi-Site Activities Properties pane, click Skills.

4. When the Skills pane opens, click Add Skills to an Activity .
5. In the Skills pane, assign the minimum and maximum skill levels.

• Skill Minimum Level—A minimum skill level value required for an agent with this skill to perform
this activity. Define whatever range is appropriate for each skill, such as 1 to 10 or 1 to 100. The
range should be consistent with the range used in Configuration Manager.

• Skill Maximum Level—A maximum skill-level value required for an agent with this skill to perform
this activity.

6. In the list of skills, select those that you want to associate with the multi-site activity.
To quickly find a skill, you can enter search criteria into the Search field (for example, the
skill name). You must define skills in Configuration Manager before they appear in this list.

7. When you have finished selecting skills, click Apply .

Deleting a Skill Associated With a Multi-Site Activity

To delete a skill:

1. In the Skills pane, select the skill you want to delete.
To quickly find a skill, you can enter search criteria into the Search field (for example, the
skill name).

2. Click Delete .

3. When you have finished deleting skills, click Save Now .
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Multi-Site Activities Agents Pane
This pane is read-only and displays the agents who are associated with the multi-site activity.

You cannot associate agents with multi-site activities directly. Agents are associated with multi-site
activities if their skills match the skills that are required by the child activities of the multi-site activity
or are assigned to work on the child activity directly in WFM Web for Supervisor. Therefore, to adjust
which agents are associated with a multi-site activity, change that agent's skill settings or assign the
activity to an agent with an effective date. For more information, see the Agent Activities view.
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Assigning Activities To Multi-Site Activities
Multi-site activities are regular activities that are being combined, for tracking purposes, into a single
multi-site activity that is associated with a business unit. For example, you might want to track an
activity, such as answering inbound calls, for all or some of the sites in one business unit, and track
another activity, such as answering email, for all or some sites in another business unit. Grouping the
same activity from multiple sites in the same business unit (creating a multi-site activity) allows you
to do that.

Use the Activities pane within the Multi-Site Activities view to associate activities with multi-site
activities.

Tip
To have the correct list of agents that can trade on primary and secondary activities,
Genesys recommends to add only one activity under a site to the multi-site activity
while configuring.

To assign an activity to a multi-site activity:

1. In the Objects pane, select a business unit.
2. In the Activities pane, select the multi-site activity with which you want to associate activities.
3. At the top of the Multi-Site Activity Properties pane, click Activities.

The Associated Activities pane opens.

4. Click Assign regular activities .
The Activities pane opens.

5. Select the activities you want to associate with this multi-site activity.

To quickly find an activity, use the Search, Filter, or Sort agents in ascending or
descending order.

6. When you have selected all activities, click Apply .

7. In the Associated Activities pane, click Save Now .

Tip
An activity can belong to only one multi-site activity. Only activities for the selected
business unit are available. Activities for other business units do not appear.
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Configure Skills and Statistics
After assigning activities, you can configure Skills and Statistics:

Click Skills at the top of the Multi-Site Activities Properties pane to configure the skills that you
want to be tracked for the multi-site activity. See Configuring Skills for Multi-Site Activities.

Configure the statistics you want to be tracked for the multi-site activity. For more information, see
Configuring Statistics for a Multi-Site Activity.

Using Filters To Assign Activities To Multi-Site Activities

1. In the Activities pane, click Filter .
The Filter pane opens.

2. In the Sites list, do one of the following:
• Remove the check mark in the All check box and select the sites, to which you want to assign these

groups and activities.
• Retain the check mark in the All check box. (If this box is checked, the activities and groups apply to

all sites in the list.)

3. In the Multi-Site Activities section, do one of the following:
• Remove the check mark in the All check box and select the multi-site activities, to which you want

to assign these groups and activities.
• Retain the check mark in the All check box. (If this box is checked, the activities and groups apply to

all multi-site activities in the list.)

4. Click Apply .
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Associating Sites with a Multi-Site Activity
If you select a multi-site activity and click Activities in the Multi-Site Activity Properties pane,

you can select Assign a Missing Site to Multi-Site Activity to assign the activity to a missing
site (unless activities from all visible sites were already assigned to a multi-site activity) The Assign
a Missing Site to Multi-Site Activity pane opens and all sites within the selected business unit are
listed.

To create a new, similar activity for each selected site:

1. Select a site.
You can select more than one site by using the CTRL or SHIFT key.

2. Optionally, you can check the Distribute Multi-Site Open Hours and Skills check box to assign
open hours. See the Tip below.

3. Click Apply .
Under each selected site, WFM generates a new activity that can be renamed and
associates that activity with the selected source multi-site activity. Open hours for the
activity are 24/7 by default.

Tip
If you checked Distribute Multi-Site Open Hours and Skills, then open hours and
skills for the generated activity (or activities) will be the same as they are for the
selected source multi-site activity.
Each site’s time zone is used to define the open hours—and it might be a different time zone from the one
used by the business unit under which the source multi-site activity is located.

An activity generated in this way will always have the same activity type as the multi-
site activity that was its source.
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Statistics For Mulit-Site Activities
Use the Multi-Site Activities Statistics pane to associate statistics with selected activities. When
you define a statistic, you tell WFM which statistics and which objects to monitor for each activity. You
define multi-site activity statistics in the same way you define regular activity statistics.

For basic information about activities, activity types, and how to configure activities, see Configuring
Statistics for Activities.

Associating Statisitics with Multi-site Activities

To associate statistics with multi-site activities:

1. In the Objects pane, select the business unit that contains the multi-site activities you want to
associate with statistics.

2. In the Activities Properties pane, select Statistics.

3. In the Activity Statistics pane, click Add Statistics Information to activity .
4. In the Statistic Type pane, configure the statistics as in steps 3-11 in the procedure Adding Statistics

to Activities. See also Recommended Statistics Settings.
The Statistics section displays different statistic, depending on the Type/Object combination
you choose. Statistic types are predefined and not all statistics types apply to all activity
types.
Fixed staff activities do not use statistics. Therefore, if you select an activity of type Fixed-
Staff Work, the Statistics pane is not displayed.

5. After the Type and Object are selected and the drop-down lists are enabled, choose statistics from the
list.
For a description of all of the Types, Objects, Statistics, and Filter, see Statistics Properties.

For more information about statistics for a multi-site activity, see Statistics Properties.

Deleting Statistics from Multi-Site Activities

To delete a statistic from a multi-site activity, follow the steps in the procedure Deleting Statistics
from Activities.
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Configuring Default Forecasting Objectives
Use the Default forecasting objectives tab within the Activities view to set default target service
levels or staffing requirements for different types of activities. You can configure default forecasting
objectives for the following activity types (for activities under sites and multi-site activities):

• Immediate work
• Deferred work
• Fixed-Staff work

Configuring default forecasting objectives for Immediate Work
activities

When an Immediate Work type activity is selected, you can configure the following settings and
options as the default forecasting objectives:

• Target Options
• Staffing Requirements
• Service Level Objectives (enabled if this option is selected in Provide Target Options)
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Provide Target Options

• Enter a percentage value for the Indirectly Occupied Time (IOT) setting. Alternatively, you can select
Use Template to define IOT with a template. For more information about IOT, see What is Indirectly
Occupied Time?

• Select Use Service Level Objectives to use the settings specified in the Service Level Objectives
section. When selected, the options in this section become active and can be configured. All other
configuration sections are greyed out.

Staffing Requirements

• Number of Agents Each Timestep — Select and enter a value for the number of agents.
• Average Activity Handling Time (sec) — Select and enter a value (seconds).
• Use Staffing Template — Select and click Load Templates to edit a template.

Service Level Objectives
The settings in this section are enabled when the Use Service Level Objectives option is selected
in the Provide Target Options section.

• Use estimated average time to abandon (sec) — This is not a service objective. It's a parameter
that helps define the queuing system used when WFM builds staffing requirements. This value
represents the average time it takes for impatient callers to abandon the call.
• Use service level objective — this setting specifies the percentage of calls to be answered in a

specific number of seconds. For example, 80% of calls must be answered in 20 seconds. Select to
enable it, and then enter the desired values. Alternatively, you can select Use Template to enable
the Load Template button and select a template to edit.

• Use Average Speed of Answer Objective — Specifies the average amount of time it takes for an
agent to answer a call. Select and specify a value for ASA (sec). Alternatively, you can select Use
Template to enable the Load Template button and select a template to edit.

• Use occupancy objectives — The total amount of time the agent is actually working on an activity as
a percentage of the total amount of time the agent is available to work on an activity. Select to enable
it and then enter a value for Maximum Occupancy Rate (%). Alternatively, you can select Use
Template to enable the Load Template button and select a template to edit.

• Use abandoned interaction objective — Select to enable it and then enter a value for Maximum
percent of interactions abandoned (%).

Configuration Activities

Workforce Management Web for Supervisors Help 259



Configuring default forecasting objectives for Deferred Work
activities

When a Deferred Work type activity is selected, you can configure the following settings and
options as the default forecasting objectives:

• Target Options
• Multimedia Service Level Objectives

Provide Target Options

• Use the Indirectly Occupied Time (IOT) setting to define the queuing model that WFM uses when
building a staffing forecast. Alternatively, you can select Use Template to define IOT with a template.
For more information about IOT, see What is Indirectly Occupied Time?

• In the Initial queue field, enter an integer value that is 0 or greater. (If you leave this value empty,
WFM assumes that the value is 0.)

Specify Multimedia Service Level Objectives
Enter a value (%) for Deferred work and enter time based on:

• Hours, Minutes, or Seconds and select either Non-interrupted time or Interrupted time or
• Business days, and enter an integer greater than 0 for the Days value.

Alternatively, you can select Use Service Level Template to enable the Load Template button
and select a template to edit.
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Configuring default forecasting objectives for Fixed-Staff Work

When a Fixed-Staff Work type activity is selected, you can configure the following settings and
options as the default forecasting objectives:

• Target Options
• Staffing Requirements

Provide Target Options

• Use the Indirectly Occupied Time (IOT) setting to define the queuing model that WFM uses when
building a staffing forecast. Alternatively, you can select Use Template to define IOT with a template.
For more information about IOT, see What is Indirectly Occupied Time?

Staffing Requirements

• Number of Agents Each Timestep — Select and enter a value for the number of agents.
• Average Activity Handling Time (sec) — Select and enter a value (seconds).
• Use Staffing Template — Select and click Load Templates to edit a template.

What is Indirectly Occupied Time (IOT)

Indirectly Occupied Time (IOT) helps to define the queuing model that WFM uses when
building a staffing forecast. WFM considers a certain pool of agents in its queuing model
when determining how calls will be distributed from the queue to agents. IOT affects the
availability of agents to handle calls. For example, if you enter a value for IOT, such as
10%, an agent will not be in the agent pool 10% of the time (because the agent is off the
phone).
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Using templates for default forecasting objectives

When configuring the default forecasting objective settings for an activity type, you can choose to
use a template to define certain properties rather than enter the settings manually. To use a
template, it must already be defined for that property.

When you select Use Template and click Load Templates, a Templates pane opens where you can
see a list of available templates for that objective property. Select at least one template and one
weekday, and then click Save.

If you don't already have forecasting templates defined for each type of objective, see Forecast
Templates to learn how to create a new template and then follow the steps described in the Activities
tab to set the desired properties.
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Deleting Default forecasting objective values

To delete the Default forecasting objective values already set for an activity, click on the Default
forecasting objectives tab.
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Users
Users are supervisors and other persons who are not agents. Users are divided into two groups:

1. Users who have been imported into WFM (WFM users).
2. Users who are configured in Genesys but not selected as WFM users (Genesys Users).

In the Users module, you can:

• View a list of existing WFM users.
• View user properties.
• Configure a specific time zone, WFM Builder instance, and security role for a user.
• View and edit security role privileges.
• Grant or remove a user's access rights to business units, sites, and teams.
• Grant or remove a user's access rights to notifications.

Tip
If the user's role privileges are changed in this module and they no longer match the
privileges set in the Roles module, the following dialog appears:

Figure: Confirmation Dialog

Click Yes to unassign the current security role or click No to cancel the action and
retain the user's current security role.

Users Pane

This pane contains a list of users that have been imported into Workforce Management. It has the
following columns: Username, First Name, Last Name, and E-mail. You can add users to this list
(see Importing Genesys Users), or delete them.
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In this pane, you can:

• Import Genesys users into WFM by clicking Import Genesys User .

• Delete users by selecting them in the list and clicking Delete .
• Search users by entering their usernames in the Search field.
• Sort the list by clicking the Username, First Name, or Last Name column headers.

Importing Genesys Users

When you import Genesys users, a pane opens that includes a drop-down list of the existing security
roles. By default, the user you select is assigned the first role in this list. If no security roles exist, the
list displays <none>. All imported users are assigned to the role selected from the list.

After import is finished, the Users pane displays the new users in its list. You can then select a user
and change or configure their settings in the Properties, Role Privileges, or Access Rights pane.
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User Properties
The Users Properties pane contains information about the selected WFM user.

User information

The User Information pane contains the following read-only fields, previously entered in Genesys
Administrator:

• First Name of the user as entered in Genesys Administrator.
• Last Name of the user as entered in Genesys Administrator.
• Email. This is the user's email address entered in Genesys Administrator. WFM uses this email address

for notification of:
• Changes in the status of schedule trade requests.
• Changes in the status of time-off requests.

For more about email notifications, see the Workforce Management Administrator's Guide.

Configuring Optional Settings
To configure the optional settings in the User Information pane:

1. Select a Time Zone for the user or leave blank. Time zone can be used in some Performance views
and reports as an alternative to the site or business unit time zone. If you configured a default time
zone before importing the user, that time zone appears as the Time Zone. If you did not configure a
default time zone, <none> appears here.

Important
If you subsequently changed the default time zone, the time zone set as default when the user was imported
appears here.

To set a different time zone for this user:

• Select the time zone from the drop-down list box. All time zones that have been imported into
Workforce Management from the Configuration Database are included.

If you need additional time zones, use the Organization > Time Zones view to change the time
zones that appear in the list. See Time Zones List for details.

2. Select a WFM Builder server for the user or leave blank. This is the server that builds schedules. To
use a specific WFM Builder to create WFM schedules for a dedicated group of users:
• Select the WFM Builder server from the drop-down list.
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You do not need to specify a WFM Builder server if you want all users to share the same one. The
default value is None.

3. Select Security Role for the user or leave blank. If you select a Security Role, the user adopts the role
privileges that you configured for that security role. If the user is not assigned to a security role:
• Clear the check boxes next to the names of the role privileges the user should not have permission

to access. By default, all options are selected.

4. Click Save Now .
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User Role Privileges
The Users > Role Privileges pane contains a list of security role privileges that are assigned to the
selected user. Role privileges are described in detail in Roles Privileges.

To change a user's role privileges:

1. Select a user and then, click the check box beside the privileges you want to change.

2. Click Save Now .

Click Help to view a Help topic about this pane.

Granting Access Rights to Get Notifications

The Role Privileges pane in the Users module is identical to the Role Privileges pane in the Roles
module, with one exception; In the Users module, you can grant access to Notifications.

To grant access to notifications:

1. In the Role Privileges list, click the arrow to expand Notifications, as shown in the figure below.

Figure: Role Privileges—Notifications

2. Click the arrow in the appropriate row to grant the selected user access to receive notifications about
one of the following status changes:
• Time-off request status changes
• Schedule trading status changes
• Time-off balance-affecting status changes
• Time-off bidding status changes

3. A new pane opens, enabling you to grant access rights to the specific notification privilege you selected.
For example, if you clicked the arrow in the first row, the Grant Access rights for Get Notified About
Time Off Request Status Changes pane opens.

4. In the new pane, do one of the following for the selected privilege:

• Add access rights
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• Remove access rights

• Close this pane and cancel any changes you made

• Open a Help topic related to this pane

5. When you have completed all tasks, in the Role Privileges pane, click Save Now .
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Access Rights
The Access Rights pane displays the business units, sites, and teams, to which the user has been
given access. Use the controls in the top-right corner of these panes to complete the all of the tasks
described in this topic.

Access Rights pane controls

Remove security rights to selected BU
leaving sites unchanged

Click to remove the user's access rights to selected
business unit, but retain the user's access rights to
the sites within this BU.

Add Access Rights

Click to open the Select items to Grant Access
to Users pane, which enables you to grant the
user access rights to selected business units, sites,
or teams within the enterprise.

Tip
Objects to which the user already has access rights
are not displayed in this pane.

Remove Access Rights to selected items
Click to remove the user's access rights to selected
objects.

Help
Click to view a Help topic about the Access Rights
pane.

Save Now
Click to save any changes you made to the user's
access rights.

Select Items to Grant Access to Users pane controls

Apply
Click to assign the user access to the selected
items.

Close
Click to close this pane without applying any
changes.

Help Click to view a Help topic about the this pane.
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Roles
Security Roles control general permissions (or privileges), as well as access permissions to various
modules in WFM Web for Supervisors. Roles do not control access to business units, sites, or teams.
To add or restrict access to these specific objects, see Access Rights.

In the Roles view there are two lists:

• The WFM Users list contains these columns: User Name, User First Name, User Last Name, User E-mail,
and Role.

• The Genesys Users list contains these columns: User Name, User First Name, User Last Name, and User
E-mail.

In the Roles module, you can:

• Import users
• Define a default security role
• Assign security roles to users. Users automatically take on the privileges or permissions configured for

the security role to which they are assigned.

Tip
Security roles enable you to set permissions for access to modules but not to business units, sites, or teams.
To enable the rights to add or restrict access to these specific objects, you must check the Access Backend
Configuration check box in the Role Privileges pane.
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Creating Roles
To create a new security role:

1. Go to Configuration > Roles.

2. In the Role pane, click New .
A new security role appears in the Role pane with a default name.

3. In the Role Privileges pane, change the Name of the role (if desired).
4. Assign privileges by expanding items in the list and selecting/clearing the check boxes.

For a complete description of all privileges, see Role Privileges.

5. Click Save Now .

Next Step: Assign the security role to a user.

Using Copy to Create Roles

To create a security role using copy:

1. In the Roles pane, select an existing role.
If there are many roles in the list, enter the role name in the Search field to find it quickly.

2. Click Copy .
A copy of the selected role appears in the Roles list.

3. Select the copy and click Role Privileges.
4. Rename and assign privileges to the role by selecting or clearing the check boxes, as required.

5. Click Save Now .

Next Step: Assign the security role to a user.
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Assigning Roles to Users
WFM enables you to assign and unassign security roles, and delete users from the Assigned Users
list. These tasks are described in the procedures below.

To assign users to the role:

1. At the top of the Role Privileges pane, click Users and then, do one of the following:

• Click Assign Users to assign a WFM user to this role.
A new pane opens, containing a list of WFM users.

• Click Import Genesys User to assign a Genesys user to this role.
A new pane opens, containing a list of Genesys users.

2. Select the users you want to assign to this role and click Apply .

3. In the Users pane, click Save Now .

Important
New users are automatically granted access to all modules, objects, and sites. Also,
only users in the WFM Users list can access Workforce Management functionality
(with the exception of WFM Web for Agents).

You can also create a new security role using copy and paste. See Editing Security Roles.

Unassigning Users from Roles

To unassign a user from a security role:

1. In the Assigned Users list, select the user to want to unassign from this role.

2. Click Unassign User .
3. When the Confirmation dialog appears, select Yes to proceed or No to cancel the action.

4. Click Save Now .
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Deleting Users from Assigned Users List

To delete a user from the Assigned Users list:

1. In the Assigned Users list, select the user to want to remove from this list.

2. Click Delete User .
3. When the Confirmation dialog appears,select Yes to proceed or No to cancel the action.

4. Click Save Now .

Important
Proceed with caution when clicking Yes in the Confirmation dialog. Doing so
removes all of the user's role privileges and access rights to WFM.
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Editing and Deleting Roles
WFM enables you to edit and delete security roles from the Roles list. These tasks are described in
the procedures below:

To edit a security role:

1. In the Role pane, select the role you want to edit.
If there are many roles in the list, enter the role name in the Search field to find it quickly.

2. Click Role Privileges.
3. Rename the role and/or select/clear the check boxes next to the privileges you want to change.

4. Click Save Now .

Deleting Security Roles

To delete a security role:

1. In the Role pane, select the role you want to delete.

2. Click Delete .
3. When the Confirmation dialog appears, click Yes to proceed or No to cancel the action.

Important
Proceed with caution. If you select Yes, the action cannot be undone.
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Role Privileges
The Role Privileges pane in the Roles module displays an extensive list of modules and objects, to
which you can control access. The same list of privileges appears when you select a user in the
Users: Role Privileges pane in the Users module.

Important
New users are automatically granted access to all modules, objects, and sites as
described in the Role Privileges overview and sub topics.

See Also:

• General Role Privileges
• Configuration Role Privileges
• Policies Role Privileges
• Calendar Role Privileges
• Forecast Role Privileges
• Schedule Role Privileges
• Trading Role Privileges
• Performance Role Privileges
• Adherence Role Privileges
• Reports Role Privileges
• Notification Role Privileges
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General Role Privileges
The role privileges under General provide the following user access:

• Show agent wage field—Controls user access to view the Hourly Wage field in WFM Web for
Supervisors Configuration > Agents > Properties pane. It also controls whether the user will see
agent wage information in the Agent Properties report.

• Show unassigned agents—Controls whether the selected user can view unassigned agents that
appear in all lists where agents appear. The lists appear in the Organization module in Sites >
Teams > Add Agents and Sites > Agents > Add Agents.

Important
New agents without logins (or with logins to multiple switches) are imported automatically during
synchronization even if the Show unassigned agents option is turned off for the user who triggers
synchronization; although they are not visible to this user. The only security for these new agents is Tenant
security.

• Allow Backup/Restore—Controls user access to the WFM Database Utility to perform backups and
restores. If cleared, the user cannot log into the Database Utility. For more information on this utility,
see the Workforce Management Administrator's Guide.
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Configuration Role Privileges
Some privileges under Configuration are Supervisor views in the Configuration module (Read,
Edit, Add/Delete, Access Backend Configuration, and Skills settings are not). Select the check box
next to each privilege to give the selected user access to configure items related to that privilege.

The role privileges under Configuration provide the following user access:

• Roles/Users
• Agents

• Read—Controls user access to view all panes within the Agents views. If unchecked, all other
privileges under Agents are also unchecked.

• Allow Move—Controls whether this user can move agents to a different team, site, or business
unit.

• Edit Properties—Controls whether this user can edit items in the Properties pane in the Agents
view.

• Edit Activities—Controls whether this user can edit items in the Activities pane in the Agents
view.

• Edit Contracts & Rotating Patterns—Controls whether this user can edit items in the Contracts
& Rotating Patterns pane in the Agents view.

• Edit Time Off—Controls whether this user can edit items in the Time Off pane in the Agents view.
• Edit Time-Off Bonuses—Controls whether this user can edit items in the Time-Off Bonuses pane

in the Agents view.

• Organization
• Read—Controls user access to view all panes within the Organization views. If unchecked, all

other privileges under Organization are also unchecked.
• Edit—Controls whether this user can edit items in all views and panes within this module.
• Add/Delete—Controls whether this user can add and delete items in all views and panes within the

Organization view.
• Access Backend Configuration—Controls configuration access to certain panes in this module. If

this right is not assigned to the user these panes are not visible:
• The Configuration pane in Organization > Business Units and Organization > Sites

views.
• The Statistics pane in Activities and Multi-Site Activities views.

• Skills—Controls user access to skills configuration in the Organization > Business Units views.
• Time Zones—Controls user access to time zones configuration in the Organization view.

• Schedule State Groups—Controls whether this user has access to the Schedule State Groups view
in this module. Users with this permission can modify the configuration of these groups.
• Read—Controls user access to view all panes within the Schedule State Groups views. If

unchecked, all other privileges under Schedule State Groups are also unchecked.
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• Add/Edit/Delete—Controls whether this user can add, edit, and delete items in all views and panes
within the Schedule State Groups view.

• Notifications—Controls whether this user has access to the Notifications view in this module. Users
with this permission can modify the configuration of email notifications in WFM.

• Colors in Schedule—Controls user access to custom colors configuration for elements in the schedule.
• Shared Transport—Controls user access to shared transport functionality (enabled by default). Clear

this check box to disable.
• Time-off Bidding Periods—Controls user access to the Time-Off Bidding Periods view.

• Read—Controls user access to view all panes within the Time-Off Bidding Periods view. If
unchecked, all other privileges under Time-Off Bidding Periods are also unchecked.

• Add/Edit/Delete—Controls whether this user can add, edit, and delete items in all views and panes
within the Time-Off Bidding Periods view.

• Activities—Controls access to the Activities and Multi-Site Activities views.
• Read—Controls user access to view all panes within the Activities view. If unchecked, all other

privileges under Activities are also unchecked.
• Add/Edit/Delete—Controls whether this user can add, edit, and delete items in all views and panes

within the Activities view.
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Policies Role Privileges
Most of the items under Policies are all WFM Supervisor views in the Policies module (Read and
Add/Edit/Delete are not). Select the check box next to each privilege to give selected users access
to configure items related to that privilege.

The role privileges under Policies provide the following user access:

• Read—Controls user access to view all panes within the Policies module. If unchecked, all other
privileges under Policies are also unchecked.

• Add/Edit/Delete—Controls whether this user can add, edit, and delete items in all views and panes
within the Policies module.
• Time-Off Rules
• Contracts
• Shifts
• Exception Types
• Meetings

• Read—Controls user access to view all panes within the Meetings views. If unchecked, all other
privileges under Meetings are also unchecked.

• Add/Edit/Delete—Controls whether this user can add, edit, and delete items in all views and
panes within the Meetings view.

• Rotating Patterns
• Marked Times
• Time-Off Types

To have this user receive email notifications when there are time-off requests that require manual
review, select Get Notified About Time-Off Request Status Changes, which appears under
Notifications.
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Calendar Role Privileges
The role privileges under Calendar provide the following user access:

• Read—Controls user access to view all panes in the Calendar module. If unchecked, all other privileges
under the Calendar are also unchecked.

• Add/Edit/Delete—Controls user access to view, add, and edit agent preferences and exceptions in the
Calendar module.

• Prefer/Grant/Decline—Controls user access to grant or decline agent preferences in the Calendar
module.

• Edit Time-Off Limits—Controls user access to edit time-off limits in the Calendar module.
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Forecast Role Privileges
The role privileges under Forecast provide the following user access:

• Read—Controls user access to:
• Creating Forecast Scenarios.
• Viewing and edit shared Forecast Scenarios.
• Viewing the Master Forecast.
• Extracting the Master Forecast to their own or shared Scenarios.
• Viewing Historical Data.

Important
If Read is unchecked, all other privileges under Forecast are also unchecked.

• Publish—Controls user access to all Read permissions plus permission to publish to the Master their
own Forecast Scenarios or shared scenarios.

Three security options are available under this Forecast Publish right:
• Publish IV to Master Forecast
• Publish AHT to Master Forecast
• Publish Staffing to Master Forecast

If only one or two of these permissions are granted, the user will not have full security access to the
Publish.

Important
Only those users who have access to Publish before migration will have access to the new options after
migration.

• View All Scenarios—Controls user access to all Read permissions plus permission to:
• View, edit and share all Forecast Scenarios.
• Extract from the Master Forecast to all Scenarios.

• Edit Historical Data—Controls user access to all Read permissions plus permission to:
• Edit historical data to be used when creating a Forecast Scenario.
• Copy/paste historical data to/from Excel.
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• Overlays—Controls user access to all Read permissions plus access to all Overlays functionality in the
Forecast module.
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Schedule Role Privileges
The role privileges under Schedule provide the user access to the actions describe below. Select the
check box next to each item to give permission to perform that action:

• Read Master—Controls user access to view and extract data from the Master Schedule, but not publish
to the Master Schedule. (See the special note below.) If unchecked, all other privileges under Schedule
are also unchecked.

• Edit Master—Controls user access to edit the Master Schedule.
• Publish—Controls user access to publish scenarios to the Master Schedule.
• Clean Up Master—Controls user access to clean up the Master Schedule.
• Create Scenario—Controls user access to create scenarios.
• Access Shared Scenario—Controls user access to all schedule scenarios that are marked as Shared.
• View All Schedule Scenarios—Controls user access to view all schedule scenarios that are marked as

Shared.
• Build—Controls user access to build schedules.
• Approve Changes—Controls user access to the Changes Approval module, to approve or decline

pending changes in schedules that you or others have made.
• Access Overtime Requirements—Controls user access to all scheduled overtime requirements that

are marked as Shared.
• Overtime Bidding—Controls user access to the Overtime Bidding view and the ability to create,

modify, and initiate processing of overtime bidding offers.
• Read—Controls user access to view all panes within the Overtime Bidding views. If unchecked, all

other privileges under Overtime Bidding are also unchecked.
• Add/Edit/Delete—Controls whether this user can add, edit, and delete items in all views and panes

within the Overtime Bidding view.

Special Note About Read Master

Check Read Master to give user access to view and extract data from the Master Schedule, but not
publish to the Master Schedule. Use the remaining check boxes under Schedule to give additional
permissions.

When Read Master is selected, the user can:

• Extract data from the Master Schedule to an owned or shared Schedule Scenario.
• View their own Schedule Scenarios and/or other Schedule Scenarios designated as shared by the

creator.
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About Scenarios
When working in Web for Supervisors, you can build multiple Schedule Scenarios that may contain
different agents, different types of shifts or rotating patterns, etc. You will eventually decide to
publish all or part of one of these scenarios to the Master Schedule.
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Trading Role Privileges
The role privilege under Trade provides the following user access:

• Trading—Controls user access to trading information in WFM Web for Supervisors.
• Read—Controls user access to view all panes within the Trading module. If unchecked, all other

privileges under Trading are also unchecked.
• Approve Trades—Controls whether users can accept or decline agents’ schedule trade proposals

and add comments in all views and panes within the Trading module.

To have users receive email notifications when there are agent trade requests that require manual
review, select Get Notified About Schedule Trading Status Changes, which appears under
Notifications.

For more information, see Trading.
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Performance Role Privileges
The role privileges under Performance provide the following user access:

• Read—Controls user access to view Performance information in WFM Web for Supervisors. All users who
have the Read privilege for the Performance module can see alerts when the configured thresholds
have been exceeded.

• Update Alerts—Controls user access to modify alert thresholds and save changes in the Alerts view in
the Performance module where users configure thresholds for each metric.

Important
The Alerts function in WFM Web for Supervisors uses Master Forecast and Schedule
data as a baseline for acceptable performance results. If user-defined performance
limits are violated (for example, if too many interactions are being abandoned, or if
service levels fall too low), an Alert warning in the Monitor view notifies that action
may be necessary.

For more information, see Performance Overview.
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Adherence Role Privileges
The role privilege under Adherence provides the following user access:

• Adherence—Controls user access to the Adherence module in WFM Web for Supervisors, which
monitors real-time agent adherence to the schedule.

For more information, see Adherence.
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Reports Role Privileges
The role privileges under Reports provide the following user access:

• Read—Controls the user's read access to all views and panes within the Reports module. If unchecked,
all other privileges under Reports are also unchecked.

• Reports Scheduler
• Allow Use of Reports Scheduler—Control user access to the Reports Scheduler, enabling them to

schedule reports generation.
• View All Scheduled Reports—Control user access to view all scheduled reports.

Selecting the check box next to a report enables the selected user to create that report.

For information on how to generate and read Reports, see Reports.
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Notification Role Privileges
The role privileges under Notifications provide the following user access:

Selecting the check box for each item enables that notification (the default state). Clearing the check
box disables that option:

• Get Notified About Schedule Trading Status Changes
• Get Notified About Time-Off Request Status Changes
• Get Notified About Time-Off Balance-Affecting Changes
• Get Notified About Time-Off Bidding Status Changes

Tip
You can set fewer objects (than those in Configuration > Notification > Targets)
for each user that will be notified by the settings in Users > Role Privileges >
Notifications.
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Calendar
The Calendar module contains two sub-modules:

• Select Calendar items to:
• Add availability, days off, exceptions, shifts, time off, and working hours.
• Edit agent exceptions, preferences, and time off.
• Review rotating patterns.
• Change the time zone to view Calendar items' times in the selected by user time zone.

• Select Time-Off Limits to set time-off limits.
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Calendar Items

Tip
The Calendar module includes Calendar Items (this topic) and Time-Off Limits.

The toolbar buttons are across the top of the window and the action buttons are across the bottom of
the window. The Agents and Activities trees are at the top of the Objects pane.

Use the Calendar Items module to add and edit agents' exceptions, preferences, and time off.

• Exceptions are periods of time when agents are engaged in non-work activities.
• Preferences are agent and supervisor requests for particular shifts, days off, availability, and time off.
• Rotating patterns are rotating work weeks of shifts, working days, working hours, and/or work activities.

A rotating pattern can be assigned to an agent or a team.

Calendar Module Controls

Toolbar Buttons
Select a view from the drop-down Views menu (on the left side of the toolbar): Calendar Items or
Time-Off Limits.

Icon Name Description

Filter Filter the display.

Options
Select whether to include these
columns in the table: Team,
Reason, Comments, Paid Hours,
Hire Date, Submitted.

Add Add an item (in this view, a
calendar item).

Edit Edit the selected calendar
item(s).

Prefer
Change the status of the
selected agent request(s) to
Preferred.
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Icon Name Description

Grant
Change the status of the
selected agent request(s) to
Granted.

Decline Decline the selected agent
request(s).

Delete Remove the selected calendar
item(s).

Update Schedule

Insert time-off items and
meeting-specific criteria to the
master schedule. (You must be a
supervisor with edit rights to the
master schedule.)

Help Display context-sensitive help.

Time Zone
Select the time zone for this instance of WFM by using the drop-down list that appears below the
toolbar buttons and above the calendars. The following choices appear in the list:

• User’s—Specifies the time zone of the current user, as configured for that user in WFM Web.
• If no time zone is configured for the current user, then WFM specifies the default time zone.
• If no time zone is configured, then this option is disabled.

• BU’s—Specifies the time zone of the BU that is selected on the Object pane.
• Site’s/BU’s—Specifies the time zone of the site that is selected on the Object pane.

• If more than one site is selected, then WFM specifies the time zone of the BU that is selected on the
Object pane.

• Local (default)—Specifies that data for every site will be returned in that site's local time zone.
• Configured time zones—Specifies the time zone that you choose from the remainder of items in this

list.
• Each remaining item is a configured time zone (and its relationship to GMT). For example, Pacific

Standard Time, which is 8 hours earlier than Greenwich Mean Time, is presented as PST (GMT-8.0).

Action Buttons
All toolbar buttons also appear in the Actions menu.

In addition, the toolbar buttons Edit, Prefer, Grant, Decline, Delete, Update Schedule, appear as
action buttons at the bottom of the Calendar window.
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Objects Pane
The Objects pane, on the left side of the WFM window, displays the database objects that you can
retrieve.

Agents Tree
The Agents tree displays agents in the Enterprise. The tree is hierarchical from top to bottom:
Enterprise, Business Units, Sites, Teams, and Agents.

Activities Tree
The Activities tree displays activities in the Enterprise. The tree is hierarchical from top to bottom:
Enterprise, Business Units, Multi-site Activities, Activity groups, Sites, and Activities.

Each item in the Object trees has a check box, which is either cleared or selected. Checking an item,
in one of the trees causes a reaction in the other tree: selecting an agent automatically selects the
corresponding activities, and selecting an activity automatically selects the corresponding
agent(s)/team(s)/site(s)/business unit.

Tip
You can simultaneously select items that are located below different sites within the
same business unit. Nothing is selected by default.

About the Calendar Items Module

The Calendar Items module displays agents' shifts, days off, time off, exceptions, and availabilities.
You can filter this display. You can add and edit most types of Calendar items from this display, and
you can edit exceptions, working hours, shifts, and availabilities.

Rotating pattern information is read-only. Rotating patterns appear with an RP: prefix. To change
rotating pattern settings, you must use the Rotating Patterns pane in the Policies module.

Calendar Module Security

The WFM Web defines security access permissions. Users may have full security access to this
module, or they may only be able to work with preferred Calendar items.

If you have limited access, then the Grant, Prefer, and Decline buttons are disabled. You can only
add, edit, or delete calendar items in Preferred status.
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Displaying the Calendar View
To view Calendar items:

1. If the Calendar Items module is not displayed, select Calendar from the Views menu.
2. In the three-month Calendar display, select the date(s) to view. Shift-click selects multiple dates.
3. Click Get data below the Object pane.

Calendar View Columns
Name Description

Date Displays the date of the Calendar item.

Site Displays the site to which the Agent in this row
belongs.

Team Displays the team to which the Agent in this row
belongs.

Agent
Displays the name of the agent who has the
Calendar item. Calendar items can be applied to
sites or teams, but they are displayed and edited
agent-by-agent.

Type Displays the type of the Calendar item (for
example, part-day exception).

Item Displays the name of the Calendar item (for
example, Team Meeting or Shift_1).

Start time

Displays the time the Calendar item begins. Some
full-day rotating pattern items (Day Off, Any Shift,
and Flexible Shift) do not have start or end times.
For this reason, the Start time and End time
columns are empty for these items.

End time

Displays the time the Calendar item ends. +1
indicates the day after the start time; +2 indicates
two days after the start time. Some full-day
rotating pattern items (Day Off, Any Shift, and
Flexible Shift) do not have start or end times. For
this reason, the Start time and End time columns
are empty for these items.

Status requested

Displays the status of a Calendar item for a period
that has not yet been included in a schedule, as set
by the user: Granted, Declined, or Preferred.

See Change Preference Status for an explanation of
the statuses. See Requested Status vs. Actual
Status for an explanation of the status that appears
in the status requested and Status actual columns.

Status actual

Displays the status of the Calendar item as
resolved by Workforce Manager: Granted,
Declined, Preferred, Scheduled, or Not
Scheduled.
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Name Description
See Change Preference Status for an explanation of
the statuses. See Requested Status vs. Actual
Status for an explanation of the status that appears
in the status requested and Status actual columns.

Reason
Explains why WFM has set an item's actual status
to Declined. You can display/hide this column by
using the Options dialog box.

Comments/Memo

Displays any comments or additional information
associated with the Calendar item, including ones
that might have been entered by agents when
requesting the item using WFM Web for Agents. You
can display/hide this column by using the Options
dialog box. This column is not sortable.

Paid Hours
Displays the number of paid hours for the calendar
item. You can display or hide this column by using
the Options dialog box.

How to Use the Calendar

• Select any single date by clicking it.
• Select multiple dates by holding down Ctrl while clicking them.
• Select a range of dates by holding down Shift while clicking them or by clicking the first day and then

dragging the mouse to the last day before releasing the mouse button.
• Select the same day of the week throughout a month by clicking that day's header. For example, to

display all Mondays, click Mon.
• Display a different year or month by clicking the year or month drop-down arrow.
• Go back a month by clicking <, or advance to the next month by clicking >.

To retrieve specific data:

1. Select a date or range of dates.
2. Select one or more sites, one or more teams, or one or more agents (within one Business Unit) from the

Objects tree.
3. Click Get data.

The table displays Calendar items for the selected site, teams, or agents. You can sort the display by
clicking the header for any column.

You can search the table for particular agents by using the Find Agent dialog box. To open it, select
the table to search and then select Find from the Edit menu or press [Ctrl] + F.

If the full text is too long to appear in a calendar cell, hover your mouse pointer over that cell. The full
text appears in a tooltip.
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Important
By default, if another user adds a new exception type while you have the Calendar open, the new exception
type is not selected in the Filter dialog box. To see agents who have an exception of the new type assigned,
open the Filter dialog box and select the check box for the new exception type.

Calendar Object Hierarchy

When you enter more than one kind of Calendar item for an agent at the same time, a hierarchy
determines which takes precedence. The higher priority item appears as Granted, and incompatible
lower-priority items appear as Declined.

The order of priority for exceptions and preferences is:

1. Granted full-day exceptions.
2. Granted days off.
3. Granted full-day time off.
4. Granted availability.
5. Granted shifts.
6. Granted paid (working) hours.
7. Granted part-day exceptions, granted part-day time off.
8. Rotating patterns.
9. Preferred items (including exceptions, paid hours, and time off with preferred status).

Consistency Checks
After you add an exception or preference in the Calendar, the Calendar performs consistency checks
to determine whether it is valid.

To be valid, an exception or preference must:

• Fall within the agent's Contract availability hours.
• Fall within activity hours of operation for activities that the agent can perform.
• Be consistent with the Contract paid hours requirements. Unpaid exceptions are added to the paid

hours if they do not violate the Contract availability hours.

In addition, if you are entering multiple part-day exceptions, part-day time off, or a mix of part-day
exceptions and time off, these:

• Cannot overlap.
• Must be compatible with a qualifying shift's settings, including meal parameters. (This limitation does
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not apply to full-day time off or days off.)

Preference and Exception Considerations

• You can enter multiple compliant Calendar items for the same day. For example, you can enter a shift
and a day off for the same day. Or you can enter an availability and a shift for the same day if the shift
fits into the availability parameter. WFM Web assigns the item that best fits the agent’s schedule.

• You can enter only one full-day exception of a single type per day. However, you can enter multiple part-
day exceptions of the same type. (WFM Web sets the status of incompatible Calendar items to
Declined.)

• You can add or edit preferences and exceptions even after a schedule has been created for the affected
days. However, if you make changes after building the schedule, you must rebuild the schedule to pick
up the changes.

Explanation of Calendar Colors

The Calendar uses two basic cell colors, light blue and grey, and two colors for selected items, yellow
and white.

• Gray indicates a non-selected cell for which data has not been requested. There may be data for that
day or there may not.

• Light blue indicates a non-selected cell for which there is data. That is, at some earlier point in this
session you selected this date and clicked Get data.

• Yellow indicates a selected cell for which there is data.
• White indicates a selected cell for which data has not been requested. There may be data for that day

or there may not.

The calendar uses two text colors, black and red.

• Black indicates that you have not yet requested data for a day, and that cells are not selected.
• Red replaces black when a cell is selected.
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Filter Dialog
Use the Filter dialog box to change which items appear in the Calendar Items module:

1. Select the Calendar tab.
2. Select Calendar Items from the Views menu.
3. Select one or more objects from the Objects pane. An object can be:

• In the Agents tree: a business unit, site, team, or agent
• in the Activities tree: business unit, a multi-site activity, site, activity.

4. Select a date or dates on the Calendar.
5. Click Get data.
6. Click the Filter icon on the Calendar Items module toolbar or select Filter from the Actions menu.

The Filter dialog box appears. It has three tabs:
• Calendar Items lists all exception types, preference types, time-off types, and rotating patterns.
• Status Requested lists all statuses that can appear in the Status Requested column of the

Calendar table.
• Status Actual lists all statuses that can appear in the Status Actual column of the Calendar table.

7. Clear the check boxes for any Calendar items or statuses that you want to hide from the Calendar
display. Or select the check boxes for any currently hidden items that you want to display.

8. Click OK to save your changes or Cancel to restore the existing selections.
The Calendar view is updated to match your selection.

Tip
By default, if another user adds a new exception type while you have Calendar open,
the new exception type is cleared in the Calendar Filter dialog box. To see agents
who have an exception of the new type assigned, open the Filter dialog box and
select the check box for the new exception type.
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Options Dialog
Use the Options dialog box to show or hide columns in the Calendar items table.

• Site—The site of the Agent who appears in that row.
• Team—The team of the Agent who appears in that row.
• Shared Transport—The shared transport to which the agent (displayed in that row) is joined.
• Reason—An explanation for why the actual status is different from the requested status.
• Comments/Memo—Any comments or memo made when this calendar item was entered or most

recently edited.
• Paid Hours—The number of paid hours for the calendar item.
• Hire Date—The date that the Agent began work for the company.
• Submitted—The date and time that the Calendar item was submitted (by either an Agent or a

Supervisor, depending on the type of Calendar item).

To use the Calendar Options dialog box:

1. Select the Calendar tab.
2. Select Calendar Items from the Views menu.
3. Select an object from each pane (Agents/Activities) of the Objects pane.
4. Select a date or dates on the Calendar, and click Get data.
5. Click the Options button on the toolbar or select Options from the Actions menu.

The Options dialog box opens and lists all available choices.
6. To display a column, select the check box next to its name. To hide it, clear the check box.
7. Click OK to save your settings or Cancel to discard them.

The main Calendar window re-appears, showing the new settings.
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Change Preference Status
Use the Calendar Items module to change the status of an agent's preference, exception, time off, or
working hours (shift and availability) request prior to publishing the schedule.

• Before you publish the schedule, the possible actual status settings are Preferred, Granted, and
Declined.

• After you publish the schedule, the possible actual status settings are Scheduled or Not Scheduled.

Preference Statuses

Before scheduling, a preference can be Granted, Declined, or Preferred. After a schedule is built
for the dates that include this preference, the status can be Scheduled (appears in the schedule) or
Not Scheduled (does not appear in the schedule).

• A Granted preference will appear in the schedule unless it is first removed or unless another
preference is added that out-ranks the first one. If this happens, the status of the lower-ranking
preference changes to Declined.

• A Declined preference will not appear in the schedule unless it was declined in favor of a higher-
ranking preference and the higher-ranking preference is later removed before the schedule is built. If
this happens the preference goes back to its original status, which can be Granted or Preferred.

• A Preferred preference may appear in the schedule if it complies with the scheduling constraints and
optimization settings that are configured for your site.

Two columns in the Calendar Items module show the preference status: Status Requested and
Status Actual. See below for an explanation of the two categories.

To change the status of a not-yet-scheduled item:

1. In the Calendar's item column, click the name of the item you want to change.
2. Click an action button for the item's new status: Prefer, Grant, or Decline.
3. Click OK.

The new status appears in the Status columns.

Important
The status can be different in each column, and the Actual Status can differ from the
status that you just assigned. This is because of the way in which the Requested and
Actual Status columns function, as explained below.
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Requested Status vs. Actual Status

Requested Status and Actual Status refer to the two ways in which each exception and preference is
saved.

• Requested Status is the preference's status as entered by the user. If more than one preference is
entered on a particular day, each item is saved to the database with the status that it has when
entered.

• Actual Status is the status as resolved by WFM. WFM evaluates all current exceptions and preferences
based on their positions in the calendar object hierarchy. If an agent has multiple preferences for a day,
the Actual Status indicates how WFM has resolved them.

For example, if an agent prefers a full-day time off, that preference is saved in the database as
Preferred. If the agent is then assigned (Granted) a meeting exception for that day, the exception
overrides the preference. WFM evaluates the current set of exceptions and preferences, and notes
the time-off preference as Declined. However, the database maintains the preference status as
Preferred because, until a schedule is generated, the exception can be removed. In this case the
preference would again take effect and the preference Actual Status would change to Preferred.

Tip
Rotating pattern assignments are Granted by default, so they do not need a separate
status saved to the database.
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Add Calendar Items Wizard
Using this wizard, you can add availability, time off, exceptions, days off, shifts, and working hours.
(This wizard is available to supervisors with the appropriate security access.)

To use the wizard:

1. Select the Calendar pane.
2. Select Calendar Items from the Views menu.
3. Select an object from the Objects pane:

• From the Agents tree: a business unit, site, team, or agent
• From the Activities tree: a business unit, multi-site activity, site, or activity

4. Select a date or dates from the Calendar.
5. Click Get data.
6. Click the Add Calendar Item icon on the toolbar or select Add Calendar Item from the Actions menu.

For instructions on filling in each wizard screen, see:

• Choose Activities.
• Choose Agents.
• Choose Calendar Items.

Depending upon the choices that you make on the first two screens, you proceed to one of these
screens:

• Add or Edit Start/End Time
• Add or Edit Exceptions
• Add or Edit Shifts
• Add or Edit Time Off
• Comments

The last three screens can also appear when you edit Calendar items.
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Choose Activities
By default, only the activities and multi-site activities that were selected in the (lower) Objects pane
when you chose the Add Calendar Items button are displayed, and all are selected.

1. Change the selections, if necessary.
2. Click Next to continue.

Tip
If you select objects from more than one site, the Choose Calendar Item page
displays a limited list of calendar item types: Availability, Day Off, Time Off,
Exception, and Working Hours.

See also: Add (or Edit) Calendar Items Wizard.
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Choose Agents
By default, the business unit, sites, teams, and agents that were selected in the Objects pane when
you clicked the Add Calendar Items button are displayed and selected.

1. Change the selections, if necessary.
2. Click Next to continue.

Tip
If you select objects from more than one site, the Choose Calendar Item page
displays a limited list of calendar item types: Availability, Day Off, Time Off,
Exceptions, and Working Hours.

See also: Add (or Edit) Calendar Items Wizard.
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Choose Calendar Item
To choose a Calendar Item:

1. Select an item from the Calendar Item Type group of radio buttons.
If you selected agents from more than one site on a previous page, then the list of calendar item types
is limited to: Availability, Day Off, Time Off, Exceptions, and Working Hours.

Depending on your selection here, one of several different screens will appear next. If you select:
• Availability, the next screen is: Choose Start/End Time.
• Day Off, the next screen is: Comments.
• Exception, the next screen is: Choose Exception.
• Shift, the next screen is: Choose Shift.
• Time Off, the next screen is: Choose Time Off.
• Working Hours, the next screen is: Choose Start/End Time.

2. Select an item from the Requested State group of radio buttons: Preferred, Granted, or Declined.

Tip
If you selected Working Hours or Exception, the required state is preset to Granted. If you grant a Day
Off, Scheduler grants the day off regardless of the impact on service levels.

3. Click Next.

Tip
If WFM Web cannot assign some selections, it opens a window that lists the agents, days, and reasons
involved.

See also: Add (or Edit) Calendar Items Wizard.
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Add or Edit Start/End Time
To set the start and end time for availability or working hours:

1. Enter the Start Time.
You can either type the start time directly into the field, or use the up or down arrow to select the time.

Tip
For Working Hours, your selections must fall within agent availability. For Working Hours with a status of
Granted, your selections override a shift with Preferred status and set absolute working hours.

2. Enter the End Time, using the same options.
The Availability or Working Hours duration cannot exceed 36 hours.

3. Select Next Day if the End Time is on the day after the Start Time.

Important
If you select Next Day, the End Time must be before 12:00 noon.

4. Enter any comments you want to make regarding this Calendar item.
5. Click Finish.
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Add or Edit Comments
If you selected Day Off in the Choose Calendar Items screen, the Comments screen appears
when you click Next.

• Type your comments, if you have any, into the Comments text box, and then click Finish.

The Calendar reappears, displaying the new or edited day off.
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Add or Edit Exceptions
If you select Exception on the Choose Calendar Item screen and click Next, the Choose
Exception screen appears.

1. Select an exception type from the Exceptions list. This list shows all of the exceptions that are
available for the selected agent(s).
• Yes, under Paid, indicates that the exception counts as paid time.
• No, under Full Day, indicates a part-day exception.
• Yes, under Convertible, indicates an exception that can be converted to a Day Off.

2. Set the Start Time and End Time, if necessary.

Tip
For part-day and full-day exceptions, you can either type times directly into these text boxes, or use the up
and down arrows to select the times. Click the down and up arrows to control hours. To change minutes,
highlight and type over existing minutes. For example, you could enter a one-minute exception from 10:01 to
10:02.

3. If you select a full-day paid exception, you can select the Specify Paid Hours check box to enter a
duration other than the default number of hours in a work day.
If you check Specify Paid Hours, the Paid Hours text box becomes editable.

Tip
If you enter a start/end time but do not enter a value for Paid Hours, then Paid Hours will equal End Time
minus Start Time (a value known as Standard Hours or Duration).

4. If you want to enter comments or additional information about this exception, type it into the Memos
text box.

Tip
To learn more about memos in Calendar items, see Exception Memos in the Workforce Management
Administrator's Guide.

5. Click Finish.
The Calendar reappears, displaying the new or edited exception.

If WFM Web cannot assign some selections, it opens a window that lists the agents, days, and
reasons involved.
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Multiple Part-Day Exceptions

You can add multiple part-day exceptions for a single day. Certain consistency checks apply:

• The exceptions must be compatible with all shift settings, including meal settings. If they are not, all of
the exceptions are declined.

• Part-day exceptions cannot overlap each other or any part-day time-off item.
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Add or Edit Shifts
If you select Shift on the Choose Calendar Item screen, the Choose Shift screen appears when
you click Next.

1. Select a shift name from the Shifts list.
This list shows all shifts that are available for the selected agents and days.

2. Change the Start Time, if necessary.
The drop-down list shows all possible start times for the selected shift, based on the shift's
configuration.

3. Enter or change the End Time, if necessary.
You can either type a time directly into the text box, or use the up or down arrow to select the time. The
field accepts only times that match the selected shift's configured end times.

4. Select Next Day if the End Time is on the day after the Start Time.
5. If you want to enter a comment, type it into the Comments text box.
6. Click Finish.

The Calendar reappears, displaying the new or edited shift.
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Add or Edit Time-Off Items
Use this dialog to add new time-off items or edit existing ones.

If you select Time Off on the Add Calendar Item screen, then the Choose Time Off screen
appears when you click Next.

1. Select a time-off type from the Choose Time Off list.
This list shows all of the time-off types that are configured for the selected site.

2. Select the Show all check box to display all time-off types. Clear this check box to display only the
time-off types that are applicable to the selected agent.

Important
If you select a time-off type that is not associated with a selected agent, then WFM assigns the time off but
does not enforce the time-off balance rules ...except for limits. If the time-off type counts toward time-off
limits, then WFM takes this time-off item into account when calculating limits.

3. Optional: select the Full Day check box if the time-off preference is for a full day off.
4. Optional: Adjust the Start time and End time for this time-off item, if the default values are not

correct.
5. Select the check box Specify Start/End to enable the Start Time and End Time fields, then click

inside each field to modify the default values for hours, minutes, and AM/PM.
6. Select Next Day to the right of the End Time text box if duration of the time off ends on the day after

it begins.
7. Optional: Specify a nonstandard length of your full-day time-off request.
8. Select the Specify Paid Hours check box to enable the Paid Hours field, then click inside and enter or

select a value to specify the exact number of hours in a full day for this particular time-off item. The
Specify Paid Hours check box is enabled only if you selected a paid time-off type in the Choose
Time Off list.

Important
If you are adjusting part-day time-off preferences, remember that all part-day time-off preferences must
comply with all settings for at least one qualifying shift, including meal parameters. You might not need to
adjust this value manually. If you selected a single agent, then the default is the number of paid hours/
minutes configured for the agent's time-off rule, for the time-off type being inserted. If you selected multiple
agents, the default value is 0 (zero).

9. Optional: Select the Wait-list check box to specify that the request stays in a Preferred status, if a
time-off request is denied because the time-off limits have already been reached.
The request could eventually be granted by a Supervisor, if an opening becomes available, although
this is not guaranteed.
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10. Optional: Enter a comment inside the Comments text box.
11. Click Finish.

The Calendar reappears, displaying the new or edited time-off item.

Important
If you are entering multiple part-day time-off items, these cannot overlap each other
or any part-day exception.

Calendar Calendar Items

Workforce Management Web for Supervisors Help 313



Update Schedule Options
Use this functionality to update the selected schedule with time-off calendar items which have the
status Granted, Not Scheduled, Recalled, or Scheduled.

1. Create a Granted Time Off item in the calendar. (Use the Add Calendar Item Wizard.) Its status will be
Granted, Not Scheduled
OR
Select a Time Off item that has Recalled, Scheduled status.

2. Click the Update Schedule icon ( ) in the toolbar, or the Update Schedule button at the bottom
right of the WFM window, or select Update Schedule from the Actions menu.

3. Correct any errors. If there are no errors, then the Update Schedule Options dialog box appears,
offering three check boxes which are all selected by default:
• Insert only if there are no errors or warnings
• Show warnings
• Auto commit inserted items

4. Clear any check boxes that you do not wish WFM to obey, and click OK.
The selected Time Off item is published to the Master Schedule.

Important
WFM displays a warning under these circumstances:

• When you insert a full-day Time Off—either from the Calendar or directly into the
Master Schedule—on a day in the Master Schedule that is already a Day Off.

• When you insert a full-day or part-day Time Off—either from the Calendar or directly
into the Master Schedule—on a day in the Master Schedule that already has an
Exception.
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Edit Calendar Items
To edit a Calendar item:

1. Select an item in the Calendar view's table.
You can edit only one Calendar item at a time.

2. Double-click the selection or click Edit.
The appropriate Edit screen displays. See the table below for a list of the Calendar-item types and the
edit screen that opens for each.

Calendar Item Edit Screen
Availability Add or Edit Start/End Time
Day Off Comments
Exception Add or Edit Exception
Shift Add or Edit Shift
Time Off Add or Edit Time Off
Working Hours Add or Edit Start/End Time

Important
If the calendar item's Exception Type or Time-Off Type has been disassociated from the current site, use
the dialog box that appears to select a new Exception Type or Time-Off Type—one that is still associated
with the current site. You can keep the disassociated Exception Type or Time-Off Type, or you can edit the
calendar item, but not both. Alternatively, you can re-associate the missing Exception Type or Time-Off
Type and then do both.

3. Change the Calendar item's settings as necessary.

Tip
The available settings depend on the type of item that you are editing.

4. Click OK to save your selections, or Cancel to exit without saving them.
The Calendar reappears, displaying any changes that you have saved.

If WFM Web cannot assign some selections, it opens a window that lists the agents, days, and
reasons involved.
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Review Batch Requests Dialog
The Review Batch Requests dialog opens when a supervisor edits (prefers, grants, declines,
deletes, or publishes) time-off requests that fall within a bidding period. WFM batches all agent time-
off requests within that period and marks them as one request. If a supervisor selects only one or two
items in the batch, the dialog opens with a message, such as, You are about to Grant selected items
that are part of a batch request(s), including Time Offs below. Selected action can be applied only to
all listed items at once. Do you want to proceed?

The dialog lists all of the selected time-off items, including the dates, the name of the agent (who is
requesting the time off), the start/end times, and the name of the time-off item. The supervisor can
select Proceed or Cancel.

Tip
You can change the way WFM processes time-off batch requests. See the WFM Server
Application configuration option [Calendar Service] BatchRequest in the Workforce
Management Options Reference.
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Review Calendar Messages Dialog
In the Calendar, if you grant a time-off item that exceeds the time-off limits, Workforce Management
(WFM) returns a warning. WFM presents all warnings as a table in the Review Calendar Messages
dialog box. The columns of the table include the check box column, Team, Agent, Date, and
Message.

If you have Prefer/Grant/Decline and Edit Time-Off Limits permissions within the Calendar
module, you can override the warnings.

1. Select the check box in the leftmost column of each warning that you want to override, or click the
Select All Warnings button.

2. Click the Proceed for Selected button to ignore the warnings and continue.

Tip
Although you can override warnings, you cannot override error messages; their check
boxes are disabled.
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Time-Off Limits
Under the Calendar module, use Time-Off Limits to control the number of agents allowed to take
time off so that you do not adversely affect the ability to meet service objectives. You can configure
time-off limits for the agents who perform a specific activity, all of the agents on a team, or all of the
agents in a site. You can also:

• Set limits for the maximum number or maximum percentage of agents who can be on time off at any
one time.

• Set different time-off limits for each timestep during the day, enabling more agents to take time off
during non-peak work periods.

• See the actual numbers percentage of agents who are scheduled for time off and compare your limits
with the actual values.

• Set minimum time-off limits for each timestep. See Setting Minimum Time-Off Limits for details.

Tip
The time-off limits apply to all time-off types that have the Counts toward time-off
limits parameter selected. You cannot set separate time-off limits for each time-off
type.
If the Counts toward time-off limits check box is cleared for a time-off type, no time-off limits apply to
that time-off type.

After the Master Schedule is published, the Calendar service still allows Agents to
enter time-off items. However, these items are automatically resolved as Not
Scheduled, with the Reason Item is Not Scheduled because different schedule has
already been built for this day. Also, these items are not checked against the time-off
limits, because they are not scheduled. This is normal behavior, because planning
(the Calendar) usually is done before scheduling.

Setting Time-Off Limits

Use this procedure to modify the Time-Off Limits table manually, or use the Set Time-Off Limits
Wizard to set these limits. Also, see Factors Impacting Agent Availability for more information about
the impact of setting time-off limits.

1. Select the Calendar tab.
2. Select Time-Off Limits from the Views menu.
3. Select a site, multi-site activity, team, or activity in the Objects tree. You cannot select a business unit

or an individual agent.
4. Select the period to be displayed in the table: Year (default), Month, or Week. The granularity

associated with the selected period appears in the read-only Granularity text box.
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5. Enter or select a date by using the date-range selector at the top of the window.
If you select a day other than the first day of the selected period, the display defaults to the first day.
For example, if you select Month and then select August 12, the display shows August 1-31.

6. To remove the column from the table, clear the check box beside the name of that column.
The table displays the current data for the object and dates that you selected. See The Time-Off Limits
Table for an explanation of the data presented in each column.

Tip
The set of columns repeats seven times in each row. Each repeat contains the values for one day of the week.

7. For each period (represented by a row), enter a value directly into the Max. Agents or Max. % cell, or
both. You can copy and paste values from one cell to another using the standard Windows Copy and
Paste functions. If you enter values into both columns, WFM applies the lower limit.
• No Time-Off Limits—Leave the cell blank.
• No Time Off Allowed—Enter 0.
• Some Time Off Allowed—Enter the number or percentage of agents who are allowed to be on

time off.

Cells with gray backgrounds are not editable. They either fall outside the selected period or contain
values that WFM generates automatically.

Tip
If you have chosen Week as the period, the minimum row appears. It displays the lowest limit entered into
any cell. See Setting Minimum Time-Off Limits for how to use this feature.

8. If you want to set different values for a specific date range, click the Set Values button, which is
located on the Action toolbar, or select Set Value from the Actions menu. See The Set Values Dialog
Box for instructions on using this feature.

9. To keep your changes, click the Save button, which is located on the Action toolbar, or select Save
from the Actions menu.

Important
If you reduce the time-off limit for a specific period or if you assign agents to another team after a time-off
period is scheduled, the limits for a particular period may be exceeded. In this case, agents retain any
previously planned or scheduled time off, even if the limits are exceeded.
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The Time-Off Limits Table

The Time-Off Limits table displays rows for each week (if the period is Year or Month) or for each
15-minute timestep (if the period is Week).

If you selected the Week period, the table also displays a Minimum row, which displays the lowest
value set in any timestep during the day.

The columns in this table are:

• Week/Timestep—If the selected period is Year or Month, this column contains the dates of each week
in the period. If the period is Week, the column lists each 15-minute timestep in a day.

• Max. Agents—Enter an integer value for the greatest number of agents in the selected site, team, or
activity who are allowed to have time off during the selected period. This must be a whole number, so
fractions are rounded down.

• Max. %—Enter a percentage value for the greatest number of agents in the selected site, team, or
activity who are allowed to have time off during the selected period.

• Max. % Agents—WFM automatically calculates, to the nearest whole number, the maximum number
of agents who can have time off based on the percentage value that you entered. This column is read-
only.

• Actual Agents—The actual number of agents in the selected site, team, or activity who are scheduled
for time off during the selected period. If a schedule is unavailable for that day, agents with granted or
preferred Time Off also count as Actual agents with Time Off. This column is read-only.

• Actual %—The actual percentage of agents in the selected site, team, or activity who are scheduled for
time off during the selected period. This column is read-only.

Setting Minimum Time-Off Limits

To set minimum limits:

1. Select the Week period.
2. Enter time-off limits in the cells for each timestep.

By default, the minimum row shows the lowest limit entered into any cell of a column.
3. To set the minimum for multiple timesteps at once, enter a value directly into one of the cells in the

Minimum row.
This new minimum value is automatically applied to all cells that contain a lower time-off limit. Cells
with higher time-off limits are unaffected.
The minimum value set in the Week view is displayed as the Daily value in the Year and Month
views.

Tip
Although you cannot view the Minimum row if you select the Month or Year view,
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entering a time-off limit that is lower than the current minimum into either of these
views automatically changes the minimum value shown in the Week view.
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Set Values Dialog
Use the Set Values dialog box to adjust the maximum number or percentage of agents who can
have time off at any one time during a specified period.

• Use this feature to adjust the maximum for periods, such as holiday seasons, when you might want to
have a different maximum value than during the rest of the year.

To use the Set Values dialog box:

1. Select the Calendar tab.
2. Select Time-Off Limits from the Views menu.
3. Select a site, multi-site activity, team, or activity in the Objects tree. You cannot select a business unit

or an individual agent.
4. Select Set Values from the Actions menu, to display the Set Values dialog box.
5. Enter a start date and end date for the period.
6. Enter a value for one or both of the following fields:

• Max Agent—The maximum number of agents who can have time off during the specified period.
You must enter a positive whole number.

• Max %—The maximum percentage of agents.
• No Time-Off Limits—Leave the text box blank.
• No Time Off Allowed—Enter 0.
• Some Time Off Allowed—Enter the number or percentage of agents who are allowed to be on

time off.

7. Click OK, or click Cancel to discard your changes.

The Set Values dialog box closes, and the new values appear on the Time-Off Limits table.
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Set Time-Off Limits Wizard Overview
The Set Time-Off Limits (STOL) wizard enables you to use WFM's best estimates of availability,
possible days off, and other relevant information to set time-off limits for agents.

1. Select Set Limits from the Action menu, or click Set Limits ( ) in the toolbar.
The wizard opens to the first page, Choose Dates.
There are potentially two more screens in the wizard

• Specify Weekly Pattern of Possible Days Off
• Specify Date Range Values of Possible Days Off

You can finish the wizard from any page, unless you select the Estimate possible days off
check box on the Choose Dates page.

2. At each page, select Next (or Finish) after completing your data entry.
After you click Finish, WFM calculates the new limits and modifies the Time-Off Limits table,
according to your choices.

Factors Impacting Agent Availability

When setting time-off limits, be aware that WFM calculates the number of available agents for every
timestep according to:

• The start and end of contract availability—The agent is not available outside of the availability interval.
• The earliest start and latest end time of shifts assigned to the contract—This might further limit the

agent's availability interval.
• The activity open hours—Even if the target is not an activity, the agent's availability is limited by the

earliest open and the latest close time of the activities, for which the agent is qualified.
• The Rotating Pattern—Strict rotating day-offs, explicitly specified start and end times, and earliest and

latest times of the rotating shift.
• Optionally, granted day-offs and full-day exceptions.
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STOL Wizard: Choose Dates
Use the Choose Dates page in the Set Time-Off Limits Wizard (STOL Wizard) to specify the range of
dates for which you will specify Time Off limits and other values.

Start Date spin box
Enter or select the date that begins the time period
for time-off limits that are to be estimated and
applied.

End Date spin box
Enter or select the date that ends the time period
for time-off limits that are to be estimated and
applied.

Time-off Limit % field
Enter a number to specify the maximum
percentage of agents who can be on time off at any
one time.

Reduce available agents by ____% field
Enter a number to specify the percentage of agents
who are to be excluded from the wizard's
calculations.

Consider granted Calendar items check box Select to specify that granted items for agents are
taken into account by the wizard.

Estimate possible days off check box
Select to specify that the weekly pattern will be
used in estimates. If this check box is cleared (the
default setting), then this is the final wizard page.

Buttons

• Click Next to continue (if the Estimate possible days off check box is selected) or Finish to end the
wizard (if the Estimate possible days off check box is cleared).

• Click Cancel to exit the wizard and make no changes.
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STOL Wizard: Specify Weekly Pattern
Use the table on the Specify Weekly Pattern of Possible Days Off page in the Set Time-Off Limits
Wizard (STOL Wizard) to design a weekly pattern of possible days off for agents, by specifying the
percentage of possible days off for agents for each weekday.

Tip
This page is part of the wizard only if you selected the Estimate possible days off
check box on the previous (Choose Dates) page.

The table has seven rows, one for each weekday (Sunday through Saturday) row, and these columns:

% of days off

Enter a number to specify the percentage of agents
who will receive a day off on each weekday. This is
the only editable column in the table, and it can be
empty to specify that no value was specified. The
value in this column cannot exceed the value in the
Max % column.

Agents with days off
This column displays the calculated number of
agents, in decimal format, using the entered
percentage in the % of days off column.

Max % The maximum percentage of agents who can
receive a day off.

Total agents The calculated total number of available agents,
averaged for each weekday in the period.

Standard %

The standard percentage of total agents who can
receive a day off, estimated according to the
minimum/maximum number of days off per week
and the minimum/maximum number of weekend
days off.

Buttons

• Click Next to continue or Finish to end the wizard.
• Click Cancel to abandon the wizard and make no changes.
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STOL Wizard: Specify Date Range Values
Use the Specify Date Range Values of Possible Days Off page in the Set Time-Off Limits Wizard
(STOL Wizard) to specify the maximum number of agents who can have a day off for each day of the
specified time period.

The table on this page has a single row for every day in the time period (a week, a month, or a year)
that is specified in the Time Off Limits table.

Tip
This page is part of the wizard only if you selected the Estimate possible days off
check box on the previous (Choose Dates) page.

If you specified a weekly pattern on the previous page, then the value for each date is calculated by
multiplying the percentage for the appropriate weekday from the weekly pattern by the total number
of agents, and then dividing by 100.

If you did not specify a weekly pattern, or if the value in the pattern for a corresponding weekday is
empty, then the value for each date is equal to the value for the same date in the Standard column.

The columns in the table are the following:

Date Displays one row for each day in the date range (a
week, a month, or a year)

Weekday Displays the day of the week for the date in this
row.

Agents with days off

Enter the number of agents who could receive a
day off on each date. This column contains the only
editable values in the table. All other values are
calculated or fixed. The value in each cell can be as
low as 0 and as large as the corresponding Max
value.

Max Displays the calculated maximum number of
agents who can receive a day off.

Total agents Displays the calculated total number of agents who
are available for each date.

Standard

Displays the calculated ”standard” number of
agents who can receive a day off, estimated
according to the minimum/maximum number of
days off per week and the minimum/maximum
number of weekend days off.

Calendar Time-Off Limits

Workforce Management Web for Supervisors Help 326



Buttons

• Click Finish to end the wizard.
• Click Cancel to abandon the wizard and make no changes.
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Forecasts

Tip
Starting in this release, WFM has a new interface for the Forecast module. If you have
landed on this page by accident and are using the new Supervisors interface, see the
"Forecasts" page in the Workforce Management Supervisor Help, which describes the
new Forecast module.

Use the Forecast module to create and edit forecast scenarios, and to publish the best scenario to
the Master Forecast. See descriptions of the buttons shown in the toolbar image below.

You can use the forecast views to:

• Create forecast scenarios.
• View your scenarios and the Master Forecast.
• Evaluate volume and staffing estimates for your scenarios and the Master Forecast.
• Publish forecast scenarios to, and extract them from, the Master Forecast.
• Add or remove activities from a forecast scenario.
• Create, modify, and apply forecast templates.

About Forecasting

A forecast is a prediction of activity workloads for one or more sites, and consists of:

• Predicted customer-interaction volumes, which include information for phone calls, chat, email,
outbound calling, back-office work, and so on.

• Predicted average handling time (AHT).
• Staffing (workforce) requirements based on service objectives.

Workforce Management uses these predictions to build optimal schedules for real agents, or for a
generic staff of profiles based on those agents. For links to major forecast help topics, see Creating
and Working with Forecasts, below.
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Creating and Working with Forecasts

1. The first step in creating a new forecast is to create a forecast scenario for one or more activities using
the New Forecast Wizard. The Wizard General Parameters screen gives the option of creating a scenario
with no forecast numbers (to be supplied later) or basing the scenario on a existing forecast.

2. If you created a scenario with no forecast numbers, open the Scenario Volumes View and use the
Volume Build Wizard to build interaction volume and AHT forecasts for each activity. You can use
various methods to build volume, including entering values, using historical data or templates.

3. Next, open the Scenario Staffing View and build a staffing forecast for each activity.
4. After you create and evaluate your scenarios, publish the best scenario to the Workforce Management

database. This scenario then becomes the Master Forecast. WFM Web builds schedules based on the
data in the Master Forecast.

Watch the Videos
Watch the 4-video series about creating, populating, and publishing forecasts, starting with Video 1.

Using the Forecast Scenarios View

The Scenarios View enables you to open and work with existing scenarios. It also enables you to
create, edit, or delete forecast scenarios, and to publish them to the Master Forecast.

• In the Modules tree, click Forecast > Scenarios to activate the Scenarios view.

Using Other Scenario Views

When you open a forecast scenario, the following views appear on a scenario-specific drop-down
menu in the toolbar: Volumes, Staffing, Overheads, and Graphs.

• Click a view to open it.

These view options appear on the Views toolbar's Scenarios drop-down list.

Opening additional scenarios adds their view options to these lists. This enables you to switch among
views for several open scenarios.

• To remove a scenario's views from the displayed lists, close that scenario.

Using the Master Forecast Views

If you have access rights to the Master Forecast, then the Modules tree's Forecast branch always
displays three Master Forecast views (regardless of your scenario selections): Master Forecast
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Volumes View, Master Forecast Staffing View, and Master Forecast Graphs View.

• Click these views to open them.

Using Historical Data in Forecasts

In most cases, forecasts are based on historical data.

• If historical data for interaction volumes and average handling time (AHT) has been imported, you can
create both interaction-volume forecasts and AHT forecasts simultaneously.

• If historical data exists for interaction volume but not for AHT, first create the interaction-volume
forecast using any of the forecasting methods. Then create the AHT forecast using a template.

• If historical data exists for AHT but not for interaction volume, first create the interaction-volume
forecast using templates. Then create the AHT forecast using any of the forecasting methods.

Actions Toolbar

You can use the following buttons on the toolbar (the same commands also appear on the Actions
menu):

Icon Name Description

Publish
Opens the Publish Forecast
Wizard, where you can publish a
forecast directly to the master
schedule.

Add activity
Opens the Add Activity window,
where you can add activities to
this forecast scenario.

Remove activity
Opens the Remove Activity
window, where you can remove
activities from this forecast
scenario.

Save Saves your changes to this
forecast scenario.

Save as Template Save this forecast scenario as a
template.

Build
Opens the Volumes Build Wizard,
which builds volume data for the
selected activity.

Comments
Opens the Comments window,
where you can enter comments
for each day of the forecast.
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Icon Name Description

Open / Close Opens the highlighted scenario,
closes the current scenario.

Use multi-site activities

Controls whether WFM Web's
calculation of aggregated
information includes multi-site
activities. You can select this
button only if you first select a
multi-site activity, business unit,
or enterprise in the Objects tree.

Required Staffing
Opens the Required Staffing
dialog box. Use it to modify
required staffing data in the grid.

Split
Opens the Volume Split Wizard,
which splits interaction volumes
from a multi-site activity to site-
specific activities.

Budgeting

Opens the Budgeting Information
dialog box, where you to specify
the start and end dates of the
target range, paid hours and
wage that are to be used by the
Staffing Forecast Wizard.
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New Forecast Wizard

Tip
Starting in this release, WFM has a new interface for the Forecast module. If you have
landed on this page by accident and are using the new Supervisors interface, see the
"Scenarios" page in the Workforce Management Supervisor Help, which describes the
new Forecast module.

Use the New Forecast Wizard (NFW) to create a new forecast scenario. Defining a forecast scenario
involves naming the forecast, defining a forecast date range, adding comments (optional), and
selecting the activities the forecast will cover. You also have the option of basing the scenario on an
existing forecast or building the numbers later.

This is Video 1 in a 4-video series. When you are ready to build volumes for the scenario, watch Video
2.

Link to video
To use the New Forecast Wizard:

1. Select the Forecast tab.
2. Select Scenarios from the Views menu.

3. Click New on the Forecast Scenarios view toolbar.
The first of the New Forecast Wizard's screens, General Parameters, opens.

4. Fill in the General Parameters screen and then click Next. The Select Activity screen opens.
5. Select one or more activities and then click Finish.

After you create a scenario, you can build interaction volume, AHT, and staffing forecasts, add
comments, and publish the scenario. For details, see Forecast Scenarios Overview.

Terminology Review

To better understand WFM forecasting and scheduling views and dialog boxes, it is helpful to review
certain WFM terminology.
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Activities
Activities are work items that are tracked and managed using Genesys Workforce Management. On a
general level, example activities are answering inbound calls, responding to email, completing after-
call work, performing scheduled callbacks, and participating in chat sessions. When you create
forecasts and schedules, these activities are typically associated with a specific product, such as
inbound calls for product A, inbound calls for product B, and so on. In the Configuration Utility,
activities are associated with skills. You define separate activities for each site or business unit.

Sites
Sites can be equivalent to switches, which are originally defined in Genesys Administrator and then
imported into WFM via WFM Server. See "Creating Switch Objects" in Genesys Adminsitrator
Extension Help.

You can also create sites that are unrelated to a switch. This is appropriate when switches do not
correlate with your company's organization. For example, a single location could be divided into
multiple entities to reflect divisions along business unit lines.

Sites can use activity sets, which provide a means to combine activities into groups for multi-skilled
scheduling. During that time:

• Agents can only work on the activities defined for the activity set.
• Scheduler cannot schedule meals at times that would interrupt the activity set.

Business units cannot use activity sets.

Business Units
A business unit consists of a set of sites that may be grouped together because the agents at the
sites perform the same activity, or for ease of management.

Multi-Site Activities
Multi-site activities combine activities at some or all of the sites in a business unit, as well as
independent sites, for tracking purposes.
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NFW: General Parameters
Use the General Parameters screen in the New Forecast Wizard (NFW) to define your new forecast's
name, dates, and other basic information.

1. In the Name text box, enter a name for the forecast scenario.
2. If you want to base this scenario on one that already exists, select the existing scenario (or the Master

Forecast) from the Based on drop-down list. Otherwise keep None to create a scenario with no
forecast numbers. You can then use the Volumes Build Wizard to populate the forecast.

Basing your new scenario on an existing scenario is a convenient way to build forecasts with frequently
used settings. The wizard takes the dates activities from the source scenario, and applies them to the
new scenario. You can then change these parameters.

3. In the Start date and End date text boxes, enter the scenario's start and end dates.
You can type directly into each text box, use the up or down arrow to modify the displayed date, or click
the button at right to display a calendar.

Tip
The scenario's date range cannot be more than two years.

4. If you want to fill the new scenario with data from the source (Based on) scenario, select the Copy
Data check box.
If you did not select a value from the Based on drop-down list, this check box is disabled.

5. If you want this scenario to be available to other WFM users, select Shared.
6. If you want to enter comments about this scenario, use the Comments text box.
7. Click Next to proceed to the next screen.
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NFW: Select Activity
Use the Select Activity screen in the New Forecast Wizard (NFW) to finish defining your new forecast.

1. Expand the applicable sites or business units.
2. Select the single-site or multi-site activities that you want to be included in this forecast. These are

activities previously defined in the WFM Web.
You can expand business units to display their sites and multi-site activities, and you can expand sites
to display their activities. You can select any number of activities.

By default, all activities are selected when this screen opens. Clear the check boxes for any activities
that you do not want to include in this forecast scenario.

If you selected a value from the General Parameters screen's Based on drop-down list, the activities
that were in the source scenario are selected in the Activities list. You can select any additional
activities, or clear selected ones, to customize this forecast scenario.

Tip
You can add activities to a forecast after it has been created.

3. Click Finish to generate the new forecast.
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Forecast Scenarios

Tip
Starting in this release, WFM has a new interface for the Forecast module. If you have
landed on this page by accident and are using the new Supervisors interface, see the
"Scenarios" page in the Workforce Management Supervisor Help, which describes the
new Forecast module.

After you create a forecast scenario using the New Forecast Wizard, use the Forecast Scenarios View
to open the forecast scenario.

1. Select Forecast from the Home menu on the toolbar.
2. Select Scenarios from the Forecast menu.

3. Select a scenario from the list in the data pane, and open it by clicking Open ( ) in the toolbar or by
double-clicking the scenario itself.

4. Select the open scenario's name from the Forecast menu on the toolbar.
All open scenarios appear on the menu.

5. Select one of these views from the <selected scenario name> menu:
• Volumes—Enables you to build, view, and edit a scenario's interaction volume and average handle

time.
• Staffing—Enables you to build, view, and edit a scenario's calculated and required staffing.
• Graphs—Displays your choice of statistics for this forecast, using line charts.
• Overheads—Displays the weekly shrinkage forecast for a selectable period.

6. In the Objects tree, select an activity, multi-site activity, site, business unit or enterprise.

Working with Forecast Scenarios

From the Forecast Scenarios view you can:

• View interaction volume and AHT forecasts in the Scenario Volumes view or create interaction volume
and/or AHT forecasts using the Forecast Volumes Build Wizard.

• View staffing forecasts in the Scenario Staffing view or create staffing forecasts using the Staffing Build
Wizard.

• View the forecast scenario in graph format.
• Add comments to the forecast scenario.
• Publish forecast scenarios to the Master Forecast or extract from the Master Forecast into a forecast
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scenario.

Some restrictions apply when viewing or deleting Forecast scenarios:

• Users must have access to at least one Activity or Multi-Site Activity in the Forecast scenario to see it.
• Users must have access to all Activities and Multi-Site Activities in the Forecast scenario to delete it.

For more information about these restrictions, see the [ConfigService] MSARestrictAccess
configuration option description in the Workforce Management Options Reference. The settings in
this option determine the level of access to Multi-Site Activities in Forecast Scenarios, as described
above.
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Forecast Scenarios View
Use the Scenarios view to create, open and work with existing forecast scenarios. See the toolbar
image below and jump to the button descriptions.

This view also enables you to delete forecast scenarios, publish data from a scenario to the Master
Forecast, and extract data from the Master Forecast to a scenario.

Displaying the Scenarios View

1. Select Forecast from the Home menu on the toolbar.
2. Select Scenarios from the Forecast menu.

Selecting Objects
When the Scenarios view is active, the Objects tree displays existing forecast scenarios in a
hierarchical list. The All Scenarios node expands to display the following options:

My Scenarios Displays scenarios that you have created.
Shared Scenarios Displays shared scenarios created by other users.

Other Scenarios
Displays unshared scenarios created by other
users. Visible only if you have the appropriate
access rights. See the Forecast role privileges

You can select All Scenarios or a lower-level option. Your selection retrieves matching scenarios and
inserts them into the Scenarios table.

Reading the Scenarios Table

The Scenarios table appears at the upper right. Its rows display scenarios that match your selection
in the Objects tree. The columns (sortable by clicking the header) display the following information
for each scenario:

Name The scenario's name.

Start date, End date The start and end dates for the forecast in this
scenario.

Owner The name of the user who created the scenario.
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Shared A check mark indicates a shared scenario; an open
box indicates one that is not shared.

Comments Remarks entered by a user who created or edited
the scenario.

• Click a row in the Scenarios table to populate the Scenario Properties pane with the scenario's details.

Editing a Scenario

To edit a scenario:

• Click its row in the Scenarios table and then click Open on the Actions toolbar or select Open from
the Actions menu.

• As an alternative, double-click a scenario.

The controls described below are available if you own, or have access rights to, the scenario.

Toolbar: Managing Scenarios

You can use the following buttons on the toolbar (the same options appear in the Actions menu):

Icon Name Description

New Opens the New Forecast Wizard.

Create Based On...
Opens the New Forecast Wizard,
with the currently selected
forecast as the default value in
the Based On field.

Open Opens the selected scenario from
the Scenarios table.

Close
Closes the selected scenario (and
prompts you to save unsaved
data).

Publish

Opens the Publish Forecast
Wizard for transferring forecast
information between the selected
scenario and the Master
Forecast.

Delete Deletes the selected scenario.

Mark as Shared,
Mark as Not Shared

Changes the sharing status of
the selected scenario.
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Icon Name Description

Sort

Opens the Sorting dialog box,
which allows sorting by name,
owner, sharing, time of creation,
time of last modification,
scenario start date, or scenario
end date. You can sort in
ascending or descending order.

Scenario Properties—Data Tab

In the Scenario Properties pane at the lower right, click the Data tab to display the following
controls:

Name Enables you to edit the scenario's name.
Start date, End date Displays the scenario's start and end dates.
Owner Displays the name of the scenario's creator.

Created, Modified Displays the scenario's original creation date and
last modification date.

Shared A check mark indicates a shared scenario; an open
box indicates one that is not shared.

Comments Enables you to enter or edit comments about the
scenario.

Save Click this button to save your changes to the
scenario's name and/or comments.

Cancel Click this button to cancel changes, restoring the
scenario's previous name and/or comments.

Scenario Properties—Statuses Tab

Click the Statuses tab (in the Scenario Properties pane at the lower right) to display a table with
the following information:

Activity Lists each activity in the scenario, preceded by its
site or Business Unit.

Volumes A check mark indicates that interaction volume was
built for this activity.

AHT A check mark indicates that average handle time
was built for this activity.

Calc. staff A check mark indicates that calculated staffing was
built for this activity.

Req. staff A check mark indicates that required staffing was
built for this activity.
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Scenario Volumes View
Use the Volumes view to build or edit the selected forecast scenario's interaction volumes and
average handle times. See the toolbar buttons image here and their descriptions below.

This view provides standard date-selection controls and a grid that shows statistics for days or
timesteps.

The following sections cover:

• Displaying the Volumes view.
• Setting the data display properties and date range.
• Reading the Data.
• Modifying and managing scenario data.

Displaying the Volumes View

To display the Volumes view:

1. Select Forecast from the Home menu on the toolbar.
2. Select Scenarios from the Forecast menu on the toolbar.

3. Select a scenario from the list in the data pane, and open it by clicking the Open icon ( ) or by
double-clicking it.

4. Select the open scenario's name from the Forecast menu on the toolbar.
All open scenarios appear on the menu.

5. Select Volumes from the <selected scenario name> menu on the toolbar.
6. In the Objects tree, select an activity, multi-site activity, site, business unit or enterprise.

The view displays a graph above a table, each containing the same statistics, and controls that set
the data display properties for the graph and table.

If you do not see any forecast data, you may need to adjust the Period, Granularity, or Date
controls at the top of the window to reflect those used for the forecast.

Tip
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The grid displays open hours for multi-site activities that you select in the object tree
exactly as it displays them for site activities.

Setting the Data Display Properties and Date Range

Use these controls to customize the data display in the graph and table:

• Period drop-down list—Change the time range for the graph and the grid by selecting Year, Month, or
Week.

Important
Planning Period also appears as a value in the Period list if the selected site has a configured planning
period.

If you select Week, you can further adjust each row's time range by selecting 15, 30, or 60 (minutes)
from the Granularity drop-down list.

• Show Statistics drop-down list—Specify what data is displayed in the graph and table by selecting
from these choices: Interaction Volume, AHT, Interaction Volume and AHT.

• Show Columns check boxes—Show (or hide) data columns in the table by selecting or clearing the
Volume, Volume %, and AHT check boxes.

• Use standard date-selection controls (in the upper right portion of the window) to jump to a different
week within the Scenario Forecast's date range.

Reading the Data

The table provides columns that display the following statistics:

Week/Time Step
Identifies the range of dates or timesteps on this
row. (The column's label and contents depend on
the date range and granularity that you selected
above.)

[Days or Dates]

If you select the Month date range, each group of
columns shows statistics for one full day.

If you select the Week date range, each group of
columns indicates one day, the top row shows daily
totals, and each lower row shows statistics for one
timestep on that date.
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(Timestep durations depend on the granularity that
you selected above.)

IV
Shows the interaction volume forecasted for each
day or timestep. You can edit these cells' contents,
replacing the displayed values with whole
numbers.

IV% Shows this row's percentage of the day's total
interaction volume.

AHT Shows the average handling time.

Weekly Totals
If you select the Month date range, these columns
show weekly totals, or averages, for the IV, IV%,
and AHT statistics.

Tip
You can copy and paste data between the grid and a spreadsheet. Before doing so,
clear the Volume % check box so the IV% column is hidden.

To edit the Weekly Totals:
If you selected the period Year or Month, you can click inside the Weekly Totals cell and edit the
value there. Daily values in the same row will automatically adjust their values so that the new
Weekly Total is redistributed according to the original distribution of volume for each day of the
week. This is useful if you have a week in which you believe the volume will be increased, but you
expect the volume to arrive at about the same rate as in your original forecast, day-over-day.

Modifying and Managing Scenario Data

You can use the following buttons on the toolbar (the same commands also appear on the Actions
menu):

Icon Name Description

Publish
Opens the Publish Forecast
Wizard, where you can publish a
forecast scenario directly to the
master forecast.

Add activity
Opens the Add Activity window,
where you can add activities to
this forecast scenario.

Remove activity
Opens the Remove Activity
window, where you can remove
activities from this forecast
scenario.
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Icon Name Description

Save Saves your changes to this
forecast scenario.

Build
Opens the Volumes Build Wizard,
which builds volume data for the
selected activity.

Comments
Opens the Comments window,
where you can enter comments
for each day of the forecast.

Close
Closes a selected open scenario,
prompting you to save any
unsaved changes.

Use multi-site activities

Controls whether WFM Web's
calculation of aggregated
information includes multi-site
activities. You can select this
button only if you first select a
multi-site activity, business unit,
or enterprise in the Objects tree.

If you set this button to On, WFM
retains your last selection—in the
current view and for all other
views that contain multi-site
activities—preventing you from
having to click it every time you
want to display data for the
selected multi-site activity.

Split
Opens the Volume Split Wizard,
which splits interaction volumes
from a multi-site activity to site-
specific activities.

Adjust

Opens a dialog box that enables
you to adjust the volume,
average handling time (AHT), or
both for the Scenario Forecast
Volumes view.
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Volumes Build Wizard
Use the Volumes Build Wizard (VBW) to build volume data for one or more selected activities, using
parameters that you specify.

• Do this if you selected None in the New Forecast Wizard General Parameters window or if you wish
to overwrite an existing Volumes scenario. If the correct Volumes data already exists in the Scenario
Volumes view, you do not need to use this wizard.

Important
Depending on the build method you specify, you might need to import historical data
or create interaction volume, average handling time, or overlap templates before
using this wizard.

This is Video 2 in a 4-video series. You can watch Video 1 here or, when you are ready to staff the
scenario, watch Video 3.

Link to video
To build volume data:

1. Select a Volumes scenario.
2. On the Scenario Volumes View toolbar, click the Build button.

The Volumes Build Wizard's first screen, Select Activities, opens.
3. Complete the Select Activities screen and then click Next.
4. Complete the Select Data Build Method screen and then click Next.
5. The screens/buttons that appear next depend on the selected build method and whether you want to

use an overlap template. If you select:
• Use Value, supply interaction volume and/or average handling time values and click Finish.
• Expert Average Engine, Universal Modeling Engine, or Copy Historical Data, complete the

Select Historical Data screen.
• Template Based, or Use Overlap Templates on the Select Historical Data screen, complete

one or more screens for selecting templates.
• Expert Average Engine or Universal Modeling Engine, complete the Select Events screen.

6. Click Finish in the last screen.
WFM builds the volumes forecast and the Scenario Volumes View reappears, showing your
results.
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Forecast Volume Build Wizard Screens

The Volume Build Wizard screens are described in these topics:

• Select Activities
• Select Data Build Method
• Select Historical Data
• Select Templates
• Select Events
• Select Events Distribution
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VBW: Select Activities
This is the first screen in the Forecast Volume Build Wizard (VBW). The activities you previously
selected for the scenario in the New Forecast Wizard (NFW) Select Activity screen appear for
selection.

Use the Select Activity screen as follows:

1. Expand business units (if any) to display their sites and multi-site activities, and expand sites to display
their activities.

2. Select all of the activities that you want to be included in this volumes forecast.

You can select multiple activities to build volume forecasts in batch mode when configuration
information for each activity is identical. If you want to use different historical data or build methods for
certain activities, build the volumes for those activities separately.

If you selected an existing forecast instead of <None> from the General Parameters screen's Based
on drop-down list, the activities that were in the source scenario are selected in the Activities list. You
can select any additional activities, or clear selected ones, to customize this forecast scenario.

Tip
You can add activities to a forecast after it has been created.

3. Click Next to continue.
The next wizard screen, Select Data Build Method, opens.
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VBW: Select Data Build Method
Use the Select Data Build Method screen in the Volume Build Wizard (VWB) to define how you
want to build your volumes data.

1. Select the statistic(s) you want from the Forecast drop-down list:
• Interaction Volume and AHT
• Interaction Volume
• AHT

2. Under Target Dates, select the date range for the forecast data. The date range cannot be outside the
scenario date range.

3. Select the forecast build Method: Template Based, Expert Average Engine, Universal Modeling Engine,
Copy Historical Data, or Use Value (see definitions below).

4. Click Next to open the wizard's next screen.

The following sections explain the Method options that are available:

Template Based

The default selection. For detailed information about templates, and instructions on how to create
them, see Forecast Templates List View. With template-based forecasting, you can build a forecast
using preconfigured interaction volume and/or average handling time (AHT) templates.

You also can have the template-based forecasting engine apply percentage growth rate to historical
data.

Template-based forecasting is best used by contact centers with very stable interaction patterns or
for activities that can be manually forecast, such as back-office work, media interactions, or outbound
campaigns.

If you select Template Based, after you click Next, the screen that opens depends on the Forecast
type selected at the top of the Select Data Build Method screen.

• Interaction Volume and AHT—The Load Interaction Volume Forecast Templates screen opens.
• Interaction Volume—The Load Interaction Volume Forecast Templates screen opens.
• AHT—The Load Average Handling Time Forecast Template screen opens.
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Expert Average Engine

This method uses the statistical analysis of historical data to produce day-of-week, weekly, and (if
sufficient historical data exists) yearly trend patterns.

The Expert Average Engine requires at least one full week of historical data. For high-quality day-
of-week and weekly results, Genesys recommends that you use a minimum of six weeks' worth of
data.

The Expert Average Engine applies events in a linear fashion, and this linear perspective smooths
out the impact of events across the forecast. Therefore, this engine is best suited to contact centers
with fairly stable interaction patterns.

If you select Expert Average Engine, after you click Next, the Select Historical Data screen opens.
If a selected activity does not have historical data, an error message appears and the Select
Historical Data screen does not open.

Universal Modeling Engine

This method uses a complex algorithm to identify trends and patterns in historical data, which it then
uses to create a forecast.

The Universal Modeling Engine requires one year's worth, or more, of historical data.

The Universal Modeling Engine is configured so that, in its analysis of historical data, it disregards
days that contain special events, if those events don’t occur during the forecast period. This
configuration eliminates misleading noise from the forecasts. However, if a special event does occur
during the forecast period, the Universal Modeling Engine uses the historical data to calculate the
impact of the event, and applies it to the baseline forecast. The Universal Modeling Engine is best
suited to sites with a large quantity of high-quality historical data.

If you select Universal Modeling Engine, after you click Next, the Select Historical Data screen
opens. If a selected activity does not have historical data, an error message appears and the Select
Historical Data screen does not open.

Copy Historical Data

Appropriate selection if you have some historical data, but not enough to use the Expert Average or
Universal Modeling engines. You can combine the historical data with overlap templates, which fill
in gaps in the historical data.

If you select Copy Historical Data, after you click Next, the Select Historical Data screen opens. If a
selected activity does not have historical data, an error message appears and the Select Historical
Data screen does not open.
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Use Value

Appropriate selection if your site activity load is very regular. Applies a specific interaction volume or
AHT to each time interval in the scenario.

If the Forecast type is Interaction Volume and AHT, selecting Use Value enables both the IV and
AHT fields.

If the Forecast type is Interaction Volume, only the IV field is enabled.

If the Forecast type is AHT, only the AHT field is enabled.

1. Enter the appropriate value(s) to be used for each cell in the forecast. For IV, enter number of
interactions per timestep (example: number of interactions per 15-minute interval). For AHT, enter the
number of seconds that represents average handling time.

2. Click Finish.

WFM builds the volumes forecast and the Scenario Volumes View reappears, showing your results.
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VBW: Select Historical Data
Use the Select Historical Data screen in the Volumes Build Wizard (VBW) to define the historical
data time range with the option of using overlap templates. If you selected the Copy Historical
Data method, this screen includes a Growth Rate field.

The Wizard brings up this screen if the Build Method is Expert Average Engine, Universal
Modeling Engine, or Copy Historical Data.

1. Select the Start date of the historical data that you want to use.
• Select the same day of the week as the forecast scenario's first day. For example, if the target start

date is a Tuesday, the historical data Start Date must also be a Tuesday.

2. Select the End date of the historical data.

Tip
If you selected Copy Historical Data on the Select Data Build Method screen, this field is disabled. If the
End date field is enabled:

• You can select a date range as short as one day, or as long as the forecast scenario
for which you are building data.

• The same historical start and end dates are used for all activities selected in the
Select Activities screen.

Tip
Remember that redistributing events does not impact historical data, only the
forecast.

3. If the Build Method is Expert Average Engine or Universal Modeling Engine, you can add
additional historical periods to the list, to specify the exact historical data that you wish to be used (and
ignore any data that you wish not to be used).
• Click Add to add a new row in the Use Historical Data area.
• Highlight a row in the Use Historical Data area and click Delete to remove that row.

Important
Multiple rows cannot overlap each other.

4. If you selected the Copy Historical Data method on the previous screen, enter a number in the
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Growth Rate field. This optional field allows you to increase or decrease the historical data by a
specified percent. The value cannot be less than -100%.

5. The next series of screens depends on the Build Method and whether you clicked the Use Overlap
Template check box.
• If the Build Method is Copy Historical Data and you are not using an overlap template, click

Finish.
• If the Build Method is Copy Historical Data and you are using an overlap template, click Next to

bring up a screen for selecting templates.
• If the Build Method is Expert Average Engine or Universal Modeling Engine, the next screen

depends on whether you want to use an overlap template.
• If you did not check the Use Overlap Templates box, click Next. The Select Events screen

opens.
• If you checked the Use Overlap Templates box, click Next to bring up a screen for loading

templates.
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VBW: Select Templates
Use the screens described below to incorporate templates into your Forecast Volumes scenario. The
Volumes Build Wizard (VBW) gives the option of using the following template types:

• Interaction volume templates
• Average handling time templates
• Interaction volume overlap templates
• Average handling time overlap templates

The following sections explain the various forecast template screens:

Interaction Volume Templates

The Load Interaction Volume Forecast Templates screen opens if you selected the following in
the Select Data Build Method screen:

Forecast = Interaction Volume and AHT or Interaction Volume.

Methods = Template Based.

1. Select a template from the Templates list on the left.
2. Select Start and End dates for the template.
3. Check days of the week boxes to indicate when the template should be applied.
4. Click the >>> button.

If you change your mind, click the <<< button.
5. If the Forecast type was Interaction Volume and AHT, click Next.

The Load Average Handling Time Forecast Template screen opens and you must complete that
screen.

Tip
If the Forecast type was Interaction Volume, the Finish button becomes enabled.

6. Click Finish.
WFM builds the volumes forecast and the Scenario Volumes View reappears, showing your results.

An error message appears if WFM Web cannot complete the calculation (for example, if historical
data contains too few timesteps to cover the scenario's activity hours). This applies to all the
template types discussed in this topic.
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Average Handling Time (AHT) Templates

The Load Average Handling Time Forecast Templates screen opens if you selected the following
in the Select Data Build Method screen:

Forecast = AHT or Interaction Volume and AHT. (If Interaction Volume and AHT is selected, the
window
appears after clicking Next in the Load Interaction Volume Forecast Templates screen shown
above.)

Methods = Template Based.

Except for the title and content of the templates list, the screen appears identical to the Load
Interaction Volume Forecast Templates screen.

1. Select a template from the Templates list on the left.
2. Select Start and End dates for the template.
3. Check days of the week boxes to indicate when the template should be applied.
4. Click the >>> button.

If you change your mind, click the <<< button.
5. Click Finish.

WFM builds the volumes forecast and the Scenario Volumes View reappears, showing your results.

Interaction Volume Overlap Templates

Assume there is some bad data in the historical data. One way to compensate for this is to build an
overlap template.

The Load Interaction Volume Forecast Overlap Templates screen opens if you selected Use
Overlap Template in the Historical Data screen and previously selected the following in the Select
Data Build Method screen:

Forecast = Interaction Volume and AHT or Interaction Volume.

Methods = Copy Historical Data, Expert Average Engine, or Universal Modeling Engine.

Except for the title, content of the templates list, and day of the week check boxes, the screen
appears identical to the Load Interaction Volume Forecast Templates screen.

1. Select an overlap template from the Templates list on the left.
2. Select Start and End dates for the overlap template.
3. Click the >>> button.

If you change your mind, click the <<< button.
4. If the Forecast type was Interaction Volume and AHT, click Next.

The Load Average Handling Time Forecast Overlap Template screen opens (described below) and
you must complete that screen.
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Tip
If the Forecast type was Interaction Volume, the Finish button becomes enabled.

5. Click Finish.
WFM builds the volumes forecast and the Scenario Volumes View reappears, showing your results.

Average Handling Time Forecast Overlap Templates

The Load Average Handling Time Forecast Overlap Templates screen opens if you selected
Use Overlap Template in the Historical Data screen and previously selected the following in the
Select Data Build Method screen:

Forecast = AHT or Interaction Volume and AHT. (If Interaction Volume and AHT is selected, the
screen
appears after clicking Next in the Load Interaction Volume Overlap Forecast Templates screen.)

Methods = Copy Historical Data, Expert Average Engine, or Universal Modeling Engine.

Except for the title, content of the templates list, and day of the week check boxes, the screen
appears identical to the Load Interaction Volume Forecast Templates screen.

1. Select an overlap template from the Templates list on the left.
2. Select Start and End dates for the overlap template.
3. Check days of the week boxes to indicate when the overlap template should be applied.
4. Click Finish.

WFM builds the volumes forecast and the Scenario Volumes View reappears, showing your results.
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VBW: Select Events
Use the Select Events screen in the Volumes Build Wizard (VBW) to factor events into a Forecast
Volumes scenario.

Prerequisite: You must create events in the Forecast > Overlays module, and assign them to
activities there, before you can add those events to a forecast scenario

• An overlay is anything that can be expected to affect the daily interaction volume of the enterprise and,
therefore, staff and schedule requirements.

• An event is a specific instance when an overlay is in effect.

To add events:

1. Select the Enabled check box for the events that you want to include.
Alternatively, you can select the Use All Applicable check box to use all applicable events, whether
the Enabled check box is selected or cleared.

2. If you are using the Universal Modeling Engine, this is all you need to configure. Click Finish.
3. If you are using the Expert Average Engine you can also, optionally:

a. Enter a Spread Over value for each event.
This determines the period that the event affects.

b. Click Days or Hours.
This determines whether the Spread Over value is interpreted as days or hours.

c. Adjust the Initial Impact and/or Ending Impact value, if appropriate.
(The default values are based on the event's configuration. If the event is configured to disregard
historical data, you cannot adjust these values here. You must change the configuration using the
Overlays module.)

d. Click Distribution to view and optionally change the distribution method of the selected overlay.
e. Check the Use All Applicable check box if the forecast build algorithm should use all events or

overlays applicable to the selected activities that fall into the scenario/historical data date range.
When checked, disables the fields and controls that appear above.

f. Click Finish.

WFM Web calculates the volumes and displays them in the Volumes view. An error message appears
if WFM Web cannot complete the calculation (for example, if the historical data contains too few
timesteps to cover the scenario's activity hours).

Important
Redistributing events does not impact historical data, only the forecast.
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VBW: Select Events Distribution
Use the Select Events Distribution screen in the Volumes Build Wizard (VBW) to view and optionally
change the distribution method of the selected overlay in a Forecast Volumes scenario.

Tip
The functionality on this page duplicates the Distribution tab of the Overlays page, if
Always Use Entered Distribution was selected on the Properties tab of that page.

Graph—Displays the same information as the grid below it displays, but in graphical form.

Grid—Displays and allows you to edit the overlay's distribution in the following columns:

• Daily or Hourly Impact—Each row displays an increment during which the overlay will be in effect.
The actual increment (Day or Hour) is configured in Spread.

• Distribution Value—Displays the distribution value of each increment. The default value in each cell is
0.
• If the selected overlay is of the type impacting, then you can enter values from -100 to 9999 into

the grid.
• If the selected overlay is of the type redistributing, then you can enter values from 0 to 100 into the

grid.

Important
If the total of all values in the grid does not equal 100, you will see a warning and will not be able to save
your changes to the overlay.
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Volumes Split Wizard
Use the Volumes Split Wizard to split a forecast scenario for a multi-site activity:

1. Select a Scenario Volumes view that uses multi-site activities.
2. On the Forecast Scenario Volumes view toolbar, click the Split button.
3. In the Split Range Date screen, enter a start and end date for the range and click Next.
4. In the Select Multi-site Activities screen, select the check boxes next to the multi-site activities that

you want to split.

Tip
You can select several multi-site activities within the same Business Unit.

5. To include the average handling time forecasts in the split, select Use AHT Forecast and click Next.
If you select Use AHT Forecast but some of the selected activities do not have an AHT forecast, the
result for each of these activities will be 0 for the timestep(s) where AHT=0.

Warning
If you do not select Use AHT Forecast, the multi-site activity AHT is assigned to the local activities. This
overwrites the local activity AHT. If there is no multi-site activity AHT, local activity AHT is simply deleted.

6. If any selected multi-site activity has the type deferred, the wizard will contain additional page: Specify
Service Time. If this is not true, go to step 9.

7. In the Specify Service Time screen, specify the service time for each deferred multi-site activity. This
screen displays a grid with the following columns, with one activity per row:
• Activity—The name of the multi-site activity.
• Service Time Type—A drop-down menu with the following values:

• Hours, interrupted time (default selection)—When an interaction is waiting, while the
activity is closed, the time is not being counted in the service level calculations.

• Hours, non-interrupted time—When an interaction is waiting, while the activity is closed, the
time is still being counted in the service level calculations.

• Business days—The number of business days, including the current day during which the
interaction arrived. If the service level = 100% within one business day, then all interactions
must be serviced on the same day they have arrived, according to open hours.

• Service Time—The nature of this control depends upon your selection in the Service Time Type
column.
• If the granularity is Hours, then this cell in the row is a spin box where you must specify hours,

minutes and seconds; and this value must be greater than 0.
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• If the granularity is Business days, then this cell in the row is a field where you must enter or
select an integer that is greater than 0.

Important
If you switch the granularity from Hours to Business days, WFM Web resets the time value to 0.

8. Click Next.
9. In the Select Activities within Multi-site Activities screen:

a. Select the local (target) activities into which you want to split the multi-site activities. (You can
select several target activities.)

Important
• If you selected Use AHT Forecast in step 5, then you cannot select target

activities that do not have at least one timestep with at least one AHT value
greater than 0.

• If you select Use All Activities, when WFM splits data for interaction volumes,
AHT, and agent availabilities for the selected activities in the scenario, it takes
into account the values for all activities in the specified site, whether selected or
not.

Activities that are not selected are not split; WFM Web simply considers them
when determining the proportions that are split to each selected activity. This
option does not affect the split result if there are no shared multi-skill agents who
work on both selected and unselected activities.

10. To ensure WFM considers the existing Calendar items when splitting the interaction volume among
activities, select the Consider Granted Calendar Items check box.

• Click Next.
• In the Manual Split Parameters screen, you can enter a percentage in the Split % column for each of the

child activities of multi-site activities or click in the Template column to use a template.
If both Split % and Template are set for any activity, the template values are used for all non empty time
steps. For empty time steps in Template, the specified Split % value is used. To select a template:

a. Select the row in which you want to use a template, click the button.
b. After the Use Template dialog opens, select a template from the list and click OK.

Important
If you click OK without selecting a template, the template field will be empty.
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• After the Manual Split Parameters screen is populated as desired, click Finish.
WFM Web displays a Progress dialog box while it splits the activities.

• Optionally, click Cancel if you want to cancel the split. After splitting the activities, WFM Web returns to the
Volumes view.

Splitting Volumes by Percentage

You can specify a percentage to allocate the Volumes from a Multi-Site Activity to each Child (Site)
Activity. An interval can be the entire forecast scenario that includes a week, day, and timestep.

At the interval level, when the percentage is specified that is greater than the timestep, WFM
propagates the percentage to the remaining timesteps. If a percentage is not specified for certain
Child Activities, WFM splits the remaining volumes to those activities, by splitting them by availability.
You can specify a different percentage value for each interval.
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Adjust Volumes Dialog Box
Use the Adjust Volume dialog box to adjust the volume, the average handling time (AHT), or both
for a selected Scenario Volumes view.

1. Click Adjust on the Forecast Volumes scenario toolbar, to display the Adjust Volumes dialog
box.

2. Click the Target down arrow and select one of the following:
• Interaction Volume
• AHT (average handling time)
• Interaction Volume and AHT

3. Decide how (and by how much) to adjust values in the Forecast Volumes grid:
• Select the Adjust By (%) radio button and enter into the field a number to be the percentage by

which to adjust existing values that fall within the date range that is specified by Start Time and
End Time below.
Valid values range from -99% to 999%.
OR

• Select the Set Total radio button and enter into the field a number to be the total by which to
adjust existing values that fall within the date range that is specified by Start Time and End Time
below.

4. Specify the date range to adjust values in the Forecast Volumes grid:
a. In the Start Time field, enter or select a start date and timestep.

Range: any date equal to or later than the date in the upper right of the Forecast Volumes grid;
00-23 hours; 00, 15, 30, or 45 minutes.

b. In the field End Time, enter or select an end date and timestep.
Range: any date later than the Start Time date; 00-23 hours; 00, 15, 30, or 45 minutes.

5. Click OK.
WFM adjusts the forecast and the view reappears, showing your results.
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Scenario Staffing View
Use the Staffing view to edit the selected forecast scenario's calculated and required staffing. See
the toolbar buttons here and their descriptions below.

This view provides standard date-selection controls and a grid that shows staffing levels for days or
timesteps.

Displaying the Staffing View

To display the Staffing view:

1. Select Forecast from the Home menu on the toolbar.
2. Select Scenarios from the Forecast menu on the toolbar.
3. Select a scenario from the list in the data pane, and open it.
4. Select the open scenario's name from the Forecast menu on the toolbar.

Tip
All open scenarios appear on the menu.

5. Select Staffing from the <selected scenario name> menu on the toolbar.
6. In the Objects tree, select an activity, multi-site activity, site, business unit, or enterprise.

The view displays a graph above a table, each containing the same statistics, and controls that set
the data display properties for the graph and table.

If you do not see any data, you may need to adjust the Period, Granularity, or Date controls at the
top of the window to reflect those used for the forecast.

Setting the Data Display Properties and Date Range

Use these controls to customize the data display in the graph and table:

• Period drop-down list—Change the time range for the graph and the grid by selecting Year, Month, or
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Week.

Important
Planning Period also appears as a value in the Period list if the selected site has a configured planning
period.

If you select Week, you can further adjust each row's time range by selecting 15, 30, or 60 (minutes)
from the Granularity drop-down list.

• Show Statistics drop-down list—Specify what data is displayed in the graph and table by selecting
from these choices: Calculated Staffing, Required Staffing, Calculated and Required Staffing.

• Show Columns check boxes—Show (or hide) data columns in the table by selecting or clearing the
Calculated and Required check boxes.

• Use standard date-selection controls (in the upper right portion of the window) to jump to a different
week within the Scenario Forecast's date range.

Reading the Data

The table provides columns that display the following statistics:

Week/Time Step
Identifies the range of dates or timesteps on this
row. (The column's label and contents depend on
the date range and granularity that you selected
above.)

[Days or Dates]

If you select the Month date range, each group of
columns shows statistics for one full day.

If you select the Week date range, each group of
columns indicates one day. The top row shows daily
totals measured in Full-Time Equivalents
(defined below). Each lower row shows statistics for
one timestep on that date.

(Timestep durations depend on the granularity that
you selected above.)

Full Time Equivalent (FTE) is a standard
measurement used within contact centers that
allows the analyst to do an "apples-to-apples"
comparison of the number of agents required to
handle the expected interaction volume, across
activities that may have different open hours,
different planned overheads, and so on.

WFM provides the number of FTEs for informational
purposes only. It does not affect the Intra-Day
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staffing requirements that WFM produces, which is
the basis for building schedules.

Calc

Shows the calculated number of agents for each
day (measured in Full Time Equivalents) or for each
timestep (measured in Single Skill Equivalents).
You can edit these cells' contents. See Req column
for more information on Calculated and Required
Staffing.

Req

Shows the required number of agents for each day
(measured in Full Time Equivalents) or for each
timestep (measured in Single Skill Equivalents).
You can edit these cells' contents.

WFM populates Calculated Staffing when you
build staffing through the Staffing Build Wizard.
Required Staffing is a user-defined data series. It
can be populated based on data from the
Calculated Staffing data series, or you can copy
and paste data from an external spreadsheet into
these columns. When building schedules, the Use
Required option lets you base a schedule on
Calculated or Required Staffing. This allows you
to take the staffing forecast that WFM provides and
adjust it in a user-defined way.

[Weekly Totals]
If you select the Week date range, the columns at
right show weekly totals for the displayed
statistics.

Tip
You can copy and paste data between the grid and a spreadsheet.

Modifying and Managing Scenario Data

You can use the following buttons on the Actions toolbar (these commands also appear on the
Actions menu):

Icon Name Description

Publish
Opens the Publish Forecast
Wizard, where you can publish a
forecast directly to the master
schedule.

Add activity
Opens the Add Activity window,
where you can add activities to
this forecast scenario.
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Icon Name Description

Remove activity
Opens the Remove Activity
window, where you can remove
activities from this forecast
scenario.

Save Saves your changes to this
forecast scenario.

Save as template
Opens the Save as Template
dialog box, where you can save
data from this scenario as a
forecast template.

Build
Opens the Staffing Build Wizard,
which builds staffing data for the
selected activity.

Comments
Opens the Comments window,
where you can enter comments
for each day of the forecast.

Close
Closes this scenario, prompting
you to save any unsaved
changes.

Use multi-site activities

Controls whether WFM Web's
calculation of aggregated
information includes multi-site
activities. You can select this
button only if you first select a
multi-site activity, business
unit, or enterprise in the
Objects tree.

If you set this button to On,
WFM retains your last

selection—in the current view
and for all other views that
contain multi-site
activities—preventing you from
having to click it every time you
want to display data for the
selected multi-site activity.

Required staffing
Opens the Required Staffing
Wizard, where you can set the
forecast's required number of
agents.

Split
Opens the Staffing Split Wizard,
which splits staffing from a multi-
site activity Staffing forecast
scenario.

Budgeting

Opens the Budgeting Information
dialog box, where you can
specify the start and end dates of
the target range, paid hours and
wage that are to be used for FTE
calculations.
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Required Staffing Wizard
Use the Required Staffing Wizard to define required staffing values in a forecast scenario's Staffing
view.

Tip
Before selecting the template option in this dialog box, create templates as needed.

To set required staffing by using this wizard:

1. Open a Forecast scenario, and its staffing view.

2. Select Required Staffing from the Action menu or click the toolbar icon ( ).
The Required Staffing Wizard starts.

3. Select one of the following radio buttons at the Select Data Source screen:
• Load Calculated Staffing—Apply calculated staffing to required staffing with no changes.

a. Click Finish.
The wizard ends here, if you make this choice.

• Load Calculated Staffing, adjusted by—Enter (into the adjacent field) a percentage by which to
adjust calculated staffing, before applying it to required staffing. Valid values are from -99 to 999.
a. Click Finish.

The wizard ends here, if you make this choice.

• Load Calculated staffing, adjusted using overheads—Use the overheads will be selected in the
Select Overheads screen to adjust calculated staffing, before applying it to required staffing.
a. Click Next to display the Select Overheads screen.
b. Select one or more items from the list.

WFM applies the overheads that you select to calculated staffing and saved as required staffing.
c. Click Finish.

The wizard ends here, if you made this choice.

• Use Templates—Apply the staffing templates that will be selected in the Select Templates screen
to required staffing.
a. Click Next to display the Select Templates screen.
b. Select one or more templates from the Templates list on the left side, and click the >> button

to move your selections to the Applied Templates list on the right side.
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Tip
You can modify a template's characteristics after selecting it on the left side and before moving it to
the right side.

c. Optional: Select each template on the left side and adjust its configuration using the controls
below the list: Start Date, End Date, and day of the week check boxes.

d. When you have made all necessary adjustments, click Finish.
The wizard ends here, if you made this choice.

About Required Staffing

Required—staffing data is user-defined staffing requirements for a forecast scenario.

• If you have compiled calculated-staffing values, you have the option of setting required staffing to the
same values as calculated staffing.

• Forecasts can contain both calculated and required data. You can build schedules by using either set of
data.

• Required staffing can be composed of a combination of template values, manually entered amounts,
and calculated staffing values.
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Staffing Budgeting Information
Use the Budgeting Information screen to enter the paid hours and wage you want to use in the
forecast.

1. For each field, enter or select the value to apply to the forecast.
2. Click OK.

Target Date Range:

• Start date
• End date

Budgeting Information:

• Paid Hours a Day
• Hourly Wage
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Staffing Build Wizard
Use the Staffing Build Wizard to build staffing data for a selected single-site activity or multi-site
activity, based on parameters that you provide. For information about building staffing forecasts for
multiple activities, see Staffing Build Wizard for Multiple Activities.

Important
Before using this wizard to build a staffing forecast, take these required actions:

• Build interaction volumes and AHT for activities.
• If necessary, create templates.
• Build a volume forecast for multi-site activity for both IV and AHT.
• Be aware that even if there is IV and AHT data for all child activities, this wizard does not

build a staffing forecast for the parent multi-site activity.

This is Video 3 in a 4-video series. You can watch Video 2 here or, when you are ready to publish the
forecast scenario, watch Video 4.

Link to video
To build staffing data:

1. On the Scenario Staffing View toolbar, click the Build button.
The Staffing Build Wizard's first screen, Provide Target Date, opens.

2. Fill in the Provide Target Date screen and then click Next.
3. Fill in the Provide Target Options screen and then click Next.
4. The screen that appears next depends on what kind of activity you are staffing. If you are staffing:

• An Immediate activity, and you select the Use Service Level Objectives check box, the Specify
Service Level Objectives screen opens.
If you do not select Use Service Level Objectives, the Staffing Requirements screen
opens.

• A Deferred activity, the Multimedia Service Level Objectives screen opens.
• A Fixed-Staff activity, the Staffing Requirements screen opens.

5. Fill in each screen that opens, and then click Finish.
The wizard closes and the Scenario Staffing View opens.

6. Alternatively, if you selected Compare results with previous on the second wizard screen, the
Scenario Build Results window opens.
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The types of activities mentioned in the procedure above are described as follows:

• Immediate activity—Work activities that are handled by agents immediately, such as voice calls.
• Deferred activity—Backlog activities, such as email, that use special forecasting calculations.
• Fixed-Staff activity—Non-CTI activities that do not use Workforce Management service objectives.

Fill in each screen that opens, and then click Finish. In some cases, the Staffing Build Wizard
displays values for objectives that were used for the most recent staffing build or the default
forecasting objective values (if these have been specified and there were no previous builds).
Otherwise, the parameter values are left blank.

Forecast Staffing Build Wizard Screens

The Staffing Build Wizard screens are described in the following topics.

• Provide Target Date
• Provide Target Options
• Specify Service Level Objectives
• Specify Multimedia Service Level Objectives
• Staffing Requirements
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Staffing Build: Provide Target Date
Use the Provide Target Date screen in the Staffing Build Wizard to specify the target date range.

1. Select a Start Date and End Date using the spinner or the calendar.
2. Click Next to continue.
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Staffing Build: Provide Target Options
Use the Provide Target Options screen in the Staffing Build Wizard to specify the options described
below.

Indirectly Occupied Time

At a minimum, enter a value for Indirectly Occupied Time (IOT). IOT is a parameter that helps
define the queuing model that WFM uses when building a staffing forecast. Here is why:

There is a certain pool of agents that WFM considers in its queuing model when determining how
calls would be distributed from the queue to agents. IOT affects the availability of agents to handle
calls. For example, if IOT is defined as 10%, that means that 10% of the time, an agent will not be in
the agent pool (because the agent is off the phone).

To use template data, select the Use Template Data check box and click the Load Templates
button to load the specific templates that you want to be used.

Initial Queue

If the selected activity has the type Deferred, then the Initial Queue field is displayed and inside it
you must enter an integer value that is 0 or greater. You can leave this value empty, to indicate that
the build process will assume that the value is 0.

Select the Save initial queue time in default SL properties check box if you want to save the
initial queue value that you have specified as the new default service level value.

How is the Initial Queue Value Determined?
WFM Server posts a default value in Initial Queue field, based on existing information and
calculations. WFM Server uses the ending queue value of the previous day as the default value. If it is
the first day of Forecast scenario, this value is taken from Master Forecast.

This same value is used in the Contact Center Performance Report > Queue > Forecasted column for
the first day of the new forecasting period after you publish the Master Forecast.

For example, if you have published the Master Forecast for 02/02 - 08/02, the Contact Center
Performance Report > Queue > Forecasted column for 09/02 displays the backlog value that is
proposed in the Staffing Forecast Build wizard for 09/02 in the Initial Queue field.

Tip
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The Initial Queue field is hidden for all activity types except Deferred.

Use Service-Level Objectives

Select this check box to enable the Specify Service Level Objectives screen, later in the wizard.

Save IOT in default SL properties

Select this check box to save the IOT value as the new default value.

Compare Results with Previous

If you want to compare the results obtained from the Staffing Build Wizard with the previous
staffing scenario results, select the Compare results with previous check box.

If you do so, after you have completed the wizard, the Staffing Build Results window opens, showing
a comparison of the new and previous results.

Save default SL objectives

If you are building staffing for a single (or multi-site) Immediate activity type, you can choose to
update some or all of the default service level objectives with the new values you have specified. In
the next step of the Staffing Build Wizard, you'll be able to choose which parameter values to save
as the new defaults by selecting the Update activity default SL objective check box for each
parameter you want to update. You can then apply the updates in one of two ways:

• Remove all is the default setting. For each parameter where the Update activity default SL
objective option is selected, the default service level objective value for that parameter is updated to
the new specified value while the default values (or templates) for all other parameters are cleared.

• When Append selected is selected, the default service level objective value for each parameter where
the Update activity default SL objective option is selected is updated to the new specified value.
The default values for all other parameters remain unchanged.

If you do not select the Update activity default SL objective check box for any parameters, the
default values remain unchanged.

Click Next to open the wizard's next screen.
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Staffing Build: Service Level Objectives
Use the Specify Service Level Objectives screen in the Staffing Build Wizard to define service
level objectives when you are building staffing volumes for an immediate activity.

1. Select the check box(es) for one or more of the following:
• Use Estimated Average Time to Abandon (sec)—This is not a service objective. It is a

parameter that helps define the queuing system model used internally by WFM when building
staffing requirements. The value you configure here should represent the average time it takes
impatient callers to abandon.

• Use Service Level Objective—You can specify that you want a specified percentage of calls
answered in a specified number of seconds. For example, when building a staffing forecast, you
may specify that 80% of calls should be answered in 20 seconds.

• Use Average Speed of Answer Objective—ASA (sec).
• Use Occupancy Objectives—Maximum Occupancy Rate (%). The total amount of time the

agent is actually doing activity work as a percentage of the total amount of time the agent is
available to do activity work. For example, assume an agent has a shift from 8am-5pm, with a
30-minute lunch and 2x15-min breaks. Although the agent's total shift duration is 9 hours, the total
amount of time the agent is actually available for work is 8 hours, after subtracting the time for the
lunch and breaks.

• Use Abandoned Interaction Objective—Maximum Percent of interactions Abandoned (%).

2. Enter values for each objective that you selected.

Tip
When you select an objective's check box, you enable the text boxes for these target levels.

3. If you want to load an existing template to specify an objective's service levels, select Use Template
Data and then click Load Template.
You might want to use a template if the values for the objective are different for different timesteps.
Otherwise, WFM uses the single value that you configure, and applies it across all open hours of the
activity.

4. If you want to update the default service level objective values for the current activity type with the new
values you have specified, select the Update activity default SL objective check box for each
parameter you want to update. When building the staffing, WFM saves these new values as the default
service level objectives for the current activity type.

Important
If you are using templates to specify the parameter values, you can select only one template to save when
choosing to update the default service level objectives for the activity. The Staffing Build Wizard will
prompt you to select the template you want to save. The staffing will be built according to the values of all
selected templates, but only the template selected to be saved will update the default service level objective
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value.

5. Click Finish.
WFM Web calculates the staffing volumes and displays them in the Staffing view. An error message
appears if WFM Web cannot complete the calculation.

Tip
You can see the effect of other values by using the What-If window in the
Performance module.
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Staffing Build: Multimedia Service Level
Objectives
Use the Specify Multimedia Service Level Objectives screen in the Staffing Build Wizard to
define service level objectives when you are building staffing volumes for a Deferred staffing activity,
such as responding to emails.

Use either one of the following two procedures:

1. Fill in the percentage target for % of Deferred Work in

a. Enter a value into each of the following fields: Hrs, Min, and Sec.
b. Select a radio button from this group:

• Hours (default)—use these controls:
• In the field below this choice, enter hours, minutes, and seconds.
• Select one of these radio buttons: Non-interrupted Time (default) or Interrupted Time.

• Business days—In the field below this choice, enter an integer greater than 0.

c. Select the Save Deferred work in default SL properties check box if you want to save the
multimedia service level values you have specified as the default service level objective values.

d. Click Finish.

— OR —

2. Use the Service Level Template

a. Select the Use Service Level Template.
b. Click Load Template to load an existing template.
c. Select the Save Deferred work in default SL properties check box if you want to save the

multimedia service level values specified in the template as the default service level objective values.
d. Click Finish.

More About Interrupted and Non-Interrupted Time

When WFM calculates staffing, selecting interrupted time or non-interrupted time determines
whether or not the Activity closed hours are counted.

For example, if you select Interrupted Time WFM does not account for the Activity closed hours
when calculating the "idle in queue" time of interactions. If you select Non-interrupted Time WFM
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does account for the Activity closed hours when calculating the "idle in queue" time of interactions.
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Staffing Build: Staffing Requirements
Use the Staffing Requirements screen in the Staffing Build Wizard to define how staffing
requirements are built. You will use this screen for Immediate activities if you do not define any
service objective, or for Fixed-Staff activities.

1. Do one of the following:
• Select Number of Agents Each Time Step and enter the appropriate number in the text box to

the right.
• Select Average Activity Handling Time and enter the appropriate value (in seconds) in the text

box to the right.
• Select Use Staffing Template and click Load Template to load an existing template.

2. Select the Update activity default staffing requirements check box if you want to update the
default staffing requirement values with the new values you have specified.

3. Click Finish.
WFM Web calculates the staffing volumes and displays them in the Staffing view. An error
message appears if WFM Web cannot complete the calculation.
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Staffing Build Wizard for Multiple Activities
Use the Staffing Build Wizard to build staffing data for multiple activities, based on the default
forecasting objectives.

The Staffing Build Wizard uses the default forecasting objectives that were defined for each of the
following activity types (for activities under sites and multi-site activities):

• Immediate—Work activities that are handled by agents immediately, such as voice calls.
• Deferred—Backlog activities, such as email, that use special forecasting calculations.
• Fixed-staff—Non-CTI activities that do not use Workforce Management service objectives.

You won't be able to make changes to these values when using the wizard to build staffing for
multiple activities.

To get started, select a Site or BU from the Enterprise panel. In the scenario's Staffing view toolbar,
click Build to launch the Staffing Build Wizard.

Step 1: Specify target dates
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• Use the Provide Target Date screen in the Staffing Build Wizard to select the Target Date Range.
• Select the Start Date and End Date for the target date range. By default, the scenario's start and end

date displays.
• Click Next.

Step 2: Select activities

• Expand business units to display their sites and activities.
• Select the activities you want to build staffing data for.
• Click Finish.
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Staffing Build: Results View
If you selected the Compare Results with Previous check box on the first screen of the Scenario
Staffing Build Wizard, the Scenario Staffing Build Results view opens after you click Finish to
complete the wizard.

The graph shows the new calculated staffing compared to the original calculated staffing.

• Where the new calculated staffing results in an increased number of agents, the graph shows the area
in red.

• Where the new calculated staffing results in a decreased number of agents, the graph shows the area in
green.

Click Save to keep the new calculated staffing in your scenario, or Discard to return to the original
calculated staffing values.
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Staffing Split Wizard
Use the Staffing Split Wizard to split staffing from a multi-site activity Staffing forecast scenario.

Multi-site Activities

A multi-site activity (virtual activity set) has one or more associated activities (existing activities).
After building calculated and required staffing for a multi-site activity, you can then use this wizard

to split the result between associated activities.

Tip
The Staffing Split Wizard is available only within a Forecast Scenario. You must
add a multi-site activity to the forecast scenario for them to be available for splitting
in Staffing Split Wizard.

To use the Staffing Split Wizard:

1. In a currently-open forecast scenario, select a multi-site activity with already-built staffing values.
2. Click the Split button on the Forecast Scenario Staffing View toolbar.

The first of the Staffing Split Wizard's three screens, Select Multi-site Activities, opens.
3. Select the check boxes next to the multi-site activities that have staffing values you want to be split

between associated activities.
You can select several multi-site activities within the same business unit.

4. Select Use AHT Forecast if you want WFM Web to consider average handling time forecasts when
performing the split and then, click Next.
The wizard's second screen, Select Activities within Multi-site Activity, opens.

5. At the bottom of the pane, enable (enter a check mark) in the Split Required Also check box, if you
want required staffing to also be split.

6. Select the local (target) activities into which you want to split the multi-site activities and then, click
Next.
The wizard's third screen, Specify budgeting data, opens. The top half of the screen displays
a table with a row for each site in the forecast. Each site row contains these columns

• Site
• Activity
• Hours (corresponds to the Paid Hrs/Day text box below the table)
• Wage (corresponds to the Hourly Wage text box below the table)

7. To change an individual value, click a number inside an Hours or Wage cell of the table, and type a
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new value.
8. To change all values in a column of the table at once, click inside the corresponding text box below the

table, and then click Set All.
You can change one, some, or all fields. See the Staffing Build Wizard topic for definitions.

9. Click Finish.
WFM Web displays a Progress dialog while it splits the activities.

10. Optionally, click Cancel in this dialog if you want to cancel the split.
After splitting the activities, WFM Web returns to the Staffing View.
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Scenario Graphs View
Use the Graphs view to display the selected forecast scenario's data in a line chart. See the toolbar
image here and the button descriptions below.

Displaying the Graphs View

To display the Graphs view:

1. Select Forecast from the Home menu on the toolbar.
2. Select Scenarios from the Forecast menu on the toolbar.
3. Select a scenario from the list in the data pane, and open it.
4. Select the open scenario's name from the Forecast menu on the toolbar.

All open scenarios appear on the menu.
5. Select Graphs from the <selected scenario name> menu on the toolbar.
6. In the Objects tree, select an activity, multi-site activity, site, business unit or enterprise.

The view displays a graph above a table, each containing the same statistics, and controls that set
the data display properties for the graph and table.

If you do not see any data, you might need to adjust the Period, Granularity, or Date controls at
the top of the window to reflect those used for the forecast.

Setting the Data Display Properties and Date Range

Use these controls to customize the data display in the graph and table:

• Period drop-down list—Change the time range for the graph and the grid by selecting Year, Month,
Planning Period, Week, or Day.

• Granularity drop-down list—Specify the increments (granularity) in the data display by selecting from
this menu. The available choices depend on your selection in the Period drop-down list:
• If you select Year: Monthly, Weekly, or Daily.
• If you select Month: Weekly or Daily.
• If you select Planing Period: Weekly or Daily.
• If you select Week: 15 (minutes), 30 (minutes), 60 (minutes), Daily.
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• If you select Day: 15 (minutes), 30 (minutes), or 60 (minutes).

• Show Statistics drop-down list—Specifies what data is displayed in the graph and table. Select from
these choices: Interaction Volume, AHT, Interaction Volume and AHT, Calculated Staffing,
Required Staffing, Calculated and Required Staffing, Calculated and multi-skill calculated
staffing. Columns in the table are displayed accordingly to the selected statistic.

• Use standard date-selection controls (in the upper right portion of the window) to jump to a different
week within the Scenario Forecast's date range.

Reading the Graph and Legend

The graph shows the statistics, dates, period, and granularity that you select. The vertical axis
indicates the units shown. If you display multiple statistics, the right and left vertical axes display
different units for the two statistics, when necessary.

The Legend, at the bottom, identifies the colors that the graph uses to represent particular statistics,
events, or historical data. The Legend changes depending on the statistics that you select. Special
events appear as markers on the graph.

Modifying and Managing Scenario Data

You can use the following buttons on the Actions toolbar (the same commands also appear on the
Actions menu):

Icon Name Description

Publish
Opens the Publish Forecast
Wizard, where you can publish a
forecast directly to the master
schedule.

Add activity
Opens the Add Activity window,
where you can add activities to
this forecast scenario.

Remove activity
Opens the Remove Activity
window, where you can remove
activities from this forecast
scenario.

Save Saves your changes to this
forecast scenario.

Comments
Opens the Comments window,
where you can enter comments
for each day of the forecast.

Close
Closes a selected open scenario,
prompting you to save any
unsaved changes.
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Icon Name Description

Use multi-site activities

Controls whether WFM Web's
calculation of aggregated
information includes multi-site
activities. You can select this
button only if you first select a
multi-site activity, business
unit, or enterprise in the
Objects tree.

If you set this button to On,
WFM retains your last

selection—in the current view
and for all other views that
contain multi-site
activities—preventing you from
having to click it every time you
want to display data for the
selected multi-site activity.

Options
Opens the Options dialog box,
where you can further customize
the graph.
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Load Forecast Template Window
Use the Load Forecast Template window to select a forecast template. This window opens when
you:

• Select Use Templates and click the Load Templates button in these Staffing Build Wizard screens:
Provide Budgeting and Overhead Data, Specify Service Level Objectives, and Staffing Requirements.
The window title includes the template type; for example, Load Indirectly Occupied Time %
Forecast Templates.

• Select Template Based and click Next in the Volumes Build Wizard.

The template's type, and its associated activity, match your selections in the previous view or
window.

To use this window:

1. Select a template in the list of available Templates at the upper left.
The list shows each source template's name and, for overlap templates, its date range.

2. Select a Start date and End date at the lower left, using the date-selection controls.
The date range that you can specify depends on the context from which you opened this window. For
non-overlap templates, you cannot select dates outside the selected template's date range, and you
cannot apply templates with overlapping date ranges.

3. Select the check boxes (at the lower left) beside any weekday to which you want to apply this template.

Tip
This does not apply to overlap templates.

4. Click >>> to apply the template.
The template moves into the Applied Templates list at the upper right. That list shows your date and
weekday selections, where applicable.

5. Repeat the preceding steps for any additional templates that you want to apply.
6. Click <<< if you want to remove any of your selections from the Applied Templates list.
7. Click OK to load the templates that you have applied.

You are returned to the window from which you opened the Load Forecast Template window.
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Add Activity Window
Use the Add Activity window to change the activities that are associated with the current forecast
scenario:

1. Select the check box next to any activity that you want to include.
You can select from multiple sites.

2. Click OK.
The previous view reappears. Its displayed data changes to match your selections.
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Remove Activity Window
Use the Remove Activity window to change the activities associated with the current forecast
scenario:

1. Clear the check box next to any activity that you want to remove.
You can clear activities from multiple sites.

2. Click OK.
The previous view reappears. Its displayed data changes to match your selections.
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Add Comments to a Forecast
Use the Comments window to add comments to a forecast scenario. For example, you might want to
add a comment after making manual changes to a scenario, so that you can keep a record of the
changes.

You can add comments only for an activity, not for a site. A Forecast scenario activity can have
numerous comments, including a new comment for each day.

See the following sections:

• Adding comments to a forecast scenario.
• Editing existing comments.
• Deleting existing comments.

Adding Comments to a Forecast Scenario

1. Click the Comments button on the Forecast Scenario View toolbar.
2. In the Comments window that appears, click New at the upper right.

The lower panel's label changes to New comment.
3. Adjust the Comment date, using the date-selection controls.

By default, the start date of the forecast appears.

Tip
You cannot select a date outside the forecast scenario's date range. If you try to make more than one
comment per date, an error message alerts you to either select a different date or edit (or delete) that date's
existing comment.

4. Type your comments into the large text box at the bottom left.
5. Click Apply to add your comment to the upper list, or Cancel to discard it.
6. Make any other changes that you want to make in this window and then do one of the following:

• Click Save to save all of your changes and close the Comments window.
• Click Close to discard all of your changes and close the Comments window.

The previous forecast scenario view reappears. Your new comments are now attached to the scenario.
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Editing Existing Comments

1. Click the Comments button on the Forecast Scenario View toolbar.
The Comments window appears. The upper section of the window lists previously entered comments.

2. Click an existing comment to select it.
The comment's text appears in the large text box at the bottom left.

3. Click Edit.
4. Edit the comment text in the large text box.
5. Click Apply to save your edits, or Cancel to discard them.
6. Make any other changes that you want to make in this window, then do one of the following:

• Click Save to save all of your changes and close the Comments window.
• Click Close to discard all of your changes and close the Comments window.

The previous forecast scenario view reappears.

Deleting Existing Comments

1. Click the Comments button on the Forecast Scenario View toolbar.
The Comments window appears. The upper section of the window lists previously entered comments.

2. Click an existing comment to select it.
The comment's text appears in the large text box at the bottom left.

3. Click Delete.

Important
The comment is deleted immediately. There is no confirmation prompt.

4. Make any other changes that you want to make in this window; then do one of the following:
• Click Save to save all of your changes and close the Comments window.
• Click Close to discard all of your changes and close the Comments window.

The previous forecast scenario view reappears.
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Forecast Scenario Overheads View
Use the Overheads view to see the overhead data, which WFM uses to forecast shrinkage while
scheduling. See the toolbar image here and the button descriptions below.

You can perform the following functions:

• View totals
• Edit pre-defined overheads (both planned and unplanned)
• Add, edit and delete overheads associated with the current Schedule State Group for specific activity.

Multi-site activities use overhead information that is associated with Schedule State Groups, from
child activities (except for planned and unplanned overheads, which are separate for local and multi-
site activities).

Setting the Grid Properties and Date Range

Use the following options in the Grid properties and Date range panes (near the top) to customize
the grid:

• The grid displays data for a period of a year, a month, the planning period, or a week. To change the
period, click Year, Month, Planning Period, or Week on the Period drop-down list to change the
time range that is shown on each row. (WFM Web prompts you to save any unsaved edits before it
refreshes the display.)

• If you select Week, you can further adjust each row's time range by selecting a Granularity of 15, 30,
or 60 minutes.

• Use the standard date-selection controls to jump to a different week within the forecast scenario's date
range.

The Overhead Menu

The Overhead drop-down menu displays a list of the following overheads:

Grand Total A read-only statistic; the aggregate overhead for
the selected target.

Total Planned A read-only statistic; the aggregate planned
overhead for the selected target.

Total Unplanned A read-only statistic; the aggregate unplanned
overhead for the selected target.
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Planned
Displays planned overhead values that are not
associated with any Schedule State Group. (In
Scenario Overheads only, not in Master
Schedule Overheads.)

Unplanned
Displays unplanned overhead values that are not
associated with any Schedule State Group. (In
Scenario Overheads only, not in Master
Schedule Overheads.)

Schedule State Group <name>

Displays overhead values that are associated with
this named Schedule State Group and the
target. If the target is a multi-site activity, the
Schedule State Group name is prefixed with the
activity name.

Tip
Not available in Master Schedule Overheads.

Important
• Statistics appear in the Overhead menu for the item that is selected in the Object

pane. If the item is an activity, then the menu lists all Schedule State Group
overheads that are associated with the activity. If the item is a multi-site activity, the
menu lists all Schedule State Group overheads that are associated with its child
activities.

• You can edit the Overhead values for activities or multi-site activities.

Managing Scenario Overhead Data

You can use the following buttons on the Actions toolbar (these commands also appear on the
Actions menu):

Icon Name Description

Publish
Opens the Publish Forecast
Wizard, where you can publish a
forecast directly to the master
schedule.

Add activity
Opens the Add Activity window,
where you can add activities to
this forecast scenario.

Remove activity
Opens the Remove Activity
window, where you can remove
activities from this forecast
scenario.
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Icon Name Description

Save Saves your changes to this
forecast scenario.

Comments
Opens the Comments window,
where you can enter comments
for each day of the forecast.

Close
Closes this scenario, prompting
you to save any unsaved
changes.

Add Overhead

Starts the Add Overhead Wizard,
which you can use to add
overhead values to be associated
with the Schedule State Group
(SSG) and the target.

Delete Overhead

Deletes overhead values that are
associated with the SSG and
selected in the Overhead drop-
down menu. The SSG is removed
from the Overhead menu, after
you confirm.

Apply Template

Applies templates for the
overhead that is selected in the
Overhead drop-down menu.

Tip
This button is disabled if one of the
read-only choices (Grand Total,
Total Planned, Total Unplanned) is
selected in the drop-down menu.
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Add Overhead Wizard
The Add Overhead Wizard contains the following pages:

Select Activity Page

This page appears only if the selected target in the Overheads view is a multi-site activity.

1. Select an activity (in the list, each is followed by its site name in parentheses).
2. Click Next.

Select Schedule State Group Page

Use this page to select a Schedule State Group (SSG) from the drop-down list of SSGs that...

• ...belong to the same site as the local activity that was selected in the Object tree or in the Overheads
view if a multi-site activity was selected.

• ...are configured as overhead-related.

Set Initial Value Page

Use this page to specify initial overhead values. Select one of the following radio buttons:

• Initial value—Select, then use the edit control to specify a value for each time step (must be 0 or
more, and less than 100%).

• Use template—Select, then click the Load Templates button to use a dialog to select the overhead
template to be applied.
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Publish/Extract Forecasts
Use the Publish Forecast Wizard to transfer unpublished forecast scenarios to the Workforce
Management database's Master Forecast, or to extract Master Forecast information to forecast
scenarios.

The following sections cover:

• Publishing to the Workforce Management Database.
• Extracting from the Workforce Management Database.

Why Publish Forecasts?

• Publishing a forecast to the Workforce Management database means that the forecast is final.
Schedules for a particular date range are based on the published (Master) forecast for those dates.

• Until a forecast is published, you cannot calculate certain performance data.

Publishing to the Workforce Management Database

This is Video 4 in a 4-video series. You can watch Video 3 here.

Link to video
To publish a forecast:

1. In the Forecast Scenarios view's Scenarios Table, select the scenario that you want to publish. Then
click the Publish button on the toolbar.
The Publish Forecast Wizard's Select Action screen appears.

2. Select Publish to Master Forecast, and then click Next.
The Publish to Master Forecast screen appears.

3. In the Source Dates section, use the date-selection controls to select the Start date and End date.
4. In the Target Dates section, use the date-selection controls to select the Start date and End date.
5. In the Activities list, select which activities you want to publish to the Master Forecast.

The tree shows all activities for which the selected scenario contains data. Expand business
units to display their sites and expand sites to display their activities.
You can select multiple activities from different sites.

6. Click Finish.
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Defining Start and End Dates when Publishing
You must understand what is defined by the start and end dates in each section in the procedure
above:

• In the Source Dates section—The start and end date values define the date range of information you
want to publish information from the selected scenario. By default, the selected scenario's own start
and end dates appear in these text boxes. You cannot select dates outside the original scenario dates.
The scenario and target start dates occur on the same day of the week.

• In the Target Dates section—The start and end date values define the date range for which you want
to update information in the Master Forecast. By default, these fields' entries match those in the
Source Dates section. Data from a specific weekday is copied only to the same weekday. That is,
forecast information for a Monday is copied to one or more Mondays, depending on the target date
range that you select. The Monday data is not copied to every day within the target date range.

Extracting a Forecast from the Workforce Management Database

To transfer data from the Master Forecast into a forecast scenario:

1. In the Forecast Scenarios view's Scenarios Table, select the scenario to which you want to extract the
data. Then click the Publish button on the toolbar.
The Publish Forecast Wizard's Select Action screen appears.

2. Select Extract from Master Forecast, and then click Next.
The Extract from Master Forecast window appears.

3. In the Source Dates section, use the date-selection controls to select the Start date and End date.
4. In the Target Dates section, use the date-selection controls to select the Start date and End date.
5. In the Activities list, select which activities you want to extract to the target scenario.

The tree shows all activities for which the Master Forecast scenario contains data. Expand
business units to display their sites and sites to display their activities.
You can select multiple activities from different sites.

6. Click Finish.

Defining Start and End Dates when Extracting
You must understand what is defined by the start and end dates in each section in the procedure
above:

• In the Source Dates section—The start and end date values define the date range for which you want
to extract information from the Master Forecast. By default, these values match those in the Target
Dates section.

• In the Target Dates section—The start and end date values define the date range for which you want
to update the information in the selected target scenario. By default, the scenario's own start and end
dates appear in the text boxes. For an existing scenario, you cannot select dates outside the scenario's
original date range.
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Graph View Options

Tip
Starting in this release, WFM has a new interface for the Forecast module. If you have
landed on this page by accident and are using the new Supervisors interface, see the
"Forecasts" page in the Workforce Management Supervisor Help, which describes the
new Forecast module.

Use the Options dialog box to customize the display of the Scenario Graphs view, the Master
Forecast Graphs view, or the Historical Data Graphs view.

To use this feature:

1. Select a statistic from the Show Statistics drop-down list.
2. Click the Options button on the toolbar.

The contents of the Options dialog box changes depending on the statistic that you selected.

The table below shows the statistics and the Help topic that explains the corresponding Options
dialog box.

Important
The Options dialog box for the three Staffing statistics (Calculated Staffing,
Required Staffing, and Calculated and Required Staffing) are the same, so a
single topic, Graphs Filters (Staffing), covers all three.

• Click the link for a Help topic listed in the table. This takes you to an explanation of the options
available for that statistic in the Options dialog box.

Interaction Volume Graph View Options (IV)
AHT Graph View Options (AHT)
Interaction Volume and AHT (not available in the
Historical Data Graphs view) Graph View Options (IV and AHT)

Required Staffing (not available in the Historical
Data Graphs view) Graph View Options (Staffing)

Calculated Staffing (not available in the Historical
Data Graphs view) Graph View Options (Staffing)

Calculated and Required Staffing (not available in
the Historical Data Graphs view) Graph View Options (Staffing)

Calculated and Multi-skilled Calculated Staffing (not
available in the Historical Data Graphs view) Graph View Options (Staffing)
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Graph View Options (IV)
Use the Options dialog box to customize a Forecast Graphs view whose Show Statistics drop-
down list is set to Interaction Volume (IV):

1. Click the Options button on the Graphs view toolbar.
The Options dialog box opens.

2. Select the check boxes for the options that you want to have displayed in the graphs.
3. Clear the check boxes for those that you want to be hidden.

You can select or clear any number of the check boxes. See the option descriptions below.
4. Click Apply.

The Graphs view is redrawn to match your selections.

Forecast Graphs Display Options

Show Special Events—When selected, graphs display a marker that represents the start of each
event’s impact.

Show Historical Data—When selected, graphs display historical data. Check boxes appear for the
following:

• This Year
• 1 Year Ago
• 2 Years Ago
• 3 Years Ago
• 4 Years Ago
• 5 Years Ago

You can independently show or hide the display of multiple prior years' data. Each year's data
appears in a different color.

The Legend identifies what each color represents.
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Graph View Options (AHT)
Use the Options window to customize a Forecast Graphs view whose Show Statistics drop-down
list is set to AHT (average handling time):

1. Click the Options button on the Graphs view toolbar.
The Options window appears.

2. Select the check boxes for the options that you want to have displayed in the graphs.
3. Clear the check boxes for those that you want to be hidden.

You can select or clear any number of the check boxes. See the option descriptions below.
4. Click Apply.

The Graphs view is redrawn to match your selections.

Forecast Graphs Display Options

Show Special Events—When selected, graphs display a marker that represents the start of each
event’s impact.

Show Weighted AHT—When selected, graphs use weighted AHT data rather than a simple average
of AHT data.

Show Historical Data—When selected, graphs display historical data. Check boxes appear for the
following:

• This Year
• 1 Year Ago
• 2 Years Ago
• 3 Years Ago
• 4 Years Ago
• 5 Years Ago

You can independently show or hide the display of multiple prior years' data. Each year's data
appears in a different color.

The Legend identifies what each color represents.
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Graphs View Options (IV and AHT)
Use the Options dialog box to customize a Forecast Graphs view whose Show Statistics drop-
down list is set to Interaction Volume and AHT (average handling time):

1. Click the Options button on the Graphs view toolbar.
The Options dialog appears.

2. Select the check box if you want the option to be displayed in the graphs.
3. Clear the check box if you want the option to be hidden.

See the option description below.
4. Click Apply.

The Graphs view is redrawn to match your selection.

Forecast Graphs Display Option

Show Special Events—When selected, graphs display a marker that represents the start of each
event’s impact.
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Graph View Options (Staffing)
Use the Options dialog box to customize a Forecast Graphs view whose Show Statistics drop-
down list is set to one of the following:

• Calculated Staffing
• Required Staffing
• Calculated and Required Staffing
• Calculated and Multi-skill Calculated Staffing

Important
An Explanation and Caution:
Multi-Skilled Calculated Staffing takes into account how many agents with multiple skills could be
available to work on an activity, and how the occupancy of an average agent would be divided among this
activity and the other activities in his or her skill set.

Multi-Skilled Calculated Staffing is available only if the Multi-Skilled Forecasting option is configured.
See Overview in the Workforce Management Administrator's Guide for a discussion of multi-skilled
forecasting and a description of how to enable multi-skill support.

However, if the Multi-Skill option is not configured, then you will still see Multi-
Skilled Equivalents in the graphical view, but they will be the same as Calculated
Staffing in Single-Skill Equivalents.

Opening the Options Dialog Box

1. Click the Options button on the Graphs view toolbar.
The Options dialog box opens.

2. Select the Show Special Events check box if you want to have that option displayed in the graphs.
3. Clear the check box if you want that option to be hidden.

See the option descriptions below.
4. Click Apply.

The Graphs view is redrawn to match your selections.

Forecast Graphs Display Options

Show Special Events—When selected, graphs display a marker that represents the start of each
event’s impact. This option appears only if the selected activity is immediate.
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Show Secondary Graph—If you select a radio button other than None in this pane, graphs include
an additional line that shows values for one additional statistic. The secondary line is superimposed
in a different color (which is identified in the Legend).

Choose a secondary statistic by selecting only one of the following radio buttons:

• None—No secondary graph.
• Service Level Objective—The requirement for the service level as defined when creating the forecast.
• Service Level—The forecast service level. (Appears only if the selected activity is immediate [not

deferred].)
• Service Level Required—The requirement for forecast service level as defined when creating the

forecast. (Appears only if the selected activity is immediate [not deferred].)
• Deferred Service Level—The deferred forecast service level. (Appears only if the selected activity is

deferred.)
• Deferred Service Level Required—The requirement for deferred forecast service level as defined

when creating the forecast. (Appears only if the selected activity is deferred.)
• Forecasted Calculated Queue—The forecast queue, calculated using Staffing Calculated values.

(Appears only if the selected activity is deferred.)
• Forecasted Required Queue—The forecast queue, calculated using Staffing Required values.

(Appears only if the selected activity is deferred.)
• Avg Speed of Answer Objective—The requirement for Average Speed of Answer (ASA) as defined

when creating the forecast.
• Avg Speed of Answer—The forecast Average Speed of Answer (ASA).
• Avg Speed of Answer Required—The requirement for Average Speed of Answer (ASA) as defined

when creating the forecast.
• % of Abandons Objective—The requirement for the percentage of interactions abandoned, as defined

when creating the forecast.
• % of Abandons—The forecast percentage of interactions abandoned.
• % of Abandons Required—The requirement for the percentage of interactions abandoned as defined

when creating the forecast.
• Maximum Occupancy Objective—The requirement for the maximum time that a logged-in agent

should be handling interactions, as defined when creating the forecast.
• Maximum Occupancy—The forecast maximum time that a logged-in agent will be handling

interactions.
• Maximum Occupancy Required—The requirement for the maximum time that a logged-in agent will

be handling interactions as defined when creating the forecast.
• Estimated Budget—The estimated budget based on a full-time working day and hourly rate.
• Hiring Plan—The total number of people, including non-working (on vacation) agents, who are needed

to handle the forecast interaction volume.
• Agent Hours—The number of agent hours that are needed to handle the interaction volume.
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Important
If you selected Use multi-site activity for any target in the object tree, Estimated
Budget, Hiring Plan, and Agent Hours are omitted from this list of secondary
statistics. If you selected fixed-staff activities, you will see only these three
statistics displayed as radio buttons.

Changing the Staffing Totals Display from FTE to Man Hours

When Calculated and Required Staffing is selected in the Show Statistics drop-down list , you can
switch between FTE and man-hours mode in the Graph view by adjusting the view settings in the
interface.

To switch display modes:

1. At the top of the Graph view, above the list of modules, click About in the grey Home toolbar

.
2. In the WFM Web About dialog, click Settings...
3. In the Settings... list, scroll down to the FRC_STAFFING_USE_MANHOURS option and, in the Value

column, enter a check mark in the boolean check box.
4. To edit the selected string in the list, click it twice.

Forecasts Graph View Options

Workforce Management Web for Supervisors Help 404



Forecast Templates

Tip
Starting in this release, WFM has a new interface for the Forecast module. If you have
landed on this page by accident and are using the new Supervisors interface, see the
"Templates" page in the Workforce Management Supervisor Help, which describes the
new Forecast module.

Forecast templates help you create forecasts for sites or business units that have little or no historical
data. In addition, there are other uses for templates. For example, you can create templates for
service objectives, such as Average Speed of Answer, and Service Level. In those cases, forecast
templates are used to apply different values for different periods of the day, instead of using a single
value for the whole day.

Use WFM Web's forecast templates features to:

Select and manage forecast templates: See Forecast Templates List View.
Edit template values: See Template Properties: Data Tab.
View template values in a graph: See Template Properties: Graph Tab.
Add or remove activities within a template: See Template Properties: Activities Tab.

Create a new template:

See New Forecast Template Window.

Tip
You can copy and paste data between a grid and a
spreadsheet. For example, you can copy and paste
from a Scenario Volumes view or Scenario Staffing
view.

Create a new template from existing data: See Save as Template Window.
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Forecast Templates List View
Use the Forecast Templates List view to create, edit, and delete forecast templates.

You use these templates to create forecasts for sites or business units that have little or no historical
data. In addition, there are other uses for templates. For example, you can create templates for
service objectives, such as Average Speed of Answer, and Service Level. In those cases, forecast
templates are used to apply different values for different periods of the day, instead of using a single
value for the whole day.

The following sections cover:

• Displaying the Forecast Templates List view
• Using the Templates table
• Creating, editing, or deleting templates

Displaying the Forecast Templates List View

1. In the Modules tree, click Forecast > Templates to activate the Templates List View.
2. In the Objects tree, select a business unit, site, or template. Business units and sites expand to display

their templates.
• If you selected a business unit or site, the table on the right-hand pane shows the templates that

correspond to your selection.
• If you selected a template, the template properties appear in the Data tab.

See Template Properties: Data, Template Properties: Activities, and Template Properties: Graph for
information on the three template properties tabs.

Using the Templates Table

The Templates table shows each template's name, type, associated site, and date range.

To filter the table so that it shows more or fewer templates:

• Select or clear check boxes in the Show Template Types pane at the top.

To select a template for editing or deletion:

• Click the template's row in the table.
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Creating, Editing, or Deleting Templates

You can use the following buttons on the Actions toolbar (these commands also appear in the
Actions menu):

New Opens the New Forecast Template dialog box.

Edit Opens the Forecast Template Properties view for
the selected template.

Delete Deletes the selected template after first displaying
a dialog box asking you to confirm your choice.
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Template Properties: Data Tab
Use the Template Properties view's Data tab to edit a forecast template's values in a table format.

The boxes at the top of the tab contain the template's name, associated site, business unit, type, and
total or average value. The table lists timesteps and corresponding values for the template's
activities.

To edit values:

1. Select the value in the right column, and replace it with the value that you want.
2. Repeat this for other timesteps that you want to change.

You can use the vertical scroll bar on the right to display more timesteps.
3. Click Save to save your changes to the template.
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Template Properties: Graph Tab
Use the Template Properties view's Graph tab to view a forecast template's values in a graphical
format.

To adjust the graph's displayed time interval, use the Display Date drop-down list.

• If you select Whole Period, the graph's horizontal axis indicates:
• Days of the week, for non-overlap templates.
• All dates in the template, for overlap templates.

• If you select an individual weekday (for non-overlap templates) or a specific date (for overlap
templates), the horizontal axis indicates timesteps.

The graph's vertical axis identifies the values shown in the graph.
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Template Properties: Activities Tab
Use the Template Properties view's Activities tab to modify the activities associated with a
forecast template:

1. Select the check boxes beside the activities that you want to associate with the template.
2. Clear the check boxes beside the activities that you want to remove from the template.

The check boxes show activities belonging to the business unit or site with which the template is
associated.

3. Use the vertical scroll bar on the right to display more activities.
4. Click Save to save your changes to the template's activities.
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New Forecast Template Dialog
Use the New Forecast Template dialog box to create a new template, but first watch the video.

Link to video
To create a template:

1. Click New in the Forecast Templates List view toolbar
The New Forecast Template dialog box opens.

2. Enter a Name for the template.
3. In the Associated drop-down list, select the site for which you are building this template.
4. Click the Type drop-down list to select the template type.

See a list of template types below.
5. Select a template from the Based On drop-down list If you want to use settings from a previously

configured template.
6. Enter a number for the Initial Value.
7. If you are creating an overlap template, enter the Start and End dates.
8. Select the Activities that you want to be associated with this template.

Selecting activities enables you to control which templates are used when forecasting for
specific activities.

9. Click OK.
The forecast template is now available in the Forecast Templates List view.

What Does the Intial Value Represent?
The initial value you enter in step 6 of the procedure is a minimum value that applies to all timesteps.
After you have created the template, edit it to adjust the precise values for each timestep. WFM Web
interprets the initial value differently, depending on the type of template. For example, if you are
creating an Interaction Volume template, the initial value might be 8 (calls per timestep). See
Template Properties: Data for details.

Forecast Template Types

• Interaction Volume—Number of interactions per timestep. When you save historical IV or AHT for a
multi-site activity as a template, only multi-site activity data are saved, never the sum of underlying
activities.

• Average Handle Time—In seconds. See note above.
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• Service Level Percentage—As a percentage. See Special Note at end of this topic.
• Overheads—As a percentage. See Special Note.
• Indirectly Occupied Time—As a percentage. See Special Note.
• Maximum Occupancy—As a percentage.
• Interaction Volume Overlap—Number of interactions per timestep.
• Average Handle Time Overlap—In seconds.
• Staffing—Number of agents (full-time equivalents) to be scheduled for each timestep. This can be

either calculated by WFM (Calculated Staffing) or set by the user (Required Staffing), or you can
use both Calculated and Required values in a forecast. See Special Note.

• Average Speed of Answer—In seconds. See Special Note.

Special Note

You can create these templates at the business unit level and apply them when building a multi-site
activity staffing forecast.
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Save as Template Dialog
Use the Save As Template dialog box to create a new forecast template from existing data. You can
open this dialog box from:

• Historical Data Volumes View
• Master Forecast Staffing View
• Scenario Staffing View

To complete the dialog box:

1. Enter a name for the new template into the Name field.
2. Select the site to which you want this template associated from the Associated drop-down list.
3. Select the template type from the Type drop-down list.

The Based on drop-down list and the Initial Value text box are disabled. You cannot alter their default
entries.

4. Select or enter the Start date and End date into the corresponding fields in the Source Dates area.

Important
For regular (non-overlap) templates, the date range must be one week. If you enter a different date range,
WFM Web automatically adjusts it to one week. Overlap templates, which fill in gaps in historical data, have
specified start and end dates.

5. Select or enter the Start date and End date into the corresponding fields in the Target Dates area.
You can select Target Dates that are different from Source Dates for these template types: IV
Overlap, and AHT Overlap.

6. Select the Activities that you want to be associated with this template.
7. Click OK.

The new forecast template now appears in the Forecast Templates List view.
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Overlays

Tip
Starting in this release, WFM has a new interface for the Forecast module. If you have
landed on this page by accident and are using the new Supervisors interface, see the
"Overlays" page in the Workforce Management Supervisor Help, which describes the
new Forecast module.

You can create and configure overlays in the Forecast module of WFM Web for Supervisors. Overlays
perform the function of factors, and help you track events that might affect interaction volume. For
example, use an overlay to include in your forecast the anticipated effect of a sales promotion or a
marketing campaign.

See also Overlays Primer.

Getting Started

Prerequisite: You must have the security permission Overlays before you can create or configure
overlays or access the action Find Events in the Historical Data Volumes View. It is assignable in
Configuration > Roles > Role Privileges > Forecast Role Privileges.

To use overlays, open the Forecast module in the Modules pane and select Overlays. You can then
see a hierarchy of business units (BUs), sites and overlays on the Object pane below.

To manage the list of Overlays, select a BU or a site in the Objects pane.

To edit an overlay, select it in the Objects pane and make changes in the Data pane.

Managing the List of Overlays

You can use toolbar icons or Actions menu commands to manage the overlays:

1. Select a BU or Site on the Object pane.
A table in the Data pane lists all current overlays.

2. Click an overlay to select its entire row.
3. Select a command from the Actions menu, or an icon from the toolbar:
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Toolbar controls
Icon Name Description

New Start the New Overlay wizard.

Edit Edit the selected overlay.

Delete Delete the selected overlay.

Data Pane Controls
The grid displays all overlays that belong to the selected BU or Site. The grid contains these columns:

Overlay Name of the selected overlay.

Spread The time period over which the overlay is spread;
in days or hours.

Type

Possible values (Impacting or Redistributing)
indicate how the selected overlay will affect
forecast values. You can change this in the
Properties tab by selecting a type:

• Calculate Using Specified Initial and Ending
Impact (select to specify Impacting)

• Always Use Entered Distribution or Always
Calculate Disregarding Impacts and
Distribution (to specify Redistributing)

Usage For each overlay, this column lists the Properties
tab choice for type (see above).

Editing an Overlay
To edit an overlay:

1. Select Overlay in the module pane.
2. Select a BU or Site in the object area.
3. Select an overlay by one of these methods:

• Select an overlay in the object area in the object area (beneath the selected BU or Site).

• Select an overlay in the data area and click Edit .
• Double-click an overlay in the data area.

4. Select a command from the Actions menu, or an icon from the toolbar:
• Edit Overlay controls:
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Icon Name Description

Save Save all changes made to
overlay.

Calculate distribution

Start the Calculate Distribution
Wizard, which calculates the
distribution of the selected
overlay.
This action is enabled only if
the option Always Use Entered
Distribution is selected.

— OR —
• Select a tab:

Properties tab View and change the main properties of the
selected overlay.

Distribution tab
View and change the distribution method of the
selected overlay. Enabled in the Properties tab
by selecting the type Always Use Entered
Distribution.

Impacted Activities tab View and change activities which are impacted
by the selected overlay.

Events tab View and change events which are related to
the selected overlay.

Properties Tab Elements

Name field You can edit the selected Overlay's name in this
field.

This overlay is label

• Impacting Forecast Values and
Totals—Specify that this overlay can impact
the forecast by changing forecast’s values and
totals. This option is the default.

• Redistributing Forecast Without Changing
Total—Specify that this overlay must preserve
a forecast’s total for specific period even while
changing the distribution of values inside that
period.

Spread Over field

Displays the length of time that the selected
Overlay will occupy.

Edit this field and select one of the two radio
buttons Days or Hours to choose the units. The
value must be greater than 0 (zero) and the default
is set during creation.

While building forecast use this overlay in the
following way
radio button group

• Calculate Using Specified Initial and
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Ending Impact—Use the specified initial and
ending impact when building a forecast. This
option enables the Distribution tab and the
fields Initial Impact and Ending Impact beneath
that tab.

• Always Use Entered Distribution—Use the
specified (entered) distribution when building a
forecast. This option enables the Distribution
tab.

• Always Calculate Disregarding Impacts and
Distribution—Use this overlay, but always
disregard impacts and distribution when
building a forecast. This option disables the
Distribution tab.

This overlay is applicable to
radio button group

• IV—Specify that this overlay applies only to
Interaction Volume (IV).

• AHT—Specify that this overlay applies only to
Average Handling Time (AHT).

Distribution Tab Elements
What you see depends upon choices that you made on the Properties page.

• This page is completely disabled if Always Calculate Disregarding Impacts and Distribution was
selected under the Properties tab.

• If Always Use Entered Distribution was selected on the Properties tab:
• Graph—Displays the same information as the grid below it displays, but in graphical form.
• Grid—Displays and allows you to edit the overlay's distribution. Columns:

• Daily or Hourly Impact—Each row displays an increment during which the overlay will be in
effect. The actual increment (day or hour) is configured in Spread.

• Distribution Value—Displays the distribution value of each increment. The default value in
each cell is 0.

• If the selected overlay is of the type impacting, then you can enter values from -100 to 9999
into the grid.

• If the selected overlay is of the type redistributing, then you can enter values from 0 to 100
into the grid.

Important
If the total of all values in the grid does not equal 100, you will see a warning and will
not be able to save your changes to the overlay.
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• If Calculate Using The Specified Initial and Ending Impact was selected on the Properties page:
• Initial Impact field—Use this field to specify the initial impact of the overlay. Range: 0 (the default)

or any positive, negative, or fractional values.
• Ending Impact field—Use this field to specify the ending impact of the overlay. Range: 0 (the

default) or any positive, negative, or fractional values.

Impacted Activities Tab
(Also a page in the New Overlay wizard.)

This tab lists all activities that correspond to the Factor that is selected in the Object tree.

• Select the check box to the left of each activity in the list, to specify which activities will be impacted by
the selected factor.

• Clear the check box to specify no impact.

Events Tab Elements
The grid on this tab lists all Events in the selected Overlay, one per row. The value in every cell of
this grid is editable. The columns are:

Name Edit the Event name in this cell.
Start Date Edit the start date.
Start Time Edit the start time.

Strength
Edit the strength of the event. The range is any
positive value (greater than zero), up to nine digits
and two decimals.

Disregard Historical Data
Select this check box if the event should disregard
historical data. Clear the check box to consider
historical data.

Events Controls

Add Event Click to add a new row to the grid, with default
values in the cells.

Delete Event Click to delete the selected event from the grid.
Cancel or Save Click to perform those functions.
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Overlays Primer
In WFM, each event in an overlay represents an abnormality in historical data or in the future—that
is, a fluctuation in Interaction Volume (IV) or Average Handling Time (AHT) that is not one of the usual
seasonal, intra-week, or intra-day trends. If these events point to the same kind of abnormality, one
that has happened multiple times in the past or can happen in the future, then overlay events can be
arranged into overlay groups that are simply called overlays. The most common overlay examples
are advertising campaigns and catalog drops.

An overlay impacts prediction data directly, when the event in a particular overlay is situated over a
prediction interval.

Overlay Types

There are two types of overlay, defined by how WFM calculates their impact on prediction data:

1. A Multiplicative Overlay increases or decreases every step of predictive data by a specific
percentage. That percentage is the overlay's impact distribution, multiplied by event strength. The total
of the interval is affected.

This type of overlay was called a factor before release 7.6.1. Each step (daily or hourly) of predictive
data that is covered by the overlay is adjusted by a certain percentage and multiplied by event
strength.

2. An Overriding Overlay redistributes the volume of an event interval. The total of the interval does not
change. The volume may be moved from one event-step to another.

This type of overlay was introduced in version 7.6.1, when factor was renamed multiplicative overlay. It
is designed to keep the predicted total of the affected period and, instead, adjust the distribution of the
volumes within that period. The events of this overlay type are applied as the last step of prediction.
The seasonal components (intra-day, daily, and yearly) and multiplicative overlays are applied before
overriding overlays are calculated.

The overriding overlay distributes the volumes according to the weight (or the percentage) of each
event-step (daily or hourly). It adjusts the volume of each event-step, so that the event-step receives
its part of the total of the whole event period according to its weight.

For example, an overriding overlay has three event-steps with respective weights of 20, 30, and 50. If
the predicted total of the entire interval is 1,000, then the first event-step will get 200, the second 300,
and the last 500. Note that the initially predicted total of the event-step is not taken into account while
calculating an impact of this overlay type. The weight of an event-step that is determined by the
overlay itself, as well as the predicted total of the whole interval that is affected by the event, are taken
into account.

When the event-step (daily or hourly) is calculated, its total is distributed to 15-minute timesteps
proportionally, to a volume of each time step before the event was applied. So, the intra-day or intra-
hour pattern is preserved.

When the event of an overriding overlay type overlaps with the other event of the same type, it cannot
be calculated, even if both belong to different overlays. However, it can overlap with events of
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multiplicative overlays.

Distributing Event Impact

There are three ways to determine the impact of each event-step, and they apply to both overlay
types:

1. By start-end—The impact distribution of an overlay is determined by specified start and end impact
values. The impact is gradually changed by the same amount for every event-step, from the start value
to the end value. For example, if the starting value is 100 and the ending value is 200, and the overlay
is daily with a length of six days, then the impact on the first day is 100, on the second day 120, and
then 140, 160, 180, and finally 200 on the sixth and final day.

2. By keeping the whole detailed distribution—The overlay saves the impact of each event-step
separately. It can be either precalculated, entered by the user, or mixed.

3. By calculating every time during the prediction (always calculated)—The impact of the overlay
is always calculated during the prediction. For successful calculation, the historical period should
include one or more events that are in the same overlay. The impact of the overlay is determined by
the prediction algorithm, according to historical data, and then used in prediction.

Ignoring Historical Data

Any event under an overlay type may have the Ignore Historical Data flag set, which specifies
whether the historical-data interval data that is covered by that event is used in calculations of
volume prediction or overlay impact (see Calculating Overlay Impact).

If an event does not have the Ignore Historical Data flag set, then the data that is covered by the
event is considered for prediction.

There is no additional processing of historical data that is affected by the event, other than ignoring it
or using it.

Calculating Overlay Impact

The impact of an overlay can be determined by analyzing historical data and is done by prediction
algorithm. The algorithm analyzes the period of historical data, which contains one or more events of
overlay that are to be calculated.

Overlays can be precalculated before starting volume forecasting or during volume forecasting (see
Distributing Event Impact). Given the same historical data and using the same method, the results
should be identical.

Multiplicative overlays are calculated by separating the seasonal component (yearly, daily, or intra-
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day) from the event impact for each event of the overlay in the given historical data. Then, the
impact is divided by event strength and averaged. When the impact is applied to an event on the
prediction interval, it is multiplied by the strength of that event.

In Overriding Overlays, the percentage of each event-step in the total of the whole event period is
calculated for each event, and then averaged.

For example, a historical period has two events in a daily overlay, which is 3 days long. The days of
the first event are 150, 200, 150 (30%, 40%, and 30% of the total, respectively), and the days of the
second event are 150, 150, 200 (30%, 30%, and 40% of the total, respectively). Each event-step (in
this case, a day) is averaged individually, and the overlay is calculated as 30%, 35%, 35%,
respectively.
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Calculate Distribution Wizard
Before using the Distribution wizard, read the Overlays Primer to understand how WFM calculates an
overlay's distribution and the overlay's impact on the forecast.

Use this wizard to calculate the distribution of an Overlay.

1. Open the Forecast module and select Overlays in the modules area.
2. Select an Overlay in the objects area.

Prerequisite: The Overlay property Always Use Entered Distribution must be selected.

3. Click Calculate Distribution ( ) or select Calculate Distribution from the Action menu.
The Calculate Distribution Wizard opens, and displays the following pages:

Select Activities Page

1. Select one or more Activities.
2. Select or enter a Start date and an End date in the Use Historical Data area.
3. Optional: check Use Overlap Templates to enable the Load Overlap Templates page (see below).
4. Click Next.

Load Overlap Templates Page

Select the overlap templates to use when calculating distribution. This page uses the same controls
as Load Forecast Overlap Templates in the Volumes Build Wizard.

Select Events Page

This page uses the same controls as the Select Events page in the Volumes Build Wizard, with
some differences. The grid at the top displays a list of events in the overlay ... but only events which
fall within the specified historical data date range. The grid has these columns:

Event—The event's name.

Start Date-Time—The event’s start date and time.

Enabled—Select this check box if the event should be considered for calculations.

Below the list are other controls:
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1. Select the events (configured for the overlay) to be used when calculating distribution.

Important
The controls for specifying impact that appear on the Select Events page in the Volumes Build Wizard) are
not displayed if the selected event belongs to an overlay that has one of these options specified on the
Properties tab: Always Use Entered Distribution, Always Calculate Disregarding Impacts and
Distribution.

2. Click the Distribution button to display the Distribution dialog, which contains the same controls and
presents the same data that appear on the Distribution tab.

The Distribution button is displayed if the selected event belongs to an overlay that has one of the
Always Use Entered Distribution option specified on the Properties tab.

3. Make your selections from the Distribution tab controls.
4. Click Finish.
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New Overlay Wizard
Use the New Overlay Wizard (NOW) to create overlays, but first watch the video.

Link to video
To create overlays:

1. Open the Forecast module and select Overlays.
2. In the Objects pane, select a Business Unit or Site.

3. Click New or select New from the Action menu.
The New Overlay Wizard opens and displays the following pages, in order

• Properties
• Usage
• Impact
• Impacted Activities

4. Select the appropriate controls on each page, remembering that some selections may deselect others.
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NOW: Properties Page
The New Overlay Wizard (NOW) opens and displays these pages, in order: Properties (this page),
Usage, Impact, and Impacted Activities. Be sure to watch the video.

1. Select the appropriate settings on this page, remembering that some selections may deselect others.
2. Click Next.

The settings on this page are:

Setting Description

Name field You can edit the selected Overlay's name in this
field.

This Overlay shall:
radio buttons

• Impact Forecast Values and Totals—Specify
that this overlay can impact the forecast by
changing forecast’s values and totals. This
option is the default.

• Redistribute Forecast Without Changing
Total—Specify that this overlay must preserve
a forecast’s total for specific period even while
changing the distribution of values inside that
period.

Spread Over: field

Displays the length of time that the selected
Overlay will occupy.

Edit this field and select one of the two radio
buttons Days or Hours to choose the units. The
value must be greater than 0 (zero) and the default
is 1.

This Overlay is Applicable To:
radio buttons

Select one of the two radio buttons IV or AHT to
choose whether the overlay applies to Interaction
Volume (IV) or Average Handling Time (AHT).
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NOW: Usage Page
The New Overlay Wizard (NOW) opens and displays these pages, in order: Properties, Usage (this
page), Impact, and Impacted Activities. Be sure to watch the video.

1. Select the appropriate settings on this page, remembering that some selections may deselect others.
2. Click Next.

The settings on this page are:

Setting Description

While Building A Forecast use This Overlay In
The Following Way: radio button group

• Calculate Using The Specified Initial and
Ending Impact—Use the specified initial and
ending impact when building a forecast. This
options is the default.

This option is missing from the display, and
thus disabled, if you selected This Overlay
Shall: / Redistribute Forecast Without
Changing Total (on the Properties page).

• Always Use Entered Distribution—Use the
specified (entered) distribution when building a
forecast.

• Always Calculate Disregarding Impacts and
Distribution—Use this overlay, but always
disregard impacts and distribution when
building a forecast.
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NOW: Impact Page
The New Overlay Wizard (NOW) opens and displays these pages, in order: Properties, Usage,
Impact (this page), and Impacted Activities. Be sure to watch the video.

Tip
This page appears only if you selected the radio button Calculate Using The
Specified Initial and Ending Impact on the Usage page.

1. Select the appropriate settings on this page, remembering that some selections may deselect others.
2. Click Next.

The settings on this page are:

Setting Description

Impact parameters of overlay fields

• Initial Impact field—Use this field to specify
the initial impact of the overlay. Range: 0 (the
default) and positive numbers.

• Ending Impact field—Use this field to specify
the ending impact of the overlay. Range: 0 (the
default) and positive numbers.

These fields are enabled only if the option
Calculate Using Specified Initial and
Ending Impact is selected.
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NOW: Impacted Activities Page
The New Overlay Wizard (NOW) opens and displays these pages, in order: Properties, Usage,
Impact, and Impacted Activities (this page). Be sure to watch the video.

1. Select the appropriate settings on this page, remembering that some selections may deselect others.
2. Click Finish.

This page contains the same controls and constraints as the Impacted Activities tab—a list of
Activities, each with its own with selectable check box.

The settings on this page are:

• Select the check box to the left of each activity in the list, to specify which activities will be impacted by
the selected factor. You can also select a site's check box to automatically select all activities below it.

• Clear the check box to specify no impact.
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Import
Workforce Management (WFM) collects historical data automatically. However, you can import
historical data manually on a regular basis, if necessary. For example, you might have a new Genesys
WFM installation and want to import previously collected historical data.

Accessing and Editing This View
Only users who have security rights to edit historical data and/or publish to Master Forecast can
access the Forecast > Import view.

Format is Important

Use the same column separator in the Import wizard as the one used in the .csv file. In the Import
wizard, this column separator is set by default and defined in the current regional settings. If you are
importing .csv files containing data whose format is defined by a different regional setting, and the
column separator in this file is different from default separator, change the column separator in the
Import wizard to match the separator used the .csv file.

You can import more than one type of data to a single file.

The data files must:

• be formatted according to regional settings.
• use 15-minute, 30-minute, 60-minute, or 24-hour (daily) timesteps. (If you are importing data to the

Master Forecast, use 15-minute and daily granularity only.)
• be ordered in ascending order by date.

The Data Import module imports the following data into WFM:

Master Forecast Historical Data
Interaction Volume data Historical Interaction Volume data
AHT data Historical AHT data
Calculated Staffing data (in Man-hours or FTE)
Required Staffing data (in Man-hours or FTE)

Exporting Data

You can also use WFM to export Forecasts and historical data collected by WFM. Use the Forecast
report to export data such as, Interaction Volumes or AHT forecasts, Staffing forecasts, Historical
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Interaction Volumes, and Historical AHT.

When using Data Importer to export historical data, take care to observe the format of the exported
files. They must be exported in .csv file format.
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Importing Data
Use the Import view in the Forecast module to import Historical Interaction Volume or
Historical AHT, Forecast Interaction Volume, Forecast AHT, and Forecast Staffing data.

Importing Data from a .CSV File

To import data:

1. In the Forecast module, click Import.
2. Expand the appropriate Site or Business Unit and choose the Activity for which you want to import

data.
3. In the Import Forecast Data pane, click Select File.

4. Click Import from file to select a .CSV file that contains the data you want imported.

Tip
When data for deferred activities is imported or exported using the 24-hours period, the data is imported for
each day using open hours like this:

• The day start is the previous overnight day end or 00:00, whichever is later.
• The day end is the overnight time end or 24:00 whichever is later.

5. From the Granularity drop-down list, select 15, 30, 60, or Daily.

Tip
WFM does not import data for the last timestep in the selected period if you select the 15-, 30-, or 60-minute
timestep. For example, assume your .CSV file contains data for the dates 4/15/2005 through 6/28/2005 in
15-minute timesteps. To completely import the data from every timestep, you must set the End Date to 6/29/
2005 and the End Time to 12:00 AM.

When WFM imports Historical data with 24-hours granularity, it takes into account only activity or multi-site activity open hours, because
the import file contains data for days only (one record per each day). Open hours acts as a filter. WFM does not use the Start Time and
End Time in the Select Dates page of the Import Wizard.

If the 15-, 30-, or 60-minute timestep is selected, data from the import file is filtered using the Start Date
and Time and End Date and Time.

6. From the Locale for Import drop-down list, select the locale.
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Tip
The Granularity parameter settings determines if the Time data type is offered in the Data Columns pane
to follow. Locale settings enable the date and time types to be parsed and used in later in the import process.

7. At the top of the pane, click Next .
You can select Back at any time is you need to return to the previous pane.

8. In the Select Data Columns pane, choose the column separator, either Character, Tab, or Space.
If you choose Character, you must enter a character in this field. For example, a comma.

9. In the Comments character field, enter a character that will indicate any lines in the .CSV file that
represent comments.
For example, a hash tag character.

10. In the Column Mapping to Data section, map the columns to the type of data you have in your .CSV
file.
The available data type columns are:
• Date
• Time
• Master Forecast IV
• Master Forecast AHT
• Historical Data IV
• Historical Data AHT
• Calculated Staffing, FTE
• Calculated Staffing, Manhours
• Required Staffing, FTE
• Required Staffing, Manhours

Tip
Non-historical data statistics are imported to the Master Forecast. Specified statistics appear only if the user
has appropriate security rights.

Different columns appear in the Column Mapping to Data section, depending on the column separator and comments character you
use. To view all applicable columns in this section, ensure that you select a separator that matches the one used in your .CSV file.

If you chose an incorrect data type for any column, the Review Validation pane opens, with an error
message.

11. At the top of the pane, click Next .
12. In the Select Dates pane, choose one of the following:

• Import everything—To import all of the data in the .CSV file.
• Import following date and time range—To specify the date and time ranges for the data you
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want to import.

13. After choosing either a or b in step 12, select the check boxes next to any days for which you want data
to be ignored.
For example, you might use setting to omit data from days when the activity is not open.

If a date and time range is not selected in step 12, by default the start time and date is the current day
and 12:00 am and the end time and date is the following day and 12:00 am.

14. At the top of the pane, click Import .
The Information dialog opens, indicating the data is being uploaded and the progress.

15. Click Cancel to end the operation, if necessary.
16. When the Information dialog indicates the data upload is done, click OK.

Use the Reports module to export data and create reports. See Forecast Report.
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Master Forecast

Tip
Starting in this release, WFM has a new interface for the Forecast module. If you have
landed on this page by accident and are using the new Supervisors interface, see the
"Master Forecasts" page in the Workforce Management Supervisor Help, which
describes the new Forecast module.

The views in the Master Forecast are:

• Master Forecast Volumes—Enables you to view the Master Forecast's Interaction Volumes and
AHT.

• Master Forecast Staffing—Enables you to view the Master Forecast's Calculated and Required
Staffing.

• Master Forecast Overheads—Enables you to view Overhead data, which WFM uses to forecast
shrinkage while scheduling.

• Master Forecast Graphs—Displays your choice of statistics for the Master Forecast, using line charts
and a table containing forecast values.

To open the views:

1. From the Home menu on the toolbar, select Forecast.
2. From the Forecast menu on the toolbar, select Master Forecast.
3. From the Master Forecast menu on the toolbar, select Volumes, Staffing, Overheads, or Graphs.
4. In the Objects tree, select an activity, multi-site activity, Site, Business Unit or Enterprise.
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Master Forecast Volumes View
Use the Volumes view to display the Master Forecast's Interaction Volumes and AHT. See the
toolbar image here the button descriptions below.

This view provides standard date-selection controls and a grid that shows statistics for days or
timesteps.

Displaying the Volumes View

To display the Volumes view:

1. From the Home menu on the toolbar, select Forecast.
2. From the Forecast menu on the toolbar, select Master Forecast.
3. From the Master Forecast menu on the toolbar, select Volumes.
4. In the Objects tree, select an activity, multi-site activity, Site, Business Unit, or Enterprise.

The view displays a graph above a table, each containing the same statistics, and controls that set
the data display properties for the graph and table.

Setting the Data Display Properties and Date Range

Use these controls to customize the data display in the graph and table:

• Period drop-down list—Change the time range for the graph and the grid by selecting Year, Month,
Week, or Planning Period.
If you select Week, you can further adjust each row's time range by selecting 15, 30, or 60 (minutes)
from the Granularity drop-down list.

• Show Statistics drop-down list—Specify what data is displayed in the graph and table by selecting
from these choices: Interaction Volume, AHT, Interaction Volume and AHT.

• Show Columns check boxes—Show (or hide) data columns in the table by selecting or clearing the
Volume, Volume %, and AHT check boxes.

• Use standard date-selection controls (in the upper right portion of the window) to jump to a different
week within the Master Forecast's date range.

Forecasts Master Forecast

Workforce Management Web for Supervisors Help 435



Reading the Data

The table provides columns that display the following statistics:

Week/Time Step
Identifies the range of dates or timesteps on this
row. (The column's label and contents depend on
the date range and granularity that you selected
above.)

[Days or Dates]

If you select the Month date range, each group of
columns shows statistics for one full day.
If you select the Week date range, each group of columns
indicates one date, the top row shows daily totals, and each
lower row shows statistics for one timestep on that date.

(Timestep durations depend on the granularity that you selected
above.)

IV Shows the interaction volume forecasted for each
day or timestep.

IV% Shows this row's percentage of the day's total
interaction volume.

AHT Shows the average handling time.

Weekly Totals
If you select the Month date range, these columns
show weekly totals, or averages, for the IV, IV%,
and AHT statistics.

Cleanup and Calculation Options

Choose these commands from the Actions menu or select their icons from the toolbar:

Icon Name Description

Cleanup

Opens the Cleanup Master
Forecast window, where you can
remove information from the
Master Forecast for selected
dates and activities.

Use Multi-Site Activities

Controls whether WFM Web's
calculation of aggregated
information includes multi-site
activities. You can select this
button only if you first select a
multi-site activity, Business
Unit, or Enterprise in the
Objects tree.
If you set this button to On, WFM retains
your last selection—in the current view
and for all other views that contain multi-
site activities—preventing you from
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Icon Name Description

having to click it every time you want to
display data for the selected multi-site
activity.
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Master Forecast Staffing View
Use the Staffing view to display the Master Forecast's Calculated and Required Staffing. See
the toolbar image here and the button descriptions below.

This view provides standard date-selection controls and a grid that shows staffing levels for days or
timesteps.

Displaying the Staffing View

To display the Staffing view:

1. From the Home menu on the toolbar, select Forecast.
2. From the Forecast menu on the toolbar, select Master Forecast.
3. From the Master Forecast menu on the toolbar, select Staffing.
4. In the Objects tree, select an activity, multi-site activity, Site, Business Unit, or Enterprise.

The view displays a graph above a table, each containing the same statistics, and controls that set
the data display properties for the graph and table.

Setting the Data Display Properties and Date Range

Use these controls to customize the data display in the graph and table:

• Period drop-down list—Change the time range for the graph and the grid by selecting Year, Month,
Week, or Planning Period from the Period drop-down list.
If you select Week, you can further adjust each row's time range by selecting 15, 30, or 60 (minutes)
from the Granularity drop-down list.

• Show Statistics drop-down list—Specifies what data is displayed in the graph and table. Select from
these choices: Calculated Staffing, Required Staffing, Calculated and Required Staffing.

• Show Columns check boxes—Show (or hide) data columns in the table by selecting or clearing the
Calc (calculations) and Req (requirements) check boxes.

• Use standard date-selection controls (in the upper right portion of the window) to jump to a different
week within the Master Forecast's date range.
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Reading the Data

The table provides columns that display the following statistics:

Week/Time Step
Identifies the range of dates or timesteps on this
row. (The column's label and contents depend on
the date range and granularity that you selected
above.)

[Days or Dates]

If you select the Month date range, each group of
columns shows statistics for one full day.
If you select the Week date range, each group of columns
indicates one date, the top row shows daily totals, measured in
Full Time Equivalents. Each lower row shows statistics for one
timestep on that date.

(Timestep durations depend on the granularity that you selected
above.)

Calc
Shows the calculated number of agents for each
day (measured in Full Time Equivalents) or for each
timestep (measured in single skill equivalents).

Req
Shows the required number of agents for each day
(measured in Full Time Equivalents) or for each
timestep (measured in single skill equivalents).

[Weekly Totals]
If you select the Month date range, the columns at
right show weekly totals for the displayed
statistics.

Save As Template, Cleanup, and Calculation Options

You can use the following buttons on the toolbar (these commands also appear in the Actions
menu):

Icon Name Description

Save As Template
Opens the Save as Template
Wizard, where you can save
Master Forecast data as a
forecast template.

Cleanup

Opens the Cleanup Master
Forecast window, where you can
remove information from the
Master Forecast for selected
dates and activities.

Use Multi-Site Activities

Controls whether WFM Web's
calculation of aggregated
information includes multi-site
activities. You can select this
button only if you first select a
multi-site activity, Business
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Icon Name Description
Unit, or Enterprise in the
Objects tree.
If you set this button to On, WFM retains
your last selection—in the current view
and for all other views that contain multi-
site activities—preventing you from
having to click it every time you want to
display data for the selected multi-site
activity.
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Master Forecast Overheads View
Use the Overheads view to view overhead data, which WFM uses to forecast shrinkage while
scheduling. See the toolbar image here and the button descriptions below.

Setting the Grid Properties and Date Range

Use these options in the Grid properties and Date Range panes (near the top) to customize the
grid:

• The grid displays data for a period of a year, month, week or planning period. To change the period,
click Year, Month, Week, or Planning Period in the Period drop-down list to change the time range
that is shown on each row. (WFM Web prompts you to save any unsaved edits before it refreshes the
display.)

• If you select Week, you can further adjust each row's time range by selecting a Granularity of 15, 30,
or 60 minutes.

• Use the standard date-selection controls to jump to a different week.

Overhead Menu

The Overhead drop-down menu displays a list of overheads:

Grand Total A read-only statistic; the aggregate overhead for
the selected target.

Total Planned A read-only statistic; the aggregate planned
overhead for the selected target.

Total Unplanned A read-only statistic; the aggregate unplanned
overhead for the selected target.

Important
Read-only statistics appear in the Overhead menu for the item that is selected in the
Object pane. If the item is an activity, then the menu lists all Schedule State Group
overheads that are associated with the activity. If the item is a multi-site activity, the
menu lists all Schedule State Group overheads that are associated with its child
activities.
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Using the Grid

The grid provides columns that display the following statistics:

Week/Time Step

Identifies the range of dates or timesteps on this
row.
(The column's label and contents depend on the date range and
granularity that you selected above.)

[Days or Dates]

If you select the Month date range, each group of
columns shows statistics for one full day.
If you select the Week date range, each group of columns
indicates one day.

(Timestep durations depend on the granularity that you selected
above.)

[Weekly Totals]
If you select the Week date range, the columns at
right show weekly totals for the displayed
statistics.

Tip
You can copy and paste data between the grid and a spreadsheet.

Managing Master Forecast Overhead Data

You can use the following buttons on the Actions toolbar (these commands also appear on the
Actions menu):

Icon Name Description

Cleanup

Opens the Cleanup Master
Forecast window, where you can
remove information from the
Master Forecast for selected
dates and activities.
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Master Forecast Graphs View
Use the Graphs view to display Master Forecast data in a line chart and a table containing forecast
values. See the toolbar image here and the button descriptions below.

Displaying the Graphs View

To display the Graphs view:

1. From the Home menu on the toolbar, select Forecast.
2. From the Forecast menu on the toolbar, select Master Forecast.
3. From the Master Forecast menu on the toolbar, select Graphs.
4. In the Objects tree, select an activity, multi-site activity, Site, Business Unit, or Enterprise.

The view displays a graph above a table, each containing the same statistics, and controls that set
the data display properties for the graph and table.

Setting the Data Display Properties and Date Range

Use these controls to customize the data display in the graph and table:

• Period drop-down list—Change the time range for the graph and the grid by selecting Year, Month,
Planning Period, Week, or Day.

• Granularity drop-down list—Specify the increments (granularity) in the data display by selecting from
this menu. What choices are available depends upon your selection in the Period drop-down list:
• If you select Year: Monthly, Weekly, or Daily.
• If you select Month: Weekly or Daily.
• If you select Planing Period: Weekly or Daily.
• If you select Week: 15 (minutes), 30 (minutes), 60 (minutes), or Daily.
• If you select Day: 15 (minutes), 30 (minutes), or 60 (minutes).

• Show Statistics drop-down list—Specifies what data is displayed in the graph and table. Select from
these choices: Interaction Volume, AHT, Interaction Volume and AHT, Calculated Staffing,
Required Staffing, Calculated and Required Staffing, Calculated and multi-skill calculated
staffing. Columns in the table are displayed accordingly to the selected statistic.
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• Use standard date-selection controls (in the upper right portion of the window) to jump to a different
week within the Master Forecast's date range.

Reading the Data

The graph shows the statistics, dates, period, and granularity that you selected above. The vertical
axis indicates the units shown. If you display multiple statistics, the right and left vertical axes display
different units for the two statistics.

The Legend, at the bottom, identifies the colors that the graph uses to represent particular statistics,
events, or historical data. The Legend changes depending on the statistics you selected above.
Special events appear as markers on the graph.

Cleanup, Calculation, and Options

You can use the following buttons on the toolbar (these commands also appear in the Actions
menu):

Icon Name Description

Cleanup

Opens the Cleanup Master
Forecast window, where you can
remove information from the
Master Forecast for selected
dates and activities.

Use Multi-site activities

Controls whether WFM Web's
calculation of aggregated
information includes multi-site
activities. You can select this
button only if you first select a
multi-site activity, Business
Unit, or Enterprise in the
Objects tree.
If you set this button to On, WFM retains
your last selection—in the current view
and for all other views that contain multi-
site activities—preventing you from
having to click it every time you want to
display data for the selected multi-site
activity.

Options
Opens the Options dialog box,
where you can further customize
the graph.
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Options for the Master Forecast Graphs
Use the Options dialog box to customize the display of the Master Forecast Graphs view:

1. Select a statistic from the Show Statistics drop-down list.
2. Click Options on the toolbar.

One of the following versions of the Options dialog box opens, depending on the statistic that you
selected above.

• Click the link for a Help topic listed in the table. This takes you to an explanation of the options available
for that statistic in the Options window.

Statistic selected Help topic for the corresponding Options
dialog box

Interaction Volume Graph View Options (IV)
AHT Graph View Options (AHT)
Interaction Volume and AHT (not available in
the Historical Data Graphs view) Graph View Options (IV and AHT)

Required Staffing (not available in the Historical
Data Graphs view) Graph View Options (Staffing)

Calculated Staffing (not available in the
Historical Data Graphs view) Graph View Options (Staffing)

Calculated and Required Staffing (not available
in the Historical Data Graphs view) Graphs View Options (Staffing)
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Cleanup Master Forecast Window
Use the Cleanup Master Forecast window if you need to remove information from the Master
Forecast for specific dates and activities.

Warning
This feature deletes all data that was saved for the selected date range and activities.
Genesys recommends that you do not use the Cleanup Master Forecast feature
unless it is absolutely necessary. If you must remove Master Forecast data, Genesys
recommends that you first extract the data to a forecast scenario (using the Publish
Forecast Wizard), and/or make a backup of the WFM database.

To remove Master Forecast information:

1. In the Start date and End date pane, select the range of dates for which you want to remove data,
using the standard date selectors.

2. From the Activities list, select the activities whose forecast information you want to remove.
You can expand business units to display their sites and you can expand sites to display their activities.
You can select multiple activities across sites.

3. Click OK to remove the Master Forecast information that you have specified, or click Cancel to close
the window without changing the Master Forecast.
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Historical Data

Tip
Starting in this release, WFM has a new interface for the Forecast module. If you have
landed on this page by accident and are using the new Supervisors interface, see the
"Building Volumes" page in the Workforce Management Supervisor Help, which
describes the new Forecast module.

The views in Historical Data are:

Historical Data Volumes
Displays Interaction Volumes and AHT for
historical data that has either been imported into
WFM or collected automatically by WFM Data
Aggregator.

Historical Data Graphs
Displays your choice of statistics, using line charts
and a table, for historical data that has either been
imported into WFM or collected automatically by
WFM Data Aggregator.

To open these views:

1. From the Home menu on the toolbar, select Forecast.
2. From the Forecast menu on the toolbar, select Historical Data.
3. From the Historical Data menu on the toolbar, select Volumes or Graphs.
4. In the Objects tree, select an activity, multi-site activity, Site, Business Unit, or Enterprise.
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Historical Data Volumes View
Use the Volumes view to display interaction volumes within imported or collected historical data.
This view provides standard date-selection controls and a grid that shows statistics for days or
timesteps. See the toolbar image here and the button descriptions below.

Displaying the Volumes View

To display the Volumes view:

1. From the Home menu on the toolbar, select Forecast.
2. From the Forecast menu on the toolbar, select Historical Data.
3. From the Historical Data menu on the toolbar, select Volumes.
4. In the Objects tree, select an activity, multi-site activity, Site, Business Unit, or Enterprise.

The view displays a graph above a table, each containing the same statistics, and controls that set
the data display properties for the graph and table.

Setting the Data Display Properties and Date Range

Use these controls to customize the data display in the graph and table:

• Period drop-down list—Change the time range for the graph and the grid by selecting Year, Month, or
Week. If you select Week, you can further adjust each row's time range by selecting 15, 30, or 60
(minutes) from the Granularity drop-down list.

• Show Statistics drop-down list—Specify what data is displayed in the graph and table by selecting
from these choices: Interaction Volume, AHT, Interaction Volume and AHT.

• Show Columns check boxes—Show (or hide) data columns in the table by selecting or clearing the
Volume, Volume %, and AHT check boxes.

• Use standard date-selection controls (in the upper right portion of the window) to jump to a different
week within the Master Forecast's date range.
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Reading the Data

The table provides columns that display the following statistics:

Week/Time Step
Identifies the range of dates or timesteps on this
row. (The column's label and contents depend on
the date range and granularity that you selected
above.)

[Days or Dates]

If you select the Month date range, each group of
columns shows statistics for one full day.
If you select the Week date range, each group of columns
indicates one date, the top row shows daily totals, and each
lower row shows statistics for one timestep on that date.

(Timestep durations depend on the granularity that you selected
above.)

IV Shows the interaction volume forecast for each day
or timestep.

IV% Shows this row's percentage of the day's total
interaction volume.

AHT Shows the average handling time.

Weekly Totals
If you select the Month date range, these columns
show weekly totals, or averages, for the IV, IV%,
and AHT statistics.

Tip
You can copy and paste data between the grid and a spreadsheet. Before doing so,
clear the Volume % checkbox so the IV% column is hidden.

To Edit the Weekly Totals

If you selected the period Year or Month, you can click inside the Weekly Totals cell and edit the
value there. Daily values in the same row will automatically adjust their values so that the new
Weekly Total is redistributed according to the original distribution of volume for each day of the
week. This is useful if you have a week, in which you believe the volume will be increased, but you
expect the volume to arrive at about the same rate as in your original forecast, day-over-day.

Save and Calculation Options

You can use the following buttons on the toolbar (these commands also appear in the Actions
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menu):

Icon Name Description

Save

Save changes that you have
made to the data.
Save appears in the toolbar and in the
Actions menu only if you have
permission to edit historical data. To set
that permission:

1. In the Configuration module,
select Roles > Role
Privileges.

2. In the Forecast Role
Privileges view, select Edit
Historical Data check box.

3. Click Save.

Save As Template

Opens the Save as Template
Wizard, where you can save
historical data as a forecast
template.
When you save historical IV or AHT for a
multi-site activity as a template, only
multi-site activity data are saved, never
the sum of underlying activities.

Use Multi-Site Activities

Controls whether WFM Web's
calculation of aggregated
information includes multi-site
activities. You can select this
button only if you first select a
multi-site activity, Business
Unit, or Enterprise in the
Objects tree.
If you set this button to On, WFM retains
your last selection—in the current view
and for all other views that contain multi-
site activities—preventing you from
having to click it every time you want to
display data for the selected multi-site
activity.

Find Events Wizard
Icon Name Description

Find Events
Click this button (or select Find
Events from the Actions menu)
to search for special events in
historical data, using the Find
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Icon Name Description
Events Wizard.
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Find Events Wizard
Use the Find Events Wizard to search through historical data for any period of time that represents
an anomaly. For example: imagine that the AHT on May 24, 2008, between 8 p.m. and 9 p.m. was
500% higher than on the historical norm for those hours. That is an anomaly in the historical data,
and the Find Events Wizard could locate it for you.

1. To reach this dialog, start at the Historical Data Volumes view.

2. Click Find Events in the toolbar or select Find Events from the Actions menu.
3. Use these controls to define the search:

Search radio buttons

Define the search metrics.
Select IV to search for events that affected Interaction
Volume.
Select AHT to search for events that affected Average
Handling Time.

Search using granularity
radio buttons

Define the search increments.
Select Daily to search through daily data.
Select Hourly to search through hourly data.

Start date and End date
fields

Define the search limits.
Enter or select a Start date and an End date.
The search will begin at the start date and end at the end date.

Threshold (%) field

Define the search criteria.
Enter or select the percentage of deviation from historical data,
that would identify the event you want to locate. Range: A
positive integer less than 1000.

For example, you would enter 500 to search for an anomaly that
is at least 500% of normal.

Running the Find Events Wizard

1. Define the search using the controls described above.
2. Click Find Events (or click Cancel to abandon the search).

A new tab in the right-hand portion of the window displays these items

• a Possible Events list
• the Create Overlay and Create Event buttons
• an Existing Events list

3.
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Select an item in the Possible Events list.
• The Create Overlay and Create Event buttons are enabled.
• All Overlay/Event items that occur within the date range of the selected Possible Event are

displayed in the Existing Events list.

Now you can create an overlay (and the event that it must contain) or create an event (and
select the existing overlay that must contain it).

4. Choose one of two options:
1. Click Create Overlay to open the New Overlay Wizard, where you create a new overlay and specify

its event’s parameters in the New Event page.
2. Click Create Event to open the New Event page, where you select an existing overlay and set the

event’s parameters.

Existing Events List

When you are finished, the wizard or page closes and the newly created overlay/event will appear in
the Existing Events list, if its Impact Start Date/Time occurs within the date range of the selected
Possible Event.

Otherwise, the overlay/event exists, but it is not displayed.
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New Event Page
The New Event page opens from the Find Events screen when you click the Create Overlay
button (as the final page of the Create New Overlay Wizard) or the Create Event button.

1. Select the appropriate settings on this page, remembering that some selections may deselect others.
2. Click Next.

The settings on this page are:

Event Name field
Letters, numbers, and symbols are all acceptable
in this field. If you enter the name of an existing
event, this new event will overwrite it.

Impact Start Date spinner Enter or select the future date that the event is to
start.

Impact Start Date spinner
Enter or select the time that the event is to start,
on the date you specified in the Impact Start
Date field.

Strength field
Enter the strength of the event. The range is any
positive value (greater than 0), up to nine digits
and two decimals.

Disregard Historical Data check box
Select this check box if the event should
disregard historical data. Clear the check box to
consider historical data. See Ignoring Historical
Data in the "Overlays Primer" topic.
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Historical Data Graphs View
Use the Graphs view to display historical data in a line chart. See the toolbar image and the button
descriptions below.

Displaying the Graphs View

To display the Graphs view:

1. From the Home menu on the toolbar, select Forecast.
2. From the Forecast menu on the toolbar, select Historical Data.
3. From the Historical Data menu on the toolbar, select Graphs.
4. In the Objects tree, select an activity, multi-site activity, Site, Business Unit, or Enterprise.

Setting the Dates, Statistics, Period, and Granularity

Use these controls to customize the data display in the graph and table:

• Period drop-down list—Change the time range for the graph and the grid by selecting Year, Month,
Week, or Day.
Which options appear in the Granularity drop-down list depend on the value selected in the Period
drop-down list.

• Show Statistics drop-down list—Specify what data is displayed in the graph and table by selecting
from these choices: Interaction Volume, AHT.

• Use standard date-selection controls (in the upper right portion of the window) to jump to a different
week within the Master Forecast's date range.

Reading the Graph and Legend

The graph shows the statistics, dates, period, and granularity that you selected. The vertical axis
indicates the units shown.

The Legend, at the bottom, identifies the colors that the graph uses to represent particular statistics.
The Legend changes depending on the statistics that you select.
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Calculation and Filtering Options

You can use the following button on the Actions toolbar (this command also appears in the Actions
menu):

Icon Name Description

Use Multi-Site Activities

Controls whether WFM Web's
calculation of aggregated
information includes multi-site
activities. You can select this
button only if you first select a
multi-site activity, Business
Unit, or Enterprise in the
Objects tree.
If you set this button to On, WFM retains
your last selection—in the current view
and for all other views that contain multi-
site activities—preventing you from
having to click it every time you want to
display data for the selected multi-site
activity.
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Schedules
Get an overview of the Schedule module by reading through the topics on this page. Before creating
a schedule, you should:

1. Configure forecast scenarios.
2. Create, build and publish a staffing forecast for each activity you plan to schedule.

Tip
A single forecast scenario can contain forecasts for multiple activities.

You can create a schedule before publishing a forecast, but many schedule functions (such as
Coverage) will be unavailable.

Using the Schedule Module

The Schedule module displays agent schedule information in a variety of tables and graphs.

Use the Schedule views to:

• Create schedule scenarios, including profile scenarios, which can be used for Schedule Bidding.
• Build the Schedule.
• Publish schedule scenarios to, and extract them from, the Master Schedule.
• View weekly and daily schedules for your scenarios and the Master Schedule.
• Evaluate schedule coverage for your scenarios and the Master Schedule.
• Revise schedules as circumstances require.
• Create, view, edit, remove, and commit pending schedule changes.
• Assign agents to profile schedules, if your scenario includes them.

Schedule Security

You might have full access to all parts of the Schedule module or you might have limited access,
depending on the settings configured for your Security Role. See Roles.

If you do not have permission to access certain schedule functions, that functionality is disabled.
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About Scheduling

The Schedule module helps you make the most efficient use of personnel, enabling you to adjust
schedules in real time, as workload or agent availability changes. The Schedule module builds
optimal schedules based on real agents, incorporating their exceptions and preferences into the
scheduling process.

Workforce Management builds optimal schedules within a site’s business constraints.

Constraints include:

• Available resources with required skills.
• Service-level requirements.
• Employment contracts and business policies.
• Agent preferences.

Profile Scheduling: Creating Schedules Without Agents

Profile scheduling enables you to model schedule outcomes without having actual agents.

You can create schedules based on user&mash;defined profiles and then assign agents to the
resulting schedules; or you can create schedules using a mix of real and profile agents.

Use profile scheduling whenever you want to create a schedule before you actually hire agents.

1. Use WFM Web to define profiles, which consist of contract working rules and a skill set.
2. Use the Schedule module to create schedules, using profiles appropriate to the work and to your

anticipated hires.
3. Assign newly hired agents to the open slots in the profile schedules.

Tip
You must assign real agents to profile schedule slots before you can publish those
schedule slots to the Master Schedule.
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Using the Schedule Scenarios View

The Scenarios view enables you to open existing scenarios and work with them. It also enables you to
create, edit, or delete schedule scenarios, and to publish them to the Master Schedule.

To display the Scenarios view:

1. Select Schedule from the Home menu on the toolbar.
2. Select Scenarios from the Schedule menu on the toolbar.

Using Other Scenario Views

When you open a scenario, the scenario's name becomes a menu in the toolbar, and an item in the
Schedule menu. The following views appear in that menu: Coverage, Weekly, Intra-Day, Agent-
Extended, Profiles/Bidding, Summary, and State Group Totals.

To open a view for that scenario, select it from the <scenario_name> menu.

Opening additional scenarios adds their names to the Schedule menu. Use the Schedule menu to
switch between several open scenarios.

To remove a scenario's views from the displayed lists, close that scenario.

Using the Master Schedule Views

If you have access rights to the Master Schedule, then you can select Master Schedule from the
Schedule menu. Master Schedule becomes a menu in the toolbar, from which you can select any of
the following Master Schedule views: Coverage, Weekly, Intra-Day, Agent-Extended, Summary,
State Group Totals and Overtime Requirement. The Changes Approval view is listed only if you have
the permission to Approve Changes in WFM Web.

To open one of these Master Schedule views, select it from the menu.

Pending Schedule Changes

If you do not have security permission to Approve Changes, any edits you make to a schedule
scenario or the Master Schedule are entered as pending. That is, they are visible only to you and do
not appear in the publically-visible version of the schedule scenario or the Master Schedule until a
user who has the Approve Master Schedule Changes permission reviews and approves them.

• If you publish a schedule scenario to the Master Schedule, pending changes are not published.
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• If you extract data from the Master Schedule to a scenario, the pending changes do not appear in the
scenario.

Approving Pending Changes

There are a number of ways to view and approve or reject pending schedule changes. If the pending
changes were created by another user, you can use:

• The Master Schedule Changes Approval view.

If the pending changes were made by you, then you can use:

• The Master Schedule Changes Approval view.
• The Commit/Rollback Multiple Wizard.
• The Commit and Rollback commands from the shortcut menus in the Schedule Scenario Intra-Day

view and Master Schedule Intra-Day view.
• The auto-commit feature in the Insert Multiple Wizard and the Delete Multiple Wizard.

Schedules Historical Data

Workforce Management Web for Supervisors Help 460



Schedule Scenarios
Use the Scenarios view in the Schedule module to create new scenarios or edit an existing schedule
scenario. When you open a scenario, that scenario's name becomes a menu on the toolbar (and a
selection in the Schedule menu). You can then select the following views from the
<scenario_name> menu:

Coverage
Compares staffing coverage to forecasted
(calculated and required) staffing data, and
highlights overstaffed or understaffed timesteps.

Weekly
Displays a weekly summary table of total paid
hours, working start/end times, or shift names for a
site's agents and/or profiles.

Intra-Day

Displays schedule details for a 24- or 36-hour
period, enabling you to modify schedules for
individual or multiple agents.

Important
You do not need the Approve Changes security
permission (as required by the Master Schedule) to
commit your changes (which are only visible to you).
You can roll back or remove your own pending
changes.

You can view your pending changes in the Weekly, Intra-Day,
and Agent-Extended views.

Agent-Extended Displays schedules for one week or the schedule
planning period for a single agent.

Profiles/Bidding Enables you to assign real agents to profile
schedule slots.

Summary Displays service-level and related statistics for the
scenario.

State Group Totals Presents Schedule State Group Totals for the
configured Schedule State Groups.

To open a scenario's views, select it from the submenu. Click Close to close it.

Important
Some restrictions apply when viewing and deleting Schedule scenarios:

• Users must have access to at least one Site in the Schedule scenario to see it.
• Users must have access to all Sites in the Schedule scenario to delete the scenario.
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For more information about other restrictions, see the WFM Server Application [ConfigService]
MSARestrictAccess configuration option description in the Workforce Management Options Reference.
The settings in this option determine the level of access to multi-site activities in Schedule scenarios.
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Scenarios View
Use Schedule Scenarios to open and work with new and existing schedule scenarios.

This view enables you to create, edit, or delete schedule scenarios, and to publish scenarios to the
Master Schedule.

Displaying the Scenarios View

To display the scenarios view:

1. From the Home menu on the toolbar, select Schedule.
2. From the Schedule menu on the toolbar, select Scenarios.

The Scenarios table (a list) appears at the top of the Data pane.

Opening a Scenario

To open a scenario, double-click it or select it and click Open .

When the Scenarios view is active, the Objects pane displays the following options:

My Scenarios Displays scenarios that you have created.

Shared Scenarios
Displays shared scenarios created by other users.
Visible only if you have the permission Access
Shared Scenarios. See the security access rights
in Roles.

Other Scenarios Displays (if you have appropriate access rights)
unshared scenarios created by other users.

To select an option:

• Click it. Your selection displays the matching scenarios in the Scenarios table.

Reading the Scenarios Table

The Scenarios table appears at the upper right of the WFM Web for Supervisors window. Its rows
display scenarios that match your selection in the Objects tree. The columns (sortable except for
Comments and Extended End Date) display the following information for each scenario:
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Name The scenario's name.

Start date, End date The start and end dates for the schedule in this
scenario. Range: from 1 to 6 weeks.

Extended End date

Specifies the time period from the currently-
published Forecast that will be used to calculate
the average staffing needs for this schedule. For
example: the schedule itself covers only the time
period between Start date and End date, but the
Forecast data used to calculate staffing needs for
the schedule is based on the time period between
Start date and Extended End date.

Tip
It's okay if the Forecast data covers a shorter period
of time than Extended End Date defines.

Owner The name of the user who created the scenario.

Shared A check mark indicates a shared scenario; an open
box indicates one that is not shared.

Comments Remarks entered by a user who created or edited
the scenario.

To populate the Data pane with the scenario's details:

• Click a row in the Scenarios table.

Editing a Scenario

To edit a scenario:

• Double-click the scenario in the Scenarios table. Or click its row in the Scenarios table, and then click
Open.

The controls described below are available to you if you own, or have access rights to, the scenario.

Creating and Managing Scenarios

You can use the following buttons on the toolbar (these same commands also appear on the Actions
menu):

Icon Name Description

New Opens the New Schedule
Scenario Wizard.
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Icon Name Description

Create based on...

Opens the New Schedule
Scenario Wizard. The data in the
wizard pages is copied from the
scenario that was highlighted
when you clicked this icon.

Open
Opens the selected scenario from
the Scenarios table. You can
then edit its properties using the
Data pane.

Close
Closes the open scenario (and
prompts you to save unsaved
data).

Publish

Opens the Publish Schedule
Wizard for transferring schedule
information between the selected
scenario and the Master
Schedule.

Delete Deletes the selected scenario.
Includes a confirmation.

Mark as Shared,
Mark as Not Shared

Changes the sharing status of
the selected scenario.

Filter

Displays the Statuses Filters
dialog box, which you can use to
control which Statuses are
displayed. These Statuses are
described below.

Sort

Opens a sorting dialog box that
allows sorting by Name, Owner,
Sharing, Time of creation,
Time of last modification,
Scenario start date, and
Scenario end date. You can
sort in ascending or descending
order.

Scenario Properties—Data Tab

To display the following controls:

• Click the Data tab on the Scenario Properties pane at the lower right.

Name Click inside to edit the scenario's name.
Start date, End date Displays the scenario's start and end dates.
Extended End date Displays the scenario's extended end date.
Owner Displays the name of the scenario's creator.
Shared Display only; a check mark indicates a shared
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scenario; an open box indicates one that is not
shared.

Created, Modified Displays the scenario's original creation date and
last modification date.

Forecast Displays the associated forecast scenario or
MASTER (if the Master Forecast is associated).
Click this button to display a pop-up list of forecast
scenarios, then select one upon which to base the
next schedule build. The table lists all forecast
scenarios that you can select, to base the next
schedule build upon. The first choice is MASTER.
This list is not editable, and it contains the following columns for
each forecast scenario that is listed: Name, Start Date, End
Date, Owner, Shared, and Comments.

Comments Click inside to enter or edit comments about the
scenario.

Save
Click this button to save your changes to the
scenario's name and/or comments. Disabled if
there are no changes.

Cancel
Click this button to cancel your changes, restoring
the scenario's previous name and/or comments.
Disabled if there are no changes.

Scenario Properties—Statuses Tab

To display a table with the following information, click the Statuses tab on the Scenario Properties
pane at the lower right. This table's columns are:

Site Displays the sites covered by this scenario.

Status See the Status Column Values table below for all
possible values and their definitions.

Bidding Start
Bidding start date for this scenario, defined in
Control Bidding Process Wizard. (Exclusive to
bidding scenarios).

Bidding End
Bidding end date for this scenario, defined in
Control Bidding Process Wizard. (Exclusive to
bidding scenarios).

Ranking Used
Ranking system used for this scenario, defined in
Auto-Assign Schedules dialog. (Exclusive to
bidding scenarios).

Last Published Date and time that this scenario was last published
to the Master Schedule.
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Status Column Values
This table defines each possible value that may appear in the Status column.

New This scenario was just created and has no schedule
built for it.

Imported This scenario was imported from the Master
Schedule.

Scheduled A schedule was built for this scenario.

Scheduled with Profiles A schedule containing profile agent schedules was
built for this scenario.

Profiles Assigned
A schedule containing profile agent schedules was
built for this scenario, and every profile agent
schedule has an actual agent assigned.

Published This scenario was published to the Master
Schedule.

Bidding Pending Scenario
This scenario has a bidding window and agents
defined, but the current date is before the bidding
window's start date. (Exclusive to bidding
scenarios).

Open for Bidding This scenario is currently open for bidding.
(Exclusive to bidding scenarios).

Bidding Closed This scenario is closed for bidding. (Exclusive to
bidding scenarios).
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New Schedule Scenario Wizard
Use the New Schedule Scenario Wizard to create a new schedule scenario:

1. On the Schedule Scenarios view toolbar, click New.
The wizard opens to the General Parameters screen.

2. Fill in the necessary information on each screen (for details, see General Parameters), and then click
Next.
• Clicking Help on any screen opens a Help page that explains that screen's options.
• Clicking Back returns you to the previous screen, if you need to revise your entries there.

3. Click Finish.
The scenario is created.

In the Schedule Scenarios view, you can now select My Scenarios to load the scenario into the
Scenarios table.
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New Schedule Scenario: General
Parameters
To fill in the first New Schedule Scenario Wizard's General Parameters screen:

1. In the Name text box, enter a name for the schedule scenario.
2. If you want this scenario to be available to other WFM users, select the Shared check box.
3. If you want to base this scenario on one that already exists, select the existing scenario from the Based

on drop-down list.
Basing your new scenario on an existing scenario is a convenient way to build schedules with
frequently used settings. The wizard takes the dates, activities, and agents (real, virtual, and profile)
from the source scenario and applies them to the new scenario. You can then change these
parameters.

4. In the Start Date field, enter (or select) the scenario's start date.
You can type directly into the field, use the up or down arrow to modify the displayed date, or click the
button at the right to display a calendar.

Important
If the WeekStartDay setting has been specified in Business Units Properties, your scenario's starting weekday
must match this setting. Otherwise, your scenario starts on the first weekday as determined by your
operating system's regional settings.

5. In the End Date field, enter (or select) the scenario's end date. The maximum time between Start
date and End Date is 42 days (6 weeks).

Important
You must build the scenario in units of one week. For example, if the schedule starts on a Monday, it must end
on a Sunday. Schedules must be at least one week, and no more than six weeks, long. WFM Web always
obeys schedule period constraints, if you are using a scheduling period for your site, regardless of the number
of weeks in the scenario.

6. In the Extended End Date field, enter (or select) the scenario's extended end date, if necessary.

Important
Default value: the scenario’s end date. This value is useful when you create a schedule scenario for bidding.
(Use the Profiles/Bidding view to configure bidding.) Edit this value manually to specify an extended end date

for the scenario ...to specify that the schedule will apply over a longer period of time (maximum: 6 months).
For example, Extended End Date could define an entire quarter—3 months. Start Date and End Date could define a period of 1 week
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that Agents actually use for bidding. When the schedule scenario is published to the Master Schedule, the 1-week schedule would be
repeated for the entire quarter.

You can also use this value to extend a non-bidding schedule for real agents in the same way: create a 1-6
week schedule that repeats itself over a longer period of time. When you publish this schedule scenario out
into the future, you can optionally ask WFM to overlay items from the Calendar, such as days off, time off,
and exceptions.

7. Optional: Enter text into the Comments field.
8. Optional: Select the Use forecast data from forecast scenario check box to specify that the

schedule will be built based on a forecast scenario, instead of on the Master Forecast.
If you select this check box, the next wizard screen will be the Select Forecast Scenario dialog box.

9. Click Next to proceed to the next screen.
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New Schedule Scenario: Select Forecast
Scenario
In the New Schedule Scenario Wizard, select a forecast scenario from the list, to specify that the
next schedule build will be based upon it.

This list is not editable, and it contains the following columns for each forecast scenario that is listed:
Name, Start Date, End Date, Owner, Shared, and Comments.

Important
You can also reach this dialog box by clicking the button that appears next
to the Forecast field in the Schedule Scenarios view. In this case, the first choice in
the list is MASTER, to specify that the schedule will be built based upon the published
Master Forecast.
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New Schedule Scenario: Select Activities
To fill in the Select Activities screen of the New Schedule Scenario Wizard:

1. Select all activities that you want to include in this schedule.
2. In the Activities list, you can expand business units to display their sites and expand sites to display

their activities.

Tip
You can select any number of activities or add activities later, but you can add them only for the sites that
you select now, on this screen. If you checked Use forecast data from forecast scenario in the General
Parameters screen of this wizard and selected a Forecast scenario in the Select the Forecast Scenario
screen, all activities from the Forecast scenario are automatically selected in this screen.

3. Optional: Select the Additionally Filter Agents By Contracts check box to enable the Filter By
Contracts page, which appears next when enabled.

4. Click Next to proceed to the next screen.

Week Start Day Validation

WFM applies the following validation rules:

• If you select activities from two BUs with different week start days, the following warning appears:
It is not possible to create schedule scenario for selected business units because they have different
week start days. You must select BUs with the same week start day to proceed.

• If you select BUs that have the same week start day, but select a scenario start date that is not the first
week start day, the following warning appears and will not allow you to proceed:
Selected scenario start date does not match selected business unit(s) week start day, <week day
name>. Please, return to previous page and select appropriate start date.

The New Schedule Scenario Wizard date selection controls use the locale settings and does not
attempt to enforce the week start day.
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New Schedule Scenario: Filter By Contracts
This page appears in the New Schedule Scenario Wizard only if you selected the Additionally Filter
By Contracts check box in the Select Activities screen.

1. Select one or more contracts from the tree, which includes business units, sites, and contracts.

Important
The tree shows only those contracts that the scenario included when it was created and, by default, all
contracts matching the activities that are selected on the Select Activities screen, are selected

.
2. Click Next to proceed to the next screen.
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New Schedule Scenario: Add Agents
To fill in the Add Agents screen of the New Schedule Scenario Wizard:

1. Select the agents that you want to include in the scenario.
In the Agents list, you can expand Business Units to display their sites and expand sites to display
their agents. The list shows only those agents who have the skills that are required for the activities
you selected on the Select Activities screen.

2. To fill the new scenario with the schedules from the source (Based on) scenario, select the Copy
Schedules check box.

3. To insert a granted exception, time off or day off item from the calendar, select the Insert granted
exception, time off and day off calendar items check box.

Tip
You can insert multiple items. However, this check box is enabled only if the following conditions are met:

• The scenario you are creating is based on an existing scenario.
• The Copy Schedules check box is selected.

4. Click Next to proceed to the next screen.
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New Schedule Scenario: Add Profile Agents
In the New Schedule Scenario Wizard's Add Profile Agents, Based on Real Agents screen, Profile
Agents are generic agents that you create by omitting preferences and exceptions.

About Scheduling with Profiles

You can create schedule scenarios using a mix of real agents and profiles. You can also create
schedule scenarios based on user-defined profiles, and then assign agents to the resulting schedules.
See the Scenario Profiles view for instructions.

When you use profiles, you generate a schedule scenario that includes open schedules. An open
schedule is one that has no agents assigned to it. You can then insert agents into the open schedules
using any criteria. (WFM automatically filters the list of qualified agents, based on the selected
schedule.)

Agents are displayed in a tree, which is inside a table with these columns:

• Agents—Each agent's name.
• Present—The number of agent profiles, based on this real agent, that are already present in scenario.

This number is read-only.
• Add—Select the check box in this column to add this agent's profile to the scenario. Clear the check box

to not add the profile. As a shortcut, you can select a single check box for any branch of the
tree—business unit, site, or team—to select all items beneath it.

To add profile agents who are based on real agents into the same team as real agents:

1. Select or clear individual agent check boxes, as needed.

Tip
A profile agent inherits the contract and skill set of the selected real agent, but the profile agent's schedule
slot is not assigned to this (or any other) real agent. Use profile agents when you create a bidding scenario.
See the topic Configure Bidding Scenario in the Schedule Bidding section.

2. Select or clear the Place Profile Agents, Based On Real Agents, Into Their Teams check box.
3. Click Next to proceed to the next screen.
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New Schedule Scenario: Add Profiles
To fill in the final New Schedule Scenario Wizard's Add Profiles screen:

1. Expand and/or scroll through the Profiles list to select the number of each type of Contract profile that
you want to include in this scenario.
You can expand business units to display their sites and expand sites to display their profiles. The list
shows only those profiles that have the skills that are required for the activities you selected on the
Select Activities screen.

2. Modify (if necessary) the number of occurrences each profile that should be included in the scenario.
3. Click Finish.

This saves your new scenario and restores the Schedule Scenarios view.

Add Profiles vs. Add Profile Agents

Here is the difference between the profiles on this screen, and the profiles on the previous screen:

• On the previous Add Profile Agents screen, you have the opportunity to select profile agents. This will
result in the schedule scenario including open schedules, based on hypothetical agents that are similar
in skill set and Contract to the agents whose profile you select.

• On the Add Profiles screen, you are selecting profiles. A profile is based on a Contract, and is defined
by a set of one or more skills and skill levels that are required for an agent to fit this profile. When
creating a schedule, you can include any combination of real agents, profile agents, and profiles.
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Building Schedule Dialog
The Building Schedule dialog appears after you click Finish in the Schedule Build Wizard. This
dialog displays the schedule building progress and basic information about the built schedule
scenario.

The Schedule Information section, contains information about the schedule, such as the sites that
are included in this build, the number of days in the schedule scenario, he number of agents, and the
schedule start date.

The Build Progress section contains status information, such as the start time, the elapsed time,
and the Current Status, indicating how the build is proceeding. After the schedule is built, the
Current Status changes to Done and you can review any messages that were generated during the
schedule building process. The number of messages is displayed in the bottom section of the dialog.
Other information in this section includes, the number of iterations of the schedule, the minimum,
maximum, and probable Agent Count Range used in this schedule build.

Clicking the one of three buttons in the Building Schedule dialog enables you to take the following
actions:

• Review Messages—Opens the Review Messages dialog. Enabled only if schedule building caused
messages to be generated.

• Stop and Save—Enabled only if Optimize Profiles is selected after the application builds the first
valid schedule (see Schedule Build Parameters). The application sometimes continues to build
additional schedules to create an optimal schedule. To speed up the schedule building process, you can
interrupt this process and save the latest results. However, this can result in schedules that are less
optimal.

• Close—Closes the Building Schedule dialog.

Schedules Schedule Scenarios

Workforce Management Web for Supervisors Help 477



Scenario Coverage View
Use the Scenario Coverage view to compare a schedule's staffing coverage with the forecast
(calculated and required) staffing data. See the toolbar image here and the button descriptions
below.

Graphs and tables show you coverage for each weekday in the selected week, along with totals for
the whole week and scenario. Overstaffed and Understaffed timesteps appear in a distinctive
color.

Displaying the Scenario Coverage View

To display the Scenarios view:

1. From the Home menu on the toolbar, select Schedule.
2. From the Schedule menu on the toolbar, select Scenarios.

The Schedule Scenarios table appears.
3. Open a scenario by double-clicking its name in the table list or by selecting its name and clicking Open

.
The scenario's name appears on the toolbar, as a menu.

To display the open scenario's Coverage view:
4. From the scenario_name menu on the toolbar, select Coverage.
5. In the Objects pane, select a single business unit, a single site within a business unit, a multi-site

activity, activity group, or a single activity within a site.

Using the Daily Graphs and Tables

The Coverage view displays the following information for days of the week:

Graphs

Display coverage information for each day, with a
data point for each timestep. Select from the Chart
Type drop-down menu to display calculated
staffing, required staffing, or both (advanced). A
blank graph indicates a closed site (or no
scheduled activity) for the day.
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Tables

Display overstaffing and understaffing totals for
each day, with respect to calculated and/or
required staffing. Contractual constraints and
other configured parameters can reduce a
schedule's optimization.

Legend Explains the significance of each color used in the
graphs.

Reading the Totals Table

The Totals table (at the lower right) displays overstaffing and understaffing totals for the selected
week and for the whole schedule scenario, with respect to calculated and/or required staffing.

Customizing the Scenario Coverage View

Use the following controls (at top of the working pane) to customize the schedule coverage data:

Chart Type
Select the type of graphs that you want to be displayed:

Advanced
Graphs present both calculated and required
information. Calculated information appears as an
area graph with overstaffing/understaffing data,
and required staffing appears as a linear graph.

Calculated Graphs present calculated information with
overstaffing/understaffing data.

Required Graphs present required information with
overstaffing/understaffing data.

Date
Use the standard date-selection controls to move to other weeks within the scenario's date range.

Toolbar Buttons
Use the buttons on the toolbar (these commands also appear in the Actions menu) for the following:

Icon Name Description

Use Multi-site Activities Controls whether WFM Web's
calculation of aggregated
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Icon Name Description
information includes multi-site
activities. You can select this
button only if you first select a
multi-site activity, Business
Unit, or Enterprise in the
Objects tree.
If you set this button to On, WFM retains
your last selection—in the current view
and for all other views that contain multi-
site activities—preventing you from
having to click it every time you want to
display data for the selected multi-site
activity.

Publish

Opens the Publish Schedule
Wizard, where you can publish a
portion of the selected scenario
to the Master Schedule, or
extract a portion of the Master
Schedule to the selected
scenario.

Add/Remove scenario
elements

Opens the Add/Remove Scenario
Elements Wizard, where you can
add activities, and add or remove
agents, for the current schedule
scenario.

Build schedule
Opens the Schedule Build Wizard,
which builds a complete schedule
for the selected site.

Rebuild schedule

Opens the Schedule Rebuild
Wizard, where you can modify
and rebuild schedules, while
optionally leaving intact any
agent schedules that you have
edited since the last build/
rebuild.

Validate schedule

Opens the Review Messages
window, which lists scheduling
warnings for a selected site.
Warnings will only be visible if
you have built a schedule for this
scenario and you saved any
warnings that were generated.

Close
Closes the open scenario (and
prompts you to save unsaved
data).

How Understaffing and Overstaffing Are Calculated

Any timestep can be subject to either understaffing or overstaffing. WFM calculates these conditions
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by evaluating Coverage against Forecast.

• Understaffing—The Forecast is greater than the Coverage. There are too few agents on duty.
• Overstaffing—The Forecast is less than the Coverage. There are too many agents on duty.

Important
Coverage is an estimate of the agents’ contributions to the presented activities, and is
displayed in the time format (hh:mm). These contributions are based on the agents'
scheduled activities for each time interval, and on any schedule items that affect
these scheduled activities for an interval (such as a break that occurs during only part
of an interval).

Totals are calculated by summing understaffing/overstaffing for all activities for a given time range
(because each single understaffing/overstaffing value is for one timestep).
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Scenario Weekly View
Use the Scenario Weekly view to display a summary table of total paid hours, working start/end
times, or shift names. The table shows this information for a selected scenario, and for selected
agents and/or profiles.

Agents can be selected under different sites at the same time, but all sites must be within a single
business unit. See the toolbar image here the button descriptions below.

The Scenario Weekly view also enables you to see summary tables of total paid hours, working
start/end times, or shift names for your schedule planning period. See Mode for details.

Displaying the Scenario Weekly View

To display the Scenarios view:

1. From the Home menu on the toolbar, select Schedule.
2. From the Schedule menu on the toolbar, select Scenarios.

The Schedule Scenarios table appears.
3. Open a scenario by double-clicking its name in the table list or by selecting its name and clicking Open

.
The scenario's name appears on the toolbar, as a menu.

To display the open scenario's Weekly view:
4. From the scenario_name menu on the toolbar, select Weekly.
5. On the Objects pane, select the appropriate item(s) from either the Agents tree (above) or the

Activities tree (below).
WFM then selects matching item(s) from the other tree.

You can expand business units to display their sites, and expand sites to display their teams and
agents. You can select multiple sites, teams, and agents, but only one business unit.

If profile agents were created for this site during schedule building, these profiles appear within a
Profiles team.

6. Click Get data to populate the Weekly view table for the selected agents.
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Using the Table

The Weekly view table contains rows for each agent or profile that you selected in the Objects tree.
(If a scroll bar is displayed to the right, you can use it to reveal more agents.)

This table includes the following columns:

[Expand/Collapse]
If in Planning Period mode, the first column
provides expand/collapse controls that you use to
display or hide each agent's or profile's weekly
schedule details.

Team This column lists each agent's or profile's team.

Agent
Two columns show an icon representing this
agent's or profile's contract, and then the agent's
or profile's name.

[Week Start Dates]
In Planning Period mode, when you display agent
details, the rows below each agent's or profile's
name indicate the start date for each week in the
scenario.

[Weekdays]

These cells show agent schedule information for
each weekday, for each week in the scenario. The
cells' contents correspond to your selection from
the Show Data for drop-down list.
If the agent is not scheduled for a shift, the cell contains Day
Off, the name of a full-day time-off type, <shift> (for scheduled
working hours without a shift), or an exception name (for
scheduled full-day exceptions).

An icon in the cell for a weekday indicates whether the schedule
has been changed for that agent.

• If the agent's schedule for that day was
assigned during scheduling or rescheduling, no
icon appears.

• If the agent's day was edited after scheduling or
rescheduling, a light-gray pencil icon appears.

• If the agent's day was assigned by trading or
swapping, the swap icon appears.

• A Yield icon (upside down red triangle) appears
if there are pending changes that have not yet
been committed to the scenario.

If there have been multiple changes, the icon represents the
most recent status.

Weekly Totals Shows each agent's or profile's total paid hours for
the displayed week.

Long (Planning) Period Totals
Shows each agent's or profile's total paid hours for
the schedule planning period. This period's
duration and start date are set in the Policies >
Contracts > Site Settings tab.
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The Weekly Totals and Period Totals boxes below the table show a grand total of the paid hours
for all selected agents for the weekly or planning period, respectively.

If the WeekStartDay setting has been specified in Business Units Properties, the first weekday is the
one specified in WeekStartDay. Otherwise, the first weekday is the one specified in your operating
system's regional settings.

Customizing the Scenario Weekly View

To customize the displayed table, use these controls at the top of the working pane:

Show Data for
From this drop-down list, select what you want to be displayed inside each day's table cell:

Total Paid Hours Total paid time for the day.
Start/End Times Start and end times of agents' work.

Shift or Schedule State Names Names of agents' assigned shifts and other full-day
states.

Mode
Select one Week or Planning Period from the Mode drop-down list. The table displays data for the
selected period. If no schedule planning period was configured or if more than one site is selected on
the Object pane, then the Planning Period option is disabled.

The Scenario Planning Period Mode
The Scenario Planning Period mode displays schedules for the entire planning period, even if the
scenario range is shorter than the number of weeks in your planning period or if the scenario's date
range falls on the boundary between two different planning periods.

In these cases, different shades of white and gray indicate the type of date range that you are
viewing.

Planning Period Color Legend:

• White—Indicates dates that fall within both the scenario period and the planning period.
• Light Gray—Indicates dates that fall within the scenario period but are outside the planning period.
• Gray—Indicates dates that fall outside the scenario period but are within the planning period.
• Dark Gray—Indicates dates that are outside both the scenario and the planning period.
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Filter and Sort the Schedule Data
You can use the following buttons on the Actions toolbar (these commands also appear in the
Actions menu) to further customize the displayed table:

Options
Opens the Options dialog box. Enables you to
customize the view by including the Agent Rank
and Site Name columns.

Filter
Enables you to filter the displayed information by
activities and contract types. (If you set a new
filter, this immediately refreshes the view.)

Sort

Opens the Sorting dialog box, which allows sorting
by name, owner, sharing, time of creation, time of
last modification, scenario start date, or scenario
end date. You can sort in ascending or descending
order.

Searching for an Agent

To find a specific agent in the Scenario Weekly view:

1. To search the table for particular agents, select Find from the Edit menu or press Ctrl + F.
The Find Agents dialog box opens. You can search by first or last name.

2. Enter part or all of the agent's name, and then click OK.
The Weekly view display shifts to display the table row for the selected agent.

Toolbar: Modifying the Schedule

You can use the following buttons on the Actions toolbar (or on the Actions menu) to modify the
displayed schedule scenario:

Icon Name Description

Publish

Opens the Publish Schedule
Wizard, where you can publish a
portion of the selected scenario
to the Master Schedule, or
extract a portion of the Master
Schedule to the selected
scenario.

Add/Remove schedule elements

Opens the Add/Remove Schedule
Elements Wizard, where you can
add activities, and add or remove
agents, for the current schedule
scenario.
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Icon Name Description

Build schedule
Opens the Schedule Build Wizard,
which builds a complete schedule
for the selected site.

Rebuild schedule

Opens the Schedule Rebuild
Wizard, where you can modify
and rebuild schedules, while
optionally leaving intact any
agent schedules that you have
edited since the last build/
rebuild.

Re-build intra-day schedule

Opens the Intra-day Schedule
Rebuild Wizard to rebuild an
Intra-Day schedule for a specific
day or time period for a site,
team, or agent.

Validate schedule

Opens the Review Messages
window, which lists scheduling
warnings for a selected site.
Warnings will only be visible if
you have built a schedule for this
scenario already, and you chose
to save any warnings that were
generated.

Close
Closes the open scenario (and
prompts you to save unsaved
data).

Options
Opens the Options dialog box.
Enables you to select/de-select
the Agent Rank and Site Name
columns..

Filter

Opens the Filter dialog box.
Enables you to filter the
displayed information according
to activities and contract types.
(If you set a new filter, this
immediately refreshes the view.)

Sort

Opens the Sorting dialog box.
Here you can sort schedules by
Site name, Team Name, Contract,
Agent Name (first or last), or
Agent Rank. You can then sort
agents by First name or Last
name, and you can sort the
entire list by ascending or
descending order.

Tip
Agent Rank sorts in apparent
reverse order due to limitations
imposed by multi-sorting by both
agent name and rank.
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Icon Name Description

Swap
Opens the Swap Agent Schedules
Wizard, which enables you to
swap two agents' schedules.

Insert Multiple
Opens the Insert Multiple Wizard,
which enables you to add
multiple items to the scenario at
one time.

Delete Multiple
Opens the Delete Multiple
Wizard, which enables you to
remove multiple items from the
scenario at one time.

Commit/Rollback Multiple

Opens the Commit/Rollback
Multiple Wizard, which enables
you to insert pending changes
into the schedule scenario or to
remove them and return the
scenario to its former settings.

Meeting Scheduler
Opens the Meeting Scheduler,
which enables you to schedule
meetings to already build
scenario for selected agents.
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Scenario Intra-Day View
Use the Intra-Day view to manage schedule details for agents and profiles, for a selected scenario
on a specific day. See the toolbar image here and the button descriptions below.

If you selected the Show Performance Information check box on the Performance tab of the
Options dialog box, this window also shows performance data in a graph. If you have cleared the
Full-Day View check box, data is also shown in a table.

You can modify schedule items for individual agents or profiles in this view, and insert schedule items
for multiple agents and/or profiles.

Displaying the Intra-Day View

To display the Scenarios view:

1. From the Home menu on the toolbar, select Schedule.
2. From the Schedule menu on the toolbar, select Scenarios.

The Schedule Scenarios table displays.
3. Open a scenario by double-clicking its name in the table list or by selecting its name and clicking Open

.
The scenario's name appears on the toolbar, as a menu.

To display the open scenario's Intra-Day view:

1. From the scenario_name menu on the toolbar, select Intra-Day.
2. On the Objects pane, select the appropriate item(s) from either the Agents tree (above) or the

Activities tree (below); WFM then selects matching item(s) from the other tree.

Tip
A default performance target is selected for the Intra-Day schedule view. To change that selection, see
Performance Data Target.

3. Click Get data to display the Intra-Day Performance graph (if you have opted to view it) and the
schedule grid.
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Adjusting the Time Zone

From this drop-down menu at the top right of the view, select the Time Zone that WFM should use to
display the data in graphs and tables for this view.

Using the Grid

The Intra-Day view includes a grid with one row per agent, and the following fields and controls. You
can sort by columns such as site, team, contract, agent, shared transport, overtime, paid hours, total
hours, and start time by clicking on the header for that column.

Scheduled agents display
This indicator shows the number of agents
displayed (based on your selection in the Objects
tree).

Edited schedules display
This indicator shows the number of agents whose
schedules you have edited in this view, but not yet
saved.

Full-Day View check box
Select the Full-Day View check box to have the
Intra-Day grid display the entire day. If you clear
this check box, the grid shows a more detailed
view.

Date: selectors These controls are standard date selectors.

!
messages & warnings column

This column contains icons that provide information
about the agents' schedules.

• A green pencil icon indicates schedule items
that you have changed but not yet saved.

• A red pencil icon indicates an item that
generated an error. (Error conditions are more
serious than warning conditions.)

• A light-gray pencil icon indicates that the
agent's day was edited after scheduling or
rescheduling.

• A swap icon indicates that the agent's day was
assigned by trading or swapping.

• A yellow icon indicates an item that generated a
warning and you chose the Fix Later option.

• A Yield icon (upside down red triangle) appears
if there are pending changes not yet committed
to the scenario.

• An agent icon and red check box appear for
every schedule day that contains a granted
calendar item (if the option Show agents with
granted and scheduled rotating pattern or
any other calendar preference is selected in the
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Options dialog box).
Double-click a yellow or red icon to review message details and
resolve the unsaved items.

Site column This column indicates each agent's assigned site.
Team column This column indicates each agent's assigned team.

Contract column

This column indicates each agent's assigned

contract. The Contracts button is displayed
in the column.

Agent column This column indicates each agent's name.

Shared Transport column
If displayed (using the Options dialog box), this
column shows the membership for each agent in
Shared Transport Group on the selected day.

Overtime column
If displayed (using the Options dialog box),Options
dialog box), this column shows the duration of
overtime for each agent on the selected day.

Paid Hours column
If displayed (using the Options dialog box), this
column shows each agent's paid hours for the
selected day.

Total Hours column
If displayed (using the Options dialog box), this
column shows each agent's total hours for the
selected day.

Start Time column
If displayed (using the Options dialog box), this
column shows each agent's start time for the
selected day's work.

(Accessible Schedule Details) button

If displayed (using the Options dialog box), you can
click this icon to display the Accessible Schedule
Details dialog box, which simplifies and organizes
commands for vision-impaired users and the screen
readers that they use.

* (Memo) column

If this column is displayed (using the Options dialog
box), an asterisk (*) indicates that a comment or
additional information was saved for the indicated
agent and schedule day.
Double-click a column cell to view or edit the memo.

[Timesteps] column

These columns indicate the agent's schedule items
in each timestep. To see greater detail, clear the
Full-Day View check box and/or resize the columns.
To make changes to one agent's schedule at a time, right-click
the timestep that you want to modify and then select the
command from the shortcut menu. See Modify Individual
Agent's Schedules for instructions and explanations.

[Horizontal scroll bar]
Appears below the table when clearing the Full-Day
View check box causes some timesteps to be
hidden offscreen. Scroll it to the right to display
later timesteps.
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Legend Indicates the particular type of schedule item that
each bar color represents.

Details field
When you click an agent's row, this field lists the
agent's scheduled activities on the selected day. It
displays only what fits in one line: additional
information does not appear.

Customizing the Grid

You can display more timesteps by resizing some columns to the left of the table. For details, see
Getting Started.

Search for an Agent

To find a specific agent in the Scenario Intra-Day view:

1. Use the Find Agent dialog box to search the table for particular agents. To open it, select Find from
the Edit menu or press [Ctrl] + F.
The Find Agent dialog box opens.

2. Search by first or last name. Enter part or all of the agent's name and then click OK.
The Intra-Day view display shifts to display the table row for the selected agent.

Toolbar: Modifying Multiple Agents' Schedules

You can use the following buttons on the toolbar (these commands also appear in the Actions menu)
to modify multiple agents' schedules at once, to further customize the displayed table, or to modify
the selected scenario:

Icon Name Description

Publish

Opens the Publish Schedule
Wizard, where you can publish a
portion of the selected scenario
to the Master Schedule, or
extract a portion of the Master
Schedule to the selected
scenario.

Add/Remove scenario
elements

Opens the Add/Remove Scenario
Elements Wizard, where you can
add or remove activities and
agents for the current schedule
scenario.
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Icon Name Description

Build schedule
Opens the Schedule Build Wizard,
where you can build a complete
schedule for the selected site.

Rebuild schedule

Opens the Schedule Rebuild
Wizard, where you can rebuild
agent schedules, while optionally
leaving intact any agent
schedules that you have
modified since the last build/
rebuild.

Rebuild intra-day schedule

Opens the Intra-day Schedule
Rebuild Wizard to rebuild an
Intra-Day schedule for a specific
day or time period for a site,
team, or agent.

Validate schedule
Opens the Review Messages
window, which lists schedule
warnings that the server returns
for a selected site.

Close
Closes the open scenario (and
prompts you to save unsaved
data).

Options

Opens the Options dialog box.
Enables you to customize the
view, including whether to show
agent availability, whether to use
a 24-hour or 36-hour display,
whether to display performance
data, and whether to display or
hide the Site Name, Shared
Transport, Overtime, Paid
Hours, Total Hours, Start
Time, and Comment columns.

Filter Enables you to filter the
displayed schedule information.

Sort Enables you to sort the table.

Auto-Commit

The Auto-Commit toolbar
button toggles on and off the
auto-commit feature. The feature
is also turned on and off by
selecting Auto-Commit on the
Actions menu. If it is on,
changes are immediately applied
to the scenario. If it is off, the
changes have pending status
and can be committed/approved
before they are incorporated in
the publicly-available version of
the schedule scenario.
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Icon Name Description

Swap Enables you to swap two agents'
schedules.

Insert Multiple

Opens the Insert Multiple Wizard,
which enables you to insert
breaks, meals, exceptions, days
off, time off, shifts, marked time,
and work sets for multiple agents
or teams.

Delete Multiple
Opens the Delete Multiple
Wizard, which enables you to
remove multiple items from the
scenario at one time.

Edit Multiple
Opens the Edit Multiple Wizard,
which enables you to edit
multiple items in the scenario at
one time.

Commit/Rollback Multiple

Opens the Commit/Rollback
Multiple Wizard, which enables
you to insert pending changes
(changes entered when auto-
commit was off) into the
schedule scenario or to remove
them and return the scenario to
its former settings.

Save

Saves any changes that you have
made to the current scenario. If
the server cannot save all
changes, red or yellow icons in
the grid's first column indicate
the agents for whom you must
correct errors or acknowledge
warnings.

Meeting Scheduler
Opens the Meeting Scheduler,
which enables you to schedule
meetings to already build
scenario for selected agents.

Move to Current Day
Also known as the Today button.
Click this button to display data
for today.

Tip
• To make detailed scheduled changes for one agent at a time (such as inserting, editing,

or deleting the agent's schedule items), see Modifying Individual Agents' Schedules.
• If you make schedule changes in the Intra-Day view and do not click Save, you are

prompted to save your changes when you select a different module or view, or when
you launch certain wizards or child windows.
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• If you change the shift start time or shift end time for an agent who belongs to a shared
transport group, you will see a warning message when you save the change.

The Performance Data Display

Selecting the Show Performance Data check box on the Performance tab of the Options dialog
box adds a chart and a table to the top of the Scenario Intra-Day display.

Tip
The table appears only if you clear the Full-Day View check box.

To configure the performance data views:

1. Select a target for the performance data by clicking the button next to the Target: label.
The Select Target list that appears contains the activities associated with the site selected on the
Objects pane, activity groups, and the multi-site activities associated with the current scenario.

2. Select the granularity in which performance data should be presented: 15, 30, or 60 minutes.
3. Select the type of data to be displayed in the graph and table.

Schedule coverage appears as a red line on the graph.
4. To configure the graph, select a value from the Chart Type drop-down list:

• Calculated (default)
• Required
• Advanced (both Calculated and Required)

The table always displays values for schedule coverage and calculated staffing. It might show
additional figures, depending on your selections on the Performance tab of the Options dialog box.

If you are not using automatic updates, click Refresh Performance Data to update the
performance data view.
You can select Update Automatically on the Performance tab of the Options dialog box.

The label Multi-Skill Enabled appears on the right end of the Performance Data Display if you
enabled the SplitMS option. See the Workforce Management Administrator's Guide.
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Scenario Intra-Day: Publish Schedule
Wizard
Use the Publish Schedule Wizard to publish a date range from the selected scenario to the Master
Schedule, or to extract a date range from the Master Schedule to the selected scenario.

At any scenario view, click Publish . The wizard activates and presents these screens:

Select Action screen

1. Select the radio button that corresponds to the action you wish to take:
• Publish to the Master Schedule
• Extract from the Master Schedule

2. Click Next.

Publish to the Master Schedule from Scenario screen

This screen appears only if you selected Publish to the Master Schedule at the previous screen.

1. Make the following selections:
a. In the Dates area, use the spin boxes or pop-up calendars to specify Start and End dates for the

selected scenario.
This date range is the publishing source.

b. Select the Publish To Date Range check box to activate that area, then use the spin boxes or pop-
up calendars to specify Start and End dates for the Master Schedule.
This date range is the publishing destination.

c. In the Agents area, select agents from an object tree individually, or in groups by selecting teams,
sites, BUs, or Enterprise.

d. Select the Insert Granted Exception, Time Off and Day Off Calendar items check box to specify
that this action is performed during publication.

2. Click Finish (or Previous to return to the Select Action screen).
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Extract from the Master Schedule to Scenario screen

This screen appears only if you selected Extract from the Master Schedule at the previous screen.

1. Make the following selections:
a. In the Dates area, use the spin boxes or pop-up calendars to specify Start and End dates for the

selected scenario. This date range is the publishing source.
b. In the Agents area, select agents from an object tree individually, or in groups by selecting teams,

sites, BUs, or Enterprise.

2. Click Finish (or Previous to return to the Select Action screen).
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Scenario Intra-Day: Performance Data
Target
To view performance data in the Master Schedule Intra-Day view or the Schedule Scenario
Intra-Day view, you must choose a target. The target is the source of the performance data. You can
select the Enterprise, a business unit, a site, an activity group, or an activity (either multi-site or
single-site).

To change the Select Target window:

• Click the Target: button on the Schedule Intra-Day view window .

Important
This option is available only if you have chosen to view performance data by selecting
the Show Performance Information check box on the Performance tab of the
View Options dialog box.

Selecting the Appropriate Time Zone

When you select a site on the Object pane (for example, San Francisco), you are also specifying that
site's time zone, which may differ from the data source's time zone. You can change the time zone
manually by selecting the appropriate zone from the Time Zone drop-down list near the upper right
of the Intra-Day view. The selected time zone is applied to the grid and graphs that you view when
you request performance data. Schedules and whatever you select to view would be displayed in the
selected time zone, regardless of the data source's local hours (WFM makes the appropriate time
conversion).

Viewing Multi-Site Activity Data

Select the Use Multi-site Activities check box to display forecast data that is taken from multi-site
activities (MSAs), and schedule data that is the sum/average of Activities under your selected target
(MSA, business unit, or site). All data is transposed to the time zone of the site that you selected on
the Object pane.

Clear the Use Multi-site Activities check box to display all MSA data as a sum/average. All data is
transposed to the selected site's time zone.

If you set the Use Multi-site Activities button to On, WFM retains your last selection—in the
current view and for all other views that contain multi-site activities—preventing you from having to
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click it every time you want to display data for the selected multi-site activity.
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Scenario Intra-Day: Edit Comments Dialog
Box
Use the Edit Comments dialog box to enter or view comments about an agent's schedule for the
selected day in the Scenario Intra-Day or Agent-Extended view. To open this dialog box:

• Double-click the Comments cell in the column labeled * for the appropriate agent.

The Comments column is visible only if you select it on the Columns tab of the Options dialog box.

This dialog box contains the following controls:

• Comments—Enter or edit comments in this text box.
• OK—Click this button to accept your changes and close the dialog box. The WFM database does not

save your comments until you save the scenario.
• Cancel—Click this button to discard your changes and close the dialog box.

Important
Adding and editing comments changes the schedule. Therefore, when you save
comments, WFM validates the schedule and relevant schedule warning messages
appear. A schedule warning message generated when you first save the schedule
scenario generates again when you save your comments if the schedule still contains
the problems that were noted in the warning.
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Scenario Intra-Day: Options Dialog Box
Use the Options dialog box to configure the data that is shown on the:

• Intra-Day view or Agent Extended view for the current scenario.
• Master Schedule Intra-Day or Master Schedule Agent-Extended view.

Opening the Options dialog

To open the Options dialog box:

1. Click Options on the Actions toolbar, or select Options... from the Actions menu.
The Options dialog box opens.
• When called from an Intra-Day view, it has three tabs: Options, Performance, and Columns.
• When called from an Agent-Extended view, it has two tabs: Options and Columns.

Each tab is described below.

2. After you are done configuring the Options dialog box, click OK to save your changes, or Cancel to
restore the original selections.

The Options dialog box closes and the view refreshes. The settings that you configure for a scenario
or the Master Schedule appear whenever you return to the view for that scenario or for the Master
Schedule, until you log off.

Configuring the options in the dialog

To configure options in this dialog box:

1. If you do not need the Legend to appear, you can clear the Show Schedule Legend check box to
provide more space for the grid.

2. If you want to see agent availability on the grid, select the Show Agent Availability check box. Hours
when an agent is unavailable are then shown in light gray on the grid.

3. Select the check box Show agents with granted and scheduled rotating pattern or any other
calendar preference to see which schedule days contain such an item. The result: a red check box and
Agent icon appears in the left-most column (labeled "!") for every Agent who meets these conditions.

Tip
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You can use this tool to learn whether an agent was given a schedule based on a schedule preference, which
might influence your decision to modify this agent's schedule. This icon is displayed only if the agent was
given a rotating pattern or preference (such as for time off) as a result of building a schedule. If an agent’s
schedule is manually edited to give him or her a preference, or a schedule from a rotating pattern, then the
icon will not be displayed.

4. Select the radio button for the hours you want to show, 24 to show 24 hours or 36 to show 36 hours.
5. Select the Presentation type: Schedule only, Schedule on top, or Marked time on top.

Your selection affects the colored bars in the schedule. If Schedule only is selected, you cannot see
Marked time.

Configuring the Performance tab

To configure the Performance tab (not available in Agent-Extended view):

1. If you select the Show Performance Information check box, you can further customize exactly what
performance information WFM Web shows on the Intra-Day Schedule view.
If you clear this check box, the rest of the options on this tab are disabled.

2. If you prefer not to see the legend that explains the colors used to distinguish performance data, clear
the Show Performance Legend check box.

3. The Update Automatically check box determines whether schedule changes are shown when they
happen.
Clear this only if you have network bandwidth issues that make automatic updates a problem.

4. If you selected to view performance data, you can select the check boxes to show additional information
in the performance table.

Tip
You see the table only if the Full-Day View check box is not selected.

In addition to scheduled coverage and calculated staffing, which always appear, you can select any or all of these Show
additional data options to appear in the table:

• Required Staffing
• Difference between Coverage and Calculated Staffing
• Difference between Coverage and Required Staffing
• Scheduled Service Level Percentage
• Scheduled Deferred Service Level Percentage
• Scheduled ASA (Average Speed of Answer)
• Overtime Schedule (default: cleared)
• Overtime Requirement (default: cleared)
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Important
If any of the cells in the Difference in Calculated Staffing or Difference in
Required Staffing columns show as understaffed, WFM alerts the user by changing
the color of the cell to red. Although red is the default color, you can change it, by
using the settings in About > Settings (in the upper-right corner of the GUI).

Configuring the Columns tab

To configure the Columns tab:

• Select the check boxes for the optional columns that you want to display. Clear the check boxes for any
columns that you want to hide. For Intra-Day and Agent-Extended views, you can add the following
columns: Site Name, Shared Transport, Overtime, Paid Hours, Total Hours, Start Time,
Accessibility, and Comments. In Intra-Day view, all columns are sortable, except for Comments. In
Agent-Extended view, these columns are not sortable.
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Scenario Intra-Day: Review Messages
(Save) Dialog Box
Use this dialog box to respond to any warnings or errors that the server returned during your last
attempt to save an agent's edited schedule.

The dialog box includes the following columns and controls:

Team Name Displays the team to which this agent belongs.

Agent Name Displays the agent whose schedule generated this
message.

Messages Displays the message type (either Warning or
Error), numeric code, and the message text.

Action

Use each message's drop-down list to select an
action to resolve the warning or error:

• Save—Saves the edited agent schedule. This is
the default action for warnings. It is unavailable
for agent schedules whose edits generated
errors (which are more severe than warnings).

• Fix Later—Does not attempt to save the agent
schedule, but keeps it in the Intra-Day grid so
that you can further modify it. This is the
default action for agent schedules whose edits
generated errors.

• Do Not Save—Discards the change that caused
the warning or error to be generated.

OK Closes the dialog box, applies your selected
actions, and retrieves fresh data from the server.

Close Closes the dialog box without saving or refreshing
data.

These errors and warnings are generated by schedule changes that you made manually in the Intra-
Day view. They differ from Validation warnings and errors, which WFM Web generates during the
schedule building process.
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Add/Remove Scenario Elements Wizard
Use the Add/Remove Scenario Elements Wizard to modify the selected scenario by adding
activities or agents to it, or by removing agents. The wizard has the following screens:

• Select Actions
• Select Activities
• Filter by Contracts
• Add Agents
• Add Profile Agents based on Real Agents
• Add Profiles
• Remove Agents.

To use this wizard:

1. Click Add/Remove Scenario Elements on a schedule scenario view's Actions toolbar or select it
from the Actions menu.
The wizard starts and opens the Select Action screen.

The Add/Remove Scenario Elements Wizard has seven screens (listed above), but depending on
your choices, you might see fewer screens.

• Click Help on any screen opens a Help page that explains that screen's options.
• Click Back returns you to the previous screen, if you need to revise your entries there.
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Add/Remove Scenario Elements: Select
Actions
In the Add/Remove Scenario Elements Wizard Select Action screen:

1. Select a radio button from the group Actions:
• Add scenario elements—Runs the Select Activities, Filter by Contracts, Add Agents, Add Profile

Agents based on real agents, and Add Profiles screens, enabling you to add new activities and/or
agents to the scenario.

• Remove agents from scenario—Runs the Remove Agents screen, to remove agents from the
scenario.

2. Click Next to proceed to the next screen.
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Add/Remove Scenario Elements: Select
Activities
In the Add/Remove Scenario Elements Wizard Select Activities to Add screen:

1. Select one or more activities from the Activities tree, which includes business units, sites, and
activities.

Tip
The tree displays only those sites that the scenario included when it was created, and by default, activities
included in the selected scenario are selected in the tree, and you cannot clear their check boxes.

2. Select or clear (default) the Additionally Filter Agents By Contracts check box. If you select it, the
Filter by Contracts screen is next.

3. Click Next to proceed to the next screen.
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Add/Remove Scenario Elements: Filter by
Contracts
In the Add/Remove Scenario Elements Wizard Filter by Contracts screen:

1. Select one or more contracts from the tree, which includes business units, sites, and contracts.

Tip
The tree shows only those sites that the scenario included when it was created, and by default, all contracts
matching the activities that were selected on the Select Activities screen, are selected.

2. Click Next to proceed to the next screen.
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Add/Remove Scenario Elements: Add
Agents
In the Add/Remove Scenario Elements Wizard Add Agents screen:

1. Select one or more agents from the tree, which includes business units, sites, and agents.

Tip
The tree shows only those sites that the scenario included when it was created, and by default, all agents
matching the activities that were selected on the Select Activities screen are selected.

2. Click Next to proceed to the next screen.
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Add/Remove Scenario Elements: Add
Profile Agents
In the Add/Remove Scenario Elements Wizard Add Profile Agents based on Real Agents screen
agents are displayed in a tree, which is inside a table with these columns:

• Agents—Each agent's name.
• Present—The number of agent profiles, based on this real agent, that are already present in scenario.

This number is read-only.
• Add—Select the check box in this column to add this agent's profile to the scenario. Clear the check box

to not add the profile. As a short cut, you can select a single check box for any branch of the tree:
business unit, site, team—to select all items below it.

To add profile agents, based on real agents:

1. Select or clear individual agent check boxes, as needed.
2. Select or clear the check box Place Profile Agents, Based on Real Agents, Into Their Teams.
3. Click Next to proceed to the next screen.
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Add/Remove Scenario Elements: Add
Profiles
In the Add/Remove Scenario Elements Wizard Add Profiles screen sites are displayed in a tree,
which is inside a table with these columns:

• Profiles—Each profile's name.
• Present—The number of profiles, based on this contract, that are already present in scenario. (Read-

only.)
• Add—The number of profiles of the type selected to add to the scenario. (Editable.)

To add profiles:

1. Display one or more profiles in the tree, which includes business units, sites, and profiles.
2. Select and edit numbers in the Add column, as needed.
3. Click Finish to save your changes to the schedule scenario.
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Add/Remove Scenario Elements: Remove
Agents
In the Add/Remove Scenario Elements Wizard Remove Agents screen:

1. Select the agent(s) to remove from a tree of business units, sites, teams, and agents.
2. Click Finish.
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Scenario Agent-Extended View
Use the Scenario Agent-Extended view to display and/or edit a single agent's schedule for one
week or for the schedule planning period. See the toolbar image here the button descriptions below.

Tip
A legend at the bottom of the window indicates the particular type of schedule item
that each bar color represents.

You can modify schedule items for individual agents or profiles in this view, and insert schedule items
for multiple agents and/or profiles.

Displaying the Scenario Agent-Extended View

To display the Scenarios view:

1. From the Home menu on the toolbar, select Schedule.
2. From the Schedule menu on the toolbar, select Scenarios.

The Schedule Scenarios table displays.
3. Open a scenario by double-clicking its name in the table list or by selecting its name and clicking Open

( ).
The scenario's name appears on the toolbar, as a menu.

To display the open scenario's Agent-Extended view:

1. From the <scenario_name> menu on the toolbar, select Agent Extended.
2. In the Objects pane, select a single business unit, a single site within a business unit, or a single agent

within a site.

Using the Scenario Agent-Extended View Grid

The Agent-Extended view includes a grid for the selected agent. Each row in the grid contains a
color coded bar. Each bar represents a scheduled day or day off for the selected agent. The table
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below explains the fields and controls.

Scheduled agents This indicator shows the number of agents
displayed (based on the selected Mode).

Edited schedules This indicator shows the number of daily schedules
you have edited in this view, but not yet saved.

Full-Day View
Select the Full-Day View check box to have the
grid display the entire day similar to the Intra-Day
view. If you clear this check box, the grid shows a
more detailed view.

Mode:
The starting Mode is set to the default of one
week, but can be changed to Schedule Planning
Period if schedule planning periods are used at
your site.

Date:
These controls are the standard date selectors. The
grid displays data for the period containing the
selected date.

!
messages/warnings column

This column contains icons that provide information
about the agents' schedules.

• A light-gray pencil icon indicates that the
agent's day was edited after scheduling or
rescheduling.

• A green pencil icon indicates schedule items
that you have changed but not yet saved.

• A yellow pencil icon indicates an item that
generated a warning and you selected the Fix
Later option.

• A red pencil icon indicates an item that
generated an error. (Error conditions are more
serious than warning conditions.)

• A swap icon indicates that the agent's day was
assigned by trading or swapping.

• A yield icon (upside down red triangle) appears
if there are pending changes. Pending changes
must be committed by a user with Approve
Changes security permission.

Double-click a yellow or red icon to review message details and
resolve the unsaved items.

Team This column on the grid indicates the selected
agent's assigned team.

colored icon The column on the grid may display a colored icon,
which represents the agent's contract.

Agent This column on the grid indicates each agent's
name.

Date This column on the grid indicates the calendar day.

Weekday This column on the grid indicates the day of the
week. (Select Day of Week in the Options >
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Column tab.)

[Timesteps]

These columns indicate the agent's schedule items
in each timestep. To see greater detail, clear the
Full-Day View check box and/or resize the columns.
To make changes to the selected agent's schedule, right-click
the timestep that you want to modify and then select the
command from the shortcut menu. The figure below shows the
menu when you right-click the dark blue area within a color-
coded bar (unless you change the color). The menu items vary
depending on the area clicked.

See Modify Individual Agent's Schedules for instructions and
explanations.

[Horizontal scroll bar]
Appears below the table when clearing the Full-Day
View check box causes some timesteps to be
hidden off screen. Scroll it to the right to display
later timesteps.

Legend
Indicates the particular type of schedule item that
each bar color represents.

Customizing the Scenario Agent-Extended View Grid

You can resize the Team, Agent, and Date columns. For details, see Getting Started. You can also
add and remove columns.

Site Name
If displayed (using the Options dialog box), this
column shows the name of the site for each agent
on the selected day.

Shared Transport
If displayed (using the Options dialog box), this
column shows the membership for each agent in
Shared Transport group on the selected day.

Overtime If displayed (using the Options dialog box), this
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column shows the duration of overtime for each
agent on the selected day.

Paid Hours
If displayed (using the Options dialog box), this
column shows each agent's paid hours for the
selected day.

Total Hours
If displayed (using the Options dialog box), this
column shows each agent's total hours for the
selected day.

Start Time
If displayed (using the Options dialog box), this
column shows each agent's start time for the
selected day's work.

(Accessible
Schedule Details)

If displayed (using the Options dialog box), you can
click this icon to display the Accessible Schedule
Details dialog box, which simplifies and organizes
commands for vision-impaired users and the screen
readers that they use.

* (Comment)

If this column is displayed (using the Options dialog
box), an asterisk (*) indicates that a comment was
saved for the indicated agent and schedule day.
Double-click a column cell to view or edit comments.

Using the Scenario Agent-Extended View Toolbar Buttons

The Scenario Agent-Extended view toolbar is similar to the Scenario Intra-Day view toolbar. The
only exception is that Scenario Agent-Extended view does not contain Filter, Sort, or Meeting
Scheduler buttons. Click a button on the Scenario Agent-Extended view image to jump to its
description.

Toolbar: Modifying an Agent's Schedule

Use buttons on the toolbar (or commands from the Actions menu) for the following:

Icon Name Description

Publish

Opens the Publish Schedule
Wizard, where you can publish a
portion of the selected scenario
to the Master Schedule, or
extract a portion of the Master
Schedule to the selected
scenario.

Add/Remove scenario
elements

Opens the Add/Remove Scenario
Elements Wizard, where you can
add or remove activities and
agents for the current schedule
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Icon Name Description
scenario.

Build schedule
Opens the Schedule Build Wizard,
where you can build a complete
schedule for the selected site.

Rebuild schedule

Opens the Schedule Rebuild
Wizard, where you can rebuild
agent schedules, while optionally
leaving intact any agent
schedules that you have
modified since the last build/
rebuild.

Rebuild intra-day schedule

Opens the Intra-day Schedule
Rebuild Wizard to rebuild an
Intra-Day schedule for a specific
day or time period for a site,
team, or agent.

Validate schedule

Opens the Review Messages
window, which lists scheduling
warnings for a selected site.
Warnings will only be visible if

you have already built a schedule
for this scenario and you saved
any warnings that were
generated.

Close
Closes the open scenario (and
prompts you to save unsaved
data).

Options

Opens the Options dialog box.
Enables you to customize the
view, including whether to show
agent availability, whether to use
a 24-hour or 36-hour display, and
whether to display or hide the
Overtime, Paid Hours, Total
Hours, Start Time, Comment,
Site Name, Shared Transport,
and Accessibility columns.

Auto-Commit

The Auto-Commit toolbar
button toggles on and off the
auto-commit feature. The feature
is also turned on and off by
selecting Auto-Commit on the
Actions menu. If it is on,
changes are immediately applied
to the scenario. If it is off, the
changes have pending status
and can be committed/approved
before they are incorporated in
the publicly-available version of
the schedule scenario.

Swap Opens the Swap Agent
Schedules Wizard, which
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Icon Name Description
enables you to swap two agents'
schedules.

Insert Multiple

Opens the Insert Multiple Wizard,
which enables you to insert
breaks, meals, exceptions, days
off, or vacation days for multiple
agents or teams.

Delete Multiple
Opens the Delete Multiple
Wizard, which enables you to
remove multiple items from the
scenario at one time.

Edit Multiple
Opens the Edit Multiple Wizard,
which enables you to edit
multiple items in the scenario at
one time.

Commit/Rollback Multiple

Opens the Commit/Rollback
Multiple Wizard, which enables
you to insert pending changes
(changes entered when auto-
commit was off) into the
schedule scenario or to remove
them and return the scenario to
its former settings.

Save

Saves any changes that you have
made to the current scenario. (If
the server cannot save all
changes, red or yellow icons in
the grid's first column indicate
the agents for whom you must
correct errors or acknowledge
warnings.
If you make schedule changes in the
Agent-Extended view and do not click
Save, you are prompted to save your
changes when you select a different
module or view, or when you launch
certain wizards or child windows.

Move to Current Day
Also known as the Today button.
Click this button to display data
for today.
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Scenario Profiles/Bidding View
Use the Scenario Profiles/Bidding view to assign agents to a schedule that you have created using
profiles. See the toolbar image here and the button descriptions below.

Bidding controls and tools are described at the bottom of this topic.

Using Profile-based Scheduling for Bidding Scenarios

WFM offers Schedule Bidding. This view offers controls you can use to:

• Assign agents to a bidding scenario before bidding starts.
• Set the start and end dates for bidding.
• Start the auto-assignment process, to assign agents to schedules, after bidding is closed.

These tools are a key portion of WFM's Schedule Bidding functionality.

Using Profile-based Scheduling for Advance Planning

You can use a profile-based schedule to plan for and schedule agents who you have not yet hired.

Schedules Schedule Scenarios

Workforce Management Web for Supervisors Help 518



1. Configure and build your scenario(s) using profiles with the characteristics of your not-yet-hired agents.
2. Once the real agents are on board, assign them to the profile schedules.

Displaying the Scenario Profiles/Bidding View

To display the Scenarios view:

1. From the Home menu on the toolbar, select Schedule.
2. From the Schedule menu on the toolbar, select Scenarios.

The Schedule Scenarios table appears.
3. Open a scenario by double-clicking its name in the table list or by selecting its name and clicking Open

.
The scenario's name appears on the toolbar, as a menu.

To display the open scenario's Profiles/Bidding view:

1. From the scenario_name menu on the toolbar, select Profiles/Bidding.
2. In the Objects pane, select the appropriate item(s) from either the Agents tree (above) or the

Activities tree (below); WFM then selects matching item(s) from the other tree.

You can expand business units to display their sites and expand sites to display their profiles. You can
select multiple sites, teams, and profiles, but just one business unit. You can select or remove all of a
site's profiles by selecting or clearing (respectively) the check box beside the site node.

Reading the Tables

This view includes two tables, arranged vertically. Each table displays a vertical scroll bar (when
required), which you can use to reveal additional rows. You can also give one table additional room by
clicking and dragging the divider bar between the two tables.

The upper table displays a list of profile schedules, identified by a contract icon and by an index
number (each of which is unique within the scenario). This table has the following columns:

Icons and columns Description

(line is expanded) Click this icon to collapse a multiple-line listing to a
single line.

(line is collapsed) Click this icon to expand a single-line listing to
multiple lines.

Site
The assigned site of the agent in this row. You can
show or hide this column using the Options
toolbar button.
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Icons and columns Description
Team The assigned team of the agent on this row.

This icon represents the agent's contract.
Agent Shows an index.

Bid
The agent's bid ranking number for this schedule.
You can show or hide this column using the
Options toolbar button.

[Weekdays]
Shows profile schedule information for the specific
day. (The cells' contents correspond to your
selection in the Show Data for drop-down list.)

Weekly Totals
To the right of each week, the total hours in that
week (sum of all days). If there is more than one
total, the sum of all totals appears above them.

Planning Period Totals The total hours of all weeks in the Planning
Period.

The lower table displays a list of real agents, with the following columns: Team, Agent Name, Rank,
Hiring Date, Employee ID, and Bid.

Each row displays information for one agent. Each agent listed meets all the requirements imposed
by the icon Show Assigned Agents and the check box Show Bidding Candidates Only.

Team The assigned team of the agent on this row.

Agent name The name of the agent on this row being
documented in this row.

Rank The agent's rank, if one exists.
Hiring Date The agent's hiring date.
Employee ID The agent's employee ID.
Bid The agent's bid ranking number for this schedule.

Using the Tables

To assign a real agent to a profile schedule slot:

1. Click a profile schedule in the upper table.
This populates the lower table with any real agents who are eligible to fill this slot. WFM Web presents
agents who share the selected profile's contract, and who have the skills necessary to handle all of the
profile's activities.

2. Click a real agent in the lower table.

3. Click .
In the upper table, the real agent's name replaces the selected schedule's index.

To remove an assignment:
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1. Click the assigned agent in the upper table.

2. Click .
A numbered profile replaces the agent's name in the upper table. The agent's name reappears in the
lower table.

To remove a profile slot from the upper table:

• In the Objects tree, clear that profile's check box.

Show Data For
Use this drop-down list to select what you want to display inside each day's table cell:

Total Paid Hours Total working time for the day. (Default display
option.)

Working Start/End Time Start and end times of agents' work.
Shift or Schedule State Names Names of agents' assigned shifts.

Mode
Use this drop-down list to select what you want to display in the table:

All data
Displays all profile schedules for the scenario
period defined by Start Date and End Date.
Includes columns for Weekly Period Totals and
Planning Period Totals.

Planning Period
Displays all profile schedules for the entire
Planning Period. Includes columns for Weekly
Period Totals and Planning Period Totals for
each profile schedule.

Filter, Build, Validate, Bidding Configuration and Save Options

You can use the following buttons on the toolbar (these commands also appear in the Actions
menu):

Icon Name Description

Publish

Opens the Publish Schedule
Wizard, where you can publish a
portion of the selected scenario
to the Master Schedule, or
extract a portion of the Master
Schedule to the selected
scenario.
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Icon Name Description

Add/Remove schedule
elements

Opens the Add/Remove Schedule
Elements Wizard, where you can
add activities, and add or remove
agents, for the current schedule
scenario.

Build schedule
Opens the Schedule Build Wizard,
which builds a complete schedule
for the selected site.

Rebuild schedule

Opens the Schedule Rebuild
Wizard, where you can modify
and rebuild schedules, while
optionally leaving intact any
agent schedules that you have
edited since the last build/
rebuild.

Rebuild Intra-day schedule
Opens the Schedule Intra-day
Rebuild Wizard, where you can
modify and rebuild intra-day
schedules.

Validate schedule

Opens the Review Messages
window, which lists scheduling
warnings for a selected site.
Warnings will only be visible if
you have already built a schedule
for this scenario and saved any
warnings that were generated.

Close
Closes the open scenario (and
prompts you to save unsaved
data).

Options
Opens the Bid Options dialog,
where you can choose to display
or hide these columns in the
upper table: Bid, Site.

Filter
Enables you to filter the
displayed contract types and
activities.

Sort

Opens the Sorting dialog box.
Here you can sort schedules by
Site name, Team Name,
Contract, Agent Name (first or
last), or Agent Rank. You can
then sort agents by First name
or Last name, and you can sort
the entire list by ascending or
descending order.

Tip
Agent Rank sorts in apparent
reverse order due to limitations
imposed by multi-sorting by both
agent name and rank.
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Bidding Scenario Tools in this View

Use these controls to assign agents to a bidding scenario before bidding starts; to set the start and
end dates for bidding; and to start the auto-assignment process to assign agents to schedules, after
bidding is closed.

Icons
Icon Name Description

Select Bidding Candidates
Opens the Select Bidding
Candidates dialog, where you
specify which Agents can bid on
the current bidding scenario.

Control Bidding Process
Opens the Control Bidding
Process wizard, where you
specify the Start and End dates
for the current bidding scenario.

Auto-Assign Schedules

Opens the Auto-assignment
wizard, where you initiate the
auto-assignment process that
assigns bid-upon profile
schedules to real agents.

Show assigned agents

Displays real agents and their
assigned shifts in the grid, only if
the schedule was originally
created using agent profiles.
Otherwise selecting has no
effect.

Associate/Separate Teams Opens the Associate/Separate
Teams wizard.

All other icons and modules are described in the Scenario Intra-Day View and the Scenario Agent-
Extended View.

Check Box

• Show bidding candidates only—Controls which agents are listed in the bottom pane. Select this
check box to display (in the bottom pane) only agents who can bid on the profile schedule selected in
the top pane. Clear this check box to display (in the bottom pane) all agents at the Site who qualify for
the profile schedule selected in the top pane.
• When you use this view for schedule bidding, check the check box.
• When you use this view for profile-based scheduling, clear the check box.

Arrows
Use these arrows to manually assign real agents to profile shifts or to unassign them.
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• (up arrow)—Assigns a real agent to the selected profile shift. To use this function:

1. Highlight a profile shift in the upper grid.
2. Highlight a real agent in the eligible list below.
3. Click the up arrow to assign the real agent to the profile shift.

The profile shift you selected becomes a real agent shift and the real agent disappears from the
eligible list below.

• (down arrow)—Unassigns a real agent from the selected shift. To use this function:

1. Select a real agent shift in the upper grid.
2. Click the down arrow to unassign the shift.

The shift you selected becomes a profile shift (now available for assignment) and the real agent
appears in the eligible list below.
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Options Dialog Box (Scenario Profiles/
Bidding View)
Use the Options dialog box to specify the columns that the Scenario Profiles/Bidding view
displays.

1. On the Scenario Profiles/Bidding view's Actions toolbar, click the Options button.
The Options dialog box opens.

Tip
All check boxes are selected by default.

2. Clear the check boxes for the items that you want excluded from the display.
3. Click OK to apply your choices.
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Scenario Summary View
Use the Scenario Summary view to display statistics about the current schedule scenario. See the
toolbar image here and the button descriptions below.

The Summary view provides standard date-selection controls and two data panes: a graph and a
table.

Displaying the Scenario Summary View

To display the Scenarios view:

1. From the Home menu on the toolbar, select Schedule.
2. From the Schedule menu on the toolbar, select Scenarios.

The Schedule Scenarios table appears.
3. Open a scenario by double-clicking its name in the table list or by selecting its name and clicking Open

.
The scenario's name appears on the toolbar, as a menu.

To display the open scenario's Summary view:

1. From the <scenario_name> menu on the toolbar, select Summary.
2. In the Objects pane, select the appropriate item from the Activities tree.

You can select a single business unit, a single site within a business unit, a multi-site activity, an
activity group, or a single activity within a site. Making the selection populates the Data grid.

Setting Granularity

Use this drop-down list to select the Time Step increment to display in the grid. Select from one of
these three values (in minutes): 15, 30, or 60.

Graph and Data Panes

This view displays its data in a graph (upper portion of the view) and a table (lower portion), instead
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of on separate tabs.

Graph Pane

The Graph pane provides a linear graph for each statistic that you select, with data points for
individual timesteps across the selected day.

Show data for
From the Show data for drop-down list:

1. Select the statistic you want to graph.
The options correspond to the Data grid's available columns (except that Difference Calculated and
Difference Required cannot be graphed).

2. Select the Show Required check box to display that data on the graph.

Graph
The graph is redrawn to match your drop-down list selection from the Show data for drop-down list.
Timesteps are shown from left to right. Quantities from bottom to top show the number of
interactions, the number of agents, or the expense amount (for Budget).

Data Table

The Data pane provides a scrollable grid that displays aggregate and per-timestep statistics. The
grid's first row displays a daily total or average for each statistic. Each of the remaining rows displays
statistics for one timestep.

Grid Columns
The grid provides columns that display the following statistics and quantities.

• Click the Options button to display or hide each of these available columns.

Column Description

Time Step The start time for each timestep, configured by the
Granularity setting.

Coverage [Scheduled]

The scheduled staffing coverage for an activity or
multi-site activity. Schedule coverage is calculated
and displayed in fractional units. For example, if
any agent is scheduled to work on three Activities
in a 15-minute timestep, that agent may count as
1/3 toward the coverage of each activity.
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Column Description

The way the scheduling engine splits an agent’s time among the
activities the agent can work on depends on many factors.
Examples include the open hours of each activity, the volume
and handle time of each activity, and some other factors such
as whether an agent has granted items in the Calendar, such
as time off or exceptions for any or part of the day.

Headcount [Scheduled] The number of agents scheduled (agents
scheduled to be seated).

Service Level Percentage Scheduled
The service level percentage that can be achieved
given the staffing coverage—assuming that other
planned metrics (such as interaction volumes and
Average Handling Time) remain unchanged.

Service Level Percentage Forecasted

The service level percentage that can be expected
to be achieved based on the number of agents
forecast.
This may differ than the original service level objective that was
stated when the staffing forecast was built due to agent
rounding. For example, WFM may forecast a staffing
requirement of 12 agents to meet a service level objective of
80% of interactions answered within 20 seconds, but Service
Level Percentage Forecast may report a higher number, such
as 83.48%. This is because 12 was the minimum number of
agents required to meet the 80% service level objective but,
with that number of agents, the contact center can be expected
to achieve a slightly better service level than 80%. With one less
agent (11 agents), the contact center would not be expected to
achieve the 80% service level.

Interaction Volume Scheduled
The number of interactions that can be handled
based on the schedule coverage—assuming that
other planned metrics remain unchanged.

Interaction Volume Forecasted The expected number of interactions, according to
the Master Forecast.

AHT Scheduled
The Average Handling Time per interaction,
based on the schedule—assuming that other
planned metrics remain unchanged.

AHT Forecasted The expected Average Handling Time, according
to the Master Forecast.

Budget Scheduled

The budget for the scheduled coverage for the
selected day and timesteps, based on the full-time-
equivalent (FTE) paid hours per day and the salary
specified in the Forecast scenario that was
published to the Master Forecast for this date. (This
statistic appears only if you have the access rights
to view agents' wage fields.)

Budget Forecasted

The budget for the calculated staffing for the
selected day and timesteps, based on the full-time-
equivalent paid hours per day and the salary
specified in the Forecast scenario that was
published to the Master Forecast for this date.
(This statistic appears only if you have access
rights to view agents' wage fields.)
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Column Description

Staffing Calculated
The required number of agents as calculated by
WFM, based on the forecast interaction volumes,
AHT, and applicable service objectives.

Staffing Required
Optional field. The required number of agents as
defined by the user, either by explicitly entering
forecast targets or by using a template.

Difference Calculated The difference between Coverage [Scheduled]
and Staffing Calculated.

Difference Required Optional field. The difference between Coverage
[Scheduled] and Staffing Required.

ASA Scheduled
Optional field. The Average Speed of Answer
that you should achieve on this activity, with the
number of agents currently scheduled for this
activity.

ASA Forecasted
Optional field. The totals/average row for ASA
Forecast reports a weighted average, calculated
across the open hours and weighted by Forecast
IV

Deferred Service Level Scheduled

Optional field. The service level percentage that
can be achieved given the deferred staffing
coverage—assuming that other planned metrics
(such as interaction volumes and Average
Handling Time) remain unchanged.

Deferred Service Level Forecasted
Optional field. The service level percentage that
can be expected to be achieved, based on the
number of deferred activities forecast.

Deferred Service Level Difference
[Scheduled minus Forecasted]

Optional field. The difference between the
Scheduled Deferred Service Level and
Forecasted Deferred Service Level statistics.

Scheduled Queue The scheduled number of interactions in the
backlog queue at the end of the period.

Difference [ASA Scheduled
minus ASA Forecasted]

Optional field. ASA Scheduled minus ASA
Forecasted

Occupancy Scheduled
Optional field. The Occupancy that you should
achieve on this activity, with the number of agents
currently scheduled.

Occupancy Forecasted
Optional field. The Occupancy objective that you
should be able to achieve when staffing with the
number of agents from the staffing forecast

Difference [Occupancy Scheduled
minus Occupancy Forecasted]

Optional field. Occupancy Scheduled minus
Occupancy Forecasted

Difference [S/L Scheduled
minus S/L Forecasted]

Optional field. S/L Scheduled minus S/L
Forecasted

Difference [IV Scheduled
minus IV Forecasted]

Optional field. IV Scheduled minus IV
Forecasted

Difference [AHT Scheduled
minus AHT Forecasted]

Optional field. AHT Scheduled minus AHT
Forecasted
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Column Description
Difference [Budget Scheduled
minus Budget Forecasted]

Optional field. Budget Scheduled minus Budget
Forecasted

Important
You can display staffing totals in FTE or man-hours mode in the Schedule coverage,
Calculated staffing, Required staffing, and other columns in the Scenario
Summary view by adjusting the view settings in the interface. To change the display
mode, see Changing the Staffing Display from FTE to Man Hours.

Using the Actions Toolbar

Use buttons on the toolbar (or commands from the Actions menu) for the following:

Icon Name Description

Publish

Opens the Publish Schedule
Wizard, where you can publish a
portion of the selected scenario
to the Master Schedule, or
extract a portion of the Master
Schedule to the selected
scenario.

Add/remove scenario
elements

Opens the Add/Remove Schedule
Elements Wizard, where you can
add activities and agents to, or
remove them from, the current
schedule scenario.

Build schedule
Opens the Schedule Build Wizard,
where you can build a complete
schedule for the selected site.

Rebuild schedule

Opens the Schedule Rebuild
Wizard, where you can modify
and rebuild schedules, while
optionally leaving intact any
agent schedules that you have
edited since the last build/
rebuild.

Validate schedule

Opens the Review Messages
window, which lists scheduling
warnings for a selected site.
Warnings will only be visible if
you have already built a schedule
for this scenario and saved any
warnings that were generated.
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Icon Name Description

Close
Closes the open scenario (and
prompts you to save unsaved
data).

Options
Opens the Options dialog box for
enabling or hiding individual
statistics.

Use Multi-Site Activities

This button becomes enabled
when you select a multi-site
activity or business unit in the
Objects tree. Clicking this button
displays data for the selected
multi-site activity.
If you set this button to On, WFM retains
your last selection—in the current view
and for all other views that contain multi-
site activities—preventing you from
having to click it every time you want to
display data for the selected multi-site
activity.
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Scenario State Group Totals
Use the Scenario State Group Totals view to display coverage statistics for every time step in a
selected day. Also, you can select agents with specific scheduled states who are contributing to a
specific shrinkage types and display their schedules in the Intra-Day view. See Selecting Agents
Contributing to Specific Shrinkage.

See the toolbar image here and the button descriptions below.

Displaying State Group Totals

To open the Scenarios view:

1. From the Home menu on the toolbar, select Schedule.
2. From the Schedule menu on the toolbar, select Scenarios.

The Schedule Scenarios table displays.
3. Open a scenario by double-clicking its name in the table list or by selecting its name and clicking Open

.
The scenario's name displays on the toolbar, as a menu.

To display the open scenario's State Group Totals view:

1. From the <scenario_name> menu on the toolbar, select State Group Totals.
2. In the Objects pane, select the appropriate item(s) from either the Agents tree (above) or the

Activities tree (below).
WFM then selects matching item(s) from the other tree.

3. Click Get data.

The columns in the scenario Schedule State Group Totals data table, and the stacked lines in the

graph, correspond to the configured schedule state groups. Select Filter in the toolbar, and use
the Schedule States tab to specify which columns appear in the table and which lines appear in the
graph.

Changing the Default Time Zone for Schedule State Totals
When displaying schedule state totals, if you select agents from the several sites, WFM uses the
business unit's time zone by default. If you select agents from only one site, WFM uses the site time
zone by default. However, in the State Group Totals view, selecting Show data for, enables you
change the default time zone by selecting a different one, by clicking the Time Zone drop-down list.
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Tip
To see the View Intra-Day Schedule context menu in step 4 in the next two
procedures, you must right-click a cell with a value other than 0.

Selecting Agents Contributing to Specific Shrinkage

1. In the Scenarios view, open a scenario.
2. Click the scenario name and select State Group Totals.

The Show data for field is populated with Schedule States Totals by default (do not change
it).

3. Select a business unit, site, and activities and click Get Data.
4. Right-click any cell that contains a value.
5. Click the View Intra-Day Schedule context menu.

A list of agents who are contributing to the shrinkage is displayed.
6. Select the agents whose schedule you want to view.
7. Optionally, check the box Open Intra-day schedule in a new window, and click OK.

This opens the Intra-Day view in a separate window, leaving the the Schedule State Totals
view open behind it.

8. Or, leave the box Open Intra-day schedule in a new window unchecked, and click OK.
The Intra-Day view opens, replacing the Schedule State Totals view.

The Intra-Day view now shows the selected agents' schedules.

Viewing State Group Totals Grouped by Name

1. In the Scenarios view, open a scenario.
2. Click the scenario name and select State Group Totals.

The Show data for field is populated with Schedule States Totals by default (do not change
it).

3. Select a business unit, site, and activities and click Get Data.
4. Click the Group by names check box.

When this check box is selected, and there are Schedule State Groups with the same name
under different sites, WFM displays their schedule state group totals in a single column
with the same name.

5. Right-click any cell that contains a value.
6. Click the View Intra-Day Schedule context menu.
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A list of the agents is displayed.
7. Select the agents whose schedule you want to view.

The Intra-Day view opens, replacing the Schedule State Totals view.

The Intra-Day view now shows the selected agents' schedules.

Viewing and Editing Agents' Intra-Day Schedules

Use this procedure to view and edit multiple agents' schedules in the Intra-Day schedule or select
multiple agents who are contributing to schedule shrinkage.
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To view and edit agents' schedules:

1. In the data pane of an open scenario, select the time step or row for the schedule state you want to
edit.
The View or Edit Intra-Day Schedules Wizard opens with all agent states selected, by
default.

2. Select/deselect agent states, as needed, and then:
• Click View schedules to open the agents' Intra-Day schedule.
• Click Delete states to delete the select agents' states.
• Click Cancel to cancel the action and close the wizard.
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3. Optionally, you can use the following check boxes:
• Open Edit Multiple Wizard—Opens the wizard and the Intra-Day schedule after you click View

schedules. See the Edit Multiple Wizard.
• Open Intra-Day schedule in a new window—Opens the agents' Intra-Day schedule in a separate

window after you click View schedules.
• Auto commit—Automatically commits the changes to the schedule. This box is checked, by default.

Unchecking this box indicates that changes will be committed to the schedule manually.

Tip
When using the Edit Multiple Wizard, you cannot cannot edit or delete the following
state types: Activity, Day Off, Full-Day Exception, or Full-Day Time Off.

Graph and Data Panes

This view displays its data in a graph (upper portion of the view) and a table (lower portion), instead
of on separate tabs. You can also specify that WFM display its data not only for days, but also for
weeks and months.

Both data displays show the differences between the schedule and the forecast, for each timestep
during the selected time period. The Graph also shows totals as a flat line, because the lines
representing forecasted and scheduled shrinkage can be of different shapes.

Graph
The groups are sorted by their weight descending and their name ascending. For example, the group
with the highest weight is layered first, at the bottom of the chart.

The graph’s legend displays the names of each schedule state group in its matching color.

Graph Type drop-down
menu

Select a display scheme for this view's graphical
data. (This menu is disabled and reset to the
default choice if the Scheduled States Totals
value is selected in the Show data for: drop-down
menu).

Period
Select the period for which the schedule state
group is applicable; Planning Period, Month,
Week, or Day.

Totals

Displays the data in a line graph, showing stacked
schedule state group information. Default.
If the Show Coverage and Forecast Information toolbar icon is
toggled on, the graph displays this data as separate lines:
Schedule Coverage, Forecasted Staffing Calculated, and
Forecasted Staffing Required.
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Comparison

Displays percentage data for a specific schedule
state group or for planned / unplanned overheads,
in a line graph that compares it to forecast-
overheads data.
The graph displays two percentage-data series as lines in the
format that you select in the drop-down menu Targets.

If the Show Coverage and Forecast Information toolbar icon is
toggled on, the graph displays two additional data series of
forecast data for the object(s) that you selected in the Objects
pane.

Variance

Displays a bar graph representing differences
between schedule and forecast, including
shrinkage information.
Variance appears only if the Show Coverage and Forecast
Information toolbar icon is toggled on.

Targets drop-down
menu

Appears only when the Graph Type menu
selection is Comparison. Use it to select percentage
data to compare. Select a format for comparing
percentage data:

Total Planned
Displays scheduled planned overheads totals data
and forecasted total planned overhead data. Not
available if the selected value in the Show data
for: menu is Unplanned Overheads.

Total Unplanned
Display scheduled unplanned overheads totals data
and forecasted total unplanned overhead data. Not
available if the selected value in the Show data for:
menu is Planned Overheads.

list of schedule state groups

Displays a line graph of data for the named
Schedule State Group. Names in this list are
followed by a site name, if more than one site is
selected in the Objects pane.
The Schedule State Groups list depends on the selection in
Show data for: menu. If you selected Planned Overheads in
the menu, then only planned Schedule State Groups display
in the list. If you selected Unplanned Overheads, then only
unplanned Schedule State Groups display.

Data Table
In the Data table, the group columns are ordered with the highest weight displayed in the left-most
column of the grid.

Important
An agent who is in multiple schedule state groups during an interval, is pro-rated in
the grid by the fraction of the interval that the agent is in each state group. For
example, an agent who is on break for 5 minutes and at work for 10 minutes is listed
in the Break cell as .33 and in the Work cell as .67.
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Show data for:
drop-down menu

Select from the menu a data-display scheme to
apply to the grid:

• Scheduled States Totals—Displays totals for
the schedule state groups of the currently
selected agents, regardless of type. Select this
option to disable the check boxes described
below, and to display the data in grid columns
that are selected in the Schedule States tab
of the Filter dialog box.

• Total Shrinkage—Displays totals for all
schedule state groups (except <none>) for the
currently selected agents. Select this option to
display the data in grid columns for the current
scenario and the grand total, and subcolumns
that match the selected check boxes below.

• Planned Overheads—Displays planned
overheads total for all selected agents. Select
to display the data in grid columns for the
current scenario and the grand total, and
subcolumns that match the selected check
boxes below.

• Unplanned Overheads—Displays unplanned
overheads total for all selected agents. Select
to display the data grid columns for the current
scenario and the grand total, and sub-columns
that match the selected check boxes below.

Each data-display scheme includes a Time Step column.

Grouped by name check box Select this check box to group the agents by name
when displaying schedule state totals.

Value check box

Select this check box to display the column that
shows coverage value in the grid.
This check box is disabled but checked if you selected
Scheduled States Totals in the Show data for: menu.

Value % check box

Select this check box to display the column that
shows coverage percentage in the grid. The
percentage value is calculated relative to the grand
total.
This check box is disabled and not checked if you selected
Scheduled States Totals in the Show data for: menu.

Compare with forecast
check box

Select this check box to display the column that
shows percentage data of overhead from the
forecast in the grid, shall be presented in grid.
This check box is enabled and applicable only if the same
conditions are met as for the toggle action Show Coverage and
Forecast Information.

This check box is disabled and not checked if you select
Scheduled States Totals in the Show data for: menu.
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Value cells Right-click in any cell (with a value other than zero)
to open the View Intra-Day Schedule context menu.

Using the Actions Toolbar

Use buttons on the toolbar (or commands from the Actions menu) for the following:

Icon Name Description

Time Zone

In the State Group Totals view,
when showing data for schedule
state totals, use this drop-down
list to change the default time
zone by selecting a different one.

Publish

Opens the Publish Schedule
Wizard, where you can publish a
portion of the selected scenario
to the Master Schedule, or
extract a portion of the Master
Schedule to the selected
scenario.

Add/remove scenario
elements

Opens the Add/Remove Schedule
Elements Wizard, where you can
add activities and agents to, or
remove them from, the current
schedule scenario.

Build schedule
Opens the Schedule Build Wizard,
where you can build a complete
schedule for the selected site.

Rebuild schedule

Opens the Schedule Rebuild
Wizard, where you can modify
and rebuild schedules, while
optionally leaving intact any
agent schedules that you have
edited since the last build/
rebuild.

Validate schedule

Opens the Review Messages
window, which lists scheduling
warnings for a selected site.
Warnings will be visible only if
you have already built a schedule
for this scenario and saved any
warnings that were generated.

Close
Closes the open scenario (and
prompts you to save unsaved
data).

Show Coverage and Forecast
Information

This button is a toggle. Select it
to present additional coverage
and forecast information in the
active view.
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Icon Name Description

Enabled only if any of these items are
selected on the Object pane's activity
tree: a single site activity, a single site, a
single multi-site activity, or a single
business unit.

Use Multi-Site Activities

Enabled when you select a multi-
site activity or business unit in
the Objects tree. Clicking this
button displays data for the
selected multi-site activity.
If you set this button to On, WFM retains
your last selection—in the current view
and for all other views that contain multi-
site activities—preventing you from
having to click it every time you want to
display data for the selected multi-site
activity.

Filter
Opens the Schedule Filter dialog
box. This icon is red when a filter
is applied.

Options

Opens the Options dialog box,
where you can show or hide the
columns Total Planned and
Total Unplanned in the grid
display; and change the colors
that are used in Coverage and
Forecast graphs.

Save as Template

Saves the current selections as a
Forecast template. Click this
icon (or select the command
from the Actions menu) to
display the New Forecast
Template dialog box.
Required settings: Graph
Type=Comparison, Period=Week.
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Schedule Filter Dialog
Applies to these modules: Weekly, Intra-Day, State Group Totals, Profiles/Bidding.

Use the Filter dialog box to control the activities and contracts that are displayed within the selected
site:

1. In any of these views— Weekly, Intra-day, State Group Totals, or Profiles/Bidding—click the Filter
button on the Actions toolbar.
The Filter dialog box opens.

2. Click the Agent Properties tab.
3. In the Contracts list, select the check boxes for contracts that you want to display, from a tree of BUs,

sites, and contracts. Clear the check boxes for contracts that you want to hide.

By default, all contracts are selected.
4. Select or clear the check box Include agents with matching secondary skills, to specify that the

main view includes agents who also match according to their secondary skills and activities.

Tip
This check box is not available from the Schedule State Group Totals view.

5. Click the Schedule States tab.
6. To filter agents that will be displayed within the selected site:

• If you are in the Weekly, Intra-Day, or Profiles/Bidding module, select Filter Using Following
Schedule States and then, select one (or all four schedule states: Activities, Meetings, Marked
Time, and Shifts). Each portion of this tree includes the current business unit, site(s), and the
appropriate objects (activities, meetings, marked times, or shifts).

• If you are in the State Group Totals module, this tab contains the Schedule State Groups list.
Select the check boxes for groups that you want to display. Clear the check boxes for any groups
that you want to hide. By default, all objects are selected.

7. Select the check boxes for objects that you want to display. Clear the check boxes for objects that you
want to hide.

8. Click OK.

The view is now filtered according to your selection. If you have filtered a scenario view, this filter
remains in effect until you close the scenario. However, if you select another site and then click the
Filter button, the Filter dialog box reopens with its default settings.
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Statuses Filter Dialog
Use the Statuses Filters dialog box to control which Statuses are displayed:

1. Select the check boxes for Statuses that you want to display.
By default, all Statuses are selected for display.

2. Clear the check boxes for any activities that you want to hide.
3. You can select the Statuses at the top of the list to select the entire list at once.
4. Click OK to apply your selections, or Cancel to abandon them.

WFM filters the view according to your selections.
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Options Dialog (Summary View)
Use the Options dialog box to customize the statistics that the Summary view displays.

1. Click Options on the Summary view's Actions toolbar.
The Options dialog box opens.

2. Select the check boxes for statistics that you want to display, and clear the check boxes for statistics
that you want to hide.

• Double-click the Statistics node to reveal its contained statistics.
• Select or clear all statistics at once by selecting or clearing (respectively) the Statistics node's check

box.

• Click OK.

The Summary view reappears, displaying only the statistics that you selected.

Coverage Statistics

You have the option to include two Coverage statistics in the Summary view:

• Coverage Published—Displays the schedule coverage based on the baseline Master Schedule.
• Coverage Scheduled—Displays the schedule coverage based on the current Master Schedule.
• Coverage Difference—Displays the difference between the schedule coverage based on the current

Master Schedule and schedule coverage based on the baseline Master Schedule.

Metrics

You have the option to include these Difference statistics in the Summary view:

• Difference [S/L Scheduled minus S/L Forecasted]—Displays (Service Level Scheduled minus
Service Level Forecasted).

• Difference [IV Scheduled minus IV Forecasted]—Displays (Interaction Volume Scheduled minus
Interaction Volume Forecasted).

• Difference [AHT Scheduled minus AHT Forecasted]—Displays (Average Handle Time Scheduled
minus Average Handle Time Forecasted).

• Difference [Budget Scheduled minus Budget Forecasted]—Displays (Budget Scheduled minus
Budget Forecasted).

You have the option to include these statistics in the Summary view:
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• AHT Forecasted—Displays the expected Average Handling Time, according to the Master Forecast.
• AHT Scheduled—Displays the Average Handling Time per interaction, based on the

schedule&emdash;assuming that other planned metrics remain unchanged.
• ASA Scheduled—Displays the Average Speed of Answer that would be expected with the number of

scheduled agents.
• ASA Forecasted—Displays the Average Speed of Answer that would be expected with the number of

agents from the staffing forecast.
• Difference [ASA Scheduled minus ASA Forecasted]—Displays (ASA Scheduled minus ASA

Forecasted)
• Budget Forecasted—Displays the budget for the calculated staffing for the selected day and

timesteps, based on the full-time-equivalent (FTE) paid hours per day and the salary specified in the
Forecast scenario that was published to the Master Forecast for this date. (This statistic appears
only if you have access rights to view agents' wage fields.)

• Budget Scheduled—Displays the budget for the scheduled coverage for the selected day and
timesteps, based on the full-time-equivalent (FTE) paid hours per day and the salary specified in the
Forecast scenario that was published to the Master Forecast for this date. (This statistic appears
only if you have the access rights to view agents' wage fields.)

• Deferred Service Level Difference [Scheduled minus Forecasted]—Displays the difference
between Scheduled Deferred Service Level and Forecasted Deferred Service Level statistics.

• Deferred Service Level Forecasted—Displays the service level percentage that can be expected to
be achieved, based on the number of deferred activities forecasted.

• Deferred Service Level Scheduled—Displays the service level percentage that can be achieved
given the deferred staffing coverage&emdash;assuming that other planned metrics (such as interaction
volumes and Average Handling Time) remain unchanged.

• Difference Calculated—Displays the difference between Coverage [Scheduled] and Staffing
Calculated.

• Difference Required—Displays the difference between Coverage [Scheduled] and Staffing Required.
(Optional field.)

• Headcount Scheduled—Displays the number of agents scheduled (agents scheduled to be seated).
• Interaction Volume Forecasted—Displays the expected number of interactions, according to the

Master Forecast.
• Interaction Volume Scheduled—Displays the number of interactions that can be handled based on

the schedule coverage&emdash;assuming that other planned metrics remain unchanged.
• Occupancy Forecasted—Displays the Occupancy objective that you should be able to achieve when

staffing with the number of agents from the staffing forecast.
• Occupancy Scheduled—Displays the Occupancy that you should achieve on this activity, with the

number of agents currently scheduled.
• Difference [Occupancy Scheduled minus Occupancy Forecasted]—Displays (Occupancy

Scheduled minus Occupancy Forecasted).
• Scheduled Queue—Displays the scheduled number of interactions in the backlog queue at the end of

the period.
• Service Level Forecasted—Displays the service level percentage that can be expected to be

achieved based on the number of agents forecasted.
• Service Level Scheduled—Displays the service level percentage that can be achieved given the
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staffing coverage&emdash;assuming that other planned metrics (such as interaction volumes and
Average Handling Time) remain unchanged.

• Staffing Calculated—Displays the required number of agents as calculated by WFM, based on the
forecasted interaction volumes, AHT, and applicable service objectives.

• Staffing Required—Displays The required number of agents as defined by the user, either by explicitly
entering forecast targets or by using a template. (Optional field.)

For in-depth descriptions of these statistics and the formulae used to derive them see "WFM Metrics"
in the Workforce Management Administrator's Guide.

Background on Baseline Master Schedule

When you publish a schedule scenario to the Master Schedule, WFM retains a snapshot of the
Master Schedule at that point in time. This is the baseline Master Schedule.

Then, after you or other schedulers make changes to the schedule such as adding exceptions and
granting vacations, you can compare the schedule coverage shown in the current Master Schedule
against the schedule coverage stored in the baseline Master Schedule.

This baseline of the Master Schedule is created/updated at the last time something was published
to the Master Schedule for a particular date range. For example, assume on May 25 you publish the
June schedule scenario to the Master Schedule, and then on May 28 you re-publish the same June
schedule scenario to the Master Schedule. In this case, WFM uses the May 28 published schedule
as the baseline against which the current schedule is compared.
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Options Dialog (Weekly View)
Use the Options dialog box to configure the data that is shown on the Weekly view or Master
Weekly view.

Use the Options dialog to configure the data that is shown on the Weekly view or Master Weekly
view.

Open the Options dialog by clicking Options in the Actions toolbar or selecting Options in the
Actions menu.

To configure options on the Options tab:

• Select the Show agents with granted and scheduled rotating pattern or any other calendar
preference check box.

When the check box is selected, the grid shows the schedule days that contain such an item. A red
check box and Agent icon appears in the leftmost column (labeled "!") for every agent who meets
these conditions.

Tip
You can use this tool to learn whether an agent was given a schedule based on a
schedule preference, which might influence your decision to modify this agent's
schedule. This icon is displayed only if the agent was given a rotating pattern or
preference (such as for time off) as a result of building a schedule. If an agent’s
schedule is manually edited to give him or her one of his or her preferences, or a
schedule from a rotating pattern, then the icon will not be displayed.

To configure options on the Columns tab:

• Select Agent Rank to add a column to the Weekly View grid that displays an agent's Rank value.
• Select Site Name to display the Site column.
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Swap Agent Schedules Wizard
Use the Swap Agent Schedules Wizard to swap the schedules of two agents in the same schedule
scenario or Master Schedule:

Tip
When swapping shifts or schedules, select agents within the same site only

1. Click the Swap button on the Actions toolbar of an Intra-Day, Agent-Extended, or Weekly view.
• For Weekly view, the Select Date and First Agent screen opens. Continue with Step 2.
• For Agent-Extended or Intra-Day view:

• If you previously selected an agent, the Select Second Agent screen opens. Continue with
Step 5.

• If you select no agent, the Select Date and First Agent screen opens. Continue with Step 2.

2. Select the Start Date and End Date.
These dates must lie within the schedule scenario's date range.

3. From the Select Agent list, select the first agent.
In this hierarchical list, you can expand business units to display sites, teams, and agents.
You can select a single real or profile agent.

4. Click Next.
The Wizard's second screen, Select Second Agent, opens.

5. From the Select Agent to Swap with list, select the agent with whom you want to swap schedules.
You can select a single real or profile agent.

6. Click Finish.

If the swap is successful, the wizard closes and returns you to the view from which you opened it.
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Sorting Dialog
Use the Sorting dialog box to sort the Weekly, Intra-Day, and Profile/Bidding views.

1. Select the item by which you want to sort. Agent Name is the default sort option.
If agents do not have the option by which you are sorting, they appear last in the list.

• Weekly view—Team Name, Contract, Agent Name (first or last), Agent Rank, or Site Name. You can
sort in ascending or descending order. Note that Agent Rank sorts in apparent reverse order due to
limitations imposed by multi-sorting by both agent name and rank.

• Intra-Day view—Site, Team, Contract, Agent (first or last), Shared Transport, Overtime, Paid Hours,
Total Hours, Shift Start Time, Shift End Time, Shift, Start Time of First Exception.

• Profile/Bidding view—Site Name, Team Name, Agent Name (first or last), and Contract.

Important
If you select Start Time of First Exception, agents with full-day exceptions appear after agents with part-
day exceptions. Agents with no exceptions appear at the bottom of the list.

• Click Apply.

The view is now sorted by the item that you selected. If you have sorted a scenario view, it retains
this sort order until you close the scenario.
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Review Swapping Messages
After you swap agent schedules, you might receive messages warning you that the swap results in
constraint violations. For example, the new shift assignment might violate an agent's Contract.

If there are problems, the Review Messages dialog box opens. For each issue, the Review
Messages dialog box shows the name of the affected agent and explains the problem.

After reviewing each entry in the list, do one of the following:

• Click Perform Anyway to make the swap in spite of the constraint violation(s).
• Click Cancel to cancel the swap and return the schedule to its former state.
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Reviewing Messages
Use the Review Messages dialog box to view any warnings or errors that the server returned, in a
variety of situations.

The dialog box contains the following columns and controls:

Team Name The team to which the agent belongs.
Agent Name The agent whose action(s) generated this message.
Date The date that the messages was generated.

Messages The message type (either Warning or Error),
numeric code, and the message text.

Action This drop-down menu presents three choices:
Save, Fix Later, and Do Not Save.

Close Closes the dialog box and does not retrieve fresh
data from the server.

OK Closes the dialog box and retrieves fresh data from
the server.

Help Displays this help topic.
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Insert Multiple Wizard
Use the Insert Multiple Wizard (IMW) to add an item, such as a break, into multiple agents'
schedules at once. You can use it in either Scenarios or the Master Schedule.

Using the Insert Multiple Wizard

To use the wizard:

1. In Intra-Day, Agent-Extended, or Weekly view, select Insert Multiple from one of the following:
• Actions toolbar
• Actions menu
• Right-clicking the Shortcut menu (not in Weekly view)

The Select Activities screen opens. If you have unsaved changes, WFM Web prompts you
to save them before proceeding.

2. Select one or more activities to insert.
The Select Agents page opens.

3. Select the agents whose schedules you are editing. (Agents without skills are not displayed in the
Select Agents page.)

4. Click Next.
5. Select the dates in which to insert items, and then click Next.
6. On the Select State Type page, select a state, and then click Finish (for a Day Off) or Next (for other

schedule items).
7. Fill in the breaks, meals, exceptions, time off, shift, marked time, or work set selection page that

appears next.
8. Click Finish.

When the view reappears:

• If the Auto-Commit inserted items check box was enabled, and you are editing a schedule scenario,
your changes are committed to the scenario.

• If the Auto-Commit inserted items check box was not enabled and you are editing a schedule
scenario, then your changes appear in the schedule in Pending mode. You must commit them or roll
them back with the Commit/Rollback Multiple wizard.

Pending changes in a schedule scenario are not transferred to the Master Schedule when the
scenario is published. If you are editing the Master Schedule, and the Auto-Commit inserted
items check box is enabled, then the changes are committed to the Master Schedule are visible to
all users.
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Auto-Committing Inserted Items
In step 3 above, if you are using the Insert Multiple feature in one of the Master Schedule views
and you have the Approve Changes security permission, you can select the Auto-commit
inserted items check box to have your changes immediately inserted into the schedule. If you do
not have the necessary security permission, this check box is cleared and disabled. In that case, any
inserts that you make are pending, and they must be committed or approved before they can take
effect in the official version of the Master Schedule.

If you are using one of the Scenario views, this check box is always enabled.

If the Auto-Commit inserted items check box is not enabled, then changes go into a Pending
mode and appear to you, but not to other users, in the Master Schedule views. Pending changes in
the Master Schedule must either be:

• Reviewed and approved/declined by a user with Approve Changes permissions (through the Master
Schedule Changes Approval view) or

• Committed or rolled back by you, if you have Approve Changes permissions, through the Commit/
Rollback Multiple wizard.
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IMW: Select Activities
To complete the Select Activities page in the Insert Multiple Wizard (IMW):

1. Select any combination of multi-site activities and activities.
You can expand business units to display their multi-site activities and sites, and expand sites to display
their activities. Only objects that were selected at the last time you clicked Get data are available. By
default, all are selected.

2. Click Next to apply your selections and continue, or click Cancel to make no changes and close the
wizard.
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IMW: Select Agents
To fill in the Select Agents page in the Insert Multiple Wizard (IMW):

1. Select any combination of agents.
You can select individual agents from multiple teams, or you can select whole teams or the whole site.
Only objects that you had selected the last time you clicked Get data are available.

2. If you want, select Insert only if there are no errors and/or Show warnings.

If you select the Insert only if there are no errors check box, then when you try to save the new
items, WFM Web will not insert any of them if the server returns any schedule validation errors.

If you select the Show warnings check box, WFM Web displays any schedule validation warnings that
would be generated if the items were inserted into agents' schedules.

Tip
If schedule validation errors also occur, WFM Web does not insert any of your changes into the schedule.

3. If you are editing the Master Schedule and have Approve Changes security permission, you can
select the Auto-Commit inserted items check box to have your changes immediately inserted into
the Master Schedule. If you do not have the necessary security permission, this check box is cleared
and disabled. In that case, any inserts that you make are pending, and they must be reviewed and
approved before they can take effect in the Master Schedule.

If you are editing a schedule scenario, you have the option to select the Auto-Commit inserted
items check box. If checked, your changes are committed to the schedule scenario. If not checked,
your changes go into a Pending state. They can be committed or rolled back by you using the Commit/
Rollback Multiple wizard. Pending changes in a schedule scenario are not transferred to the Master
Schedule when the scenario is published.

4. Click Next to open the Select Dates page.
Click Cancel if you want to close the wizard without saving your selection.
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IMW: Select Dates
The Select Dates page in the Insert Multiple Wizard (IMW) contains a calendar.

1. Select the date or dates into which to insert the schedule items.

The calendar works as described in How to Use the Calendar.

Tip
If you are inserting into a schedule scenario, you cannot select dates that fall outside of the scenario's date
range.

2. Click Next.

If you want to close the wizard without saving your selection, click Cancel.
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IMW: Select State Type
To fill in the Select State Type page in the Insert Multiple Wizard (IMW):

1. Select the state type that you want to insert.
If you selected agents from more than one site at the Select Agents page, then only these
types are available Day Off, Exception, Time Off, Marked Time, and Work Set.

2. Click Finish or Next (to proceed to the next page).
The button that is enabled depends on the state that you have selected

• Finish button—Enabled if you select Day Off. Click it to insert a day off on the selected dates for the
selected agents and close the wizard.

• Next button—Enabled if you select any other state. Click it to open the appropriate wizard page for
selecting breaks, meals, exceptions, time off, shift, marked time or work set.

3. To review or change your entries on the Select Dates page, click Previous.
Or click Cancel to close the wizard without saving your selection.
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IMW: Select Shift
To fill in the Select Shift page in the Insert Multiple Wizard (IMW):

1. Select the shift that you want to insert.
2. If the selected shift ends on the day after it begins, select Next Day next to the End Time text box.
3. Select the Automatically Insert Meals and Breaks check box to enable that function.
4. Click Next to open the Select Activity Set page.
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IMW: Select Activity Set
To fill in the Select Activity Set page in the Insert Multiple Wizard (IMW):

1. Select the check box next to each activity that you want to insert.
2. Click Finish.
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IMW: Select Break
To fill in the Select Break page Insert Multiple Wizard (IMW):

1. Select a break from the Choose Item to Insert list.
• Click a single row to select its break. (If more breaks are hidden above or below the displayed list

items, a vertical scroll bar appears to the right to help you reveal them.) The list shows all of the
breaks that have been configured for the selected site in WFM Web.
The list's columns show each break's full name, short name, how long it lasts, and
whether or not the break is paid. You cannot select or clear the Paid check box here.

2. Fill in the Start time and End time text boxes for this break.
Type in the times that you want, or use the up or down arrows to modify the displayed
times.

3. Select Next Day next to the Start Time and End Time text boxes if the break starts on the day after
the agents' shifts begin.
— or —

4. Select Next Day next to the End Time text box if the break begins on the same day as the agents'
shifts begin, but ends on the day after.

5. Click Finish to insert the selected break and close the wizard.
This returns you to the Intra-Day view.
• If you want to review or change your entries in the Select State Type page, click Previous.
• If you want to close the wizard without inserting the break, click Cancel.
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IMW: Select Meal
To fill in the Select Meal page Insert Multiple Wizard (IMW):

1. Select a meal from the Choose Item to Insert list.
• Click a single row to select its meal. (If more meals are hidden above or below the displayed list

items, a vertical scroll bar appears to the right to help you reveal them.) The list shows all of the
meals that have been configured for the selected site in WFM Web.
The list's columns show each meal's full name, short name, how long it lasts, and
whether or not the meal is paid. You cannot select or clear the Paid check box here.

2. Fill in the Start time and End time text boxes for this meal.
Type in the times that you want, or use the up or down arrows to modify the displayed
times.

3. Select Next Day next to the Start Time and End Time text boxes if the meal starts on the day after
the agents' shifts begin.
— or —

4. Select Next Day next to the End Time text box if the meal begins on the same day as the agents'
shifts begin, but ends on the day after.

5. Click Finish to insert the selected meal and close the wizard.
This returns you to the Intra-Day view.
• If you want to review or change your entries in the Select State Type page, click Previous.
• If you want to close the wizard without inserting the meal, click Cancel.
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IMW: Select Exception
To fill in the Select Exception page Insert Multiple Wizard (IMW):

1. Select a exception from the Select Exception list.
• Click a single row to select its exception. (If more exception are hidden above or below the displayed

list items, a vertical scroll bar appears to the right to help you reveal them.) The list shows all of the
exception that have been configured for the selected site Policies module of WFM Web.
The list's columns show each exception's full name, short name, whether it is paid, whether it
counts as time off, whether the exception is convertible to a day off, whether it is a full-day
exception, and all sites to which it is assigned.

Tip
The check boxes simply indicate the exception's configured properties. You cannot select or clear them
here.

2. If the Start time and End time text boxes are enabled, fill them in for this exception.
Either type in the times that you want, or use the up or down arrows to modify the displayed times.

3. Select Next Day next to the Start Time and End Time text boxes if the exception starts on the day
after the agents' shifts begin.
— or —

4. Select Next Day next to the End Time text box if the exception begins on the same day as the agents'
shifts begin, but ends on the day after.
• If you selected a full-day, paid exception, you can select the Specify Paid Hours check box to

enter a duration other than the default number of hours in a work day.
• If you select the Specify Paid Hours check box, the Paid Hours text box becomes editable.

5. Click Finish to insert the selected exception and close the wizard.
This returns you to the Intra-Day view.
• If you want to review or change your entries in the Select State Type page, click Previous.
• If you want to close the wizard without inserting the exception, click Cancel.

Important
WFM requests approval to insert new exceptions that overlap existing exceptions with
this message for each exception/agent instance: Warning: Newly inserted state
Exception name (date & time) is replacing an existing state exception name (date &
time) that it overlaps.

All requests appear in the Review Messages dialog box, where you can approve or reject each instance. This
behavior applies only to part-day exceptions that overlap part-day exceptions; other instances (such as full-
day exceptions) are still rejected.
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IMW: Select Time Off
To fill in the Select Time Off page Insert Multiple Wizard (IMW):

1. Select a time-off type from the Select Time Off list.
• Click a single row to select its time-off type. (If more time-off types are hidden above or below the

displayed list items, a vertical scroll bar appears to the right to help you reveal them.)
The list shows all of the time-off types that have been configured for the selected site in the
Policies module of WFM Web.
The list's columns show each time-off type's name, short name, whether or not the time off is paid,
whether the time off counts toward the configured time-off limits, and all sites to which Time Off is
assigned.

• Select the Show all check box to display all Time-Off types.
Clear the check box to display only the Time-Off types that are applicable to the selected agent.
See the Time-Off Primer in the Workforce Management Administrator's Guide.

Tip
The Paid and Counts check boxes are informational only. You cannot select or clear them.

2. If the time-off item is part-day, fill in the Start time and End time text boxes. Type in the times that
you want, or use the up or down arrows to modify the displayed times.

3. Select Next Day next to the Start Time and End Time text boxes if the time-off period starts on the
day after the agents' shifts begin.
— or —

4. Select Next Day next to the End Time text box if the time-off period begins on the same day as the
agents' shifts begin, but ends on the day after.

5. If the time off is for the entire day, select the Full Day check box. This disables the start time and end
time text boxes.

6. Click Finish to insert the selected time off and close the wizard.
This returns you to the Intra-Day view.
• If you want to review or change your entries in the Select State Type page, click Previous.
• If you want to close the wizard without inserting the time off, click Cancel.
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IMW: Select Marked Time
To fill in the Select Marked Time page in the Insert Multiple Wizard (IMW):

1. Select the marked time that you want to insert.
2. Adjust the Start time and End time, as necessary.
3. Select Next Day next to the Start Time and End Time text boxes if the marked time starts on the day

after the agent's shifts begin.
— or —

4. Select Next Day next to the End Time text box if the marked time begins on the same day as the
agent's shifts begin, but ends on the day after.

5. Click Finish.
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IMW: Select Work Set
In WFM, work sets are used to configure the time interval within the shift when agents are working
only on specified activities. You can include several activities or a single activity set into a work set.

Insert work sets by using the steps described in the procedure below or by selecting it in the Intra-
day view's pop-up menu (using a right-click, in the same way you insert other items, such as time off,
exceptions, or marked time).

In the Insert Multiple Wizard (IMW), you select Work sets using 1 or 2 pages, depending on your
choices:

• Specify work set parameters
• Select activities for work set screen

Specify Work Set Parameters Page

1. Select or enter the Start time and End times.
2. Select Next Day (next to the Start Time text box) if the work set starts on the day after the agent's

shifts begin.
— or —
Select Next Day (next to the End Time text box) if the work set begins on the same day as the
agent's shifts begin, but ends on the day after.

3. Select one of these radio buttons:
• Select new activities for Work Set—Enables the Select activities for work set screen, where you

select the new activities.
• Use existing shift activities—Applies the activities already selected.

4. Select or clear the check box Mark as overtime with marked time.
Select to enable the Marked Time page when you're done with activities.

5. Click Next (if you selected the radio button Select new activities for Work Set or the check box
Mark as overtime with marked time) or click Finish.

Select Activities for Work Set Page

This page appears only if you selected the Select new activities for Work Set radio button.

1. Select one or more activities from the tree.
2. Click Next (if you selected the check box Mark as overtime with marked time in the previous page) or
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click Finish.

Marked Time with Overtime

To fill in the Select marked time with overtime page in the Insert Multiple Wizard (IMW):

Important
This page in the wizard appears only if you checked the Mark as overtime with
marked time check box on the Specify work set parameters page of this wizard.

1. Select a Marked Time.
2. Click Finish.

If you want to close the wizard without inserting the marked time, click Cancel.
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IMW: Review Messages
Use the Review Messages dialog box in the Insert Multiple Wizard (IMW) to respond to any
warnings returned when you tried to save agents' edited schedules.

1. For each Warning that is listed, check the items you want to insert and then click Insert for selected.
To select all Warnings, use the Select All Warnings check box.

2. Review all Errors.
You cannot select the check box next to the Error.

To cancel out without applying any changes, click Close.

The Review Messages dialog box includes the following columns and controls:

Date Displays the schedule date.

Agent Displays the agent whose schedule generated this
message.

Team Displays the agent's team.

Message Displays the message type (either Warning or
Error), and the message text itself.

Select All Warnings Marks the check box for all Warnings.

Insert For Selected Closes the dialog box, applies your selected
actions, and retrieves fresh data from the server.

Close Closes the dialog box without saving or refreshing
data.

Important
These errors and warnings are generated by schedule changes that you made
manually in the Agent-Extended, Intra-Day, or Weekly view. They differ from
Validation warnings and errors, which WFM Web generates during the schedule
building process.
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Edit Multiple Wizard
Use the Edit Multiple function to edit one or more items from agents' schedules at once. You can use
the Edit Multiple Wizard by opening it from the toolbar or Actions menu in the following views:

• Scenarios > Intra-Day
• Scenarios > Agent-Extended
• Master Schedule > Intra-Day
• Master Schedule > Agent-Extended

To use the wizard:

1. In the Intra-Day or Agent-Extended view, use the Actions menu to open the wizard by selecting Edit
Multiple, or click the icon in the toolbar.

2. When the wizard opens, make the appropriate selections and change settings, as necessary, in each of
the following screens (as described below):
• Select date
• Select activities
• Select agents
• Select state types
• Select states

3. Click Finish.

When the view reappears:

• If the Auto-Commit inserted items check box is enabled, and you are editing a schedule scenario, your
changes are committed to the scenario.

• If the Auto-Commit inserted items check box is not enabled and you are editing a schedule scenario,
then your changes appear in the schedule in Pending mode. You must commit them or roll them back
with the Commit/Rollback Multiple wizard.

Pending changes in a schedule scenario are not transferred to the Master Schedule when the
scenario is published. If you are editing the Master Schedule, and the Auto-Commit inserted
items check box is enabled, then the changes are committed to the Master Schedule and visible to
all users.

Select date

This page in the wizard contains a calendar.
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1. Select the date for the schedule items you want to change.
If you are editing a schedule scenario, you cannot select dates that fall outside of the
scenario's date range. The calendar works as described in How to Use the Calendar.

2. Select a Start Time and End Time and, if applicable, check the Next Day check box.
3. Select the Time Zone.

If you select Local or User for time zone, agent states will display in the time zone of the
agent's site. Keep this in mind if you are selecting agents from multiple sites.

4. Click Next.
If you want to close the wizard without saving your selection, click Cancel.

Select activities

1. Select any combination of activities and multi-site activities.
Expand business units to display their multi-site activities and sites, and expand sites to
display their activities. Only objects that were selected at the last time you clicked Get data
are available. By default, all are selected.

2. Click Next to apply your selections and continue, or click Cancel to make no changes and close the
wizard.

Select agents

1. Select any combination of agents.
2. Select individual agents from multiple teams, or you can select whole teams or the whole site. Only

objects that you selected the last time you clicked Get data are available.
3. Optionally, select Insert only if there are no errors and/or Show warnings.

• If you select the Insert only if there are no errors check box and try to save the new items, WFM
Web will not insert any of them if the server returns any schedule validation errors.

• If you select the Show warnings check box, WFM Web displays any schedule validation warnings
that would be generated if the items were inserted into agents' schedules. If schedule validation
errors also occur, WFM Web does not insert any changes into the schedule.

• If you are editing the Master Schedule and have Approve Changes security permission, you can
select the Auto-Commit inserted items check box to have your changes immediately inserted
into the Master Schedule. If you do not have the necessary security permission, this check box is
cleared and disabled. In that case, any inserts that you make are pending, and they must be
reviewed and approved before they can take effect in the Master Schedule.

• If you are editing a schedule scenario, you have the option to select the Auto-Commit inserted
items check box. If checked, your changes are committed to the schedule scenario. If not checked,
your changes go into a Pending state. They can be committed or rolled back by you using the
Commit/Rollback Multiple wizard. Pending changes in a schedule scenario are not transferred to the
Master Schedule when the scenario is published.

4. Click Next to open the next dialog in the wizard, or click Cancel if you want to close the wizard without
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saving your selection.

Select state types

1. Select the state type that you want to edit: Breaks, Meals, Exception, and Time Off.
Only part-day exceptions and time off are displayed. You cannot edit full-day items when
using this wizard.

2. Click Next (to proceed to the next page).
3. To review or change your entries in other dialog in the wizard, click Previous, or click Cancel to close

the wizard without saving your selection.

Select states

1. Select the agents' states you want to change, and then make changes by clicking the following radio
buttons and check boxes:
• Move start time—Enter a new start time and click either the Forward or Backward radio button.
• Set start time—Enter a new start time and, if applicable, check the Next Day checkbox.
• Change duration—Click the check box to enable and enter a new value for the duration.
• Move to date—Click the check box to enable and enter a new value for the date within 6 weeks of

the schedule date range. WFM will display an error if you select dates outside of this limit.

2. Click Finish.
After making changes in this screen and clicking Finish, the Review Messages dialog might
open to display error or warning messages. To understand when and why it sometimes
appears, see Review Messages.

Review Messages

In the Edit Multiple wizard, the Review Messages dialog contains any warnings or errors that
display if the start and end times entered in the Select state types page are not within the shift's
time range. Depending on what values you change, you'll see one of two error messages:

• Error: The start time and end time of the state must be within the agent's day range.

• Error: The duration of agent state must be greater than 0.

If the new values for start and end time or duration for the selected state are not within an
acceptable range for the agent's shift, the Repeat update button is disabled. If you click Back, the
changed values appear in red. Only after you've changed the value to within an acceptable range will
they appear in black again and no further error messages will display.
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The dialog contains the following details:

Team Name The team to which the agent belongs.
Agent Name The agent whose schedule item is being changed.
Date The date that the message was generated.

Messages The message type (either Warning or Error),
numeric code, and the message text.

Action

Click one of two buttons:

• Back—Enables you to go back and change the
values you initially entered (if you receive an
error message).

• Repeat update—Enables you to retry the
values you initially entered.

Close Closes the dialog box and does not retrieve fresh
data from the server.

Help Displays this help topic.
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Delete Multiple Wizard
Use the Delete Multiple function to remove one or more items from one or more agents' schedules
at once. You can use the Delete Multiple Wizard (DMW) to delete items from either schedule
scenarios or the Master Schedule.

To use the Delete Multiple Wizard:

1. From the Agent-Extended, Intra-Day, or Weekly view's Actions toolbar or Actions menu, select
Delete Multiple.
If you have unsaved changes, WFM Web prompts you to save them before proceeding.

2. Select activities from the Delete Multiple Wizard's screen Select Activities.
3. Select agents from the Delete Multiple Wizard's screen Select Agents.

Tip
Agents without skills are not displayed in the Select Agents screen.

4. Select the agents whose schedules you are editing.

Important
If you are deleting items from the Master Schedule and you have the Approve Changes security
permission, you can select the Auto-Commit deleted items check box to have your items immediately
deleted from the Master Schedule. If you do not have the necessary security permission, this check box is
cleared and disabled. In that case, any deletions that you make are pending, and they must be reviewed and
approved before they can take effect in the Master Schedule. If you are deleting items from a schedule
scenario, you have the option to select the Auto-Commit deleted items check box. If selected, then your
deletions are committed to your schedule scenario. If not selected, then your deletions go into a Pending
state. They can be committed or rolled back by you using the Commit/Rollback Multiple wizard. Pending
changes in a schedule scenario are not transferred to the Master Schedule when the scenario is published.

5. Click Next.
6. Select the dates from which to delete items in the Select Dates screen, then click Next.

Warning
Any item that overlaps the dates and times selected will be deleted, even if it overlaps by as little as a
minute.

7. In the Select State Types view, select one or more states. Then click Next.
8. Fill in the Select Breaks, Select Meals, Select Exceptions, Select Time Offs or Select Marked Times screen

that appears next. Then click Finish.
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The view reappears. If Auto-Commit was on, your changes are committed to the schedule. If not,
the changes are in a Pending mode.
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DMW: Select Activities
To complete the Select Activities screen in the Delete Multiple Wizard (DMW):

1. Select any combination of multi-site activities and activities.

You can expand business units to display their multi-site activities and sites, and expand sites to display
their activities. Only objects that were selected at the last time that you clicked Get data are available.
By default, all are selected.

2. Click Next to apply your selections and continue, or click Cancel to make no changes and close the
wizard.
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DMW: Select Agents
To fill in the Select Agents screen in the Delete Multiple Wizard (DMW):

1. Select any combination of agents.

You can select individual agents from multiple sites and multiple teams, or you can select whole teams
or whole sites. Only agents who are selected on the Object pane’s Agents tree and who can work on
activities that are selected in the first page of this wizard are available for selection.

The list of available agents is also affected by the filter dialog check box Include agents with matching
secondary skills.

2. If you want, select Delete only if there are no errors and/or Show warnings.
• If you select the Delete only if there are no errors check box, then when you try to save the new

items, WFM will not delete any of them if the server returns any schedule validation errors.
• If you select the Show warnings check box, WFM displays any schedule validation warnings that

would be generated if you were to delete the items from the agents' schedules.

Important
If schedule validation errors also occur, WFM does not delete any items from the schedule.

3. If you are deleting items from the Master Schedule and you have the Approve Changes security
permission, you can select the Auto-Commit deleted items check box to have your deletions
immediately made to the Master Schedule. If you do not have the necessary security permission, this
check box is cleared and disabled. In that case, any deletions that you make are Pending. They must
be reviewed and approved before they can take effect in the Master Schedule.

If you are deleting items from a schedule scenario, you have the option to select the Auto-Commit
deleted items check box. If you do, then your deletions are committed to your schedule scenario. If
not, then your deletions go into a Pending state. They can be committed or rolled back by you using
the Commit/Rollback Multiple wizard. Pending changes in a schedule scenario are not transferred to the
Master Schedule when the scenario is published

4. Click Next to open the Select Dates screen.

Click Cancel if you want to close the wizard without saving your selection.
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DMW: Select Dates
The Select Dates screen in the Delete Multiple Wizard (DMW) contains a calendar.

1. Select the date or dates from which you want to delete the schedule items.
The calendar works as described in How to Use the Calendar.

Tip
If you are deleting from a schedule scenario, you cannot select dates that fall outside of the scenario's date
range.

2. Click Next.
The Select State Type screen appears.

Warning
Any item that overlaps the dates and times selected will be deleted, even if it overlaps by as little as a
minute.
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DMW: Select State Types
To fill in the Select State Types screen in the Delete Multiple Wizard (DMW):

1. Select the state or states that you want to delete. You can delete breaks, meals, exceptions, time off,
or marked time.

2. Click Next.

The screen that appears next depends on your selections on this screen. If you are deleting one state
type, the screen for that state appears. Otherwise, the screens appear one after the other in the order
Select Breaks, Select Meals, Select Exceptions, Select Time Off, and Select Marked Time.

3. If you want to review or change your entries in the Select Dates screen, click Previous.
Or, if you want to close the wizard without saving your selection, click Cancel.
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DMW: Select Breaks
To fill in the Select Breaks screen in the Delete Multiple Wizard (DMW):

1. Select one or more breaks from the Select Breaks list. (If more breaks are hidden above or below the
displayed list items, a vertical scroll bar appears to the right to help you reveal them.)
• To select individual items, hold down the Ctrl key while you select. To de-select, continue holding

Ctrl and click the item(s) you wish to de-select.
• For a range of items, select the first item, hold down the Shift key, select the last item in the range.

To revise the range, continue holding Shift and click the last item to be included in the range.

The list shows all of the breaks that have been configured for the selected site in the WFM
Web. The list's columns show each break's full name, short name, how long it lasts,
whether or not the break is paid, and the site in which the break's site name is shown. You
cannot select or clear the Paid check box here.

2. If you selected to delete meals, exceptions, time off, or marked time, click Next.
Otherwise, click Finish to delete the selected breaks and close the wizard. This returns you
to the Agent-Extended, Intra-Day, or Weekly view.
• If you want to review or change your entries in the Select State Types screen, click Previous.
• Or, if you want to close the wizard without saving your selection, click Cancel.
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DMW: Select Meals
To fill in the Select Meals screen in the Delete Multiple Wizard (DMW):

1. Select one or more meals from the Select Meals list. (If more meals are hidden above or below the
displayed list items, a vertical scroll bar appears to the right to help you reveal them.)
• To select individual items, hold down the Ctrl key while you select. To de-select, continue holding

Ctrl and click the item(s) you wish to de-select.
• For a range of items, select the first item, hold down the Shift key, select the last item in the range.

To revise the range, continue holding Shift and click the last item to be included in the range.

The list shows all of the meals that have been configured for the selected site in the WFM
Web. The list's columns show each meal's full name, short name, how long it lasts, whether
or not the meal is paid, and the site in which the meal's site name is shown. You cannot
select or clear the Paid check box here.

2. If you selected to delete exceptions, time off or marked time, click Next.
Otherwise, click Finish to delete the selected meals and close the wizard. This returns you
to the Agent-Extended, Intra-Day, or Weekly view.
• If you want to review or change your entries in a previous screen, click Previous.
• Or, if you want to close the wizard without saving your selection, click Cancel.
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DMW: Select Exceptions
To fill in the Select Exceptions screen in the Delete Multiple Wizard (DMW):

1. Select one or more exceptions from the Select Exceptions list. (If more exceptions are hidden above
or below the displayed list items, a vertical scroll bar appears to the right to help you reveal them.)

• To select individual items, hold down the Ctrl key while you select. To de-select, continue holding Ctrl
and click the item(s) you wish to de-select.

• For a range of exceptions, select the first exception, hold down the Shift key, select the last exception
in the range. To revise the range, continue holding Shift and click the last exception to be included in
the range.

The list shows all of the exceptions that have been configured for the selected site in the Policies
module of WFM Web. The list's columns show each exception's full name, its short name, whether it is
paid, whether it is convertible to a day off, whether it is a full-day exception, and all sites to which the
exception is assigned.

Tip
The check boxes simply indicate the exception's configured properties. You cannot select or clear them here.

• If you selected to delete time off or marked time, click Next.
Otherwise, click Finish to delete the selected exceptions and close the wizard. This returns you to the
Agent-Extended, Intra-Day, or Weekly view.

• If you want to review or change your entries in a previous screen, click Previous.
• Or, if you want to close the wizard without saving your selection, click Cancel.
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DMW: Select Time Offs
To fill in the Select Time Offs screen in the Delete Multiple Wizard (DMW):

1. Select one or more time-off types from the Select Time Offs list. (If more time-off types are hidden
above or below the displayed list items, a vertical scroll bar appears to the right to help you reveal
them.)

• To select individual time-off types, hold down the Ctrl key while you select. To de-select, continue
holding Ctrl and click the item(s) you wish to de-select.

• For a range of time-off types, select the first time-off type, hold down the Shift key, select the last time-
off type in the range. To revise the range, continue holding Shift and click the last time-off type to be
included in the range.

The list shows all of the time-off types that have been configured for the selected site in the Policies
module of WFM Web. The list's columns show each time-off type's full name, its short name, whether it
is paid, whether it counts toward the configured time-off limits, and all sites to which Time Off is
assigned.

Tip
The check boxes simply indicate the time-off type's configured properties. You cannot select or clear them
here.

• If you selected to delete marked time, click Next.
Otherwise, click Finish to delete the selected time-off items, and all other selected items, and close the
wizard. This returns you to the Agent-Extended, Intra-Day, or Weekly view.

• If you want to review or change your entries in a previous screen, click Previous.
• Or, if you want to close the wizard without saving your selection, click Cancel.
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DMW: Select Marked Times
To fill in the Select Marked Times screen in the Delete Multiple Wizard (DMW):

1. Select the marked time items that you want to delete.
2. Click Finish to delete the selected marked time items, and all other selected items, and close the

wizard.
You return to the Agent-Extended, Intra-Day, or Weekly view.
• To review or change your entries in a previous screen, click Previous.
• To close the wizard without saving your selection, click Cancel.
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Commit/Rollback Multiple Wizard
Use the Commit/Rollback Multiple Wizard (CRW) to commit or roll back all pending schedule
changes for selected agents on selected dates. You can use this wizard in Agent-Extended, Intra-
Day, or Weekly view for a schedule scenario or the Master Schedule.

Important
You must have the Approve Changes security permission enabled to commit
pending changes to the Master Schedule. If you do not, you can use this wizard only
to roll back pending changes. If you are working in a schedule scenario, then you can
commit/rollback all pending changes.

Terminology

• Commit—Committing a pending change makes it part of the Commit/Rollback Wizard publically-
available scenario or Master Schedule. When a schedule scenario is published, only committed
changes appear in the Master Schedule.

• Rollback—Rolling back pending changes removes them from possible inclusion in the scenario or
Master Schedule.

• Pending—A schedule change will be put in Pending status in three cases:
1. The user making changes to the Master Schedule does not have security permissions to approve

changes in the Schedule module.
2. The user who is making changes to the Master Schedule does have permission to approve

changes, but turns off Auto-Commit ( ).
3. The user is working with a schedule scenario and turns off the Auto-Commit icon.
In all cases, the user must click Save for the changes to be evaluated by the system (and appropriate warnings generated). At
that point, the changes go into a Pending state if any of the three conditions are met.

Users can see changes that are Pending because they will have an upside-down red triangle (yield icon) in the left-most column
of the schedule view. However, if the user does have Approve Changes permission and does have the Auto-Commit icon
enabled, then when the user clicks Save, barring any warnings, these changes will become Committed to the schedule.

So, with Pending changes, the user may invoke the Commit/Rollback Wizard to either commit
pending changes for selected agents and dates, or roll those pending changes back, which is basically
undoing those pending changes for the selected agents and dates

If you have the Approve Changes permission, there are two additional ways to work with pending
schedule changes:

• You can approve or reject pending changes to the Master Schedule using the Master Schedule Change
Approval module. The Changes Approval module enables you to view each pending change before
deciding whether to approve or reject them. Using the Commit/Rollback Multiple Wizard, you
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commit or roll back all changes for the selected agents and dates without seeing each change.
• You can commit or roll back all items in an agent's schedule day that have pending status directly in the

Master Schedule Intra-Day or Master Schedule Agent-Extended views. To do so, right-click the
row showing the agent's schedule and then select Commit or Rollback. If you are working in a
schedule scenario, you can do this regardless of whether or not you have Approve Changes
permissions.

Using the Commit/Rollback Multiple Wizard

To use the wizard:

1. From the view's Actions toolbar or Actions menu, select Commit/Rollback Multiple.
If you have unsaved changes, WFM Web prompts you to save them before proceeding.
The Commit/Rollback Multiple Wizard's first screen, Select Activities, opens.

2. Select the activities whose pending changes you want to commit or roll back.
The Commit/Rollback Multiple Wizard's next screen, Select Agents, opens.

3. Select the agents whose pending changes you want to commit or roll back.
Note that agents without skills are not displayed in the Select Agents screen.

4. Select whether to commit or roll back pending changes.
5. Click Next.
6. In the [[CRBSltDtsSc|Select Dates] screen, select the dates for which to save or delete pending items,

and then click Finish.
The view reappears.
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CRW: Select Activities
To fill in the Select Activities page in the Commit/Rollback Wizard (CRW):

1. Select any combination of activities.
You can select individual activities from multiple sites and multi-site activities from
business units. Only activities that belong to the business unit and sites that are selected
on the Object pane's Activities tree are available for selection here.

2. Click Next to open the Select Agents page.
Click Cancel if you want to close the wizard without saving or deleting pending changes.
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CRW: Select Agents
To fill in the Select Agents page in the Commit/Rollback Wizard (CRW):

1. Select any combination of agents.
You can select individual agents from multiple sites and multiple teams, or you can select
whole teams or whole sites. Only agents who are selected on the Object pane's Agents tree,
and who can work on activities that are selected in the first page of this wizard, are
available for selection.

2. Select Commit or Rollback.
If you do not have the Approve Changes security permission, the Commit check box is
cleared and disabled. In that case, you can only roll back pending changes.

3. Click Next to open the Select Dates page.
Click Cancel if you want to close the wizard without saving or deleting pending changes.

Schedules Commit/Rollback Multiple Wizard

Workforce Management Web for Supervisors Help 585



CRW: Select Dates
The Select Dates page in the Commit/Rollback Wizard (CRW) contains a calendar.

1. Select the date or dates for which you want to commit or rollback all schedule items.
The calendar works as described in How to Use the Calendar.

Tip
If you are working with a schedule scenario, be sure to select dates that fall within the scenario's date range.

2. Click Finish.
This returns you to the Agent-Extended, Intra-Day, or Weekly view. If you committed items, these
now appear in the schedule.

• If you want to review or change your entries on the Select Agents page, click Previous.
• Or, if you want to close the wizard without saving your selection, click Cancel.
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Modify Individual Agents' Schedules
You can insert and edit schedule items for a particular agent using:

• Master Schedule Agent Extended or Intra-Day view
• Scenario Agent Extended or Intra-Day view

For example, you might want to reassign an agent from an overstaffed activity to an understaffed
activity; or you might want to swap paid hours for a day off, due to a change in overall interaction
volume.

You can insert and edit schedule items using shortcut menus. Once items are inserted, you can
graphically move or resize certain items using your mouse.

Using Shortcut Menus

To display a shortcut menu:

• Right-click an agent's grid row at the timestep where you want to insert or edit a schedule item. (To
zoom in on a particular timestep, clear the Full-Day view check box and/or resize the columns.)

To close a shortcut menu without selecting any of its commands:

• Press Esc.

Inserting Full-Day Schedule Items
Right-click an agent timestep that contains schedule items to bring up a shortcut
menu. The menu items available for selection depend on the full-day items that
already exist (or do not exist) in the agent's schedule day. The table below
discusses all menu items.
Insert Day Off Assigns the agent a day off, which appears as a

light-green bar.

Insert Full-Day Time Off
Displays a window where you can select a full-day
time-off type. Once inserted, the time off appears
as a dark-green bar (you can change the color with
the Colors Tool).

Insert Full-Day Exception
Displays a window where you can select a full-day
exception type. Once inserted, the exception
appears as a red bar.
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Insert Shift
Displays a window where you can select a shift
type and start/end times. Once inserted, the shift
appears as a dark-blue bar with thick black borders
(you can change the color with the Colors Tool).

Insert Marked Time Displays the Insert Marked Time dialog box.

Undo Changes Restores this agent's schedule to the state in which
it was last saved.

Insert Multiple Enables you to insert schedule items for multiple
agents or teams.

Copy Schedule

This menu item appears in Agent-Extended view.
You can select a single agent schedule day, and
use this option to select the Start and End dates
to which you want to copy the selected schedule
day.

Modifying Full-Day Exceptions, Days Off, and Full-Day Time Off

Once a full-day exception, day off, or a full-day time off is inserted, you cannot delete or move or
resize its bar in the grid. However, you can replace it by inserting a different full-day item.

When you right-click an inserted full-day exception, day off, or full-day time off, the existing item
(Exception, Day Off, or Full-Day Time Off) does not appear on the full-day shortcut menu, but the
Edit Exception or Edit Full-Day Time Off options appear for Exception or Time Off in the pop-up
menu. You can move or resize the Full-Day Exception or Full-Day Time Off if they were created
with start/end time settings. See also Edit Exception Dialog Box and Inserting and Editing Shift Items.

Modifying Shifts

After a shift is inserted, you cannot delete its bar in the grid; but you can replace the bar by inserting
a different full-day item. When you right-click an inserted shift, you see the shift items shortcut menu.

To change the shift's start and/or end times, do one of the following:

• Use the shortcut menu's Edit command.
• Move or Resize the shift bar visually while holding down the Ctrl key.

Tip
If you change the shift start time or shift end time for an agent who belongs to a
shared transport group, you will see a warning message when you save the change.
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Inserting and Editing Shift Items
Once an agent's schedule contains a shift (represented by a blue bar with thick
black borders), you can insert and edit schedule items within that shift, or you
can edit the shift itself.

• Right-click the shift to display a shortcut menu with the options listed below.
• When you move your mouse pointer over an option that ends with an arrow (>), a submenu displays

further options.

Insert >

From the submenu, select Break, Meal, [part-day]
Exception, [part-day] Time Off, Activity Set, Work
Set, Marked Time, or Exception with payback....
Use the resulting dialog box or wizard to insert
schedule items.

Edit >
From the submenu, select the activity set, shift, or
other schedule item that you want to edit. Use the
resulting Edit dialog box to adjust the item's start
and/or end times.

Set Activities For >
From the submenu, select Work, Work Set, or
Activity Set. Use the resulting Set Activities dialog
box to define the agent's work activities. Activity
Sets appear in the grid as yellow bars.

Delete >

From the submenu, select the activity set or other
schedule item that you want to delete from the
schedule.

Important
Select carefully, because there is no confirmation
prompt before the item is deleted. If a shift has only
one activity set, you cannot delete that activity set, so
the Delete command does not appear when you right-
click it.

Replace

When you right-click directly on an item (a meal, a
break, a part-day or a full-day exception, a part-day
or a full-day time off, or marked time) in an agent's
schedule, the Replace command becomes visible
and enabled in the drop-down menu. Use this
command to replace the selected "old" item with
another "new" item of the same type.
Selecting Replace > item... from the menu activates the
Replace Multiple Wizard. This wizard displays a series of
selection screens (for example, Select Activities and Select
Agents) that mimic similar screens in the Insert Multiple
Wizard.

Make your selection(s) on each of these screens and click Next.

The final selection screen displays items of the same type as the
item you are replacing. Select an item and click Finish.

WFM replaces the "old" item with the "new" item, for all
selected agents who have the same "old" item in their schedule
on that day.
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Commit

When you are working in the Master Schedule, if
the agent's schedule day has pending items, and
you have the Approve Changes security
permission enabled, you can select Commit to
have all that day's pending changes included in the
schedule. If you are working in a schedule scenario
and the agent's schedule day has pending items,
you can select Commit to have all that day's
pending changes included in the schedule.

Rollback
If the agent's day has pending schedule items, you
can select Rollback to remove all pending changes
for the agent for that day.

Undo Changes Restores this agent's schedule to the state in which
it was last saved.

Insert Multiple Enables you to insert schedule items for multiple
agents or teams.

Schedule History
Use to compare the current master schedule with
its previous state, and optionally restore the
master schedule to that same previous state
(rollback).

Tip
A warning message appears if your insertions or edits violate time constraints for the
shift or for any shift item, including the timing and distribution of meals, breaks, and
exceptions.

Moving and Resizing Shift Items

Once an agent's schedule contains a shift, you can use your mouse to move (drag and drop) or resize
some of the shift's schedule items (activity sets, breaks, meals, and part-day exceptions) or the shift
itself.

Moving an item changes both its start and end times, but maintains its duration. Resizing an item
changes its start or end time, which changes its duration.

Important
A Warning message is displayed if your changes would create overlapping schedule
items, or if they would violate time constraints for the shift or any shift item. Some
examples of time constraints are:

1. WFM Web never moves meals or part-day exceptions along with shifts; some meals or
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part-day exceptions—depending on their configuration—cannot occur outside shift
hours.

2. WFM Web never moves activity sets or work sets with 1-minute granularity, but treats
these shift items as 15-minute granularity items and, if the 15-minute granularity
constraint is violated, the following Warning message is displayed: Constraint violation:
Activity set times must match the start/end or 15-minute time steps.

Moving a Shift Item

Tip
To move the shift itself, hold down the Ctrl key throughout the first two steps.

1. Click in the middle of the schedule item and hold down the mouse button.
The mouse pointer changes to a four-pointed arrow.

2. Drag the item to the right or left.
3. Release the mouse button (and any keys) when the item has the start and end times that you want.

A warning message informs you of any constraint violations.

Resizing a Shift Item

Tip
To resize the shift itself, hold down the Ctrl key throughout the first two steps.

1. Click near a schedule item's start or end point and hold down the mouse button.
The mouse pointer changes to a two-pointed arrow. (If you see a four-pointed arrow, or if the point does
not change at all, release the mouse button, and then click at the very edge of the item's colored bar.)

2. Drag the bar's start or end point to the right or left.
3. Release the mouse button when the item has the start or end time that you want.

A warning message informs you of any constraint violations.

Committing or Rolling Back Pending Changes

To include all pending changes that are in an agent's schedule for the selected day, or to remove
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them all:

1. Right-click the agent's schedule row in the Intra-Day view.
2. Select Commit or Rollback from the shortcut menu.

Tip
If do not have the Approve Changes security permission enabled, you cannot select
Commit.
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Insert Shift Wizard
Use the Insert Shift Wizard to insert a shift into an agent's schedule:

1. In the Intra-Day or Agent-Extended grid, right-click an agent's row.
2. Click any timestep for any agent who does not have a scheduled shift.
3. From the shortcut menu that appears, select Insert Shift.

The first of the Insert Shift Wizard's two screens, Select Shift opens.
4. In the Select Shift list, click a shift row to select it.

The list shows the name and hours of each shift that was configured in the WFM Web. If necessary, a
vertical scroll bar appears to the right.

5. Adjust the shift's Start time and End time, as necessary.
• Select Next Day if the End time is on the day after the Start time. Your settings must match the

shift type's configured time constraints.
• Select Automatically Insert Meals and Breaks to have meals and breaks automatically inserted

along with the shift and optimized, based on schedule coverage, according to the constraints
configured for this Shift in Web. If this option is unchecked, then the Shift will be inserted with no
meals and breaks, and those can be inserted manually.

• Select the check box Show activities matching secondary skills to specify that activities which
match the secondary skill of this agent.

6. Click Next.
7. On the Select Activity Set screen, you can select:

• one or more work activities
• an activity set
• one or more activities associated with an activity set.

8. If you are inserting a shift for an agent that can work on multiple activities, you can select multiple
activities.

Important
The shift hours that you selected on the previous screen must be consistent with the activity set's configured
time constraints. (Click Back if you need to change the shift's start or end times.)

9. Click Finish to insert the selected work activities or activity sets and close the wizard.

Important
No warnings are displayed if the shift contains incorrectly configured shift items that cannot be inserted.
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The view reappears. The new shift appears as a dark-blue bar (you can change the color with the Colors
Tool).
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Insert Break Dialog
Use the Insert Break dialog box to insert a break into an agent's schedule:

1. In the Intra-Day or Agent-Extended view, right-click an agent's dark-blue shift bar (you can change
the color with the Colors Tool).

Click at or near the timestep where you want the break to begin.

2. From the shortcut menu that appears, select Insert > Break.
The Insert Break dialog box opens. It shows the breaks that are associated with the selected shift.

Click Show all if you prefer to display all of the breaks that are configured for your site.

3. In the Choose Item to Insert list, click a break row to select it.
The list's first two columns show each break's full and short name.

The Hours column shows the break's configured duration in hours and minutes.

A check mark in the Paid column indicates that the break time is paid. (You cannot select or clear
check boxes to change this attribute here.)

4. Adjust the Start time and End time, as necessary.
You can select Next Day for End time only or both Start and End time if either of them is on the
next day. (You cannot select Next Day for Start time only.)

5. Click OK to insert the selected break and close the dialog box.
The view reappears. The new break appears as a light-gray bar.
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Insert Meal Dialog
Use the Insert Meal dialog box to insert a meal into an agent's schedule:

1. In the Intra-Day or Agent-Extended view, right-click an agent's dark-blue shift bar (you can change
the color with the Colors Tool).

2. Click at or near the timestep where you want the meal to begin.
3. From the shortcut menu that appears, select Insert > Meal.

The Insert Meal dialog box opens. It shows meals that are associated with the selected
shift.
Click Show all if you prefer to display all of the meals that are configured for your site.

4. In the Choose Item to Insert list, click a meal row to select it.
The list's first two columns show each meal's full and short name.
The Hours column shows the meal's configured duration in hours and minutes.
A check mark in the Paid column indicates that the meal time is paid. (You cannot select or
clear check boxes to change this attribute here.)

5. Adjust the Start time and End time, as necessary.
You can select Next Day for End time only or both Start and End time if either of them is on
the next day. (You cannot select Next Day for Start time only.)

6. Click OK to insert the selected meal and close the dialog box.
The view reappears. The new meal appears as a light-blue bar.

Important
When you insert a meal using this dialog box, the schedule does not take into account
the agent’s qualification for the meal.
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Insert Activity Set Dialog
Use the Insert Activity Set dialog box to insert an activity set into an agent's schedule:

1. In the Intra-Day or Agent-Extended view, right-click an agent's dark-blue shift bar (you can change
the color with the Colors Tool).

2. Click at or near the timestep where you want the activity set to begin.
From shortcut menu that appears, select Insert > Activity Set.

The Insert Activity Set dialog box opens.
3. Select an activity set, or one or more of its associated activities.

In the Choose Item to Insert tree, you can expand activity sets to display their activities. You can
select a whole activity set, or one or more activities within any one activity set.

4. Adjust the Activity Set or selected activity Start time and End times, as necessary.
You can select Next Day for Start time or End time if either of them is on the next day.

Important
Your settings must match the activity set's configured time constraints.

5. Click OK to insert the selected activity set and close the dialog box.
The view reappears.

Activity Sets appear as yellow bars (you can change the color with the Colors Tool).
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Inserting Exceptions
WFM uses different dialog boxes and menu items for part-day and full-day exceptions:

• Use the Insert Exception dialog to insert a part-day exception into an agent's schedule.
• Use the Insert Full-Day Exception dialog to insert a full-day exception into an agent's schedule.

For example, you might need to schedule a full-day meeting or a one-hour appointment after the
schedule was created.

Inserting Part-Day Exceptions

To insert a part-day exception:
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1. In the Intra-Day or Agent-Extended view, right-click an agent's dark-blue shift bar (you can change
the color with the Colors Tool).

2. Click at or near the where you want the exception to begin.
3. From the shortcut menu that appears, select Insert > Exception.

The Insert Exception dialog box opens. The agent's name appears in the title bar.
You can add memos to Exceptions that then appear in some Schedule views and reports. For
details see Exception Memos in the Workforce Management Administrator's Guide.

4. In the grid, click an exception row.
The grid shows the part-day exception types that are configured in the Policies module of
WFM Web for Supervisors.
If necessary, a vertical scroll bar appears to the right. The first two columns show each
exception's full and short name.
Check marks in the remaining columns indicate whether the exception is paid, whether it is
convertible to a day off, and whether it counts as time off. You cannot select or clear check
boxes to change these attributes here.
The column Site lists all sites to which the exception is assigned.

5. Adjust the Start time and End time for this exception.
• Select Next Day next to the Start Time and End Time text boxes if the exception starts on the

day after the agent's shifts begin.
• Or select Next Day next to the End Time text box if the exception begins on the same day as the

agent's shifts begin, but ends on the day after.

6. Click OK to insert the selected exception and close the dialog box.
The view reappears. The new exception appears as a red bar (you can change the color with
the Colors Tool).

Important
If the Start and End times would place the exception outside the agent's shift hours, a
warning message appears. If an agent's activities are all scheduled in activity sets,
and you assign a long exception, the exception may be the only schedule state group
available during the agent's paid hours.

Inserting Full-Day Exceptions

To insert a full-day exception:

1. In the Intra-Day or Agent-Extended grid, right-click an agent's row.
2. From the shortcut menu that appears, select Insert > Full-Day Exception.

The Insert Full-Day Exception dialog box opens. The agent's name appears in the title bar.
3. Click an exception row.

The list shows the full-day exception types that were configured in the Policies module of WFM Web for
Supervisors. If necessary, a vertical scroll bar appears to the right. The first two columns show each
exception's full and short name.
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Check marks in the remaining columns indicate whether the exception is paid, whether it is convertible
to a day off, and whether it counts as time off. You cannot select or clear check boxes to change these
attributes here.
The column Site lists all sites to which the exception is assigned.

4. In the Specify Start/End section, you can optionally adjust the exception's Start time and End time
as necessary.
• If the exception begins on the same day as the agent's shift begins, but ends on the day after,

select Next Day next to the End Time text box.
• If you selected a paid exception, you can select the Specify Paid Hours check box to enter a

duration other than the default number of hours in a work day.
• If you select the Specify Paid Hours check box, the Paid Hours check box becomes enabled.

Important
If you enter a start/end time but do not enter a value for Paid Hours, then Paid Hours will equal End Time
minus Start Time (a value known as Total Hours or Duration).

5. Click OK to insert the selected exception and close the dialog box.
The view reappears. The new exception shows as a red bar.
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Insert Time Off Dialogs
WFM uses different dialog boxes and menu items for part-day and full-day time-off schedule items:

• Use the Insert Time Off dialog to insert part-day time off into an agent's schedule.
• Use the Insert Full-Day Time Off dialog to insert full-day time off into an agent's schedule.

For example, an agent might be called to jury duty or need to be out sick after the schedule is
created.

Inserting Part-Day Time Off

To insert a part-day time-off item into an agent's schedule:

1. In the Intra-Day or Agent-Extended view, right-click an agent's dark-blue shift bar (you can change
the color with the Colors Tool).

2. Click at or near the timestep where you want the time off to begin.
3. From the shortcut menu that appears, select Insert > Time Off.

The Insert Time Off dialog box opens and the agent's name appears in the title bar.
4. In the list of time-off types, click the row for the time-off type that you want to insert.

• Select the Show all check box to display all time-off types. Clear the check box to display only the
time-off types that are applicable to the selected agent. See the "Time-Off Primer" appendix in the
Workforce Management Administrator's Guide.

Important
The list shows time-off types that were configured in the Policies module of WFM Web for Supervisors. If
necessary, a vertical scroll bar appears to the right.

If you select a time-off type that is not associated with a selected agent, WFM assigns the time-off item but does not enforce the time-off
balance rules. However, if the time-off type counts toward time-off limits, WFM takes this time-off item into account when calculating
limits.

The first two columns show each time-off type's full and short name.

Check marks in the remaining columns indicate whether the time-off item is paid and whether it counts toward time-off limits. You cannot
select or clear check boxes to change these attributes here.

The Site column lists all sites to which the time-off type is assigned.

• Optional: Adjust the Start Time and End Time for this time off, if the default values are not correct.

a. Click inside the Start Time and End Time fields, to modify the default values for hours, minutes, and
AM/PM.

b. Select Next Day to the right of the Start Time text box if the time-off period starts on the day after the
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agent's shifts begin.
c. Select Next Day to the right of the End Time text box if the time-off period ends on the day after it

begins.

• Click OK to insert the selected time-off item and close the dialog box.
The view reappears and the new time-off item appears as a dark-green bar (you can change the color with
the Colors Tool).

Important
If the Start and End time would place the time off outside the agent's shift hours, a
warning message appears. If an agent's activities are all scheduled in activity sets,
and you assign a long time off, the time off may be the only schedule state group
available during the agent's paid hours.

Inserting a Full-Day Time Off

To insert a full-day time-off item into an agent's schedule:

1. In the Intra-Day or Agent-Extended grid, right-click an agent's row.
2. From the shortcut menu that appears, select Insert > Full-Day Time Off.

The Insert Full-Day Time Off dialog box opens. The agent's name appears in the title bar.
3. In the list of time-off types, click the row for the time-off type that you want to insert.

Important
The list shows the time-off types that were configured in the Policies module of WFM Web. If necessary, a
vertical scroll bar appears to the right.

If you select a time-off type that is not associated with a selected agent, WFM assigns the time off but does not enforce the time-off
balance rules. However, if the time-off type counts toward time-off limits, WFM takes this time-off item into account when calculating
limits.

The first two columns show each time-off type's full and short name.

Check marks in the remaining columns indicate whether the time-off item is paid and whether it counts toward time-off limits. You cannot
select or clear check boxes to change these attributes here.

The Site column lists all sites to which the time-off type is assigned.

4. Optional: Adjust the Start time and End time for this time-off item, if the default values are not
correct.
a. Select the check box Specify Start/End to enable the Start Time and End Time fields, then click

inside each field to modify the default values for hours, minutes, and AM/PM.
b. Select Next Day to the right of the End Time text box if the time-off period ends on the day after

it begins.
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3. Optional: Specify a nonstandard length for your full-day time-off item.

• Select the Specify Paid Hours check box to enable the Paid Hours field, then click inside and enter or
select a value to specify the exact number of hours in a full day for this particular time-off item.

Important
The Specify Paid Hours check box is enabled only if you selected a paid time-off type in the Choose Time
Off list.

• Click OK to insert the selected time-off item and close the dialog box.
The view reappears. The new full-day time-off item appears as a dark-green bar (you can change the color
with the Colors Tool).
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Insert Work Set Wizard
Use the Insert Work Set Wizard to insert a work set into an agent's schedule.

1. In the Intra-Day or Agent-Extended grid, right-click an agent's row.
2. From the shortcut menu that appears, select Insert Work Set.
3. In the Insert Work Set Wizard's Specify Work Set Parameters screen:

1. Adjust the Start time and End time, as necessary.
Select Next Day (next to the Start Time text box and next to the End Time text box) if
the work set starts and ends on the day after the agent's shifts begin.
— OR —
Select Next Day (next to the End Time text box only) if the work set begins on the same
day as the agent's shifts begin, but ends on the day after.

2. Select one of the following two radio buttons:
• Select new activities for work set (default) enables the wizard to display the Select

activities for work set screen.
• Use existing shift activities disables that screen.

3. Select the check box Mark as overtime with marked time (default) to enable the wizard to
display the Select Marked Time for Overtime screen. Clear this check box to disable that screen.

4. Click Next
The Select activities for work set screen opens, if you enabled it previously.

4. Select from the list of activities (ones that the agent could work, based on his/her primary and
secondary skills):
• One or more work activities
• An activity set
• One or more activities that are associated with an activity set; If you are inserting a work set for an

agent who can work on multiple activities, you can select multiple activities.
The work set hours that you selected on the previous screen must be consistent with the
activity set's configured time constraints. (Click Back if you need to change the work
set's start or end time.)

5. Click Next (or Finish, if this is the final screen).
The Select marked time for overtime screen opens, if you enabled it previously.

6. Select an item from this list.
The list displays only items that have Used To Mark Overtime enabled and thus may be
empty.

7. Click Finish to insert the selected work sets and close the wizard.
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How WFM Processes Overtime Work Sets

The process described here applies only to work sets that are inserted as overtime (as Marked Time).
For work sets that are not inserted as Marked Time, WFM simply replaces the shift activities with new
activities, as specified in the work set. WFM does no additional checks or rescheduling.

WFM's automated overtime insertion process:

1. Finds the appropriate shift definition for the extended shift.
2. Schedules break/meals on the inserted overtime part of the shift.
3. Designates the overtime by specifying a Marked Time.

WFM checks all of the shifts that agent can potentially work in the following order:

1. The currently scheduled shift
2. Primary shifts, other than the currently scheduled shift
3. Secondary shifts

If WFM does not find an acceptable shift, it keeps the current shift, which might now be invalid (if paid
time is too long, start or end time is out of bounds, etc.).

WFM also checks the following shift parameters:

• Are the shift start time, end time, and paid time correct?—If any one of these parameters are
unacceptable, WFM does not use the shift (for example, if shift starts at 9:00 am and the inserted work
set is from 8:00 am to 9:00 am).

• Are the shift's breaks and meals compatible with the currently scheduled breaks and meals?—WFM
check the order, duration, paid/unpaid status, and start/end time of meals. Meaning that if one shift has
a 10-minute paid break, then it is considered equivalent to a 10-minute paid break in another shift.

When matching shift items sequences, WFM checks:

• From the left to right if the work set is inserted at the end of the shift.
• From right to left if the work set is inserted at the beginning of the shift.

Use Case: Applying Secondary Shifts to Overtime Work Sets
This use case describes how WFM processes overtime work sets when added at the beginning of the
shift and when added at the end of the shift:

Shift 05—Original shift:

• Shift starts at 8:00 am ends at 4:30 pm:
• The paid duration is 8 hours (valid duration 8:00-9:45), and unpaid break = 30 minutes.
• Scheduled breaks are: 15-minutes paid, 30-minutes unpaid, 15-minutes paid.
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Adding Work Sets to End of Shifts

When a work set is added to the end of Shift 05 we have the following configuration:

• Shift starts at 8:00 am ends at 7:00 pm
• The paid duration is 10 hours and 30 minutes.
• WFM considers this shift invalid.

Shift 96—No match for Shift 05

• Start, end and paid time are OK but breaks do not match as this shift has one unpaid 60 minute break.

Shift 95—Match for Shift 05

• Start, end and paid time are OK
• Breaks for this shift duration are 15 minutes paid (match), 30 minutes unpaid (match), 15 minutes paid

(match) and 10 minutes paid (no match but this new break can be scheduled in added workset).

Adding Work Sets to Beginning of Shifts

When a work set is added to the beginning of Shift 05 we have the following configuration:

• Shift starts at 5:30 am and ends at 4:30 am.
• The paid duration is 10 hours and 30 minutes.

Shift 96—No match for Shift 05

• Start, end and paid time are OK but breaks do not match as this shift has one unpaid 60 minute break.

Shift 95—No match for Shift 05

• Start, end, and paid time are OK
• Paid breaks are also mandatory so the new shift MUST have all breaks of the original Shift 05.
• As work set is added in the beginning WFM looks at breaks from the right (or the end of the sequence).
• Break comparison fails at the last 10-minute paid break. It is present in Shift 95 but it does not exist in

Shift 05. If paid breaks were not mandatory, then Shift 95 might be used.

Since none of the shifts match WFM keeps the original Shift 05, as is.
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Insert Marked Time Dialog
Marked Time allows you to mark part or all of an agent's shift to track how that time is being spent
by the agent. For example, you may want to mark extra time that an agent is working at the end of
the day. You can see this marked time on the schedule, and you can run several reports to track how
different types of marked time are used within the schedules.

Use the Insert Marked Time dialog box to insert marked time into an agent's schedule:

1. In the Intra-Day or Agent-Extended view, right-click an agent's dark-blue shift bar (you can change
the color with the Colors Tool).
Click near the timestep where you want the marked time to begin. You can also click a
timestep outside of the shift. If you click a timestep before the shift's current start time,
you will be able to both extend the shift start time and insert the marked time between the
new earlier start time, and the current start time, in one step. If you click a timestep after
the shift's current end time, you will be able to both extend the shift end time and insert
the marked time between the current end time and the new later end time, in one step.

2. From the shortcut menu that appears, select Insert > Marked Time.
The Insert Marked Time dialog box opens. It shows the marked-time types that are
configured for the selected site. For each marked-time instance, the display shows its long
name, short name, and whether it is designated for overtime.

3. In the list of marked-time types, click the row for the type that you want to insert.
The list shows each marked-time type's full and short name.

4. Adjust the Start time and End time, as necessary.
Select Next Day next to the Start Time and End Time text boxes if the marked time starts on
the day after the agent's shifts begin. Or select Next Day next to the End Time text box if
the marked time begins on the same day as the agent's shifts begin, but ends on the day
after.

5. Click OK to insert the marked time and close the dialog box.
The view reappears. The new marked time appears in orange (you can change the color with
the Colors Tool).

Important
If the marked-time period that you selected overlaps any time off, WFM Web
generates an error message, and the marked time is not inserted.

For an explanation of how to display marked time, see Master Schedule Intra-Day View or Schedule
Scenario Intra-Day View.
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Insert Exception with Payback
Use the Insert Payback Exception Wizard in the Schedule > Intra-Day view to add unpaid, part-
day exceptions to agents' schedules to make up for or pay back time lost due to lateness or a
personal appointment.

To enter an exception with payback:

1. In the Intra-Day grid, right-click a shift in an agent's row.
2. From the shortcut menu that opens, select Insert > Exception with payback....

The Insert Payback Exception Wizard opens.
3. Select Exception:

a. Select and exception in the list.
b. Set a new Start time and End time to cover the time missed, checking Next Day, if applicable.

The Enter payback check box is checked by default.
c. In the Memo field, add comments or additional information about this exception.
d. Click Next.

4. Select Marked Time:
a. Select a Marked Time of type Payback from the list.
b. Click the Calendar to select the date for this payback.
c. Click Next.

5. Select Payback Parameters:
a. Add work to the shift or meal, by changing one or more of the following parameters. If you change

more than one, the total time must equal the payback period for this exception:
• The New start time for the shift
• The New end time for the shift
• The New start time for the meal
• The New end time for the meal

6. Click Finish.

What You Should Know About Payback Exceptions

Keep these things in mind when inserting payback exceptions:

• You can insert payback intervals into schedules for:
• For the current date, to the end of a shift and/or over meals by decreasing meal duration.
• For future dates, to the beginning of a shift, end of a shift, and/or over meals by decreasing meal
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duration.
To decrease the meal duration, edit start/end time by setting start time later and/or the
end time earlier.

• You can specify multiple intervals of payback for a single day, but all intervals must be within the same
shift. If the payback starts before the shift start time, you must specify a new start time for the shift.
The payback interval is the time between the new and previous shift start time.

• If you add an exception over unpaid time, you must estimate the amount of time for payback, because
it might not be the entire duration of the exception.

• When reviewing schedule validation warnings related to payback exceptions, you can save or cancel the
changes.

After Inserting Exceptions with Payback
WFM reschedules shift items as follows:

• WFM leaves unpaid shift items as they are (same duration, same place in the schedule).
• If a shift change occurs and additional shift items are required, WFM schedules them. For example, if the

shift duration increases, then additional breaks could be added to the schedule.

If an existing shift does not have a shift item sequence that matches the modified schedule, WFM
selects other shifts with shift item sequences that "fit better". If WFM cannot find a shift item
sequence that "fits", it leaves the existing or current schedule as is.
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Schedule History
Use this window to compare the current schedule with its previous state, and optionally to restore the
schedule to that same previous state (rollback).

Tip
The rollback function—and all Schedule History functionality—applies only to the
Master Schedule.

1. In the Intra-Day grid, right-click an agent's row.
2. From the shortcut menu that appears, select Schedule History...

The Schedule History window opens.
The top half of the window displays a grid listing all changes made to the schedule, with
each change on a single line. The columns for each line are

• Date of Change
• User (who made the change)
• Action (type of change performed)
• Historical Schedule (a horizontal bar graphic that represents the hours of the shift containing

those changes).

The bottom half displays the agent's current (post-change) schedule on the left and the
agent's historical (pre-change) on the right. As you use the cursor to select each listed
change in the top half of the window, WFM highlights the elements that changed on both
sides of the bottom half. Thus, you can compare each change with the original state and
decide if you want to restore the schedule to its original state before that particular
change.

3. When you have selected the change you wish to restore, click Restore at the bottom of the window.
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Edit Item Dialog
Use the Edit Item dialog box to edit the start time, and the end time or duration, of an agent's
schedule item.

1. In the Intra-Day or Agent-Extended grid, right-click an agent's shift or shift item.
To edit the shift itself, right-click anywhere in the shift. To edit a shift item (activity set, time off,
marked time, break, or meal), right-click that item. See Edit Exception Dialog Box if you are editing
an exception.

2. From the shortcut menu that appears, click or hover over Edit to display the Edit submenu.
3. From the submenu, select the item that you want to edit.

The submenu always includes the Shift option. If it omits the shift item that you intended to edit,
press Esc to close the shortcut menu, and then right-click again directly inside that shift item.

4. Adjust the Start time and End time, if you want to.
Select Next Day next to the Start Time and End Time text boxes if the shift item starts on the
day after the agent's shifts begin. Or select Next Day next to the End Time text box if the shift
item begins on the same day as the agent's shifts begin, but ends on the day after.

5. If you are editing a shift, you can select Move Schedule Items With Shift.
• If you select this check box, you cannot directly edit the shift's end time. WFM Web calculates the

end time based on the start time that you enter. It moves the whole shift and all shift items, except
for meals and exceptions.

• If you leave this check box cleared, you can specify the shift's start and end time.
• The Move Schedule Items With Shift option appears only when you edit a shift.

6. Click OK to save your changes.

The dialog box closes if the edit is successful. The grid reflects your edits to this schedule item, and
adjacent activity sets may automatically expand or contract to maintain a continuous schedule.

A Warning message appears if the edit violates time constraints for the shift or any shift item. For
example, WFM Web attempts to maintain the distribution of breaks and activity sets within shifts, and
it never moves meals or exceptions along with shifts. Also, meals cannot occur outside shift hours.
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Edit Exception Dialog
Use the Edit Exception dialog box to edit exceptions on the Schedule Intra-day or Agent-
Extended view.

1. In the Intra-day or Agent-Extended grid, right-click the exception that you want to change.
2. From the shortcut menu that appears, click or hover over Edit to display the Edit submenu.

See Editing Part-Day Exceptions and Editing Full-Day Exceptions.
3. From the submenu, select Exception.

You can either edit the parameters of the current exception or replace it with a new one
from the exception list in the Edit Exception dialog box.

Editing Part-Day Exceptions

To edit part-day exceptions:

1. If you are replacing the current exception with another one, select it from the list (only valid part-day
and full-day exceptions are listed).
• If it is a part-day exception, set Start and End times.
• If it is full-day exception, use the next algorithm To edit full-day exceptions.
• If the exception starts on the day after the agent's shifts begins, select Next Day beside the Start

time and End time text boxes.
• If the exception begins on the same day as the agent's shifts begins, but ends on the day after,

select Next Day beside the End time text box.

2. Click OK to save your changes or Cancel to discard them.

Editing Full-Day Exceptions

To edit full-day exceptions:

1. If you are replacing the current exception with another one, select it from the list (only valid full-day
exceptions are listed).

2. Optional: To set start and end times for full-day exceptions, select the Specify Start/End check box
and enter the value.
If the exception ends on the day after its beginning, select Next Day next to the End Time text box.

3. Optional: If full-day exception is paid, select the Specify Paid Hours check box and enter a duration
other than the default number of hours in a work day.
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Tip
If you select the Specify Paid Hours check box, the Paid Hours text box becomes editable. If you enter a
start/end time but do not enter a value for Paid Hours, then Paid Hours equals End time minus Start time
(a value known as Total Hours or Duration).

4. Click OK to save your changes or Cancel to discard them.
The edited exception is displayed.
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Edit Full-Day Time Off Dialog
Use the Edit Full-Day Time Off dialog to edit full-day time-off items on the Schedule Intra-Day or
Agent-Extended view. Use the Edit Item dialog for a part-day time off.

Editing Full-Day Time Off

To edit Full-Day Time Off:

1. In the Intra-day or Agent-Extended grid, right-click the full-day time off that you want to change.
2. From the shortcut menu that appears, select Edit Full-Day Time Off.
3. Edit the parameters of the current time off or replace it with a new one from the time off list in the Edit

Full-Day Time Off dialog box.
Only valid time-off items that are assigned to agent are shown in the list.

4. Check Show All to show all of the time-off items assigned to the site.
5. If you are replacing the current time off with another one, select it from the list.
6. Optional: Select the Specify Start/End check box and enter or select the correct times in the Start

time and End time text boxes.

Tip
If the time off ends on the day after its beginning, select Next Day next to the End Time text box.

7. Optional: If the Full-Day Time Off is paid, select the Specify Paid Hours check box to enter a
duration other than the default number of hours in a work day.

Tip
If you select the Specify Paid Hours check box, the Paid Hours text box becomes editable. If you enter a
start/end time but do not enter a value for Paid Hours, then Paid Hours equals End time minus Start time
(a value known as Total Hours or Duration).

8. Click OK to save your changes or Cancel to discard them.
The view displays, showing the edited time off.
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Set Activities Dialog
1. In the Intra-Day or Agent-Extended view, right-click an agent's shift or activity set. (The agent's

schedule must already contain a shift with or without an activity set.)
2. From the shortcut menu that appears, select Set Activities For.
3. From the submenu, select the activity set that you want to modify.

• If right-clicking on dark blue activity work inside a shift, the submenu allows you to select Work
(you can change the color with the Colors Tool).

• If right-clicking on a yellow activity set, the submenu also allows you to select Activity Set (you can
change the color with the Colors Tool).

• If a work set exists, the submenu also allows you to select Work Set, which starts the Insert Work
Set Wizard.

Depending on your selection from this submenu, you will either edit the work activities or
the activities inside the Activity Set.
The Set Activities dialog box opens. Its grid shows all activities that belong to the selected
work or activity set. (If necessary, a vertical scroll bar appears to the right.)
In the first column, a check mark indicates activities that have already been assigned.

4. Add or remove activities.
• Select a check box to add an activity.
• Clear a check box to remove an activity.
• You can add multiple activities within any one activity set.

5. Click OK to save your changes.
If your changes violate no constraints, the dialog box closes and the view reappears.
If your changes would delete an activity set's last remaining activity, an error message
appears. Use the Delete command to delete the activity set itself.
If your changes violate any constraints (for example, keeping too few activities to fill the
activity set's hours of operation), a warning message informs you of the problem.
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Copy Schedule Dialog
The Copy Schedule dialog box appears when you right-click an agent schedule and select Copy
Schedule from the shortcut menu in:

• Scenario Agent Extended view
• Master Schedule Agent-Extended view

Text at the top of this dialog box contains the date to be copied:
Copying schedule of agent_name from date to:

To specify the copy-to date range:

1. Click the date selector for Start date and enter or select the start date for the copy-to range.
2. Click the date selector for End date and enter or select the end date for the copy-to range.
3. Click OK.

If the copy operation does not violate the agent's schedule constraints (maximum selection
of six weeks, and the Start and End dates must fall within the target schedule's date range
for the Master Schedule or schedule scenario), WFM copies the selected schedule day from
the Start date to the End date. If the operation does violate schedule constraints, the
Review Messages dialog box opens.

4. Under Action, keep Save or click the down arrow and select Do Not Save from the drop-down menu.
5. When finished in this dialog box, click OK.
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Meeting Scheduler
Use the Meeting Scheduler Wizard to schedule a meeting:

1. In the Schedule module, select one of these views: Master Schedule Weekly, <schedule> Weekly,
Master Schedule Intra-day, <schedule> Intra-day.

2. At the top right of the Work pane, select the week that you want to schedule the meeting.

3. Click Meeting Scheduler .
4. At the Please select a meeting from the list page, choose an existing meeting (or decide to create a new

one) and enable or disable auto-commit.
If you chose to use an existing meeting, you will see all Meeting Scheduler pages except Meeting
Parameters. Otherwise, you will see only the Participants and Meeting Parameters pages.

5. At the Participants page, choose the agents who should attend (if you are creating a new meeting). if
you use an existing meeting, the list of participants is read-only.

6. At the Dates Range page, choose the range of dates that are acceptable for the meeting.
7. At the Meeting Parameters page, select the meeting type, possible dates, possible times, duration, and

minimum percentage of required attendees.
8. A message box appears, listing how many agents were scheduled for the meeting. Click OK.
9. If some agents were not scheduled, a message box may appear listing them. Click OK.

The meeting is scheduled, and exceptions, representing meeting, are inserted into the schedule.

Meeting Scheduler vs. Meeting Planner

The Meeting Scheduler is best suited for scheduling ad hoc meetings and other meetings that you did
not know about when you built the original schedule.

The Meeting Planner (available through the Policies module) is useful for scheduling pre-planned
meetings especially ones that recur, such as weekly team meetings or bi-weekly one-on-one
coaching sessions. If you want to edit, copy, or delete meetings, use the Meeting Planner.
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MSW: Select Meeting
To fill in the Please Select A Meeting From The List screen in the Meeting Scheduler Wizard
(MSW):

1. Choose one of the following two radio buttons:
• Create new meeting—You will configure the meeting by making choices on this screen and two

others: participants and parameters.
• Use existing meeting—You will configure the meeting by making choices on this screen and two

others: participants and date range.

2. Select or clear the Auto-commit Changes check box , to control the auto-commit feature.
When enabled, the auto-commit feature applies the meeting that you are scheduling to the
Master Schedule, immediately after you click Finish. When auto-commit is disabled, your
meeting will have the status Pending after you click Finish, and must be committed
/approved before it is incorporated into the Master Schedule.
If you do not have the Approve Changes security permission for the Master Schedule, the
Auto-commit Changes check box is disabled.

3. Click Next to proceed to the next screen in the wizard.
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MSW: Select Participants
To fill in the Participants screen in the Meeting Scheduler Wizard (MSW):

1. Select any combination of agents.

If you are creating a new meeting, you can select individual agents from multiple sites or teams, or you
can select entire sites or teams. However, you can select only within the business unit for which you
displayed the Intra-Day or Weekly view.

Tip
If you use an existing meeting, the list of participants is read-only.

2. Click Next to proceed to the next screen in the wizard.
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MSW: Select Dates
To fill in the Dates Range screen in the Meeting Scheduler Wizard (MSW):

1. Enter or select a date in each of the two date selectors.
• Start Date
• End Date

2. Click Next to proceed to the next screen in the wizard or Finish, whichever is enabled.

Date Selection and Schedules

• The End Date must be later than the start date.
• The End Date date selector is enabled only if the Recurrence Rule for this meeting is Weekly or

Monthly.
• WFM will insert into the schedule a single instance of the specified meeting for each agent.
• Default values and validation rules shall depend on the meeting’s recurrence rule (if one exists):

• Daily—The default start date is the same as the first date of the current view. The default end date
is disabled and always equal to the start date. If you are scheduling in a scenario, the dates must be
inside the scenario date range.

• X-weekly—The default start date is the same as the first day of the week that is selected in the
current view. The end date is the last day of the X-week period from the start date. If you are
scheduling in a scenario, the dates will be trimmed to stay inside the scenario date range.

• Monthly—The default start date is the first day of month that is selected in the current view. The
end date is the last day of the same month as the start date. If you are scheduling in a scenario, the
dates will be trimmed to stay inside the scenario date range.
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MSW: Meeting Parameters
To fill in the Meeting Parameters screen in the Meeting Scheduler Wizard (MSW) complete the
following areas of the screen:

Properties

1. Enter the meeting name into the Meeting Name field.
2. Select an exception type from the Exception type drop-down menu.

The list of exception types is populated by exceptions from all sites that were selected on the
Participants screen, and were assigned the status Exception Can Be Used in Meeting Planner/
Scheduler in the Policies > Exceptions Types view.

Dates and Recurrance Rules

1. Enter or select a date in the Start Date box.
2. Enter or select a date in the End Date box.
3. Optional: Clear the check box to its right to disable the End Date.
4. Select the check boxes that correspond to all days of the week that are acceptable for the meeting.

Time and Duration

1. Enter or select a time in the dialog box Earliest Start.
2. Enter or select a time in the dialog box Latest End.
3. Enter or select the number of hours and minutes that the meeting will last in the dialog box Meeting

Duration.
4. Select a time zone from the Time Zone drop-down list.

Important
Only configured time zones appear in this list; each item includes the time zone's
relationship to GMT. For example, Pacific Standard Time, which is 8 hours later than
Greenwich Mean Time is presented as PST (GMT-8.0).
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Meeting Type

1. Select one of the following three radio buttons, which enable the properties that are associated with
them.
• Single Group—The default meeting type. Represents a single meeting for all agents who are

specified on the Participants tab.

Enter or select the meeting's minimum number of attendees requirement in the Minimum % of
required attendees box. Set this value to 1% to indicate no minimum requirement for the number
of attendees—for example, to schedule a meeting for as many attendees as possible.

Important
The value 0 (zero) is interpreted as 100% to accommodate data that was migrated from WFM 6.5,
because that version did not include the variable Minimum Percentage of Selected Attendees in its
database.

• Single Agent—A common activity, such as a webinar, that can occur at the most convenient time
for each agent.

• Multiple Groups—A common time but for multiple groups. Enter or select a number in each of the
four fields below, to specify the group sizes.

• Min(imum) Number of Groups
• Max(imum) Number of Groups

• Min(imum) Group Size
• Max(imum) Group Size

2. Click Finish.
A progress message shows that the meeting being scheduled.

If the meeting cannot be scheduled for all selected agents, a message box lists how many agents are
scheduled, and a second message box lists the agents who could not be scheduled. Click OK to
acknowledge each message.

Tip
Meeting scheduler will always use calculated staffing when scheduling the meeting for
the Master Schedule. However, for the Schedule Scenario, it will use the staffing type
(calculated or required) that was used when building the scenario. As always, existing
agent schedules are taken into account and the staffing is adjusted accordingly for
both Master and Scenario schedules.
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Master Schedule
Use the Master Schedule views to display and modify Master Schedule data.

If your access rights include access to the Master Schedule, the Master Schedule menu displays
the following Master Schedule views:

Master Schedule Coverage
Compares staffing coverage to forecasted
(calculated and required) staffing data, and
highlights overstaffed or understaffed timesteps.

Master Schedule Weekly
Displays a weekly summary table of total paid
hours, working start/end times, or shift names for a
site's agents.

Master Schedule Intra-Day

Displays Master Schedule details for a 24- or
36-hour period, enabling you to modify schedules
for individual or multiple agents.
Unless you have the Approve Changes security permission,
your changes are entered in pending mode. An approver with
the Approve Changes security permissions must then accept
or reject the changes.

You can view your pending changes in the Weekly, Agent-
Extended, and Intra-Day views.

Master Schedule Agent-Extended
Displays and allows editing of a single agent's
schedule for one week or the schedule planning
period.

Master Schedule Summary Displays service-level and related statistics for the
Master Schedule.

Master Schedule State Group Totals Displays coverage statistics for every timestep in a
selected day.

Master Schedule Overtime Requirement Use to enter and edit overtime requirements.

Master Schedule Changes Approval
Enables users with the appropriate security
permissions to review pending schedule changes,
and approve or reject them.
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Master Schedule Coverage View
Use the Master Schedule Coverage view to compare the Master Schedule's staffing coverage
with the forecasted (calculated and required) staffing data. See the toolbar image and the button
descriptions below.

Graphs and tables show you coverage for each weekday in the selected week, along with totals for
the whole week. Overstaffed and understaffed timesteps appear in a distinctive color.

Displaying the Coverage View

To display the Master Schedule Coverage view:

1. From the Home menu on the toolbar, select Schedule.
2. From the Schedule menu, select Master Schedule.
3. From the Master Schedule menu, select Coverage.
4. In the Objects pane, select a single business unit, a single site within a business unit, a multi-site

activity, and activity group, or a single activity within a site.

Using the Daily Graphs and Tables

The Coverage view displays the following information for days of the week:

Graphs

Display coverage information for each day, with a
data point for each timestep.
Click the Chart Type down arrow to select
calculated staffing, required staffing, or both. A
blank graph indicates a closed site (or no
scheduled activity) for the day.

Tables

Display overstaffing and understaffing totals for
each day, with respect to calculated and/or
required staffing. Contractual constraints and other
configured parameters can reduce a schedule's
optimization.

Legend Explains the significance of each color that is used
in the graphs.
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Reading the Totals Table

The Totals table (at the lower right) displays overstaffing and understaffing totals for the selected
week, with respect to calculated and/or required staffing.

Customizing the Coverage View

To customize the schedule coverage data that is presented, use these controls at the top of the
working pane:

Chart Type
Click the Chart Type down arrow to choose the type of graphs that you want to be displayed:

Advanced
Graphs present both calculated and required
information. Calculated information appears as an
area graph with overstaffing/understaffing data,
and required staffing appears as a linear graph.

Calculated Graphs present calculated information with
overstaffing/understaffing data.

Required Graphs present required information with
overstaffing/understaffing data.

Cleanup
Opens the Cleanup Master Schedule window, where you can delete Master Schedule information
for selected dates and agents.

Date
Use the standard date-selection controls to move to other weeks.

Calculating Understaffing and Overstaffing

Any timestep can be subject to either understaffing or overstaffing. WFM calculates these conditions
by evaluating Coverage against Forecast. The result is displayed in Time format (hh:mm).

Understaffing = The Forecast is greater than the Coverage. There are too few agents on duty.

Overstaffing = The Forecast is less than the Coverage. There are too many agents on duty.

Coverage is measured by evaluating the agents’ contributions against the presented activities. These
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contributions are based on the agents' scheduled activities for each time interval, and on any
schedule items that affect these scheduled activities for an interval (such as a break that occurs
during only part of an interval).

Totals are calculated by summing Understaffing/Overstaffing for all activities for a given time
range (because each single Understaffing/Overstaffing value is for one timestep).

Toolbar Buttons

You can use the following buttons on the Actions toolbar (or commands in the Actions menu) to
further customize the chart:

Icon Name Description

Cleanup

Opens the Cleanup Master
Schedule window. Enables you to
delete Master Schedule
information for selected dates
and agents.

Use Multi-Site Activities

Controls whether WFM Web's
calculation of aggregated
information includes multi-site
activities. You can select this
button only if you first select a
multi-site activity, business unit,
or enterprise in the Objects tree.
If you set this button to On, WFM retains
your last selection—in the current view
and for all other views that contain multi-
site activities—preventing you from
having to click it every time you want to
display data for the selected multi-site
activity.
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Master Schedule Weekly View
Use the Master Schedule Weekly view to display a summary table of total paid hours, working
start/end times, or shift names, for all selected agents (who can be under multiple sites but must all
be under the same business unit). See the toolbar image here and the button descriptions below.

Important
You can also see a summary table of total paid hours, working start/end times, or shift
names for your schedule planning period. See Mode for details.

When displaying the Master Schedule Weekly view, you can use the Intra-Day Schedule Rebuild
Wizard.

Displaying the Master Schedule Weekly View

To display the Master Schedule Weekly view:

1. From the Home menu on the toolbar, select Schedule.
2. From the Schedule menu on the toolbar, select Master Schedule.
3. From the Master Schedule menu on the toolbar, select Weekly.
4. On the Objects pane, select the appropriate item(s) from either the Agents tree (above) or the

Activities tree (below); WFM then selects matching item(s) from the other tree.

You can expand business units to display their sites, and you can expand sites to display their teams
and agents. You can select multiple sites, teams, and agents, but only one business unit.

5. Click Get data to populate the Weekly view table for the selected agents.

You can search the table for particular agents using the Find Agent dialog box. To open it, select
Find from the Edit menu or press Ctrl + F.

Using the Table

The Weekly view table contains rows for each agent that you selected in the Objects tree. (If a
scroll bar is displayed to the right, you can use it to reveal more agents.) This table includes the
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following columns:

[Expand/Collapse]
If in Planning Period mode, the first column
provides expand/collapse controls that you use to
display or hide agent details.

Team This column lists each agent's team.

Agent Two columns show an icon representing each
agent's contract and the agent's name.

[Week Start Dates]
If you display agent details and you are in Planning
Period mode, the rows below each agent's name
indicate the start date for each week in the
schedule.

[Weekdays]

These cells show agent schedule information for
each weekday, for each week in the schedule. The
cells' contents correspond to your selection from
the Show Data for drop-down list.
If an agent is not scheduled for a shift on this day, the cell will
contain: Day Off, <name of the full-day time-off type>,
Working Hours (for scheduled working hours without a shift),
or an exception name (for scheduled full-day exceptions).

An icon in the cell for a weekday indicates whether the schedule
has been changed for that agent.

• If the agent's schedule for that day was
assigned during scheduling or rescheduling, no
icon appears.

• If the agent's day was edited after scheduling or
rescheduling, a light-gray pencil icon appears.

• If the agent's day was assigned by trading or
swapping, the swap icon appears.

• A yield icon (upside down red triangle) appears
if there are pending changes. Pending changes
must be committed by a user with Approve
Changes security permission.

• An icon and red check box appears for every
schedule day that contains a granted calendar
item (if the option Show agents with granted
and scheduled rotating pattern or any
other calendar preference is selected in the
Options dialog box).

Tip
If there have been multiple changes, the icon
represents the most recent status.

Weekly Totals Shows an agent's total working hours for the
displayed week.

Planning Period Totals Shows an agent's total paid hours for the schedule
planning period.
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Important
To set this period's duration and start date, see the
Configuration > Polices > Contracts > Site
Settings tab.

The Weekly Totals and Period Totals boxes below the table show a grand total of all weekly or
planning period total paid hours (respectively) for all selected agents.

Customizing the Master Schedule Weekly View

To customize the displayed table, use these controls at the top of the working pane:

Show Data for
From this drop-down list, select what you want to display inside each day's table cell:

Total Paid Hours Total working time for the day.
Start/End Times Start and end times of agents' work.

Shift or Schedule State Names Names of agents' assigned shifts and other full-day
states.

Mode
Select one Week or Planning Period from the Mode drop-down list. The table displays data for the
selected period. If no schedule planning period is configured, or if more than one site is selected on
the Objects pane, then the Planning Period option is disabled.

Planning Period Mode

Planning Period mode displays schedules for the entire planning period. White and dark gray
indicate the type of date range that you are viewing.

Planning Period Color Legend

• White—Indicates dates that fall within the planning period.
• Dark Gray—Indicates dates that are outside the planning period.

Date
Use the standard date-selection controls to move to other weeks.
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Toolbar Buttons
You can use the following buttons on the Actions toolbar (or commands in the Actions menu) to
further customize the displayed table:

Icon Name Description

Cleanup

Opens the Cleanup Master
Schedule window. Enables you to
delete Master Schedule
information for selected dates
and agents.

Rebuild Intra-day Schedule

Opens the Intra-day Schedule
Rebuild Wizard to rebuild an
Intra-Day schedule for a specific
day or time period for a site,
team, or agent.

Options
Opens the Options dialog box.
Enables you to select/de-select
the Agent Rank and Site Name
columns.

Filter

Opens the Filter dialog box]
Enables you to filter the
displayed information according
to activities and contract types.
(If you set a new filter, this
immediately refreshes the view.)

Sort

Opens the Sorting dialog box,
which allows sorting by Team
Name, Contract, Agent Name
(first or last), Agent Rank or Site
Name. You can sort in ascending
or descending order. Note that
Agent Rank sorts in apparent
reverse order due to limitations
imposed by multi-sorting by both
agent name and rank.

Swap
Enables you to swap two agents'
schedules with the Swap Agent
Schedule Wizard.

Insert Multiple
Opens the Insert Multiple Wizard,
which enables you to add
multiple items to the Master
Schedule at one time.

Delete Multiple
Opens the Delete Multiple
Wizard, which enables you to
remove multiple items from the
Master Schedule at one time.

Commit/Rollback Multiple

Opens the Commit/Rollback
Multiple Wizard, which enables
you to insert pending changes
into the Master Schedule or to
remove them and return the
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Icon Name Description
Master Schedule to its former
settings.

Meeting Scheduler Opens the Meeting Scheduler
Wizard.

Important
You can save changes from within the Master Schedule Weekly view only if you
have appropriate access rights.
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Weekly View Options Dialog Box
Use the Options dialog box to display/hide the Agent Rank column in the Schedule Scenario and
Master Schedule Weekly views. To open this dialog box:

• Click the Options button on the toolbar or select Options from the Actions menu.

The dialog box that opens for Weekly view has two tabs, Options and Columns.

On the Options tab:

1. Select Show agents with granted and scheduled rotating pattern or any other calendar
preference to display an icon and red check box near the agents name for every schedule day that
contains a granted calendar item.

2. Click Apply to save.

On the Columns tab:

1. Select Agent Rank or Site Name to display the corresponding column; de-select to hide the column.
2. Click Apply to save.
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Master Schedule Intra-Day View
Use the Master Schedule Intra-Day view to manage schedule details for agents, for a specific day
in the Master Schedule. See the toolbar image here the button descriptions below.

If you selected the Show Performance Information check box on the Performance tab of the
Options dialog box, this window also shows performance data in a graph. If you have cleared the
Full-Day View check box, data is also shown in a table.

You can modify schedule items for individual agents here, and you can insert schedule items for
multiple agents.

See also: Modifying individual agents' schedules and Using the Intra-Day Schedule Rebuild Wizard.

Displaying the Intra-Day View

To display the Intra-Day view:

1. From the Home menu on the toolbar, select Schedule.
2. From the Schedule menu on the toolbar, select Master Schedule.
3. From the Master Schedule menu, select Intra-Day.
4. On the Objects pane, select the appropriate item(s) from either the Agents tree (above) or the

Activities tree (below). WFM then selects matching item(s) from the other tree.

You can expand business units to display their sites, and expand sites to display their teams and
agents. You can select multiple sites, teams, and agents, but only one business unit.

5. Click Get data to display the Intra-Day view for the selected agents.

Managing the Grid

The Master Schedule Intra-Day view includes a grid with one row per agent and the following
fields and controls. You can sort by site, team, contract, agent, shared transport, overtime, paid
hours, total hours and start time, by clicking on the header for that column.

Double-click cells containing these items, to edit them: Shift, Activity Set, Time Off, Meal, Break,
Exception, Marked Time.
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Grid Controls

Time Zone
From this drop-down menu, select the Time Zone
that WFM should use to display the data in graphs
and tables.

Scheduled agents Shows the number of agents displayed (based on
your selection in the Objects tree).

Edited schedules
This indicator shows the number of agents whose
schedules you have edited in this view, but not yet
saved.

Full-Day View

Select the Full-Day View check box to display the
current schedule's full day (compressed to fit on
screen, without scrolling).
Clear the Full-Day View check box to display every timestep in
the entire day on the Intra-Day grid (scrolling required) and
above the grid, display a summary of corresponding statistics:
Coverage Scheduled, Staffing Calculated, Staffing
Required, Difference Calculated, Difference Required,
Service Level Scheduled, ASA Scheduled, Deferred
Service Level Scheduled, Overtime Scheduled, and
Overtime Required.

Date selector Standard date selectors.

Target

Displays the Select Target dialog box, where an
object tree lets you choose a Performance Data
Target that can be: a business unit, a multi-site
activity, a site, an activity, or an activity group. See
Performance Data Display for details.

Chart Type Controls what statistics appear in the graph. See
Performance Data Display for details.

Granularity
Specifies the granularity, in minutes, of the
timesteps in the grid by selecting a number—15
(default), 30, or 60—from the drop-down menu.

Refresh Performance Data
Refreshes the grid. See Performance Data Display
for details.

Grid Columns

! (Save Messages/Warnings)

This column contains icons that provide information
about the agents' schedules.

• A yellow pencil icon indicates an item that
generated a warning and you selected the Fix
Later option.

• A green pencil icon indicates schedule items
that you have changed but not yet saved.

• A red pencil icon indicates an item that
generated an error. (Error conditions are more
serious than warning conditions.)
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• A light-gray pencil icon appears if the agent's
day was edited after scheduling or
rescheduling.

• A Swap icon appears if the agent's day was
assigned by trading or swapping.

• A Yield icon (upside down red triangle) appears
if there are pending changes. Pending changes
must be committed by a user with Approve
Changes security permission.

• An agent icon and red check box appear for
every schedule day that contains a granted
calendar item (if the option Show agents with
granted and scheduled rotating pattern or
any other calendar preference is selected in
the Options dialog box).

Double-click a yellow or red icon to review message details and
resolve the unsaved items.

Site This column shows the site of each agent.
Team This column shows each agent's assigned team.

This column shows each agent's contract. The
color-coded symbol appears in each row, and the
column heading is blank.

Agent This column shows each agent's name.

Shared Transport

If displayed (using the Options dialog box), this
column shows the shared transport group
participation for each agent on the selected day.
Shared Transport is known by many different names
worldwide—bus, carpool, ride share, lift share, and para transit,
for example. See Wikipedia for details.

Overtime
If displayed (using the Options dialog box), this
column shows the duration of overtime for each
agent on the selected day.

Paid Hours
If displayed (using the Options dialog box), this
column shows each agent's paid hours for the
selected day.

Total Hours
If displayed (using the Options dialog box), this
column shows each agent's total hours for the
selected day.

Shift Start Time
If displayed (using the Options dialog box), this
column shows each agent's }shift or full day start
time for the selected day's work.

Shift End Time

If displayed (using the Options dialog box), this
column shows each agent's shift or full day end
time for the selected day's work.

If there is a full day item without an end time, the
value in this column is empty. This column is
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sortable.

Shift If displayed (using the Options dialog box), this
column shows the shift name.

* (Comment)

If this column is displayed (using the Options dialog
box), an asterisk (*) indicates that a comment was
saved for the indicated agent and schedule day.
Double-click a column cell to view or edit comments.

Accessible Schedule Details
If displayed (using the Options dialog box), you can click this
icon to display the Accessible Schedule Details dialog box, which
simplifies and organizes commands for vision-impaired users
and the screen readers that they use.

[Timesteps]

These columns indicate the agent's schedule items
in each timestep. To see greater detail, clear the
Full Day View check box and/or resize the
columns.
To make changes to one agent's schedule at a time, right-click
the timestep that you want to modify and then select the
command from the shortcut menu. See Modify Individual
Agent's Schedules for instructions and explanations.

[Horizontal scroll bar]
This scrollbar appears below the grid when clearing
the Full Day View check box causes some
timesteps to be hidden offscreen. Scroll it to the
right to display later timesteps.

Legend Identifies the particular type of schedule item that
each bar color in the grid indicates.

Details When you click an agent's row, this field lists the
agent's scheduled activities on the selected day.

Customizing the Grid

You can display more timesteps by resizing some columns to the left of the grid. For details, see
Getting Started.

Searching for an Agent

To find a specific agent in the Master Schedule Intra-day view:

1. Search the table for particular agents, by using the Find Agent dialog box. To open it, select Find from
the Edit menu or press Ctrl + F.
The Find Agent dialog box opens. You can search by first or last name.

2. Enter part or all of the agent's name and then click OK.
The Master Schedule Intra-Day view display shifts to display information for the selected agent.
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Toolbar: Modifying Multiple Agents' Schedules

Use the following buttons on the toolbar (or commands in the Actions menu) to modify multiple
agents' schedules at once, or to further customize/cleanup the displayed grid:

Icon Name Description

Cleanup

Opens the Cleanup Master
Schedule window, which enables
you to delete Master Schedule
information for selected dates
and agents.

Rebuild intra-day schedule

Opens the Intra-Day Schedule
Rebuild Wizard. Use this wizard
to rebuild an Intra-Day schedule
for a specific day or time period
within a day for a selected site,
team, or agent.

Options

Opens the Options dialog box.
Enables you to customize the
view, including whether to show
agent availability, use a 24-hour
or 36-hour display, display
marked time on top, display
performance data, and display or
hide the Site Name, Shared
Transport, Overtime, Paid
Hours, Total Hours, Start
Time, Accessibility, and
Comment columns.

Filter

Opens the Filter dialog box.
Enables you to filter the
displayed Master Schedule
information. (If you set a new
filter, this immediately invokes
Get data.)

Sort Opens the Sorting dialog box.

Swap
Opens the Swap Agent Schedule
Wizard, which enables you to
swap two agents' schedules.

Insert Multiple

Opens the Insert Multiple Wizard,
which enables you to insert
breaks, meals, and exceptions,
days off, time off, shifts, marked
time, or work sets for multiple
agents or teams.

Delete Multiple Opens the Delete Multiple
Wizard, which enables you to
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Icon Name Description
remove multiple items in the
Master Schedule at one time.

Edit Multiple
Opens the Edit Multiple Wizard,
which enables you to edit
multiple items in the Master
Schedule at one time.

Commit/Rollback Multiple

Opens the Commit/Rollback
Multiple Wizard, which enables
you to insert pending changes
(changes entered when auto-
commit was off or disabled) into
the Master Schedule or to
remove them and return the
Master Schedule to its former
settings.

Save

If you have the appropriate
access rights, clicking this button
saves any Master Schedule
changes that you have made in
this view. If the server cannot
save all changes, red or yellow
icons in the grid's first column
indicate those agents for whom
you must correct errors or
acknowledge warnings.

Auto-Commit

Toggles the auto-commit feature
on and off (or you can select
Auto-Commit from the Actions
menu). If on, changes are
immediately applied to the
Master Schedule. If off,
changes have Pending status
and can be committed/approved
before they are incorporated in
the official version of the Master
Schedule.
If you do not have the security permission
Approve Changes for the Master
Schedule, auto-commit is disabled.

Meeting Scheduler
Opens the Meeting Scheduler,
which enables you to schedule
meetings to already build
scenario for selected agents.

Move to Current Day
Also known as the Today button.
Click this button to display data
for today.

To make detailed schedule changes for one agent at a time (such as inserting, editing, or deleting the
agent's schedule items), see Modifying Individual Agents' Schedules.

If you make schedule changes in the Intra-Day view and do not click Save, you are prompted to
save your changes when you select a different module or view, or when you launch certain wizards or
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child windows.

Performance Data Display

Selecting the Show Performance Data check box on the Performance tab of the Options dialog
box adds a graph and a table to the Master Schedule Intra-day display.

Tip
The table appears only if you clear the Full Day View check box.

To configure the performance data views:

1. Select a target for the performance data by clicking the button next to the Target: label.

The list that appears can contain the activities and activity groups that are associated with the site
selected on the Objects pane, and the multi-site activities that are associated with the current
schedule. If no site is selected, the list contains only multi-site activities.

2. Select the granularity in which performance data should be presented: 15, 30, or 60 minutes.
3. Select the type of data to be displayed in the graph and table.

• Schedule coverage appears as a red line on the graph. To configure the graph, select a value from
the Chart Type drop-down list:
• Calculated (Calculated Staffing)—Appears on the graph in blue.
• Required (Required Staffing)—Appears on the graph in yellow.
• Advanced (both Calculated and Required Staffing)—Appears on the graph as a blue area for

the calculated staffing and as a yellow line showing the required staffing.
• Overtime (calculated as Calculated Staffing–Overtime Requirement)—Appears on the

graph as a light blue area.
• Overtime Advanced (calculated as Scheduled Coverage–Overtime Scheduled)—Appears

on the graph as a line in magenta. By default, the graph shows Calculated Staffing.

• The table always displays values for Schedule Coverage and Calculated Staffing. It might show
additional figures, depending on your selections on the Performance tab of the Options dialog box.

If you are not using automatic updates, click Refresh Performance Data to update the
performance data view. You can select Update Automatically on the Performance tab of the
Options dialog box.

The Multi-Skill Enabled label appears on the right end of the Performance Data Display if you
enabled the SplitMS option in Genesys Administrator. For more information, see the "Enabling Multi-
Skill Support" section in the Workforce Management Administrator's Guide.
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Tip
WFM presents Performance data in the Master Schedule > Intra-Day view in the
same format as the data in the Performance > Intra-Day view; specifically, empty
data is no longer shown as 0.
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Master Schedule Intra-Day Accessible
Schedule Details
To reach this view, you clicked Accessible Schedule Details in a specific agent's row, for a
specific date, in any of the four views listed above.

This view is designed specifically for screen-reader software, and for ease of selecting commands. It
includes:

• Read-only information about the selected agent's team, time, and other statuses.
• A table that lists in each row: one item in the schedule and multiple buttons to modify it.
• A field for comments by users.
• Buttons for inserting items into the selected day on the selected agent's schedule—also for deleting

items, and for performing other functions.

Click a button to display the dialog box or the wizard which corresponds to that action.

If you select any action or command in error, click Cancel on the unwanted dialog box, to return to
the Accessible Schedule Details view.
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Master Schedule Intra-Day: Performance
Data Target
To view performance data in the Master Schedule Intra-Day view or the Schedule Scenario
Intra-Day view, you must choose a target. The target is the source of the performance data. You can
select the Enterprise, a business unit, a site, an activity group, or an activity (either multi-site or
single-site).

To change the Select Target window:

• Click the Target: button on the Schedule Intra-Day view .

Important
This option is available only if you have chosen to view performance data by selecting
the Show Performance Information check box on the Performance tab of the
View Options dialog box.

Selecting the Appropriate Time Zone

When you select a site on the Object pane (for example, San Francisco), you are also specifying that
site's time zone, which may differ from the data source's time zone. You can change the time zone
manually by selecting the appropriate zone from the Time Zone drop-down list near the upper right
of the Intra-Day view. The selected time zone is applied to the grid and graphs that you view when
you request performance data. Schedules and whatever you select to view would be displayed in the
selected time zone, regardless of the data source's local hours (WFM makes the appropriate time
conversion).

Viewing Multi-Site Activity Data

Select the Use Multi-site Activities check box to display forecast data that is taken from multi-site
activities (MSAs), and schedule data that is the sum/average of Activities under your selected target
(MSA, business unit, or site). All data is transposed to the time zone of the site that you selected on
the Object pane.

Clear the Use Multi-site Activities check box to display all MSA data as a sum/average. All data is
transposed to the selected site's time zone.

If you set the Use Multi-site Activities button to On, WFM retains your last selection—in the
current view and for all other views that contain multi-site activities—preventing you from having to
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click it every time you want to display data for the selected multi-site activity.
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Master Schedule Intra-Day: Options Dialog
Use the Options dialog box to configure the data that is shown on the:

• Intra-Day view or Agent Extended view for the current scenario.
• Master Schedule Intra-Day or Master Schedule Agent-Extended view.

To open the Options dialog box:

1. Click Options on the Actions toolbar, or select Options... from the Actions menu.
The Options dialog box opens.
• When called from an Intra-Day view, it has three tabs: Options, Performance, and Columns.
• When called from an Agent-Extended view, it has two tabs: Options and Columns.

Each tab is described below.

2. After you are done configuring the Options dialog box, click OK to save your changes, or Cancel to
restore the original selections.

The Options dialog box closes and the view refreshes. The settings that you configure for a scenario
or the Master Schedule appear whenever you return to the view for that scenario or for the Master
Schedule, until you log off.

To configure options in this dialog box:

1. If you do not need the Legend to appear, you can clear the Show Schedule Legend check box to
provide more space for the grid.

2. If you want to see agent availability on the grid, select the Show Agent Availability check box. Hours
when an agent is unavailable are then shown in light gray on the grid.

3. Select the check box Show agents with granted and scheduled rotating pattern or any other
calendar preference to see which schedule days contain such an item. The result: a red check box and
Agent icon appears in the left-most column (labeled "!") for every Agent who meets these conditions.

Tip
You can use this tool to learn whether an agent was given a schedule based on a schedule preference, which
might influence your decision to modify this agent's schedule. This icon is displayed only if the agent was
given a rotating pattern or preference (such as for time off) as a result of building a schedule. If an agent’s
schedule is manually edited to give him or her a preference, or a schedule from a rotating pattern, then the
icon will not be displayed.

4. Select the radio button for the hours you want to show, 24 to show 24 hours or 36 to show 36 hours.
5. Select the Presentation type: Schedule only, Schedule on top, or Marked time on top.

Your selection affects the colored bars in the schedule. If Schedule only is selected, you cannot see
Marked time.
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To configure the Performance tab (not available in Agent-Extended view):

1. If you select the Show Performance Information check box, you can further customize exactly what
performance information WFM Web shows on the Intra-Day Schedule view.
If you clear this check box, the rest of the options on this tab are disabled.

2. If you prefer not to see the legend that explains the colors used to distinguish performance data, clear
the Show Performance Legend check box.

3. The Update Automatically check box determines whether schedule changes are shown when they
happen.
Clear this only if you have network bandwidth issues that make automatic updates a problem.

4. If you selected to view performance data, you can select the check boxes to show additional information
in the performance table.

Tip
You see the table only if the Full-Day View check box is not selected.

In addition to scheduled coverage and calculated staffing, which always appear, you can select any or all of these Show
additional data options to appear in the table:

• Required Staffing
• Difference between Coverage and Calculated Staffing
• Difference between Coverage and Required Staffing
• Scheduled Service Level Percentage
• Scheduled Deferred Service Level Percentage
• Scheduled ASA (Average Speed of Answer)
• Overtime Schedule (default: cleared)
• Overtime Requirement (default: cleared)

Important
If any of the cells in the Difference in Calculated Staffing or Difference in
Required Staffing columns show as understaffed, WFM alerts the user by changing
the color of the cell to red. Although red is the default color, you can change it, by
using the settings in About > Settings (in the upper-right corner of the GUI).

To configure the Columns tab:

• Select the check boxes for the optional columns that you want to display. Clear the check boxes for any
columns that you want to hide. For Intra-Day and Agent-Extended views, you can add the following
columns: Site Name, Shared Transport, Overtime, Paid Hours, Total Hours, Start Time,
Accessibility, and Comments. In Intra-Day view, all columns are sortable, except for Comments. In
Agent-Extended view, these columns are not sortable.
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Master Schedule Intra-Day: Review
Messages (Save) Dialog Box
Use this dialog box to respond to any warnings or errors that the server returned during your last
attempt to save an agent's edited schedule.

The dialog box includes the following columns and controls:

Team Name Displays the team to which this agent belongs.

Agent Name Displays the agent whose schedule generated this
message.

Messages Displays the message type (either Warning or
Error), numeric code, and the message text.

Action

Use each message's drop-down list to select an
action to resolve the warning or error:

• Save—Saves the edited agent schedule. This is
the default action for warnings. It is unavailable
for agent schedules whose edits generated
errors (which are more severe than warnings).

• Fix Later—Does not attempt to save the agent
schedule, but keeps it in the Intra-Day grid so
that you can further modify it. This is the
default action for agent schedules whose edits
generated errors.

• Do Not Save—Discards the change that caused
the warning or error to be generated.

OK Closes the dialog box, applies your selected
actions, and retrieves fresh data from the server.

Close Closes the dialog box without saving or refreshing
data.

These errors and warnings are generated by schedule changes that you made manually in the Intra-
Day view. They differ from Validation warnings and errors, which WFM Web generates during the
schedule building process.
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Master Schedule Agent-Extended View
Use the Master Schedule Agent-Extended view to display/edit a single agent's schedule for one
week or the schedule planning period. See the toolbar image here and the button descriptions.

Tip
A legend at the bottom of the window indicates the particular type of schedule item
that each bar color represents.

You can modify schedule items for individual agents in this view and insert schedule items for
multiple agents.

Displaying the Master Schedule Agent-Extended View

To display this view:

1. From the Home menu on the toolbar, select Schedule.
2. From the Schedule menu on the toolbar, select Master Schedule.
3. From the Master Schedule menu, select Agent Extended.
4. In the Objects pane, select a single business unit, a single site within a business unit, or a single agent

within a site.

Using the Master Schedule Agent-Extended View Grid

The Agent-Extended view includes a grid for the selected agent. Each row in the grid contains a
color coded bar. Each bar represents a scheduled day or day off for the selected agent. The table
below explains the fields and controls.

Double-click cells containing these items, to edit them: Shift, Activity Set, Time Off, Meal. Break,
Exception, Marked Time.

Scheduled agents This indicator shows the number of agent days
displayed (based on the selected Mode).

Edited schedules This indicator shows the number of daily schedules
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you have edited in this view, but not yet saved.

Full-Day View

Select the Full-Day View check box to have the
grid display the entire day similar to the Intra-Day
view. If you clear this check box, the grid shows a
more detailed view as shown for the Scenario
Agent-Extended view. Full-Day View also affects
the Options dialog box.

Mode:
The starting Mode is set to the default of one
week, but can be changed to Schedule Planning
Period (if Schedule Planning Periods are in use
at your site).

Date:
These controls are the standard date selectors. The
grid displays data for the period containing the
selected date.

! (Save Messages/Warnings)

This column contains icons that provide information
about the agents' schedules.

• A light-gray pencil icon indicates that the
agent's day was edited after scheduling or
rescheduling.

• A yellow pencil icon indicates an item that
generated a warning and you selected the Fix
Later option.

• A green pencil icon indicates schedule items
that you have changed but not yet saved.

• A red pencil icon indicates an item that
generated an error. (Error conditions are more
serious than warning conditions.)

• A Swap icon indicates that the agent's day was
assigned by trading or swapping.

• A yield icon (upside down red triangle) appears
if there are pending changes that have not yet
been committed by a user with Approve
Changes security permission.

Double-click a yellow or red icon to review message details and
resolve the unsaved items.

Team This column on the grid indicates the selected
agent's assigned team.

colored icon
The column on the grid may display a colored icon.
This icon, assigned in Polices > Contracts
represents the agent's contract.

Agent This column on the grid indicates each agent's
name.

Date This column on the grid indicates the calendar day.

Weekday
This column on the grid indicates the day of the
week. (Select Day of Week in the Options >
Column tab.)

[Timesteps] These columns indicate the agent's schedule items
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in each timestep. To see greater detail, clear the
Full-Day View check box and/or resize the columns.
To make changes to the selected agent's schedule, right-click
the timestep that you want to modify and then select the
command from the shortcut menu. The figure below shows the
menu when you right-click the dark blue area within a color-
coded bar (unless you change the color). The menu items vary
depending on the area clicked.

See Modify Individual Agent's Schedules for instructions and
explanations.

[Horizontal scroll bar]
Appears below the table when clearing the Full-Day
View check box]causes some timesteps to be
hidden off screen. Scroll it to the right to display
later timesteps.

Legend Indicates the particular type of schedule item that
each bar color represents.

Customizing the Master Schedule Agent-Extended View Grid

You can resize the Team, Agent, and Date columns. For details, see the Getting Started. You can
also add and remove columns.

Site Name
If displayed (using the Options dialog box), this
column shows the name of the site for each agent
on the selected day.

Shared Transport
If displayed (using the Options dialog box), this
column shows the shared transport group
participation for each agent on the selected day.

Overtime
If displayed (using the Options dialog box), this
column shows the duration of overtime for each
agent on the selected day.
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Paid Hours
If displayed (using the Options dialog box), this
column shows each agent's paid hours for the
selected day.

Total Hours
If displayed (using the Options dialog box), this
column shows each agent's total hours for the
selected day.

Start Time
If displayed (using the Options dialog box), this
column shows each agent's start time for the
selected day's work.

* (Comment)

If this column is displayed (using the Options dialog
box), an asterisk (*) indicates that a comment was
saved for the indicated agent and schedule day.
Double-click a column cell to view or edit comments.

(Accessible Schedule Details)

If displayed (using the Options dialog box), you can
click this icon to display the Accessible Schedule
Details dialog box, which simplifies and organizes
commands for vision-impaired users and the screen
readers that they use.

Using the Master Schedule Agent-Extended View Toolbar Buttons

The Master Schedule Agent-Extended view toolbar is similar to the Master Schedule Intra-Day
view toolbar. The only exception is that Agent-Extended view does not contain a Sort button.

Modifying an Agent's Schedule

You can use the following buttons on the Actions toolbar (these commands also appear in the
Actions menu):

Icon Name Description

Cleanup

If you have Schedule Clean Up
Master permission, opens the
Cleanup Master Schedule window
that enables you to delete
Master Schedule information
for selected dates.

Rebuild intra-day schedule

Opens the Intra-Day Schedule
Rebuild Wizard that enables you
to rebuild an Intra-Day schedule
for a specific day or time period
within a day for a selected site,
team, or agent.

Options Opens the Options dialog box
that enables you to customize
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Icon Name Description
the view. This includes whether
to show agent availability,
whether to use a 24-hour or
36-hour display, and whether to
display or hide the Overtime,
Paid Hours, Total Hours, Start
Time, Comment, Site Name,
Shared Transport, and
Accessibility columns.

Auto-Commit

The Auto-Commit toolbar
button toggles on and off the
auto-commit feature. The feature
is also turned on and off by
selecting Auto-Commit on the
Actions menu. If it is on,
changes are immediately applied
to the Master Schedule. If it is
off, the changes have Pending
status and can be committed/
approved before they are
incorporated in the official
version of the Master
Schedule.
If you do not have the Approve
Changes security permission for the
Master Schedule, the auto-commit
feature is disabled.

Swap
Opens the Swap Agent Schedule
Wizard that enables you to swap
two agents' schedules.

Insert Multiple

Opens the Insert Multiple Wizard
that enables you to insert breaks,
meals, exceptions, days off, time
off, shift, marked time and work
sets for multiple agents or
teams.

Delete Multiple
Opens the Delete Multiple
Wizard, which enables you to
remove multiple items in the
Master Schedule at one time.

Edit Multiple
Opens the Edit Multiple Wizard,
which enables you to edit
multiple items in the Master
Schedule at one time.

Commit/Rollback Multiple

Opens the Commit/Rollback
Multiple Wizard, which enables
you to insert pending changes
(changes entered when auto-
commit was off or disabled) into
the Master Schedule or to
remove them and return the
Master Schedule to its former
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Icon Name Description
settings.

Save

Saves any changes that you have
made to the schedule. (If the
server cannot save all changes,
red or yellow icons in the grid's
first column indicate the agents
for whom you must correct errors
or acknowledge warnings.
If you make schedule changes in the
Agent-Extended view and do not click
Save, you are prompted to save your
changes when you select a different
module or view, or when you launch
certain wizards or child windows.

Move to Current Day
Also known as the Today button.
Click this button to display data
for today.
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Master Schedule Summary View
Use the Master Schedule Summary view to display statistics about the Master Schedule. See the
toolbar image here and the button descriptions below.

The summary view provides standard date-selection controls, a Granularity control, a Graph and a
Data table.

Displaying the Master Schedule Summary View

To display the Master Schedule Summary view:

1. From the Home menu on the toolbar, select Schedule.
2. From the Schedule menu on the toolbar, select Master Schedule.
3. From the Master Schedule menu, select Summary.
4. Select an activity from the tree on the Objects pane.

You can select a single business unit, a single site or a multi-site activity or an activity group within a
business unit, or a single activity within a site. Making the selections populates the Data table.

Setting Granularity

Use this drop-down list to select the Time Step increment to display in the grid. Select from one of
these three values (in minutes): 15, 30, or 60.

Graph and Data Panes

This view displays its data in a graph (upper portion of the view) and a table (lower portion), instead
of on separate tabs.

Graph Pane
The Graph pane provides a linear graph for each statistic that you select, with data points for
individual timesteps across the selected day.
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Show data for

From the Show data for drop-down list, select the statistic you want to graph. The options
correspond to the Data table's available columns (except that Difference Calculated and
Difference Required cannot be graphed).

Select the Show Required check box to display that data on the graph.

Graph

The graph is redrawn to match your drop-down list selection from the Show data for drop-down list.
Timesteps are shown from left to right. Quantities from bottom to top show the number of
interactions, the number of agents, or the expense amount (for Budget).

Data Table

The Data pane provides a scrollable grid that displays aggregate and per-timestep statistics. The
grid's first row displays a daily total or average for each statistic. Each of the remaining rows displays
statistics for one timestep.

Grid Columns

The grid provides columns displaying the following statistics and quantities.

• Click Options to display or hide each of these columns, available for selection:

Coverage Scheduled
Headcount Scheduled
Service Level Scheduled
Service Level Forecasted
Interaction Volume Scheduled
Interaction Volume Forecasted
AHT (Average Handling Time) Scheduled
AHT Forecasted, Budget Scheduled
Budget Forecasted
Staffing Calculated

Staffing Required
Difference Calculated
Difference Required
Coverage Published
Coverage Difference
ASA Scheduled
ASA Forecasted
Difference [ASA Scheduled - ASA Forecasted]
Occupancy Scheduled
Occupancy Forecasted

Difference [Occupancy Scheduled - Occupancy Forecasted]
Difference [S/L Scheduled - S/L Forecasted]
Difference [IV Scheduled - IV Forecasted]
Difference [AHT Scheduled - AHT Forecasted]
Difference [Budget Scheduled - Budget Forecasted]
Deferred Service Level Scheduled
Deferred Service Level Forecasted
Deferred Service Level Difference
Scheduled Queue

See explanations of Optional fields in the "Options Dialog Box" topic.

Time Step The start time for each timestep, configured by the
Granularity setting.

Coverage [Scheduled]

The scheduled staffing coverage for an activity or
multi-site activity. Schedule coverage is calculated
and displayed in fractional units. For example, if
any agent is scheduled to work on three Activities
in a 15-minute timestep, that agent may count as
1/3 toward the coverage of each activity.
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The way the scheduling engine splits an agent’s time among the
activities the agent can work on depends on many factors.
Examples include the open hours of each activity, the volume
and handle time of each activity, and some other factors such
as whether an agent has granted items in the Calendar, such
as time off or exceptions for any or part of the day.

Coverage [Published] The schedule staffing coverage, based on the
baseline Master Schedule.

Coverage [Difference]
The difference between the schedule staffing
coverage, based on the current Master Schedule
and schedule staffing coverage, based on the
baseline Master Schedule.

Headcount [Scheduled] The number of agents scheduled (agents
scheduled to be seated).

Service Level Percentage Scheduled
The service level percentage that can be achieved
given the staffing coverage—assuming that other
planned metrics (such as interaction volumes and
Average Handling Time) remain unchanged.

Service Level Percentage Forecasted

The service level percentage that can be expected
to be achieved based on the number of agents
forecast.
This may differ than the original service level objective that was
stated when the staffing forecast was built due to agent
rounding. For example, WFM might forecast a staffing
requirement of 12 agents to meet a service level objective of
80% of interactions answered within 20 seconds, but Service
Level Percentage Forecast might report a higher number,
such as 83.48%. This is because 12 was the minimum number
of agents required to meet the 80% service level objective but,
with that number of agents, the contact center can be expected
to achieve a slightly better service level than 80%. With one less
agent (11 agents), the contact center would not be expected to
achieve the 80% service level.

Interaction Volume Scheduled
The number of interactions that can be handled
based on the schedule coverage—assuming that
other planned metrics remain unchanged.

Interaction Volume Forecasted The expected number of interactions, according to
the Master Forecast.

AHT Scheduled
The Average Handling Time per interaction,
based on the schedule—assuming that other
planned metrics remain unchanged.

AHT Forecasted The expected Average Handling Time, according
to the Master Forecast.

Budget Scheduled

The budget for the scheduled coverage for the
selected day and timesteps, based on the full-time-
equivalent (FTE) paid hours per day and the salary
specified in the Forecast scenario that was
published to the Master Forecast for this date.
(This statistic appears only if you have the access
rights to view agents' wage fields.)

Budget Forecasted The budget for the calculated staffing for the
selected day and timesteps, based on the full-time-
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equivalent (FTE) paid hours per day and the salary
specified in the Forecast scenario that was
published to the Master Forecast for this date.
(This statistic appears only if you have access
rights to view agents' wage fields.)

Staffing Calculated
The required number of agents as calculated by
WFM, based on the forecast interaction volumes,
AHT, and applicable service objectives.

Staffing Required
Optional field. The required number of agents as
defined by the user, either by explicitly entering
forecast targets or by using a template.

Difference Calculated The difference between Coverage [Scheduled]
and Staffing Calculated.

Difference Required Optional field. The difference between Coverage
[Scheduled] and Staffing Required.

ASA Scheduled
Optional field. The Average Speed of Answer
that you should achieve on this activity, with the
number of agents currently scheduled for this
activity.

ASA Forecasted
Optional field. The totals/average row for ASA
Forecasted reports a weighted average,
calculated across the open hours and weighted by
Forecasted IV

Deferred Service Level Scheduled

Optional field. The service level percentage that
can be achieved given the deferred staffing
coverage&emdash;assuming that other planned
metrics (such as interaction volumes and Average
Handling Time) remain unchanged.

Deferred Service Level Forecasted
Optional field. The service level percentage that
can be expected to be achieved, based on the
number of deferred activities forecasted.

Deferred Service Level Difference
[Scheduled minus Forecasted]

Optional field. The difference between the
Scheduled Deferred Service Level and
Forecasted Deferred Service Level statistics.

Scheduled Queue The scheduled number of interactions in the
backlog queue at the end of the period.

Difference [ASA Scheduled
minus ASA Forecasted]

Optional field. ASA Scheduled minus ASA
Forecasted

Occupancy Scheduled
Optional field. The Occupancy that you should
achieve on this activity, with the number of agents
currently scheduled.

Occupancy Forecasted
Optional field. The Occupancy objective that you
should be able to achieve when staffing with the
number of agents from the staffing forecast

Difference [Occupancy Scheduled
minus Occupancy Forecasted]

Optional field. Occupancy Scheduled minus
Occupancy Forecasted

Difference [S/L Scheduled
minus S/L Forecasted]

Optional field. S/L Scheduled minus S/L
Forecasted

Difference [IV Scheduled Optional field. IV Scheduled minus IV
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minus IV Forecasted] Forecasted
Difference [AHT Scheduled
minus AHT Forecasted]

Optional field. AHT Scheduled minus AHT
Forecasted

Difference [Budget Scheduled
minus Budget Forecasted]

Optional field. Budget Scheduled minus Budget
Forecasted

Tip
You can display staffing totals in Full Time Equivalent (FTE) or man-hours mode in
the Coverage [Scheduled], Staffing Calculated, Staffing Required, Difference
Calculated, and Difference Required columns by adjusting the view settings in the
interface. To change the display mode, see Changing the Staffing Display from FTE to
Man Hours.

Customizing the Summary View

These commands are available on the Actions toolbar (and also on the Actions menu):

Icon Name Description

Options

Opens the Options dialog box.
Enables you to display or hide
individual statistics.
The following statistics are
available for selection:

• ASA Scheduled, ASA
Forecasted, Headcount
Scheduled, Service Level
Scheduled, Service Level
Forecasted, Interaction
Volume Scheduled,
Interaction Volume
Forecasted, AHT (Average
Handling Time) Scheduled,
AHT Forecasted, Budget
Scheduled, Budget
Forecasted, Staffing
Calculated, Staffing Required,
Difference Calculated,
Difference Required,
Coverage Scheduled,
Coverage Published,
Coverage Difference,
Difference [ASA Scheduled -
ASA Forecasted], Occupancy
Scheduled, Occupancy
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Icon Name Description

Forecasted, Difference
[Occupancy Scheduled -
Occupancy Forecasted],
Difference [S/L Scheduled -
S/L Forecasted], Difference
[IV Scheduled - IV
Forecasted], Difference [AHT
Scheduled - AHT Forecasted],
Difference [Budget Scheduled
- Budget Forecasted

See the Optional field section.

Use multi-site activities

This button becomes enabled
when you select a multi-site
activity or business unit in the
Objects tree. Clicking this button
causes both tabs to display
combined data for all the
activities included in the selected
multi-site activity or business
unit.
If you set this button to On, WFM retains
your last selection—in the current view
and for all other views that contain multi-
site activities—preventing you from
having to click it every time you want to
display data for the selected multi-site
activity.

Cleanup
Opens the Cleanup view. Enables
you to delete Master Schedule
information for selected dates
and agents.

Granularity
Select a timestep to apply to the grid: 15 (default), 30, or 60. All values are in minutes.

Date
Use the standard date-selection controls to move to other days.
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Cleanup Master Schedule Window
Use the Cleanup Master Schedule window if you need to remove information from the Master
Schedule for selected dates and agents. You must have Schedule Clean Up Master security
permission.

Warning
This feature deletes all previously saved data that was saved for the selected date
range and agents. Genesys recommends that you do not use the Cleanup Master
Schedule feature unless it is absolutely necessary. If you must remove Master
Schedule data, Genesys recommends that, before doing so, you first extract the data
to a schedule scenario (using the Publish Schedule Wizard), and/or make a backup
of the WFM database.

To remove Master Schedule information:

1. In the Cleanup dates section, select the range of dates for which you want to remove data.
You can type in the Start date and End date, or use the up or down arrows to modify the
displayed dates. You can also click Open Popup Calendar to display a monthly calendar
that you can use to jump to other dates.

2. From the Agents list, select the agents whose schedule information you want to remove.
You can expand business units to display their sites and you can expand sites to display their
teams and agents. You can select any number of agents. (By default, no agents are selected.)

3. Click Finish to remove the specified Master Schedule information, or click Cancel to close the
window without changing the Master Schedule.
As the cleanup starts, the progress bar displays additional information in brackets

• Number of selected agents.
• Number of selected teams for a particular site.

If an asterisk (*) is displayed instead of a number, this indicates all agents or teams under
the site were selected.
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Filter By Agent Properties
You reach this dialog box by clicking the Filter button in the Master Schedule Changes Approval
dialog box.

Use this dialog box to filter the display by specific agent properties. You can choose from two lists of
Contracts under the current site:

All check boxes are selected by default.

1. Clear the check boxes for the items that you want to be excluded from the filter.
2. Click OK to apply your choices.
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Master Schedule State Group Totals
Use the Master Schedule State Group Totals view to display coverage statistics for every
timestep in a selected day. See the toolbar and the button descriptions below.

This view can help you to determine the cause of an overstaffing or understaffing during the day. For
example: Although your site has 400 agents, a 3 PM traffic surge left you understaffed. How did it
happen? Using this view, you can pinpoint the number of agents who are on breaks, in meetings, and
otherwise not on duty, at 3 PM. You can use this information to justify adjustments such as moving
agents' breaks or canceling a team meeting.

You can also:

• Compare Calculated and Required Staffing, and schedule coverage, with schedule-state-totals data.
• Anticipate shrinkage and estimate how much of it (in the form of meetings and training, for example)

can be assigned and stay within your forecast.
• Select agents with specific scheduled states who are contributing to a specific shrinkage types.

This view displays its data in a graph (upper portion of the view) and a table (lower portion), instead
of on separate tabs. You can also specify that WFM display its data not only for days, but also for
weeks and months. Both data displays show the differences between the Schedule and the
Forecast, for each timestep during the selected time period. The Graph also shows totals as a flat
line, because the lines representing forecasted and scheduled shrinkage can be of different shapes.

Displaying State Group Totals

1. From the Home menu on the toolbar, select Schedule.
2. From the Schedule menu on the toolbar, select Master Schedule.
3. From the Master Schedule menu, select State Group Totals.
4. Select the objects from the Objects pane whose State Group Totals you want to display.

You can select the appropriate item(s) from either the Agents tree (above) or the Activities tree
(below); WFM then selects matching item(s) from the other tree.

5. Click Get data.
6. Select an item from the Show Data For drop-down menu to control what data is displayed in the grid:

• Scheduled States Totals—Display all schedule-state groups (and their data), of all types, but
exclude shrinkage-related information. This is the default display.

• Total Shrinkage—Display all schedule-state groups (and their data), but exclude the type none.
• Planned Overheads—Display only schedule-state groups (and their data) with the type planned
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overheads.
• Unplanned Overheads—Display only schedule-state groups (and their data) with the type

unplanned overheads.

Changing the Default Time Zone for Schedule State Totals
When displaying schedule state totals, if you select agents from the several sites, WFM uses the
business unit's time zone by default. If you select agents from only one site, WFM uses the site time
zone by default. However, in the State Group Totals view, selecting Show data for, enables you
change the default time zone by selecting a different one, by clicking the Time Zone drop-down list.

Tip
To see the View Intra-Day Schedule context menu in step 4 in the next two
procedures, you must right-click a cell with a value other than 0.

Selecting Agents Contributing to Specific Shrinkage

1. From the Master Schedule menu, select State Group Totals.
The Show data for field is populated with Schedule States Totals by default (do not change
it).

2. Select a business unit, site, and activities and click Get Data.
3. Right-click any cell that contains a value.
4. Click the View Intra-Day Schedule context menu.

A list of agents who are contributing to the shrinkage is displayed.
5. Select the agents whose schedule you want to view.
6. Optionally, check the box Open Intra-day schedule in a new window, and click OK.

This opens the Intra-Day view in a separate window, leaving the the Schedule State Totals
view open behind it.

7. Or, leave the box Open Intra-day schedule in a new window unchecked, and click OK.
This opens the Intra-Day view, replacing the Schedule State Totals view.

The Intra-Day view now shows the selected agents' schedules.
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Viewing State Group Totals Grouped by Name

1. From the Master Schedule menu, select State Group Totals.
The Show data for field is populated with Schedule States Totals by default (do not change
it).

2. Select a business unit, site, and activities and click Get Data.
3. Click the Group by names check box.

When this check box is selected, and there are Schedule State Groups with the same name
under different sites, WFM displays their schedule state group totals in a single column
with the same name.

4. Right-click any cell that contains a value.
5. Click the View Intra-Day Schedule context menu.

A list of the agents is displayed.
6. Select the agents whose schedule you want to view.

The Intra-Day view opens, replacing the Schedule State Totals view.

The Intra-Day view now shows the selected agents' schedules.

Viewing and Editing Agents' Intra-Day Schedules

Use this procedure to view and edit multiple agents' schedules in the Intra-Day schedule or select
multiple agents who are contributing to schedule shrinkage.
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To view and edit agents' schedules:

1. In the data pane of an open scenario, select the time step or row for the schedule state you want to
edit.
The View or Edit Intra-Day Schedules Wizard opens with all agent states selected, by
default.

2. Select/deselect agent states, as needed, and then:
• Click View schedules to open the agents' Intra-Day schedule.
• Click Delete states to delete the select agents' states.
• Click Cancel to cancel the action and close the wizard.

3. Optionally, you can use the following check boxes:

Schedules Master Schedule

Workforce Management Web for Supervisors Help 664



• Open Edit Multiple Wizard—Opens the wizard and the Intra-Day schedule after you click View
schedules. See the Edit Multiple Wizard.

• Open Intra-Day schedule in a new window—Opens the agents' Intra-Day schedule in a separate
window after you click View schedules.

• Auto commit—Automatically commits the changes to the schedule. This box is checked, by default.
Unchecking this box indicates that changes will be committed to the schedule manually.

Tip
When using the Edit Multiple Wizard, you cannot edit or delete the following state
types: Activity, Day Off, Full-Day Exception, or Full-Day Time Off.

Graph Controls

The Graph displays data for the object(s) selected in the Object pane. Use the controls in the Data
pane to further configure the data display.

Graph Type drop-down menu

Select a display scheme for the graphical data.
(This menu is disabled and reset to the default
setting if the Scheduled States Totals value is
selected in the Show Data For: drop-down menu
).

Totals

Display the data in a line graph, that shows stacked
schedule-state groups information. Default.
If the Show Coverage and Forecast Information toolbar icon
is toggled on, the graph displays this data, in separate lines:
Schedule Coverage, Forecasted Staffing Calculated, and
Forecasted Staffing Required.

Comparison

Display percentage data for a specific schedule-
state group or for planned/unplanned overheads, in
a line graph that compares it to forecast overheads
data.
The graph displays two percentage data series as lines, in the
format that you select in the Targets drop-down menu.

Tip
If the Show Coverage and Forecast Information
toolbar icon is toggled on, the graph displays two
additional data series of forecast data for the object(s)
that you selected on the Object pane.

Variance

Display a bar graph of positive or negative values
for each timestep, if one of the following is selected
in the Object area’s activity tree: a single-site
activity, a single site, a single multi site activity, a
single business unit.
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Period Select Day, Week, Month, or Planning Period to
specify the granularity of the display.

Targets drop-down menu
This menu appears only when the Graph Type
menu selection is Comparison; use it to select
percentage data to compare. Select a format for
comparing percentage data:

Total Planned
Display scheduled planned overheads totals data
and forecasted total planned overhead data. Not
available if the selected value in the Show data
for: menu is Unplanned Overheads.

Total Unplanned
Display scheduled unplanned overheads totals data
and forecasted total unplanned overhead data. Not
available if the selected value in the Show data
for: menu is Planned Overheads.

List of schedule-state groups

Display a line graph of data for the named
Schedule State Group. Names in this list are
followed by a site name if more than one site is
selected on the Object pane.

Important
The Schedule State Groups list depends on the
selection in Show data for: menu. If you selected
Planned Overheads in the menu, then only planned
Schedule State Groups are shown in the list. If you
selected Unplanned Overheads in the menu then
only unplanned Schedule State Groups are shown in
the list.

Grid Layout and Controls

The columns in the Master Schedule State Group Totals table correspond to the configured
schedule-state groups. Use the Schedule States tab in State Groups Filter to specify which columns
appear in the table.

Grand Total

This column displays the grand total for all selected
agents (not just for the visible schedule-state
groups). It never contains the sub column %
(because its value is always 100%). Values in this
column depend on the selection in the Show data
for: menu.

Scheduled States Totals
This column displays the totals for visible schedule-
state groups for the selected agents, regardless of
their type.

Planned Overheads
This column displays the planned overheads total
for all selected agents. It is hidden if Scheduled
States Totals or Unplanned Overheads is selected in
the Show data for: menu.

Unplanned Overheads
This column displays the unplanned overheads
total for all selected agents. It is hidden if
Scheduled States Totals Planned Overheads is
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selected in the Show data for: menu.

Important
• An additional row displays the daily total for each visible column.
• An agent who is in multiple schedule-state groups during an interval, is prorated in the

grid by the fraction of the interval that the agent is in each state group. For example, an
agent on break for 5 minutes and at work for 10 minutes might be listed in the Break
cell as .33 and in the Work cell as .67 (Note that the terms Break and Work are used
here as examples of schedule-state group names, and may not correspond to the
schedule-state groups that are configured for your WFM environment.)

• The columns in the Master Schedule State Group Totals data table, and the stacked
lines in the graph, correspond to the configured schedule-state groups. Select Filter

in the toolbar, and use the Schedule States tab to specify which columns appear
in the table and which lines appear in the graph.

Data Controls

Show data for: drop-down menu

Select from the menu, a data-display scheme to
apply to the grid:

• Scheduled States Totals—Displays totals for
the schedule-state groups of the currently
selected agents, regardless of type. Select this
option to disable the check boxes described
below, and displays the data in grid columns
that are selected in the Schedule States tab
of the filter dialog.

• Total Shrinkage—Displays the total shrinkage
for the schedule-state groups (and their data),
excluding the type none.

• Planned Overheads—Displays the planned
overheads total for all selected agents. Select
to display the data in grid columns, grand total,
and sub columns that match the selected check
boxes below.

• Unplanned Overheads—Displays the
unplanned overheads total for all selected
agents. Select to display the data in grid
columns, grand total, and subcolumns that
match the selected check boxes below.
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Tip
Each data-display scheme includes a Time Step
column.

Grouped by name check box Select this check box to group the agents by name
when displaying schedule state totals.

Value check box

Select this check box to display the column that
shows coverage value in the grid.
This check box is disabled but checked if you select Scheduled
States Totals in the Show data for: menu.

Value % check box

Select this check box to display the column that
shows coverage percentage in the grid. The
percentage value is calculated relative to the grand
total.
This check box is disabled and not checked if you select
Scheduled States Totals in the Show data for: menu.

Compare with forecast check box

Select this check box to display the column that
shows percentage data of overhead from the
forecast in the grid, shall be presented in grid.
Enabled and applicable only if the same conditions are met as
for the toggle action Show Coverage and Forecast Information.

This check box is disabled and not checked if you select
Scheduled States Totals in the Show data for: menu.

Value cells Right-click in any cell (with a value other than zero)
to open the View Intra-Day Schedule context menu.

Actions Menu/Toolbar Buttons

These commands are available on the Actions toolbar (and on the Actions menu):

Icon Name Description

Time Zone

In the State Group Totals view,
when showing data for schedule
state totals, use this drop-down
list to change the default time
zone by selecting a different one.

Cleanup
Opens the Cleanup window.
Enables you to delete Master
Schedule information for
selected dates and agents.

Show Coverage and
Forecast Information

This toggle controls if additional
coverage and forecast
information is displayed, and is
enabled only if one of the
following is selected in the
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Icon Name Description
Object area’s Activity tree: a
single-site activity, a single site,
a single multi-site activity, a
single business unit.

Use Multi-Site Activities

This button becomes enabled
when you select a multi-site
activity or business unit in the
Objects pane. Clicking this button
displays combined data for all
the activities included in the
selected multi-site activity or
business unit.
If you set this button to On, WFM retains
your last selection—in the current view
and for all other views that contain multi-
site activities—preventing you from
having to click it every time you want to
display data for the selected multi-site
activity.

Filter Opens the State Groups Filter
dialog box.

Options

Opens the Options dialog box,
where you can show or hide the
columns Total Planned and
Total Unplanned in the grid
display; and change the colors
that are used in Coverage and
Forecast graphs.

Save As Template

Saves the current selections as a
forecast template of type
Overheads. Click this icon (or
select the command from the
Actions menu) to display the
New Forecast Template dialog
box.
Required settings: Graph
Type=Comparison, Period=Week.

Important
The Save as Template command
is not visible and the user cannot
edit Overheads if he/she has no
security rights to the Forecast
module.
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Master Schedule State Group Totals:
Options Dialog Box
Use the Options dialog box to specify the columns that the Master Schedule State Group Totals
view display.

1. Click Options on the Master Schedule State Group Totals view's Actions toolbar.
The Options dialog box opens. The Columns tab is selected by default.

2. Select the check boxes for the items that you want to be displayed.
3. Clear the check boxes for the items that you want to be excluded from the display.
4. Click the Options tab to display and modify the current Coverage and Forecast Graph color choices.
5. Click any of the color setting bars to open a color tool for that setting:

• Coverage Scheduled
• Forecast Staffing Calculated
• Forecast Staffing Required

This tool is described in the Configuration module topic.
6. Click OK to apply your choices.
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Master Schedule Overtime Requirement
View
Use the Master Schedule Overtime Requirement view to enter and edit overtime requirements.
It is available for the Master Schedule only. See the toolbar image here and the button descriptions
below.

This new overtime requirement module shares the same or similar interface components and their
functionality as other main forecast views, such as Volumes:

The Object pane presents site and multi-site activities.

1. Select a business unit, multi-site activity, site, or activity from the tree in the Objects pane.
2. Select Month (the default) or Week from the Period drop-down menu (above the grid in the Data

pane) to specify the granularity of data that is displayed in the grid.
3. Enter or select a date in the date selector (above the grid in the Data pane) to specify what days' data

are displayed in the grid. This choice also specifies the granularity of the date selector itself.

The grid reacts immediately to each of these selections. For example:

• If the Period value is Month, each row is the date of the first day in a week of the month in the date
selector, and each column is a day of that week.

• If the Period value is Week, each column is a single day's date of the week in the date selector, and
each column is a day of that week and each row is a 15-minute time step of that single day.

Using Options Dialog to Enable Subcolumns
You can use the Options dialog to enable sub-columns for each column.

Overtime

This sub column contains its own sub columns:

• Required (editable)—The daily total for Overtime Required is calculated not as the simple total of
timestep values, but as an Full-Time Equivalent (FTE). This column is displayed at all times.

• Scheduled (read-only)—This column is displayed by default but can be unchecked in the Options
dialog.

Important
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You can display staffing totals in Full Time Equivalent (FTE) or man-hours mode in
the Master Schedule Overtime Requirement view by adjusting the view settings
in the interface. To change the display mode, see Changing the Staffing Display from
FTE to Man Hours.

Staffing

This sub column contains its own sub columns:

• Calculated—read-only.
• Required—read-only.
• Coverage—read-only.
• Variance—read-only.

Formulas

• Graph Value = Schedule activities coverage (in single skill equivalents [sse]) - calculated forecast (sse)
- anticipated non-working overhead (sse)

• Anticipated Non-Working Overhead (sse) = schedule state total (sse) * total forecasted non-working
overhead (percentage)/100 - total scheduled non-working overhead (sse). If anticipated non-working
overhead (sse) is less than 0, then anticipated non-working overhead = 0.

Important
In the formulas above, there are two different values called coverage . The first one is
the Schedule Activity coverage, which is normal activity coverage (indicated by a
red line in Intra-Day Schedule graph). The other is the Schedule State total, which
is the sum of all Schedule States, except those belonging to the group of type
<none> .

Difference

This sub column contains its own sub columns:

• Calculated—Calculated staffing – read-only.
• Required—Required staffing – read-only.

Actions Menu and Toolbar Buttons

The following commands are available on the Actions toolbar (and also on the Actions menu):
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Icon Name Description

Cleanup
Opens the Cleanup dialog.
Enables you to delete Master
Schedule information for
selected dates and agents.

Convert variance to
overtime required

Enabled only when you select
Weekly in the Period drop-down
list, select an activity or multi-
site activity, and the Staffing
Variance is present in the data
grid.
Click Convert staffing variance to
overtime required to open the dialog
box and find the Do not decrease
overtime requirement check box:

• Do not check—If you want
the Overtime Required to
change to a value that is
calculated by the following
formula: [Overtime
Scheduled - Staffing
Variance] for all timesteps
that have a negative value
for Staffing Variance.

• Add a check mark—If you
want the Overtime
Required to change to value
that is calculated by the
following formula: [Overtime
Scheduled - Staffing
Variance] for all timesteps
that have a negative value
for Staffing Variance and an
Overtime Required value
that is less than [Overtime
Scheduled - Staffing
Variance].

Save Saves your changes.

Use multi-site activities

Enabled when you select an
Enterprise or a Business Unit,
and disabled when you select a
Multi-Site Activity. Clicking this
button adds to the grid multi-site
activity data for the selected
business unit.
If you set this button to On, WFM retains
your last selection—in the current view
and for all other views that contain multi-
site activities—preventing you from
having to click it every time you want to
display data for the selected multi-site
activity.
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Icon Name Description

Options
Opens the Options dialog.
Enables you to display or hide
individual statistics.
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Master Schedule Overtime Requirement:
Options Dialog
Use the Options dialog to specify the columns that the Master Schedule Overtime Requirement
view displays.

1. Click the Options button on the Master Schedule Overtime Requirement view's Actions
toolbar.

The Options dialog box opens. Only the Overtime Scheduled check box is selected by default.

2. Select the check boxes for the column(s) that you want to be included in the display:
• Overtime Scheduled
• Staffing Calculated
• Staffing Required
• Staffing Coverage
• Staffing Variance
• Difference Calculated
• Difference Required

3. Click OK to apply your choices.
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Master Schedule Changes Approval
Viewing and using the Master Schedule Changes Approval view requires that you have Schedule
Approve Changes security permission enabled. If you do not, you cannot see this view in the
Modules tree.

Changes to the Master Schedule that are made by users with the Schedule Approve Changes
security permission disabled are first entered in Pending mode. Use the Master Schedule
Changes Approval view to accept or reject these pending changes.

Alternatively, for pending changes that you made, you can:

• Use the Commit/Rollback Multiple Wizard to commit or rollback all pending changes for selected agents
on selected dates.

• Use the Schedule Intra-Day views to directly save or delete all items in an agent's schedule day that
have Pending status. To do so, right-click the row showing the agent's schedule and then select
Commit or Rollback.

Displaying Pending Changes

1. From the Home menu on the toolbar, select Schedule.
2. From the Schedule menu on the toolbar, select Master Schedule.
3. From the Master Schedule menu, select Master Schedule Changes Approval.
4. On the Objects pane, select the appropriate item(s) from either the Agents tree (above) or the

Activities tree (below); WFM then selects matching item(s) from the other tree.
You can expand business units to display their sites, and you can expand sites to display
their teams and agents. You can select multiple sites, teams, and agents, but just one
business unit.

5. From the Period drop-down list, select the time period to view. You can select Daily or Weekly.
6. From the Users drop-down list, select which user's changes you want to see. Select All to see all

pending schedule changes. All is selected by default.
7. Use the date selectors to change the schedule dates to view.

By default, if you chose to view the Weekly period and select a day other than the first day of the
week, the display begins on the first day of the week containing the day you selected.

8. Click Get data.
The top pane of the Changes Approval view displays a table containing the pending
schedule changes made by the users you selected. The columns in the table are sortable.
The columns in the Pending Changes table are the following

• Date—The schedule date that has been changed.
• User—The user who made the change, or Changed by Agent if an agent made the change.
• Agent—The agent whose schedule has been changed.
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• Site—The site to which the affected agent belongs.
• Team—The team to which the affected agent belongs.

Approving or Rejecting Pending Changes

1. Select one or more schedule changes in the pending changes table.
The current version of each affected agent's schedule, and the agents' schedules as they would
appear with the changes incorporated, appear in the Original Schedule and Modified Schedule
panes below the table.

• Original Schedule pane—Shows the agent's schedule as it appears in the current version of the
Master Schedule.

• Modified Schedule pane—Shows the agent's schedule with the pending changes included.

These panes contain the following columns:

• Item—The name or type of the changed item. For shifts and activity sets, this column displays all of
the associated activities.

• Start Time—The start time of the changed item. For full-day items, this column is empty.
• End Time—The end time of the changed item. For full-day items, this column reads Full Day.
• Paid Hours—The number of paid hours in the schedule.
• Colors—Items that do not match in the original and edited schedules appear in specific colors. Non-

matching items in the original schedule pane are marked in blue. Non-matching items in the
Modified Schedule pane are marked in green.

2. To see whether the changes violate any schedule constraints, select the change in the pending changes
table and then click Validate.

The Review Validation Messages dialog opens. See Schedule Validation for a list of possible error
and warning messages and their descriptions.

3. After reviewing the changes, select one or more of them and then click Accept to save the changes in
the Master Schedule or Reject to discard them.

The Master Schedule is updated to include all accepted schedule changes.

Warning
If you accept or reject any pending change for an agent, all pending changes for that
agent are accepted or rejected.
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Review Validation Messages Dialog
Use the Review Validation Messages dialog to view any warnings or errors that the server
returned when you validated the selected pending changes to the Master Schedule.

The dialog contains the following columns and controls:

Date Date of the message.

Agent The agent whose schedule change generated the
message.

Team The team to which the agent whose schedule is
being changed belongs.

Message The message type (either Warning or Error),
numeric code, and the message text.

OK Closes the dialog.

Important
These errors and warnings would be generated if you validated the selected pending
schedule changes. They differ from Validation warnings and errors, which WFM Web
generates during the schedule building process.
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Overtime Bidding
Rather than simply assigning overtime hours to agents, you can create Overtime Offers and enable
agents to select the overtime hours they most prefer. After you customize and open the offer for
bidding, agents can view it in the Web for Agent's interface and enter bids for their desired overtime
slots. WFM then processes the bids, using the hierarchy system of seniority or rank that you have
chosen.

Important
To configure objects and change settings in the Overtime Bidding view, you must
have the appropriate role privileges. See Schedule Role Privileges.

How Overtime Bidding Works

Complete these steps to set up WFM Overtime Offers and initiate the bidding process. Click the links
in the summary steps below, to read details.

1. Obtain user role privileges—Ensure that an administrator (or someone with administration
privileges) has given you the proper role privilege, enabling you to access Overtime Bidding. See
Assigning Roles to Users and Schedule Role Privileges.

2. Create an overtime offer—Create the offer and sets its properties.
3. Open the overtime offer for bidding—Open the offer, making it visible in the WFM Web for Agents

interface. You can edit the Overtime Offer at any time.
4. Wait for agents to submit bids—Wait for agents who are associated with (can see) the Overtime

Offer to submit their requests for overtime slots, including the desired start and end time for each slot.
Agents can enter multiple bids within the same Overtime Offer, setting the preferred priority for each
slot. Agent can enter overlapping time intervals or slots.

5. Initiate the overtime scheduling process—Start the overtime scheduling process; at the top of the
Overtime Offers pane, click Initiate scheduling process.

WFM Processes Bids for Overtime Scheduling
WFM begins the overtime scheduling process, using the associated agents list to select agents one-
by-one, based on ranking order, and processing their overtime requests, based on the priority
specified by the agent.

WFM schedules the slot if:

• The requested overtime is under the overtime requirement for activities associated with the Overtime
Offer.
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• Rules and constraints configured within Overtime Offer are satisfied
• Agents receive valid schedules based on existing constraints, meaning they do not generate schedule

warnings.

After WFM finishes the overtime scheduling process, agents' schedule are committed to the Master
Schedule.

Overtime Offer Properties

You'll find the following settings and controls in the Overtime Offers Properties pane:

• Name—Enter a name for the overtime offer. The name must be unique in the Configuration database.
• Start Date and Time—Enter the start date and time for the overtime offer. This is the earliest date/

time for which agents can submit bids for overtime.
• End Date and Time—Enter the end date and time for the overtime offer. This is the latest date/time

for which agents can submit bids for overtime.

Tip
Create Overtime Offers that are less than 6 weeks. WFM does not process or save offers that
exceed 6 weeks.

• Criteria—Select the criteria that WFM will use to prioritize the processing of agents' bids. For example:
• Rank
• Seniority
• Seniority and Rank
• First come, first serve

• This Overtime Offer is open check box—Check this box to open the overtime offer and make it
visible to agents. You can save the offer without checking this box and check it later when you are
ready to open the offer.

ASSIGNS section:

• Activity/Multi-Site Activity—Use the radio buttons to select an activity or multi-site activity that

agents will work on during the hours of the overtime offer. Click Edit to open a list of activities or
multi-site activities, select one, and click Apply . Click the x on an existing activity/multi-site
activity to clear this field.

• Marked Time drop-down list—Select the Marked Time that will identify the assigned overtime activity/
multi-site activity in schedules.
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RULES AND CONSTRAINTS section—Enter values in the format hh:mm in this section:

• Minimum slot size—The minimum slot size of any one agent bid.
• Maximum slot size—The maximum slot size of any one agent bid.
• Maximum agent overtime per day—The maximum amount of overtime per day that a single agent

can work.
• Maximum total overtime per day—The maximum total amount of overtime per day that all agents

can work.
• Maximum total agent overtime—The maximum amount of overtime that a single agent can work.
• Maximum total overtime—The maximum total amount of overtime that all agents can work.

COMMENTS section—Enter any relevant comments or details about the Overtime Offer.
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Managing Overtime Offers
At any given time, you might have more than one Overtime Offer open or in progress. WFM makes it
easy for you to manage Overtime Offers by providing intuitive controls and views, enabling you to
perform the following tasks:

• Create, edit, delete, or copy offers.
• Associate agents and sites with offers.
• Disassociate or remove agents and sites from offers.
• View bid slots for selected agents and decline bid requests.
• Initiate the overtime scheduling process.
• Edit the Properties, Agents, and Sites settings for a selected offer by clicking the tab, making the

necessary changes and then, saving them.

Creating Overtime Offers
Create Overtime Offers that are less than 6 weeks only. WFM displays a validation error if an offer
exceeds 6 weeks and does not saved it.

Link to video
To create an overtime offer:

1. Go to Schedule > Overtime Bidding.

2. In the Objects pane, select a business unit or a site and then, click .

3. In the Overtime Offers pane, click New .
The Overtime Offer Properties pane opens.

4. Enter a name for the Overtime Offer.
By default, the Name field is already populated with a unique name when you select New.
The name includes a number to ensure that each newly created Overtime Offer has a
unique name in the Configuration database. You can change this name, but it must remain
unique to prevent duplicate name errors from occurring.

5. Continue setting the properties as described in Overtime Offer Properties.

6. When finished, click Save .
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Tip
If the list of Overtime Offers becomes long, find offers quickly by entering criteria into

the Search field, or by using clicking Sort and selecting one of three
columns to sort on: Name, Start, End. Alternatively, sort any of these columns in
ascending or descending order, by clicking the column header.

After you save the Overtime Offer, WFM displays the Agents tab, enabling you to associate agents
with this offer. Also, use the Sites tab to associate sites with this offer.

Editing Offers
To edit an overtime offer:

1. In the Overtime Offers pane, select the offer you want to edit.
2. In the Overtime Offer Properties pane, make the necessary changes.

3. Click Save .

Deleting Offers
To delete an overtime offer:

1. In the Overtime Offers pane, select the offer you want to delete.

2. Click Delete .
3. When the Confirmation dialog opens, click Yes to delete the offer, or No to cancel the action.

Using Copy to Create Offers
To create an overtime offer by copying an existing offer:

1. In the Overtime Offers pane, select the offer you want to copy.
The Associate

2. Select the Business Unit that you want to associate with this offer and click Apply .
3. Rename the offer and change any other property settings, as required.

The Overtime Offer name must be unique.

4. Click Save .
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Associating Agents with Offers

You can associate agents in two ways: By selecting all agents skilled in the activity you specified for
this Overtime Offer or by choosing agents from a list. Note that the controls used to add and remove
agents from a list are not visible when you select the option Use all agents skilled for the
selected activity.

To associate agents with an overtime offer:

1. Click the Agents tab.
2. Check the Use all agents skilled for the selected activity check box.

The Agents section of the pane is populated only with agents who are skilled in the
specified activity. WFM selects these agents automatically.

3. Optionally, click Add Agents to select agents from a list.
The Available Agents pane opens these columns

(the agents') Last name, First name, Site, and Team.

4. Select the agents you want to associate with the Overtime Offer and click Assign and save .

This procedure is also demonstrated in the video Creating Overtime Offers above.

Using Search and Sort to Find Agents
If the list of agents on the Agents tab or in the Available Agents pane becomes long, find agents
quickly by clicking Sort :

• Select one of three columns to sort on the Agents tab: First name, Last name, Site.
• Select one of four columns to sort in the Available Agents pane: First name, Last name, Site,

Team.

You can also use Search to find agents in long lists by clicking the First name or Last name radio
buttons and then, entering the agent's name, or enter other search criteria

Removing Associated Agents from Offers
To remove agents associated with an overtime offer:

1. In the Agents tab, click the row of the agent that you want to remove.

2. Click Remove agents .
3. When the Confirmation dialog opens, click Yes to delete the agent, or No to cancel the action.
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Viewing Bid Slots for Agents
To view bid slot for an agent:

1. In the Agents tab, click the row of the agent whose bid slots you want to see.
The Bid Slots pane opens, showing bid information for the selected agent in four columns

• Bid (priority)
• Start (date/time)
• End (date/time)
• Status (of the bid)

Declining Agents' Bid Requests
To decline an agent's bid request:

1. Click the Agents tab and select the agent whose bids you want to view and decline.
The Bid Slots pane opens displaying a list of the agent's bid requests.

2. Select the row containing the bid you want to decline.
The Bid Slot Details pane opens with the following information:
• The schedule date (on which agents insert bid slots)
• The bid slot start date and time
• The bid slot end date and time
• The priority number
• The status
• The reason (or warnings that appear when agents insert bid slots or during processing)
• The comments associated with the bid slot

3. Click Decline .
4. In the Confirmation dialog that opens, click Yes to proceed or No to cancel the action.

If you select Yes, the status in the Bid Slots pane changes to Declined.

5. To continue with another bid slot or another agent, click Close to return to the Agents tab.

Associating Sites with Offers

To associate sites with an overtime offer:
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1. Click the Sites tab.
2. Check the sites that you want to associate with the offer.

If you want to select all sites, select the top check box named Site.

This procedure is also demonstrated in the video Creating Overtime Offers above.

Removing Associated Sites from Offers
To remove sites associated with an overtime offer:

1. In the Sites tab, clear the check box beside the site(s) you want to remove or disassociate from the
offer.

2. Click Save .

Initiating the Overtime Scheduling Process

To start the overtime scheduling process:

1. At the top of the Overtime Offers pane, click Initiate scheduling process .
2. When the Confirmation dialog opens, click Yes to begin the scheduling process or No to cancel the

action.
If you select Yes, a Processing dialog opens with a progress bar indicating that WFM is
processing the agents' requests.

After WFM processes all agents' requests for overtime and schedules them, the Overtime offer is
closed and WFM clears the check box This Overtime Offer is open. Agents who submitted requests
will see them as Resolved in the Web for Agents UI and the Overtime offer status as Closed.

Continuous Processing of Overtime Offers
You can enable WFM to continuously process Overtime Offers, which have FIFO selected for agent bid
ranking criteria. Continuous, automatic processing is enabled by setting a configuration option in the
WFM Server application, which specifies the time interval between overtime bidding processes. When
enabled, there's no need to manually initiate the scheduling process, as Overtime Offers stay open
and WFM does not automatically clear the This Overtime Offer is open check box to close the offer
(as it does when the process is manually initiated).

For information about how to enable this feature, see the Workforce Management Administrators
Guide.
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Schedule Bidding
WFM's Schedule Bidding feature enables a workforce planner to create schedules with no agent
names, and then distribute those schedules to agents via the Web, so that agents can rank their
most desired and least desired schedules.

Schedule Bidding enables contact centers to comply with certain labor union regulations that require
that the most senior agents, or the most highly-ranked agents, get the schedules they most desire.
Even if your contact center does not have these labor regulations, it may still be a process that could
provide business value to you. It is a way to empower agents to have more input into the schedules
they will be given, and therefore could be used to increase morale within the contact center and
reward high-performing agents.

How Bidding Works

Instead of simply assigning schedules to agents, the Supervisor designs and builds a schedule
scenario. Then, agents can view the scenario and enter bids for their most desired, and most
unwanted, shifts. Finally, the Supervisor can auto-assign or manually assign schedules to agents
based on their bids, using a hierarchy system of seniority or rank.

Click links in the summary steps below, to read details.

1: Setting Up Bidding

a. Someone with administration permissions must verify that Schedule Bidding is enabled. To do so,
make sure that the AllowBidding configuration option is set to true (the default setting) in the
AgentBidding section of the WFM Web application.

b. The Supervisor creates and configures a bidding scenario. Steps include creating a forecast and then a
schedule for specific activities and profile agents, then deciding which agents can bid and when.

This opens the bidding process and makes the schedule options visible to agents.

Important
During the Schedule Bidding period, a scenario’s site has the status Open for Bidding. Any action or
operation that would alter schedules for that site is disabled. This includes (but is not limited to) these
actions: direct schedule editing, insertions or deletions, clean up or extraction from the Master Schedule,
schedule rebuild or optimization.

2: Bidding on the Schedule

a. Agents examine the bidding scenario options and submit their bids.
b. The bidding period closes when the Bidding End Date arrives. Agents can not access the closed bidding
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scenario.

3: Resolving the Bids

a. The Supervisor reviews schedule bids. The Supervisor might want to manually modify or assign
schedules to agents.

b. The Supervisor starts the auto-assignment wizard. The wizard assigns schedules to agents.
c. The Supervisor reviews results of auto-assignment. The Supervisor might want to manually modify or

reassign schedules.

4: Finalizing the Schedule

a. The Supervisor publishes the bidding scenario to the Master Schedule.
b. After all schedules have been assigned to real agents, the Supervisor can run a Schedule Bidding

Report.

How the Auto-Assignment Wizard Works

It's important to understand how WFM's schedule bidding auto-assignment wizard works, otherwise,
it might appear that agent rankings for granting bids is incorrect in some cases.

The wizard's algorithm makes two passes through all bids. Here's how it works:

1. The wizard first processes Desired bids only for all agents (higher ranking agents first).
2. The wizard then processes agents without assigned schedules—agents whose Desired bids were not

granted or agents who have no Desired bids—taking into account Undesired bids for shifts that were
not assigned previously as Desired for any agent.

Shifts in Undesired bids can be taken by agents who entered them as Desired bids. The worst case
scenario occurs when an agent who has no assigned schedule finds all of his/her Desired bids granted
to another agent with a higher rank who bid Desired on the same shifts, and all of his/her Undesired
or neutral bids granted to other agents with a lower rank who bid Desired on those same shifts.
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Configuring Bidding Scenarios
Begin at the Schedule Scenarios view.

1. Create a Forecast Scenario

1. Create a New Forecast Scenario.
2. Define the work week(s) that this forecast spans and the activities that it requires.
3. Build Volumes, Build Staffing, and then Publish the Forecast.

This transfers the forecast to the master schedule database, so you can configure a bidding
schedule.

4. Follow all the steps exactly as you would to create a non-bidding schedule.

2. Create a Schedule Scenario

1. Create a New Schedule Scenario.
2. Define the General Parameters including Start Date, End Date and Extended End Date.

For example, you can build a 1-week bidding schedule the Start Date 3 June 2007, and the
End Date 9 June 2007, and the Extended End Date is 1 September 2007. The one-week
schedule that you present to agents for bidding, is applicable for the entire 3rd quarter of
2007. Agents can see the Extended End Date during bidding, and thus know that they are
bidding on schedules for the entire 3rd quarter.

3. Select Activities, and Agent Profiles.
You can select real agents too, but their schedules will not be biddable.

4. Build the scenario.

3. Configure the Scenario for Bidding

1. Build the Bidding Schedule.
2. Define which agents can bid in the Bidding Candidates Selection dialog.
3. Define when agents can bid in the Control Bidding Process Wizard.
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Select Bidding Candidates
Use the Bidding Candidates Selection dialog to specify which agents are eligible to bid on a
chosen bidding scenario.

1. Preparation

a. Create and configure a Scenario for bidding.
b. Open the Scenario and select the Profiles/Bidding view.

2. Assigning the Agents

a. To open the wizard, click Bidding Candidates Selection in the toolbar.
b. In the Bidding Candidates Selection dialog, open the Site(s) and then the Team(s).
c. Select only the team members who will be eligible to bid on your configured Scenario.
d. Clear the check box to the left of each member who will not be eligible to bid.
e. Click OK.
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Associate/Separate Teams

You reached this wizard by clicking Associate/Separate Teams in the toolbar.

Follow these steps to associate or separate teams:

1. Select one of these two radio buttons:
• Associate Teams—The teams that you select from the Configured Team and Profile Team drop-

down menus will be associated with each other. Profile agents from the profile team will be placed
on the configured team.

• Separate Into Teams—Any profiles that are in the team that you select from the Configured
Team drop-down menu will be separated to a profile team. The Profile Team drop-down menu will
be disabled.

2. Select a site from the Sites drop-down menu.
All sites that are present in the currently selected scenario are listed. Selecting a site refreshes the
team lists in this dialog box.

3. Select a team from the Configured Team drop-down menu.
All configured teams in the currently selected site are listed, with no default choice. Configured
means teams created in the Organization > Sites module of WFM Web, with real agents
assigned.

4. Select a team from the Profile Team drop-down menu.
All profile teams that are in the currently selected site are listed, with no default choice. Disabled if
the radio button Separate into Teams is selected.

5. Click OK to perform Association (or Separation).
Click Cancel to abandon it.
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Control Bidding Process Wizard
Use this wizard to:

• Define the Schedule Bidding period (Bidding Start date/time and Bidding End date/time) for the
current bidding scenario.

• End bidding early, or extend bidding, by changing the Bidding End value for a bidding scenario that is
currently open.

1. Preparation

a. Create and configure a Scenario to be used for bidding.
b. Open the Scenario and select the Profiles/Bidding view for that scenario.

2. Running the Wizard

a. To start the wizard, click Control Bidding Process in the toolbar.
b. In the Select Site dialog, select the appropriate site and click Next.
c. In the Set Bidding Options dialog, use these controls to specify the start and end of bidding:

Bidding Start

Specify the bidding start date and time. You can
type directly into each text box, use the up or
down arrow to modify the displayed date, or click
the button at right to display a calendar.

Default value: bidding start date (if bidding was already
initiated) or midnight tomorrow (if bidding is not yet
initiated).

Bidding End

Specify the bidding end date and time. You can
type directly into each text box, use the up or
down arrow to modify the displayed date, or click
the button at right to display a calendar.

Default value: bidding end date (if bidding was already
initiated) or midnight tomorrow + 1 week (if bidding is not
yet initiated).

You can change the End Date after the bidding scenario is already open and while agents are bidding.
You might have to change the date, either to extend or to shorten the bidding period, for business
reasons. But be careful if you do that.

The End Date is visible to agents as they bid, and they will rely on its accuracy. If you decide to close
bidding early (or to extend it), inform all your agents beforehand so they will not be caught by surprise.

d. Click Finish.
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Resolving and Publishing Bidding Scenarios
The Schedule Bidding period has ended. Eligible agents have bid on their preferred schedules and
if each agent requested a different schedule, then the Supervisor could grant everyone's wish. But of
course there are conflicts. The Supervisor must resolve identical bids and create a schedule with a
real agent assigned to every schedule, while heeding such factors as agent seniority and rank.

Supervisors should follow these steps to resolve the bidding and publish a schedule with real agents:

1. Select the Schedule module, open the bidding scenario that needs resolution, and select the Bidding/
Profiles view.

If necessary, you can end bidding early for a still-open schedule.

2. Examine the agents' bids, and make manual adjustments or assignments as necessary.
3. Run the Auto-Assign Schedules Wizard, to assign real agents to the "profile" schedules automatically.
4. Publish the now-finished bidding schedule to the Master Schedule.

The Publish to Master Schedule page of the Publishing Wizard includes the Insert granted
exception, time off, and day off Calendar items check box, which you can use to overlay these items
in the schedule.

Important
Unassigned profile schedules are not published to the Master Schedule; only real
agents' schedules.

After the bidding scenario is published to the Master Schedule, agents can view it when they log in.

The Supervisor can generate a Schedule Bidding Report if all profile schedules were assigned to real
agents.
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Auto-Assigning Schedules

You reached this view by clicking Auto-Assign Schedules in the toolbar.

Follow these steps to auto-assign schedules:

1. Select a site.
2. Select a ranking system by clicking one of these three radio buttons:

• Seniority favors agents by their hire dates.
• Rank favors agents by their rank, as defined by a supervisor.
• Seniority + Rank favors agents by seniority first, and if that results in a tie, then uses rank as the

criterion.

3. Select a target (which agents will be assigned schedules).
All Agents—Auto-assigns from the pool of all agents. Here are two uses for this option

• You previously prepared profile schedules, not intended for bidding but for 400 new agents that you
have now hired, and need to assign.

• Bidding is resolved but you still need to assign a few profile schedules to real agents.

Bidding Agents Only (default)—Auto-assigns only those agents that were designated as
eligible to bid, in the Bidding Candidates Selection dialog.

4. Click OK to begin the auto-assignment process or Cancel to abandon it.
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Schedule Build Wizard
Use the Schedule Build Wizard to build a schedule for a selected site, based on a selected forecast
scenario. The build process includes all activities and agents defined for this site in the scenario.

Using the Schedule Build Wizard

To use the wizard:

1. Select an existing schedule scenario or use the New Schedule Scenario Wizard to create a new scenario.
2. Open one of the following Schedule Scenario views:

• Scenario Intra-Day view
• Scenario Agent-Extended view
• Scenario Coverage view
• Scenario Weekly view
• Scenario Profiles/Bidding view
• Scenario Summary view
• State Group Totals view

3. In the Actions toolbar, click Build Schedule , or select Build Schedule from the Actions menu.
The Select Sites screen opens.

4. Select the site(s) and build options that you want, and then click Next.
The Schedule Build Parameters screen opens.

5. Select the specific parameters to apply for Team Synchronicity, Shared Transport Constraints,
Preference Fulfillment Options, Optimizing Profiles, and Assigning Profiles to Teams.

6. Click Finish.
The Building Schedule... dialog appears, showing the progress of schedule building.

Schedules Schedule Build Wizard

Workforce Management Web for Supervisors Help 695



Select Sites (and Build Options)
Use the Schedule Build Wizard's Select Site screen to select one or more sites, and specific schedule
build options for each site.

This screen displays a table, with a separate row for each available site. Within each row are columns
that contain build options.

• Choose all items in any column by selecting the check box at the top of the column. Clear the check box
to reject all items.

• Choose any individual item in any row by selecting the check box in that row. Clear the check box to
reject that item.

The columns contain the following build options.

Site

Each row contains a site that is in the currently selected schedule scenario. You must select at least
one site.

If you do not see a site that you want to include, cancel and create a new schedule scenario that
contains that site, and then use that site as the basis for your schedule build.

Force Single Skill

If you select this option and an agent has multiple skills, the agent can be scheduled for only one
activity on each workday.

If you clear this option, the agent can be scheduled for multiple activities on the same day.

Use Required
If you select this option, the schedule is built with the Required Staffing forecast, not with the
Calculated Staffing forecast.

Disable monthly constraints for the first month
Select this check box when the first month is not complete (because you are scheduling from the
middle of the month) and there is no historical data for the beginning of the month. In this situation,
schedule building cannot correctly accommodate monthly constraints, such as minimum or maximum
work hours per month.
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Select this check box to relax those constraints for this month.

Shuffle Agents

If you select this option, the agent pool is randomized before scheduling. (Randomizing ensures that
the schedule's results are independent of the sequence in which agents are loaded into the
scheduling algorithm.)

Use Team Constraints

Select this check box to enable team synchronicity constraints in the next wizard screen (Specify
Build Parameters). Clear the check box to disable this functionality.

This option and the Use Shared Transport Constraints option cannot be selected simultaneously.

Use Shared Transport Constraints

Select this option to enable shared transport group constraints in the next (Specify Build
Parameters) wizard screen. Clear the check box to disable this functionality.

This option and the Use Team Constraints option cannot be selected simultaneously.

Tip
Shared Transport is known by many different names worldwide—bus, carpool, ride
share, lift share, and paratransit, for example. See Wikipedia for details.

Exclude Granted Agents from Used Constraints

If you select this option, agents who have been granted full-day exceptions or working hours are not
considered when team synchronization is enforced.

Important
Always select this option when you are using team constraints.

Click Next to continue, or Cancel to discard your selections and close the wizard.
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Use Secondary Activities

Check this option to assign a secondary activity to agents directly. Activity assignment is based on
skills and skill levels, therefore a secondary activity is one, in which at least one of the agent's skills
is marked as secondary. Leave this option unchecked if you want only primary activities considered in
the Site schedule scenario.
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Schedule Build Parameters
Use the Schedule Build Wizard's Parameters screen to select parameters for the selected sites from
the previous screen. Each site is a node in a tree on the left-hand side of the screen. Click the node to
open the tree and display that site's build parameters. Select a parameter in the tree (on the left,)
and you can select, specify, or disable all of its options on the right side of the screen.

The parameter categories are:

• Team Synchronicity
• Shared Transport Constraints
• Preference Fulfillment Options
• Optimize Profiles
• Assign Profiles to Teams

Team Synchronicity

Specify these parameters:

Synchronize Days Off Select this check box to specify that days off should
be synchronized for all teams.

Synchronize By

Use the radio buttons to specify the
synchronization combinations to apply when
building the schedule:

• No additional synchronization
• Shift Start Time—If checked, use the duration

control Maximum Start Time Difference to
specify the maximum difference between shift
start times inside the team. Use the format
HH:MM; where 02:59 is two hours and fifty-nine
minutes.

• Paid Duration
• Shift Start Time and Paid Duration
• Shift Start Time, Paid Duration, and Meals
• Shift Start Time, Paid Duration, Meals and

Breaks
• Paid Duration and Meals
• Paid Duration, Meals and Breaks

Maximum Start Time Difference Specify in hh:mm format. Range is from 0 (zero) to
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23:59.

Apply constraints only to the same contracts
inside team

Select this check box to specify that while
synchronizing teams, WFM must take configured
contract information into account while creating
the schedule. By default, this check box is cleared.

Tip
Synchronization applies to all teams under the selected site.

Shared Transport Constraints

Tip
Shared Transport is known by many different names worldwide—bus, carpool, ride
share, lift share, and paratransit, for example. See Wikipedia for details.

If you selected Shared Transport Constraints in the Select Sites (and Build Options) dialog, this
selection is enabled and Team Synchronicity is disabled (team and shared transport group
restraints are mutually exclusive). Type, or use the spinner controls, to specify the maximum
deviation between starts and ends of shifts. You can specify any value between 1 minute and 23
hours, 59 minutes; most practical values will be less than 30 minutes.

Important
The participants in a shared transport group can work in shifts that begin and end at
different times; however, they should not deviate greatly, or the shared transport
group becomes impractical. You are specifying the maximum allowable deviation in
the schedule of each participant in the same shared transport group.

Preference Fulfillment Options

The Force Maximum Preference Fulfillment parameter optimizes the number of profiles for the
selected site. See How the Preference Fulfillment Ratio Works for more information.

Select this parameter to:

• Treat all preferences with preferred status as granted.
• Resolve all granted and would-be granted preferences.
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• Use the result to build the schedule.
• Disable all other options on the page.

Clear this parameter (default) to disable the options listed above, and enable the options listed
below.

Prioritization

Specifies how WFM Builder favors agent requests
when building the schedule. Select one item from
the drop-down list:

• None specifies no prioritization during schedule
building.

• Seniority favors agents by their hire dates
(which are indicated in the table on the lower
part of the Preference Fulfillment screen).

• Rank favors agents by their rank, as defined by
a supervisor in the Agent Properties (and also
indicated in the table on the lower part of the
Preference Fulfillment screen).

• Seniority + Rank favors agents by Seniority
first, and if that results in a tie, then uses Rank
as the criterion.

Emphasis

Controls how closely the build process considers
skill coverage when it assigns priorities to
preferences. Select one item from the drop-down
list:

• None specifies that agents' preferences are
assigned on the basis of seniority and/or rank
alone, using the percentages assigned to the
agents (as shown in the % column). This option
tends to favor multi-skilled optimization over
preference fulfillment.

• Low specifies that schedule building places
more emphasis on preference fulfillment,
without sacrificing multiskilled optimization.

• Medium specifies that schedule building
accommodates preferences if a loss in any skill
coverage is caused only by an exception.

• Strong specifies that schedule building does
not consider multiskilled optimization when it
allocates preferences.

Tip
Emphasis is disabled when you select Team
Constraints in the Select Sites (and Build Options)
wizard page.

Fulfillment
Sets the minimum and maximum percentage of
preferences that schedule building fulfills. For
example, if you set Min to 10% and Max to 80%,
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every agent has at least 10% of his or her
preferences fulfilled, while the highest-ranking or
most senior agent has at least 80% of his or her
preferences fulfilled. Agents with intermediate
standing receive a percentage between the two
extremes (their exact percentage depends on their
place in the hierarchy).
Enter or select the Min(imum) and Max(imum) values. The range
is 0—100 and Min. must be lower than Max.

Tip
Schedule building applies these percentage values separately to
each preference type and satisfies all preferences, when possible.
For example, if an agent has a 50% fulfillment ratio, and makes 20
shift preferences and 8 day-off preferences over a 4-week period,
the agent is guaranteed to receive at least 10 preferred shifts and 4
preferred days off, unless this preference fulfillment is prohibited by
other working rules.

In cases where the preference fulfillment ratio cannot be achieved
due to working-rule violations, WFM Web displays a warning
indicating that the schedule results may not be desirable. WFM Web
attempts to satisfy more than the minimum level of preference
fulfillment, as long as the results do not cause understaffing.

Calculate

Re-sorts the table below by the % column, which
will then display each agent's calculated chance of
preference fulfillment. (Use the table's vertical
scroll bar to display more agents.)

• Click Calculate.

Adjust Fulfillment Ratio

Adjusts the preference fulfillment ratio using the
controls below the table.

1. In the Adjust Fulfillment Ratio text box, enter
a value or use the up or down arrows to modify
the displayed value. Range is -100 to +100.

2. Click Adjust.

Tip
In the % column, WFM Web adds your adjustment to,
or subtracts it from, all agents' chances of preference
fulfillment. However, it does not increase any agent's
fulfillment ratio above 100% or reduce it below 0%.

How the Preference Fulfillment Ratio Works

The preference fulfillment ratio modifies the impact of the agent prioritization settings.

• The preference fulfillment functionality applies only to calendar items that an agent can request (Shift,
Day Off, and Availability). Also these items may be inserted into the calendar by a supervisor. Any other
preferred calendar items (such as Exceptions, Times Off, Working Hours) are not fulfilled; they remain in
Preferred status even if 100% fulfillment is defined.

• If you set the ratio to a value greater than 0, then each agent's chances of having his or her preferences
fulfilled is increased by whatever value you entered, up to the maximum percentage that you set for
the Max option.
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• If you set the ratio to a value less than 0, then every agent's preference fulfillment ratio is reduced by
whatever value you entered, down to the minimum percentage that you set for the Min option.

Tip
The preference fulfillment ratio cannot surpass the Min and Max percentage values
set under Preference Fulfillment Options. For example, if Max is set to 80%, and
the preference fulfillment ratio is set to 100 (maximum preference fulfillment), all
agents will top out at 80%. If Max is set to 80% and Min is set to 10%, and the
preference fulfillment ratio is set to -30 (favoring optimization), then agents who
would be at 80% are dropped to 50%; agents at 40% are dropped to 10%; and all agents
with prioritizations lower than 40% also drop to 10%.

Optimize Profiles

The grid displays all profiles for the selected site. These are the profiles that are based on configured
profiles, not profiles that are based on agents. The columns in this grid are:

Profile Profile names.

Min

The minimum number of profiles that WFM can use
when building the schedule. Range: Empty
(default) or any number from 0 to 9999. This value
is editable, and must be less than the value of
Max.

Max

The maximum number of profiles that WFM can use
when building the schedule. Range: Empty
(default) or any number from 1 to 9999. This value
is editable, and must be greater than the value of
Min.

Existing The number of actual profiles already present in
the selected schedule scenario.

Growth Ratio
The current growth ratio value that WFM can use
for a particular profile when building the schedule.
Range: Empty (default) or any number from 1 to
9999. This value is editable.

To archive specific goals for profiles optimization, the following valid parameters must also be
considered:

1. Profiles are excluded from optimization when none of the following are specified: minimum profiles,
maximum profiles, or growth ratio. Profiles must be empty.

2. Profiles with a fixed number of agents must have the minimum profiles = maximum profiles, with both
values greater than 0. They do not require optimization, growth ratio is not applicable, and growth ratio
fields must be empty.

3. Profiles participate in optimization when both minimum and maximum values are specified by following
these rules: minimum profiles must be > or = 0, maximum profiles must be > 0, and minimum profiles
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must be < maximum profiles.
a. Growth ratio is specified—All profiles that participate in profile optimization must have a specified

growth ratio > 0 (0 is not a valid value for growth ratio).

b. Growth ratio not specified—Must be empty for all profiles.

Important
• You cannot have profiles with growth ratio and without growth ratio in the same

schedule. Growth ratio must be specified for all profiles being optimized (see 3a) or
none (see 3b). The only exception is in line 1 (above), where profiles are excluded from
optimization completely.

• If minimum profiles = 0, it does not mean that a value is not specified. 0 is a valid value
for minimum profiles.

Controls

These controls appear at the bottom of the Optimize Profiles pane:

Total Growth Ratio Total of all rows from the grid column Growth
Ratio (%). Not editable.

Show configured profiles check box
Check to limit filter the grid to show only profiles
that have Min and Max parameters specified.
Default: cleared

Show existing profiles check box

Check to limit filter the grid to show only profiles
that are already present in the selected schedule
scenario. Grid column Existing cannot contain 0
(zero).
Default: cleared

Understaff threshold (%) field

Enter the understaff threshold that WFM must use
when building the schedule.
Range: 0 (no understaffing) to 100 (total understaffing).

Default: 20.

Assign Profiles to Teams

• Select Use Backfilling of Existing Teams to enable this parameter.

Schedules Schedule Build Wizard

Workforce Management Web for Supervisors Help 704



• Enter a number in the Team Size field.

The schedule scenario that you are building contains profiles and not actual agents in the selected
site. You can assign profiles to be used to backfill teams that require it.

The grid displays all non-profile teams in the selected scenario. For each team, you can select the
profile should be used to backfill that team. The grid has these columns:

Team The team name.

Profile

A drop-down list of possible profile choices:

• None (default)
• A list of profiles that corresponds the value of

Max on the Optimize Profiles page.

Click Finish to apply your choices and begin the build.
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Scenario Building Schedule Dialog
The Building Schedule dialog appears after you click Finish in the Schedule Scenario Build Wizard.
This dialog displays the schedule building progress and basic information about the built schedule
scenario.

The Schedule Information section contains information about the schedule, such as the sites that
are included in this build, the number of days in the schedule scenario, the number of agents, and
the schedule start date.

The Build Progress section contains status information, such as the start time,
the elapsed time, and the Current Status, indicating how the build is
proceeding. After the schedule is built, the Current Status changes to Done
and you can review any messages that were generated during the schedule
building process. The number of messages is displayed in the bottom section of
the dialog. Other information in this section includes the number of iterations of
the schedule, the minimum, maximum, and probable Agent Count Range used
in this schedule build.
Clicking one of the three buttons in the Building Schedule dialog enables you to take the following
actions:

• Review Messages—Opens the Review Messages dialog. Enabled only if schedule building caused
messages to be generated.

• Stop and Save—Enabled only if Optimize Profiles is selected after the application builds the first
valid schedule (see Schedule Build Parameters). The application sometimes continues to build
additional schedules to create an optimal schedule. To speed up the schedule building process, you can
interrupt this process and save the latest results. However, this can result in schedules that are less
optimal.

• Close—Closes the Building Schedule dialog.
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Intra-Day Schedule Rebuild Wizard
Use this wizard to rebuild an Intra-Day schedule for multiple days (selected dates or a date range) for
a site, team, or an agent. While in a Schedule Scenario you can rebuild from any of the following
views: Intra-Day, Weekly, Agent Extended, or Profiles/Bidding view.

While in a Master Schedule view, you can rebuild from any of the following views: Intra-Day, Weekly,
or Agent Extended.

The rebuild process can include any activities and agents defined for this site/day in the selected
scenario or Master Schedule.

Reasons for Using This Wizard

The goal of the WFM scheduling algorithm is to minimize the over and under-staffing of agents,
against the forecasted staffing requirements. This is the outcome when a schedule is generated.
However, several circumstances might cause the schedule to be suboptimal by the time a particular
schedule day arrives. For example:

1. You might have reforecasted volumes and staffing for the day.
2. Agents might have called in sick or were given time off.
3. Existing agent schedules might have been manually adjusted.
4. Additional agents might have been added into the schedule.
5. Meetings or other types of exceptions might have been added to the schedule.

Because of this, you may wish to reoptimize the schedule day. It does not make sense to reoptimize
days or hours that have already passed. You probably do not want to reoptimize the current hour,
since any changes to meals, breaks, and/or work activities would be difficult to communicate to the
affected agents. The Intra-day Rebuild wizard allows you to reoptimize specific types of schedule
items for selected agents, based on a particular configured start time, which would normally be later
than the current time when you invoke the reoptimization.

However, it is important to understand several facts about Intra-Day schedule Rebuild function and
be aware of situations such as when a schedule might not be reoptimized or will be impacted by set
of limitations.

In a regular schedule build or rebuild, the existing schedule is simply replaced with a new schedule
generated. But, a rebuild Intra-Day schedule function works with schedules/shifts that were
scheduled to agents by any previous action that tried to modify selected wizard parameters, but
couldn't substitute a currently scheduled item with another one. Therefore, the rebuild Intra-Day
schedule functionality has a set of limitations that we should consider while using it. For example, the
following cannot change by re-optimization:

• Day-Off cannot become Workday
• Workday cannot become Day-Off
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• The scheduled shift cannot be changed to a different shift. The start/end time of the same shift can be
re-scheduled if the corresponding option was selected. But, the shift cannot be moved if the shift’s
configuration has a non-flexible window or scheduled activities' open hours prevent different hours.

• Schedule of the day cannot become invalid (paid time, shift start/end). In such cases, the original
schedule remains.

• If a scheduled shift is no longer under the current agent’s contract, such schedule cannot be Intra-Day
re-scheduled.

• If a scheduled shift contains a meal or a break that is no longer assigned to that shift in the current
configuration or does not contain a meal that is in the current configuration, it cannot be Intra-Day re-
scheduled.

• If the scheduled break/meal duration is different from the current break configuration or the break/
meal’s paid/unpaid flag is different, the shift cannot be re-scheduled.

• If the agent does not have any schedule for the rescheduled date, then it will stay with no schedule.
• Nothing can be changed before the re-optimization start time.

To use the Intra-Day Schedule Rebuild Wizard:

1. Select a Schedule Scenario or Master Schedule view (Intra-Day, Weekly, or Agent Extended).
2. Click the Rebuild intra-day schedule button on the Actions toolbar.
3. Complete each screen as it appears, and then click Next, or click Finish if it is the final screen:

• Select Site
• Select Options
• Shared Transport Constraints
• Team Synchronicity
• Select Agents
• Select Activities

Tip
• The Select Activities screen may not appear, depending on your selections at the

Select Options screen.
• You can always click Cancel to discard your selections and close the wizard without

making any changes.
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Site and Build Options
Use the Intra-Day Schedule Rebuild Wizard's Select Sites screen to select a site and schedule
rebuild options.

This screen displays a table, with a separate row for each available site. Within each row are columns
that contain build options.

• Choose all items in any column by selecting the check box at the top of the column. Clear the check box
to reject all items.

• Choose any individual item in any row by selecting the check box in that row. Clear the check box to
reject that item.

Changes to the Intra-day Schedule Rebuild Wizard

The Intra-day Schedule Rebuild Wizard also has the new Use Shared Transport Constraints
option. This option has the same purpose and similar functionality as the Shared Transport
Constraints option in the Schedule Build Wizard.

The columns contain the following build options.

Site
Each row contains a site that is in the currently selected schedule scenario. You must select at least
one site.

If you do not see a site that you want to include, cancel and create a new schedule scenario that
contains that site, and then use it as the basis for your schedule build.

Force Single Skill
If you select this option and an agent has multiple skills, the agent can be scheduled for only one
activity on each workday.

If you clear this option, the agent can be scheduled for multiple activities on the same day.

Use Required
If you select this option, the schedule is built by using the Required Staffing forecast, and not the
Calculated Staffing forecast.

Disable monthly constraints for the first month
Select this check box when the first month is not complete (because you are scheduling from the
middle of the month) and there is no historical data for the beginning of the month. In this situation,
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schedule building cannot correctly accommodate monthly constraints, such as minimum or maximum
work hours per month.

Select this check box to relax those constraints for this month.

Shuffle Agents
If you select this option, the agent pool is randomized before scheduling. (Randomizing ensures that
the schedule's results are independent of the sequence in which agents are loaded into the
scheduling algorithm.)

Use Team Constraints
If you select this option, the schedule start times are synchronized for agents in the same team,
within the configured threshold.

If you select this option, the Team Synchronicity page will appear later in wizard, and there you can
specify how daily schedules for agents in the same team should be synchronized.

Use Shared Transport Constraints
Select this option to enable shared transport group constraints when the schedule is rebuilt. The
participants in a shared transport group can work in shifts that begin and end at different times;
however, they should not deviate greatly, or the shared transport group will become impractical. You
will specify the length of the deviation.

If you select this option, the Shared Transport Constraints wizard page will appear instead of the
Team Synchronicity wizard page. There, you will specify the maximum allowable deviation in the
schedule of each participant in the same shared transport group.

Tip
Shared Transport is known by many different names worldwide—bus, carpool, ride
share, lift share, and paratransit, for example. See Wikipedia for details.

Exclude Granted Agents from Used Constraints
If you select this option, agents who have been granted full-day exceptions or working hours are not
considered when team synchronization is enforced.

Important
Always select this option when you are using team constraints.

Click Next to continue or Cancel to discard your selections and close the wizard.
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Use Secondary Activities

Check this option to assign a secondary activity to agents directly. Activity assignment is based on
skills and skill levels, therefore a secondary activity is one in which at least one of the agent's skills is
marked as secondary. Leave this option unchecked if you want only primary activities considered in
the Site schedule scenario.

Schedules Intra-Day Schedule Rebuild Wizard

Workforce Management Web for Supervisors Help 711



Select Options
Use the Intra-Day Schedule Rebuild Wizard's Select Options screen to select date(s), time, and
rescheduling options.

1. In the calendars displayed for date(s) selection, enter or select the day(s) to be rebuilt in the schedule.
The calendars allow you to select multiple date(s) or a date range. However, the selected date(s) or
date range cannot be outside the scenario's date range and out of 2 weeks date range. The default
value shown is the date selected in the view from which the Wizard was called.

2. In the Start from selector, enter or select the time in the scheduled day(s) to start rebuilding.
The default value shown is the computer's current time rounded to the nearest timestep start plus one
hour. Before selecting the time from which you want to rebuild, consider that you will need to notify the
affected agents of these changes.

3. In the Time Zone selector, select the applicable time zone. The default is Local.
4. Select one item from the Rescheduling Options list of self-explanatory radio-button choices. Selecting

the final option (Reschedule breaks, meals, activities/activity sets/task sequences, shift start
and/or end times may change) will enable check boxes that control whether shift start time, shift
end time, and paid duration are fixed (not changeable).

Important
The final check box Paid duration is fixed in this grouping applies to breaks and meals (shift items), which
are defined as paid or non-paid. If paid duration is fixed, when WFM rebuilds, it cannot give an agent a shift
with a different paid duration than the agent currently has assigned. Otherwise, if the agent has a flexible
Contract, it could be possible for the agent to get assigned a shorter or longer shift than currently assigned.
The agent could potentially be assigned different meals and breaks as well.

5. Keeping the Auto-commit changes check box default value (selected) instructs the schedule builder
to commit all schedule changes. Otherwise, they will be put into the schedule in a pending mode.

6. Select the Additionally filter agents by contract check box if you want to select agents with
contracts for the schedule rebuild. When selected, the wizard displays the contracts tree. Select the
check box for each contract you want to filter and click Next. The agents are then filtered according to
the contracts you selected. Select the check box for each agent to include in the schedule rebuild.

7. Click Next to continue, or Cancel to discard your selections and close the wizard.

For information about task sequences (which are included in the fourth and fifth rescheduling
options), see Shift Task Sequences and the Workforce Management Administrator's Guide.
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Shared Transport Constraints

Tip
Shared Transport is known by many different names worldwide—bus, carpool, ride
share, lift share, and paratransit, for example. See Wikipedia for details.

The members of a shared transport group can work in shifts that begin and end at different times, but
they should not deviate greatly or the shared transport group will become impractical. You are
specifying the maximum allowable deviation in the schedule of each participant in the same shared
transport group.

If you enable Shared Transport Constraints, this dialog box appears in place of the Team
Synchronicity page (team restraints and shared transport group restraints are mutually exclusive).
Type, or use the spinner controls, to specify the maximum allowable deviation between the start
times and end times of shifts for the shared transport group members. You can specify any value
between 1 minute and 23 hours, 59 minutes; most practical values will be less than 30 minutes.
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Team Synchronicity
This screen appears only if you selected at least one site under the category Use Team Constraints
on the first screen. Each site that you checked on that screen (Select Sites) appears in the leftmost
column of a table. The others columns display certain settings for each site.

Specify the following parameters:

Synchronize Days Off Select this check box to specify that days off should
be synchronized for all teams.

Synchronize By

Each cell is a drop-down menu that you can use to
specify the synchronization combinations to apply
when you are building the schedule:

• No additional synchronization
• Shift Start Time—If this check box is checked,

use the duration control Maximum Start Time
Difference to specify the maximum difference
between shift start times inside the team. Use
the format HH:MM; where 02:59 is two hours
and fifty-nine minutes.

• Paid Duration
• Shift Start Time and Paid Duration
• Shift Start Time, Paid Duration, and Meals
• Shift Start Time, Paid Duration, Meals and

Breaks
• Paid Duration and Meals
• Paid Duration, Meals and Breaks

Maximum Start Time Difference
Each cell is a spinner box where you can specify
this value in the hh:mm format. The range is from 0
(zero) to 23:59.

Apply constraints only to the same contracts
inside team

Select this check box to specify that while
synchronizing teams, WFM must take configured
contract information into account while creating
the schedule. By default, this check box is cleared.

Tip
This check box is enabled only when one of the
options Paid Duration, Paid Duration and Meals or
Paid Duration, Meals and Breaks is selected in the
Synchronize By column. The check box is disabled,
otherwise, because it does not apply when shifts are
synchronized.

Click Next to continue, or Cancel to discard your selections and close the wizard.
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Select Agents
Use the Intra-Day Schedule Rebuild Wizard's Select Agents screen to select one or more teams or
agents within a team.

1. Under Select Agents, you can expand business units and sites to display agents. The tree shows only
those agents who have the skills that are required for the scheduled activities.

You can select individual agents from multiple teams, or you can select whole teams or the whole
site.

A highlighted background appears around the names of Agents whose schedule was edited in the
selected date range after the last build or rebuild.

2. Select Do not rebuild modified agent schedules to exclude agents whose schedules have already
been changed from the last time the schedule was built, re-built, or published.

3. Click Next (or Finish if that is offered instead).
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Select Activities
The Select Activities screen appears if, on the Rescheduling Options screen, you select one of the
following options:

• Reschedule activities/activity sets/task sequences only
• Reschedule breaks, meals, activities/activity sets/task sequences, without affecting shift

start/end times
• Reschedule breaks, meals, activities/activity sets/task sequences, shift start and/or end

times may change

To complete this screen:

1. Expand the object tree as needed.
2. Select one or more activities or multi-site activities.
3. Select Retain scheduled activities to have the build add any previously selected activities while

keeping the activities that are currently in the Schedule.
4. Click Finish, or Cancel to discard your selections and close the wizard.
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Schedule Rebuild Wizard
Use the Schedule Rebuild Wizard to change a built schedule's included agents, teams, and/or dates:

1. Click Rebuild Schedule in the Schedule Scenario view's Actions toolbar or select Rebuild
Schedule from the Actions menu.
The first of the Schedule Rebuild Wizard's two screens, Choose Start/End Date, opens.

2. Enter the dates for which you want to rebuild the schedule.
Neither date can be outside the scenario's original date range.

3. Click Next.
4. From the Select Agents window's list, select the agents you want to include in the modified schedule.

You can expand business units to display their sites and you can expand sites to display their teams
and agents. You can select any number of agents and/or teams within a single business unit.

Tip
A highlighted background color indicates agents whose schedules were edited (for the selected date range)
after the last build or rebuild.

5. If appropriate, select Do not rebuild modified agent schedules.
Selecting this check box prevents the schedule builder from making further schedule changes for
agents whose schedules were edited after the last build/rebuild.

6. Click Finish to rebuild the schedule with the new parameters.
Or click Previous to review or change your Start/End Date selections, or Cancel to close the wizard
without modifying the schedule.

Viewing Warnings after Schedule Rebuild

After rebuilding Intra-Day, Weekly, and Agent Extended Master Schedules is finished, you can view
and save any warnings messages that were generated during the rebuild. WFM displays the number
of warnings that occurred during Master Schedule rebuilds and saves them for further review.
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Publishing/Extracting Schedules
Use the Publish Schedule Wizard to transfer unpublished schedule scenarios (or republish already-
published schedule scenarios) to the Workforce Management database's Master Schedule, or to
extract Master Schedule information to schedule scenarios.

The following sections cover:

• Publishing to the WFM Database.
• Extracting from the WFM Database.

Why Publish Schedules?

• Publishing represents the act of making a schedule scenario official. Only the Master Schedule is
regarded as the official schedule.

• Until a schedule is published, you cannot calculate certain performance data or real-time agent
adherence data.

• Until a schedule is published, agents cannot view it in the WFM Web for Agents client interface.

Publishing to the Master Schedule

Before launching the Publish Schedule Wizard:

• Assign real agents to your schedule scenario's profile slots. (Only real agents' schedules are published
to the Master Schedule.)

• Commit all pending changes that you want to include in the Master Schedule. Uncommitted pending
changes are disregarded when the scenario is published.

To publish a schedule:

1. In the Schedule Scenarios view's Scenarios Table, select the scenario that you want to publish. Then,
click Publish on the Actions toolbar.
The Publish Schedule Wizard's Select Action screen appears.

2. Select Publish to Master Schedule, and click Next.
The Publish to Master Schedule screen appears.

3. In the Publish Dates section, select the Start Date and End Date.
By default, the selected scenario's start and end dates appear in these fields.

4. If you want to repeat the schedule in the future, select Publish to Date Range, and then select the
Start Date and End Date that you want. The Publish to Date Range feature enables you to publish
the same schedule scenario for more than one schedule period. You can quickly publish schedules to fill
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an extended time period. However, be aware that:
• If schedule length and the period selected to be published to the new date range do not match

exactly, the Wizard copies as many days of the schedule as will fit into the new date-range period.
For example, if the schedule is three weeks and the Publish to Date Range period is two weeks,
the wizard copies only the first two weeks of the schedule. If the schedule is two weeks and the
Publish to Date Range period is five weeks, the wizard copies the whole schedule twice in
succession, and then copies the first week again to provide the fifth week of the new date range.

• All data within the schedule scenario is published to the new date range exactly. All schedule items,
such as exceptions, breaks, meals, and time off, are also transferred.

5. From the Agents list, select which agents you want to publish to the target schedule.
You can expand business units to display their sites and you can expand sites to display their agents.
You can select any number of real (not profile) agents.

6. Optional: Select the Insert granted exception, time off, and day off Calendar items check box to
overlay these items in the schedule when the scenario is published to the Master Schedule. Clear the
check box to ignore these items.
This option is useful when you want to use "fixed" agent schedules. You would create a 1-to-6 week
schedule for one or more agents, and then use this feature to copy the schedule out into the future.
When copying the schedule, WFM will account for granted Calendar items such as time off, exceptions,
and days off. WFM may not be able to overlay all of the granted Calendar items because they may
conflict with the items already in the schedule. In this case, you will receive a warning about the
Calendar items which could not be scheduled.

7. Optional: Select the Publish forecast scenario too check box to publish the associated forecast
scenario that you selected in the Schedule Scenarios view, for the selected dates for all activities in the
scenario. If more control is needed over forecast-scenario publishing, it should be done from the
forecast-scenario view instead. The default value is cleared (not selected), and this check box is absent
if the schedule scenario is not associated with any forecast scenario.

8. Click Finish.

Baseline Master Schedule
After you publish a schedule scenario to the Master Schedule, WFM retains a snapshot of the Master
Schedule at that point in time. This is called the baseline Master Schedule. Then, after you make
changes to the Master Schedule, such as adding exceptions and granting vacations, you can compare
the schedule coverage shown in the current Master Schedule against the schedule coverage stored in
the baseline Master. The Schedule Summary Report and the Schedule Summary view present the
comparison.

The Master Schedule baseline is created/updated each time something is published to the Master
Schedule for a particular date range. Example: Assume on May 25, you publish the June schedule
scenario to the Master Schedule. Assume on May 28, you republish the same June schedule scenario
to the Master Schedule. On the Schedule Summary Report and in the Schedule Summary view, WFM
uses the May 28 published schedule as the baseline against which the current schedule is compared.
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Extracting a Schedule from the Workforce Management
Database

To transfer data from the Master Schedule into a schedule scenario:

1. In the Schedule Scenarios view's Scenarios Table, select the scenario into which you want to extract the
data. Then, click Publish on the Actions toolbar.
The Publish Schedule Wizard's Select Action screen appears.

2. Select Extract from Master Schedule, and then click Next.
The Extract from Master Schedule screen appears.

3. In the Dates section, select the Start Date and End Date.
You must select dates within the target scenario's date range.

4. From the Agents list, select the agents whose schedules you want to extract to the target scenario.
You can expand business units to display their sites and you can expand sites to display
their agents. You can select any number of real (not profile) agents.

5. Click Finish.

Tip
Pending changes to the Master Schedule are not extracted to the schedule scenario.
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Schedule Validation
Use the Review Messages window to manage warning and error messages that were generated the
last time the schedule was built, validated, or rebuilt.

See a complete list of Error and Warning messages in the Workforce Management Adminstrator's
Guide.

Using the Review Messages Window

The Review Messages window contains the following controls:

Reviewed Select the check boxes in this column to indicate
messages that you have reviewed.

Site Displays the site name.
Message Shows the text of each generated message.
Save button Saves your reviewed selections.
Close button Discards all changes and closes the window.
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Trading
Use the Trading module to review, and accept or decline, agents’ proposed schedule trades. The
features of this module are:

• A List of Trades.
• Ability to add Trading Comments.
• A Schedule Details window.

Important
If you do not see Trading information, or cannot configure objects or change settings
in Web for Supervisors, you might not have the appropriate role privileges. See
Trading Role Privileges in this Help. Also, you must configure WFM Web to initiate
trading for agents. See the Workforce Management Configuration Options Reference.

Using the List of Trades View

The List of Trades view displays a week's schedule trading information for a single site at a time.
Controls enable you to view details about each trade, to accept or decline the trade, and to enter
comments about your decision.

Trade proposals appear in the List of Trades view if they meet the following criteria:

• The trade has not been automatically approved. Automatic approval is based on WFM's built-in trade
rules or on exception types' own configured trade rules.

• The trade has not been automatically cancelled. WFM automatically cancels a proposed trade if either
agent's schedule has been modified in some way in the Master Schedule since the trade request was
made. For example, a supervisor has explicitly modified the agent schedule; or another trade, with
overlapping schedule data, has been approved and executed.

• The trade has not been automatically declined. WFM automatically declines a proposed trade if either
agent's schedule overlaps with overnight schedule from the previous day for a recipient agent.

• The trade has not yet been explicitly approved or declined by any supervisor. (Once acted upon, trades
no longer appear.)

If a trade proposal has not been approved or declined by its effective date, the proposal expires and
the trade does not occur.

Trading Schedule Validation
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How Trading Works
The topics on this page describe how a schedule trade proceeds to approval or rejection.

Tip
If you do not see Trading information in Web for Supervisors, you might not have the
appropriate role privileges. See Trading Role Privileges in this Help. Also, you must
configure WFM Web to initiate trading for agents. See the Workforce Management
Configuration Options Reference.

Trading Summarized

A trade can include up to six full weeks of schedule days. Every schedule trade requires:

• One agent's proposal for a trade. The proposal specifies which schedule days this agent wants to trade.
• Another agent's response to that proposal. The response indicates this agent's willingness to accept the

proposed trade.
• An approval, either automatically by WFM or explicitly by a supervisor.

For some trades, the proposing agent must explicitly accept the response before submitting the trade
for approval. This is always true for community proposals, which are offered to all agents within a
team, site, or business unit (if multi-site trading is permitted).

If a trade is approved, WFM executes it and both agents' schedules are changed to reflect it. After
execution, WFM removes the trade from the Trading > List of trades view and you will see it only
in the Schedule Trade report.

Not all trades are approved. For example:

• Under certain conditions (when one agent is not qualified for the other agent's scheduled activities),
WFM automatically declines a trade.

• If either agent's schedule is changed before a pending trade's approval, the trade is automatically
canceled.

• A supervisor may explicitly decline a trade.
• If a pending trade has not been approved before the first day involved in the trade, it expires.

In each of these cases, the trade does not occur.

Trading How Trading Works
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Requirements for a Successful Trade

For a trade to take place, all of the following steps must occur. (See the Workforce Management Web
for Agents Help for details about how agents perform the first three steps.)

• One agent creates a community or personal trade proposal.
• At least one agent responds to the community proposal, or the receiving agent accepts the personal

proposal.
• The proposing agent accepts a response to a community or personal proposal. (This step is required for

personal proposals only if the proposing agent specified manual approval.)
• The trade receives either WFM's automatic approval or a supervisor's explicit approval.

Tip
At any time before approval, a pending trade can fail in one of three ways: either
agent can cancel it; the trade can automatically be canceled if either agent's schedule
is changed; or the trade can expire.

How Trades are Tested for Automatic Approval

Once both agents have accepted a trade proposal, WFM tests it for automatic approval. These tests
evaluate the trade using the conditions listed in each of the following sections:

Exceptions' Trade Conditions
If either agent has a scheduled exception on any of the days to be traded, WFM tests the trade
against the trade rules configured for that exception type. For example, exceptions that count as
vacation time always have either the Delete, Keep with agent, or Do not trade rule.

Here is how WFM acts on each trade rule:

Exception Trade Rule: How WFM Responds:

Delete Allows the trade to proceed to the next test, but
deletes the exception from the schedule.

Do not trade Agent is not allowed to create trading proposal on
day with scheduled exception "Do not trade".

Keep with agent
Allows the trade to proceed to the next test, but
keeps the scheduled exception with the original
agent.

Keep with schedule Allows the trade to proceed to the next test, and
trades the exception along with the schedule.

Trading How Trading Works
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Auto-Decline Conditions
WFM automatically declines a trade if either agent's schedule overlaps with the overnight schedule
from the previous day for a recipient agent.

If multi-site trading is permitted, WFM automatically declines a trade if:

• A scheduled shift cannot be matched with a shift on another site
• A scheduled exception type is not available on another site
• A scheduled marked time is not available on another site
• A scheduled time-off item is not available on another site

Supervisor Approval Conditions
WFM places a trade "in review"—a status that requires a supervisor to approve the trade—if the trade
involves any of the following conditions:

• The traded schedules have different paid hours.
• Either agent is trading days off for working days.
• Either agent has a scheduled exception with the delete rule enabled.
• Either agent is trading a keep with agent exception for fixed-staff work.
• The trade violates an agent's availability (contract availability, granted availability preferences, or

rotating availability).
• The trade violates certain contract terms or site rules: minimum or maximum working hours per day or

per week; minimum or maximum days off per week; or minimum time off between consecutive working
days.

Auto-Approval Conditions
If a schedule trade does not match any of the Auto-Decline or Supervisor Approval conditions, WFM
automatically approves it and trades the schedules.

Auto-Cancel Conditions
WFM automatically cancels a trade proposal, a response, or a pending trade in review if either
agent's schedule is modified in the Master Schedule. Examples of auto-cancel conditions are:

• A supervisor explicitly modifies either agent's schedule.
• Another trade is approved and executed for either agent that involves a schedule period that overlaps

with the schedule period for this trade.

Trading How Trading Works
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Expiration Conditions
If a trade has not received approval by the day before its first included day, it expires, and can no
longer be approved by any agent or supervisor.

Trading How Trading Works
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List of Trades View
Use the List of Trades view to review and manage agents' pending schedule trades. The view displays
a table of agents' proposed schedule trades, standard date-selection controls, buttons to accept or
decline each pending trade, and a drop-down list that modifies the table's contents.

Multi-Site Trading
If multi-site trading is permitted in your environment, it enables agents to trade across different sites
within the same business unit. This means you might see the same trade under two different sites, if
the trade participants are located in different sites.

Depending on which sites you have access rights to, you can either fully approve the trade or
partially approve it (if you have access rights to only one of the two sites in the trade). When you
partially approve a trade, you receive an appropriate warning message (that the trade needs further
approval) and the trade remains in Pending status until a supervisor with the required site access
rights completes the trade approval process.

Displaying the List of Trades

To display the List of Trades view:

1. In the Modules tree, click Trading > List of Trades.
The List of Trades view appears.

2. In the Objects tree, select a site, teams, and/or agents.
You can expand business units to display their sites and you can expand sites to display
their teams and agents. You can select any number of agents and/or teams within a single
site.
Trades can occur only between agents in the same site. If you select a new site or its teams/
agents, this clears any previous selection that you made within a different site.

3. Click Get data to populate the table for the selected agents.

Using the Table

The List of Trades table shows all of the proposed schedule trades that meet the following criteria:

• At least one trade participant is among the agents that you selected in the Objects tree.
• The trade can still be accepted or declined. (Once accepted or declined, trades no longer appear in the

table.)
• The trade is within the selected week. (To see other weeks, use the date-selection controls at the upper

right.)

Trading List of Trades View
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Each proposed trade appears on two rows. (If a scroll bar appears to the right, you can use it to
reveal more trades.) The table includes the following columns:

Dates Start and end dates for the proposed trade.
Agent Name Names of both agents involved in the trade.

[Weekdays]

Agent schedule information for the specific day in
the trade. The cell contents correspond to your
selection from the Show data for drop-down list.
If the agent is not scheduled for a shift on this day, the cell
contains: Day Off, Vacation, Working Hours (for scheduled
working hours without a shift), or an exception name (for
scheduled full-day exceptions). A blank cell indicates that this
day is not included in the proposed schedule trade.

Paid Hours Total paid hours in the trade proposal.

Details Button to display schedule details for both agents
involved in the trade.

Accepting or Declining Trades

To accept or decline proposed trades:

1. Select one or more trades in the table to select them.
2. Select one of the following options from the view's right side (or on the Actions menu):

• Accept—Opens the Comments window for you to add an (optional) comment and approve the
selected trade(s)

• Decline—Opens the Comments window for you to add a (required) comment and reject the
selected trade(s).

Show Data for
From this drop-down list, you can select what you want to display inside each day's table cell:

Total Paid Hours Total paid hours for each day.

Working Start/End Time Start and end times of agents' work. (Default
display option.)

Shift or Schedule State Names Names of agents' assigned shifts for each day.

Trading List of Trades View
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Trading Comments Dialog
Use the Trading Comments dialog box to confirm your acceptance or rejection of a proposed
schedule trade, and to add a comment about your decision:

1. Type your comment into the Comments text box.
A comment is required when you decline a trade, but it is optional when you accept a trade.

2. Do one of the following:
• Click OK to attach your comment and confirm the trade's acceptance or rejection.
• Click Cancel to discard your comment and take no action on the proposed trade.

Clicking either button closes the window and returns you to the List of Trades view.

Trading Trading Comments Dialog
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Schedule Details Dialog
Use the Schedule Details dialog box to view schedule information for both of the agents in a
proposed schedule trade.

Each column displays one agent's information, in the following rows:

Agent The agent's name.
Date The date for which details are displayed.

Paid Hrs The agent's total paid hours for the scheduled
states/activities.

Schedule Details The states or activities for which the agent is
scheduled.

Sch. Attendance: Start Time The agent's scheduled start time for these states/
activities.

Sch. Attendance: End Time The agent's scheduled end time for these states/
activities.

Trading Schedule Details Dialog
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Performance
Use the Performance module to display performance statistics for business units, sites, and activities.
This module includes a Monitor view for the most recently completed timestep, an Intra-day table
view, and an Alerts view.

Also, use the What-If Window to analyze how changes to some statistics affect other factors.

All views display the following statistics, which are calculated by the WFM servers:

Interaction Volume Forecast and Actual number of interactions.

AHT (Average handling Time) Forecasted, Actual, Difference, and Difference % in
the average handling time, in seconds.

Abandoned Interactions (%) Scheduled, Calculated, Required, and Actual
percentage of abandoned calls.

Service Level (%) Scheduled, Calculated, Required, and Actual
service level percentage.

Deferred Service Level (%) Scheduled, Calculated, Required, and Actual
deferred service level percentage.

Actual Queue The actual number of interactions in the backlog
queue at the end of the period.

ASA (Average Speed of Answer) Scheduled, Calculated, Required, and Actual
average speed of answer, in seconds.

Coverage

Number of agents scheduled for each activity. If an
agent works only part of a time interval, only the
portion during which the agent works (rounded to
the nearest minute) is counted toward scheduled
staffing. As a result, these values may be fractions
or decimals. This column is now under Staffing in
the grid.

Staffing

Number of agents Calculated and Required for each
activity, and the difference between Coverage and
Calculated and Coverage and Required staffing.
The Required and Calculated values are taken from
the forecast and are always whole numbers, but
the Diff. Calc. and Diff. Req. values can be
fractional.

Variance

Scheduled and Required variance. Optimal staffing
value for the timestep minus the scheduled
number of agents (Sch.), and the optimal staffing
value for the timestep minus the required number
of agents (Req.).

Tip
Optimal staffing is a calculation based on actual
interaction volume, actual AHT, and the service
objectives specified in the forecast. This value is not
displayed on its own, but is used in calculating
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Variance values.

Headcount
Scheduled and Actual headcount. Number of
scheduled (Sch.) and actually working (Act.)
agents. For more information, see description of
Headcount in the Master Schedule Summary view.

These statistics are presented for a 24-hour range, with 12 hours before, and 12 hours after, the
current timestep. The displayed data is automatically refreshed at least once per minute.

For timesteps in the future, the displayed "actual" values are those that WFM Web anticipates by
comparing past data with the planned forecast. These anticipated values do not affect the schedule,
and they are not saved.

The anticipated values can help you make real-time changes to your site setup. For example,
unneeded agents can be sent home if you are overstaffed, or extra agents can be called in if you are
understaffed. You cannot change the schedule from the Performance views; use the Master Schedule
Intra-Day view to do so.

Tip
For timesteps that have an interaction volume of zero, you can display service-level
data as either 0% or 100%. This is determined in Configuration Server by the WFM
Server application’s Options tab > PerformanceService section >
NoCallsServiceLevel key, whose value can be set to either 0 or 100. The default
value is 0.

Performance Schedule Details Dialog
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Performance Monitor View
Use the Monitor view to view a horizontal bar graph for each performance statistic, based on the
most recent timestep. See descriptions of the buttons shown in the toolbar image below.

Displaying the Monitor View

1. In the Modules tree, select Performance > Monitor.
The Monitor view appears. If you switched to this view from another Performance view, it
retains your earlier objects selection and shows graphs for the most recent timestep.

2. Select the enterprise, a business unit, site, or activity in the Objects tree.
In the tree, you can expand business units to show their sites and expand sites to show
their activities. If you make a new selection, the graphs refresh to match it.

Using the Monitor View

The Monitor view shows as many graphs as can fit on the screen at once. Use the scroll bar to the
right to reveal graphs for additional statistics.

Each graph shows actual data, and either forecasted data or scheduled and required data. The
displayed data is automatically refreshed at the conclusion of each 15-minute timestep, and
represents the values from the most recent timestep.

The Legend (at the bottom) shows which color bar indicates which data category. Next to each data
bar, a label lists the numerical value shown on the graph, with the following prefixes:

• A for actual data
• F for forecasted
• S for scheduled
• R for required

Tip
Scheduled metrics such as scheduled Average Speed of Answer (sec), Scheduled
Service Level Percentage, and so on, describe what objectives you should meet based
on the number of agents scheduled.

Performance Performance Monitor View
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If alerts were configured for a statistic and that statistic exceeds the alert's configured deviation
level, a red ALERT comment appears near the graph.

Required Data Options

You can use the following buttons on the toolbar (these commands also appear in the Actions
menu):

Icon Name Description

Show Required

Turns on and off the display of
"Required" data in some
statistics' graphs. (This option is
a toggle: A darker button color,
or a check mark beside the
Actions menu option, indicates
that it is selected. Click the same
option again to deselect it.)

Use Multi-site Activities

This button becomes enabled
when you select a multi-site
activity or business unit in the
Objects tree. Clicking this button
displays data for the selected
multi-site activity.
If you set this button to On, WFM retains
your last selection—in the current view
and for all other views that contain multi-
site activities—preventing you from
having to click it every time you want to
display data for the selected multi-site
activity.

Performance Performance Monitor View
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Performance Intra-Day View
Use the Intra-Day view to display performance statistics (both summarized and detailed) in a grid.
See the descriptions of buttons shown in the toolbar image below.

Displaying the Intra-Day View

1. In the Modules tree, select Performance > Intra-Day.
The Intra-Day view appears. If you switched to this view from another Performance view, it
retains your earlier Objects tree selection and shows the corresponding statistics.

2. Select the enterprise, a business unit, a multi-site activity, an activity group, a site, or an activity in the
Objects tree.
In the tree, you can expand business units to show their sites and activity groups and multi-
site activities, and expand sites to show their activities. If you made a new selection in the
Objects tree, the grid is updated to match it.

Setting the Time Zone, Granularity, and Date

Use the Time Zone, Granularity and Date controls (near the top) to customize the graph:

• Use the Time Zone drop-down list to choose the time zone to display in the graph and grid.
• Use the date-selection controls to choose the date to display in the graph and grid.
• Use the Granularity drop-down list to select the time interval for the graph's horizontal axis, and also

for timesteps in the table below the graph: 60 min (minutes), 30 min, or 15 min.

Reading and Configuring the Graph

By default, you see a graph for the Interaction Volume (IV) statistic.

• To switch the graph view to match a different statistic, select the statistic from the Show Data for:
drop-down list above the graph. The choices in the drop-down list reflect the columns displayed in the
grid below the graph.

• Select the Show Required check box to toggle on and off the display of required data in the graph.

The graph shows times on the horizontal axis, and values on the vertical axis. The Legend (below the

Performance Performance Intra-Day View
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graph) indicates which color is used for which data category.

Reading and Navigating the Grid

For each statistic, the grid displays actual values compared to forecasted, or scheduled and required,
values. The displayed data is automatically refreshed at the conclusion of each 15-minute timestep,
and represents the values from the most recent timestep. The grid's rows show timesteps, and its
columns show statistic categories. The current timestep is identified by a yellow background.

By default, the grid shows a rolling view, which displays 12 hours before, and 12 hours after, the
current timestep. You can choose instead to have the grid show the Whole Day view, which shows all
of the timesteps, from midnight to midnight, of the current day.

• To use the current-day view, select Show Whole Day from the Actions menu.

Tip
When WFM is unable to calculate a value for a particular timestep, or if no value has
yet been entered for it in forecast views, the cell is empty (blank).

Grid Rows
The grid contains the following rows, which are labeled in the Time Step column:

First row (--)
The first row displays summary (aggregate total or
average) values for each statistic, calculated from
the grid's first displayed timestep until the current
timestep.

Timestep rows (numbered)

The remaining rows show 15-, 30-, or 60-minute
timesteps. There are 24 hours' worth of data, which
may be shown as including 12 hours before, and 12
hours after, the current timestep (rolling view) or
from midnight to midnight of the current day
(Current Day view). The rolling view is the default
view.
Use the scroll bar to the right to reveal more timesteps. A yellow
bar indicates the current timestep.

Grid Columns
The grid's remaining columns show the following statistics and subcategories (these statistics are
present in all views, and are described in the Performance overview):

• Interaction Volume
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• AHT
• Abandoned Interactions
• Service Level
• Deferred Service Level
• Actual Queue
• ASA
• Staffing
• Variance
• Headcount

Anticipated Values
For Interaction Volume and AHT, future "actual" timestep values are calculated based on the ratio of
previous actual/forecast values from moment to moment. For the other columns, values for future
timesteps are forecasted based on anticipated IV and AHT. Actual values replace these anticipated
values as the displayed data is refreshed.

Display, Copy/Paste, and Other Options

The Intra-Day view provides the following options:

• You can resize the grid columns to better view their contents.
• You can copy data from the grid to the clipboard and then paste it into another application.

1. Click, or use the Tab or arrow keys, to move the selection box to one or more table cells.
2. Select Edit > copy, or use your operating system's "copy" keyboard shortcut (such as Ctrl+C or

Command+C).

Toolbar and Actions Menu
You can use the following buttons on the toolbar (these commands also appear in the Actions
menu):

Icon Name Description

What If
Opens the What If window for
calculating "what if" scenarios
based on the selected timestep's
data.

Use Multi-site Activities

By default, this button is enabled
when you select a multi-site
activity or business unit in the
Objects tree. If you set this
button to On, WFM retains your
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Icon Name Description
last selection—in the current
view and for all other views that
contain multi-site
activities—preventing you from
having to click it every time you
want to display data for the
selected multi-site activity.

Show Whole Day

Click this button to toggle
between a rolling view (12 hours
before and 12 hours after the
current timestep) to a current-
day view (from midnight to
midnight of the current day).

Total Forecasted Values for
Whole Day

When selected, calculates totals
across the grid's top row using
actual performance data
(displayed above the horizontal
yellow line that indicates the
current time slot) and forecast
data (displayed below the line).
When not selected, calculates totals
across the grid's top row using actual
performance data only.

Tip
This option affects only how the
totals row is calculated, using the
currently displayed data.

Move to Current Day Click this button to display data
for today.

Options
Displays the Performance
Options dialog with a list of
statistics that can be displayed in
the grid.
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Performance Alerts View
Use the Performance Alerts view to configure visual alert notifications for unacceptable performance.

The Alerts function uses Master Forecast and schedule data as a baseline for acceptable performance
results.

If user-defined performance limits are violated (for example, if too many interactions are being
abandoned, or if service levels fall too low), an Alert warning in the Monitor view notifies site
managers that action may be necessary.

To configure alerts:

1. In the Modules tree, select Performance > Alerts.
The Alerts view appears. If you switched to this view from another Performance view, it retains your
earlier Objects tree selection. At right, the Deviation table is refreshed with any alert settings that
have already been configured for this selection.

2. To set an alert on a different business unit, site, or activity, select it in the Objects tree.
You can expand business units to show their activity groups and sites and expand sites to show their
activities. If you made a new selection, the Deviation table is updated to match it.

3. In the Deviation table, select the Alerts check box beside each statistic name for which you want an
alert. Clear the check box for statistics that should not have alerts.

4. Set the Minimum (%) and Maximum (%) allowable deviation for each statistic whose check box you
selected.
Set these limits by clicking and typing in the appropriate columns. These limits define the variance
beyond which an alert is displayed. For example, assume that you set 3.0 as the Minimum (%)
deviation level for Average Handling Time, and 5.0 (%) as the Maximum (%). In this case, an alert
appears when the AHT goes more than 3 percent under, or 5 percent over, the number set in the
forecast.

5. Click Apply. (Or, to discard your changes, click Cancel.)
6. If desired, configure alerts for other Business Units, activity groups, sites, or activities.

You can repeat Steps 2-5 for as many Objects tree selections as you like. If you make a new selection
without first clicking Apply, a dialog box prompts you to save your changes (Yes), discard them (No),
or keep working with the same selection (Cancel).

7. To exit the Alerts view, select a different view from the Objects tree.

Performance Performance Alerts View
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Performance Options Dialog Box
Selecting the Options button in the Performance Intra-Day view opens the Options dialog box,
which contains a directory-style tree of statistics that can be displayed in the grid. By default all are
selected. To clear or select any individual statistic, click its check box. There is a check box at the top
of the tree that selects or clears all statistics at once.

Click OK to accept your changes or Cancel to abandon them.

For a list of statistics and their descriptions, see Performance.

Performance Performance Options Dialog Box

Workforce Management Web for Supervisors Help 740



What-If Window
Use the What-If window to immediately analyze how changes in some statistics would affect other
factors.

To open the What-If window:

1. Select an activity in the Performance Intra-Day module.
2. Select a timestep in the data grid.
3. Click the What if button on the Actions toolbar.

Once the window is open, you can change certain values shown in the window to perform what-if
calculations.

Statistics presented in the What-If window are as follows (these statistics are present in all views,
and are fully described in the Performance overview):

• Interaction Volume
• AHT
• Abandoned Interactions
• Service Level
• Deferred Service Level
• Actual Queue
• ASA
• Coverage
• Required Staffing
• Variance
• Headcount

Interaction volume
Initial value is the forecasted interaction volume
taken from Master Forecast. Enter a value greater
than zero.

AHT (Average Handle Time) Initial value is the forecasted AHT taken from
Master Forecast. Enter a value greater than zero.

Abandoned Interactions (percentage)

Initial value is the scheduled abandoned calls
percentage. Enter a value greater than 0 and less
than 100. If you do not enter a value, the
abandoned calls percentage is not included in the
what-if calculation.

Service level (percentage)
Initial value is the scheduled service level
percentage. Enter a value greater than 0 and less
than 100. If you do not enter a value, service level

Performance What-If Window
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is not included in the what-if calculation.

ASA (Average Speed of Answer)
Initial value is the scheduled average speed of
answer. Enter a value greater than zero. If you do
not enter a value, ASA is not included in the what-if
calculation.

Coverage (formerly Scheduled Staffing) Initial value is the scheduled coverage. Enter a
value greater than zero.

Service time (sec) Taken from Master Forecast. Configured in Staffing
Build Wizard.

Average time to abandon (sec) Taken from Master Forecast. Configured in Staffing
Build Wizard.

Indirectly Occupied Time (%) Taken from Master Forecast. Configured in Staffing
Build Wizard.

Maximum Occupancy (%) Taken from Master Forecast. Configured in Staffing
Build Wizard.

The window also shows the following parameters from your forecast, if a forecast has been built
(otherwise, these indicators are empty):

• Service time
• Average time to abandon
• Indirectly occupied time
• Maximum occupancy

To calculate what-if scenarios, you must have the following:

• Published forecast values for interaction volume and AHT (which initialize the window's first two fields),
abandonment, service level, ASA, indirectly occupied time, and maximum occupancy.

• A published schedule that allows staffing suitability calculations. (This initializes the window's Coverage
field.)

Calculating What-If Scenarios

You can calculate what-if scenarios for the group of service-level statistics (Abandoned calls, Service
level, and Average speed of answer), or for the coverage level.

Calculating Abandoned Calls, Service Level, and Average Speed of Answer

1. Enter values into the Interaction volume and AHT text boxes.
2. Enter values into the Coverage text box.

For successful calculations, enter values in all of these text boxes.

3. Click the Calculate button next to the Service level text box.
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The window shows the expected impact of your changes on the Abandoned calls, Service level, and
ASA. If a box is empty, there is no data for the appropriate statistic for that timestep.

Calculating Coverage Scenarios

1. Enter values into the Interaction volume and/or AHT text boxes.
2. Enter values into the Abandoned calls, Service level, and/or ASA text boxes. For successful

calculations, enter a value in at least one of these text boxes.
3. Click the Calculate button next to the Coverage text box.

The window shows the expected impact of your changes on the Coverage.

Closing the What-If Window
When you have completed your calculations, click Close.

Performance What-If Window
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Adherence
Use the Adherence module to monitor real-time agent adherence to the schedule. You can display
adherence data in the Details View (table) or the Graphical View (pie chart).

Each view refreshes its data at the time interval that is specified in WFM Web Application object's
Options tab > Adherence section > RefreshTime option. The minimum refresh interval that you
can configure is one second. Genesys recommends that you set the refresh interval to the minimum
acceptable time, such as 20 seconds, as a shorter refresh time will affect overall system
performance.

Agent information is updated automatically when the data in Configuration Server changes.

To force a display of updated information in either view:

• Click Refresh.

Adherence in Multi-Channel Sites

WFM determines if agents are adherent by comparing their channel real-time state, plus the reason
codes, with the scheduled states for that same channel during each specified time interval. If at least
one scheduled state for that channel can be mapped to the channel real-time state, according to its
adherence rules, the agent is considered adherent.

Head Count for Activities in Multi-Channel Sites

WFM calculates the agent head count for activities in this way: If the activity belongs to a channel-
related schedule state group, the agent is counted for the activity only if he/she is compliant with the
adherence rules for that channel. Also, if an agent is non-adherent overall, but adherent for a
channel, the agent is added to the head count for the activities for that channel.

Exporting Adherence Data

To export adherence data to a report or in CSV-friendly format, see the Adherence Reports.
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Adherence Calculations
WFM can track single-channel agent adherence or agent adherence across multiple channels
simultaneously. In sites where schedule state groups are configured for multiple channels, WFM
determines if agents are adherent, by comparing their channel real-time state, plus the reason codes,
with the scheduled states for that same channel during each specified time interval. If at least one
scheduled state for that channel can be mapped to the channel real-time state, according to its
adherence rules, the agent is considered adherent.

Calculation of Single-Channel Adherence

Agent adherence (single channel) is calculated as follows:

1. WFM maps the agent's real-time state plus the reason code. If there is more than one reason code,
there is more than one state + reason code mapping. If there is no reason code, WFM uses only the
state for mapping. For example, if the agent has real-time state WaitingForNextCall with reason
codes r1 and r2, for adherence purposes, WFM maps WaitingForNextCall + r1 and
WaitingForNextCall + r2.

2. WFM then finds all schedule state groups that are adherent to at least one agent real-time state from
step 1. A list of schedule state groups is compiled that maps to the state, based on the configuration of
the schedule state groups.

3. WFM obtains all scheduled states from the current agent schedule and maps them to the schedule state
groups.

4. WFM collects all schedule state groups from step 3.
5. WFM intersects the sets of schedule state groups from step 2 and step 4. If the intersection is not

empty, the agent is adherent.

Calculation of Multi-Channel Adherence

Multi-channel agent adherence is calculated as follows:

1. Similar to step 1 in Calculation of Single-Channel Adherence, WFM maps the agent real-time state +
reason code. However, in addition to the aggregated agent state, WFM also adds separate real-time
states for each channel configured on the site. (Agents can sometimes have no state on certain
channels.) If reason codes are used, WFM could map multiple state + reason code pairs for each
channel, plus the aggregated state.

2. Similar to step 2 in Calculation of Single-Channel Adherence, WFM maps schedule state groups adherent
to the aggregated state. However, in addition, WFM finds a separate set of schedule state groups for
each channel. WFM considers only the schedule state groups that are specifically assigned to a
particular channel for adherence with the states on that channel. WFM considers the schedule state
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groups without a channel for adherence with the aggregated agent state.

3. WFM obtains all scheduled states from the current agent schedule and maps them to the schedule state
groups.

4. WFM collects all schedule state groups from step 3.
5. WFM Intersects the sets of schedule state groups from step 2 and step 4 separately for each channel. If

both sets are empty or the intersection is not empty, WFM considers the agent is adherent to the
channel. For the aggregated agent status, WFM assumes adherence, when either the pair in step 4 is
empty or step 2 and step 4 intersect. WFM considers the agent adherent, if he/she is adherent on all
channels and adherent to the aggregated status.

The multi-channel algorithm also comes to a boolean conclusion; that is, the agent is either adherent
or non-adherent. However, to be adherent the agent must be adherent on every channel, on which
he/she is scheduled or, for which he/she receives a real-time state. Also, if the agent is scheduled on
non-channel-related states, he/she must also be adherent to those states. See the example in Use
Case: Multi-Channel Adherence.

Use Case: Multi-Channel Adherence
This use case is based on the schedule state group configuration in Use Case: Multi-Channel
Adherence Tracking.

Summary Real-time states Scheduled states Adherence

Agent is working on
voice only, but
scheduled for email and
voice.

Agent state:
CallInbound

DN email: NotReady
DN 2323: CallInbound

E-mail activity, voice
activity Not adherent

Agent is working on
email and voice, but
scheduled for email
only.

Agent state:
CallInbound

DN email: WaitForNextCall
DN 2323: CallInbound

E-mail activity Not adherent

Agent is on a break.
Agent state: NotReady
DN email: NotReady
DN 2323: NotReady

Break Adherent

Calculation of Agent Head Count

WFM calculates the agent head count for activities in this way: If the activity belongs to a channel-
related schedule state group, the agent is counted for the activity only if he/she is compliant with the
adherence rules for that channel. Also, if an agent is non adherent overall, but adherent for a
channel, the agent is added to the head count for the activities for that channel.
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Adherence Details View
Use the Adherence Details view to examine individual agents' adherence statuses.

Displaying the Adherence Details View

To display the Details view:

1. Do one of the following:
• In the Modules tree, select Adherence > Details module.
• If you are in the Adherence Graphical view, use the Adherence drop-down list (on the right side of

the toolbar) to select the Details module.

2. In the Objects tree, select the teams or agents you want and click Get data.
If you previously selected teams or agents in the Adherence Graphical view, these selections remain.
You can modify them if you want to.
You can expand business units to display their sites and sites to display their teams and agents. You
can select an entire site or several sites within a single business unit, or any combination of agents and
teams within a business unit. For independent sites, you can select the entire site or any number of
teams and agents within the site.

Tip
Selecting a site or its teams/agents in a different business unit clears any previous selection within the first
business unit. Or (for independent sites) selecting a different site or its teams/agents clears your selections
under the first site.

The Details table is populated with adherence data for the selected agents and/or teams.

In the Adherence Details view, you can view the multi-channel adherence details by clicking the
arrow in first column of a specific row to expand it. For more information, see Adherence Per-Channel.
To export this data to a report or in CSV-friendly format, see the Agent States Report.

Reading the Details Table

The table columns list the following information for each agent:

• Last and First name
• Team
• Scheduled state group
• Current state
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• Duration of non-adherence
• Channels (optional—use the Detail Options dialog box to select this column if you want to see it)
• Adherence State (optional—use the Detail Options dialog box to select this column if you want to see it)
• Shift start time (optional—use the Detail Options dialog box to select this column if you want to see it)

Tip
If you include the Shift Start column but an agent has no shift, the cell for the
agent in this column is empty.

• Site (optional—use the Detail Options dialog box to select this column if you want to see it)

Colors indicate each agent's degree of non-adherence: Adherent, Non-adherent, or Severely non-
adherent (that is, non-adherent for more minutes than a defined threshold allows). The Legend below
the table identifies each color's meaning.

Customizing the Table

You can use the following options to customize the table's display:

• By default, agents are ranked according to non-adherence. Therefore, the agent who is out of
adherence the longest appears at the top of the list. You can sort the display according to different
columns (except for Scheduled State Group) by clicking the column headers.

• To filter the displayed information by state or by reason (aux) code, click the Filter button on the
Actions toolbar or select Settings from the Actions menu.

• To change which columns appear, click the Options button on the Actions toolbar or select Options
from the Actions menu.

• Agent names do not appear if the following option in the WFM Web Application object is set to true:
Options tab > Options section > HideNames.

• The display is updated at a user-defined interval, as described in the Adherence overview.
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Adherence Per-Channel
If agents in a specific site perform work on multiple media channels, you can view real-time states,
schedule states, and adherence sub-statuses for each channel separately. The optional columns
Duration of Non-adherence and Channels display time interval and name of channels, on which a
particular agent is not adherent. An agent could be non-adherent on more than one channel at any
given moment. If an agent is adherent, the Channels column on the aggregated level is empty.

Displaying Real-Time Adherence Per-Channel

To view the multi-channel adherence details for a specific agent in the Adherence Details view,
click the arrow in the first column of that row to expand it. The expanded rows contains information
about the selected agent for each channel and the aggregated adherence.

In the figure below (click to enlarge it), agent 1213 is working on more than one channel and the row
is expanded to show the duration of non-adherence for each channel.

The aggregated state is displayed in the first row and, depending on the schedule state group
configuration, might also be the only row. The dialog displays all channels, whether adherent or not.
When the dialog is opened, the data refreshes when the main Adherence Details view refreshes.

Figure: Multi-Channel Adherence Details
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Adherence Filter Dialog
Use the Adherence Filter dialog box to filter the items displayed in the data pane.

1. In the Adherence Details view or in the Adherence Graphical view, click the Filter button on the
Actions toolbar or select Filter from the Actions menu.
The Adherence Filter dialog box appears. It contains four tabs that present four different ways to
filter the data that appears in the Data pane:
• Scheduled State Groups—This tab displays a hierarchical list of items corresponding to the

current selection(s) on the Object pane:
• Business Unit (BU)—Sites—Schedule State Groups if the object pane selection is a BU or multiple

sites.
• Site—Schedule State Groups if the selection is only one site.

• Genesys States—This tab displays all possible Genesys states.
• Adherence Statuses—This tab displays all four possible statuses: Adherent, Non-adherent,

Severely non-adherent, and No information.
• Activities—This tab displays a hierarchical list of items corresponding to the current selection(s) in

the object pane:
• BU–Sites–Activities if the object pane selection is a BU or multiple sites.
• Site–Activities if the object pane selection is only one site.

2. Clear an item's check box ( ) to filter that item from the displayed data.
3. To filter on user-defined Reason codes, select the Filter using the following reason check box; then

type the appropriate code in the text box to its right.

Important
The specified reason code must not contain any spaces inside, or at the end of, the key value.

4. Click OK.

The Adherence Filter dialog box closes and your filter selections are applied immediately. They will
continue to apply until you change them or log off.

Tip

• In the toolbar, the filter icon is blue ( ) if all defaults are in effect and red ( ) if any
are not.
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• The Adherence Details view updates automatically if you change your selection(s) on the
Object pane. Also, if you select agents or teams in another site, then their selection
under the Scheduled States tab returns to the default, All.

• Items that you have configured to appear are displayed in the Scheduled State
Groups and Genesys State tabs. Schedule State Groups are configured in WFM, see
Scheduled State Groups. Genesys states are configured in Genesys Administrators.

• You can also use the Filter dialog in the Adherence Graphical view. Changes that you
make in one view apply to both views.
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Adherence Details Options Dialog
Use the Options dialog box to select which columns should appear in the Adherence Details view:

1. In the Adherence Details view, click the Options button on the Actions toolbar or select Options from
the Actions menu.
The Options dialog box appears. When you select a check box, the corresponding column appears in
the Adherence table:
• Shift Start Time check box:

• If an agent is already working during the period shown in the Adherence Details view, this
column shows the start time of the current shift. If the shift start time is the previous day, the
time has a minus sign (-) in front of it.

• If an agent is not currently on a shift, this column shows the next scheduled shift start time. If
the shift starts on the following day, the time has a plus sign (+) in front of it.

• Site check box. This column displays each agent's site.
• Adherence State check box. This column displays each agent's current state of adherence.

.
• Channels check box. This column displays agent adherence for each configured media channel.

2. Click Apply.
The Adherence Details view reappears. It is automatically updated to display the columns you selected.

Tip
When unchecked, the Channels column is not hidden if any agent adherence details are expanded. If none
are expanded and the check box is unchecked, the column is hidden. See examples in the figures below (click
to enlarge them).

Figure: No Multi-Channel Adherence Details: Not expanded—Channel column hidden

Figure: Multi-Channel Adherence Details: Expanded—Channel column displayed
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Adherence Graphical View
Use the Adherence Graphical view to see a pie-chart summary of agents' adherence states.

Displaying the Adherence Graphical View

To display the Graphical view:

1. Do one of the following:
• In the Modules tree, select Adherence > Graphical module.
• If you are in the Adherence Details view, use the Adherence drop-down list (on the right side of the

toolbar) to select the Graphical module.

2. In the Objects tree, select the teams or agents that you want, and then click Get data.
If you previously selected teams or agents in the Adherence Details view, these selections remain. You
can modify them if you want to.

You can expand business units to display their sites and expand sites to display their teams and agents.
You can select an entire site or multiple sites within a single business unit, or any combination of
agents and teams within the business unit. For independent sites, you can select the entire site or any
number of teams and agents within the site.

Tip
Selecting a site or its teams/agents in a different business unit clears any previous selection within the first
business unit. Or (for independent sites) selecting a different site or its teams/agents clears your selections
under the first site.

The pie chart displays adherence data for the selected agents and/or teams.
3. To filter the displayed information by state or by reason (aux) code, click the Filter button on the Actions

toolbar or select Settings from the Actions menu.

How to Read the Chart

The pie chart summarizes the share of agents in each of the following adherence states:

• Adherence.
• Non-adherence.
• Severe non-adherence. (Severe non-adherence means that the agent has been non-adherent for more

minutes than a defined threshold allows. The threshold is set at the site level.)
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Each category is represented by a colored wedge in the pie chart. The Legend (below the chart)
identifies each color's meaning. If no data is available, the whole chart is gray.

Beside each wedge, the first number shows the percentage of agents in the category. The second
number shows the actual number of agents in the category.
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Reports
Use WFM Web's Reports features to generate a variety of Configuration, Policies, Calendar, Forecast,
Schedule, Performance, Adherence, and Audit reports. (See the Reports List for details about the
reports available.) Once generated, the reports appear in the Report Viewer.

Report Viewer Features

With the Report Viewer, you can:

• View all information contained in the report.
• Print the report. You can create many reports in CSV (comma-separated values) format, which is easily

opened with spreadsheet software.
• Export the report to a local file.
• Regenerate the report, using the same or modified settings.
• Review an already generated report.

Viewing Reports

To view all pages of a multi-page report, use the following navigation buttons on the Reports Viewer's
toolbar (these look like the physical buttons on video or Compact Disk players):

• To move one page forward or back, click > or < (respectively).
• To jump to the final page or back to the first page, click >| or |< (respectively).
• To jump to a particular page, type the page number into the first text box between the > and < buttons

and then press Enter.

To zoom to a different magnification:

• Use the drop-down list to select a different %, Page Width, or Whole Page.

Report Viewer displays reports based on the selections that you made in the Reports Wizard. To
change these settings, see Using Reports as Templates.
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Printing Reports

To print a copy of a report, click the Printer icon on the Report Viewer toolbar.

Tip
Do not use WFM to print reports that you create in ".csv friendly format," because the
result may be truncated. To print such a file correctly, open it in a program that reads
the .csv format, and then print it.

Exporting Reports to Local Files

1. Click the Save As button on the Actions toolbar.
A dialog box appears.

2. Select a report format from the Report Format drop-down list.
3. Click OK or Apply.
4. If a File Download dialog box appears, click Save or OK.

This confirms that you want to save (not open) the file and displays a final dialog box.

5. Adjust the report's destination folder and file name.
6. Click Save or OK.

Using Reports as Templates

You can define and generate a new report based on the current report's settings (including all of your
selections in the Reports Wizard).

1. Click the Use as Template button on the Actions toolbar.
The current report's first wizard screen appears. Each screen retains the last selections you made.

2. Proceed through the wizard screens, changing your selections as necessary on each screen.
3. Click Finish on the last screen.

The Report Viewer displays the new report.
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Reviewing Reports

Once a report has been generated, you can reopen and review it without regenerating it:

1. In the Objects pane, click the report name or expand its expand/collapse control.
Any generated copies of this report appear in the tree, labeled by the date and time they were
generated.

2. Double-click a generated report to review it.
The report opens in the Report Viewer.

Copies of generated reports remain in the Objects tree until you either close them or exit WFM Web.

Closing Reports

To close a displayed report:

• Click the Close button ( ) on the Actions toolbar.

This clears the working pane and removes this report (whether standard or generated) from the
Objects tree. However, your last Reports branch remains selected in the Modules tree.
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Reports List
Use the Modules tree's Reports branch to generate the following reports (grouped here by category):

Configuration Reports

• Activity Properties Report—Includes hours of operation, skills, and activity set assignments.
• Shared Transport Report—Includes Shared Transport name, business unit, site, bus, status, size, the list

of agents who are participants in this Shared Transport, and their team names.

Policies Reports

• Agent Properties Report—Includes hire date, contract, wage, and skills.
• Contract Properties Report—Includes daily, weekly, schedule planning period paid hours, daily

availability settings, synchronization settings, days off settings, and assigned shifts.
• Shift Properties Report—Includes shift duration, start and end times, days of the week, contract

assignments, and break settings.
• Rotating Pattern Properties Report—Includes weekly pattern information, shifts, and activities.

Calendar Reports

• Calendar Items Report—Summarizes agent rotating patterns, availabilities, days off, shifts, working
hours, times off, and exceptions for the selected time range.

• Time-Off Report—Lists all preferred, granted, declined, and scheduled time off in a selected time range
for selected agents. Optionally includes time-off balances for all the time-off types selected.

• Time-Off Balance Report—Displays time-off balances for time-off types.
• Time-Off Management Report—Displays granted, preferred, declined, and scheduled time off. It includes

time-off balances for all the time-off types selected.

Forecast Reports

• Forecast Report—Forecast values for Calculated Staffing, Required Staffing, Interaction Volumes,
Average Handling Time (AHT), Service Level, Average Speed of Answer (ASA), Percentage of
Interactions Abandoned, and Maximum Occupancy. Shows these values for selected dates and selected
targets (activities, multi-site activities, business units, or sites).

• Forecast Graphs Report—Graphic presentation of forecast values for Calculated Staffing, Required
Staffing, Interaction Volumes, and AHT. Graphs these values for selected dates and selected targets
(activities or multi-site activities).

Performance Reports

• Actual Overhead Report—Forecast and scheduled agent information, including overhead figures.
• Workforce Performance Report—Average percentage of the deviation between Forecast, Required,

Scheduled, and Actual staffing.
• Contact Center Performance Report—Number of agents, interaction volumes, AHT, service level, ASA,
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and percentage of interactions abandoned. Shows these statistics for activities, multi-site activities,
sites, or business units.

• Contact Center Performance Graphs Report—Forecast and actual adherence data for selected activities
displayed in a graph format.

Schedule Reports

• Schedule States Report—Agent schedule states, organized by team.
• Schedule State Totals Report—Total durations of scheduled states for agents, teams, or sites, over a

selected period.
• Individual Schedule Report—Paid hours and scheduled states for the selected agent.
• Team Schedule Report—Total hours, paid hours, effective hours, and schedule state information for all

agents on a selected team.
• Activity Weekly Schedule Report—Total employment figures (full-time equivalents) for the selected

activity, and paid, effective, and noneffective paid hours for each agent.
• Team Weekly Schedule Report—Weekly paid, effective, and noneffective hours for each agent on the

selected team, as well as total hours (paid hours plus unpaid hours) for the team.
• Weekly Schedule Coverage Report—Calculated (or Required) and Scheduled Staffing for a specific

activity or site; difference between Calculated and Scheduled Staffing; and total staffing hours.
• Scheduled Budget Report—Regular, overtime, and total budgeted hours for each agent within a team.
• Agent Comments Report—Comments entered for agents in the Comments text box of the schedule.
• Schedule Validation Report—The Schedule Validation window's data in a report format. If the

configuration settings lead to a disparity between the staffing requirements and the actual schedule,
the Schedule Validation window records the problems. It also indicates what parameters need to be
changed to correct the disparity.

• Schedule Trade Report—Schedule trade participants (proposer and respondent), dates involved,
approval status, approving supervisor, and comments.

• Schedule Summary Report—Coverage, headcount; service level percentages; scheduled and forecasted
for interaction volume, AHT, and budget. Optional columns include published coverage and the
difference between schedule coverage based on the current Master Schedule and schedule coverage
based on the baseline Master Schedule.

• Schedule Marked Time Report—Agent marked time, organized by team.
• Schedule Marked Time Totals Report—Total durations of marked time for agents, teams, or sites, over a

selected period.
• Schedule Bidding Report—Includes ranking system, agent, team, agent's relative position in the bidding

process, agent's original bid number, and more.
• Weekly Schedule Report—Includes date range, agent, paid hours, effective hours, non-effective hours,

planning period hours, totals, and more.

Adherence Reports

• Agent Adherence Report—All schedule non-adherence for selected agents.
• Adherence Totals Report—Average adherence percentage for selected teams or sites, with calculated

agent adherence.
• Agent States Report—A timestep-by-timestep account of each selected agent's state throughout the
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selected days.

Audit Reports

• Calendar Audit Report—Insertion/deletion/editing of Calendar items. Also granting/declining Calendar
items, and making Calendar items Preferred.

• Schedule Audit Report—Publishing/cleanup, modification of Master Schedule including insertions, edits,
and deletions.

• Configuration Audit Report—Shows configuration object (data) types that have been associated with
specific sites and users, including the SYSTEM user.
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Saving Reports to Files
To export a report to a disk file:

1. In the Actions toolbar, click Save As .
A dialog box appears.

2. Select a report format from the Report Format drop-down list.
3. Click OK or Apply.
4. If a File Download dialog opens, click Save or OK.

This confirms that you want to save (not open) the file and displays a final dialog.

5. Adjust the report's destination folder and file name.
6. Click Save or OK.
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Reports Scheduler
Use this module to schedule reports, and to view and edit those schedules.

When you select Reports Schedule in the module pane, a list of the schedule(s) you have created
appears in the data pane. The list is a grid that has these columns:

Enabled Cells in this field can contain the values true or
false.

Name Name of the report.
Report type Type.
User User who created the schedule.
Schedule Lists the specifics of the schedule.

Next run Lists the date / time of the next run of a recurring
report.

Commands (also on the Actions menu)
Icon Name Description

New Display the Scheduled Report
Task dialog in the data pane.

Edit
Edit the selected overlay using a
limited version of the Scheduled
Report Task dialog.

Delete Delete the selected overlay.

Show All

This button is a toggle. Select it
to display all report schedules,
that have been created by all
users (the icon becomes
darkened). Clear to display only
schedules that have been
created by the current user.

Enable Enable the selected report.

Disable Disable the selected report.

To schedule a report:

1. Select Reports Scheduler in the modules pane.

2. Click the New ( ) icon or select New from the Actions menu.
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The Scheduled Report Task dialog appears in the data pane.

3. For each page of the dialog, make the appropriate selections and click Next.
4. On the final page, click Finish.

Scheduled Report Task Dialog:

The pages are:

• Scheduled report task page
• Data page
• Date Range page
• Pages that correspond to your selection in the Report Type field.

Scheduled Report Task page
There are three sections on this page.

General Parameters:

• Name — Enter a name for the schedule task.
• Report type — Select a report type from the drop-down menu.
• Export to — Select an output format from the drop-down menu.

Run Time:

• Start date — Select or enter a start date to generate the report.
• End date — Enable by clicking the Enable end date check box, then select or enter an end date to

generate the report.
• Run time — Select or enter a time of day to generate the report.
• Time Zone — Select the time zone from a drop-down list.

• Select Local or Configured time zones. If you select Local, the report generation time is set to the
time zone of the host on which WFM Daemon is running.

Frequency:

• Daily — Specify that the report will be produced every day.
• Weekly — Also specify one or more days of the week by clicking the corresponding check box(es).

Default: all days of the week are checked.
• Monthly — Also specify the day of the month by selecting or entering a day in the Day of month field.

Default: 1.
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Data page
Available User:

• Select the check box of every user who you wish to be able to see the generated report.

All subsequent pages that appear correspond directly to the report type. (For example, if you select
Time-Off Balance Report in the Report Type field (in the General Parameters area below), then
see the Time-Off Balance Report topic in this Help for descriptions of the rest of the pages.

Date Range page
You are specifying the range of data that the report will contain.

Start Date Offset:

• Adjust the data's starting date, relative to the start date of the report's generation. You can select a
positive or negative integer, or 0 (zero, the default). The increment is Days.

End is Relative to [start date | generation date]:

• Specify if the data's ending date will be relative to the data's start date (specified above) or the data's
generation date (the Run Time date, which you specified on the first page).

• Adjust the data's ending date, relative to your selection. You can select a positive or negative integer, or
0 (zero, the default). The increment is Days.

If your selection is incorrect, an error message will appear to explain why.
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Reports Generated
Select Generated Reports in the module area to display a grid that lists scheduled reports that
have already been generated. Select a report in the list and use these controls to manage it:

Delete button—Remove the selected report. You must be the creator of the scheduled report task or
have the right to access all scheduled report tasks.

Show All button—This a toggle. Select it to display all reports generated that have been created by
all users (the icon becomes darkened). Clear it to display only reports that have been generated by
the current user.

Save As button—Download the selected report in the format that it was saved after generation. A
standard Save File dialog appears.

The grid has the following columns: Name, Report type, User, Time (date and time), and Status
(information about a report’s generation).

To specify the network path to store generated reports, use Genesys Administrator to modify or
create the option [Reports] PathToAutoGeneratedReports in the WFM Web application. See the
Workforce Management Options Reference.

See also Creating New Sections and Options.
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Configuration Reports
The Configuration report summarizes the configuration settings for WFM objects. (For a complete list
of all WFM reports, see the Reports List.)

The Configuration reports are:

• Activity Properties Report.
• Shared Transport Report.

To create a report, click that report's link (above) and follow the steps.

Report Security Restrictions

You can view and print reports only for those sites for which you have security access.

Date Restrictions

For reports whose wizard includes a Date Range screen:

• If you select weekly or monthly granularity, the Start Date and End Date selectors may be
constrained to particular days (to the week's start and end days, or to the selected month's first and
last days).

• If you enter dates that do not match these constraints and click Next, an error message alerts you to
change your selection.

• If you select intra-day granularity, the End Date selector is disabled.

Reports Configuration Reports

Workforce Management Web for Supervisors Help 766



Activity Properties Report
To create an Activity Properties Report:

1. On the Reports tab, select Configuration Reports from the Views menu.
2. Select Activity Properties Report from the list on the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. To print a header on the report, select Show Header and type your header text into the text box.
4. Click Next.
5. On the Data screen, select the activities you want to include in the report.

You can expand business units to display their sites; you can expand sites to display their activities. You
can select any combination of activities from multiple sites.

6. Click Finish.
The report appears in the Report Viewer.

Understanding the Activity Properties Report

Site [header] The selected site, its time zone, and the maximum
number of seats available.

Activity Each activity that you selected to include in the
report.

Hours of Operation (Start Time, End Time)
The start and end times for each activity on the
indicated day in hh:mm format. (A plus sign (+)
before the end time indicates that the activity ends
on the next day.)

Maximum Simultaneous Users The maximum number of agents scheduled to
perform each activity at any one time.

Minimum Staffing

The minimum staffing levels configured for each
activity. Minimum Staffing Level can be shown as a
percentage or shown as number of agents (see
Activity Properties). If the Minimum Staffing
Level parameter is configured as percentage, then
the value is shown as a percentage; For example,
20%. If set as agents, then this value is shown as a
number; For example, 20.

Skills (Min-Max Levels) The skills, and minimum and maximum skill levels,
configured for each activity.

Activity Set Name The name of the activity set in which the activity is
included (if applicable).
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Shared Transport Report

Tip
Shared Transport is known by many different names worldwide—for example, bus,
carpool, ride share, lift share, and paratransit. See Wikipedia for details.

To create a Shared Transport Report:

1. On the Reports tab, select Configuration Reports from the Views menu.
2. Select Shared Transport Report from the list on the Objects pane.

The Reports wizard's Header page, appears.
3. To print a header on the report, select Show Header and type your header text into the text box.
4. Click Next.
5. On the Data page, select the agents you want to include in the report.

Tip
You can expand business units to display their sites; you can expand sites to display their agents. You can
select any combination of agents from multiple sites.

6. On the Shared Transport page, select the shared transport items you want to include in the report.
7. Click Finish.

The report appears in the Report Viewer.

Understanding the Shared Transport Report
Shared Transport Report The report title.
Each Shared Transport in the report has this
information in its header:

Business Unit field Business unit of the shared transport.
Site field Site of the shared transport.

Transport field Shared transport name.
Status field Status of the shared transport.

Comments field Comments (if any) that are attached to the shared
transport.

This is the bus with maximum size nn field Maximum size of the shared transport, if it is a bus.
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Below the header, each agent in the shared
transport is listed on a separate row, with these
columns:

No. Number of the row.
Agent Agent name.
Team Agent's team name.
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Policies Reports
Policies reports summarize the properties of agents, contracts, shifts, and rotating patterns. (For a
complete list of all WFM reports, see the Reports List.)

The Policies reports are:

• Agent Properties Report.
• Contract Properties Report.
• Shift Properties Report.
• Rotating Pattern Properties Report.

To create a report, click that report's link (above) and follow the steps.

Report Security Restrictions

You can view and print reports only for those sites for which you have security access.

Date Restrictions

For reports whose wizard includes a Date Range screen:

• If you select weekly or monthly granularity, the Start Date and End Date selectors may be
constrained to particular days (to the week's start and end days, or to the selected month's first and
last days).

• If you enter dates that do not match these constraints and click Next, an error message alerts you to
change your selection.

• If you select intra-day granularity, the End Date selector is disabled.
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Agent Properties Report
To create an Agent Properties Report:

1. On the Reports tab, select Policies Reports from the Views menu.
2. Select Agent Properties Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. To print a header on the report, select Show Header and type your header text into the text box.
4. Click Next.
5. On the Data screen, select the agents that you want to include in the report.

You can expand business units to display their sites, teams, and agents. You can select any
combination of agents or teams, from multiple sites.

6. Click Finish.
The report appears in the Report Viewer.

Understanding the Agent Properties Report

Site [header] The report is organized by sites, by teams within
each site, and site time zone.

Agent Name of each agent included in the report.
ID Agent’s identification number.
Hire Date Date that agent was hired.
Termination Date Date that agent was terminated.
Rank Agent's rank set in Agent Properties.
Contract The contract type assigned to agent.
Rotating Pattern The agent's rotating pattern, if one was assigned.
Wage The current wage set for the agent.
Skills (Level) The skills that have been assigned to agent.
Activities List of activities that the agent can work on.

Comments Any comments for agent that were entered during
configuration.

Time-Off Rule Time-off rule assigned to agent.
Time-Off Types All time-off types associated with time-off rule.

Last Carry-Over Date Most recent date for carry-over of unused time-off
hours.

Hours Carried Over Number of time-off hours carried over from the
previous year to the current one.

Stop Date Date when the Time-Off Rule became inactive for
agent.
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Contract Properties Report
To create an Contract Properties Report:

1. On the Reports tab, select Policies Reports from the Views menu.
2. Select Contract Properties Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. To print a header on the report, select Show Header and type your header text into the text box.
4. Click Next.
5. On the Data screen, select the contracts that you want to include in the report.

Tip
You can expand business units to display their sites, teams, and agents. You can select any combination of
agents or teams, from multiple sites.

6. Click Finish.
The report appears in the Report Viewer.

Understanding the Contract Properties Report

Site [header]
The selected site, its time zone, and the (first)
selected contract. Each subsequent contract is
displayed separately.

Contract Name The name of the contract whose properties are
displayed below.

Daily Working Hours

The number of daily paid hours defined for this
contract. Agents assigned to the contract must
have at least this number of paid hours each day.
This value is aggregated to the three report statistics: Min.,
Std., and Max. representing the minimum, standard, and
maximum number of paid hours per day.

Weekly Working Hours

The number of weekly paid hours defined for this
contract. Agents assigned to the contract must
have at least this number of paid hours each week.
This value is aggregated to the three report statistics: Min.,
Std., and Max. representing the minimum, standard, and
maximum number of paid hours per week.

Schedule Planning Period Working Hours
The number of daily paid hours defined for the
schedule planning period for this contract. Agents
assigned to the contract must have at least this
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number of hours within the schedule planning
period.
This value is aggregated to the three report statistics: Min.,
Std., and Max. representing the minimum, standard, and
maximum number of paid hours per schedule planning period.

Weekly Working Days

The number of weekly working days defined for
this contract. Agents assigned to the contract must
be available to work at least this number of days
each week.
This value is aggregated to the two report statistics: Min. and
Max. representing the minimum and maximum number of
working days per week.

Max. Consecutive Working Days
The maximum number of consecutive working days
defined for this contract. Agents assigned to the
contract cannot exceed this number of consecutive
working days.

Synch. Period The period of time over which synchronization
occurs.

Synch. of Daily Schedules Flexibility The number of hours within which the daily
schedule is assumed to be synchronized.

Synch. Type
The type of synchronization used for the contract,
such as shifts between days off, one week or a
period of weeks, or the Schedule Planning Period.

Weekdays for Synch. The weekdays on which synchronization will occur.

Daily Availability (Start time and End time) The Start and End times that the agent assigned to
the contract is available to work each day.

Weekend First Day
The day that is assigned or designated as the first
day of the weekend, such as Friday, Saturday, or
Sunday.

First Weekend Days Off

The number of times that the agent assigned to the
contract can have the first weekend day off.
This value is aggregated to the three report statistics: Min.,
Max., and Enabled representing the minimum and maximum
number of first weekend days off allowed for the contract, and
whether or not the restriction is enabled (Yes, No).

Second Weekend Days Off

The number of times that the agent assigned to the
contract can have the second weekend day off.
This value is aggregated to the three report statistics: Min.,
Max., and Enabled representing the minimum and maximum
number of second weekend days off allowed for the contract,
and whether or not the restriction is enabled (Yes, No).

Both Weekend Days Off

The number of times that the agent assigned to the
contract can have the both weekend days off.
This value is aggregated to the three report statistics: Min.,
Max., and Enabled representing the minimum and maximum
number of both weekend days off allowed for the contract, and
whether or not the restriction is enabled (Yes, No).
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Each category is an element of the Contract/Site combination that is listed in the report header.

Key

• Min.—Minimum
• Std.—Standard
• Max.—Maximum
• Synch.—Synchronization
• Shift table lists all shifts covered by the contract.
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Shift Properties Report
To create a Shift Properties Report:

1. On the Reports tab, select Policies Reports from the Views menu.
2. Select Shift Properties Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. To print a header on the report, select Show Header and type your header text into the text box.
4. Click Next.
5. On the Data screen, select the shifts to include in the report.

You can expand business units expand to display their sites, and expand sites to display their shifts. You
can select any combination of shifts from multiple sites.

6. Click Finish.
The report appears in the Report Viewer.

Understanding the Shift Properties Report

Site [header]
The selected site, its time zone,
and the (first) selected shift.
Each subsequent shift is
displayed separately.

Shift Name The name of the shift whose
properties are displayed below.

Min. Paid Hours

The minimum number of hours
defined for this shift. All contracts
assigned to the shift must be
available to work at least this
number of hours.

Max. Paid Hours The maximum number of hours
defined for this shift.

Earliest Start Time The earliest time that this shift
can start.

Latest Start Time The latest time that this shift can
start.

Earliest End Time The earliest time that this shift
can end.

Latest End Time The latest time that this shift can
end.

Days of Week Days on which this contract can
be scheduled.

Day Off Rule Rule for scheduling this shift. (For
example, one possible value is
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Next day is not off.)
Distrib. Period Distribution period for this shift.

Min Distrib.
Minimum amount of time that
this shift should be scheduled
during the Distribution Period.

Max Distrib.
Maximum amount of time that
this shift should be scheduled
during the Distribution Period.

Min. Distance Between Shift
Items

The shortest amount of time
allowed between shift items
(breaks and meals).

Max. Distance between Shift
Items

The longest amount of time
allowed between shift items
(breaks and meals). Also applies
to the distance from shift start to
first shift item and from last shift
item to shift end.

Task sequences usage The usage for Task Sequences
during scheduling.

Task sequences [if
applicable] Task Sequence Name The task sequence associated

with the shift.

Index
The position of the task-
sequence item in the task
sequence.

Activity Set
The activity set on which the
agent can work during the
specified task-sequence interval.

Min Duration Minimum task sequence
duration.

Max Duration Maximum task sequence
duration.

Fixed Position

Whether the task-sequence
interval has strict bounds.
Possible values are:

• Task is flexible within the
earliest start, latest end
interval.

• Start is fixed, end is flexible.
• End is fixed, start is flexible.
• Start and end are fixed.

Contracts The contracts associated with the
shift.

Shift Item sequences [if
applicable] Min. Paid Hours

The minimum paid shift duration
for which this break and meal
sequence takes effect. (This
break and meal sequence cannot
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be applied to shifts shorter than
this duration.)

Allowed
Specifies if this Shift Item
Sequence be used while
scheduling (value can be Yes or
No).

Index The position of the shift item in
the Shift Item Sequence.

Meal Meals that are assigned to this
Shift Item Sequence.

Break Breaks that are assigned to this
Shift Item Sequence

Break [if applicable] Break Name The break associated with the
shift.

Index
The position of the break in the
shift's list of breaks. The same
break may occur more than
once.

Duration The length of the break.

Min. Length From Shift Start
The minimum distance between
the start of the shift and the start
of the break.

Max. Length from Shift Start
The maximum distance between
the start of the shift and the start
of the break.

Min. Length from Shift End
The minimum distance between
the end of the break and the end
of the shift.

Paid Time Shows break is paid or not.

Start Step

Shows increments between break
start times. For example, with a
start step of 15 minutes, agents
leave for the break 15 minutes
apart.

Start Offset
Sets how many minutes past the
hour in the interval in which a
break may occur that the start
step calculation should begin.

Fixed Position
Shows whether the break has to
occur at a specific point in the
shift.

Meals [if applicable] Meal Name The meal associated with the
shift.

Index
The position of the meal in the
shift's list of meals. The same
meal may occur more than once.

Earliest Start Time The earliest time this meal can
start.
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Latest End Time The latest time this meal can
end.

Duration The length of the meal.

Min. Time Before Meal
The minimum distance between
the shift's start time and the
meal's start time.

Min. Time After Meal
The minimum distance between
meal's end time and the shift's
end time.

Paid Whether the meal is paid or
unpaid.

Start Step The meal's start times must be a
multiple of this integer.
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Rotating Pattern Properties Report
To create a Rotating Pattern Properties Report:

1. On the Reports tab, select Policies Reports from the Views menu.
2. Select Rotating Pattern Properties Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. To print a header on the report, select Show Header and type your header text into the text box.
4. Click Next.
5. On the Data screen, select the rotating patterns you want to include in the report.

Tip
You can expand business units to display their sites, and expand sites to display their rotating patterns. You
can select any combination of rotating patterns from multiple sites.

6. Click Finish.
The report appears in the Report Viewer.

Understanding the Rotating Pattern Properties Report
Site [header] The selected site.
Time Zone The time zone for the site.
Rotating Pattern The rotating pattern displayed.
Weekly Pattern The name of displayed weekly pattern.

Min. Paid Hours
If Use Weekly Paid Hours is selected in the
Weekly Rules pane, the minimum Paid Hours for
the weekly pattern.

Max. Paid Hours
If Use Weekly Paid Hours is selected in the
Weekly Rules pane, the maximum paid hours for
the weekly pattern.

Day of Week The weekly schedule settings for each day of the
week.

Shift The shift assigned on each day for each weekly
schedule within the rotating pattern, if applicable.

Start Time The shift's start time on each day of the weekly
schedule, if applicable.

Paid Hours/Duration The paid hours in the shift on each day of the
weekly schedule, if applicable.

Estimated End Time The estimated end time of the shift (start time +
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paid hours), if applicable.

Activities
The activities performed on each day for the
weekly schedule. Displays All Applicable if No
Activity Limitation was selected in the Rotating
Pattern Activities pane for this Rotating Pattern.

Possible Day Off Whether it is possible for the Schedule resolution
process to assign this day as a day off.
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Calendar Reports
Calendar reports list time off, days off, shifts, rotating patterns, availabilities, working hours,
exceptions, and preferences. (For a complete list of all WFM reports, see the Reports List.)

The Calendar reports are:

• Time-Off Report
• Time-Off Balance Report
• Calendar Items Report
• Time-Off Management Report

To create a report, click that report's link (above) and follow the steps.

Report Security Restrictions

You can view and print reports only for those sites for which you have security access.

Date Restrictions

For reports whose wizard includes a Date Range screen:

• If you select weekly or monthly granularity, the Start Date and End Date selectors may be
constrained to particular days (to the week's start and end days, or to the selected month's first and
last days).

• If you enter dates that do not match these constraints and click Next, an error message alerts you to
change your selection.

• If you select intra-day granularity, the End Date selector is disabled.
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Calendar Items Report
To create a Calendar Items Report:

1. On the Reports tab, select Calendar Reports from the Views menu.
2. Select Calendar Items Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result might be truncated. To print
the file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. In the Date Range screen, select a start and end date for the report's data.
6. Optionally, you can select Show comments/memo to control whether comments or memos, if any, are

shown on the report.
Click Next.

7. On the Data screen, from the Available Agents list, select the agents that you want to include in your
report.
You can expand business units to display their sites, and expand sites to display their teams and
agents. You can select any combination of teams and/or agents from multiple sites.
Click Next.

8. On the Calendar Items screen, select the check boxes for items that you want to include in the report,
and clear the check boxes for items that you want to omit. Available selections are:
• Rotating Patterns
• Availabilities
• Days Off
• Shifts
• Working Hours
• Times Off
• Exceptions

9. Click Finish.

Important
If Exceptions and Times Off are selected on the Calendar Items page, you must specify Exceptions and
Time-Off types.
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The report appears in the Report Viewer.

Understanding the Calendar Items Report

Site [header] The selected site, its time zone, and the (first)
selected team. The report is organized by team.

Date Period [header] The dates covered in the report.
Agent The name of each agent included in the report.

Date
The date on which the agent requested an
exception, rotating pattern, or preference. The
report can show multiple calendar items for agents.

Type Rotating patterns, availabilities, days off, shifts,
working hours, times off, or exceptions.

Description The name of exception or preference, or
description of rotating pattern.

Start Time The time at which the calendar item starts.
End Time The time at which the calendar item ends.

Status
Whether the calendar item is Scheduled, Not
Scheduled, Granted, Declined, Preferred, or
Recalled.

Comments/Memo Optional column.
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Time-Off Report
For the agents and dates that you select, this report displays granted, preferred, declined, and
scheduled time off. It optionally includes time-off balances for all the time-off types selected.

To create a Time-Off Report:

1. On the Reports tab, select Calendar Reports from the Views menu.
2. Select Time-Off Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result may be truncated. To print
such a file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. In the Date Range screen, select a start and end date for the report's data.
6. From the Sort Options drop-down list, select to sort the report by agent name, by the date for which

time off was requested, or by the request's date submitted.
7. Optionally, you can select Show time-off balance.
8. Optionally, you can select Show comments to control whether comments, if any, are shown on the

report.
9. Click Next.

10. On the Data screen, select the agents you want to see in the report.
You can expand business units to display their sites, and expand sites to display their teams and
agents. You can select any combination of teams and/or agents from multiple sites.

11. Click Next.
12. On the Available Time-Off Types screen, select the time-off types you want to see in the report. Time-

off types are grouped by business units and sites.
13. Click Finish.

The report appears in the Report Viewer.

Understanding the Time-Off Report
Site [header] The selected site and its time zone.

Team [header]
The team to which the agents in the table below
belong. If you selected more than one team, teams
are listed in alphabetical order, with the data for
agents in one team appearing before the next
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team name in the list.
Date Period [header] The dates covered in the report.

Agent The name of the agent whose information is
displayed.

Date
The date for which the agent has submitted a time-
off preference. The time-off balance shown in the
Balance column is also for this date.

Description The name of the time-off type.

Start Time and End Time When the time-off period starts and ends. For a full-
day time-off request, both columns say Full Day.

Status
Whether the time-off preference is Preferred,
Granted, Declined, Recalled, Scheduled, or not
Scheduled.

Date and Time Submitted The time at which the time-off preference was
made.

Balance The agent's available time-off hours as of the date
of the request.

Comments Comments, if any, submitted with time-off item.
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Time-Off Balance Report
For the agents and dates that you select, this report displays time-off balances for time-off types.

To create a Time-Off Balance Report:

1. On the Reports tab, select Calendar Reports from the Views menu.
2. Select Time-Off Balance Report from the list on the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result may be truncated. To print
such a file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. In the Date Range screen, select a start and end date for the report's data.
6. From the Sort Options drop-down list, select to sort the report by agent name or by the date for which

time off was requested.
Click Next.

7. On the Data screen, select the agents you want to see in the report.
You can expand business units to display their sites, and expand sites to display their teams and
agents. You can select any combination of teams and/or agents from multiple sites.
Click Next.

8. On the Available Time-Off Types screen, select the time-off types you want to see in the report. Time-
off types are grouped by business units and sites.

9. Click Finish.
The report appears in the Report Viewer.

Understanding the Time-Off Balance Report
Site [header] The selected site and its time zone.

Team [header]

The team to which the agents in the table below
belong. If you selected more than one team, teams
are listed in alphabetical order, with the data for
agents in one team appearing before the next
team name in the list.

Date Period [header] The dates covered in the report.

Agent The name of the agent whose information is
displayed.

Date The date for which the agent has submitted a time-
off preference. The time-off balance shown in the
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Balance column is also for this date.
Description The name of the time-off type.

Balance
The agent's current number of available time-off
hours of the type shown in the Description
column, as of the date shown in the Date column.
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Time-Off Management Report
For the agents and dates that you select, this report displays granted, preferred, declined, and
scheduled time off. It includes time-off balances for all the time-off types selected.

To create a Time-Off Management Report:

1. On the Reports tab, select Calendar Reports from the Views menu.
2. Select Time-Off Management Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
4. Click Next.
5. In the Date Range screen, select a start and end date for the report's data.
6. Click Next.
7. On the Data screen, select the agents you want to see in the report.

Tip
You can expand business units to display their sites, and expand sites to display their teams and agents. You
can select any combination of teams and/or agents from multiple sites.

8. Click Next.
9. On the Available Time-Off Types screen, select the time-off types that you want to see in the report.

Time-off types are grouped by business units and sites.
10. Click Finish.

The report appears in the Report Viewer.

Understanding the Time-Off Management Report
Report Header
Site The selected site and its time zone.
Time Zone Time zone of the he selected site.

Team The team to which the agent in the table below
belongs.

Date Period The dates covered in the report.

Agent The name of the agent whose information is
displayed.

Rules table columns: This table lists data for each rule that applies to
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each time-off type in the report. The format is one
rule per line, and one table per type/agent
combination.
Time-Off Rule, Time-Off Type, Start date, End date,
Carried Over, Carry Over Day

Daily Status table (untitled) columns:

This table lists data for each date in the report. The
format is one date per line, and one table per agent
/ time-off type combination.
Date, Balance, Accrued/Awarded, Credit, Carried Over,
Used, Bonus Assigned, Bonus Used, Bonus Expired, Bonus
Balance

Tip
The Used column contains the sum of Granted +
Preferred + Scheduled + Not Scheduled time-off hours
which exceed bonus hours, but Not Scheduled hours
are included only if the option
CalendarOverScheduleData is enabled.

Instance Status table (untitled) columns:

This table lists data for each time-off instance that
was either Granted, Declined, Preferred, Scheduled,
or Not Scheduled.
The format is one title per line / data line per instance.

Time-Off Type, Time-Off Status, Start Time, End Time,
Paid Hours, Submitted On, Comments
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Forecast Reports
Forecast reports display key details of anticipated activity and staff requirements, in tabular and/or
graph formats. (For a complete list of all WFM reports, see the Reports List.)

The Forecast reports are:

• Forecast Report.
• Forecast Graphs Report.

To create a report, click that report's link (above) and follow the steps.

Report Security Restrictions

You can view and print reports only for those sites for which you have security access.

Date Restrictions

For reports whose wizard includes a Date Range screen:

• If you select weekly or monthly granularity, the Start Date and End Date selectors may be
constrained to particular days (to the week's start and end days, or to the selected month's first and
last days).

• If you enter dates that do not match these constraints and click Next, an error message alerts you to
change your selection.

• If you select intra-day granularity, the End Date selector is disabled.
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Forecast Report
To create a Forecast Report:

1. On the Reports tab, select Forecast Reports from the Views menu.
2. Select Forecast Graphs Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. To print a header on the report, select Show Header and type your header text into the text box. Then

(whether you entered a header or not) click Next.
4. On the Scenario screen, select a forecast scenario or the Master Schedule. Then click Next.

You will not see this screen if the report is created from the Report Scheduler, because the report data
is retrieved from the Master Forecast.

5. On the Date Range screen:
a. Select a Granularity and a corresponding Start and End Date. (Your Granularity selection may

restrict your Date selections.)
b. Select Activity, Site, Multi-site Activity, or Business Unit from the drop-down list.
c. Click Next.

6. In the Data screen, select forecast targets.
This page's tree displays activities, sites, multi-site activities, or business units (depending on your
choice of target). If you selected a target other than business unit, the tree's business units expand to
display their contents. You can make multiple selections.

7. You can display staffing totals in Full Time Equivalent (FTE) or man-hours mode in this report by
selecting the mode in the report wizard. Select the mode by checking or unchecking the Show
staffing totals information in man hours instead of FTE option. The default value of this option
will be the same as the settings in Changing the Staffing Display from FTE to Man Hours.

8. Click Next.
On the Forecast Data Types screen, select the Data Types you want to include.

9. Click Finish.
The report appears in the Report Viewer.

Understanding the Forecast Report

Site Information or Business Unit Information
or Enterprise [header]

The site name and time zone, if you selected
activity as the report's target.
The business unit name and time zone, if you selected multi-site
activity or site as the report's target.
The enterprise, if you selected business unit as the report's
target.
(Each root is displayed separately.)

Activity, Multi-Site Activity, Site, or Business
Unit [header]

The report is organized by activity, multi-site
activity, site, or Business Unit – depending on the
target that you selected in the Reports Wizard.
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Date/Date Period [header]

The dates covered by the report. The report
displays separate information for each target and
date. This header shows the Date if you selected
Intra-day granularity and Date Period for other
granularities.

Time Step, Day, Week Of, X Weeks of, Month
The time period shown. The header and the column
contents depend on the granularity that you
selected.

Statistics/Options [columns]

The forecast value, for each period, for the display
options that you selected in the wizard. The
possible columns are:

• Interaction Volume
• Average Handling Time
• Calculated Staffing
• Required Staffing
• Service Level
• Deferred Service Level
• ASA
• Abandons Factor
• Max. Occupancy
• Historical data Interaction Volume
• Historical data Average Handle Time

Tip
If you select a scenario, other than the Master
Forecast, the historical data types in this list are not
available

Total/Average for Activity/Site [footer]

The total or average forecast value for each
statistic shown in the table for this activity or site.

Tip
If you generate reports in .CSV-friendly format, the
Total/Average for Activity values are displayed in
separate columns and not as a footer.

Total/Average for Site/Business Unit [footer] The total and/or average forecast value for each
displayed option for the displayed target.
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Forecast Graphs Report
To create a Forecast Graphs Report:

1. On the Reports tab, select Forecast Reports from the Views menu.
2. Select Forecast Graphs Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. To print a header on the report, select Show Header and type your header text into the text box. Then

(whether you entered a header or not) click Next.
4. On the Scenario screen, select a forecast scenario or the Master Forecast and then click Next.

You will not see this screen if the report is created from the Report Scheduler, because the report data
is retrieved from the Master Forecast.

5. On the Date Range screen:
a. Select a Granularity and a corresponding Start and End Date. (Your Granularity selection may

restrict your Date selections.)
b. Select Activity or Multi-site Activity from the drop-down list.
c. Click Next.

6. You can display staffing totals in Full Time Equivalent (FTE) or man-hours mode in this report by
selecting the mode in the report wizard. Select the mode by checking or unchecking the Show
staffing totals information in man hours instead of FTE option. The default value of this option
will be the same as the settings in Changing the Staffing Display from FTE to Man Hours.

7. On the Data screen, select forecast targets.
The tree's contents depend on your choice of target. You can expand business units to display their
sites or multi-site activities. You can expand sites to display their activities. You can make multiple
selections.

8. If you selected Multi-site Activity or Activity as the target:
a. Click Next.
b. On the Forecast Data Types screen, select the Data Types you want to include.
c. Click Finish.

The report appears in the Report Viewer.

Understanding the Forecast Graphs Report

Site or Business Unit [header] The site, or Business Unit, and time zone included
in the report.

Activity or Multi-Site Activity [header] The activity or multi-site activity displayed in the
following graph.

Date [header] The dates covered by the report. The information in
the report is shown separately for each activity,
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display option, and date.

Statistics/Options [graph bars]

Each display option is shown in a separate graph.
The displayed statistic, and its units, are labeled on
the left side. The possible columns are:

• Interaction Volume
• Average Handling Time
• Calculated Staffing
• Required Staffing

Timestep / Day / Week of / Month / X weeks of
The time period covered by each bar in the graph.
The period depends on the granularity that you
selected in the wizard.
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Performance Reports
Performance reports display site performance measures in tabular and/or graph formats. (For a
complete list of all WFM, see the Reports List.)

The Performance reports are:

• Actual Overhead Report.
• Workforce Performance Report.
• Contact Center Performance Report.
• Contact Center Performance Graphs Report.

To create a report, click that report's link (above) and follow the steps.

Report Security Restrictions

You can view and print reports only for those sites for which you have security access.

Date Restrictions

For reports whose wizard includes a Date Range screen:

• If you select weekly or monthly granularity, the Start Date and End Date selectors may be
constrained to particular days (to the week's start and end days, or to the selected month's first and
last days).

• If you enter dates that do not match these constraints and click Next, an error message alerts you to
change your selection.
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Actual Overhead Report
To create an Actual Overhead Report:

1. On the Reports tab, select Performance Reports from the Views menu.
2. Select Actual Overhead Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
4. Optional: To export the report to a file in the comma-separated values format, select the check box

Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management
(WFM) to print reports that you created in ".csv friendly format," because the result may be truncated.
To print the file correctly, open it in a program that reads the .csv format, and then print it.

5. Click Next.
6. On the Date Range screen, select a Granularity and a corresponding Start and End Date. (Your

Granularity selection may restrict your Date selections.)
7. You can display staffing totals in Full Time Equivalent (FTE) or man-hours mode in this report by

selecting the mode in the report wizard. Select the mode by checking or unchecking the Show
staffing totals information in man hours instead of FTE option. The default value of this option
will be the same as the settings in Changing the Staffing Display from FTE to Man Hours.

8. Click Next.
9. On the Data screen, select the sites that you want to include in the report's data.

You can expand business units to display their sites. You can make multiple selections.
10. Click Finish.

The report appears in the Report Viewer.

Understanding the Actual Overhead Report

Site or Business Unit [header] The name and time zone of the site or business
unit.

Date [header] The dates that you selected in the Reports Wizard.

Timestep/Day/Week of/Month/X Weeks The time periods shown in this column correspond
to the granularity that you selected in the wizard.

Forecast

Calculated Staffing Calculated Staffing taken from Master Forecast on
selected time period.

% Planned Forecasted Total Planned Overhead for selected site
on selected period.

% Unplanned Overhead Forecasted Total Unplanned Overhead for selected
site on selected period.
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Schedule

Coverage The scheduled staffing coverage for an activity or
multi-site activity.

% Planned Overhead
The percentage of time that the agent is scheduled
for Schedule State Groups defined as Planned
Overhead.

% Unplanned Overhead
The percentage of time that the agent is scheduled
for Schedule State Groups defined as Unplanned
Overhead.

Total/Average [footer]
The total or average for each statistic, over the
report's displayed period. Displayed in Full-Time
Equivalents (FTEs).
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Workforce Performance Report
To create a Workforce Performance Report:

1. On the Reports tab, select Performance Reports from the Views menu.
2. Select Workforce Performance Report from the list in the Objects pane. The Reports Wizard's first

screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management
(WFM) to print reports that you created in ".csv friendly format," because the result may be truncated.
To print such a file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. On the Date Range screen:

a. Select a Granularity and a corresponding Start and End Date. (Your Granularity selection may
restrict your Date selections.)

b. Enter a Percentage of Deviation Threshold. (Periods whose actual values differ from the planned
values by more than this percentage are listed as noncompliant.)

c. Select a time zone.
d. Select Activity, Site, Activity Group, Multi-site Activity, or Business Unit from the drop-down

list.
e. Click Next.

6. On the Data screen, select the targets that you want to include in the report's data.
This page's tree displays activities, sites, activity groups, multi-site activities, or business units
(depending on your choice of target). If you selected a target other than business unit, the tree's
business units expand to display their contents. You can make multiple selections.

7. Click Finish. The report appears in the Report Viewer.

Understanding the Workforce Performance Report
Root/Site [header] The name and time zone of the target or site.

Target/Activity or Site [header]
The report is organized by activity, site, business
unit, or multi-site activity, depending on the target
that you selected in the Reports Wizard.

Date/Date Period The date or date period selected in the wizard.

Timestep / Day / Week of / Month / X Weeks of Time periods, corresponding to the granularity that
you selected in the wizard.

Actual The actual staffing for each timestep.
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Calculated

The calculated staffing for each timestep. The
report shows the calculated value, the difference
between calculated and actual values (that is,
calculated minus actual), and the difference
expressed as a percentage.

Required

The required staffing for each timestep. The report
shows the required value, the difference between
required and actual values (that is, required minus
actual), and the difference expressed as a
percentage.

Headcount

The scheduled staffing for each timestep. The
report shows the scheduled value, the difference
between scheduled and actual values (that is,
scheduled minus actual), and the difference
expressed as a percentage.

Deviation [footer]
The number of compliant periods. To be compliant,
a period's actual values must differ from planned
values by less than the Percentage of Deviation
Threshold that you set in the wizard.

Deviation % The percentage of compliant periods.
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Contact Center Performance Report
To create a Contact Center Performance Report:

1. On the Reports tab, select Performance Reports from the Views menu.
2. Select Contact Center Performance Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management
(WFM) to print reports that you created in ".csv friendly format," because the result may be truncated.
To print such a file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. On the Date Range screen:

a. Select a Granularity and a corresponding Start Date and End Date. (Your Granularity selection may
restrict your Date selections.)

b. Select a time zone.
c. Select the Target type – activity, activity group, multi-site activity, site, business unit – for which you

want the report generated. If you select multi-site activity or business unit, the following check box
appears: Use Multi-site Activities. Leave checked to aggregate report data by multi-site
activities.

d. Click Next.

6. On the Data screen, select the targets that you want to include in the report's data.
This page's tree displays activities, sites, multi-site activities, or business units (depending on your
choice of target). If you selected a target other than business unit, you can expand the tree's business
units to display their contents. You can make multiple selections.

7. Click Next.
8. On the Performance Data Types screen, select the Data Types (statistics) that you want to include.
9. Click Finish.

The report appears in the Report Viewer.

In addition to actual and scheduled data, the Contact Center Performance Report now includes
forecast-related data. You can select the granularity (15, 30 or 60) and select Calculated or
Required forecast values.

Understanding the Contact Center Performance Report
Root/Site [header] The name and time zone of the target or site.
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Target/Activity or Site [header]
The report is organized by activity, site, business
unit, or multi-site activity, depending on the target
that you selected in the Reports Wizard.

Date or Date Period The date or date period that you selected in the
wizard.

Timestep / Day / Week of / Month / X Weeks of The time periods shown in this column correspond
to the granularity that you selected in the wizard.

Coverage

The scheduled and optimal coverage per period,
the scheduled coverage minus the optimal
coverage, the difference as an absolute value, and
the difference as a percentage.

See also Variance, where the calculation for optimal staffing
(another name for optimal coverage) is described.

Headcount
The scheduled and actual agents per period, the
scheduled number minus the actual number, and
the difference as a percentage.

Interaction Volumes
The forecast and actual interaction volume per
period, the forecast minus the actual, and the
difference as a percentage.

AHT
The forecast and actual average handling time per
period, the forecast minus the actual, and the
difference as a percentage.

Service Level The scheduled and actual service level per period.

Deferred Service Level The deferred scheduled and actual service level per
period.

Queue The scheduled and actual number of interactions in
the backlog queue at the end of the period.

ASA The scheduled and actual average speed of answer
for each period.

Abandoned (%) The percentage of scheduled and actual abandons
per period.

Total/Average [footer]

The value for Interaction volume is calculated as
the sum of values in each timestep.
The value for all other Data Types is calculated as the average
of values in each timestep.
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Contact Center Performance Graphs Report
To create a Contact Center Performance Graphs Report:

1. On the Reports tab, select Performance Reports from the Views menu.
2. Select Contact Center Performance Graphs Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. To print a header on the report, select Show Header and type your header text into the text box. Then

(whether you entered a header or not) click Next.
4. On the Date Range screen:

a. Select a Granularity and a corresponding Start Date and End Date. (Your Granularity selection may
restrict your Date selections.)

b. Select a time zone.
c. Click Next.

5. On the Data screen, select the activities that you want to include in the report's data.
You can expand business units to display their sites, and expand sites to display their activities. You can
select any combination of activities from multiple sites.

6. Click Next.
7. On the Performance Data Types screen, select the Data Types (statistics) that you want to include.
8. Click Finish.

The report appears in the Report Viewer.

Understanding the Contact Center Performance Graphs Report

In addition to actual and scheduled data, the Contact Center Performance Graphs Report now
includes forecast-related data. You can select the granularity (15, 30 or 60) and select Calculated or
Required forecast values.

Site [header] The site's name and time zone.
Activity [header] The report is organized by activity.

Date or Date Period [header] The date or date period that you selected in the
Reports Wizard.

Planned/Actual [legend] Indicates how the report displays forecasted and
actual data.

Graph Type
The graph's vertical axis identifies the displayed
statistic (Interaction Volumes, Average Handling
Time, or Number of Agents), and labels its units.

Timestep / Day / Week of / Month / X Weeks
of

The graph's horizontal axis labels the time period
covered by each of the graph's bars. The periods
depend on the granularity that you selected in the
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wizard.
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Schedule Reports

Schedule reports display detailed schedule settings, in tabular and/or graph formats. (For a complete
list of all WFM reports, see the Reports List.) The Schedule reports are:

• Schedule States Report
• Schedule State Totals Report
• Individual Schedule Report
• Team Schedule Report
• Weekly Schedule Report
• Activity Weekly Schedule Report
• Team Weekly Schedule Report
• Weekly Schedule Coverage Report
• Scheduled Budget Report
• Agent Comments Report
• Schedule Validation Report
• Schedule Trade Report
• Schedule Summary Report
• Schedule Marked Time Report
• Schedule Marked Time Totals Report
• Schedule Bidding Report

To create a report, click that report's link (above) and follow the steps.

Report Security Restrictions

You can view and print reports only for those sites for which you have security access.

Creating a Report

1. In the Modules tree, click Reports (to expand the report categories); then click a category.
A list of the selected category's reports appears in the working pane and in the Objects
tree.

2. From either list, select the report that you want:
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• Click a report's name in the working pane.
• Or click the report's name in the Objects tree.

After you select a report, the Reports Wizard's first page (Header Page) appears.
3. To print a header on the report, select Show Header and type your header text into the text box.
4. Click Next.
5. Select the objects, dates, or other options that you want to include in the report.

The number of screens that follow the first one depends on the report you are creating.
• Click Next after making your selections on each intermediate screen.
• Make your selections on the final screen (which has a Finish button).

6. Click Finish.
A Progress message box appears. You can click Cancel to interrupt the report's generation.

When the report has been generated, the Report Viewer appears to display it. The report is also
added to the Objects tree so that you can review it later.

Tip
For detailed explanations of what is displayed in each report, click the name of the
report in the bullet list above.

Date Restrictions

For reports whose wizard includes a Date Range screen:

• If you select weekly or monthly granularity, the Start Date and End Date selectors may be
constrained to particular days (to the week's start and end days, or to the selected month's first and
last days).

• If you enter dates that do not match these constraints and click Next, an error message alerts you to
change your selection.

• If you select intra-day granularity, the End Date selector is disabled.
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Schedule States Report
To create a Schedule States Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Schedule State Totals from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result may be truncated. To print
the file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. On the Scenarios screen, select a schedule scenario or the Master Schedule and then click Next.

You will not see this screen if the report is created from the Report Scheduler, because the report data
is retrieved from the Master Schedule.

6. On the Date Range screen, select Start and End Dates and Times for the report.
Optional: You can check the Show filter on the first page of the report only check box, then click
Next.

Tip
You can select fewer weeks than are defined in the scenario that you selected in step 5.

7. On the first Data screen, select teams and/or agents.
You can expand business units to display their sites, and expand sites to display their teams and
agents. You can select any combination of teams and/or agents from multiple sites.

8. Click Next.
9. On the second Data screen, select schedule state groups and states.

You can expand business units to display their sites, and expand sites to display their schedule state
groups and schedule states. You can select multiple schedule states across different sites.

Important
Schedule states that do not belong to any schedule state group are missing from this display, but you can
include them in the report by selecting the site that includes them.

10. Click Finish.
The report appears in the Report Viewer.
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Understanding the Schedule States Report
Site [header] The site name and time zone.

Selected Schedule State Groups and
Schedule States [header]

A comma-separated list of the schedule state
groups and schedule states that were selected in
the wizard, and are applicable to the selected site.

Team [header] Agents are displayed by team.

Date and Time Period [header] The dates covered by the report, and time period
covered each day.

Employee ID The agent's company ID.
Agent The agent whose information is displayed.

Date The date on which the schedule state’s shift
begins.

Schedule State The name of the schedule state.
Start Time The schedule state start time.
End Time The schedule state end time.
Duration The duration of each schedule state.
Paid Hours The paid hours for each schedule state.

Total Duration/Paid Hours for Agent
(not labeled)

This total appears beneath the statistics for each
agent.
Duration: The total duration of all the agent's schedule states
during the time range covered by the report.
Paid Hours:The total paid hours for all the agent's schedule
states during the time range covered by the report.

Total Duration/Paid Hours for Team

This total appears at the end of the report.
Duration: The total duration of all selected agents on each
selected team.
Paid Hours: The total paid hours of all selected agents on each
selected team.

Total Duration/Paid Hours for Site

This total appears at the end of the report.
Duration: The total duration of all selected agents from all
selected teams on the site.
Paid Hours: The total paid hours of all selected agents from all
selected teams on the site.

Tip
The duration of full-day time off and full-day exceptions in the report are computed
according to these rules:

• The duration of paid, full-day time-off items and exceptions are equal to Paid Time.
• The duration of unpaid, full-day time-off items and exceptions are equal to Standard
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Daily Paid Hours from the agent's contract.
If the Start Time and End Time values are specified for time-off items and exceptions, the duration is
estimated as the difference between those values.

In Genesys Administrator, if the Reports > TotalsInStatesReport property is set to
true WFM uses the daily totals for calculations.
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Schedule State Totals Report
To create a Schedule State Totals Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Schedule State Totals from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management
(WFM) to print reports that you created in ".csv friendly format," because the result may be truncated.
To print the file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. On the Scenario screen, select a schedule scenario or the Master Schedule and then click Next.

You will not see this screen if the report is created from the Report Scheduler, because the report data
is retrieved from the Master Schedule.

6. On the Date Range screen, select a Granularity and a corresponding Start and End Date. (Your
Granularity selection may restrict your Date selections.) Then click Next.

7. On the Target screen, select Agent, Team, or Site from the drop-down list. Then click Next.
8. On the Options screen, check the Exclude Date Without State and Show filter on the first page

of the report only check boxes, if required, then click Next.
9. On the first Data screen, select the targets (agents, teams, or sites) to include in the report.

You can expand business units to display their sites. If you selected Team or Agent in the Target Page,
you can further expand the tree's branches. You can select across multiple sites.

10. Click Next.
On the second Data screen, select the schedule states to include.

11. Click Finish.
The report appears in the Report Viewer.

Understanding the Schedule State Totals Report

The report takes one of two forms, depending on the target that you selected.

The Site Schedule State Totals Report
Enterprise [header] The enterprise covered by the report.

Business Unit [header] The name of each business unit included in the
report.

Date Period [header] The time range covered by the report.

Reports Schedule Reports

Workforce Management Web for Supervisors Help 809



Selected Schedule State Groups and
Schedule States [header]

The schedule state groups and schedule states
covered by the report.

Site The name of each site included in the report.

Total Duration for Business Unit
The combined time that all the business unit's
agents spent in the selected schedule states, over
the report date range.

The Team Schedule State Totals Report

Business Unit [header] The name of each business unit included in the
report.

Site [header] The name and time zone of the site.
Date Period [header] The time range covered by the report.
Selected Schedule State Groups and
Schedule States [header]

The schedule state groups and schedule states
covered by the report.

Team The name of each team included in the report.
Day Each matching date in the selected date range.

Duration The time each agent spent in the selected schedule
states, for each day included in the report.

Total Duration [per Agent] The total time each agent spent in the selected
schedule states, over the report's date range.

Total Duration for Site
The combined time that all the site's agents spent
in the selected schedule states, over the report's
date range.

Total Duration for Team
The combined time that all the team's agents spent
in the selected schedule states, over the report's
date range.

Tip
The durations of full-day time off and full-day exceptions in the report are computed according to these
rules:

• If the start and end are specified or estimated by WFM Server, then the duration is the
difference between the end and start values.

• If the start and end are not specified or estimated:
• The durations of paid full-day time off and exceptions are equal to paid time.
• The durations of unpaid full-day time off and exceptions are equal to Standard

Daily Paid Hours from the agent's contract.
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Individual Schedule Report
To create an Individual Schedule Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Individual Schedule from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result may be truncated. To print
the file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. On the Scenario screen, select a schedule scenario or the Master Schedule. Then click Next.

You will not see this screen if the report is created from the Report Scheduler, because the report data
is retrieved from the Master Schedule.

6. On the Date Range screen, select a Start and End date for the report. Then click Next.
7. On the Data screen, select the agent(s) for whom to generate the report.

You can expand business units to display their sites, teams, and agents.
8. Click Finish.

The report appears in the Report Viewer.

Understanding the Individual Schedule Report
Site [header] The site's name and time zone.
Team [header] The selected agent's team.
Agent [header] The selected agent's name.
Date Period [header] The total date range covered by the report.
Employee ID The agent's company ID.
Day The date for each information set.

Paid Hours Total number of paid hours the agent works on
each displayed day.

Schedule State The agent's schedule states on each displayed day.

Start Time The time at which the agent is scheduled to start
each scheduled state.

End Time The time at which the agent is scheduled to end
each scheduled state.
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Team Schedule Report
To create a Team Schedule Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Team Schedule from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result may be truncated. To print
the file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. On the Scenario screen, select a schedule scenario or the Master Schedule. Then click Next.

You will not see this screen if the report is created from the Report Scheduler, because the report data
is retrieved from the Master Schedule.

6. Optionally, click the Sort by shift start check box. Then click Next.
7. In the Date Range Page, select a Start and End date for the report. Then click Next.
8. On the Data screen, select the team(s) for which to generate the report.

You can expand business units to display their sites and teams.
The report is sorted in alphabetical order by business unit, site name within each business unit, and
team name.

9. Click Finish.
The report appears in the Report Viewer.

Understanding the Team Schedule Report
Site [header] The site's name and time zone.
Team [header] The team covered by the report.
Date Period [header] The date period covered by the report.

Day [header] The report is organized day-by-day. This line
identifies the first displayed date.

Agent The name of each of the team's agents.

Total Hours The agent's total hours (paid hours plus unpaid
hours) for the day.

Paid Hours The agent's paid hours for the day.

Effective Hours
The hours during which the agent is paid and
working. (Activity work is included, but breaks are
not.)
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Schedule State Schedule state and activity set information.

Start Time The time at which the agent is scheduled to start
each scheduled state.

End Time The time at which the agent is scheduled to end
each scheduled state.
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Weekly Schedule Report

Important
You can view this report only if you have the Weekly Schedule Report security
permission. See the Configuration > Roles topics for more information about security
privileges.

To create a Weekly Schedule Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Weekly Schedule Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result may be truncated. To print
the file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. On the Scenario screen, select a schedule scenario or the Master Schedule. Then click Next.

You will not see this screen if the report is created from the Report Scheduler, because the report data
is retrieved from the Master Schedule.

6. On the Data screen, select the elements to include in the report.
This screen's tree displays a hierarchical tree of business units, sites, teams and agents. You can
expand each of the tree's elements to display its contents. You can make multiple selections.

7. On the Date Range screen, select a date range by one of two methods:
• Select a Start and End Date.

Important
If you selected the Master Schedule in step 5, you can select any number of weeks.
If you selected a different schedule in step 5, you can select any number of weeks – up to the total
number of weeks which are defined in that scenario.

• Select the check box Planning Period (not checked by default) to specify a planning period or
week range.

8. Also on the Date Range screen, select a data type from the radio button group Data Type To Show to
specify what will appear in the report. The possible values are: Shift Start/End times, Total Paid
Hours, and Shift or Schedule State Names.
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9. Click Finish.
The report appears in the Report Viewer.

Understanding the Weekly Schedule Report

Site [header] The name and time zone of the business unit or
site.

Team [header] Agents are displayed by team.
Date Period [header] The total date range covered by the report.
Planning Period [header] The total planning period covered by the report.
Employee ID The agent's company ID.
Agent The agent's name.
Weekdays Columns for each day of the week.
Paid Hours The agent's paid work hours per week.
Effective Hours The agent's effective work hours per week.

Non-Effective Hours
The agent's noneffective work hours per week (that
is, hours during which the agent is paid but not
working, such as during paid breaks and paid days
off).

Planning Period Paid Hours The agent's paid work hours per planning period.
Totals for Paid Hours [row] Total of the Paid Hours column.
Totals for Effective Hours [row] Total of the Effective Hours column.
Totals for Non-Effective Hours [row] Total of the Non-effective Hours column.
Totals hours for each week day [row] Total of the Weekdays columns.

Presentation

The information in the finished report is grouped under the following headings:
Enterprise
Business Unit Name
Site Name
Team Name

Agent Name

Reports Schedule Reports

Workforce Management Web for Supervisors Help 815



Activity Weekly Schedule Report
To create an Activity Weekly Schedule Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Activity Weekly Schedule from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result may be truncated. To print
the file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. On the Scenario screen, select a schedule scenario or the Master Schedule. Then click Next.

You will not see this screen if the report is created from the Report Scheduler, because the report data
is retrieved from the Master Schedule.

6. Fill in the Date Range screen.
a. Select a Start and End Date for the report.

You can select multiple weeks for the report output, but your selection must be full weeks.
b. Select Show Required Staffing, if required.
c. In the Data Type to Show screen, select the Start/End times, Total Paid Hours, or Shift or

Schedule State Names option, as required.
d. Click Next.

7. Display staffing totals in Full Time Equivalent (FTE) or man-hours mode in this report by selecting the
mode in the report wizard. Select the mode by checking or unchecking the Show staffing totals
information in man hours instead of FTE option. The default value of this option will be the same
as the settings in Changing the Staffing Display from FTE to Man Hours.

8. On the Data screen, select the activity or activities for which to generate the report.
You can expand business units to display their sites and activities.

9. Click Finish.
The report appears in the Report Viewer.

Understanding the Activity Weekly Schedule Report
Site [header] The site's name and time zone.
Activity [header] The activity that is covered by the report.

Date Period [header] The date range that you selected in the Reports
Wizard.

Reports Schedule Reports

Workforce Management Web for Supervisors Help 816



Scheduled FTEs The number of agents (full-time equivalents)
scheduled for the activity on the selected days.

Calculated FTEs The number of agents (full-time equivalents) in the
calculated staffing for the activity.

Difference The difference between calculated and scheduled
FTEs.

Required FTEs
The number of agents (full-time equivalents) in the
required staffing for the activity. This row and the
next appear if you selected the Show Required
Staffing check box.

Difference The difference between required and scheduled
FTEs.

Agent The agent's name.
ID The agent's identification number.

Days
Multiple columns display the agent’s start/end
times (or paid hours, if Paid Hours check box was
selected) for each weekday of the report period.

Weekly Work Hours–Paid The agent's paid work hours per week.
Weekly Work Hours–Eff. The agent's effective work hours per week.

Weekly Work Hours–NonEff.
The agent's noneffective work hours per week (that
is, hours during which the agent is paid but not
working, such as during paid breaks and paid days
off).

Total Hours
The total number of paid-hours spent by all agents
scheduled to work under the activity during the
day. This row includes a total for each day, and a
weekly total for each paid-hours category.

Total Paid Hours The team's paid work hours per week.
Total Effective Hours The team's effective work hours per week.
Total Non-Effective Hours The team's noneffective work hours per week.

Total Hours for each week day The team's paid work hours, for each day, per
week.

Footnote Indicates that the agent worked on a different
activity during the specified time.

Presentation

The information in the finished report is grouped under the following headings:
Enterprise
Business Unit
Site
Week date range
Team
Activity
Agent
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Team Weekly Schedule Report
To create a Team Weekly Schedule Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Team Weekly Schedule from the list in the Objects pane.

The Reports Wizard's first screen, Header, appear.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result may be truncated. To print
the file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. On the Scenario screen, select a schedule scenario or the Master Schedule. Then click Next.

You will not see this screen if the report is created from the Report Scheduler, because the report data
is retrieved from the Master Schedule.

6. Fill in the Date Range screen:
a. Select a Start and End date for the report. You can select multiple weeks for the report output, but

your selection must be full weeks.
b. In the Data Type to Show screen, select a data type: Start/End Time, Paid Hours, or Shift or

Schedule State Names, as required.
c. Click Next.

7. On the Data screen, select the team(s) for which to generate the report.
You can expand business units to display their sites and teams.

8. Click Finish.
The report appears in the Report Viewer.

The report is sorted in alphabetical order by business unit, site name within each business unit, and
team name.

Understanding the Team Weekly Schedule Report
Site [header] The site's name and time zone.
Team [header] The team covered by the report.

Date Period [header] The date range that you selected in the Reports
Wizard.

Activity Each activity performed by agents on the selected
team. The report is organized by activity name.

Agent Each agent scheduled to work on the indicated
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activity.
ID Each agent's identification number.
Day Each day of the week.
Weekly Work Hours–Paid The number of paid hours per week for each agent.

Weekly Work Hours–Eff. The number of effective hours per week for each
agent. (Excludes paid breaks and paid days off.)

Weekly Work Hours–NonEff.
The number of noneffective hours per week for
each agent. (Paid non-working hours, such as paid
breaks and paid days off.)

Total Hours
The total number of paid hours worked by the
entire team if it had agents scheduled to work at
the activity during the day (for the daily total) and
the week (for the weekly total).

Footnote

Indicates that the agent worked on a different
activity during the specified time. The footnote
appears in a format similar to this: ( ) - Agent
Works on the other Activity, indicating that the
"different" activity these agents are working on is
enclosed in brackets in the report.

Presentation

The information in the finished report is grouped under the following headings:
Enterprise
Business Unit
Site
Week date range
Team
Activity
Agent
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Weekly Schedule Coverage Report
To create a Weekly Schedule Coverage Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Weekly Schedule Coverage from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result may be truncated. To print
the file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. On the Scenario screen, select a schedule scenario or the Master Schedule. Then click Next.

You will not see this screen if the report is created from the Report Scheduler, because the report data
is retrieved from the Master Schedule.

6. On the Date Range screen:
a. Select a Start Date and an End Date in the Data Range pane.
b. Select Show Required Staffing or Calculated Staffing in the Options pane.
c. Select one: Activity, Site, Multi-site Activity, or Business Unit from the drop-down list in the

Target pane.
d. Click Next.

7. Display staffing totals in Full Time Equivalent (FTE) or man-hours mode in this report by selecting the
mode in the report wizard. Select the mode by checking or unchecking the Show staffing totals
information in man hours instead of FTE option. The default value of this option will be the same
as the settings in Changing the Staffing Display from FTE to Man Hours.

8. On the Data screen, select the targets to include in the report.
This page's tree displays activities, sites, multi-site activities, or business units (depending on your
selection on the Target screen). If you selected a target other than business unit, the tree's business
units expand to display their contents. You can make multiple selections.

9. Click Finish.
The report appears in the Report Viewer.

Understanding the Weekly Schedule Coverage Report

Site [header] The name and time zone of the business unit or
site.

Activity or Site [header] The name of the activity or site whose information
appears in the table.
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Date Period [header] The total date range covered by the report.
Timestep The data is displayed timestep-by-timestep.
Days Columns for each day of the week.

Calculated/Required
The calculated or required staffing per timestep.
(These columns appear if you selected Show
Required Staffing and/or Calculated Staffing in
the Reports Wizard.)

Scheduled The effective number of agents that are scheduled
for this activity for this timestep.

Difference The difference between the calculated/required and
scheduled staffing.

Total Hours [row] The total full-time-equivalent person-hours for each
day.

Tip
When the forecast for an Activity is absent, the default value for paid hours per day (a
parameter used for FTE calculations) is 1 hour.
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Scheduled Budget Report
To create a Scheduled Budget Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Scheduled Budget Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result may be truncated. To print
the file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. On the Scenario screen, select a schedule scenario or the Master Schedule. Then click Next.

You will not see this screen if the report is created from the Report Scheduler, because the report data
is retrieved from the Master Schedule.

6. On the Date Range screen, select a Start and End Date. Then click Next.
7. On the Data screen, select the team(s) for which to generate the report.

You can expand business units to display their sites and teams.
8. Click Finish.

The report appears in the Report Viewer.

Understanding the Scheduled Budget Report
Site [header] The site's name.
Team [header] The report is organized team-by-team.
Date Period [header] The total time period covered by the report.

Day [headers] For each team, the report displays budget
information day-by-day.

Agent The name of each agent on the team.

Regular Budget The agent's pay for regular work hours on the
given day, based on the agent's hourly wage.

Overtime Budget The agent's pay for overtime work hours on the
given day, based on the agent's hourly wage.

Total Budget The agent's total pay for the given day.
Number of Agents Number of agents on the team.

Total Per Day [row] The entire team's total regular, overtime, and total
budgets for the given day.

Total for Team [row] The team's total regular, overtime, and total
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budgets for the whole selected date range.
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Agent Comments Report

Tip
This report presents information only for agents and days that have comments
entered. The report is not generated if there are no agent comments in the schedule
on the specified dates.

To create an Agent Comments Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Agent Comments Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. To print a header on the report, select Show Header and type your header text into the text box. Then

(whether you entered a header or not) click Next.
4. On the Scenario screen, select a schedule scenario or the Master Schedule. Then click Next.

You will not see this screen if the report is created from the Report Scheduler, because the report data
is retrieved from the Master Schedule.

5. On the Date Range screen, select a Start and End Date. Then click Next.
6. On the Data screen, select the agents that you want to include in the report.

You can expand business units to display their sites, teams, and agents. You can select multiple agents
across teams and sites. You can also select whole teams or sites.

7. Click Finish. The report appears in the Report Viewer.

Understanding the Agent Comments Report
Site [header] The name of the site.
Team [header] Agent information is displayed team-by-team.
Date Period [header] The total date range covered by the report.
Day [header] The date to which each group of comments applies.
Agent The name of each agent.

Comments Any comments about the agent entered in the
Daily Schedule window.
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Schedule Validation Report
To create a Schedule Validation Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Schedule Validation Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. To print a header on the report, select Show Header and type your header text into the text box.
4. Click Next.
5. On the Scenario screen, select a schedule scenario or the Master Schedule.
6. Click Finish.

The report appears in the Report Viewer.

Understanding the Schedule Validation Report

This report provides a printable, searchable format in which to view generated Schedule Validation
warnings. You can browse the same warnings in the Review Messages window.

For more information about these warnings, see Schedule Validation.
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Schedule Trade Report
To create a Schedule Trade Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Schedule Trade Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result may be truncated. To print
the file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. On the Date Range screen, select a Start and End Date.
6. In the Data Type section, select each trade status that you want to include in the report. Clear the

check boxes for each status that you want to omit. Then click Next.
7. In the Sort Options screen, select one of two ways to sort the report data, by Agent name or by

Date.
8. On the Data screen, select the agents that you want to include in the report.

You can expand business units expand to display their sites, teams, and agents. You can select multiple
agents across teams. You can also select whole teams or a whole site.

9. Click Finish.
The report appears in the Report Viewer.

Understanding the Schedule Trade Report
Site [header] The site's name and time zone.

Date Period [header] The date range that you selected in the Reports
Wizard.

Proposer: Team, Name The team and name of the agent proposing each
trade.

Respondent: Team, Name The team and name of the agent responding to
each trade proposal.

Trade: Days The dates included in each trade proposal.

Status
The status of each trade proposal. (If you cleared a
status on the Reports Wizard's Schedule Trade
States screen, trades with that status do not
appear in the report.)

Transaction Date The date on which the trade proposal entered its
current status.
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Approved By / Declined By
The supervisor who approved or declined the trade
proposal, or "Auto-Approved" / "Auto-Declined" if it
was done by the system.

Comments Any comments attached by the supervisor who
acted on the trade proposal.
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Schedule Summary Report
To create a Schedule Summary Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Schedule Summary Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result may be truncated. To print
the file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. On the Scenarios page, select a schedule scenario or the Master Schedule. Then click Next.

You will not see this screen if the report is created from the Report Scheduler, because the report data
is retrieved from the Master Schedule.

6. On the Date Range page:
a. Select the radio button for the granularity you want.

If you select Intraday, the report shows the data for one 24-hour period in timesteps. Use the drop-
down box to specify timestep granularity: 15 (default), 30, or 60 minutes.

b. If you selected [X]-weeks granularity, next select the number of weeks to include. You can
generate the report for any number of weeks between one and six. This option is unavailable if you
selected any granularity other than weeks.

c. Enter the date range you want displayed in the report. If you have selected to generate the report
for a schedule scenario, the dates must fall within the scenario period.

d. Select the Target type—activity, multi-site activity, activity group, site, business unit—for which you
want the report generated. If you select multi-site activity or business unit, the following check box
appears: Use Multi-site Activities. Leave checked to aggregate report data by multi-site
activities.

e. Click Next.

7. Display staffing totals in Full Time Equivalent (FTE) or man-hours mode in this report by selecting the
mode in the report wizard. Select the mode by checking or unchecking the Show staffing totals
information in man hours instead of FTE option. The default value of this option will be the same
as the settings in Changing the Staffing Display from FTE to Man Hours.

8. On the Data page, select the specific objects that you want to view. Depending on your choice of object
type, you can choose to view the enterprise, business units, sites, or activities. Not all options are
available for all object types.
If you select Activity, the tree contains the enterprise, business units (if applicable), activity groups (if
applicable), sites, and activities. If you select Site, the tree contains the enterprise, business units (if
applicable), activity groups (if applicable), and sites. If you select Business Unit, the tree contains the
enterprise and business units. You can generate the report for only the enterprise, one business unit,
one site, or one activity.

9. On the Statistics page, select the statistics that you want to include in the report by clicking the check
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box next to each statistic. You can select up to 18 items from the list. For descriptions of these
statistics, see WFM Metrics in the Workforce Management Administrator's Guide.
The list of statistics includes these categories:
• Headcount
• Service Level
• Interaction Volume
• AHT
• Budget
• Staffing
• Difference
• Coverage
• ASA
• Occupancy

For each category, there is one or more of these metrics:

• Sch. (Scheduled)
• Frc. (Forecast)
• Diff. (Difference)
• Calc. (Calculated)
• Req. (Required)
• Publ. (Published)

If Master was selected on the Scenario screen, the check boxes Coverage Publ. and Coverage Diff.
are enabled and selected by default. This latter column displays the difference between schedule
coverage based on the current Master Schedule and schedule coverage based on the baseline Master
Schedule.

10. Click Finish.
The report appears in the Report Viewer.

Understanding the Schedule Summary Report

Site Information or Business Unit
Information or Enterprise [header]

The site's name and time zone, if you selected activity as
the report's target.
The business unit's name and time zone, if you selected multi-site
activity or site as the report's target.
The enterprise, if you selected business unit as the report's target.
(Each root is displayed separately.)

Activity, Multi-Site Activity, Site, or
Business Unit [header]

The report is organized by activity, multi-site activity,
site, or business unit— depending on the target that you
selected in the Reports Wizard.

Date/Date Period [header] The dates covered by the report. The report displays
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separate information for each target and date. This
header shows the Date if you selected Intra-day
granularity and Date Period for other granularities.

Time Step, Day, Week Of, X Weeks of,
Month

The time period shown. The header and the column
contents depend on the granularity that you selected.

Coverage [Scheduled] The scheduled staffing coverage.
Headcount [Scheduled] The number of agents scheduled.

Service Level Percentage Scheduled
The service level percentage that can be achieved given
the staffing coverage, assuming that other planned
metrics (such as interaction volumes and Average
Handling Time) remain unchanged.

Service Level Percentage Forecasted

The service level percentage that can be expected to be
achieved based on the number of agents forecasted.
This may differ from the original service level objective that was stated
when the staffing forecast was built due to agent rounding. For
example, WFM may forecast a staffing requirement of 12 agents to
meet a service level objective of 80% of interactions answered within 20
seconds, but Service Level Percentage Forecast may report a higher
number, such as 83.48%. This is because 12 was the minimum number
of agents required to meet the 80% service level objective but, with
that number of agents, the contact center can be expected to achieve a
slightly better service level than 80%. With one less agent (11 agents),
the contact center would not be expected to achieve the 80% service
level.

Deferred Service Level Percentage
Scheduled

The deferred service level percentage that can be
achieved given the staffing coverage, assuming that
other planned metrics (such as interaction volumes and
Average Handling Time) remain unchanged.

Deferred Service Level Percentage
Forecasted

The deferred service level percentage that can be
expected to be achieved based on the number of agents
forecasted.

Interaction Volume Scheduled The number of interactions that can be handled based on
the schedule coverage.

Interaction Volume Forecasted
The expected number of interactions, according to the
Master Forecast—assuming that other planned metrics
remain unchanged.

AHT Scheduled
The Average Handling Time per interaction, based on the
schedule—assuming that other planned metrics remain
unchanged.

AHT Forecasted The expected Average Handling Time, according to the
Master Forecast.

Budget Scheduled
The budget for the scheduled coverage for the selected
day and target, based on the scheduled agents' paid
hours and wages.

Budget Forecasted
The budget for the calculated staffing for the selected
day and target, based on the full-time-equivalent (FTE)
paid hours per day and salary specified in the scenario.

Staffing Calculated
The required number of agents as calculated by WFM,
based on the forecasted interaction volumes, AHT, and
applicable service objectives.
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Staffing Required
The required number of agents defined by the user,
either by explicitly entering forecast targets or by using a
template.

Difference Calculated The difference between Coverage [Scheduled] and
Staffing Calculated.

Difference Required The difference between Coverage [Scheduled] and
Staffing Required.

Coverage Publ. The published staffing coverage.

Coverage Diff.
The difference between schedule coverage based on the
current Master Schedule and schedule coverage based on
the baseline Master Schedule.
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Schedule Marked Time Report
To create a Schedule Marked Time Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Schedule Marked Time Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result may be truncated. To print
the file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. On the Scenarios screen, select a schedule scenario or the Master Schedule. Then click Next.

You will not see this screen if the report is created from the Report Scheduler, because the report data
is retrieved from the Master Schedule.

6. On the Date Range screen:
a. In the Date Range section, select Start and End dates for the report. If you selected a scenario on

the previous screen, you cannot select dates outside the scenario date range.
b. In the Time Range section, select Start and End times and check Next Day for End time, if

required.
c. In the Options section, check the Show filter on first page of report only check box, if required.

Then click Next.

7. On the first Data screen, in the Options section, select the enterprise or business units, sites, teams,
or agents you want to see in the report.
You can expand business units to display the sites and expand the sites to view the teams and agents.
You can select any combination of teams and/or agents from multiple sites.

8. Click Next.
9. On the second Data screen, select the marked-time types that you want to be displayed. Marked-time

types are listed under the sites for which they are configured.
10. Click Finish.

The report appears in the Report Viewer.

Understanding the Schedule Marked Time Report
Site [header] The site's name and time zone.
Team [header] Agents are displayed by team.
Date and Time Period [header] The dates covered by the report, and the time
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period covered each day.
Agent The agent whose information is displayed.
Date The date on which the marked time occurs.
Marked Time The name of the marked-time type.
Start Time The marked time's start time.
End Time The marked time's end time.
Duration The duration of each marked-time period.

Paid Hours The number of paid hours covered by the marked-
time period.

Total Duration and Total Paid Hours for Team
The total number of marked-time hours and the
total paid marked-time hours for the team during
the selected report period.
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Schedule Marked Time Totals Report
To create a Schedule Marked Time Totals Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Schedule Marked Time Totals Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
Optional: To export the report to a file in the comma-separated values format, select the check box
Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result may be truncated. To print
the file correctly, open it in a program that reads the .csv format, and then print it.

4. Click Next.
5. On the Scenario screen, select a schedule scenario or the Master Schedule. Then click Next.

You will not see this screen if the report is created from the Report Scheduler, because the report data
is retrieved from the Master Schedule.

6. On the Date Range screen:
a. Select a granularity and a corresponding start and end date. (Your granularity selection may restrict

your date selections.)
b. On the Target pane, select Agent, Team, or Site from the drop-down list.
c. In the Options section, check the Show filter on first page of report only check box, if required.

Then, click Next.

7. On the first Data screen, select the targets (agents, teams, or sites) that you want to include in the
report. Then click Next.
You can expand business units to display their sites. If you selected Team or Agent on the Target
pane, you can further expand the tree's branches. You can select across multiple sites.

8. On the second Data screen, select the marked-time types to include. Then click Finish.
You can expand business units to display their sites, and expand sites to display their marked-time
types. You can select multiple marked-time types across different sites.

The report appears in the Report Viewer.

Understanding the Schedule Marked Time Totals Report

The report takes one of three forms, depending on the target that you selected.

The Site Schedule Marked Time Totals Report

Enterprise [header] The name and time zone of the enterprise in which
this site is included.
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Business Unit [header]
The name of the business unit, if any, to which the
selected site belongs. If the report covers
independent sites, no business unit name appears.

Date Period [header] The time range covered by the report.
Selected Schedule Marked Times [header] The marked time types covered by the report.
Site The name of each site included in the report.
Day Each date in the selected date range.

Duration
The time that this site's agents spent in the
selected marked-time types for each day included
in the report.

Paid Hours The number of the marked-time hours that were
paid.

Total Duration and Total Paid Hours for
Business Unit

The combined time that all the sites spent in the
selected marked-time types over the report's date
range and the number of those hours that were
paid.

The Team Schedule Marked Time Totals Report

Business Unit [header]
The name of the business unit. If the report covers
only independent sites, no business unit name
appears.

Site [header] The name and time zone of the site.
Date Period [header] The time range covered by the report.
Selected Schedule Marked Times [header] The marked-time types covered by the report.
Team The name of each team included in the report.
Day Each matching date in the selected date range.

Duration
The time that each team spent the selected
marked-time types during each day included in the
report.

Paid Hours The number of hours spent in the marked-time
types that were paid.

Total Duration and Total Paid Hours for Site
The combined time that all of the teams in the site
spent in the selected marked-time types during the
report's date range.

The Agent Schedule Marked Time Totals Report

Site [header] The name and time zone of each site included in
the report.

Team [header] The team to which the selected agents belong.
Date Period [header] The time range covered by the report.
Selected Schedule Marked Times [header] The marked-time types covered by the report.

Agent The name of each agent in the team who had
marked time.
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Day Each matching date in the selected date range.

Duration
The time that this team's agents spent in the
selected marked-time types for each day included
in the report.

Paid Hours The number of marked-time hours that were paid
for each day included in the report.

Total Duration and Paid Time for Team
The combined time that all of the team's agents
spent in the selected marked time over the report's
date range, and how many of those hours were
paid.
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Schedule Bidding Report

Important
• You can generate this report only if you have the Schedule Bidding Report security right

(which is granted by default). See the Configuration > Roles topics for more information
about security privileges.

• The scenario that will provide data for the report must have real agents assigned to all
profiles.

• The report displays only bidding candidates, not all Agents and Teams.

To create a Bidding Report:

1. On the Reports tab, select Schedule Reports from the Views menu.
2. Select Schedule Bidding Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. On the Header page, you have two optional choices:

• To print a header on the report, select Show Header and type your header text into the text box.
• To output the report in .csv format, select Create report with .csv friendly format.

Click Next.
4. On the Scenarios page, select the appropriate schedule scenario and click Next.
5. On the Data page, select the appropriate Agents or Teams and click Next.
6. On the Date Range page, select one of three Data Types To Show:

• Shift Start/End Time
• Total Paid Hours
• Shift or Schedule State Names

Select one of two Sort Options: By Agent Name or by Agent's Position.
7. Click Finish.

The report appears in the Report Viewer.

Understanding the Bidding Report
Site [header] The site name and time zone.

Date Range [header] The dates covered by the report, and time period
covered each day.
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Ranking System [header] The type of ranking system used to auto-assign the
shifts.

Agent The agent whose information is displayed.
Team The name of the Agent's team.

Position

The agent’s position in the site, based on the
selected ranking system.
The ranking system can be an agent’s rank or seniority or
combination of rank and seniority. The higher ranked or more
senior (by hiring date) agents get the top positions. The position
is always calculated based on all available site agents and is not
dependent on the pool of agents in the particular bidding
process.

Week The week that is being documented in the same
row.

Bid
Agent’s original bid number for assigned schedule.
Unwanted bids appear in brackets [2]. No value is
display if the agent did not bid.

Days of the Week
Each column (Sun, Mon, Tue, Wed, Thu, Fri, Sat)
displays data of the type specified in Data Type To
Show.

Paid Hours The Total of paid hours for the week.
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Adherence Reports
Adherence reports display adherence statistics at the business unit, site, team, or agent level. If
agents in your site perform work on multiple media channels, you can run adherence reports that
also contain adherence statistics per channel. (For a complete list of all WFM reports, see the Reports
List.)

The Adherence reports are:

• Agent Adherence Report.
• Adherence Totals Report.
• Agent States Report.

Report Security Restrictions

You can view and print reports only for those sites for which you have security access. To create a
report, click that report's link (above) and follow the steps.

Date Restrictions

For reports whose wizard includes a Date Range screen:

• If you select weekly or monthly granularity, the Start Date and End Date selectors may be
constrained to particular days (to the week's start and end days, or to the selected month's first and
last days).

• If you enter dates that do not match these constraints and click Next, an error message alerts you to
change your selection.

• If you select intra-day granularity, the End Date selector is disabled.

Historical Multi-Channel Adherence Data in Reports

The Agent Adherence and Agent States reports contain historical multi-channel data. These WFM
reports include aggregated agent state and channel state data in the same level. If there is no
scheduled state to be mapped to a schedule state group that does not have a specified channel
during a particular time interval, the aggregated agent state is omitted from the returned data for
that interval and WFM returns only channel data. As part of the record corresponding to the
aggregated status, WFM returns only schedule states that map to schedule state groups that do not
have a specified channel. WFM omits the channel data when the channel does not have a real-time
state and there are no schedule states to be mapped to the schedule state group for that channel.
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WFM returns data with one minute granularity, which is the same granularity real-time data is stored
in the database. One record represents data for a single channel or agent-aggregated level data. The
record also contains the start/end date and time, and a list of schedule states. In this way, it is
possible to have multiple events for the same time period. However, these events are not double
counted for report totals.

For more information about the how historical multi-channel adherence data is displayed, see the
section Channel Sub Reports in Agent Adherence Report and Agent States Report.
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Agent Adherence Report
To create an Agent Adherence Report:

1. On the Reports tab, select Adherence Reports from the Views menu.
2. Select Agent Adherence Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
4. Optional: To export the report to a file in the comma-separated values format, select the check box

Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management to
print reports that you created in ".csv friendly format," because the result may be truncated. To print
the file correctly, open it in a program that reads the .csv format, and then print it.

5. Click Next.
6. On the Date Range screen, select a Start date and End date for the report.
7. Optionally, you can select the Display Every Unique Status check box. Select this option if you want

to see every nonadherent status that the agent was in during periods of nonadherence. If you leave
this check box cleared, the report shows only the first of the consecutive nonadherent statuses that
occurred during each schedule state.

8. Optionally, you can also check the Exclude Days Without Shifts check box. In this case, scheduled
days without shifts are not included in the report.

9. Click Next.
10. On the Data screen, select the agent(s) to include in the report.
11. You can expand business units to display their sites, teams, and agents.
12. Click Finish.

The report appears in the Report Viewer.

Understanding the Agent Adherence Report
Site [header] The site's name and time zone.
Team [header] The name of the selected agent's team.

Agent [header] The name of the agent whose information is
displayed in the report.

Date Period The time range covered by the report. Adherence
data is shown for each day separately.

Scheduled State Lists the agent's noncompliant scheduled states.

Agent State The noncompliant states registered for the agent
throughout the day.

Start Time/End Time The start and end times for the noncompliant
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states.

% Adherence Per Day

The percent of the day during which the agent was
adherent to his or her scheduled state. This is
calculated using the formula
100 - ((NC+UNC)∗100/(ST+UNC)) where:

• NC—Noncompliant time
• UNC—Noncompliant time outside of scheduled

time
• ST—Scheduled time

% Adherence for Agent
The percent of the report's total time range during
which the agent was adherent to his or her
scheduled state.

Channels Sub Report

The Agent Adherence report has a Channels sub report that provides separate data for each media
channel and aggregated real-time state information for those schedule state groups with no specified
channel. The data in each record of the report is aggregated and contains the following columns:

• Channel—The name of the channel.
• Agent State—Real-time state of the agent on that specific channel.

The order and format of these columns is as shown in the example below.
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Adherence Totals Report
To create an Adherence Totals Report:

1. On the Reports tab, select Adherence Reports from the Views menu.
2. Select Adherence Totals Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: Generate a header on the report, by selecting Show Header and typing the header text into

the text box.
4. Optional: Export the report to a file in the comma-separated values format, by selecting the check box

Create report with .csv friendly format.
• After the report is created, select Actions > Save As and then, Comma Separated as the report

format.

Do not use Workforce Management (WFM) to print reports that you created in ".csv friendly
format," because the result may be truncated. To print such a file correctly, open it in a
program that reads the .csv format, and then print it.

5. Click Next.
6. On the Date Range screen, select a Granularity and a corresponding Start Date and End Date.

Your Granularity selection may restrict your Date selections.
7. Click Next.
8. In the Target section, select Agent, Team, or Site from the drop-down list.
9. Optional: Select the Exclude Days Without Shifts check box and then, click Next.

10. On the Data screen, select the targets (agents, teams, or sites) that you want to include in the report.
You can expand business units to display their sites. If you selected Team or Agent on the
Target screen, you can further expand the tree's branches. You can select across multiple
sites.

11. Click Finish.
The report appears in the Report Viewer.

Understanding the Adherence Totals Report

The report takes one of three forms depending on the target selected. The Site, Team, and Agent
reports are detailed separately below.

The Site Adherence Totals Report

Business Unit [header] The name of the business unit, if applicable, and its
time zone.

Date Period [header] The time range covered by the report.
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Site The name of each site included in the report.

Total Time
The combined total of the duration of the shift in
the Master Schedule plus the non adherent time
outside the shift for agents in each site.

Duration of Non Adherence The length of time agents in each site were non
adherent (within the shift and outside of the shift).

Duration of Non Adherence Out of Schedule
The length of time agents in each site were non
adherent outside of the shift. This number makes
up part of the Total Time and Duration of Non
Adherence.

% of Adherence
The percentage of time that the agents in each site
spent in a compliant state for each day included in
the report.

% of Adherence per Day The average of the compliant time for all sites for
the specified day.

% Adherence per Week The average of the compliant time for all sites for
the specified week.

% Adherence per X Weeks The average of the compliant time for all sites, for
your specified period of up to six weeks.

% Adherence per Month The average of the compliant time for all sites for
the specified month.

% of Adherence for the Business Unit The total average compliant time for all sites for
the specified date range.

The Team Adherence Totals Report

Business Unit [header] The name of the business unit, if applicable, and its
time zone.

Site [header] The name and time zone of the site.
Date Period [header] The time range covered by the report.
Team The name of each team included in the report.

Total Time
The combined total of the duration of the shift in
the Master Schedule plus the non adherent time
outside the shift for agents in each team.

Duration of Non Adherence The length of time agents in each team were non
adherent (within the shift and outside of the shift).

Duration of Non Adherence Out of Schedule
The length of time agents in each team were non
adherent outside of the shift. This number makes
up part of the Total Time and Duration of Non
Adherence.

% of Adherence
The percentage of time that agents in each team
spent in a compliant state for each day included in
the report.

% of Adherence per Day The average of the compliant time for all teams on
the specified day.

% Adherence per Week The average of the compliant time for all teams for
the specified week.
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% Adherence per X Weeks
% Adherence per Month

The average of the compliant time for all teams, for a specified
period of up to six weeks.
The average of the compliant time for all teams, for the
specified month.

% of Adherence for Site An average of all daily adherence totals for the
date period.

The Agent Adherence Totals Report
Site [header] The name and time zone of the site.
Team [header] The team displayed in the report.

Date Period [header] The time range covered by the report. Each day is
shown separately.

Agent The name of each agent included in the selected
team.

Total Time
The combined total of the duration of the shift in
the Master Schedule plus the non adherent time
outside the shift for each agent.

Duration of Non Adherence The length of time each agent was non adherent
(within the shift and outside of the shift).

Duration of Non Adherence Out of Schedule
The length of time each agent was non adherent
outside of the shift. This number makes up part of
the Total Time and Duration of Non Adherence.

% of Adherence The percentage of time that each team spent in a
compliant state for each day included in the report.

% of Adherence The percentage of time that each agent spent in a
compliant state for each day included in the report.

% of Adherence per Day The average of the compliant time for all agents on
the specified day.

% Adherence per Week
% Adherence per X Weeks
% Adherence per Month

The average of the compliant time for all agents for
the specified week.
The average of the compliant time for all agents, for a specified
period of up to six weeks.
The average of the compliant time for all agents, for the
specified month.

% of Adherence for Team An average of all daily adherence totals for the
date period.
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Agent States Report
To create an Agent States Report:

1. On the Reports tab, select Adherence Reports from the Views menu.
2. Select Agent States Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. Optional: To generate a header on the report, select Show Header and type your header text into the

text box.
4. Optional: To export the report to a file in the comma-separated values format, select the check box

Create report with .csv friendly format (and then, after the report is created, select Actions >
Save As and select Comma Separated as the report format). Do not use Workforce Management
(WFM) to print reports that you created in ".csv friendly format," because the result may be truncated.
To print such a file correctly, open it in a program that reads the .csv format, and then print it.

5. Click Next.
6. On the Date Range screen, select a Start Date and End date for the report. Then click Next.
7. On the Data screen, select the agent(s) that you want to include in the report.

You can expand business units to display their sites, teams, and agents.
8. Click Next.
9. On the Agent states page, select the Agent States that you want to include in the report. Clear the

check boxes for Agent States that you want to omit. If you want to, enter any Reason Code with which
you want to filter the report.

10. Click Finish.
The report appears in the Report Viewer.

Understanding the Agent States Report
Site [header] The site's name and time zone.
Team [header] The team to which the selected agent belongs.
Agent [header] The agent whose status is displayed in the report.
Date Period The dates that you selected in the Reports Wizard.
Agent State The name of the schedule state.

Reason
If you are using reason [Aux] codes, the code
associated with an occurrence of the schedule
state.

Start Time The time at which the agent enters the schedule
state.

End Time The time at which the agent switches to another
state.

Duration Duration of the schedule state.
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Total Duration Per Day (row) The combined time of the schedule states per day.

Total Duration Per Date Period (row) The combined time of the schedule states per date
period.

Channels Sub Report

The Agent States report has a Channels sub report that provides separate data for each media
channel and aggregated real-time state information for those schedule state groups with no specified
channel. The data in each record of the report is aggregated and contains the following columns:

• Channel—The name of the channel.
• Agent State—Real-time state of the agent on that specific channel.
• Reason—If present, a list of reasons for a specific channel. (This column is only displayed in the Agent

States report.)

The order and format of these columns is as shown in the example below.

Screenshot of the Channels sub report page in the Agent States Report.
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Audit Reports
Audit reports track the actions performed by supervisors while working in the Calendar and Master
Schedule.

The Audit reports are:

• Calendar Audit Report
• Schedule Audit Report
• Configuration Audit Report

To create a report, click that report's link (above) and follow the steps.

For a complete list of all WFM reports, see the Reports List.

Report Security Restrictions

In order to create and print these reports, permission must be assigned. See the Configuration >
Roles topics for more information about security privileges.

Date Restrictions

For reports whose wizard includes a Date Range screen:

• If you select weekly or monthly granularity, the Start Date and End Date selectors may be
constrained to particular days (to the week's start and end days, or to the selected month's first and
last days).

• If you enter dates that do not match these constraints and click Next, an error message alerts you to
change your selection.
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Calendar Audit Report

This report can show calendar items modified not only by supervisors, but also by agents. However,
the items modified by agents cannot be filtered by the agent name or ID. Instead, all items modified
by agents are listed as being modified by the SYSTEM user. An example would be an agent time-off
preference. Since time-off preferences are calendar items that can be entered by agents through
their Web GUI, this type of calendar item would show up in the Calendar Audit Report as having been
modified by the SYSTEM user.

To create a Calendar Audit Report:

1. On the Reports tab, select Audit Reports from the Views menu.
2. Select Calendar Audit Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. To print a header on the report, select Show Header and type your header text into the text box. Then

(whether you entered a header or not) click Next.
4. Complete the Date Range screen.

a. Under Action Date Range, do one of the following:
• Select Start and End dates for supervisor actions in the Calendar module.
• Select the Any check box to select any date range for supervisor actions in the Calendar

module. If checked, the Start and End date fields are disabled.

b. Under Actions and Statuses, check boxes to indicate the actions and statuses that you wish to
audit:
• Insert
• Edit
• Delete
• Preferred
• Granted
• Declined
• Recalled

c. Under Calendar Items Date Range, do one of the following:

d. Select Start and End dates for the agent calendar items you wish to audit.
e. Select the Any check box to select calendar items in any date range. If checked, the Start and End

date fields are disabled.

5. Under Options, select Show comments/memo to control whether comments or memo, if any, are
shown on the report.

6. Under Sort Options, select one of the following:
• By Agent name
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• By Supervisor name
• By Timestamp date
• By Calendar Item date

• Click Next.
• On the Data screen, under Available Users, select the supervisors and other users/agents that you want

to include in your report.
• Click Next.
• On the second Data screen, under Available Agents, select the agents to include in the report.

You can expand business units to display their sites, teams, and agents. You can select agents from multiple
sites.

• Click Next.
On the Calendar Items screen, select the check boxes for items that you want to include in the report, and
clear the check boxes for items that you want to omit. Available selections are:

• Availabilities
• Days Off
• Shifts
• Working Hours
• Times Off
• Exceptions

• Click Finish.

The report appears in the Report Viewer. The report is initially sorted by business unit within the
enterprise, by site name within each business unit, then team name (if any) within each site. Further
sorting is based on Sort Options selected on the Date Range screen.

Understanding the Calendar Audit Report

Site [header] The selected business unit, site, site time zone, and
the (first) selected team.

User Name The name of the user (supervisor) or agent
responsible for the action.

Timestamp The date and time of the supervisor action.

Action The description of the action. Examples: Insert,
Edit, and Delete.

Date The calendar item day.
Agent The name of the agent affected by the action.
Type The item type name. Example: Working Hours.
Name The calendar item name.

Status The status assigned by the user. Examples:
Granted, Declined.
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Comments/Memo This column appears if Show Comments was
selected on the Date Range screen.
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Schedule Audit Report
This report can show not only schedule changes made by supervisors, but also by agents. However,
the schedules modified by agents cannot be filtered by the agent name or ID. Instead, all schedules
modified by agents are listed as being modified by the SYSTEM user. An example would be an agent
trade that is auto-approved by the system. In this case, no supervisor was involved, and that
schedule change would be reported in the Schedule Audit Report as being done by the SYSTEM user.

To create a Schedule Audit Report:

1. On the Reports tab, select Audit Reports from the Views menu.
2. Select Schedule Audit Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. To print a header on the report, select Show Header and type your header text into the text box. Then

(whether you entered a header or not) click Next.
4. Complete the Date Range page.

a. Under Action Date Range, do one of the following:
• Select Start and End dates for supervisor actions in the Master Schedule.
• Select the Any check box to select any date range for supervisor actions in the Master Schedule.

If checked, the Start and End date fields are disabled.

b. Under Actions, check boxes to indicate the actions that you wish to audit:
• Publish
• Cleanup
• Modify
• Trade
• Rollback

c. Under Schedule Date Range, do one of the following:
• Select Start and End dates for the schedule days you wish to audit.
• Select the Any check box to select schedule days in any date range. If checked, the Start and

End date fields are disabled.

d. Under Options, select Present action's details to control whether additional detail on the action
is shown on the report. See Understanding the Schedule Audit Report below for more information.

e. Under Sort Options, select one of the following:
• By Supervisor name
• By Timestamp date
• By Schedule date

5. Click Next.
6. On the Data screen, under Available Users, select the supervisors and other users/agents that you
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want to include in your report.
7. Click Next.
8. On the second Data screen, under Available Agents, select the agents to include in the report.

You can expand business units to display their sites, teams, and agents. You can select agents from
multiple sites.

9. Click Finish.

The report appears in the Report Viewer. The report is initially sorted by business unit within the
enterprise, by site name within each business unit, then team name (if any) within each site. Further
sorting is based on Sort Options selected on the Date Range screen.

Understanding the Schedule Audit Report
Site [header] The selected business unit, site, and site time zone.

Date Period
The selection made by the user for Action Date
Range on the Date Range page of the report
generation wizard.

User Name The name of the user (supervisor) or agent
responsible for the action.

Timestamp The date and time of the supervisor action.

Action The description of the action. Examples: Publish,
Cleanup, Modify.

Date Range
If the Action is Publish or Cleanup, this column
shows the date range for the action. If the Action is
Modify, this column shows the date of the
modified schedule day.

Applied to

If the Action is Publish, this column shows the
name of the scenario used for the published data. If
the Action is Modify, this column shows the name
of the agent associated with the schedule
modification. If the Action is Cleanup, this column
is empty.

Tip
If you selected Present action's details on the Data
Range screen, the following applies:
If the Action is Publish or Cleanup, the report lists all
affected agents.

If the schedule was changed and you checked Present Action's Details on the Date Range page,
the report displays two tables at the bottom:

• Left-hand table: Original schedule
• Right-hand table: Modified schedule.

The left-hand table contains these columns:
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• Original Schedule
• Start Time
• End Time
• Paid Time
• Applied To

The right-hand table contains these columns:

• Modified Schedule
• Start Time
• End Time
• Paid Time
• Applied To
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Configuration Audit Report

This report can show configuration object (data) types that have been associated with specific sites
and users, including the SYSTEM user.

To create a Configuration Audit Report:

1. On the Reports tab, select Audit Reports from the Views menu.
2. Select Configuration Audit Report from the list in the Objects pane.

The Reports Wizard's first screen, Header, appears.
3. To print a header on the report, select Show Header and type your header text into the text box. Then

(whether you entered a header or not), click Next.
4. Complete the Date Range screen.

a. Under Action Date Range, do one of the following:
• Select Start and End dates for supervisor actions with configuration objects.
• Select the Any check box to select any date range for supervisor actions with configuration

objects. If checked, the Start and End date fields are disabled.

b. Under Actions, select the check boxes which indicate actions that you wish to audit: Insert,
Modify, Delete.

c. Under Sort Options, select one of the following from the drop-down menu:
• By Object's type
• By Supervisor name
• By Timestamp date.

5. Click Next.
6. On the Configuration Object Types screen, under Data Types, select the check boxes for data types

that you want to include in the report, and clear the check boxes for items that you want to omit.
7. Click Next.
8. On the Data Page, under Available Users, select the supervisors and other users (including agents, if

shared transport groups are enabled) that you want to include in your report.
9. Click Next.

10. On the second Data Page, under Available Sites, select the sites to include in the report.
You can expand business units to display their sites. You can select multiple sites.

11. Click Finish.

The report appears in the Report Viewer. The report is initially sorted by business unit within the
enterprise, by site name within each business unit. Further sorting is based on Sort Options
selected on the Date Range screen.
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Understanding the Configuration Audit Report
Header The selected business unit, site, and date period.

User Name The name of the user (supervisor) or agent
responsible for the action.

Action The description of the action. Examples: Insert,
Edit, and Delete.

Object Type The object that is being reported (Example: Time-
Off Type)

Object Name The reported object’s name (Example: Time Off 1)
Timestamp The date and time of the supervisor action.
Field Data field inside the object.
Old Value The object's previous value (if there was one).
New Value The object's updated value.
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